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Getting Started

Welcome to Style Scope Agile Edition! 

Style Scope Agile Edition is a dashboard design and interactive analysis
package that allows you to explore, analyze, monitor, report, and
collaborate on business and operational data, all in real time. You will find
Style Scope Agile Edition to be agile, robust, and easy to use.

To get started, first launch the Portal and proceed to log in. See Launching
the Portal and Logging into the Portal for more details. The first time you
access the Portal, you will see the ‘Getting Started’ wizard.

The wizard guides you through the following basic steps:

1. Configure Email. See Configuring Email for more details.

2. Connect Database. See Connecting to a Database for more
details.

3. Create Data Set. See Creating a Data Set from Excel or Text,
Creating a Data Set from Database Query, and Creating a Data
Set by Mash-Up for more details.

4. Create Dashboard. See Creating a New Dashboard for more
details.

To skip the wizard, press the ‘Close’ button at the bottom of the wizard. To
open the wizard at a later time, press the ‘Open Wizard’ button on the right
side of the Portal.
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Connecting to Your 
Data

Dashboards can retrieve data from either a database or a file.

• If you want your dashboards to retrieve data from a relational database,
first create a connection to your data. See Connecting to a Database. 

• If you want your dashboards retrieve data from a text file or Excel file,
proceed to Creating a Data Set from Excel or Text. 
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Connecting to a Database

If the Portal displays the ‘Getting Started’ wizard, jump to
Getting Started.

To create a data source based on a relational data base, follow the steps
below. 

1. Select the top Data tab in the Portal. (See Using the Portal for
more about Portal features.)

2. Select the ‘Databases’ option in the left panel.

3. Press the ‘New Database’ button. This opens the database
definition screen.
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4. In the ‘Name’ field, enter a label for this database connection.

5. From the ‘Database Type’ menu, select the type of your database
(ODBC, Oracle, SQLServer, etc.).

6. If you are prompted to supply a driver for the database, follow the
steps below:

a. Obtain the driver file(s) from the database vendor. Usually these
JAR files are available for download on the vendor’s website. 

b. Press the ‘Choose Files’ button and select the appropriate
database driver.
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c. Press the ‘Upload’ button to install the driver.

To upload a driver at a later time, see Uploading a Database
Driver. To remove a driver from the server, see Removing a
Database Driver.

7. Enter the additional required connection information for your
database, such as host name, port, and login credentials. You can
obtain this information from your database administrator.

8. Press ‘OK’.

9. Verify that the database you added is shown with a green dot,
indicating that the connection was successful.
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10. If the database is shown with a red dot, this means that the
connection was not successful. Check the settings to make sure
they are correct for your database. See Editing a Database
Connection for information on how to change connection settings.

After you have created a connection to the database, you can proceed to
define a data set. See Creating a Data Set from Database Query.
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Editing a Database Connection

To edit an existing database connection, follow the steps below.

1. Select the top Data tab. (See Using the Portal for more about
Portal features.)

2. Select the ‘Databases’ option in the left panel.

3. Press the ‘Edit’ button next to the database connection that you
want to edit.

This opens the ‘Edit Database’ dialog box.

4. Proceed to edit the connection settings as described in Connecting
to a Database.
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Deleting a Database Connection

To delete an existing database connection, follow the steps below.

1. Select the top Data tab. (See Using the Portal for more about
Portal features.)

2. Select the ‘Databases’ option in the left panel.

3. Press the ‘Delete’ button next to the database you want to delete.
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Refreshing a Database Connection

If you make changes to your database schema, you may need to refresh the
metadata stored by the server. To refresh the cached table information for
an existing database connection, follow the steps below.

1. Select the top Data tab. (See Using the Portal for more about
Portal features.)

2. Select the ‘Databases’ option in the left panel.

3. Press the ‘Refresh’ button next to the database you want to refresh.
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Uploading a Database Driver

To upload a driver to the server, follow the steps below:

1. Select the top Data tab. (See Using the Portal for more about
Portal features.)

2. Select the ‘Databases’ option in the left panel.

3. Press the ‘Manage Drivers’ button.

4. Press the ‘Choose Files’ button and select the appropriate database
driver.

Press the ‘Upload’ button to install the driver.
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The driver is now available to the server.
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Removing a Database Driver

To remove a driver from the server, follow the steps below:

1. Select the top Data tab. (See Using the Portal for more about
Portal features.)

2. Select the ‘Databases’ option in the left panel.

3. Press the ‘Manage Drivers’ button.

4. Press the ‘Delete’ button next to the driver that you want to remove
from the server.

The driver is now shown disabled, pending removal.
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5. To complete removal of the driver, stop the server and then restart.
To stop the server on a Windows computer, select ‘Stop Server’ in
the ‘Style Scope Agile Edition’ program group. To restart the
server on a Windows computer, select ‘Start Server’ in the ‘Style
Scope Agile Edition’ program group.
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Creating a Data Set from Excel or Text

If the Portal displays the ‘Getting Started’ wizard, jump to
Getting Started.

To create a new data set from an uploaded file, follow the steps below:

1. Select the top Data tab. (See Using the Portal for more about
Portal features.)

2. Select the ‘Data Sets’ option in the left panel.

3. Press the arrow button in the navigation bar and select ‘New Data
Set’.

This opens the ‘New Data Set’ dialog box.
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4. Select ‘Upload File’. This opens the ‘Import Data File’ screen.

5. Press ‘Select File’, and choose the desired text or Excel file. 

6. For an Excel file, use the ‘Sheet’ menu to choose the sheet that you
want to import.

7. From the ‘Encoding’ menu, select the encoding of the text file. 

8. In the ‘Delimiter’ field, enter the character that is used in the text
file to separate entries. The default delimiter character is a comma.
For tab-delimited files, select the ‘Tab’ option.

9. Adjust any of the following optional settings to modify the way the
file data is interpreted:

You can only unpivot
a crosstab that has a
single level of col-
umn headers.

a. Select ‘Unpivot Data (Crosstab Table)’ if the data in the file is in
crosstab table form, and you want to convert the crosstab table
into a regular table. This option will convert the column header
row into a “dimension” column and convert the crosstab cells
into a “measure” column. If the crosstab table in the file
contains multiple levels of row headers, enter the number of
levels in the ‘Header Columns’ field.
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b. Select ‘First Row as Header (Regular Table)’ to use the entries
in the first row of the file as the column header text. Otherwise,
default column names are used (“col0,” “col1,” etc.).

c. Select ‘Remove Quotation Marks’ to strip quotation marks out
of the text file upon import.

10. Press ‘OK’. This opens the ‘Save Data Set’ dialog box.

11. Enter a name for the new data set in the ‘Name’ field. In the
‘Repository’ panel, select the folder into which you want to save.

12. Press ‘OK’. This creates a new data set on the ‘Data Sets’ page in
the location that you specified. 

Proceed to Creating a New Dashboard to create a visualization based on
the uploaded data set. 
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If the data in the original spreadsheet or text file is updated at a later time,
you should re-import the data from the spreadsheet or text file into the data
set. To do this, open the data set for editing (Editing a Data Set) and re-
import the data from the spreadsheet or text file into the Worksheet data
block. See Importing Data Into an Embedded Table in Advanced Data
Mashup for detailed instructions.
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Creating a Data Set from Database Query

If the Portal displays the ‘Getting Started’ wizard, jump to
Getting Started.

To create a new data set from an existing database connection, follow the
steps below: 

1. If you have not yet configured a database, see Connecting to a
Database. Then proceed with the steps below.

2. Select the top Data tab. (See Using the Portal for more about
Portal features.)

3. Select the ‘Data Sets’ option in the left panel.

4. Press the arrow button in the navigation bar and select ‘New Data
Set’.



CONNECTING TO DATA

20 of 2639

This opens the ‘New Data Set’ dialog box.

5. Select ‘Database Query’. This opens the ‘Database Query’ dialog
box.

6. In the ‘Select a Data Source’ menu, choose the database that you
want to supply data to the data set.

7. Select the database fields that you want to retrieve by dragging
them from the left panel into the ‘Columns’ area.
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8. Define any required joins. To do this, follow the steps below:

a. Press the ‘New’ button next to the ‘Joins’ area to open the ‘Add
Join’ dialog box.

b. Select a table from the top-left menu, and select the join field for
that table from the bottom-left menu. Select a table from the
top-right menu, and select the join field for that table from the
bottom-right menu. From the center menu, select the join
operator (equi-join or inequality join). 

For full information
about specifying
joins, see Changing
the Join Type in
Advanced Data
Mashup.

c. (Optional) Select the ‘All’ option on the left side to retain all
records from the left table, even those for which there is no
match in the right table (left outer join). Select the ‘All’ option
on the right side to retain all records from the right table, even
those for which there is no match in the left table (right outer
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join). Select both ‘All’ options to retain all rows from both
tables (full outer join).

d. Press ‘OK’ to add the join. The join is now displayed in the
‘Joins’ area.

e. To add an additional join, press the ‘New’ button again to open
the ‘Add Join’ dialog box. Repeat as necessary to add all desired
joins.

f. To change an existing join, press the ‘Edit’ button next to the
join.

g. To delete an existing join, press the ‘Delete’ button next to the
join.

For full information
about specifying con-
ditions, see Filtering
in Advanced Data
Mashup.

9. (Optional) Press the ‘Edit’ button next to the ‘Conditions’ area to
open the ‘Conditions’ dialog box. Use the menus to enter a desired
filter condition and press ‘Insert’. Then press ‘OK’.
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Note: If you make manual edits to the SQL string, you will no
longer be able to modify the query using the 'Columns', 'Joins',
and 'Conditions' panels.

10. (Optional) To make manual edits to the SQL string that will be sent
to the database, press the ‘Edit’ button next to the ‘SQL’ area to
open the ‘SQL’ panel for editing. Make the desired edits.

11. Press ‘OK’ to close the ‘Database Query’ dialog box. This opens
the ‘Save Data Set’ dialog box.
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12. Enter a name for the data set, and select a location in the repository
tree.

This saves the data set in the specified location.

Proceed to Creating a New Dashboard to create a visualization based on
this data set.
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Creating a Data Set by Mash-Up

If the Portal displays the ‘Getting Started’ wizard, jump to
Getting Started.

To create a new data set for dashboard visualization, follow the steps
below:

1. Select the top Data tab. (See Using the Portal for more about
Portal features.)

2. Select the ‘Data Sets’ option in the left panel.

3. Press the arrow button in the navigation bar and select ‘New Data
Set’.

This opens the ‘New Data Set’ dialog box.
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4. Select ‘Mashup Data’. This opens a blank Data Worksheet.

5. To create a data block based on a local text or Excel file, press the
‘Upload File’ button in the center of the Worksheet.

This creates a new embedded table and opens the ‘Import Data
File’ dialog box. For information about using this dialog box, see
Importing Data Into an Embedded Table in Advanced Data
Mashup. If you do not see the ‘Upload File’ button, use the
procedure described in Importing Data Into an Embedded Table.

6. To create a data block based on queried data, drag a data set,
database table, or individual fields from the Asset panel into the
Data Worksheet.
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This creates a new data block displaying meta-data (column names
and types). 

To view actual data, see Displaying Data in a Data Block.

7. Repeat the above steps to add any additional data blocks into the
Worksheet.

8. Press the ‘Save’ button in the toolbar to save the data set.

9. Perform any desired mashup operations on the data blocks. For
more information on the available operations, see Transforming
and Mashing Up Data.

Proceed to Creating a New Dashboard to create a visualization based on
this data set.



CONNECTING TO DATA

28 of 2639

Editing a Data Set

To edit an existing data set, follow the steps below.

1. Select the top Data tab. (See Using the Portal for more about
Portal features.)

2. Select the ‘Data Sets’ option in the left panel.

3. (Optional) Click on a folder to display the datasets contained in the
folder.

4. Click on the data set that you want to edit.

This opens the data set for editing in a Data Worksheet.
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5. (Optional) If a data block was created directly from a query, press
the ‘Edit Query’ button in the title bar to access the ‘Database
Query’ dialog box.

6. Perform any desired mashup operations on the data blocks in the
Worksheet. For more information on the available operations, see
Transforming and Mashing Up Data.
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Deleting a Data Set

To delete an existing data set, follow the steps below.

1. Select the top Data tab. (See Using the Portal for more about
Portal features.)

2. Select the ‘Data Sets’ option in the left panel.

3. (Optional) Click on a folder to display the datasets contained in the
folder.

4. Expand the menu for the data set you want to delete and select
‘Delete’.
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Transforming and 
Mashing Up Data

If your data source returns data that requires more sophisticated
manipulation (e.g., additional filtering, grouping, sorting), or if you need to
mashup data from multiple data sources, use a Data Worksheet. The
following sections explain the features that Data Worksheets provide for
transformation and mashup.
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Creating a Data Mashup

To create a new data mashup in a Data Worksheet, see Creating a Data Set
by Mash-Up.



TRANSFORMING DATA

33 of 2639

Displaying Data in a Data Block

To view live data within a data block, press the ‘Change View’ button in
the data block title bar, and choose ‘Live Preview’.

To expand the data block to see additional rows, drag the bottom border.

Note that the data displayed in ‘Live Preview’ may be truncated. To view
the full data set, right-click on the data block and select ‘Preview’.

This displays the full data set in a new tab.
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To close the tab, press the red ‘X’ on the right side of the tab.
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Filtering Data

To place filtering conditions on a data block, follow the steps below. Note:
If you want dashboard users to dynamically filter the data in a dashboard,
see Adding a Filter (Selection) instead.

1. Create the data block you want to filter. See Creating a Data Set by
Mash-Up for information on how to create a data block.

This data block is
shown with live data.
See Displaying Data
in a Data Block for
more information.

2. Press the ‘Define Condition’ button on the title bar of a data block.
This opens the ‘Condition’ dialog box.

3. Select the ‘Advanced Conditions’ check box. 

4. To create a pre-aggregate condition (a condition that applies to
detail data prior to grouping and aggregation), press the ‘Edit’
button next to the ‘Pre-aggregate Conditions’ panel. Use the menus
to specify the desired condition. Then press ‘Append’ to add the
condition and ‘OK’ to close the dialog box.
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5. To create a post-aggregate condition (a condition that applies to
summarized data following grouping and aggregation), press the
‘Edit’ button next to the ‘Post-aggregate Conditions’ panel. Use the
menus to specify the desired condition. Then press ‘Append’ to add
the condition and ‘OK’ to close the dialog box.

See Grouping and Aggregating Data for information on creating
aggregate fields.

6. To create a ranking condition (a condition that filters the top-N or
bottom-N groups based on a specified measure), press the ‘Edit’
button next to the ‘Ranking Conditions’ panel. Press the ‘More’
button and use the menus to specify the desired condition. Then
press ‘OK’ to close the dialog box.
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The selected data block is now filtered to return only data matching the
specified condition. 

See Also
Filtering, in Advanced Data Mashup for full information on filtering data
blocks.
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Grouping and Aggregating Data

To group and aggregate data, follow the steps below. 

1. Create the data block you want to group. See Creating a Data Set
by Mash-Up for information on how to create a data block.

This data block is
shown with live data.
See Displaying Data
in a Data Block for
more information.

2. Press the ‘Group’ button on the title bar of a data block. This opens
the ‘Aggregate’ dialog box.

3. Use the menus to select grouping fields and summary fields. For
date-type fields, select the desired level of date grouping (‘Year’,
‘Month’, etc.). For summary fields, select the desired method of
aggregation (‘Sum’, ‘Average’, etc.).

4. Press ‘OK’ to close the dialog box. 

The data block is now grouped, and only the grouping and summary
columns are returned in the result set.

See Also
Grouping, in Advanced Data Mashup, for full information on grouping and
aggregating data blocks.
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Joining Tables

Joins allow you to mash up data from different data blocks. A joined table
is a composition of two data blocks that preserves a specified relationship
between the participating data blocks (base tables). 

The joined table contains all the columns from both base tables, but retains
only the rows satisfying a specified set of join conditions. The join
conditions are relations between pairs of columns, one from each base
table.

To join tables together using an inner join, outer join, or inequality join,
follow the steps below:

1. Create the data blocks that you want to join. See Creating a Data
Set by Mash-Up for information on how to create a data block.

2. Select the data blocks you want to join together. (You can Shift-
click on the data blocks to select both, or simply drag the mouse
across them.)

You can also create a join by dragging columns. See Creating a
Inner Join by Dragging Columns in Advanced Data Mashup.

3. Press the ‘Join Table’ button in the toolbar, and select the ‘Inner
Join’ option.

This opens the ‘Inner Join’ dialog box.

4. Specify the join conditions. Each join condition specifies how a
pair of columns from different data blocks should be related. 
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For example, this join condition specifies that the values in the
‘EMPLOYEE_ID’ column from the ‘Orders’ data block should be
matched to the values in the ‘EMPLOYEE_ID’ column from the
‘Employees’ data block. 

5. (Optional) Select the ‘Include All Values’ option next to the left-
side table to create a left outer join. Select the ‘Include All Values’
option next to the right-side table to create a right outer join. Select
both options to create a full outer join.

6. Press ‘OK’ to create the joined data block.

To view the actual
data, see Displaying
Data in a Data Block.

The resulting data block is displayed in ‘Composition View’,
which shows the original tables and how they are joined. 

7. To remove duplicate columns (e.g., the join columns), first press
the ‘Change View’ button in the title bar and select either ‘Default’
or ‘Preview’. 
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To change column
names, double click
the column header
and edit the text.

Then press the ‘Visibility’ icon in the column header that you want
to hide.

8. Right-click the joined data block, and select ‘Set As Primary’ from
the context menu.

It is good practice to mark the final result of your Data Worksheet
as the primary data block. This ensures that this data block will be
listed first among the data blocks available to any dashboard based
on this data set.

See Also
Joining Tables, in Advanced Data Mashup, for full information about
joins.
Changing the Join Type, in Advanced Data Mashup, for information on
converting between join types. 
Editing a Composition Table, in Advanced Data Mashup, for information
on how to use the editable and composition views of tables.
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Concatenating Tables

Union, intersection, and difference operations are known as
concatenations. Data blocks must have the same number of columns in
order to participate in concatenations, and the corresponding columns of
each data block must have the same data type. 

To concatenate multiple data blocks, follow these steps:

The order in which you select the data blocks will influence the
result for a ‘Minus’ operation.

1. Create the data blocks that you want to join. See Creating a Data
Set by Mash-Up for information on how to create a data block.

2. Select the data blocks that you want to concatenate. (Ctrl-click on
the data blocks to select them, or drag across the data blocks.)

3. Press the ‘Concatenate Table’ button in the Worksheet toolbar and
select the desired concatenation: ‘Union’, ‘Intersect’, or ‘Minus’. 

See Union, Intersect, and Minus in Advanced Data Mashup for
more details.

See Changing the Concatenation Type in Advanced Data Mashup for
information about switching the concatenation type of an existing
concatenated table.
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Creating an Expression

An expression column is a data block column that you define using either
JavaScript or SQL. The expression is evaluated for each row of the data
block.

To add an expression column to a data block, follow the steps below:

1. Create the data block to which you want to add an expression
column. See Creating a Data Set by Mash-Up for information on
how to create a data block.

2. Press the ‘Expression’ (fx) button in the title bar of the data block to
which you want to add an expression column. This opens the
‘Expression’ dialog box.

3. In the ‘Expression’ dialog box, enter the name of the new column. 

Press ‘OK’ to open the Formula Editor.

4. At the top of the Formula Editor, select either ‘SQL’ or ‘Script’.
Select ‘SQL’ (if available) to write the expression using your
database’s SQL syntax. Select ‘Script’ to write the expression
using JavaScript.

5. From the ‘Return Data Type’ menu, select the appropriate data
type for the values that the expression will return.

6. Type the desired expression into the script area. To add a field into
the expression, click on the field name in the ‘Fields’ listing. 
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7. Press ‘OK’ to close the Editor and create the new column.
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Saving a Data Set

To save the data set in a Data Worksheet, press the ‘Save’ button in the
toolbar or press Ctrl-S on the keyboard. 

To save the data set in a Data Worksheet under a different name or in a
different location, follow the steps below:

1. Press the ‘Save As’ button in the toolbar. This opens the ‘Save Data
Set’ dialog box.

2. Enter a name for the data set in the ‘Name’ field.

3. Select a location in which to save the data set.

4. (Optional) Under the Options tab, set the ‘Design mode sample
data size’ to the maximum number of rows that you want data
blocks in the Data Worksheet to retrieve. 

5. Press ‘OK’ to save the data set.
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Creating a Dashboard

This section explains how to create a new dashboard and lay out
components such as the gauges, tables, and charts shown below.
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Creating a New Dashboard

To create a new dashboard follow the steps below:

1. Select the Dashboards tab in the Portal.

2. Press the arrow button in the navigation bar, and select ‘New
Dashboard’.

This opens the ‘New Dashboard’ dialog box.

3. Enter a name for the dashboard and select the dataset that he
dashboard will visualize.
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4. Press ‘OK’ to open the dashboard for editing.

The dashboard editor
is called Visual Com-
poser.

5. Build the dashboard by dragging components from the left
Component panel onto the grid. See the following sections for
more details on building the dashboard.
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Adding a Chart

To add a chart, follow the steps below:

1. If necessary, create a new dashboard. See Creating a New
Dashboard.

2. From the Component panel, drag a Chart component into the grid.
This adds the Chart to the dashboard and opens the Chart Editor in
the left panel.

A chart visualizes a data set, which is a table containing rows and
columns. Columns (also called fields) in the dataset are classified as
either ‘Dimensions’ or ‘Measures’ in the Chart Editor.

3. Resize the chart as desired by dragging the handles.
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To set different styles
for different datasets,
see Displaying Multi-
ple Chart Styles on a
Single Axis.

4. (Optional) Set the style of the chart. To do this, press the ‘Select
Chart Style’ button in the Data panel. Choose a desired style, such
as ‘Line’ or ‘Bar’, and press the green ‘Apply’ button.

Note: If you select a ‘Pie’ style, you should place the dimension
field on either the ‘Color’ or ‘Shape’ region of the Visual panel.

To create a stacked chart, enable the ‘Stack’ option at the bottom of
the panel. If you do not select a specific chart style, the default
‘Auto’ style automatically selects a chart style appropriate to your
dataset. 

To convert a measure
to a dimension, right-
click the measure in
the Data Source panel
and select ‘Convert to
Dimension’.

5. From the ‘Dimensions’ folder of the Data Source panel, drag a
desired dimension to the ‘X’ region.

Dimensions are used to break-down the dataset into multiple
groups. Adding a dimension to the ‘X’ region distinguishes the
different dimension groups by location on the X-axis. Adding a
dimension to the ‘Y’ region distinguishes the different dimension
groups by location on the Y-axis. You can add multiple dimensions
into the ‘X’ or ‘Y’ regions to create multiple grouping levels.

You can also distinguish groups in a dimension by using color,
shape, size, or label, as described in the next step.



CREATING DASHBOARDS

51 of 2639

6. To break-out the dataset into groups using color, shape, size, or text
labeling, drag a dimension from the Data Source panel to one of
the regions in the Visual panel.

a. To denote different groups using different colors, drag the field
to the ‘Color’ region.

b. To denote different groups using different shapes, drag the field
to the ‘Shape’ region.

c. To denote different groups using different sizes, drag the field to
the ‘Size’ region.

d. To denote different groups using different text labels, drag the
field to the ‘Text’ region.

Note that the effect of color, shape, and size codings varies by chart
style. For example, in a bar-type chart the ‘Shape’ representation
affects the style of the fill pattern, whereas in a point-type chart the
‘Shape’ representation affects the image of the point.

7. To break-out the data into groups without applying any visual
formatting, drag a dimension to the ‘Break By/Tooltip’ region.

8. (Optional) For a date dimension, press the ‘Edit Dimension’ button
next to the field name in the Chart Editor, and set the ‘Level’ to the
desired date grouping. Then press the green ‘Apply’ button. 
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You can add multiple
measures to a chart.
To convert a dimen-
sion to a measure,
right-click the dimen-
sion in the Data
Source panel and
select ‘Convert to
Measure’.

9. From the ‘Measures’ folder of the Data Source panel, drag a
measure to the ‘Y’ region. This places the selected field onto the
chart as a measure.

A measure is generally used for aggregation (summation,
averaging, correlation, etc.). Adding a measure to the ‘Y’ region
displays the computed aggregates by using locations on the Y-axis.
Adding a measure to the ‘X’ region displays the computed
aggregates by using locations on the X-axis. 

10. Press the ‘Edit Measure’ button next to the measure, and select the
desired aggregation method for the measure.

11. To represent a measure using color, shape, size, or labeling, drag
the desired measure field from the Data Source panel to a region
of the Visual panel.
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a. To represent the measure value using a continuous color
spectrum, drag the measure to the ‘Color’ region.

b. To represent the measure value using a continuous shape
spectrum, drag the measure to the ‘Shape’ region.

c. To represent the measure value using a continuous size
spectrum, drag the measure to the ‘Size’ region.

d. To represent the measure by placing numerical values on the
chart, drag the measure to the ‘Text’ region.

Note that the effect of color, shape, and size codings varies by chart
style. For example, in a bar-type chart the ‘Shape’ representation
affects the density of the fill pattern, whereas in a point-type chart
the ‘Shape’ representation affects the geometry of the point or the
fraction filled.

12. To represent a measure by using tooltip information, drag the
measure to the ‘Break By/Tooltip’ region.

For full information on creating charts, see Charts in Advanced Dashboard
Design.
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Creating a Dual-Axis Chart

By default, when you add two or more measure fields on the Y-axis, the
selected datasets are plotted on adjacent sets of axes, as shown below:

In some cases, you may want to use dual Y-axes to represent these
measures, as shown below:

To display a dataset on the right-side (secondary) Y-axis, follow these
steps:

1. Press the ‘Switch to Single Graph’ button in the Data panel of the
Chart Editor.
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This places all measures on the same Y-axis rather than on adjacent
axes.

2. Press the ‘Edit Measure’ next to the measure that you wish to
display against the secondary Y-axis. 

3. Enable the ‘Secondary Axis’ option at the bottom of the panel.

4. Press the ‘Apply’ button (green arrow).

To return to the multiple axis style, press the ‘Switch to Separate Graph’
button.
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Displaying Multiple Measures on a Single 
Axis

By default, when you add two or more measure fields on the Y-axis, the
selected datasets are plotted on adjacent sets of axes, as shown below:

In some cases you may want to display the measures on the same axis. To
do this, press the ‘Switch to Single Graph’ button in the Data panel of the
Chart Editor. 

This fits both datasets on the same set of axes. If the single axis is not
appropriate for both measures, for example when one measure has much
larger values than the other, you can create a secondary Y-axis on the right
side of the chart. See Creating a Dual-Axis Chart.
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Displaying Multiple Chart Styles on a Single 
Axis

To set the chart style for an individual dataset on a multi-dataset chart,
follow the steps below:

Note: The ‘Auto’
chart type automati-
cally selects an appro-
priate chart type for
the provided data.

1. In the Data panel of the Chart Editor, press the ‘Select Chart Type’
button. This opens the chart styles panel.

2. In the chart styles panel, enable the ‘Multiple Styles’ option (below
the chart style options), and press ‘Apply’.

3. Press the ‘Select Chart Type’ button next to dataset you wish to
change. 

This opens the chart styles panel for the specified dataset.
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Note: Only certain compatible style combinations can be selected
(e.g., Pie style and Line style are incompatible).

4. Click a chart type to select it, and then press the ‘Apply’ button.
(You can also double-click the desired chart type.) 
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Creating a Grid of Charts

In some cases you may want to create a grid of charts, such as that below,
where different charts represent different values of a particular dimension
(here ‘Region’ and ‘Category’).

To create a grid of charts, simply add dimensions into the ‘X’ and ‘Y’
regions to create the desired arrangement. For example, to break out the
‘Region’ dimension on the X-axis and the ‘Category’ dimension on the Y-
axis, place these fields as shown below:
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Adding a Table

To create and format a table, follow the steps below:

1. If necessary, create a new dashboard. See Creating a New
Dashboard.

2. Add a new table using one of the following approaches:

a. Expand the data source node at the top of the Component
panel. Drag an entire data block into the grid. This adds the data
block as a new table.

b. Alternatively, drag a Table component from Component panel
into the grid to create a blank table. 

Then drag individual columns from a data block into the table.
The green highlight shows you where each column will be
placed.
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3. Click the table to select it. Drag the bottom border of the table to
display more rows.

4. Right-click the table and select ‘Properties’ from the context menu.
This opens the ‘Table Properties’ dialog box. In the ‘Table Styles’
panel of the General tab, select a table style. Press ‘OK’.

This applies a global style to the table, including fonts, background
colors, foreground colors, and borders.
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5. Drag the column borders as necessary to resize the columns. 

6. To align a column header, click the column header to select it
(Shift-click or Ctrl-click to select multiple columns). Then press the
desired alignment button in the toolbar to align the header text.

7. To align the data values in a column, select any cell in the column
and press the desired alignment button in the toolbar to align the
text.

8. To format a column’s data as currency, select any cell in the column
and press the ‘Currency Style ($)’ button in the toolbar. This
formats the column as currency. 
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See Format Dialog
Box in Advanced
Dashboard Design for
more information
about formatting.

9. To format a column’s data as dates, follow the steps below:

a. Right-click on any data cell in the column and select ‘Format’
from the context menu. This opens the ‘Format’ dialog box.

b. In the ‘Format’ dialog box, under the Format tab, select the
‘Date’ option. Select a date code from the menu or enter your
own. (For example, the code MM/dd/yyyy indicates that dates
should be displayed with a two-digit month, two-digit day, and
four-digit year.)

c. Press ‘OK’ to close the dialog box.

10. To change the order of the columns, click and drag on a column
header and drop the column into the desired position. A green
highlight indicates the drop position.
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For complete information about creating tables, see Tables in Advanced
Dashboard Design.
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Adding a Crosstab

To add a crosstab to a dashboard, follow the steps below:

1. If necessary, create a new dashboard. See Creating a New
Dashboard.

2. Drag the Crosstab element from the Component panel into the
grid. 

This opens the Crosstab Editor. 

3. If the Editor is not open, move the mouse over the top right corner
of the crosstab, and press the ‘Edit’ button to open the Editor.

4. In the Data Source panel, expand a data block to display the
available dimensions and measures.
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5. Drag the desired columns or cube dimensions into the ‘Column
Headers’ and ‘Row Headers’ regions. 

You can change the
order of multiple
dimensions or mea-
sures by dragging
them up or down in
the Editor.

6. Drag the desired columns or cube measures into the region labeled
‘Measures’.

7. (Optional) Specify group totals and ranking:

a. Click on a row header or column header. This activates the
‘Sort’, ‘Ranking’, and ‘Group Total’ controls.
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b. In the ‘Sort’ menu, specify how the values in the field should be
ordered. ‘Ascending’ and ‘Descending’ sort the values in
alphabetical or reverse-alphabetical order. ‘By Value (Asc)’ and
‘By Value (Desc)’ sort the values according to the aggregate
measure selected in the adjacent menu. 

To specify an arbitrary sort order, select the ‘Manual’ option in
the ‘Sort’ menu, and press the ‘Edit’ button to open the ‘Manual
Ordering’ dialog box. To reorder an item in the ‘Manual
Ordering’ dialog box, drag the item up or down within the list or
select the item and press the ‘Up’ or ‘Down’ buttons. Press
‘OK’ to close the dialog box.

c. In the ‘Ranking’ menu, select the ‘Top’ or ‘Bottom’ filter, and
specify the (integer) number of top or bottom groups to select.
In the adjacent menu, specify the measure by which groups
should be ranked. 

Select ‘Group all others together’ to create an “Others” category
which represents (in aggregate) all the groups excluded by the
Top/Bottom ranking filter.

d. In the ‘Group Total’ menu, specify whether group totals should
be shown.

8. Click on a measure, and select the summarization method from the
‘Aggregate’ menu. 
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To display a bivariate aggregation measure (e.g., ‘Correlation’,
‘Weighted Average’, etc.), select the second operand (column)
from the ‘with’ menu. 

9. (Optional) Set any desired percentage options:

a. To display a univariate measure (‘Sum’, ‘Count’, etc.) as a
percentage, select the basis for percentage in the ‘Percentage of’
menu. 

b. If you choose a percentage representation, click the ‘Options’
button (at the top of the dialog box) to select the dimension
along which the percentage is computed (‘Rows’ or
‘Columns’). Percentage by rows uses the row totals, and by
columns uses the column totals.

10. Press the green ‘Apply’ button to close the Crosstab Editor.

11. If desired, expand the crosstab horizontally so that all of the column
headers are visible.
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For complete information about creating crosstabs, see Crosstabs in
Advanced Dashboard Design.
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Adding a Map

To add a map to a dashboard, first drag the Chart component from the
Component panel into the grid. (See Adding a Chart.) 

To bind the chart to geographical data, follow the steps below:

1. Click on the center of the chart, or click the ‘Edit’ button in the top-
right corner. This opens the Chart Editor on the left side of the
Visual Composer.

2. In the Chart Editor’s Data panel, press the ‘Select Chart Style’
button, and choose the ‘Map’ chart type. Press the ‘Apply’ button
(or double-click the ‘Map’ icon).

The Data panel now provides a ‘Geographic’ field.

If your columns con-
tain longitude and lat-
itude data (in decimal
format) rather than
location names, use
the ‘Longitude’ and
‘Latitude’ fields of the
‘Data’ panel.

3. Mark the dimensions you want to use on the map as geographical
fields. To mark a field as geographical, follow the steps below:

a. Right-click the field in the tree, and select ‘Set Geographic’
from the context menu. This places a “compass” icon next to the
field name, and may also open the geographical level editor.
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To open the level editor if it does not open automatically, right-
click the field name, and select ‘Edit Geographic’ from the
context menu.

The map that you
select for a geo-
graphic field applies
to all other geographi-
cal fields.

b. In the level editor, select the desired region from the ‘Map’
menu: Asia, Canada, Europe, Mexico, U.S., or World. 

c. From the ‘Layer’ menu, select the geographical layer that
corresponds to the data in the selected field. 

This specifies the layer of the geographical database against
which field values should be matched (e.g., city names should
be matched against the city layer, etc.). The options available in
the ‘Layer’ menu depend on the previously selected ‘Map’
option.

d. From the ‘Mapping’ menu, select the desired map database. 

The Chart Editor attempts to resolve values in the selected
geographic field against the corresponding layer in the map
database. If all data values are successfully matched, a green
check mark is displayed. If some data values cannot be
matched, a red question mark is displayed.

e. To resolve any unmatched names, press the red question mark.
This opens the ‘Geographical Mapping’ dialog box, which
allows you to manually match place names. Make any required
matches and press the ‘Apply’ button.

f. To modify the settings for an existing geographical field, right
click the field, and select ‘Edit Geographic’ from the context
menu. This opens the geographical level editor described above.
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To remove the geographical status of a field, right click the
field, and select ‘Clear Geographic’ from the context menu.

4. From the Data Source panel in the Chart Editor, drag a geographic
dimension onto the ‘Geographic’ field in the Data panel. 

The chart updates to display the locations contained in the
geographic field.

5. Repeat the previous step to bind additional ‘Geographic’ levels.
For example, you can bind ‘City’ and ‘State’ fields.

6. From the Data Source panel, drag a measure onto one of the fields
in the Visual panel (‘Color’, ‘Shape’, ‘Size’, or ‘Text’). 
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This displays the measure on the chart using the visual coding you
selected (color, shape, or size), and automatically creates a
corresponding legend. 

7. Press the ‘Edit Measure’ button, and select the desired aggregation
method for the measure.

8. (Optional) For any geographical fields that you specified, press the
‘Edit Dimension’ button, and select the desired ranking for the
geographical data. For example, you can display just the top three
states according to the measure.

9. (Optional) To create a particular trajectory through the points on
the chart, drag a path field to the ‘P’ region. The values of this field
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are used to assign the sort order for the plotted data so that
connecting lines are drawn between points that are adjacent in the
path sort order.

10. (Optional) Set the initial map view by selecting a region, and
pressing the ‘Zoom’ button.

For complete information about creating maps, see Map Charts in
Advanced Dashboard Design.
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Adding a Filter (Selection)

To allow a user to filter the data displayed in the dashboard, add Selection
components. A Selection component automatically filters the data in all
tables, charts, and output components that are based on the same data
block. 

To add a Selection component, follow the steps below:

1. If necessary, create a new dashboard. See Creating a New
Dashboard.

2. In the Component panel, expand the data block that contains the
field you want to filter.

3. Drag the field you want to filter to an empty region in the grid. For
a string-type field, this creates a Selection List. 
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For a date-type or numerical-type field, this creates a range slider. 

To filter dates more precisely, use a Calendar component. See
Calendar in Advanced Dashboard Design for details.

4. Resize the Selection elements as desired.

5. To display multiple columns in a Selection List, click any data cell
to select it. Then drag the handle on the right side of the cell to
change the cell size. (Hint: You may need to wait a second for the
scroll bar to fade before you can grab the handle.)
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See Filter Components in Advanced Dashboard Design for full
information about Selection components. See Filtering a Dashboard for
information on how to use Selection Components to filter the dashboard.
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Adding a Gauge

A Gauge component allows you to prominently display a single aggregated
value, for example, a grand total. To add an Gauge component, follow the
steps below:

1. If necessary, create a new dashboard. See Creating a New
Dashboard.

2. From the Component panel, drag the Gauge component onto the
Viewsheet grid. 

3. From the Component panel, drag a data block measure onto the
Gauge component. (A green outline informs you when you can
drop the field.)

This binds the measure to the Gauge component so that the
component displays the aggregated value of the measure.
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4. Right-click on the Gauge component, and select ‘Properties’ from
the context menu. This opens the ‘Properties’ dialog box.

5. Select the General tab of the ‘Properties’ dialog box, and choose a
desired gauge face. Press ‘OK’.

6. Enlarge the component as desired by dragging on any of the
component borders.

See Output Components in Advanced Dashboard Design for full
information about Gauges.
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Adding a Form Component

A Form component allows the user to dynamically control properties of
other components. In this example, you will use a Form component to
allow the user to change the measure displayed on a chart. 

A Form component
can also pass a value
to the underlying data
set. (See Form Com-
ponents in Advanced
Dashboard Design for
more information.)

To add a Form component, follow the steps below:

1. If necessary, create a new dashboard. See Creating a New
Dashboard.

2. From the Component panel, drag a RadioButton component into
the grid.

3. From the Component panel, drag a data block measure onto the
RadioButton. (Look for the green highlight that indicates the drop
zone.)

This adds the field name as an option in the RadioButton.
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4. Repeat the above step to add other field names as additional
options.

5. Resize the RadioButton as desired.

6. Right-click the RadioButton and select ‘Properties’ from the
context menu. This open the ‘RadioButton Properties’ dialog box.

7. Set the ‘Name’ property to describe the role of the Form
component (e.g., “MeasureChoice”). Set the ‘Title’ property as
desired. Press ‘OK’.

The ‘Name’ is a unique component ID. (You will need to refer to
the RadioButton by its name in a later step.) The ‘Title’ is simply
the text that appears in the title bar of the component.

To configure a Chart so that the RadioButton controls the measure
displayed on the Chart Y-axis, continue with the steps below. See Adding a
Chart for information about how to create a chart.

8. Drag a Chart component from the Component panel into the grid.
This opens the Chart Editor. (If the Chart Editor does not open,
press the ‘Edit’ button at the top-right corner of the chart.)
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Many dashboard properties can be controlled by Form components in
the same manner.

9. In the Chart Editor, add the desired fields to the X axis and Y axis
of the chart.

10. Expand the pop-up menu next to the field on the ‘Y’ axis, and
select ‘Variable’. The ‘Variable’ option allows the property to be
set by a Form component.

11. Select the name of the desired Form control from the menu. 

By selecting the name of a Form control, you are specifying that
the value the user chooses in the Form control will determine the
field that is displayed on the chart Y-axis.

12. Use the Form control to toggle between the different field names
and observe how the chart Y-axis adapts to display the
corresponding measure.

See Form Components in Advanced Dashboard Design for full
information about inputs.
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Adding Decoration

The following sections explain how you can use images, text, and shapes to
enhance the appearance of your dashboard.

Adding Decoration with Images
To add images to the dashboard, follow the steps below:

1. If necessary, create a new dashboard. See Creating a New
Dashboard.

2. From the Component panel, drag an Image component into an
empty area of the grid. In this example, the image will be used as a
background.

3. Right-click on the Image component, and select ‘Properties’ from
the context menu. This opens the ‘Image Properties’ dialog box.

4. Under the General tab, expand the ‘Skin’ folder and select the
desired skin, or press ‘Upload’ to upload your own image file to the
server.
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5. Select the Advanced tab.

6. (Optional) Check the ‘Scale Image’ box, and select either
‘Maintain Aspect Ratio’ or ‘Scale (9-Cell Grid)’ option. The
‘Maintain Aspect Ratio’ option keeps the original image
proportions as the image is scaled. The ‘Scale (9-Cell Grid)’ allows
the interior of the image to scale without scaling the border around
the image. 

When using the default skins, select ‘Scale (9-Cell Grid)’ and enter
“1” in each of the ‘Top’, ‘Right’, ‘Bottom’, and ‘Left’ fields.
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7. Press ‘OK’ to close the dialog box.

8. (Optional) If you are using the image as a background, drag the
borders of the Image component to resize the image so that it is
large enough to provide a background for the dashboard.

9. (Optional) If the image should be placed behind the other
components, right-click on the Image component and select ‘Send
to Back’. 
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See Image in Advanced Dashboard Design for full information about this
component.

Adding Decoration with Text
To add text to the dashboard, follow the steps below:

1. If necessary, create a new dashboard. See Creating a New
Dashboard.

2. From the Component panel, drag a Text component into the
Viewsheet. (If you see the following ‘Layout Option’ dialog box,
select ‘Move component here’ and press ‘OK’.)

3. Double-click on the Text component to edit the text.
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4. Use the toolbar buttons to adjust the appearance of the text.

See Text in Advanced Dashboard Design for full information about this
component.

Adding Decoration with Shapes
To add shapes to the dashboard, follow the steps below:

1. If necessary, create a new dashboard. See Creating a New
Dashboard.

2. From the Component panel, drag a Rectangle component or other
shape to an empty area of the Viewsheet grid.

3. Right-click the shape component and select ‘Properties’ from the
context menu. This opens the shape’s ‘Properties’ dialog box.
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4. (Optional) Select the Shape tab. For a rectangle, set the ‘Round
Corner’ property to soften the corners of the rectangle if desired.
(Larger values indicate softer corners.)

5. Drag to move and resize the shape to the appropriate dimensions. 

6. (Optional) If you are using the shape as a background, right-click
the shape and select ‘Send to Back’ from the context menu. If the
shape disappears behind other components, then repeat the same
procedure to send those components to the back as well.

See Shape Components in Advanced Dashboard Design for full
information about these components.
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Previewing a Dashboard

Although a dashboard is fully functional in design view, sometimes it is
useful to preview the dashboard exactly as users will see it. To preview the
dashboard, press the ‘Preview’ button on the toolbar.



CREATING DASHBOARDS

90 of 2639

Saving a Dashboard

To save a dashboard, press the ‘Save’ button in the toolbar. The dashboard
is saved under the name you previously assigned.
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Using the Portal

The Portal provides features for creating, accessing, and managing folders
dashboards, data sets, and database connections. The Portal is a web-based
interface, so you do not need to install any special software on your
computer. The following sections explain the different features available in
the Portal.
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Launching the Portal

Your administrator may have provided you with a link or URL to access
the User Portal on a remote server. In this case, proceed to log in as
described in Logging into the Portal.

If you are running Style Scope Agile Edition on your own machine, follow
the steps below:

1. Select ‘Start InetSoft Style Scope’ from the ‘Style Scope Agile
Edition’ program group in the Windows Start menu. This opens
the User Portal in a browser.

Note: On Windows 8, you can find the ‘Start InetSoft Style Scope’
link under ‘Style Scope Agile Edition’ on the Windows Apps
screen.

2. Proceed to log in as described in Logging into the Portal.

Note: The first time you launch the Portal, you will be asked to enter the
license key that was provided to you by InetSoft.

You will then be asked to create an administrator username and password.
If you are using the free version of Style Scope Agile Edition, the
administrator username is preset to “admin” and cannot be changed.
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After you have entered the information, press ‘Continue’ to proceed. See
Logging into the Portal.
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Logging into the Portal

On the login screen, enter your username and password in the provided
‘User’ and ‘Password’ fields and press ‘Sign in’. 

If you do not see the login screen, this means you are logged in as an
anonymous guest user and can only view dashboards. To log in with your
username, press the ‘Log in’ link at the top right.

The first time you access the Portal, you will see the ‘Getting Started’
wizard. See Getting Started for more information about using the wizard.

When you log into the Portal using the free version of Style Scope Agile
Edition, the logged-in username is always “admin”. To use the Portal as
“guest”, simply press the ‘Log out’ link at the top right of the Portal.

In the free version of Style Scope Agile Edition, the “admin” user has full
access to all Portal features, while the “guest” user can only view
dashboards. The free version does not support creation of additional users.
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Portal Functions

Select the desired Portal tab for the features you want to access.

The following tabs are available.

Note: A “guest” user has access only to the Dashboard tab. The “guest”
user can view dashboards, but cannot rename, move, or edit dashboards.

TAB FUNCTION

Dashboards Access your dashboards. See Visualizing with Dashboards 
for more information.

Data Connect to your data source. See Connecting to Your Data 
for more information.

Schedule Schedule dashboards to be generated and emailed 
automatically. See Scheduling a Dashboard for more details.

Administration Administer the Style Scope server. See Managing the Server 
for more information.
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Opening a Dashboard or Folder

To open a dashboard or a folder, first select the Dashboards tab at the top
of the Portal.

To view the contents of a folder, click on the folder. 

To open a dashboard, click on the dashboard.

For information on how to explore your data with the dashboard, see
Visualizing with Dashboards.
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Creating a New Folder

The free version of Style Scope Agile Edition does not allow a
“guest” user to create folders.

To create a new folder in the Portal, follow the steps below:

1. Navigate to the location in which you want to create the new folder.
See Opening a Dashboard or Folder for information on opening a
folder.

2. Press the arrow button at the right side of the navigation bar, and
select ‘New Folder’.

3. Enter a name for the new folder and press ‘OK’.

This creates a new folder with the specified name.
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Renaming an Asset

The free version of Style Scope Agile Edition does not allow a
“guest” user to rename assets.

To rename a folder, dashboard, or data set, follow the steps below:

1. Select ‘Rename’ from the asset’s pop-up menu.

2. Enter a new name and press ‘OK’.
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Moving an Asset

The free version of Style Scope Agile Edition does not allow a
“guest” user to move assets.

To move a folder, dashboard, or data set to a different location, follow the
steps below:

1. Select ‘Move’ from the asset’s pop-up menu.

2. Select a new location. To expand a folder, press the arrow button at
the right side. 

3. Press ‘OK’.
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Deleting an Asset

The free version of Style Scope Agile Edition does not allow a
“guest” user to delete assets.

To delete an existing folder, dashboard, or data set, follow the steps below:

1. Select ‘Delete’ from the asset’s pop-up menu.

2. Press ‘OK’.
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Recovering a Deleted Asset

The free version of Style Scope Agile Edition does not allow a
“guest” user to recover assets.

If you need to recover a dashboard, folder, or data set that you have
previously deleted, follow the steps below:

To restore the entire
system to an earlier
state, see Restoring
from Backup.

1. Press the arrow button at the right side of the navigation bar, and
select ‘Open Recycle Bin’.

2. Press the ‘Restore’ button next to the item that you want to recover.

This returns the item to the folder from which it was deleted.
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Deleting an Asset Permanently

The free version of Style Scope Agile Edition does not allow a
“guest” user to delete assets.

To permanently remove a folder, dashboard, or data set from the system,
follow the steps below:

1. Press the arrow button at the right side of the navigation bar, and
select ‘Open Recycle Bin’.

2. Press the ‘Delete’ button next to the item that you want to
permanently remove.
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Editing an Existing Dashboard

The free version of Style Scope Agile Edition does not allow a
“guest” user to edit dashboards.

To make modifications to an existing dashboard, select ‘Edit’ from the
dashboard’s pop-up menu.

This opens the dashboard for editing. See Creating a Dashboard for
information on how to add and modify components such as charts, tables,
and filters.

If you do not see the ‘Edit’ option, this means that you do not have
permission to edit the dashboard. Consult your administrator.
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Refreshing Data in a Dashboard

The free version of Style Scope Agile Edition does not allow a
“guest” user to adjust caching.

Dashboards take advantage a high-performance caching strategy to
improve dashboard performance. The data displayed by the dashboard
reflects the most recently cached result set.

To force an immediate update of the cached data or to set a new update
schedule, follow the steps below:

1. Select ‘Data Caching’ from the dashboard’s pop-up button.

This opens the ‘Data Caching’ screen.

2. Select ‘Enable data caching’.

3. Select the desired refresh schedule (1 hour, 6 hours, or 24 hours).

4. (Optional) Select ‘Rebuild data cache now’ to perform an
immediate cache refresh.

5. Press ‘OK’.
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Scheduling a Dashboard 

Note: Email must be configured in order to use the Schedule
features. The free version of Style Scope Agile Edition does not
allow a “guest” user to schedule dashboards.

To schedule a dashboard for automatic generation and delivery, follow the
steps below:

1. Select the Schedule tab in the Portal.

2. Press the ‘New Schedule’ button. 

This opens the Schedule page.
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3. Enter information to define the scheduled task:

a. From the ‘Dashboard’ menu, select the dashboard you want to
schedule for automatic generation.

b. From the ‘Bookmark’ menu, select a bookmark for the
dashboard that you want to generate. (A bookmark stores
particular dashboard settings. The selected bookmark’s settings
will be used when the dashboard is automatically generated. See
Bookmarking a Dashboard for more information.)

c. From the ‘Start Time’ menu select the start time for the task.

d. From the ‘Type’ menu, select the ‘Daily’, ‘Weekdays’,
‘Weekly’, or ‘Monthly’ option, and enter the required time
parameters.
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e. In the ‘Recipients’ field, enter a comma-separated list of email
addresses to which the dashboard should be delivered. 

f. In the ‘Subject’ field, enter a subject for the email.

g. In the ‘Attachment Type’ menu, select the format in which the
dashboard should be delivered. 

h. In the ‘Message’ field, enter the text that you want to be
transmitted as the email content.

4. Press ‘OK’ to save the task.

The new task will be shown on the table under the Schedule tab in the
portal. To make modifications to a scheduled task, see Managing
Scheduled Tasks for more information.
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Managing Scheduled Tasks

The free version of Style Scope Agile Edition does not allow a
“guest” user to schedule dashboards.

You can view and monitor all of your scheduled tasks from the Schedule
tab. 

To edit an existing scheduled task, press the ‘Edit’ button next to the task.
See Scheduling a Dashboard for information about the scheduled task
settings.

To delete a scheduled task, press the ‘Delete’ button next to the task.
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Visualizing with 
Dashboards

The following sections explain the basics of visualizing data with
dashboards.
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Interacting with Dashboards

The following sections discuss basic aspects of interacting with
dashboards, including filtering with Selection List and Calendar
components.

Opening a Dashboard
To open a dashboard, select the Dashboard tab and click on the desired
dashboard. See Opening a Dashboard or Folder for more information.

Using the Dashboard Toolbar
The dashboard toolbar has the following buttons:

Previous: Undoes the most recent action.

Next: Restores the most recent action that was undone.

Refresh: Updates the dashboard with the most current data, bookmarks,
and script results. 

Email: Sends an export of the dashboard to another person. See Emailing a
Dashboard for more information.

Print: Prints the dashboard on any available printer.

Export: Exports a copy of the dashboard to Excel, PowerPoint, or PDF
format. See Exporting a Dashboard for detailed instructions.

Bookmark: Opens the ‘Bookmark’ menu, which allows you to save a
bookmark or load a previously-saved bookmark. See Bookmarking a
Dashboard for more details.

Annotation: Toggles annotations on and off. See Annotating a Dashboard
for more details.

Filtering a Dashboard
Selection components allow you to filter the data that is displayed in the
dashboard and create custom views of the dataset. The following example
illustrates how to use the Selection Lists in the sample ‘Death Causes’
dashboard. 
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1. Select the Dashboard tab at the top of the Portal. Click the
‘Examples’ folder to open it.

2. Click on the ‘Death Causes’ dashboard to open it for viewing.

3. In the ‘Cause of Death’ selection tree, expand the ‘Mental’ entry
and select ‘Intentional self-harm’. Then expand the ‘Neurological’
item and select ‘Alzheimer’s disease’.

Observe how the Selection Tree filters the data in the chart, and
note that the ‘Age’ selection list now shows some items with
marked with green squares (e.g., ‘05-14 years’, ‘15-24 years’, etc.).
All of these age groups include individuals who died from the
selected causes. 

4. Click the ‘+ Others’ symbol. Note that two items are shown with a
gray ‘X’.

These age groups do not include any deaths from the selected
conditions. 

5. Filter the results further based on age. Select ‘05-14 years’ in the
‘Age’ list. 
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6. When you make this selection in the ‘Age’ selection list, the ‘Cause
of Death’ selection tree automatically updates.

Note the following features of the ‘Cause of Death’ selection list:

a. ‘Intentional self-harm’ is shown with a green check mark. This
indicates that you explicitly selected ‘Intentional self-harm’ and
deaths due to intentional self-harm were returned in the result
set.

b. ‘Alzheimer’s disease’ is shown with a gray check mark. This
indicates that you explicitly selected this cause of death but
nevertheless deaths due to Alzheimer’s are not included in the
result set. This is because you subsequently selected the age
group ‘05-14 years’. Since there are no deaths due to
Alzheimer’s disease in this group, the ‘Alzheimer’s’ selection is
ignored.

c. Many of the causes of death are shown with empty boxes beside
them. This indicates that records for these causes are not
currently included in the result set, but these choices are
compatible with your other selections. You can select these
choices to widen your result set.

d. One cause, ‘Parasitic’, is listed under the ‘+ Others’ others label.
This indicates that this cause of death is not compatible with
your other selections. In particular, no deaths in the 5-14 year
age group were attributed to a ‘Parasitic’ condition.

7. Expand the ‘+ Others’ node in the ‘Cause of Death’ selection list.
Select ‘Parasitic’. 
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Note that this resets the ‘Age’ selection list. Whenever you make a
selection from an ‘Others’ list, this resets any incompatible selec-
tions in other lists. 

For more information about the different icons in Selection Lists, see
Selection Lists.

Closing a Dashboard
To close a dashboard, press the red ‘X’ in the toolbar. 

When you close a dashboard, you will be prompted to save your current
settings (filter selections, menu choices, annotations, etc.) in a bookmark.
See Bookmarking a Dashboard for more details.

Using a Dashboard on a Mobile Device
Note: You can also install a native app for iOS or Android, and
connect to http://hostname:35100/mobile. Ask your administrator for
details.

You can access dashboards on a mobile device (iPad, Android, etc.) in the
same way that you access dashboards on a personal computer. To open the
Portal, point your browser to http://localhost:35100.
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On iOS and Android devices, the dashboard interface is slightly modified
to take advantage of features on these platforms. Component toolbars are
displayed as a floating toolbars. Simply tap on the desired dashboard
component to expand the component’s toolbar. For example, the
illustration below shows the Chart menu as it appears on a PC and an iPad.

To activate tooltips for a Chart, press the ‘Tooltip’ toolbar button. To
activate multiple-selection (similar to Ctrl-click on a PC), press the
‘Multiselect’ toolbar button. To activate a hyperlink, press and hold the
hyperlinked region.

To activate multiple-
selection (similar to
Ctrl-click on a PC),
press the ‘Multise-
lect’ toolbar button.

The illustration below shows the difference between the Selection List
menu on a PC and an iPad.
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Aside from the different appearance of the component toolbars, dashboards
on mobile devices have certain limitations as far as component behavior:

• Dashboards cannot be edited.

• The Chart Editor is not available for making modifications to a Chart
binding.

• The Crosstab Editor is not available for making modifications to a
Crosstab binding.

• The Chart ‘Format’ and ‘Properties’ dialog boxes are not available.

• The Chart right-click menu options (‘Hide Legend’, etc.) are not
available.

Keyboard Navigation 
There are several different techniques by which you can navigate a
dashboard using the keyboard (or equivalent voice commands). The table
below lists these essential techniques.

OPERATION TECHNIQUE

Move focus from one component to another Press ‘Tab’ or ‘Shift-Tab’

Move focus within a component (e.g., from 
Range Slider handle to Range Slider body)

Press ‘Up-arrow’ or ‘Down-
arrow’

Adjust a component setting (e.g., adjust 
Range Slider range)

Press ‘Left-arrow’ or ‘Right-
arrow’

Make a selection (e.g., choose an item in a 
Selection List)

Press ‘Space bar’

Move focus within component toolbar Press ‘Left-arrow’ or ‘Right-
arrow’

Move focus from component body to 
component toolbar

Press ‘Up-arrow’ (repeatedly, if 
necessary)

Move focus from component toolbar to 
component body

Press ‘Down-arrow’ 
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Interacting with Charts

Charts offer several interactive features including brushing, zooming, and
filtering. The following sections introduce these features.

Brushing a Chart
Brushing is a powerful tool that helps you to quickly detect and understand
relationships your data. Consider the following charts. (See Adding a Chart
for instructions on how to create a chart.)

Use brushing to answer the following question: “In what month did
salesperson Sue Marston have peak sales?”

1. Double-click the ‘Marston’ label in the legend to brush Sue
Marston’s sales in both charts.
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It is now obvious that Marston’s greatest sales month was April of
2013, when she sold over $400,000.

2. Press the ‘Clear Brushing’ button to return to the normal view.

Overall sales were high in August 2014. Use brushing to answer the
following question: “Which state saw the greatest sales during this
month?”

1. In the second chart, click to select the data point for August 2014.
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2. Press the ‘Brush’ button on the chart toolbar to highlight all the
data corresponding to this month.

It is clear that Texas had the majority of sales in August 2014.

A majority of Sue Marston’s sales are in New Jersey and New York. Use
brushing answer the following question: “During which month were
Marston’s combined sales in NJ and NY the greatest?”

1. In the first chart, Ctrl-click to select Marston’s sales both in NJ and
NY.

2. Press the ‘Brush’ button on the chart toolbar to highlight all of
Marston’s sales corresponding to these states.
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It is clear that Marston’s sales in NJ and NY reached a peak in June
2012.

See Also
Brushing a Chart, in Advanced Dashboard Design, for further details
about brushing.

Zooming a Chart
To zoom in on a particular region of a chart, follow the steps below:

See Selecting Chart
Data in Advanced
Dashboard Design for
more about data selec-
tion.

1. Select the data on the chart that you wish to zoom. (Ctrl-click or
drag across multiple groups to select them.)

2. Press the ‘Zoom’ button in the toolbar. This zooms the chart to
display only the data selected.

3. Repeat the above steps to zoom in further. 

4. To return to the original chart view, press the ‘Clear Zoom’ button.
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The Zoom feature allows you focus in on a selected set of groups by
specifying the groups to include in the zoomed view. In some cases,
however, you might find it easier to create the desired view by specifying
particular groups to exclude from the zoomed view.

To exclude particular groups from a chart display, follow the steps below:

1. Select the data on the chart that you wish to exclude from the
zoomed view. (Ctrl-click or drag across multiple groups to select
them.)

2. Press the ‘Exclude Data’ button in the toolbar. This removes the
selected data from the chart.

3. Repeat the above steps to exclude further data. 

4. To return to the original chart view, press the ‘Clear Zoom’ button.
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Sorting a Chart
To sort chart groups based on a measure, hover the mouse over the desired
measure axis. This displays the ‘Sort’ button next to the axis. Click the
button once to sort the groups in ascending order by measure value, click a
second time to sort in descending order by measure value, and click a third
time to restore the original order.

When multiple dimensions are represented on the chart (as in the image
above), the ‘Sort’ button operates on the innermost dimension. 

Adding a Target Line
A target line is a horizontal or vertical line drawn on the chart that denotes
an ideal value (goal or threshold) or representative value (average,
minimum, etc.). A target band is a horizontal or vertical band drawn on
the chart that denotes either an ideal range (e.g., goal zone) or
representative range (e.g., span of maximum to minimum). A statistical
measure is a line or region drawn on the chart to represent one or more
statistical quantities derived from the data (confidence intervals,
percentiles, etc.).
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To create or edit a target line, target band, or statistical measure on a Chart,
right-click on the Chart and select ‘Properties’. This opens the ‘Chart
Properties’ dialog box.

To create a new target line, band, or statistical measure, press ‘Add’. To edit
an existing target line, band, or statistical measure, select the desired target
and press ‘Edit’.

For full information about these chart features, see Adding a Target Line,
Adding a Target Band, and Adding a Statistical Measure in Advanced
Dashboard Design.

Filtering a Chart
The easiest way to filter a chart is by using Selection components. (See
Filtering a Dashboard for more information.) However, you can also filter
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a chart by using the right-click ‘Filter’ option. To do this, follow the steps
below:

The ‘Filter’ option is only available if the dashboard contains a
Selection Container component.

1. Right-click on the label or measure that you want to filter and select
‘Filter’ from the context menu.

This opens the filtering control for the selected dimension or mea-
sure: Selection List for a string-type field, Range Slider for a
numerical-type or date-type field. 

A Range Slider that filters a measure operates on the post-
aggregate data displayed in the chart.

2. Make the desired selection using the selection control, and click
away to submit. (See Selection Lists and Range Sliders for
information on how to use these controls.)

The selections that you make are shown in the Selection Container.
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To remove the filter from a particular field, follow the steps above, and
press the ‘Clear Selection’ button on the selection control.

To remove all filters on the chart, press the ‘Clear Selections’ button in the
Selection Container.

See Also
Filtering a Table, for instructions how to filter the aggregated data in a
Crosstab or Freehand Table.
Selection Container, for more information about the Selection Container
component.
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Interacting with Tables

Tables can display a large amount of data in text format. The following
sections explain some of the more common table features.

See Also
Tables, in Advanced Dashboard Design, for more detailed information.

Sorting a Table
Note: Sorting actions
for certain tables may
be administratively
restricted.

To sort a table column or crosstab column, hover the mouse over the right
side of header or data cell and press the ‘Sort Column’ button. 

Press the button once to sort in ascending (alphabetical) order.

Press the button a second time to sort in descending (reverse-alphabetical)
order.

Press the button a third time to restore the original order.

Hover the mouse over a cell to display the current sort order for the field.
An up-arrow means “ascending”. A down-arrow means “descending”. An
up-arrow or down-arrow accompanied by a sigma indicates that the field is
sorted by aggregate value. For example, if you sort an aggregated field in
ascending order, the sort indicator for the dimension shows that it is sorted
in ascending order by the aggregate value.
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Filtering a Table
The easiest way to filter a table is by using Selection components. (See
Filtering a Dashboard for more information.) However, you can also filter
a table by using the right-click ‘Filter’ option. To do this, follow the steps
below:

The ‘Filter’ option is only available if the dashboard contains a
Selection Container component.

1. Right-click on the column that you want to filter and select ‘Filter’
from the context menu.

This opens the filtering control for the column: Selection List for a
string-type column, Range Slider for a numerical-type or date-type
column. 

For a Crosstab or Freehand Table with aggregation, a Range Slider
filters the post-aggregate data.

2. Make the desired selection using the selection control, and click
away from the column to submit. (See Selection Lists and Range
Sliders for information on how to use these controls.)

The selections that you make are shown in the Selection Container.
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To remove the filter from a particular column, follow the steps above, and
press the ‘Clear Selection’ button on the selection control.

To remove all filters on the table, press the ‘Clear Selections’ button in the
Selection Container.

See Also
Filtering a Chart, for instructions how to filter the aggregated data in a
chart.
Selection Container, for more information about the Selection Container
component.

Exporting a Table
To export the data in a Table or Crosstab to Excel, press the ‘Export’ button
in the table title bar.

Modifying an Embedded Table
A regular dashboard table does not allow you to modify the data in the
table cells. However, an Embedded Table does allow you to modify data in
table cells.
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An Embedded Table in a dashboard is a table that is based on an Embedded
Table in the underlying Worksheet. Data that you enter into an Embedded
Table is automatically passed to the corresponding Embedded Table in the
Worksheet.

To enter data into an Embedded Table, simply type values into the desired
cells.

Data that you enter is stored with the current bookmark. Therefore, to save
the data that you enter, you must save the current bookmark (or create a
new bookmark). See Bookmarking a Dashboard for more information.
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Interacting with Crosstabs

A Crosstab (also called a pivot table) is the tabular equivalent of a chart,
displaying aggregated data along one or more dimensions. The following
sections explain some basic features of Crosstabs.

See Also
Crosstabs, in Advanced Dashboard Design, for more detailed information.

Drilling Down in Crosstab Data
To drill-down into the data in a Crosstab table, follow the steps below:

1. Select the aggregated data into which you want to drill. (You can
select data in a Crosstab by clicking to select individual cells, Shift-
clicking to select contiguous ranges of cells, and Ctrl-clicking to
select discontiguous ranges of cells.)

2. Press the ‘Show Details’ button in the title bar.

This displays the detail data in a panel at the bottom of the screen.
You can continue to select different cells without clicking ‘Show
Details’ again.

3. To export the data to Excel, press the ‘Export’ button at the top
right.

Editing a Crosstab
Press the ‘Edit’ button in the Crosstab title bar to open the Crosstab Editor
to modify the table. 
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See Adding a Crosstab for more information about how to use the Editor. If
the ‘Edit’ button is not visible in the title bar, this means that the Crosstab is
not editable.

Exporting a Crosstab
To export the data in a Table or Crosstab to Excel, press the ‘Export’ button
in the table title bar.
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Collaborating

Dashboards support a number of features for natural and easy
collaboration. The following sections explain these features.

Emailing a Dashboard
To email a dashboard to other users, follow the steps below:

1. Open the dashboard for viewing. (See Opening a Dashboard.)

2. Press the ‘Email’ button on the dashboard toolbar. 

This opens the ‘Email’ dialog box.

3. On the Email tab of the ‘Email’ dialog box, make the following
selections:

a. In the ‘Mail To’ field, enter a semicolon-separated list of emails
to which the dashboard should be sent. To choose the emails
from a list, press the ‘...’ button. This opens the ‘Select Emails’
dialog box.
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Select the users you want to email and press the ‘Add’ (arrow)
button, or simply drag users to the right panel. When you are
finished, press ‘OK’.

b. Repeat the above step to enter the desired emails in the ‘CC To’
field.

c. In the ‘From’ field, enter the email address that should be used
to represent the sender.

d. In the ‘Subject’ field, enter a message for the email subject line.

e. In the ‘Message’ field, enter the body of the email message.

4. Select the Content tab, and make the following selections:

a. Choose the export type: ‘Excel’, ‘PowerPoint’, or ‘PDF’.

b. For ‘Data Size’, select ‘Match Layout’ to obtain the closest
possible match between the appearance of the exported copy
and the original dashboard. Select ‘Expand Tables and Charts’
to expand scrolling tables and scrolling charts to show all data.
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c. Select ‘Current View’ to include the current state of the
dashboard in the emailed file.

d. Select ‘Include Link’ to include a URL link to the dashboard in
the email. The email recipient can click the link to open the
dashboard in a new browser tab if they possess the appropriate
permissions for that dashboard.

e. Select the bookmarks that you want to include in the exported
file. The selected views are converted to individual pages
(PowerPoint and PDF) or sheets (Excel) in the exported copy.

5. Press ‘OK’ to close the dialog box and email the dashboard.

Bookmarking a Dashboard
Bookmarks do not
store data, only set-
tings.

A bookmark allows you save your current dashboard settings (filter
selections, menu choices, annotations, etc.) so that you can return to these
settings at a later time. The following sections explain how to work with
bookmarks.

Saving a New Bookmark

To save a dashboard configuration as a new bookmark, follow the steps
below:

1. Adjust the dashboard settings (filtering selections, menu choices,
annotations, etc.) as desired to obtain the configuration that you
want to save.

2. Press the ‘Bookmark’ button on the right side of the toolbar. This
opens the ‘Bookmark’ menu.

3. Select the ‘Save as New Bookmark’ option. This opens the
‘Bookmark Properties’ dialog box.

4. Enter a name for the new bookmark in the ‘Name’ field. (The
default bookmark name is current time.)
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5. Select ‘Private’ if you want the bookmark to be visible only to you.
Select ‘Shared’ if you want other users of the dashboard to be able
to use the bookmark that you have created. 

If you select ‘Shared’, select ‘All Users’ to share the bookmark
with all dashboard users or select ‘Same Groups’ to share the book-
mark only with users that belong to one or more of your current
user groups. (See Creating a New Group for information about
configuring groups.)

6. Enable the ‘Read-only’ option if you do not want other users to
modify this bookmark. Otherwise, any user who shares this
bookmark will be able to change the bookmark settings.

7. Press ‘OK’ to save the bookmark.

See Also
Annotating a Dashboard, to annotate dashboard components or data.

Restoring a Bookmark

To restore a dashboard to the settings saved in a bookmark, follow the steps
below:

1. Press the ‘Bookmark’ button on the right side of the toolbar. This
opens the ‘Bookmark’ menu.

2. Select the bookmark you want to restore.
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The dashboard is updated with the settings previously saved in the
bookmark.

Updating a Bookmark

To update a bookmark with new settings, follow the steps below:

1. Press the ‘Bookmark’ button on the right side of the toolbar. This
opens the ‘Bookmark’ menu.

2. Select the bookmark you want to update. This bookmark is now the
active bookmark.

3. Make any desired changes to the dashboard settings (selections,
input components, etc.).

4. Press the ‘Bookmark’ button again and select ‘Save Current
Bookmark’ or press Ctrl-S on the keyboard. (On Internet Explorer,
press Ctrl-Alt-S.) This updates the active bookmark with the
current dashboard settings.

Note that you can only update a bookmark for which you have write
permission. You can only update the default bookmark (the bookmark
shown in italics or the ‘Home’ bookmark) if you have write permission for
the dashboard.

Deleting a Bookmark

To delete a bookmark, follow the steps below:
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1. Press the ‘Bookmark’ button on the right side of the toolbar. This
opens the ‘Bookmark’ menu.

2. Right-click on the bookmark that you want to delete, and select
‘Remove’ from the context menu.

Note that you can only delete a bookmark for which you have write
permission. (The ‘Home’ bookmark cannot be deleted.)

Modifying a Bookmark

To change the name or sharing settings for a bookmark, follow the steps
below:

1. Press the ‘Bookmark’ button on the right side of the toolbar. This
opens the ‘Bookmark’ menu.

2. Right-click on the bookmark that you want to change, and select
‘Properties’ from the context menu. This opens the ‘Bookmark
Properties’ dialog box.
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3. Make the desired changes to the bookmark name and sharing. See
Saving a New Bookmark for more information about these settings. 

4. Press ‘OK’ to update the bookmark name and sharing.

Note that you can only modify a bookmark that you have created yourself.
(The ‘Home’ bookmark cannot be modified.)

Setting a Default Bookmark

The default bookmark for a dashboard specifies the settings (filter
selections, menu choices, annotations) that will be in effect each time you
re-open the dashboard in the Portal, i.e., the “starting state” of the
dashboard. 

If you have not yet
bookmarked the
desired dashboard
state, see Saving a
New Bookmark.

To set an existing bookmark as the default bookmark, follow the steps
below:

1. Press the ‘Bookmark’ button on the right side of the toolbar. This
opens the ‘Bookmark’ menu.
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The default book-
mark is subsequently
shown in italics.

2. Right-click on the bookmark that you want to set as the
dashboard’s starting state, and select ‘Set As Default’.

The dashboard will now open with the settings defined by this default
bookmark. 

If you do not specify a default bookmark for a dashboard, the dashboard
will open with the settings defined by the ‘Home’ bookmark. To remove
the default designation from a bookmark, simply designate a different user-
created bookmark or the ‘Home’ bookmark as the default.

Annotating a Dashboard
You can add annotations to a dashboard, to an individual dashboard
component, and even to an individual data point. The following sections
explain how to do this.

Annotating the Dashboard Body

To add annotations to the body of the dashboard, follow the steps below:

1. Select the bookmark in which you want to save the annotation.
(See Restoring a Bookmark for information on selecting a
bookmark.)

2. Right-click in an empty region of the dashboard, and select
‘Annotate’ from the context menu.
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This opens the annotation in the Annotation Editor.

3. Enter the desired annotation text into the Editor, and use the toolbar
to visually format the text. See Editing Annotation Text for more
information on how to use the Editor.

4. Press ‘OK’ to close the Annotation Editor. This adds the annotation
to the dashboard.

5. Position the annotation as desired. See Positioning an Annotation
for more information.

Annotations are
always saved together
with a bookmark.

6. To save the annotation, save the current bookmark. (See Updating
a Bookmark for more information.) 

Annotating a Component

To add an annotation to one of the Data View components (Table, Chart,
Crosstab), Output components (Gauge, Image, Text, etc.), or Shape
components (Rectangle, etc.) follow the steps below:

1. Select the bookmark in which you want to save the annotation.
(See Restoring a Bookmark for information on selecting a
bookmark.) 
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2. Right-click on the Data View, Output, or Shape component, and
select ‘Annotate Component’ from the context menu.

This opens the Annotation Editor. (For an Output component, the
Editor displays a default annotation giving the component’s current
aggregate.)

3. Enter the desired annotation text into the Editor, and use the toolbar
to visually format the text. See Editing Annotation Text for more
information on how to use the Editor.
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4. Press ‘OK’ to close the Annotation Editor. This adds the annotation
to the dashboard and attaches a callout line to the designated
component.

5. Position the annotation as desired. See Positioning an Annotation
for more information.

Annotations are
always saved together
with a bookmark.

6. To save the annotation, save the current bookmark. (See Updating
a Bookmark for more information.) 

Annotating a Chart Data Point

To add an annotation to a data point on a chart, follow the steps below:

1. Select the bookmark in which you want to save the annotation.
(See Restoring a Bookmark for information on selecting a
bookmark.)

2. Right-click on the chart data point you wish to annotate, and select
‘Annotate Point’ from the context menu.

This opens the Annotation Editor, which by default displays the
contents of the current data point tooltip.
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3. Enter the desired annotation text into the Editor, and use the toolbar
to visually format the text. See Editing Annotation Text for more
information on how to use the Editor.

4. Press ‘OK’ to close the Annotation Editor. This adds the annotation
to the dashboard and attaches a callout line to the designated data
point.

5. Position the annotation as desired. See Positioning an Annotation
for more information.

Annotations are
always saved together
with a bookmark.

6. To save the annotation, save the current bookmark. (See Updating
a Bookmark for more information.) 
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Annotating a Table Cell

To add an annotation to a data cell in a table, follow the steps below:

1. Select the bookmark in which you want to save the annotation.
(See Restoring a Bookmark for information on selecting a
bookmark.)

2. Right-click on the table cell you wish to annotate, and select
‘Annotate Cell’ from the context menu.

This opens the Annotation Editor, which by default displays the
contents of the current cell’s tooltip.

3. Enter the desired annotation text into the Editor, and use the toolbar
to visually format the text. See Editing Annotation Text for more
information on how to use the Editor.
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4. Press ‘OK’ to close the Annotation Editor. This adds the annotation
to the dashboard and attaches a callout line to the designated table
cell.

5. Position the annotation as desired. See Positioning an Annotation
for more information.

Annotations are
always saved together
with a bookmark.

6. To save the annotation, save the current bookmark. (See Updating
a Bookmark for more information.) 

Positioning an Annotation

To resize an annotation, click-and-drag on one of the annotation “resize”
handles.

To move the annotation, click-and-drag on the “move” handle, or click and
drag on the annotation body.

To format the annota-
tion box or callout
line, see Formatting
an Annotation.

To move the callout arrow for a component annotation, click-and-drag on
the arrow handle. The callout arrow must be placed within the body of the
component.
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The callout arrow for a data point annotation cannot be repositioned.

Annotations are
always saved together
with a bookmark.

To save the annotation after you make changes, save the current bookmark.
(See Updating a Bookmark for more information.) 

Editing Annotation Text

To edit an existing annotation, first make sure the annotation is visible.
(See Hiding an Annotation.) Then follow the steps below:

1. Right-click on the annotation and select ‘Edit’ from the context
menu. 

This open the annotation for editing in the Annotation Editor.

2. Modify the annotation text as desired by typing in the text box.

3. Modify the visual formatting of a block of text as desired by using
the formatting tools in the toolbar to adjust the font, size, weight,
color, etc.

4. Press ‘OK’ to close the Editor.

Annotations are
always saved together
with a bookmark.

5. To save the annotation, save the current bookmark. (See Updating
a Bookmark for more information.) 
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Formatting an Annotation

To change the visual appearance of an annotation box or callout line, first
make sure the annotation is visible. (See Hiding an Annotation.) Then
follow the steps below:

1. Right-click on the annotation and select ‘Format’ from the context
menu. 

This opens the ‘Format’ dialog box.

2. Adjust the following settings in the ‘Box’ panel:

a. From ‘Style’ menu, select a line style for the box border. Select
a border color from the adjacent color-picker.

b. From the ‘Round Corner’ menu, select a radius (in pixels) for
the box corners. Larger values produce more gently rounded
corners, and smaller values produce more sharply rounded
corners.

c. From the ‘Fill Color’ menu, select a background color for the
annotation box.
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d. From the ‘Alpha’ menu, set the background transparency. A
value of 0% indicates complete transparency (i.e., fill color not
visible), and a value of 100% indicates complete opacity.

3. Adjust the following settings in the ‘Line’ panel:

a. Enable the ‘Visible’ option to display the callout line.

b. From ‘Line’ menu, select a line style for the callout line. 

c. From the ‘End’ menu, select the arrow type for the callout line.

d. From the ‘Color’ menu, select a color for the callout line.

4. Press ‘OK’ to close the dialog box.

Annotations are
always saved together
with a bookmark.

5. To save the annotation, save the current bookmark. (See Updating
a Bookmark for more information.) 

Hiding an Annotation

When a dashboard or component annotation is hidden, it appears on the
dashboard or component as a small “note” icon. The toolbar ‘Annotation’
button allows you toggle annotations between their hidden and visible
states.

Every annotation is associated with a particular bookmark.

To display all annotations for a particular bookmark, follow the steps
below:

1. Select the bookmark for which you want to see annotations. (See
Restoring a Bookmark for information on selecting a bookmark.)

2. Press the ‘Annotation’ button in the toolbar.

If you export a dashboard while annotations are visible, the annotations
will be included in the export.

To hide all annotations, simply press the ‘Annotation’ button in the toolbar
a second time.
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Exporting a Dashboard
To export a copy of the dashboard into Excel, PowerPoint, or PDF format,
follow the steps below:

1. Press the ‘Export’ button in the dashboard toolbar. This opens the
‘Export’ dialog box.

2. Choose the export type: ‘Excel’, ‘PowerPoint’, or ‘PDF’.

3. Select ‘Match Layout’ to obtain the closest possible match between
the appearance of the exported copy and the original dashboard.

4. Select ‘Current View’ to include the current state of the dashboard
in the exported file.

5. Select the bookmarks that you wish to include in the exported file.
The selected views are converted to individual pages (PowerPoint
and PDF) or sheets (Excel) in the exported copy.

6. Press ‘OK’ to close the dialog box and proceed with the export.
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Using Dashboard Components

The following sections explain how to use the features of individual
dashboard components.

Inputs
Note: The dashboard interface operates in a slightly different way
on mobile devices such as phones and tablets. See Using a Dashboard
on a Mobile Device for details.

You can enter values into a dashboard by using Input components. The
following Input components are often use to dynamically adjust dashboard
properties such as the data displayed on chart axes, and can also be used to
modify tables and variables in an underlying Data Worksheet.

Slider: Drag the handle to the desired value. 

Spinner: Press the arrow buttons to select the desired value, or type a
numerical value directly into the number field.

CheckBox: Click to select the desired item or items. 

RadioButton: Click to select the desired single item. 

ComboBox: Expand the menu and select the desired item. In some cases,
you can also manually type values into the ComboBox.

Embedded Table: Type data into the Table component. Click away from
the Table to submit the data.
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TextInput: Enter text into the box. Often a TextInput component is
accompanied by a ‘Submit’ or ‘OK’ button to allow you to submit your
text.

See Also
Adding a Form Component, for information on how to create an Input
control.

Gauges
Gauges display a single aggregate value, and do not allow input or
manipulation.

See Also
Output Components, in Advanced Dashboard Design, for more detailed
information.

Selection Lists
A Selection List filters the data displayed by data view components
(Tables, Charts, etc.) and output components (Gauges, Thermometers,
etc.). A Selection List can provide either single-selection or multiple-
selection capability, and can be configured to submit selections
immediately when you make the selection or on-demand when you press
the ‘Apply’ button.

To filter data using a Selection List, select the desired item(s) in the list. If
an ‘Apply’ button is visible in the title bar, press the ‘Apply’ button to
submit your selections.
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If there is no ‘Apply’ button in the title bar, each selection you make is
submitted immediately. To make multiple selections before submitting,
hold down the Ctrl-key on the keyboard while making your selections.

The Selection List provides a mini-toolbar that allows you make
convenient modifications to the current selection. Move the mouse over the
Selection List to see the mini-toolbar. The following functions are
available.

Selection Lists make use of five different icons to designate the status of
items in the list.

Search
Press the ‘Search’ button and enter a search term in the text 
field. As you type, the Selection List updates to display only 
items having a match for your search text (appearing anywhere 
in the item). Press the ‘X’ button in the text field to close the 
Search feature.
Sort Selection
Press the ‘Sort Selection’ button once to sort the items in 
ascending numerical or alphabetical order. Press the button 
again to sort in descending numerical or reverse alphabetical 
order. Press the button a third time to reset the original order.
Reverse Selection.
Press the ‘Reverse Selection’ button to deselect all currently 
selected items and select all currently unselected items.
Clear Selection. 
Press the ‘Clear Selection’ button to deselect all items.
Apply. 
Press ‘Apply’ to submit the current selection. If the ‘Apply’ 
button is not visible, this means that your selections are 
submitted automatically.

Data selected and included.
The user has explicitly selected this item, and the corresponding 
records are included in the returned data set.
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See Also
Filtering a Dashboard, for a complete example of using Selection Lists.
Selection List, in Advanced Dashboard Design, for information on
designing a Selection List.

Selection Trees
The Selection Tree is a hierarchical version of the Selection List that allows
you to select items at multiple levels. 

Press the ‘+’ icon next to an item on the three to expand the tree and view
items at the next level in the hierarchy. To select all items under a given
parent item in the tree, right-click the parent item and choose ‘Select
Subtree’ from the context menu. To clear all items under a given parent
item in the tree, right-click the parent item and choose ‘Clear Subtree’ from
the context menu. 

Data selected but not included. 
The user has explicitly selected this item, but more recent 
explicit selections in other selection lists have now made this 
selection incompatible. The corresponding data is therefore not 
included in the returned data set.
Data included but not selected. 
The user has not explicitly selected this item, but has made other 
selections that implicitly select this item as well. The 
corresponding records are included in the returned data set (as a 
result of those other selections). 
Data compatible but not included. 
The user has not explicitly selected this item, and the item 
remains compatible with existing user selections. This item can 
therefore be selected to add additional records to the returned 
data set.
Data incompatible. 
The user has not explicitly selected this item, and this item is 
incompatible with existing selections. (It appears listed under 
‘Others’). Selecting this clears all other selections and starts 
fresh.
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See Selection Lists for operation of the mini-toolbar and the meaning of the
different selection icons. 

See Also
Selection Tree, in Advanced Dashboard Design, for information on
designing a Selection Tree.

Range Sliders
The Range Slider component allows you to select a date range or numerical
range. 

To adjust the start-point or end-point of a range, drag the left or right
handle. To slide the entire range, drag the slider body.

To quickly set the right side of the range to its maximum, double-click on
the right handle. To quickly set the left side of the range to its minimum,
double-click on the left handle. To quickly set the slider to its full range,
double-click on the slider body.

To enter precise values for the start-point or end-point, right-click on the
Range Slider and select ‘Edit’ from the context menu. In the ‘Edit’ dialog
box, enter the desired values and press ‘OK’.
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See Also
Range Slider, in Advanced Dashboard Design, for information on
designing a Range Slider.

Calendars
The Calendar component provides a calendar interface that allows you to
filter data based on a range of dates or a comparison of dates. The Calendar
is similar in purpose to a Range Sliders, but provides functionality beyond
simple range selection.

The following illustration shows some of the types of ranges that you can
select by clicking on different regions in a Calendar. Note that the Calendar
title bar indicates the selected range.

To select a column of days (e.g., all Thursdays in a month), click the name
of the desired day.

To select an entire year, click the name of the year.
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The Calendar component provides a mini-toolbar in the title bar that allows
you make convenient modifications to the calendar. (Move the mouse over
the Calendar to see the mini-toolbar.) The mini-toolbar buttons are
described below.

See Also
Calendar, in Advanced Dashboard Design, for information on designing a
Calendar.

Filtering a Range of Dates

To filter a range of dates using the Calendar component, follow the steps
below:

1. If the Calendar is currently in ‘Comparison’ mode (indicated by an
“=” symbol between the left and right calendar pages), press the
‘Switch to Date Range Mode’ button, or click the “=” symbol to
switch to ‘Date Range’ mode.

Switch to Year View and Switch to Month View
Press to alternate between year and month styles.
Switch to Range/Comparison and Switch to Simple 
View
Press to alternate between single- and double- calendar 
modes. In single-calendar mode, selections are applied 
immediately. In double-calendar mode, press the 
‘Apply’ button to submit your selections.
Switch to Comparison Mode and Switch to Date Range 
Mode
Press to switch between date range selection and date 
comparison operations.
Clear
Press to remove the specified date information.

Apply
Press ‘Apply’ to submit the selection. If the ‘Apply’ button does 
not appear, this means that your selection is submitted 
automatically.
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2. (Optional) To switch the Calendar from single-page to double-page
display, press the ‘Switch to Range/Comparison’ button.

To switch the Calendar from double-page to single-page display,
press the ‘Switch to Simple View’ button.

3. (Optional) To switch the Calendar from displaying a single month
to displaying the entire year, press the ‘Switch to Year View’
button.

To switch the Calendar from displaying the entire year to display-
ing a single month, press the ‘Switch to Month View’ button.
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4. Press the ‘Last Year’/‘Last Month’ buttons and ‘Next Year’/‘Next
Month’ buttons to display the appropriate calendar pages.

5. Click a date on the Calendar to select the start date of the range.
You can select a day, week, or month, depending on the how the
Calendar has been configured.

In a ‘Month View’ calendar, click to select a day or week, or click
the name of the month at the top of the calendar to select the entire
month. In a ‘Year View’ calendar, click to select a month, or click
the year at the top of the calendar to select the entire year.

6. Click another date on the Calendar to select the end date of the
range, or Ctrl-click to select discontiguous dates.

7. If the Calendar is double-page view, press the ‘Apply’ button to
submit your selection. (If the Calendar is in single-page view, the
selection is applied automatically.)

The range that you select is used to filter all data view and output
components that are based on the same Data Block as the Calendar
component.

Comparing a Range of Dates

To compare a range of dates using the Calendar component, follow the
steps below:

1. If the Calendar is in single-page view, press the ‘Switch to Range/
Comparison’ button to switch to double-page display.
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2. If the Calendar is currently in ‘Range’ mode (indicated by an arrow
symbol between the left and right calendar pages), press the
‘Switch to Comparison Mode’ button, or click the arrow symbol to
switch to ‘Date Comparison’ mode.

3. (Optional) To switch the Calendar from displaying a single month
to displaying the entire year, press the ‘Switch to Year View’
button.

To switch the Calendar from displaying the entire year to display-
ing a single month, press the ‘Switch to Month View’ button.

4. Press the ‘Last Year’/‘Last Month’ buttons and ‘Next Year’/‘Next
Month’ buttons to display the appropriate calendar pages for the
comparison that you wish to make.
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5. Select a date range to compare on the left page of the Calendar.
You can select a day, week, or month, depending on the how the
Calendar has been configured. 

The initial selection
that you make will be
mirrored on the right
page of the Calendar,
but you can change
this in the next step.

In a ‘Month View’ calendar, click to select a day or week, or click
the name of the month at the top of the calendar to select the entire
month. In a ‘Year View’ calendar, click to select a month, or click
the name of the year at the top of the calendar to select the entire
year. Ctrl-click to select discontiguous dates.

6. Select a date range to compare on the right page of the Calendar.
You can select a day, week, or month, depending on the how the
Calendar has been configured. Ctrl-click to select discontiguous
dates.

7. Press the ‘Apply’ button to submit your selection.

The date ranges that you select are used to generate comparisons in all
Charts and Crosstabs that are based on the same Data Block.

Selection Containers
A Selection Container provides convenient access to multiple selection
elements, and allows you to add new Selection Components into the
dashboard.

The following sections explain how to use a Selection Container.
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See Also
Selection Container, in Advanced Dashboard Design, for more
information about Selection Containers.

Using Contained Selections

To display a selection component in a Selection Container, press the
‘Show’ button in the selection component title bar. This expands the
selection component and its toolbar. (See Selection Lists, Selection Trees,
and Range Sliders for information on how to use these selection
components.) To collapse a selection component in a Selection Container,
press the ‘Hide’ button.

To clear the filters on all selection components in the Selection Container,
press the ‘Clear All Selections’ button in the Selection Container title bar.

Adding Contained Selections

For certain dashboards, you may be able to add new selection components
into an existing Selection Container. To do this, follow the steps below:

1. Press the ‘Edit’ button in a Chart or Crosstab component on the
dashboard.
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Note: If no ‘Edit’ but-
ton is available on any
Chart or Crosstab, you
cannot add a new
selection into the
Selection Container. 

This opens the Chart Editor or the Crosstab Editor.

2. Drag the desired fields from the Data Source panel into the
Selection Container.

String-type fields are added to the Selection Container as Selection
Lists, while numerical-type and date-type fields are added to the
Selection Container as Range Sliders.

3. To remove a selection component from the Selection Container,
right-click the component and select ‘Remove’.
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Charts
Select one or more data groups in a Chart component to view the Chart
toolbar. (You can select data groups by dragging across the groups on the
chart, by clicking on group, or by Shift-clicking or Ctrl-clicking to select
multiple groups.)

The following toolbar options may be available: 

• ‘Edit’: Opens the Chart Editor to modify the chart. See Charts in the
Advanced Dashboard Design for more information.

• ‘Max Mode View’: Displays the chart in a floating window that you can
resize.

• ‘Chart Data’: Displays a tabular listing of the chart’s summarized data
that you can export to Excel.

• ‘Show Details’: Displays the detail records underlying the chart’s
summarized data that you can export to Excel. 

• ‘Zoom’: Zooms the chart to display only the selected data groups. See
Zooming a Chart for more details.

• ‘Exclude’: Zooms the chart to exclude the selected groups (i.e., displays
only the unselected groups). See Zooming a Chart for more details.

• ‘Brush’: Highlights the selected data groups across all charts in which
the data occurs. See Brushing a Chart for more information.

To save an individual Chart as an image, right-click the Chart and select
‘Save Image As’ from the context menu.

The following sections explain how to format chart labels and set other
chart properties.

See Also
Changing the Chart View, in Advanced Dashboard Design, for more
detailed information on these features.
Grouping Chart Labels into Named Groups, in Advanced Dashboard
Design, for information on agglomerating chart categories.
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Formatting Chart Elements

Chart formatting includes data formats (date, number, currency, etc.),
borders, colors, fonts, and other aspects pertaining to the visual
presentation of the Chart.

To set formatting for a particular aspect of a Chart, right-click on the aspect
of the chart that you want to format (axis title, axis labels, plot area, etc.),
and select ‘Format’. 

This opens the ‘Format’ dialog box.

See Format Dialog Box in Advanced Dashboard Design for full
information about the dialog box properties.

Setting Chart Plot Properties

Plot properties for a Chart include grid-lines, trend-lines, banding,
transparency, and other features that pertain to the visual appearance of the
plot region.

To set plot properties for a Chart, right-click on the chart and select ‘Plot
Properties’. This opens the ‘Plot Properties’ dialog box.
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See Editing Plot Properties in Advanced Dashboard Design for full
information about the dialog box properties.
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Managing the Server

On Windows operating systems, Style Scope Agile Edition is installed as a
Windows service. On MacOS operating systems, Style Scope Agile
Edition is installed as a launch daemon. On Linux platforms, Style Scope
Agile Edition is installed as an init.d service.

Only users who have administrator privileges can change server
settings.

The following sections discuss several key aspects of managing the server,
including defining users, setting permissions, and configuring email.
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Viewing Server Status and License

To view the current status of the dashboard server, select the
Administration tab and open the ‘Status’ page.

To update the license key, press the ‘Edit’ button next to the ‘License
Keys’ field, enter a new key, and press ‘Apply’.

To add an additional license key, press the ‘Add License Key’ button and
enter the additional key.
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Troubleshooting Server Errors

If a dashboard is not working correctly or if a visible error message is
generated, you can obtain further information about the cause of the error
by inspecting the server logs. To do this, follow the steps below:

1. Open the server ‘Status’ page. (See Viewing Server Status and
License.)

2. Press the ‘Details’ button next to the ‘Errors’ field.

This opens the ‘Error Details’ dialog box, which allows you to
review recent server errors.
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3. To download the server and Scheduler logs for offline viewing,
press the ‘Download Logs’ button. This downloads a Zip file
containing the sree.log file for server errors and the scheduler.log
file for Scheduler errors.

4. To clear errors from the list, select the errors you want to clear by
clicking the adjacent boxes. Then press ‘Mark as Resolved’.
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Restoring from Backup

System backups are created automatically and retained for 30 days. In the
event of a server crash or file corruption, these backups allow you to restore
the system to an earlier state. 

To recover an asset
that you deleted, see
Recovering a Deleted
Asset.

To restore the system to a earlier state, follow the steps below:

1. Open the server ‘Status’ page. (See Viewing Server Status and
License.)

2. Press the ‘Restore’ button.

This displays a table of available backups. The ‘Date’ column
indicates when the corresponding backup was created. The ‘Files
Updated’ column indicates for each backup which files were
changed from the preceding backup.

3. Select the backup that you want to restore by clicking the adjacent
radio button. Then press ‘Restore’.
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To clear the list of available backups, press the ‘Clear History’ button.



MANAGING THE SERVER

171 of 2639

Creating a New User

The free version of Style Scope Agile Edition does not allow
creation of new users.

To create a new user, follow the steps below:

1. Open the server ‘Users’ page under the Administration tab.

The ‘Licensed Users’ panel shown you what types of users
currently exist, and how many additional users you can create. (The
total number of available users is controlled by the Style Scope
Agile Edition license key. Please contact InetSoft to purchase
additional licenses.)

2. Press the ‘Add’ button in the ‘Users’ panel.

3. Enter a name, password, and email for the new user.
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4. In the ‘Roles’ panel at the bottom, select the roles that the user will
posses:

a. The ‘Guest’ role allows a user to log in without any credentials.
Guest users can only view dashboards. They cannot create or
modify any assets.

b. The ‘Create dashboards’ role allows a user to create new
dashboards and edit dashboards for which they have write
permission. (See Setting Permissions for information on how to
assign user permissions.)

c. The ‘Create data sets and databases’ role allows a user to create
new data sets and configure new databases, as well as to edit
data sets and databases for which they have write permission.
(See Setting Permissions for information on how to assign user
permissions.)

5. Press ‘OK’ to add the new user. The new user is now displayed in
the ‘Users’ list. The icon on the right side indicates the roles that the
user possesses (dashboards, data sets, and/or administration).
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To assign permissions to a user or group, see Setting Permissions.

See Also
Creating a New Group, for information on how to create a group of users.
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Editing or Deleting a User

The free version of Style Scope Agile Edition does not allow
creation or deletion of users.

To edit user attributes, groups, or role associations, follow the steps below:

1. Open the server ‘Users’ page under the Administration tab.

2. Press the ‘Edit’ button next to the user name.

Proceed to edit the user attributes as described in Creating a New
User.

To delete a user, follow the steps below:

1. Open the server ‘Users’ page under the Administration tab.
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2. Press the ‘Delete’ button next to the user name.
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Creating a New Group

The free version of Style Scope Agile Edition does not allow
creation of groups.

To create a new user group, follow the steps below:

1. Open the server ‘Users’ page under the Administration tab.

2. Press the ‘Add’ button in the ‘Groups’ panel.

3. Enter a name for the group and select the users that should be
placed into this group.

4. Press ‘OK’ to add the new group.
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The new group is now displayed in the ‘Groups’ list.

To assign permissions to a user or group, see Setting Permissions.

See Also
Creating a New User, for information on how to create an individual user.
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Editing and Deleting a Group

The free version of Style Scope Agile Edition does not support
groups.

To edit group attributes or delete a group, follow the steps below:

1. Open the server ‘Users’ page under the Administration tab.

2. To edit a group, press the ‘Edit’ button next to the group name.

Proceed to edit the group attributes as described in Creating a New
Group.

3. To delete a group, press the ‘Delete’ button next to the group name.
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Configuring Email

To configure email on the server so that users can email and schedule
dashboards, follow the steps below:

1. Open the ‘Email’ page under the Administration tab.

2. From the ‘Server Type’ menu, select the email server from which
mailed dashboards should be sent: ‘Gmail’, ‘Outlook.com’, or
‘SMTP’.

3. Enter the required information for the server you selected:

a. For ‘Gmail’, press the ‘Get Authorization Code’ button, and
copy the Google-supplied authorization code into the
‘Authorization Code’ field.

b. Four ‘Outlook.com’, enter a valid Outlook.com username and
password.

c. For ‘SMTP’, enter the name of the mail host in the ‘Host’ field
and enter the email address from which emails should be sent in
the ‘Send emails from’ field. In the ‘Username’ and ‘Password’
fields, enter the username and password for the SMTP server, if
required.

4. Press ‘Apply’.
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Setting Permissions

By default, all assets (folders, dashboards, data sets, databases) inherit
permissions from their parent folders. There are three root folders on the
the ‘Permissions’ page under the Administration tab.

The free version of Style Scope Agile Edition does not support
changing permissions. The “admin” user has full permission while
the “guest” user can view only dashboards.

The root folders have the following default global permissions:

• Dashboards: All users have read permission. Administrators and users
with the ‘Create dashboards’ role have read/write permission.

• Data Sets: Administrators and users with the ‘Create data sets and
databases’ role have read/write permission.

• Databases: Administrators and users with the ‘Create data sets and
databases’ role have read/write permission.

The following sections explain how to change these global permissions and
how to set permissions for particular assets.

Setting Global Permissions
To change the global permissions for the root ‘Dashboards’, ‘Data Sets’,
and ‘Databases’ folders, follow the steps below.

1. Open the ‘Permissions’ page under the Administration tab.
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2. Click to select the desired resource: Select ‘Dashboards’ to set
global permissions for dashboards. Select ‘Data Sets’ to set global
permissions for data sets. Select ‘Databases’ to set global
permissions for databases.

3. Uncheck the ‘Use default permissions’ option.

4. Press the ‘Add’ button in the ‘Users/Groups’ panel.

This opens the ‘Add Permission’ screen.
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5. In the menu, select a group or user for which you want to set
permissions.

Administrators are not
listed because the
‘Administrator’ role
automatically grants
full permission.

You can select only users who have the appropriate role to access
the asset. For example, in order to assign ‘Database’ permission to
a user, the user must possess the ‘Create data sets and databases’
role. See Editing or Deleting a User for information on how to
assign a role to a user.

6. Select the desired permission, ‘Read only’ or ‘Read/write’.

7. Press ‘OK’. This assigns the specified permission to the asset that
you selected.

All default permissions for an asset are removed when you assign a
specific permission for the asset. To restore the default
permissions, check the ‘Use default permissions’ option.

8. To add permission for additional users or groups, press the ‘Add’
button again, and repeat the above steps.

9. Press ‘OK’ to save the permission settings.
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The global permissions that you set on the root ‘Dashboards’, ‘Data Sets’,
and ‘Databases’ folders are applied to all assets of the selected type unless a
more specific permission setting exists (e.g., for a specific folder,
dashboard, data set, or database).

Setting Permissions for an Asset
An asset inherits permissions from its parent folder unless specific asset
permissions are assigned. To set permissions for an individual folder,
dashboard, data set, or database, follow the steps below.

1. Open the ‘Permissions’ page under the Administration tab.

2. Navigate to the desired asset by pressing the arrow buttons on the
right side.

3. Click to select the asset (folder, dashboard, data set, or database)
for which you want to set permissions.
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Permissions that are inherited from the parent folder are shown in
the ‘Users/Groups’ table at the bottom. 

4. Uncheck the ‘Inherit permissions from parent folder’ option.

5. Press the ‘Add’ button in the ‘Users/Groups’ panel.
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This opens the ‘Add Permission’ screen.

6. In the menu, select a group or user for which you want to set
permissions.

Administrators are not
listed because the
‘Administrator’ role
automatically grants
full permission.

You can select only users who have the appropriate role to access
the asset. For example, in order to assign data set permission to a
user, the user must possess the ‘Create data sets and databases’
role. See Editing or Deleting a User for information about how to
assign a role to a user.

7. Select the desired permission, ‘Read only’ or ‘Read/Write’.

8. Press ‘OK’. This assigns the specified permission to the asset that
you selected.
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All inherited permissions for an asset are removed when you assign
a specific permission for the asset. To restore the inherited
permissions, check the ‘Inherit permissions from parent folder’
option.

9. To add permission for more users or groups, press the ‘Add’ button
again, and repeat the above steps.

The permissions that you set on a folder are applied to all assets contained
within the folder unless a more specific permission setting exists (e.g., for a
specific folder, dashboard, data set, or database).

Editing Permissions for an Asset
To edit permissions for an individual folder, dashboard, data set, or
database, follow the steps below.

1. Open the ‘Permissions’ page under the Administration tab.

2. Navigate to the desired asset by pressing the arrow buttons on the
right side.
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3. Click to select the asset (folder, dashboard, data set, or database)
for which you want to set permissions.

If the ‘Inherit permissions from parent folder’ option is checked,
this means that the asset is currently using the permissions set on its
parent folder. See Setting Permissions for an Asset to assign a
specific permission to the asset.

4. Press the ‘Edit’ button next to the permission that you want to
change.

This opens the ‘Edit Permission’ screen.

5. Change the permission setting and press ‘OK’.
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Deleting Permissions for an Asset
To delete a permission for an individual folder, dashboard, data set, or
database, follow the steps below.

1. Open the ‘Permissions’ page under the Administration tab.

2. Navigate to the desired asset by pressing the arrow buttons on the
right side.

3. Click to select the asset (folder, dashboard, data set, or database)
for which you want to delete permissions.

If the ‘Inherit permissions from parent folder’ option is checked,
this means that the asset is currently using the permissions set on its
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parent folder. In this case you will need to adjust the permissions
for the parent folder.

4. Press the ‘Delete’ button next to the permission that you want to
remove.

5. Press ‘OK’ when prompted to confirm your action.
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Advanced Dashboard 
Design

A Viewsheet is a dashboard that allows you to visualize a dataset.
Viewsheets allow you explore your data from every angle, discover new
patterns, test new ideas, and envision new opportunities

Note: Viewsheets are available only in Style Intelligence and Style
Scope.

The following sections explain all the features available for constructing
and editing Viewsheets. 
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1 Managing Dashboards in Visual Composer

A dashboard is also called a Viewsheet. 

Visual Composer is a tool for creating and editing dashboards. 

• If you are using Style Scope or Style Intelligence, see Creating a New
Dashboard on the Desktop or Creating a New Dashboard in the User
Portal for information on how to launch Visual Composer. (Use the
desktop version of Visual Composer if your browser does not support
Flash.)

• If you are using Style Scope Agile Edition, see Creating a New
Dashboard for information on how to launch Visual Composer.

• If you are using Visualize Free at visualizefree.com, see Creating a
Visualization for information on how to launch Visual Composer.

The following sections explain basic operations available for dashboards in
Visual Composer.

1.1 Setting Dashboard Options
You can set global options for a dashboard from the ‘Viewsheet Options’
dialog box in Visual Composer. (“Viewsheet” is another term for
dashboard.) To open the ‘Viewsheet Options’ dialog box, press the
‘Options’ button in the toolbar.

Note: This dialog box is not available in Visualize Free. See Using
Visualize Free for information on dashboard settings. This dialog
box is called ‘Dashboard Options’ in Style Scope Agile Edition, and
certain features are not available.

You can also right-click in an empty location on the Viewsheet grid, and
select ‘Options’ from the context menu.

http://visualizefree.com/
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The Options tab of the ‘Viewsheet Options’ dialog box provides the
following settings:

SETTING DESCRIPTION

Data Source The Worksheet, query, data model, or table to which the current 
Viewsheet is linked. Press ‘Select’ to choose a data source. 
Press ‘Clear’ to unbind the data source.

Use Metadata Suppress the display of live data during Viewsheet design. See 
Suppressing Query Execution in Design View.

Prompt for 
parameters

Enables user prompting for any parameters defined in the linked 
data source. Disable ‘Prompt for parameters’ to completely 
suppress prompting. Press the ‘Customize’ button to selectively 
disable prompting for certain parameters. (If disabled 
parameters are used within filter conditions, the corresponding 
filter conditions are dropped.) See Suppressing Parameter 
Prompting for more information.

Create MV On-
demand

Specifies that a new materialized view should be automatically 
created on-the-fly if the Viewsheet does not have an existing 
materialized view (either because the materialized view was 
never populated with data or because the Viewsheet underwent 
modifications that rendered an existing materialized view 
unusable). The materialized view will supply data to the 
Viewsheet both at design time and at runtime. (Not available in 
Style Scope Agile Edition.)

Design mode 
sample data 
size

Limits the number of records retrieved by a Viewsheet in design 
mode. This setting applies only to Viewsheets based on queries 
and data models. Viewsheets that are based on a Data 
Worksheet are governed by the corresponding ‘Design mode 
sample data size’ setting in the Worksheet, and the Viewsheet 
setting is disabled. See Setting Global Worksheet Options in 
Advanced Data Mashup for more information.
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The Layout tab is not available in Style Scope Agile Edition.

The Layout tab of the ‘Viewsheet Options’ dialog box provides the
following settings:

Alias Specifies a designation to be used in place of the actual 
Viewsheet name. The alias replaces the Viewsheet name in all 
contexts except the Repository tab and the ‘Export Assets’ 
page in Enterprise Manager. These always display the actual 
Viewsheet name. (Not available in Style Scope Agile Edition.) 

Description A description to appear as a tooltip when the user hovers the 
mouse over the Viewsheet in the Portal tree.

Server-Side 
Update

Automatically refreshes Viewsheet data at the period specified 
by the ‘Refresh Interval’. To customize the refresh behavior, see 
Enabling Server-Side Update for a Dashboard in Advanced 
Server Administration. If a materialized view has been created 
for the Viewsheet, server-side update is inactive. (See 
Materialized Views in Advanced Server Administration for 
more information on materialized views.) To suppress the 
“spinning wheel” loading graphic during automatic updates, 
deselect the ‘Display Loading Indicator’ property.

List on Portal 
Tree

Determines whether the current Viewsheet will be visible in the 
User Portal, subject to permissions set by administrator. (Not 
available in Style Scope Agile Edition.) 

Scale to Screen (Style Scope Agile Edition only.) When enabled, scales the 
Viewsheet to utilize the entire width and height of the browser 
window so that all components are visible without scrolling. 

Fit to Width (Style Scope Agile Edition only.) When enabled, scales the 
Viewsheet to the full width of the browser window. The 
Viewsheet height is scaled proportionally to the width, and may 
therefore exceed the height of the window. (A vertical scroll bar 
is provided in this case.)

SETTING DESCRIPTION

Target Screen Displays a dashed border of the specified pixel dimensions on 
the Viewsheet grid to assist with Viewsheet sizing. See 
Tailoring the Dashboard Screen Size for more information.

Scale to Screen When enabled, scales the Viewsheet to the browser window so 
that all components are visible without scrolling. This applies 
only to the “Master” layout. To set scaling for other layouts, see 
Specifying a Layout for a Device.

Fit to Width When enabled, scales the Viewsheet to the full width of the 
browser window. The Viewsheet height is scaled proportionally 
to the width and may therefore exceed the height of the window. 
(A vertical scroll bar is provided in this case.) This applies only 
to the “Master” layout. To set scaling for other layouts, see 
Specifying a Layout for a Device.

Layout Specifies the page or screen layout for the Viewsheet. See 
Setting the Viewsheet Layout for more information.

SETTING DESCRIPTION
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The Filters tab of the ‘Viewsheet Options’ dialog box allows you to
specify the manner in which selection elements in different Viewsheets
should interact within the Portal. See Sharing Filters for more information.

The Localization tab is not available in Style Scope Agile Edition.

The Localization tab allows you to identify Viewsheet elements that
should be translated into one or more other languages based on user locale.
See Localizing/Internationalizing a Dashboard for more information.

See Also
Changing a Dashboard Data Source, to configure a Viewsheet data
source.
Using a Parameter in a Condition, in Advanced Data Mashup, for
parameter usage.

1.2 Renaming a Dashboard
This does not apply to Visualize Free. See instead Modifying
Visualization Properties in Using Visualize Free. For Style Scope
Agile Edition, see also Renaming an Asset.

To rename a dashboard, follow these steps:

1. Select the dashboard in the Asset panel of Visual Composer.

2. Right-click and select ‘Rename’. This activates the editing mode. 

3. Enter the new name, and press Enter.

1.3 Changing a Dashboard Data Source
This does not apply to Visualize Free. See instead Updating a
Dataset in Using Visualize Free.

To bind a dashboard to a new data source, follow the steps below:

1. Open the dashboard in Visual Composer.

2. Press the ‘Options’ button in the Visual Composer toolbar. 
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This opens the ‘Viewsheet Options’ dialog box.

3. In the ‘Data Source’ region, press the ‘Select’ button.

4. Select a data source for the dashboard (Viewsheet):

a. Queries, data models, and database tables are listed under the
‘Data Source’ node. (In Style Scope Agile Edition only database
tables are listed.) The Viewsheet has access to all of the fields in
the selected query, model, or table.

b. Data Worksheets are listed under the ‘Global Worksheet’ and
‘User Worksheet’ nodes. (In Style Scope Agile Edition, they are
listed under the ‘Data Sets’ node.) The Viewsheet will have
access to all of the data blocks in the selected Worksheet.
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5. Press ‘OK’. 

If a Viewsheet contains controls that are already bound to a Worksheet,
those controls will stop functioning when the Viewsheet is bound to a new
Worksheet. However, the controls will remain functional if the data blocks
and columns in the new Worksheet are named identically to the data blocks
and columns in the old Worksheet.

See Also
Controlling Access to an Asset, in Advanced Data Mashup, for information
on the Worksheet scopes.

1.4 Opening a Dashboard Data Source
This does not apply to Visualize Free. See instead Managing
Visualizations in Using Visualize Free.

To open the Data Worksheet that supplies data to the dashboard in Visual
Composer, click the Worksheet link at the bottom of Visual Composer.

For more information about editing a Data Worksheet, see Transforming
and Mashing Up Data or Transforming and Mashing Up Data (Style
Scope Agile Edition).

1.5 Previewing a Dashboard
To preview a dashboard (Viewsheet) in Visual Composer, do one of the
following: 

• Press the ‘Preview’ button in the main toolbar. 
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• Right-click in an empty region of the Viewsheet grid, and select
‘Preview’ from the context menu.

This opens a new Preview tab that presents the Viewsheet with full
interactivity, just as end-users will experience it in the Portal.

The design view must
remain open for auto-
matic refresh.

If you make further changes in the design view tab, you can refresh the
existing Preview with your changes by simply clicking the Preview tab
again. You can also press the ‘Refresh’ button in the toolbar. (The
‘Refresh’ button is not available for materialized Viewsheets.)

1.6 Refreshing a Dashboard
To refresh a dashboard (Viewsheet) while in design view, right-click in an
empty region of the Viewsheet grid and select the ‘Refresh’ option from
the context menu.

This refreshes the Viewsheet to reflect changes to the underlying data
source and embedded components. To refresh a Viewsheet while in
preview, see Previewing a Dashboard.

1.7 Controlling Access to a Dashboard
This feature is not available for Style Scope Agile Edition.

You can store dashboards (Viewsheets) under two different scopes. The
scope determines which users can access the Viewsheet in the Portal,
Visual Composer, and Dashboards. 
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The following two scopes are available for Viewsheets:

• Global scope: All of the users in the system have potential access to the
Viewsheet. The administrator assigns individual user permissions.

• User scope: Only the user who creates the Viewsheet can access it. 

For Global scope only, an administrator can define subdirectories to
organize Viewsheets into different domains, for example: 

  – Shared Viewsheets
  – Sales domain
  – Marketing domain 
  – R&D domain
  – Support domain
  – Financial domain

Each domain can be given different access rights. 

To change the scope of a Viewsheet in the Asset Repository, drag the
Viewsheet to the desired scope in the Asset panel. 

The following rules apply:

• You must possess write permission to the target scope.

• If the Viewsheet is linked to a Worksheet that has User scope, the
Viewsheet cannot be moved to Global scope.

See Also
Controlling Access to a Dashboard, for information on toggling Global
and Local scope.
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Creating Folders, in Advanced Server Administration, to define sub-
folders.
Repository Permissions, in Advanced Server Administration, to assign
permissions.
Controlling Access to an Asset, in Advanced Data Mashup, for information
on the Worksheet scopes.

1.8 Enabling End-User Chart and Crosstab Editing 
To provide end users with access to the Chart Editor and Crosstab Editor,
follow the steps below:

1. Right-click the desired chart or crosstab and select ‘Properties’
from the context menu. This opens the ‘Chart Properties’ or
‘Crosstab Properties’ dialog box.

2. Select the Advanced tab in the dialog box.

3. Select the ‘Enable Ad Hoc Editing’ option.

If this option is not selected, users will not have access to the Chart Editor
or Crosstab Editor. However, other features (brushing, show details, export,
zooming, etc.) will remain available.

See Also
Creating a Chart, for information on designing with the Chart Editor.
Creating a Crosstab, for information on designing with the Crosstab
Editor.
Visualizing with Dashboards or Using a Visualization (Visualize Free) for
information on working with dashboards.
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1.9 Suppressing Query Execution in Design View
Note: If you press the
‘Cancel’ button in the
Viewsheet loading
dialog box, the View-
sheet is automatically
displayed in meta-data
mode.

The design view for a dashboard (Viewsheet) is intended to simulate the
functional dashboard as closely as possible, including all data
representation and interactivity. However, when a dashboard relies on large
or complex queries, retrieval of data from the database at design time can
introduce unnecessary delays into the design process. In such cases, it is
convenient to suppress the execution of queries in the dashboard design
view and instead display only meta-data.

To manually suppress execution of queries in the design view, follow the
steps below:

1. Press the ‘Options’ button in the Visual Composer toolbar. This
opens the ‘Viewsheet Options’ dialog box.

2. Select the ‘Use Metadata’ option, and click ‘OK’.

With ‘Use Metadata’ enabled, data-view and filter components in the
design view display query meta-data rather than the query result set. 
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1.10 Sharing Filters
You can synchronize selection and form components within a dashboard
(Viewsheet) or across multiple dashboards so that a selection in one
component is automatically propagated to other compatible components.
This is called sharing filters. The following selection and form components
can be synchronized as shared filters:

  – Range Slider
  – Selection List
  – Selection Tree
  – Calendar
  – Radio Button, Check Box, Combo Box
  – Slider and Spinner
  – TextInput

There are three general cases where sharing filters is useful:

Note: Filter elements
based on the same
data block in the same
Viewsheet are always
automatically syn-
chronized.

1. A Viewsheet displays data from multiple data blocks, and two or
more of these data blocks share a common field that you wish to
simultaneously filter. 

For example, consider a Viewsheet which has two charts, one
presenting data from data block A and the other presenting data
from data block B. Assume that each of these data blocks contains
an ‘Employee’ field. In order to allow the user to filter both charts
based on their respective ‘Employee’ fields, you need to create one
Selection List for each data block. However, these two ‘Employee’
Selection Lists are not synchronized by default, which means that
the user is free to select different values in each list. In this case,
synchronize the two elements as described in Sharing Filters
Among Dashboards, and then hide one of the two filter
components (set ‘Visible’ property to ‘Hide’).

2. A “parent” Viewsheet contains a nested “child” Viewsheet, and the
child Viewsheet contains elements that should be filtered by
selections the user makes within the parent Viewsheet. (See
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Nesting Viewsheets for information on how to embed one
Viewsheet within another Viewsheet.)

To synchronize ele-
ments across Views-
heets you must
specify a shared fil-
ter, as described
below, even if the ele-
ments utilize the same
Worksheet data block.

For example, consider a Viewsheet that contains a chart displaying
‘Total’ vs. ‘Employee’ and also contains a Selection List to filter
the ‘Employee’ field. Nested within this parent Viewsheet is a child
Viewsheet that contains a chart displaying ‘Quantity’ vs.
‘Employee’ and also contains a Selection List to filter the
‘Employee’ field. The two ‘Employee’ Selection Lists (one in the
parent and one in the child) are not synchronized by default, which
means that the user is free to select different values in each list. In
this case, synchronize the two elements as described in Sharing
Filters Among Dashboards, and then disable the ‘Visible in
External Viewsheets’ property of the Selection List in the child
Viewsheet. (This prevents the child’s Selection List from appearing
in the parent Viewsheet, avoiding duplication of components).

3. A “parent” Viewsheet contains hyperlinks to a “child” Viewsheet,
and the child Viewsheet contains elements that should be filtered
by selections the user makes within the parent Viewsheet. (See
Hyperlinks for information on configuring hyperlinks.)

For example, consider a parent Viewsheet that contains a chart
displaying ‘Total’ vs. ‘Employee’ and also contains a Selection
List to filter the ‘Employee’ field. Assume that this parent
Viewsheet contains hyperlinks to a child Viewsheet which contains
a chart displaying ‘Quantity’ vs. ‘Employee’ and also contains a
Selection List to filter the ‘Employee’ field. The two ‘Employee’
Selection Lists (one in the parent and one in the child) are not
synchronized by default, which means that the user is free to select
different values in each list. In this case, synchronize the two
elements as described in Sharing Filters Among Dashboards.

1.10.1 Sharing Filters Among Dashboards

To synchronize Filter Components and Form Components, assign them the
same ‘Shared Filter’ ID. Only elements that have the same data type and
same data binding should be synchronized. Follow the steps below:

1. Open the Viewsheet in Visual Composer

2. Press on the ‘Options’ button in the toolbar. This opens the
‘Viewsheet Options’ dialog.
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3. Select the Filters tab. 

4. In the ‘Filters’ list, click on a selection or form component that you
would like to synchronize, and drag it into the ‘Shared Filters’ list.
(You can also double-click the item to add it to the list.)

Components that have the same ID (within the Viewsheet or across
Viewsheets) will be synchronized.

5. Click on the component label in ‘ID’ column of the ‘Shared Filters’
list, and enter a suitable name. 

6. Repeat the above steps to add additional components to the ‘Shared
Filters’ list.

7. Press the ‘OK’ button to exit the dialog box.

8. Repeat the same process for other Viewsheets (nested Viewsheet or
hyperlinked Viewsheets). 

Use identical IDs for components you wish to synchronize with one
another. For example, to synchronize an ‘Employee’ Selection List in a
“parent” Viewsheet with an ‘Employee’ Selection List in a nested “child”
Viewsheet, follow the steps below:

1. Open the ‘Options’ dialog box for the parent Viewsheet. Assign the
‘Employee’ Selection List in the parent Viewsheet a shared filter
ID such as “SharedEmployeeFilter”, and press ‘OK’.
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2. Open the ‘Options’ dialog box for the child Viewsheet. Assign the
‘Employee’ Selection List in the child Viewsheet the same shared
filter ID (“SharedEmployeeFilter”), and press ‘OK’.

This will synchronize the ‘Employee’ Selection Lists in the two
Viewsheets.

1.10.2 Sharing Filters Between Dashboards and Reports
This feature is not supported in Style Scope Agile Edition.

To share filters between a dashboard and report, follow the steps below:

1. Assign filter IDs to the desired dashboard components as described
in Sharing Filters Among Dashboards. 

2. Assign filter IDs to the desired report data fields as described in
Sharing Filters with a Dashboard in Advanced Report Design.

When you create a set of shared filters between a dashboard and report, the
report will be filtered to match the dashboard selections whenever a user
opens the report while the dashboard is open. 

In most cases where shared filters are used, the user opens the report by
clicking a hyperlink in the dashboard. For example, the dashboard below
provides a hyperlink on the ‘Detail Data’ text component.

The hyperlink targets the desired detail report.



DATA MASHUP

335 of 1397

See Hyperlinks for information on how to add hyperlinks to text, images,
and other components.
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2 Controlling Dashboard Display

The following sections explain how to control various aspects of how a
dashboard is displayed.

2.1 Limiting Data Retrieved by a Dashboard
It is common for administrators to limit data retrieved by user queries, in
order to avoid overtaxing database resources. Administrators can limit the
number of records retrieved in design mode, preview mode, and at runtime
(in the Portal). The design mode limit can also be set in the Worksheet. See
the related links for more information.

In cases where a Worksheet data block is slow or returns an empty result
set, you can apply formatting features (e.g., highlights) by Suppressing
Query Execution in Design View.

See Also
Web Properties and Safeguards, in Advanced Server Administration
Limiting Query Size and Execution Time, in Advanced Server
Administration, for global safeguards.
Setting Global Worksheet Options, in Advanced Data Mashup, to limit
Viewsheet data in design view.
Limiting the Number of Rows in a Table, in Advanced Data Mashup, for
other Worksheet-level safeguards.

2.2 Suppressing Parameter Prompting
By default, a Viewsheet will prompt the user for all parameters in the
linked data source (query, Data Worksheet, etc.) and have not been
assigned a value. In some cases, you may want to suppress the prompting
for some or all of these parameters. 

To suppress prompting for all parameters, follow the steps below:

1. Press the ‘Options’ button in the toolbar to open the ‘Viewsheet
Options’ dialog box.
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2. Disable the ‘Prompt for parameters’ option.

3. Press ‘OK’ to close the dialog box.

To suppress prompting for a subset of parameters, follow the steps below:

1. Press the ‘Options’ button in the toolbar to open the ‘Viewsheet
Options’ dialog box (as above).

2. Press the ‘Customize’ button next to the ‘Prompt for parameters’
option.

This open the ‘Customize Parameters’ dialog box.
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3. To disable one or more parameters, select the parameters you wish
to disable in the ‘Enabled Parameters’ panel, and press the ‘Add’
button. This moves the selected parameters to the ‘Disabled
Parameters’ panel.

To re-enable one or more disabled parameters, select the
parameters you wish to enable in the ‘Disabled Parameters’ panel,
and press the ‘Remove’ button. This moves the selected parameters
to the ‘Enabled Parameters’ panel.

4. Press ‘OK’ to close the ‘Customize Parameters’ dialog box.

5. Press ‘OK’ to close the ‘Viewsheet Options’ dialog box.

See Also
Setting Dashboard Options, for more information about the ‘Viewsheet
Options’ dialog box.

2.3 Tailoring the Dashboard Screen Size
To lay out a dashboard (Viewsheet) to fit particular screen dimensions, use
the ‘Target Screen’ option to display appropriate guidelines on the
Viewsheet grid. Follow the steps below:

1. Press the ‘Options’ button in the toolbar to open the ‘Viewsheet
Options’ dialog box.
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2. Enable the ‘Target Screen’ option, and enter the desired screen
dimensions in pixels.

3. Press ‘OK’ to close the dialog box.

The Viewsheet grid now displays dashed border lines defining a region of
the size that you specified. 

By laying out the Viewsheet components within these border lines, you can
ensure that the Viewsheet will fit within a screen of the specified
dimensions.
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See Also
Setting Dashboard Options, for more information about the ‘Viewsheet
Options’ dialog box.

2.4 Setting the Viewsheet Layout
You can configure a dashboard to dynamically adapt its layout for viewing
on different devices (e.g., phones, tablets). Follow the steps below:

1. Create one or more layouts based on the available device classes.
See Specifying a Layout for a Device.

2. Assign dashboard components to the layouts you created. See
Assigning Components to a Dashboard Layout.

You can also assign a dashboard layout for print. Follow the steps below:

1. Specify a layout for printing the dashboard. See Specifying a
Layout for Print.

2. Assign dashboard components to the print layout. See Assigning
Components to a Dashboard Layout.

2.4.1 Specifying a Layout for a Device

A dashboard “layout” identifies a class of devices (e.g., phone, tablet)
based on screen dimensions. The dashboard layout allows you to tailor the
display of the dashboard to this class of devices. To create a dashboard
layout for a device class, follow the steps below:

1. Press the ‘Options’ button in the toolbar to open the ‘Viewsheet
Options’ dialog box.

2. Select the Layout tab.
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3. Press the ‘New’ button in the ‘Layouts’ panel. This opens the
‘Viewsheet Layout’ dialog box.

4. Select the ‘Device’ option. 

5. (Optional) To add a custom device class to the ‘Select Device
Classes’ panel, see Defining a New Device Class.

6. In the ‘Select Device Classes’ panel, select one or more classes that
you want to share a single layout. In the ‘Name’ field, enter a name
for the shared layout.
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The named layout is triggered whenever the dashboard is being
viewed on a device in one of the selected size classes. To customize
the dashboard for a named layout, see Assigning Components to a
Dashboard Layout. 

7. Enable the ‘Mobile Only’ option to trigger the layout only when
the dashboard is genuinely being viewed on a mobile device. (This
prevents the layout from being triggered on a desktop computer
when the browser window is set to a narrow width.) This is the
recommended setting.

8. Select a value in the ‘Scale Font’ menu. This value multiplies the
font size of all text on the dashboard. This may be appropriate
when you create a layout for a small device such as a phone.

9. Press ‘OK’ to close the ‘Viewsheet Layout’ dialog box.

10. Press ‘OK’ to close the ‘Viewsheet Options’ dialog box.

To assign components to the dashboard layout you created, see Assigning
Components to a Dashboard Layout. 

2.4.2 Specifying a Layout for Print

A print “layout” specifies the page settings for printing the dashboard. The
print layout allows you to tailor the arrangement of the dashboard to these
page settings. To configure a print layout for a dashboard, follow the steps
below:

1. Press the ‘Options’ button in the toolbar to open the ‘Viewsheet
Options’ dialog box.
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2. Select the Layout tab.

3. Press the ‘New’ button in the ‘Layouts’ panel. This opens the
‘Viewsheet Layout’ dialog box.

4. Select the ‘Print’ option. 

5. For the ‘Select Paper’ field, choose the size of paper on which the
dashboard will be printed.

6. (Optional) To create a custom-sized page, select the ‘Custom Size’
option and enter the desired paper dimensions.
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7. Select a value in the ‘Scale Font’ menu. This value multiplies the
font size of all text on the dashboard.

8. Select ‘Landscape’ to force the dashboard to print in landscape
orientation.

9. Enter the desired values in the ‘Margins’ and ‘From Edge’ fields.

10. In the ‘Start page numbering at page index’ field, indicate the page
on which page numbering should commence.

Note that the print layout of a dashboard automatically modifies
certain dashboard components when the dashboard is printed:
Tables are fully expanded to show all rows, and selection
components such as Selection Lists and Range Sliders are
presented with current selections only.

Note: You can only define a single print layout.

11. Press ‘OK’ to close the ‘Viewsheet Layout’ dialog box.

12. Press ‘OK’ to close the ‘Viewsheet Options’ dialog box.

To assign dashboard components to an existing print layout, see Assigning
Components to a Dashboard Layout.

2.4.3 Editing Device or Print Layout Settings

To edit the existing layout settings for a device class or print layout, follow
the steps below:

1. Press the ‘Options’ button in the toolbar to open the ‘Viewsheet
Options’ dialog box.

2. Select the Layout tab.

3. Select the desired layout in the ‘Layouts’ panel and press the ‘Edit’
button.
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4. Edit the layout as desired. See Specifying a Layout for a Device or
Specifying a Layout for Print for more information.

To delete an existing layout, select the layout in the ‘Layouts’ panel and
press the ‘Delete’ button.

2.4.4 Defining a New Device Class

The four default device classes provided on the Layout tab of the
‘Viewsheet Options’ dialog box are ‘Extra small devices’, ‘Small devices’,
‘Medium devices’, and ‘Large devices’. These classes are adequate for a
majority of applications, but may not correctly characterize every device.
For example, you may want a particular tablet device to use a “small
device” layout even though the tablet’s actual width falls within the
“medium device” range. In this case you can create custom device classes
based on minimum and maximum device widths suitable for your
application. 

To add a custom device class, follow the steps below:

1. Press the ‘Options’ button in the toolbar to open the ‘Viewsheet
Options’ dialog box.

2. Select the Layout tab.



DATA MASHUP

346 of 1397

3. Press the ‘New’ button in the ‘Layouts’ panel. This opens the
‘Viewsheet Layout’ dialog box.

4. Select the ‘Device’ option at the top. Then press the ‘New Device
Class’ button. 

This opens the ‘Screen Size’ dialog box. 
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5. Enter a name for the device class (e.g., “Small Tablet”) in the
‘Label’ field, and add an optional description of the class in the
‘Description’ field.

6. In the ‘Width’ fields, enter the minimum and maximum device
widths that define this device class. Note that the pixel values that
you enter for the width should be CSS pixel values, not physical
pixel values.

7. Press ‘OK’ to close the dialog box and add the new device class to
the list of existing device classes.
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To edit or remove a device class, press the ‘Edit’ or ‘Delete’ button to the
right of the label in the ‘Select Device Classes’ list.

Note that custom device classes are saved globally, and can be accessed
from any Viewsheet on the server. Custom device classes that are used by a
Viewsheet are included with the Viewsheet when you import or export the
Viewsheet in Enterprise Manager. (See Incremental Deployment of Assets
in Advanced Server Administration for more information.)

2.4.5 Assigning Components to a Dashboard Layout

You can tailor the arrangement of dashboard components for different
devices or for print. For example, if the dashboard is viewed on a large-
screen device you may want to display all the components of the
dashboard, but if the dashboard is viewed on a tablet or phone, you may
want to display only a subset of components in an arrangement that suits
the smaller viewing area. 

To assign components to a dashboard layout, follow the steps below:

1. Define one or more viewing layouts (see Specifying a Layout for a
Device) and/or a print layout (see Specifying a Layout for Print).

2. Verify that Visual Composer is currently displaying the Viewsheet
in design view (not preview).
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3. From the ‘Layout’ menu in the Viewsheet status bar (at the bottom
of the Visual Composer window), select the layout for which you
want to assign components.

The ‘Master’ layout is the standard design view of the Viewsheet,
including all components. Layouts in the menu are shown in red if
they do not yet have components assigned or if they are out of sync
with the Master view (e.g., because new components were added to
the Master view since the layout was last modified). The ‘Layout’
label itself is shown in red whenever there is at least one layout that
is out of sync.

4. (Optional) For print layout, press the ‘Edit Content/Header/Footer’
button in the toolbar, and select ‘Edit Content’.

5. (Optional) Press the ‘Guides’ button in the toolbar and choose the
guidelines you want to display in the layout view. The options
provided (16:9 and 4:3, landscape or portrait) are the most common
screen proportions. Choose the option that most closely matches
the intended device proportions. To hide the guidelines, select
‘None’.
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Guidelines are provided for informational purposes only. Use the
guidelines to arrange components so that the dashboard best
utilizes the available screen dimensions. Note that the final
dashboard layout is automatically scaled to fit the device screen, so
only the relative sizes and positions of the components are
important when you lay out the dashboard. Components can be
placed outside the guidelines if desired, and the dashboard will be
scaled to place these components on the screen.

6. Drag components from the Component panel into the layout area.
You can add each component only once into the layout.

Note that layouts for devices will be automatically scaled to fit
the device screen.

7. Position and resize components in the layout as desired by
dragging on the “move” handle and “resize” handles. Note that the
layout for print provides multiple pages, and you can drag
components onto any available page.

8. (Optional) For a print layout, add additional Text components into
the page header or footer. To do this, follow the steps below:

a. Press the ‘Edit Content/Header/Footer’ button in the toolbar,
and select ‘Edit Header’ or ‘Edit Footer’.
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b. Drag a Text component from the Component panel into the
header or footer region.

c. Right-click on the Text component, and select ‘Properties’ from
the menu to open the ‘Text Properties’ dialog box. Enter the
desired text in the ‘Text’ field, and press ‘OK’.

Note that you can use the following special codes within the text
that you enter: {P} inserts the current page number, {N} inserts
the total number of pages, and {D} and {T} insert the current
date and time. To control the formatting of the inserted values,
use the optional format parameter, for example, {P, format}.
The format for page numbering should be a
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java.text.DecimalFormat format. (See Number Format for
more details.) The format for date and time should be a
java.text.SimpleDateFormat format. (See Date Format for more
details.)

d. (Optional) To format the text, right-click the Text component
and select ‘Format’ from the menu. Apply the desired
formatting using the ‘Format’ dialog box, and press ‘OK’. 

See Format Dialog Box for more information about the
‘Format’ dialog box.

e. Repeat the above steps to add additional Text components into
the header or footer.

f. Position and resize Text components in the header or footer as
desired by dragging on the “move” handle and “resize” handles.

9. (Optional) For a print layout, add additional Image components
into the page header or footer. To do this, follow the steps below:

a. Press the ‘Edit Content/Header/Footer’ button in the toolbar,
and select ‘Edit Header’ or ‘Edit Footer’.
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b. Drag an Image component from the Component panel into the
header or footer region.

c. Right-click on the Image component, and select ‘Properties’
from the menu to open the ‘Image Properties’ dialog box. 

d. Select the General tab. Select an existing image from the list, or
press ‘Upload’ to upload a new image from a local source. (See
Image Properties: General Tab for more information.)

e. Select the Advanced tab and set the desired scaling for the
image. (See Image Properties: Advanced Tab for more
information.)

f. (Optional) To format the Image, right-click the Image
component and select ‘Format’ from the menu. Apply the
desired formatting using the ‘Format’ dialog box, and press
‘OK’. See Format Dialog Box for more information about the
‘Format’ dialog box.
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g. Repeat the above steps to add additional Image components into
the header or footer.

h. Position and resize Image components in the header or footer as
desired by dragging on the “move” handle and “resize” handles.

10. Press the ‘Preview’ button in the toolbar to see a preview of the
dashboard for the selected devices or for print.

The preview for devices is displayed within Visual Composer. The
dashboard is automatically scaled to fit the screen.

The preview for print is displayed as PDF. The print version of the
dashboard automatically adapts dashboard components as suitable
for printing: Tables are fully expanded to show all rows, and
selection components such as Selection Lists and Range Sliders
display any selected values as plain text.

11. Press the ‘Save’ button in the toolbar to save the Viewsheet.
(Layouts are saved together with the Viewsheet.)

12. Select the ‘Master’ option from the ‘Layout’ menu in the status bar
to return to the normal design view of the dashboard.

When the dashboard is viewed on a device that matches a specified layout,
the dashboard will be displayed with the configuration that you designed.
Note that the device layout will be automatically scaled to fit the device
screen.

2.5 Styling a Dashboard with CSS
You can use a Cascading Style Sheet (CSS) to format components, which
allows you to obtain a consistent appearance across all your dashboards.
You can override the CSS formatting as needed by setting manual formats
on individual components. 

CSS is not available for Style Scope Agile Edition.

The following CSS formatting options are available for styling
components. The styles must be defined within a CSS file and uploaded to
the server before they can be used within a Viewsheet. See Creating a
Component CSS Definition File in Advanced Server Administration for
more details.

• CSS Type: Every Viewsheet component has a fixed CSS Type. Some
sub-components have a CSS Type as well. CSS Type styles are used to
automatically apply styling to all Viewsheets (without the need to make
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modifications to individual Viewsheets). See CSS Tab for a list of
component types.

• CSS ID: You can assign a unique CSS ID to each component in a
Viewsheet. This allows you to target a particular component for styling.
The CSS file should contain a CSS ID definition for each component ID
you assign.

• CSS Class: You can assign a CSS Class to any component in a
Viewsheet. This allows you to style a group of components (all having
the same CSS Class) with a single set of instructions. The CSS file
should contain a CSS Class definition for each CSS Class you assign in
the Viewsheet.

You can combine these selectors as needed. For example, the CSS file
might define a default “Text” CSS Type to apply to most Text components,
and also provide special Text CSS Classes (e.g., ‘Header1’, ‘Header2’,
‘Quoted’, ‘Hyperlink’, etc.) to use on individual Text components. See
Creating a Component CSS Definition File in Advanced Server
Administration for details on how to create these CSS definitions.

To set a Viewsheet component’s style by using CSS Class and ID, follow
the steps below:

1. Verify that an administrator has uploaded the CSS file containing
the Type, Class, and ID definitions. See Creating a Component
CSS Definition File in Advanced Server Administration for more
information on how to create and upload this file.

2. In Visual Composer, right-click on the region of the component
you want to style, and select ‘Format’ from the context menu. (For
a list of component regions that can be styled, see CSS Tab.) This
opens the ‘Format’ dialog box. 

3. Select the CSS tab. The text next to the ‘Type’ label indicates the
CSS Type of the component. The component automatically
inherits any styles defined in the CSS file for its Type. 
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CSS styles are overridden by styles you set manually in Visual
Composer. The ‘Reset’ button in the dialog box removes the
manually-set styles, restoring any CSS defaults. Manually-set
transparency will affect the appearance of CSS colors. 

4. On the CSS tab, select the CSS ‘ID’ and/or ‘Class’ to define the
component’s style from the corresponding menus. Multiple
components can share the same CSS Class but a CSS ID should be
unique to a given component. 

For table components, you can select only a TableStyle ‘Class’.
Note that table styles specified in the General tab of the ‘Table
Properties’ dialog box override any table style specified on the
CSS tab of the ‘Format’ dialog box. You must therefore clear table
styles from the ‘Table Properties’ dialog box in order to apply
styles from the CSS tab.

If you do not see the desired CSS ID or CSS Class listed in the ‘ID’
or ‘Class’ menus, you can manually type a new Class or ID name.
However, this will not apply any styles until a corresponding
definition is created in the CSS definition file.

CSS properties that have not been assigned explicit values at the
component or sub-component level will be set by the global default (*) if
the CSS file specifies one. Otherwise properties of a sub-component are
inherited from the component's parent. See CSS Component Properties and
CSS Global Default (*) in Advanced Server Administration for more
information.

Example: 
Applying CSS 
Styles

In this example, you will apply CSS styles to a Viewsheet. 
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1. If you have not done so already, deploy the sample CSS file
described in Example: Creating a CSS Definition File, in Advanced
Server Administration. (This may require an administrator.) 

2. Create a new Viewsheet based on the sample ‘ProductSales’ Data
Worksheet.

3. Add a Text element to the Viewsheet. Enter the text ‘Total Sales’. 

Note that the text you enter uses the font “Verdana”. This font is
used as the default for all text in the Viewsheet because it is set as
the global default in the CSS file. See Example: Creating a CSS
Definition File in Advanced Server Administration for more
information about this CSS file.

4. Right-click the Text component, and select ‘Format’ from the
context menu. This opens the ‘Format’ dialog box.

5. Select the CSS tab. From the ‘Class’ menu, select ‘Header2’, and
press ‘OK’. 

This applies the Header2 style to the text element.

6. Resize the text element so that the text is fully visible.

7. Add a new Chart component. From the ‘SalesByDate’ data block
in the Data Source panel, drag the ‘Month(Date)’ field to the ‘X’
region, and drag the ‘Total’ field to the ‘Y’ region.
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Note that the chart background has color “azure” because the CSS
file specifies this color for all components of type “Chart”. The Y-
axis title has background color “yellow” because the CSS file
specifies this color for all components of type “ChartAxisTitle”.
The X-axis title has background color “dark khaki” because the
CSS file specifies this color for all components of type
“ChartAxisTitle[axis=x]”. The font used for all axis text is
“Verdana” because the CSS file specifies this font as the global
default. See Example: Creating a CSS Definition File in Advanced
Server Administration for more information about this CSS file.

8. Press the ‘Select Chart Style’ button in the Data panel, and select
the bar-chart option. This changes the display to a bar chart.

9. Right-click the X-axis title on the chart, and select ‘Format’ from
the context menu. This opens the ‘Format’ dialog box.

Note that the ‘Type’
field indicates ‘Char-
tAxisTitle[axis=x]’.
The only classes listed
are those than can
apply to this region.

10. On the CSS tab, select ‘AxisText’ from the ‘Class’ menu. Press
‘OK’. 
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This applies the AxisText style to the X-axis title.

11. Repeat the above steps to apply the AxisText style to the Y-axis
title as well.

12. Close the Chart Editor.

13. From the Component tree, drag the entire ‘SalesByDate’ data
block to the Viewsheet. This creates a new table called
‘SalesByDate’.

Note that the table title bar displays green text because the CSS file
specifies this color for all components of type “TableTitle”. The
font used for the title text is “Verdana” because the CSS file
specifies this font as the global default. See Example: Creating a
CSS Definition File in Advanced Server Administration for more
information about this CSS file.

14. Right-click on the table’s “move” handle and select ‘Format’ from
the context menu. This opens the ‘Format’ dialog box for the table
as a whole.
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Note that the ‘Type’
field indicates
‘Table’. This means
that the CSS applies
to the table as a whole

15. On the CSS tab, from the ‘ID’ menu, select ‘SalesTable’, and press
‘OK’. 

This applies the SalesTable style to the table as a whole, which
applies background color #FFEEBB.

16. Again right-click on the table’s “move” handle and select ‘Format’
from the context menu. 
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This opens the ‘Format’ dialog box for the table as a whole.

17. On the CSS tab, from the ‘Class’ menu, select ‘YellowRows’ and
press ‘OK’. 

This applies the YellowRows class definition.

You can manually make additional modifications to the chart, as desired.
Format settings that you adjust manually will override format settings
controlled by CSS.
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¢

See Also
CSS Tab, for a list of Viewsheet component CSS Types.
Alignment Tab, Font Tab, Border Tab, Color Tab, to set styles without
using CSS.
Dynamic Properties, for information on setting color via variable or
expression.

2.6 Localizing/Internationalizing a Dashboard
Localization is not available in Style Scope Agile Edition.

If the dashboards you create are viewed from multiple locales, it may be
desirable to configure Viewsheet components to display text in a language
specific to the user locale. The following Viewsheet components can be
localized in this way:

• Table title and column header text

• Freehand Table title and text cell text

• Crosstab title, column header text, and grand total text

• Chart axis titles and legend titles

• Filter component titles

• Text component text

• Form component titles

• Submit button label 

You can configure a Viewsheet component for localization by associating
one or more Text ID properties with the component. The specified Text IDs
for each component are then used to create a mapping between the text
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string(s) in the component and the replacement text string(s) to be shown to
the user. 

To specify a Text ID for a component, follow the steps below:

1. Press the ‘Options’ button in the Visual Composer toolbar to open
the ‘Viewsheet Options’ dialog box.

2. Select the Localization tab. 

3. In the left ‘Component’ panel, select the property in the element
tree that you wish to localize, and press ‘Add’. This adds the
property to the right ‘Localization Text ID’ panel.

4. In the ‘Localization Text ID’ panel, enter a label for the element in
the ‘Text ID’ field. 
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The Text ID that you enter here is the label used to represent the
text of the corresponding component in the localization mapping
file discussed below.

5. Press ‘OK’ to exit the ‘Viewsheet Options’ dialog box.

The mapping between the specified Text IDs and the replacement text for
each locale is specified in a resource bundle specific to that locale. The
resource bundle is a “.properties” file, and must be available on the
classpath, preferably in the sree\WEB-INF\classes directory. The file
should be named using the ISO-standard two-letter codes for language and
country; for example, a property file supporting Canadian French speakers
would be called ‘SreeBundle_fr_CA.properties’. See the Localization/
Internationalization section of the Advanced Server Administration for
details on configuring resource bundle contents.

When the end-user selects a locale from the User Portal login menu, the
mapping in the corresponding resource bundle is used to display the
replacement text for all mapped elements. If a resource bundle
corresponding to the user’s locale selection is not found on the classpath,
no localization will be performed.

In addition to localizing Viewsheet elements, you can also configure
localization for User Portal interface components (tabs, tree elements, etc.).
See the Localization/Internationalization section of the Advanced Server
Administration for instructions.
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2.7 Creating a Dashboard Background
You can use an image or a shape component as a background for any
portion of a dashboard (Viewsheet). For example, you can place an image
behind a set of components to provide the appearance of a frame or panel.

To use an image or shape as a background, follow the steps below:

1. Add an image component or shape component to the Viewsheet. 

2. For an image component, follow the steps below:

a. Right-click the image component, and select ‘Properties’ from
the context menu. This opens the ‘Properties’ dialog box.

b. Select the General tab. From the ‘Static Image’ panel, specify
an image to display as the background. (See Image for more
details.)

c. Select the Advanced tab, and enable the ‘Scale Image’ option. 

d. Click ‘OK’ to exit the dialog box.

3. Right-click the image or shape component, and select ‘Send to
Back’ from the context menu.

4. Drag the image or shape into the desired position (usually behind
another component or components). 

5. Resize the image or shape as desired. 
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6. (Optional) Right-click on the image or shape and select ‘Lock’ to
prevent the component from being selected or moved. 

Locking the component is useful when you are laying out other
components on top of the image or shape. When the background
image or shape is locked, you can easily move the top components
without disturbing the position of the background. To unlock the
component, right-click and select ‘Unlock’.

You can continue placing other components on top of this background
image.
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See Also
Moving a Component, for information on resizing an element.
Scaling an Image, for methods of scaling an image without distortion.
Shape Components, for detailed information about setting shape properties.
Image, for detailed information about setting image properties.

2.8 Annotating a Dashboard
You can add annotations to the following parts of a Viewsheet:

Bookmarks and annotations are not available for Visualize Free.

• Viewsheet body

• Output and data view components

• Chart data point

• Table data cell

To add an annotation to a Viewsheet, follow these steps:

1. Preview the Viewsheet. See Previewing a Dashboard for details.

2. If necessary, select the bookmark in which you want to save the
annotation. (Annotations that you add will be saved with the active
bookmark.) See Restoring a Bookmark or Restoring a Bookmark
(Style Scope Agile Edition) for information on selecting a
bookmark. 

3. Right click on the Viewsheet body, a Viewsheet component, or a
data point that you want to annotate, and select ‘Annotate’ from the
context menu.
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4. Add the desired annotation, and press ‘OK’.

See Annotating a Dashboard or Annotating a Dashboard (Style Scope
Agile Edition) for complete information on adding, editing, and formatting
annotations.

2.9 Inserting HTML in Dashboard Text
You can display HTML content within any element that displays text (e.g.,
Table cell, Text component, Selection List, etc.). To do this, surround the
HTML markup with <html>...</html> tags. For example, the following
markup placed within a Text element creates a list within the Text element:

<html><font color="#0000FF"><b>My List:</b></
font><ul><li>Apples</li><li>Oranges</li><li>Mangos</li></
ul></html>

The HTML tags supported are the same as those supported by the Flex
label.htmlText component: <a>, <b>, <br>, <font>, <img>, <i>, <li>, <p>,
<span>, <textformat>, and <u>.

2.10 Building a Composite Dashboard
Some dashboards require a large number of elements, and would be
complex to design using just a single Viewsheet. In such cases, it is often
easier to use a modular design, and build the final dashboard from a set of
simple Viewsheets. Each of the simple Viewsheets might contain just a few
controls, and provide specific functionality to the composite dashboard. 

Modular designs offer benefits in terms of reusability, because you can
deploy your simple Viewsheet modules in multiple dashboard applications.
For example, you can create a Viewsheet that contains a simple cluster of

http://help.adobe.com/en_US/FlashPlatform/reference/actionscript/3/flash/text/TextField.html#htmlText
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Gauges, and then just plug that Viewsheet into any dashboard to provide
the dashboard with that Gauge cluster.

Modular design also simplifies maintenance. When you use a Viewsheet in
multiple composite dashboards, you can update all of the composite
dashboards simultaneously by making changes centrally to the shared
module. 

To create a composite dashboard, simply nest a set of simple Viewsheets
within a parent Viewsheet. The following sections explain how to do this,
and how to synchronize the nested Viewsheets to work as a unified whole.

2.10.1 Nesting a Viewsheet

To embed or nest one Viewsheet within another Viewsheet, follow these
steps:

1. Create the Viewsheet that you wish to embed. (This is the
Viewsheet containing the common components that you wish to
embed in other Viewsheets.)

2. Save this common Viewsheet to the Repository (under ‘Global
Viewsheet’ or ‘User Viewsheet’, as desired.)

3. Open or create the host Viewsheet. (This is the Viewsheet within
which the common Viewsheet will be embedded.)

4. Open the Asset panel on the left side of the Visual Composer to
display the Asset tree. 

5. Drag and drop the common Viewsheet (saved in Step 2) from the
Repository into the host Viewsheet.

The common Viewsheet is now embedded within the host Viewsheet, and
all of the components marked ‘Visible in External Viewsheets’ within the
common Viewsheet are displayed. To synchronize selection and form
components within two (or more) Viewsheets, see Sharing Filters.

See Also
General Tab, for information on marking components as ‘Visible in
External Viewsheets’.
Nesting Viewsheets, for information on nested Viewsheet properties.

2.10.2 Opening a Nested Viewsheet

To open an embedded Viewsheet for editing, move the mouse over the
embedded area in the host Viewsheet, and then click the Viewsheet icon in
the upper left corner of the area. 



DATA MASHUP

370 of 1397

This feature is also available to end-users who view the host Viewsheet in
the Portal if there is at least one hidden element in the embedded
Viewsheet. (See Setting a Component to be Visible within External
Viewsheets for more information about hiding components.)

2.10.3 Synchronizing Nested Viewsheets

You can create interactivity between nested Viewsheets by synchronizing
their selection elements. See Sharing Filters for more information. 

2.11 Modifying the Dashboard Grid
It is possible to alter the Viewsheet grid by inserting or deleting cells, rows,
and columns. You can also resize the grid rows and column, and make the
grid invisible.

2.11.1 Inserting Space into a Dashboard

To insert a new cell, row, or column into the Viewsheet grid, follow these
steps:

1. Right-click on the cell, row, or column where you want the
insertion to take place, and select ‘Insert Cell(s)’ from the context
menu. This opens the ‘Insert Cell(s)’ dialog box.

2. In the ‘Insert Cell(s)’ dialog box, select the desired insertion type: 

a. To insert a single blank cell at the current grid location, select
‘Shift cells down’ or ‘Shift cells right’. 
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Note: The position of
a Viewsheet compo-
nent will be shifted
only if the new cell is
inserted in the same
row or column as the
grid cell occupied by
the component’s top-
left corner.

This inserts the new cell, and displaces the currently selected
cell (and all subsequent cells) downward or to the right,
respectively.

b. To insert a blank row or column at the current grid location,
select ‘Entire row’ or ‘Entire column’. 

This inserts the new row or column, and displaces the currently
selected row or column (and subsequent rows or columns)
downward or to the right, respectively.

2.11.2 Removing Space from a Dashboard

To delete a cell, row, or column from the Viewsheet grid, follow these
steps:

1. Right-click the cell, row, or column you want do delete, and select
‘Delete Cell(s)’ from the context menu. This opens the ‘Delete
Cell(s)’ dialog box.

2. In the ‘Delete Cell(s)’ dialog box, select the desired deletion type: 

a. To delete the single cell at the current grid location, select ‘Shift
cells up’ or ‘Shift cells left’. This deletes the currently selected
cell, and displaces the following cells upwards or to the left,
respectively.

b. To delete the currently selected column or row, select ‘Entire
row’ or ‘Entire column’. This deletes the current row or column,
and displaces the following rows or columns upward or to the
left, respectively.

2.11.3 Resizing the Dashboard Grid

To resize a row or column of the Viewsheet grid, follow these steps:

1. Move the mouse over a divider in the row or column header region.
The pointer changes to a resize tool.
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2. Drag the row or column divider to change the row height or
column width.

See Also
Resizing a Table Row, to adjust row size independently of the grid.
Resizing a Table Column, to adjust table cell size independently of the grid.

2.11.4 Zooming the Dashboard Grid

The Viewsheet grid provides a “zoom” feature that uniformly scales the
entire Viewsheet. This allows you to simultaneously reduce or enlarge all
components on the Viewsheet while keeping their relative positions and
sizes intact.

To zoom into or out of a Viewsheet, right-click in an empty region of the
grid, and select ‘Zoom In’ or ‘Zoom Out’ from the context menu.

The Viewsheet remains fully functional even while it is in a zoomed state.

See Also
Resizing a Component, to adjust the size of an individual component.

2.12 Setting Dashboard Initial State
Bookmarks are not available for Visualize Free.

When you save a Viewsheet using Visual Composer, the current state of
the Viewsheet (selection choices, menu choices, etc.) is saved as the
Viewsheet’s default bookmark. The default bookmark defines the default
state of the Viewsheet when it is first viewed by the user. Therefore, to set
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the default Viewsheet state, simply arrange the Viewsheet controls as
desired in Visual Composer, and then save the Viewsheet.

See Bookmarking a Dashboard or Bookmarking a Dashboard (Style
Scope Agile Edition) for more information about bookmarks.
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3 Using Dashboard Components

Viewsheet components are listed under the ‘Toolbox’ node of the
Component tree on the left side of Visual Composer. Viewsheet
components share a number of common features, including certain
properties, formatting options, and hyperlinks. The following sections
explain these common features.

See Also
Data View Components
Filter Components
Output Components
Form Components
Shape Components
Organization Components

3.1 Common Operations
The following sections discuss common Viewsheet operations.

3.1.1 Adding a Component

To add a component to a Viewsheet, follow these steps:

1. Open the Component panel on the left-side of Visual Composer.
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When no Viewsheet is
open for editing, the
components in the
Component panel
appear dimmed (dis-
abled). In this case,
verify that you are
editing Viewsheet, not
a Worksheet.

If the Component panel is not visible (i.e., the Asset panel is
showing), click the Component title bar at the bottom of the
screen.

2. Expand a node on the ‘Toolbox’ tree (Data View, Filter, Output,
Form).

3. Click and drag the desired component onto the Viewsheet grid. If
there is sufficient grid space, this creates the new component on the
grid.

If there is not sufficient space on the grid to add the new component
(due to other components nearby), the ‘Layout Options’ dialog box
will open. This allows you to specify the method for repositioning
nearby components to create space for the new component, or to
overlap the exiting component on top of the exiting components.
See Overlapping Components for details about the available
options.

In many cases, after you add a component, you will need to bind the
component to a data field in the data block. For information on how to do
this, see the individual Component section.

See Also
Data View Components, for Table, Chart, Crosstab.
Filter Components, for Selection List/Tree, Range Slider, Calendar.
Output Components, for Text and Gauge.
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Form Components, for Slider, Spinner, CheckBox, RadioButton,
ComboBox.

3.1.2 Deleting a Component

To delete an element from the Viewsheet grid, right-click the component
and select ‘Remove’ from the context menu (or press ‘Delete’ on the
keyboard).

You can also cut-and-paste the component so that it deleted from one
location and inserted at another.

See Also
Moving Components using Cut and Paste, for information on cut, copy,
and paste.
Properties Dialog Box, for information on hiding elements.
Setting a Component to be Visible within External Viewsheets, for
information on hiding nested Viewsheets.

3.1.3 Positioning a Component

To position a components in a Viewsheet, you can either drag the
component to the desired location, or cut and paste the component. To
change the size of a component, drag the resizing handles on the
component’s borders. The following sections discuss these methods in
more detail.

Moving a Component

To move a component by dragging with the mouse, follow these steps:

To move a table, drag
the title bar. To move
an output component,
drag its body.

1. Click the component to select it. This enables the “move” handle at
the top left corner.
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2. Click and drag on the “move” handle to move the component to the
desired location. (Hold down the ‘Alt’ key while dragging to snap
the component to the Viewsheet grid.) You can also use the
keyboard arrow keys to move the selected component. Hold down
the ‘Ctrl’ key together with the arrow keys to move the component
in smaller increments.

To align the component border with the border of another
component, drag until you see the green alignment guide and then
release. To move a component into alignment with other
components, see Aligning, Distributing, and Size-Matching
Components.

When exporting a Viewsheet to Excel, grid-aligned Text elements are
exported as editable values. Non-aligned Text elements are exported
as images.

Most components can be positioned and resized freely, independent of the
Viewsheet grid. However, the following components always snap the
Viewsheet grid: Checkbox, Radio Button, all Table types, Selection Lists/
Trees, and Groups.

See Also
Aligning, Distributing, and Size-Matching Components, to move a
component into alignment with other components.
Grouping Components, for information on creating component groups.

Resizing a Component

To resize a component, follow these steps:

1. Click the component to select it. This enables the component
“resize” handles.
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2. Click and drag on a resize handle or on the component border to
resize the component. (Hold down the ‘Alt’ key while dragging to
snap the component border to the grid.)

To align the border with the border of another component, drag
until you see the green alignment guide, and then release.

To resize a component to match another component’s size exactly,
see Aligning, Distributing, and Size-Matching Components.

Most components can be positioned and resized independent of the
Viewsheet grid. However, the following components always snap the
Viewsheet grid: Checkbox, Radio Button, all Table types, and Groups.

Components such as Charts, Tables, and Selection Lists display a scroll bar
if the component is not large enough to display all information in a single
view.

See Also
Aligning, Distributing, and Size-Matching Components, to resize a
component to match other components.
Zooming the Dashboard Grid, to resize all Viewsheet components
uniformly.
Grouping Components, for information on creating component groups.

Moving Components using Cut and Paste

Tip: To copy the con-
tents of a Text ele-
ment, double-click the
element.

To cut or copy a component, right-click the component and select ‘Cut’ or
‘Copy’ from the context menu. (Alternatively, click Ctrl-X or Ctrl-C on the
keyboard).

To insert the component elsewhere in the Viewsheet, right-click the desired
region and select ‘Paste’ from the context menu (Ctrl-V on the keyboard).
If other components already occupy this region, the inserted component
will overlap those components. See Overlapping Components for more
information.

You can copy and move a component with a single action. Simply Ctrl-
click the element, and drag it to a new location. The cursor displays a ‘+’
sign while dragging to indicate that a copy is being created.
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Overlapping Components

When you drag a new component from the Component tree onto an
existing Viewsheet component, you will see the ‘Layout Option’ dialog
box:

The following options are available:

• ‘Move component right’ places the new component in the first available
column to the right of your original placement (same row).

• ‘Move component down’ places the new component in the first
available row below your original placement (same column).

• ‘Place component into tabbed interface’ creates a tabbed interface with
each component in its own tab. 

When you move or paste an existing component onto another existing
component, you will see a slightly different version: 

The following options are available:

• ‘Move component here’ permits the components to naturally overlap
each other.
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• ‘Place component into tabbed interface’ creates a tabbed interface with
each component in its own tab. 

To move an overlapping component behind other components, right-click
the component and select ‘Send to Back’ from the context menu. To move
an overlapping component in front of other components, right-click the
component and select ‘Bring to Front’ from the context menu.

See Also
Creating a Tabbed Interface, for information on using placing components
in tabs.
Setting Colors, for information setting transparency.

Aligning, Distributing, and Size-Matching Components

You can align, distribute, and match sizes of multiple components on the
grid. Note that these positioning features apply only to “floating”
components (components that do not automatically snap to the Viewsheet
grid). Non-floating components such as Checkboxes, Radio Buttons,
Tables, and Groups cannot be positioned in this way.

To align multiple components, select the desired components and press the
‘Align’ button on the toolbar. Then choose the desired alignment.
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To distribute (equally space) multiple components, select the desired
components and press the ‘Align’ button on the toolbar. Then choose
‘Distribute Horizontally’ or ‘Distribute Vertically’.

To match the sizes of multiple components, select the desired components
and press the ‘Align’ button on the toolbar. Then choose the desired
‘Resize’ option.
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See Also
Moving a Component, to manually reposition a component.
Resizing a Component, to manually resize a component.

3.1.4 Setting a Component to be Visible within External 
Viewsheets

To set a component to be visible within an external Viewsheet (i.e., within a
Viewsheet that hosts the component’s Viewsheet as an embedded
Viewsheet), follow the steps below:

1. Right-click the element and select ‘Properties’ from the context
menu. This opens the ‘Properties’ dialog box.

2. Enable the ‘Visible in External Viewsheets’ option in the dialog
box. 
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3. Click ‘OK’.

All elements set as ‘Visible in External Viewsheets’ will be visible (unless
explicitly hidden) when the Viewsheet is embedded (nested) within
another Viewsheet. 

See Also
Building a Composite Dashboard, for information on embedding
Viewsheets.
Properties Dialog Box, for information on element visibility.

3.1.5 Selecting Components

To select a single component on the Viewsheet, click on the component
with the mouse. This activates the component’s “move” handle and
“resize” handles, which then allow you to position and size the component.

To simultaneously select multiple components on the Viewsheet, use one
of the following techniques. 

In some cases you
may need to Ctrl-click
on the component title
bar or “move” handle
to deselect the compo-
nent.

• Ctrl-click on each component in turn to add it to the selection. (Ctrl-
click an already-selected component to remove it from the selection.)

• Shift-click on each component in turn to add it to the selection. (Ctrl-
click an already-selected component to remove it from the selection.)

• Click in an empty region of the Viewsheet, and drag the mouse to draw
a selection region covering the desired components. When you release
the mouse, all components that are partially or wholly covered by the
selection region become selected.

You can also use
these techniques in
combination with
each other.

For example, by dragging the mouse to create the selection region below,
you can easily select all three components. You only need to include part of
each component within the selection region.

Move Handle Resize Handles
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Selecting multiple components allows you to move the components
together, group the components, and set common properties (e.g., font). 

See Also
Grouping Components, for more information on keeping components
together.
Positioning a Component, for more information on moving and resizing.

3.1.6 Selecting Groups and Grouped Components

To select the Container component itself, click on any component within
the group, or click in any empty space between group components. This
activates the Container’s “move” handle and “resize” handles, which then
allow you to position and size the Container component.

To select an individual component within a group, first select the group as
above, and then click the desired component. 

See Also
Organization Components, for complete information on group behavior.

Click between components Selected Container component
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3.1.7 Grouping Components

When you need to position a set of components together, it is helpful to
combine the components into a group. Components within a group always
retain their relative positions when the group is moved, and cannot be
positioned independently. 

Note: A group always snaps to the Viewsheet grid. Selection
Containers cannot be grouped.

To create a group, follow these steps:

1. Select the components you wish to group. (See Selecting
Components.) You can also select existing groups.

2. Right-click any selected component, and choose ‘Group’ from the
context menu (or press Ctrl-G on the keyboard).

This creates a new Container component to contain the selected
components. The components within a Container remain fully functional,
and you can adjust the component settings and properties in the usual
manner.

A Container component contains only individual components, not other
Container components. Therefore, if you group together two existing
groups, the existing Containers are deleted, and a single new Container is
created to contain all of the individual components from the two
preexisting groups. See Organization Components for complete
information about groups.

To undo a grouping, right-click the group and select ‘Ungroup’ from the
context menu (or press Ctrl-Shift-G on the keyboard).

See Also
Organization Components, for complete information on group behavior.
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Building a Composite Dashboard, to nest or embed one Viewsheet in
another.
Creating a Tabbed Interface, to provide tab access to overlapping
components.

3.2 Properties Dialog Box
To set the properties of a Viewsheet component, right-click the component
in the Viewsheet grid, and select ‘Properties’ from the context menu (or
press Ctrl-R on the keyboard). This opens the ‘Properties’ dialog box for
the component. 

To set the properties of a Container component, right-click in an empty
region between the components in the group, and select ‘Properties’ from
the context menu. This opens the ‘Properties’ dialog box for the Container
component.

Many of the properties in the ‘Properties’ dialog box are common across
components. The following sections discuss these common properties.
Properties that are unique to a particular element are discussed in the
section for that element.

See Also
Table Properties
Crosstab Properties
Chart Properties
Map Chart Properties
Selection List Properties
Selection Tree Properties
Range Slider Properties
Calendar Properties
Slider and Spinner Properties
Radio Button/Check Box/Combo Box Properties
Container Properties
Selection Container Properties
Shape Properties

3.2.1 General Tab

The General tab of the ‘Properties’ dialog box is common to many
components. It has five standard properties, shown in the table below. 

Name This name is used to refer to the component in binding and 
scripting. For purposes of scripting, the name should contain no 
spaces.

Visible in 
External 
Viewsheets

If checked, the component will be visible when this Viewsheet is 
embedded in another Viewsheet (see Building a Composite 
Dashboard). 
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3.2.2 Data Tab
Note: You can also
associate data with a
component by drag-
ging a field from the
data source onto the
component.

The Data tab in the ‘Properties’ dialog box is common to many
components. This tab allows you bind the component to the data source
that supplies the data displayed by the component. The Data tab has the
standard properties shown below.

Visible Show: Element is visible.
Hide: Element is invisible.
Hide on Print and Export: Element is visible on screen but 
hidden when exported. (

Enabled true: Element is interactive.
false: Element is not interactive.
Note: For Filter components, when ‘Enabled’ is ‘false’, existing 
selections in the component do not affect Viewsheet data.

Title The text that appears in the title bar (for components which have 
one). The ‘Visible’ option determines whether the title bar itself is 
displayed. Besides the ‘Title’ field, you can also edit title bar text 
by double-clicking the title bar itself.

Table The query, model, table, or Worksheet data block to which the 
component is bound. 

Target For form components (Radio Button, Spinner, etc.), the Embedded 
Table or Variable in the Worksheet to which the form value is passed. 
(See Using Form Components for further details.)

Column The field in the selected table that supplies data to the component.
Aggregate The method of data aggregation/summarization. (See Aggregation 

Options for a description of the methods.)
With A second data field for aggregation methods requiring two operands.
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Note: The Data tab has a different layout for Filter components.
See Filter Components for more details.

3.2.3 Advanced Tab

The Advanced tab of the ‘Properties’ dialog box is common to many
components, but options presented vary for different components.

3.2.4 Script Tab

The Script tab of the ‘Properties’ dialog box is common to all components,
and contains a Script Editor that allows you to insert component-level
scripts. These scripts can modify component properties based on
programmatic logic. See Advanced Dashboard Scripting for complete
information about scripting capabilities.

3.3 Format Dialog Box
The ‘Format’ dialog box provides options for changing the visual
appearance of elements and their representation of data. To open the
‘Format’ dialog box, right-click on a component and select ‘Format’ from
the context menu. 

Certain components have multiple regions that can be selected and
formatted independently. For example, a component title bar can always be
formatted independently of the component body.

Value The scaling factor used to display data on output components:
As Is: No scaling.

Thousands: Displayed values are divided by 103.

Millions: Displayed values are divided by 106.

Billions: Displayed values are divided by 109.
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A more specific for-
mat overrides a more
general format. For
example, a title bar
format overrides a
general component
format.

To format a particular region of a component, right-click on the desired
region, and select ‘Format’ from the context menu. To format the general
component (rather than a particular region), first make sure the component
is entirely deselected. Then right-click to select the general component (not
a region), and choose ‘Format’ from the context menu. See CSS Tab for a
list of regions that can be independently formatted.

The ‘Format’ dialog box contains the following tabs: Format, Alignment,
Font, Border, Color, and CSS. The following sections describe each of
these tabs. 

3.3.1 Format Tab

The Format tab allows you to specify a data format. Formatting is
available for the following data types: Date, Number, Currency, Text,
Percent.

A data format is a method for representing data as a string (for display
purposes). For example, the date December 31, 2008 might be displayed as
“12/31/08” or “Dec. 31, 2008” or simply “2008,” depending on the Date
format specified. Likewise, the number 123456 might be displayed as
“123,456” or “123456.00” or “00123456,” depending on the Number
format specified. 

Title bar

Body
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The following sections explain these available formats. 

Date Format

For ‘Date’ formatting, several predefined formats are available from the
pop-up menu.

Date masks follow the
java.text.SimpleDate-
Format format. To
insert a single-quote
in the date format, use
a double single-quote
(e.g., MMM ''yy).

To create other formats, use the following date masks:

M = Month
d = date
y = year
E = day of the week

Example: Date 
Format

For the date Nov 8, 2006:

M = 11; MM = 11; MMM = Nov; MMMM = November
d = 8; dd = 08;
yy = 06; yyyy = 2006
EEE = Wed

http://download.oracle.com/javase/7/docs/api/index.html?java/text/SimpleDateFormat.html
http://download.oracle.com/javase/7/docs/api/index.html?java/text/SimpleDateFormat.html
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EEEE = Wednesday

Therefore, the mask ‘MMM-dd-yyyy’ yields the string “Nov-08-2006.”

¢

Number Format

For ‘Number’ formatting, several predefined formats are available. 

Decimal formatting
only works if the
value is truly a
numeric type. If the
numeric value you
wish to format is actu-
ally text, convert the
type using JavaScript
so that formatting can
be applied.

The number format pattern string uses the pattern defined by the
java.text.DecimalFormat class. For example, to add commas to a number,
use ‘#, ###, ###. ##’. Using a ‘#’ will show a digit if needed, a ‘0’ will
display zero if the digit is not needed. Adding a ‘%’ at the end of the format
will multiply the value by 100 and display as a percentage.

You can add a suffix “K”, “M”, or “B” to the pattern string to automatically
divide the numerical value by 103, 106, or 109, respectively.

http://download.oracle.com/javase/7/docs/api/index.html?java/text/DecimalFormat.html
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To create custom multipliers, see Defining Custom Number Format
Multipliers in Advanced Server Administration.

Example: 
Number Format: 

For the number 124521.63:

#,###.## = 124,521.63
#,###.000 = 124,521.630

¢

Currency Format

The ‘Currency’ format represents the number as a currency rounded to two
decimal places For example, the number 25.867 displays as $25.87. The
currency symbol is automatically determined by the user locale upon login.
If the user has no assigned locale, the locale settings of the Operating
System are used.

To apply a fixed currency symbol for all locales, use the ‘Number’ format
option with a recognized currency symbol, e.g., ‘$#,###.##’.

Text Format

Use ‘Text’ format to add a prefix or suffix to string data. The special tag
‘{0}’ acts as a place holder for the actual data. Use the escape sequence
“\n” to insert a carriage return in the text.

Text Format Examples 

1. Consider a text column containing the following values:

Annie
Eric
Robert
Sue

The text format “Employee name: {0}” will display these values as
follows:

Employee Name: Annie
Employee Name: Eric
Employee Name: Robert
Employee Name: Sue

2. Consider a text column containing the following values: 

NJ
NY
CA
AZ

The text format “-{0}-” will display these values as follows:

-NJ-
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-NY-
-CA-
-AZ-

Localizing a Text Format

To apply localization within a text format, use a string identifier in curly
braces within the text format. The identifier in curly braces is used as a Text
ID to locate the corresponding replacement text (usually a translation into
another language) within the SreeBundle localization file. For example, the
string “{replacementText}” within a text format will use
“replacementText” as the Text ID.

For information on how to map Text IDs to replacement text in the
SreeBundle localization file, see Localizing Reports, Viewsheets, Data
Models/Queries in Advanced Server Administration.

Percent Format

The ‘Percent’ format displays a number as a percent. For example, percent
format displays the number 0.15 displays as “15%.”

Presenter

A presenter is a graphical representation of a numeric value. You can
assign a presenter to a numerical cell of a table or to a text element that
displays numerical data. 

The following table lists some commonly used presenters.

PRESENTER DESCRIPTION

Basic HTML Display strings with embedded tags, such as <b> for 
bold and <u> for underline

Checkmark For a ‘true’ Boolean value, displays a check mark. 
Otherwise, displays nothing.
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3.3.2 Alignment Tab
You can also set
alignments by using
the Viewsheet toolbar.

The Alignment tab settings determine the horizontal and vertical
alignment of text in Viewsheet components, including labels and titles on
Charts. The ‘Wrap Text’ option wraps text to multiple lines instead of
truncating the text.

Stars(Counter) Draws icons (stars) horizontally. The number of icons is 
determined by value; for example, two icons are drawn 
for a value of two. Options: ‘Icon’ specifies the image 
used, and ‘Icon Color’ sets the background color.

Horizontal Bar +/- Same as Horizontal Bar, but handles both positive and 
negative numbers. Options: ‘Color’ sets the positive bar 
fill color, ‘Maximum’ sets the value represented by a 
full-width bar, and ‘Negative Color’ sets the negative 
bar fill color.

Horizontal Bar Draws a horizontal bar based on the numeric cell value, 
similar to a bar chart. Options: ‘Color’ sets the positive 
bar fill color and ‘Maximum’ sets the value represented 
by a full-width bar.

Traffic Light Represents data ranges using three different colors. 
Options: ‘Border’ sets the border line style and color, 
‘Low’ sets the color for the low range, ‘Low Value’ sets 
low-middle transition point, ‘Mid’ sets the color for the 
middle range, ‘High’ sets the color for the high range, 
‘High Value’ sets the middle-high transition value, ‘Low 
at Top/Right’ indicates that the right or top light in the 
traffic light represents the low range (otherwise, the left 
or bottom light is the low range), ‘Horizontal’ indicates 
that the traffic light is displayed horizontally, ‘Single 
Light’ displays just one light instead of three, and ‘Size’ 
specifies the size of the traffic light.

Barcode Display various bar codes. Options: ‘Bar Height’ sets 
the height of the bars in pixels, ‘Bar Width’ sets the 
width of the bars in pixels, and ‘Resolution’ specifies 
the code image resolution in pixels/inch.

2D Code Two-dimensional QR Code for alphanumeric data. 
Options: ‘Width’ sets the width of the code in pixels.

Clockwise Rotation Rotates contents by 90 degrees in clockwise direction.
Counterclockwise 
Rotation

Rotates contents by 90 degrees in counter-clockwise 
direction.

Multi-Header
Button Adds a 3D border. Options: ‘Color’ sets the button 

color, ‘Bezel Width’ sets the width of the button border.
Shadow Adds a shadow. Options: ‘Shading’ sets the background 

color, ‘Shadow Width’ sets the thickness of the shadow, 
and ‘Text Color’ sets the font color.
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The text affected by the alignment setting varies for each component, as
shown below:

COMPONENT ALIGNMENT TARGET

Table Alignment can be set independently for title text, column 
header text, and data row text. Select the title bar, column 
header, or data cell, and then select ‘Format’ from the 
context menu to set the corresponding alignment.

Embedded Table Same as Table.
Crosstab Same as Table.
Chart Alignment can be set independently for axis titles, Y-axis 

labels, legend titles, and legend labels.
Selection List Alignment can be set independently for title text and choice 

labels. Select either the title bar or a choice cell, and then 
select ‘Format’ from the context menu to set the 
corresponding alignment.

Selection Tree Same as Selection List. Alignment can be set independently 
for each level of the hierarchy.

Selection 
Container

Alignment can be set on the component, and then 
overridden on each member selection.

Range Slider Alignment setting affects all text displayed on the slider 
(range display and endpoints). 

Calendar Alignment setting affects the title text.
Text Alignment setting affects the text
Slider Alignment setting affects the labels.
Spinner Alignment setting affects the spinner text.
Checkbox Alignment can be set independently for title text and choice 

labels. Select either the title bar or a choice cell, and then 
select ‘Format’ from the context menu to set the 
corresponding alignment.

Radio Button Same as Checkbox.
Combo Box Alignment setting affects the choice text.
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3.3.3 Font Tab

The Font tab allows you to specify the font face (Arial, Serif etc.), the style
(bold, italic), and the size of the font used for component text. 

The text affected by the font setting varies by component, as shown below:

COMPONENT ALIGNMENT TARGET

Table Font can be set independently for title text, column header 
text, and data row text. Select the title bar, column header, or 
data cell, and then select ‘Format’ from the context menu to 
set the corresponding font.

Embedded Table Same as Table.
Chart Font setting affects all the text, including axis labels, titles, 

legends, and text binding.
Crosstab Same as Table.
Selection List Font can be set independently for title text and choice text. 

Select either the title bar or a choice cell, then select 
‘Format’ from the context menu to set the corresponding 
font.

Selection Tree Same as Selection List. Font can be set independently for 
each level of the hierarchy.

Selection 
Container

Same as Selection List and Range Slider.

Range Slider Font setting affects all text displayed on the slider (range 
display and endpoints). 

Calendar Font setting affects the title text.
Text Font setting affects the text
Gauge Font setting affects labels and value (if present).
Slider Font setting affects the labels.
Spinner Font setting affects the spinner text.
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See Also
Adding Highlights to a Table, for information on conditional font
assignments.

3.3.4 Border Tab

The Border tab allows you to set border thickness and color for
components.

Borders for Tables
can also be set using
Table Styles.

For most components, the border setting determines the appearance of the
component’s boundary. For Tables, a border can be set for the table as a
whole, or independently for the title bar, columns headers, and column
cells.

Setting Borders

To set borders for a component, follow these steps:

1. Right-click the component, and select ‘Format’ form the context
menu. This opens the ‘Format’ dialog box.

For a Table, right-click on the region to which you want to add the
border:

a. Right-click a data cell to apply the border to all data cells in the
column. 

Checkbox Font setting affects the choice labels. Select a choice cell, 
and then select ‘Format’ from the context menu to set the 
corresponding font.

Radio Button Same as Checkbox.
Combo Box Font setting affects the choice text.

COMPONENT ALIGNMENT TARGET
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b. Right-click on the column header cell to apply the border to
only the column header. 

c. Right-click the title bar to apply the border to only the title bar.

Hint: To select the
Table without select-
ing any cells, drag
across the Table or
click on the Table
handle.

d. Right-click the Table handle (with no cell selected) to apply the
border to the Table’s outer boundary. The selected border color
is also applied to the cell boundaries. 

2. Click the Border tab in the ‘Format’ dialog box.

3. In the ‘Line’ panel, select a line style from the ‘Style’ box, and
select a line color from the ‘Color’ menu.

4. In the ‘Border’ panel, click the desired boundary to which you
want to apply the current line style.

Note: To change the border color first set the color and then
select the border type.

To set all borders to the current line style, click the ‘All Border’ button. To
remove all borders or return to the default style, click the ‘No Border’ or
‘Default’ button, respectively.

See Also
Table Properties, for information on setting borders using Table styles.

3.3.5 Color Tab

The Color tab allows you to set text color, background color, and
transparency for components.
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Colors for Tables can
also be set using
Table Styles and high-
lighting.

For Tables, a text and background color can be set for the table as a whole,
or independently for the title bar, columns headers, and column cells.

Setting Colors

To set a static foreground color, background color, and transparency
(alpha) for a component, follow the steps below:

1. Right-click the element, and select ‘Format’ form the context
menu. This opens the ‘Format’ dialog box.

For a Table component, right-click on the region of the table to
which you want to apply the property:

a. Right-click a data cell to apply the property to all data cells in
the column. 

b. Right-click on the column header cell to apply the property to
only the column header. 

c. Right-click the title bar to apply the property to only the title bar.

Hint: To select the
Table without select-
ing any cells, drag
across the Table or
click on the Table
handle.

d. Right-click the Table handle (with no cell selected) to apply the
property to the whole Table. This global table color or
transparency is overridden by the property specified for the
individual cell.

2. Select the Color tab in the ‘Format’ dialog box. 

3. In the ‘Text’ panel, select ‘Value’ from the right-side pop-up menu. 

4. Click on the color chip to select the desired foreground (text) color.
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5. Repeat the above steps in the ‘Fill’ panel to set the background
(fill) color.

6. Set the fill transparency by selecting a value from the ‘Alpha’
menu. A value of 0% indicates complete fill transparency (i.e., fill
color not visible), and a value of 100% indicates complete fill
opacity.

You can also color dynamically by specifying an form control (variable) or
an expression. See Dynamic Properties for details.

See Also
Adding Highlights to a Table, for information on conditional color
assignments.
Table Properties, for information on setting borders using Table styles.
Dynamic Properties, for information on setting color via variable or
expression.

3.3.6 CSS Tab

The CSS tab allows you to specify a CSS Class or ID to style the visual
properties of a component. 
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CSS is not available in Style Scope Agile Edition.

Before you can apply CSS styles based on ID or class, an administrator
must upload a CSS file containing the ID and class definitions. See
Uploading a CSS File in Advanced Server Administration for more
information.

The table below lists the component regions that can be independently
formatted, and the corresponding CSS “type” selectors. See Styling a
Dashboard with CSS for information about styling these regions using
CSS.

COMPONENT REGION CSS TYPE SELECTOR

Global Default None * (see below)
Viewsheet Viewsheet background Viewsheet (see below)
Table Table component Table

Table title bar TableTitle (see below)
Table column header See CSS TableStyle 

Properties in Advanced 
Server Administration.

Table body cells See CSS TableStyle 
Properties in Advanced 
Server Administration.
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Crosstab Crosstab component Crosstab
Crosstab title bar CrosstabTitle
Crosstab column headers See CSS TableStyle 

Properties in Advanced 
Server Administration

Crosstab row headers See CSS TableStyle 
Properties in Advanced 
Server Administration

Crosstab summary cells See CSS TableStyle 
Properties in Advanced 
Server Administration

Freehand Table Freehand Table component FreehandTable
Freehand Table title bar FreehandTableTitle
Freehand Table column 
headers

See CSS TableStyle 
Properties in Advanced 
Server Administration

Freehand Table row headers See CSS TableStyle 
Properties in Advanced 
Server Administration

Freehand Table summary 
cells

See CSS TableStyle 
Properties in Advanced 
Server Administration

Chart Chart component Chart
Chart axis titles ChartAxisTitle[axis=x]

ChartAxisTitle[axis=y]
ChartAxisTitle[axis=x2]
ChartAxisTitle[axis=y2]

Chart axis labels ChartAxisLabels[axis=x]
ChartAxisLabels[axis=y]
ChartAxisLabels[axis=x2]
ChartAxisLabels[axis=y2]

Chart labels generated by 
‘Show values’ and ‘Text’ 
visual binding

ChartPlotLabels

Chart legend title ChartLegendTitle
Chart legend content ChartLegendContent
Chart target line labels, for 
target line index n (starting 
from 1)

ChartTargetLabels[index='
n']

Chart pallet color, for color 
index n

ChartPalette[index='n']

Selection List Selection List component SelectionList
Selection List title bar SelectionListTitle
Selection List body cells SelectionListCell

COMPONENT REGION CSS TYPE SELECTOR
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Selection Tree Selection Tree component SelectionTree
Selection Tree title bar SelectionTreeTitle
Selection Tree nth-level 
body cells (levels are 
independent)

SelectionTreeCell[level='n']
, indexed from 0

Selection Tree measure text 
for nth-level body cells 
(levels are independent)

MeasureText[level='n'], 
indexed from 0

Selection Tree positive 
measure bar for nth-level 
body cells (levels are 
independent)

MeasureBar[level='n'], 
indexed from 0

Selection Tree negative 
measure bar for nth-level 
body cells (levels are 
independent)

MeasureNBar[level='n'], 
indexed from 0

Range Slider Range Slider component RangeSlider
Selection 
Container

Selection Container 
component

SelectionContainer

Title bar SelectionContainerTitle
Calendar Calendar component Calendar

Calendar title bar CalendarTitle
Calendar year/month header CalendarHeader
Calendar month labels CalendarMonths
Calendar day labels CalendarDays

Gauge Gauge component Gauge
Gauge tick labels GaugeTickLabel
Gauge value label GaugeValueLabel
Gauge value fill GaugeValueFill

Text Text component Text
Image Image component Image
CheckBox CheckBox component CheckBox

CheckBox title bar CheckBoxTitle
CheckBox body cells CheckBoxCell

RadioButton RadioButton component RadioButton
RadioButton title bar RadioButtonTitle
RadioButton body cells RadioButtonCell

Slider Slider component Slider
Spinner Spinner component Spinner
ComboBox ComboBox component ComboBox
TextInput TextInput component TextInput
Submit Submit component Submit
Upload Upload component Upload
Line Line Component Line
Rectangle Rectangle component Rectangle

COMPONENT REGION CSS TYPE SELECTOR
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All of the above regions can be formatted using the ‘Format’ dialog box or
using CSS. (See Styling a Dashboard with CSS.) To format parts of a table
(other than title bar) using CSS, see CSS TableStyle Properties in Advanced
Server Administration.

Viewsheet Background

Two specify a Viewsheet background, use the following definition:

Viewsheet {
background-color: blue;

}

This property can be used to coordinate the Viewsheet background color
with the color of the application in which the Viewsheet has been
integrated. If background-color is specified, as above, it will determine the
background color of the Viewsheet. If it is not specified, the Viewsheet
background color is inherited from the * type (see below). If neither the
Viewsheet nor * type define a background color, the Viewsheet background
defaults to white. 

Oval Oval component Oval
COMPONENT REGION CSS TYPE SELECTOR
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4 Data View Components

A Viewsheet typically contains at least one data view that presents the
primary analysis result. Data views can be in the form of a simple table, a
crosstab (pivot table), a chart, or a geographical map. 

All data view elements are listed under the ‘Toolbox > Data View’ node of
the Component tree.

See Also
Output Components, for information on graphical presentation of data.
Filter Components, for information on filtering the data view display. 
Form Components, for information on dynamically modifying Worksheet
results. 

4.1 Tables
This section explains how to create Viewsheet tables and set their
properties.

4.1.1 Creating a Table

There are several ways to create a new table.

Creating a Table by Dragging a Data Block

To create a table follow these steps: 

Dragging individual
data block columns
will create a Selec-
tion List/Tree, not a
Table.

1. Select a complete data block in the Component tree. 

2. Drag the entire data block directly onto the Viewsheet grid. 

Creating a Table with the Table Element

To create a table follow these steps:

1. Drag a Table element from the Component tree into the Viewsheet
grid. This creates an empty table element. 

2. Expand a data block node in the Component tree, and drag and
drop one or more columns onto the Table element.

Note: Cube dimensions and measures cannot be added to a Table.

3. Repeat to add additional columns. A green highlight on the Table
indicates where the dragged columns will be placed.
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See Also
Creating an Embedded Table, for information on displaying an Embedded
Table.
Creating a Crosstab, for information on generating pivot tables.

4.1.2 Creating an Embedded Table

An Embedded Table is a table into which you can manually enter data.
Embedded tables can be edited both within Visual Composer and within
the Portal, allowing the end-user to enter data in tabular form.

Note: Filter elements do not affect Embedded Tables.

An Embedded Table in a Viewsheet is always connected to an Embedded
Table in the underlying Worksheet. Edits that you make to the Viewsheet’s
Embedded Table are automatically propagated to the associated Worksheet
table at runtime. Data that you enter is saved with the Viewsheet, not with
the Worksheet, so edits that you make to one Viewsheet do not affect other
Viewsheets based on the same Worksheet.

To add a full Embedded Table data block, follow the steps below: 

1. Select an Embedded Table data block from the data source in the
Component panel. 
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2. Drag the entire data block directly onto the Viewsheet grid. This
adds the entire data block to the Viewsheet as an Embedded Table.

Ctrl-click to select
multiple cells.

3. (Optional) To delete an unwanted column or columns, click to
select the unwanted column header cell. Right-click on the selected
cell(s), and choose ‘Delete Column(s)’ from the context menu.

To build an Embedded Table column-by-column, follow the steps below:

1. Drag a Table element from the Component tree into the Viewsheet
grid. This creates an empty Table element. 

2. Expand an Embedded Table data block in the Component panel.

3. Drag-and-drop an individual column or columns onto the empty
Table element.

4. Repeat to add additional columns. A green highlight on the Table
indicates where the dragged columns will be placed.

See Also
Adding Hyperlinks to an Embedded Table, for information on using
hyperlinks.
Table Properties, for Embedded Table properties (same as regular table).
Form Components, for providing user input via graphical controls.
Format Dialog Box, for the available table formatting options.
Creating an Embedded Table, in Advanced Data Mashup.
Accessing Component Data, in Advanced Dashboard Scripting, to set
properties using embedded data.

4.1.3 Table Properties

The Table component’s ‘Properties’ dialog box provides General,
Advanced, and Script tabs. The next sections discuss the component-
specific properties available under these tabs.

See Also
Crosstab Properties, for information about Crosstab properties.
Properties Dialog Box, for information about common component
properties.
Format Dialog Box, for information on the ‘Format’ dialog box.



DATA MASHUP

408 of 1397

Table Properties: General Tab 

In addition to the common properties, the General tab in the ‘Table
Properties’ dialog box allows you to select a layout theme from the ‘Table
Styles’ panel. 

A table style is a set of predefined formats (fonts, alignments, backgrounds
etc.) that is directly applied to any table. The ‘Table Styles’ panel provides
access to a Style Library containing a large number of predefined table
styles. To select a table style, expand the desired category node (e.g. ‘Grid’,
‘Columns’, ‘Rows’, etc.) and click on one of the styles. A preview is of the
style is displayed on the right side.

The General tab of the ‘Properties’ dialog box for an Embedded Table
additionally provides a ‘Submit On Change’ option. When this option is
enabled (default), any changes that you make to entries in the Embedded
Table are immediately submitted to the linked Embedded Table in the
underlying Worksheet, which immediately updates any dependent data
views in the Viewsheet. 

When ‘Submit On Change’ is disabled, changes that you make to entries in
the Embedded Table are not submitted until you press the ‘Apply’ button in
the table title bar. Click the ‘Reset’ button to restore the table’s entries to
their most recently submitted state.
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See Also
General Tab, for information on properties common to the General tab.
Border Tab, for information on manually setting border styles.
Color Tab, for information on manually setting text and background colors.
Creating a Custom Table Style, in Advanced Report Design, to create new
table styles.

Table Properties: Advanced Tab

Table editing is not available in Style Scope Agile Edition.

The Advanced tab in the ‘Table Properties’ dialog box provides the
following Table-specific properties:

Shrink to 
Fit

When enabled, this reduces the height of the table to match the 
number of records displayed. For example, if the original table height 
(as designed) was 10 rows, and the user then makes selections which 
restrict the result set to five rows, the table’s bottom border will 
retract or “shrink” to eliminate any empty rows at the bottom of the 
table. 

Embedded 
Table

When enabled, specifies that the table is an Embedded Table. This 
makes the table cells editable by the user and removes any 
hyperlinks. (This option is only available if the table was originally 
created as an Embedded Table. See Creating an Embedded Table for 
more information.)

Enable 
Table 
Editing

This option allows users to modify various aspects of a table by 
inserting, removing, or changing data records. To perform validation 
checks on data entered by users, see Setting Column Editing Options. 
Modified table data can be written back to the database by an 
appropriate Viewsheet script. See Accessing User-Modified Data in a 
Table in Advanced Dashboard Scripting for information. The ‘Add 
Rows’, ‘Delete Rows’, and ‘Edit Rows’ settings are discussed below.

Add Rows Allows a user to add new rows to the table. To add a new row, the 
user should right-click a row in the table and select ‘Insert Row’ or 
‘Append Row’ from the context menu to respectively add a row 
before or after the clicked row. Added rows are not retained across 
sessions unless they are committed to the database by a Viewsheet 
script (see above). See Setting Column Editing Options for 
information about validation.

Delete 
Rows

Allows a user to delete rows from the table. To do this, the user 
should right-click a row in the table and select ‘Delete Row’ from the 
context menu. Deletions are not retained across sessions unless they 
are committed to the database by a Viewsheet script (see above).
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Note: End-user table editing options are available only if product
is licensed for Viewsheet Forms.

See Also
Accessing User-Modified Data in a Table, in Advanced Dashboard
Scripting, for information on reading and committing modified data.

4.1.4 Setting Column Editing Options
Note: Column editing options are available only if product is
licensed for Viewsheet Forms.

Edit Rows Allows a user to edit data in the table. Edited data is not retained 
across sessions unless committed to the database by a Viewsheet 
script (see above). See Setting Column Editing Options for 
information about validation.

Data Tip 
View

A Viewsheet component is displayed when mouse hovers over table 
area. The component is filtered based on the hover region. See Data 
Tip View for more details.

Flyover 
Views

Allows you to select a set of Viewsheet components which will be 
adaptively filtered as the user hovers the mouse or clicks on the table 
area. (Select ‘On Click Only’ if you want the filtered components to 
update when the user clicks.) If the table contains aggregated data, 
filtering is based on the grouping fields (dimensions) in the row on 
which the user hovers or clicks. If the table contains detail data, 
filtering is based on the non-numeric columns in the row on which 
the user hovers or clicks. See Flyover View for more details.

Shrink to 
Fit

When enabled, this reduces the height of the table to match the 
number of records displayed. For example, if the original table height 
(as designed) was 10 rows, and the user then makes selections which 
restrict the result set to five rows, the table’s bottom border will 
retract or “shrink” to eliminate any empty rows at the bottom of the 
table. 
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When you configure a table as “editable” (see Table Properties: Advanced
Tab), you can place restrictions on which columns may be edited by users,
and what types of values can be entered. 

To set the editing options for a particular column, follow the steps below:

1. Right-click the column header, and select ‘Column Option’ from
the context menu. This opens the ‘Column Option’ dialog box.

2. In the ‘Column Option’ dialog box, select ‘Enable Column
Editing’ to make the column editable by users.

Note: The Viewsheet’s onRefresh Handler script is re-executed each
time the user makes an edit to an editable table. See Accessing
User-Modified Data in a Table, in Advanced Dashboard Scripting,
for more details.

3. In the ‘Column Editor’ menu, select the type of editing control you
wish to provide to users. The available options are ‘Text Editor’,
‘ComboBox Editor’, ‘Date Editor’, ‘Number Editor’, ‘Float
Editor’, and ‘Boolean Editor’.

4. Press ‘OK’ to close the dialog box.
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Each type of column editor provides settings which allow you to restrict the
values that a user may enter into the column. This allows you to perform
validation checking on user input. See Validating User Input for the
available settings.

You can apply formatting to a editable column in the usual manner (see
Format Dialog Box). Formatting is applied to existing column data as well
as to any data that a user adds or edits in the column.

See Also
Table Properties: Advanced Tab, for information on enabling end-user
table editing.

4.1.5 Hiding Table Columns
Note: Column hiding options are available only if product is
licensed for Viewsheet Forms.

When you configure a table as “editable” (see Table Properties: Advanced
Tab), you can choose to hide specific table columns. This is useful in cases
when the table includes a primary key column (used to write data back to
the database) that should not be displayed to the user.

To set a column of an editable table as a hidden column, follow the steps
below:

1. Right-click the table title bar, and select ‘Hide Columns’ from the
context menu. This opens the ‘Hide Column’ dialog box.

2. In the ‘Available Columns’ panel, select the columns you want to
hide (Ctrl-click or Shift-click to select multiple columns), and press
‘Add’.
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3. Press ‘OK’ to close the dialog box and hide the columns.

To retrieve the value of a hidden column, use the script function
getHiddenColumnValue(col,row). See Accessing User-Modified Data in a
Table, in Advanced Dashboard Scripting, for more details.

See Also
Table Properties: Advanced Tab, for information on enabling end-user
table editing.

4.1.6 Validating User Input

You can configure TextInput components and editable table columns with
different types of input controls and validation features. The following
sections describe the available editors for TextInput components and
editable table columns.

See Also
Table Properties: Advanced Tab, for information on enabling end-user
table editing.

Text Editor

The ‘Text Editor’ provides the user with standard text field input. This
allows a user to simply type values into an editable table cell or TextInput
component. To mask the entered text, use the ‘Password Editor’ option
instead of the ‘Text Editor’ option.
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The following options are available in the dialog box:

You can find many regex tutorials and examples on the Internet (e.g., as
http://www.regular-expressions.info). Some sample expressions and error
message combinations are show below:

The following is a summarization of the regular expression syntax.

Alternatives separated by | 
Quantified atoms 
          {n,m} Match at least n but not more than m times. 
   {n,} Match at least n times. 
   {n} Match exactly n times. 

Pattern 
Check

Specifies a regular expression (regex) which the input must match. 
Failure to match the regular expression will cause the error message 
to be displayed.

Error 
Message

A text message to display when the pattern check fails. The 
placeholder “{0}” can be used to insert the user-entered value at a 
desired location in the error message. Example error message: “The 
value you entered, {0}, is not acceptable.”

PATTERN CHECK ERROR MESSAGE (SUGGESTED)

^[a-zA-Z0-9_]*$ Input can contain only numbers, letters, and underscore 
(_).

\d{3}-\d{3}-\d{4} Input must be a phone number with form ###-###-####.
^[a-zA-Z0-9_]{0,15}$ Input length must be 15 characters or fewer.

http://www.regular-expressions.info/
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   * Match 0 or more times. 
   + Match 1 or more times. 
   ? Match 0 or 1 times.  
a . matches everything except \n 
a ^ is a null token matching the beginning of a string or 
line (i.e., the position right after a newline or right 
before the beginning of a string) 
a $ is a null token matching the end of a string or line 
(i.e., the position right before a newline or right after 
the end of a string) 
Character classes (e.g., [abcd]) and ranges (e.g., [a-z])
Special backslashed characters work within a character class 
(except for backreferences and boundaries). 
\b is backspace inside a character class
Special backslashed characters 
\b null token matching a word boundary (\w on one side and 
\W on the other) 
\B null token matching a boundary that isn't a word boundary 

\A Match only at beginning of string
\Z Match only at end of string (or before newline at the 
end) 
\n newline 
\r carriage return 
\t tab 
\f formfeed 
\d digit [0-9] 
\D non-digit [^0-9] 
\w word character [0-9a-z_A-Z]
\W a non-word character [^0-9a-z_A-Z]
\s a whitespace character [ \t\n\r\f]
\S a non-whitespace character [^ \t\n\r\f]
\xnn hexadecimal representation of character
\cD matches the corresponding control character 
\nn or \nnn octal representation of character unless a 
backreference.
a \1, \2, \3, etc. match whatever the first, second, third, 
etc. parenthesized group matched. This is called a 
backreference. If there is no corresponding group, the 
number is interpreted as an octal representation of a 
character. 
\0 matches null character 
Any other backslashed character matches itself 
Expressions within parentheses are matched as subpattern 
groups and saved for use by certain methods. 

See Also
Setting Column Editing Options, for information on setting column
options.
Table Properties: Advanced Tab, for information on enabling end-user
table editing.

ComboBox Editor

The ‘ComboBox Editor’ provides the user with standard menu input. This
allows a user to simply select a value from a predefined list.
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To populate the menu items from a manually created list, follow the steps
below:

1. In the ‘Column Option’ dialog box, select the ‘Embedded’ option
and click on the ‘Edit’ button. This opens the ‘Embedded List
Values’ dialog box. 

2. Click the ‘Add’ button. This will populate the list with blank
‘Label’ and ‘Value’ fields. 

3. Double-click on the list elements, and enter a desired ‘Label’ and
‘Value’.

4. Repeat the above steps to insert more elements.
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5. Click ‘OK’ to close the dialog box.

To populate the menu items from the Viewsheet’s data source, follow the
steps below:

1. In the ‘Column Option’ dialog box, select the ‘Query’ option, and
click on the ‘Edit’ button. This opens the ‘List Values Selection’
dialog box. 

2. Select a data block from the list on the left side. Select the
appropriate fields from the ‘Label’ and ‘Value’ menus. 

3. Click ‘OK’ to close the dialog box.

Enable both the ‘Embedded’ and ‘Query’ options to merge together the
values retrieved from both sources into a single list.

See Also
Setting Column Editing Options, for information on setting column
options.
Table Properties: Advanced Tab, for information on enabling end-user
table editing.
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Date Editor

The ‘Date Editor’ provides the user with a pop-up calendar on which to
select a date. This allows a user to enter date values into an editable table
cell or TextInput component.

The following options are available in the dialog box:

See Also
Setting Column Editing Options, for information on setting column
options.

Minimum Specifies the start date for the permitted time interval. If the user 
enters a date earlier than the minimum, the error message will be 
displayed.

Maximum Specifies the end date for the permitted time interval. If the user 
enters a date later than the maximum, the error message will be 
displayed.

Error 
Message

A text message to display when the user enters a date outside the 
specified interval. The placeholder “{0}” can be used to insert the 
user-entered value at a desired location in the error message. 
Example error message: “The value you entered, {0}, is 
not acceptable.”
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Table Properties: Advanced Tab, for information on enabling end-user
table editing.

Integer Editor

Alphabetical charac-
ters and decimal
points are not permit-
ted. To enter deci-
mals, use the Float
Editor.

The ‘Integer Editor’ provides the user with standard integer field input.
This allows a user to type integer values into an editable table cell or
TextInput component.

The following options are available in the dialog box:

See Also
Setting Column Editing Options, for information on setting column
options.
Table Properties: Advanced Tab, for information on enabling end-user
table editing.

Minimum Specifies the lowest allowed integer value. If the user enters a value 
lower than the minimum, the error message will be displayed.

Maximum Specifies the highest allowed integer value. If the user enters a value 
higher than the maximum, the error message will be displayed.

Error 
Message

A text message to display when the user enters a value outside the 
specified interval. The placeholder “{0}” can be used to insert the 
user-entered value at a desired location in the error message. 
Example error message: “The value you entered, {0}, is 
not acceptable.”
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Float Editor

Alphabetical charac-
ters are not permitted.

The ‘Float Editor’ provides the user with a standard floating point field
input. This allows a user to type decimal values into an editable table cell or
TextInput component.

The following options are available in the dialog box:

See Also
Setting Column Editing Options, for information on setting column
options.
Table Properties: Advanced Tab, for information on enabling end-user
table editing.

Minimum Specifies the lowest allowed floating point value. If the user enters a 
value lower than the minimum, the error message will be displayed.

Maximum Specifies the highest allowed floating point value. If the user enters a 
value higher than the maximum, the error message will be displayed.

Error 
Message

A text message to display when the user enters a value outside the 
specified interval. The placeholder “{0}” can be used to insert the 
user-entered value at a desired location in the error message. 
Example error message: “The value you entered, {0}, is 
not acceptable.”
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Boolean Editor

The ‘Boolean Editor’ provides the user with a simple checkbox input. This
allows the user to enter “true” (checked) or “false” (unchecked) into an
editable table cell or TextInput component.

See Also
Setting Column Editing Options, for information on setting column
options.
Table Properties: Advanced Tab, for information on enabling end-user
table editing.

Password Editor

The ‘Password Editor’ option is the same as the Text Editor option, but
masks the entered text using ‘*’ characters.

4.1.7 Resizing a Table Column

To resize a table column, click and drag on the column border to obtain the
desired width. 

See Also
Resizing the Dashboard Grid, for information on changing the global grid
spacing.

4.1.8 Resizing a Table Row

To resize a table header row, click and drag on the Viewsheet row border
corresponding to the desired header row. Header rows can be resized
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independently of body rows. For a Freehand Table, the number of header
rows is defined in the Freehand Table Properties: Advanced Tab.

To resize the table body rows, click and drag on the Viewsheet row border
corresponding to the first body row. All other body rows adopt the same
size as the first body row.

See Also
Resizing the Dashboard Grid, for information on changing the global grid
spacing.

4.1.9 Adding Hyperlinks to a Table 

In tables, you can attach hyperlinks to a specific columns. 

Adding Hyperlinks to a Regular Table

To add hyperlinks to regular table data, right-click the table column to
which you wish to add the links, and select ‘Hyperlink’ from the context
menu.
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This opens the ‘Hyperlink’ dialog box. See the Hyperlinks section for
complete instructions on how to use the ‘Hyperlink’ dialog box.

Adding Hyperlinks to an Embedded Table

It is not possible to attach hyperlinks to the cells of an Embedded Table.
However, you can convert the Embedded Table into a regular table, and
then add the hyperlinks to the regular table.

To add hyperlinks to an Embedded Table using this method, follow the
steps below:

1. Right-click on the Embedded Table, and select ‘Properties’ from
the context menu. This opens the ‘Table Properties’ dialog box.

2. Disable the ‘Embedded Table’ option, and press ‘OK’.

3. Add hyperlinks to the desired column(s) as described in
Hyperlinks.

To restore the editability of the table, re-enable the ‘Embedded Table’
option in the ‘Table Properties’ dialog box. Note: This will remove any
hyperlinks from the table.

See Also
Creating an Embedded Table, for information on how to create an
embedded table.
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4.1.10 Adding Highlights to a Table

To add highlights to table data, right-click the table column to which you
wish to add the highlight, and select ‘Highlight’ from the context menu.

This opens the ‘Highlight’ dialog box. See the Highlights section for
complete instructions on how to use the ‘Highlight’ dialog box.

4.1.11 Displaying Table Cell Values Graphically

To display cell values using a graphical representation such as a colored bar
or QR code, follow the steps below. 

1. Select the table cell that you want to display graphically.

2. Right-click on the cell, and select ‘Format’ from the context menu.

3. On the Format tab of the ‘Format’ dialog box, select a desired
graphical representation from the ‘Presenter’ menu.
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4. Press the ‘Options’ button to open the ‘Presenter’ dialog box.

5. Specify the desired values for the presenter options, and press
‘OK’.

See Presenter for more information about the options.

6. Press ‘OK’ to close the ‘Format’ dialog box. This applies the
presenter to the selected cells.



DATA MASHUP

426 of 1397

See Also
Displaying Data in a Text Component Graphically, to use a presenter in a
Text component.
Presenter, for more information about presenters.

4.1.12 Changing Table Column Headers
You can also double-
click the column
header to modify the
text.

To change or format table column headers, right-click the desired column
header and select ‘Format’ from the context menu. See Format Dialog Box
for more details.

When a Crosstab is used to represent hierarchical cube dimensions, the
column headers may display all of the hierarchical components within
brackets. To override this behavior, manually format the column headers as
described. Alternatively, ask an administrator to set the property
olap.table.originalContent=false in the sree.properties file.

4.1.13 Sorting Table Columns

To sort a table column, hover the mouse over the right side of the column
header. This enables the ‘Sort Column’ button. Click the button once to
sort the column’s data in ascending (alphabetical) order, click a second
time to sort in descending (reverse alphabetical) order, and click a third
time to restore the original order.

To sort multiple columns simultaneously (nested sorting), hold down the
Ctrl-key as you click the ‘Sort Column’ button for the additional columns
to be sorted. The order in which you click the ‘Sort Column’ button for the
columns determines the nesting of the sorting. 

For example, click ‘Sort Column’ for a table’s ‘Company’ column and
then Ctrl-click ‘Sort Column’ for the ‘Order Number’ column to sort the
‘Order Number’ data on a company-by-company basis. The column header
displays a small number to indicate the sorting precedence.
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4.1.14 Exporting Table Data for Viewing

To export the data contained in a Table or Crosstab to an Excel file, follow
the steps below:

1. Click the ‘Export’ button in the Table title bar. This opens the
‘Export’ dialog box.

2. In the ‘Export’ dialog box, enter a name for the exported Excel file,
and press ‘OK’. 

This will save the table data as an Excel file in the browser’s default
download location.

4.1.15 Exporting Table Data for Editing

Viewsheets provide several features to assist in offline data editing. A user
can export data from a Viewsheet to an Excel file, edit the data values
within the Excel file, and re-import the revised data into the Viewsheet at a
later time. This gives a user the ability to edit a Viewsheet “offline,” while
not actively logged into the server.

Note: Offline editing features are available only if product is
licensed for Viewsheet Forms.

To configure a Viewsheet so that users can export data to an Excel file for
editing (and subsequent importing), follow the steps below:

1. For each table that you wish to make editable in Excel, right-click
the table, and select ‘Properties’ from the context menu. This opens
the ‘Table Properties’ dialog box.
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2. Select the General tab, and enter a unique name for the table in the
‘Name’ field. (This name will be used to label the table in the Excel
export, and to match the Excel table to the Viewsheet table during
subsequent importing.)

3. Select the Advanced tab, and check the ‘Enable Table Editing’
option. Select the desired editing features, ‘Add Rows’, ‘Delete
Rows’, and/or ‘Edit Rows’. See Table Properties: Advanced Tab
for more information about these options.

4. Press ‘OK’ to close the ‘Table Properties’ dialog box.

See Also
Table Properties: Advanced Tab, for information on how to make a table
editable.
Importing Excel Data into a Dashboard or Uploading a Dataset (Visualize
Free) for information on how to import the generated Excel file.
Exporting an Editable Dashboard, for information on how to export the
Viewsheet.

4.2 Freehand Tables
The basic methods for presenting tabular data in a Viewsheet are Tables
and Crosstabs. However, in some cases Tables and Crosstabs may not be
flexible enough to create the specific tabular layout that you require. 

For such cases, you can gain greater flexibility by using a Freehand Table.
A Freehand Table allows you to specify complex cell expansions and
associations, and integrate data from multiple data blocks into a single
table.

4.2.1 Creating a Freehand Table

There are two ways to create Freehand Tables, either as a new component
or by converting an exiting Table or Crosstab. The following sections
explain the two methods:

Creating a Freehand Table as a New Component

To create a new Freehand Table as a new component, follow the steps
below:

1. Drag a Freehand Table from the Component panel into the
Viewsheet. This adds a blank Freehand Table to the Viewsheet.

2. Press the ‘Edit’ button in the top-right corner of the Freehand
Table.
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This opens the binding dialog box for the Freehand Table. The
dialog box displays an interactive table diagram in the top panel, as
well as a Data panel and Options panel below.

A field name is not permitted to contain the “?” symbol when used
in a Freehand Table. To display data from such a field, first
create a copy of the field as a Calculated Field (see Calculated
Fields) or as an Expression Column (see Creating an Expression/
Formula Column in Advanced Data Mashup) with a legal name.

3. Drag the desired fields from the available data blocks into the table
diagram in the binding dialog box.
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4. Select ‘Expand Cell’ and set the expansion direction (‘Horizontal’
or ‘Vertical’) for any fields that return an array of values. 

5. (Optional) To populate a cell using script, press the ‘Edit’ button at
the bottom of the dialog box. This opens the Script Editor and
allows you to create a calculation based on cell values, parameter
values, component values, or values from any accessible query or
Worksheet.

Refer to the value in a cell of the table by using syntax
“$cell_name”, where cell_name is the name assigned in the ‘Cell
Name’ field for the cell being referenced.
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You can insert this reference easily by selecting the field name from
the ‘Cell’ folder in the editor. See Cell Referencing in Advanced
Dashboard Scripting for more advanced cell reference syntax.

Remember to set the ‘Expand Cell’ option for any expression that
returns an array of values.

To access the underlying data block, use the keyword data. For
example, toList(data['Company'],'sort=desc') returns a unique
sorted list of values from the ‘Company’ field of the table’s
underlying data block. Use query-style syntax to select data that
matches a specified condition. For example,
toList(data['Product@Category:$CategoryCell']) returns the
value from field ‘Product’ where the value in field ‘Category’
matches the value in the cell named ‘CategoryCell’.

To reference data from other data blocks in the underlying
Worksheet, see Referencing Data in the Worksheet Data Block. To
reference data from an arbitrary query or data worksheet, use
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runQuery() in the onRefresh handler. See Accessing Query Data
for more information on using runQuery().

6. To add rows and columns, right-click on a cell in the table diagram
and select the desired option from the context menu.

For more detailed information on how to configure expansion, grouping,
and other properties, see Walkthrough: Freehand Table.

Creating a Freehand Table from an Existing Table or Crosstab

To create a Freehand Table from an existing Table or Crosstab, follow the
steps below:

1. Right-click on the existing Table or Crosstab, and select ‘Convert
to Freehand Table’.

2. (Optional) If the original Crosstab had a table style applied, the
appearance may change slightly after conversion. To restore the
original style, follow the steps below:
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a. Right-click on the Crosstab and select ‘Properties’ from the
context menu. This opens the ‘Properties’ dialog box.

b. Select the Advanced tab in the ‘Properties’ dialog box.

c. Adjust the header and trailer options to correctly reflect the
number of header and trailer rows/columns in the table.

d. Press ‘OK’ to close the dialog box.

3. Press the ‘Edit’ button in the top-right corner of the new Freehand
Table.

This opens the binding dialog box for the Freehand Table. The
dialog box displays an interactive table diagram in the top panel, as
well as a Data panel and Options panel below.
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4. Add rows and columns as desired. To do this, right-click on a cell
in the table diagram and select the desired option from the context
menu.

5. Drag any additional desired fields from the available data blocks
into the table diagram in the binding dialog box.
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6. Adjust the expansion directions and other properties for the
individual cells as desired.

For more detailed information on how to configure expansion, grouping,
and other properties, see Walkthrough: Freehand Table.

See Also
Creating a Table, for information on creating a regular table.
Creating a Crosstab, for information on creating a regular crosstab.

4.2.2 Walkthrough: Freehand Table

The following walkthrough illustrates how you can create a complex data
layout by using a freehand table.

Walkthrough In this example, you will create a custom crosstab that breaks down sales
totals both according to individual ‘State’ and ‘Category’ combinations,
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and simultaneously according to ‘Order Date’ and ‘Category’
combinations. 

In a regular Crosstab, the data is represented with a nested header structure,
such as shown below. Note that the aggregated measure (‘Total’) is
represented for every combination of ‘State’, ‘Date’, and ‘Category’.

Instead, in this example you will create a table where the ‘Date’ headers are
not nested within the ‘State’ headers, but are rather displayed separately, as
shown below.

To create this table, begin by creating a regular Crosstab that contains just
the ‘State’ and ‘Category’ combinations. You will then convert this table to
a Freehand Table, and use basic Freehand Table techniques to add the
‘Date’ headers. 

Follow the steps below:

A Worksheet is also
called a “data set” in
Style Scope Agile
Edition.

1. Create a new Viewsheet based on the sample ‘Sales Explore’
Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Drag a Crosstab component from the Components panel into the
Viewsheet. This opens the Crosstab Editor. 

3. From the ‘Sales’ data block in the Data Source panel, drag the
following fields into the Crosstab Editor:

a. Drag the ‘Category’ field to the ‘Row Header’ panel.

b. Drag the ‘State’ field to the ‘Column Header’ panel.

c. Drag the ‘Total’ field to the ‘Measure’ panel.
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d. Click the ‘State’ field in the ‘Column Header’ panel to select it.
From the ‘Ranking’ menu in the bottom panel, select ‘Top’.
Enter ‘10’ as the number of groups. (This will return the top 10
groups according to the summed total.)

e. Press ‘Apply’ to close the binding dialog box. This creates a
new Crosstab in the Viewsheet.

4. Right-click the Crosstab, and select ‘Convert to Freehand Table’
from the context menu. 

5. Press the ‘Edit’ button in the table title bar to open the Table Editor.

6. Shift-click to select all of the ‘State’ cells in the header row. Press
the ‘Fill Color’ toolbar button, and specify a light blue background.
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7. You will now use freehand table operations to add the ‘Date’
headers to the table. Follow the steps below:

a. Press the ‘Edit’ button in the top-right corner of the Freehand
Table. This opens the Table Editor.

b. Right-click the top-right corner cell and select ‘Append
Column’ from the context menu. This adds a new column.

c. From Data Source panel, drag the ‘Date’ field to the new top-
right corner cell of the table. This adds the ‘Date’ field as a
column header.
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d. Click to select this new ‘Date’ cell. Next to the ‘Expand Cell’
option in the bottom panel, select ‘Horizontal’. This sets the
year groups in the ‘Date’ field to display horizontally, as
multiple columns headers.

e. Press the green ‘Apply’ button at the top of the binding dialog
box to close the dialog box.

f. Expand the table horizontally so that you can see all columns.
Shift-click to select all of the ‘Date’ headers. Press the ‘Fill
Color’ button in the Visual Composer toolbar and set a yellow
background for the ‘Date’ headers.

8. You will now use freehand table operations to add an aggregate
‘Total’ measure corresponding to the year groups. Follow the steps
below:

a. Press the ‘Edit’ button in the top-right corner of the Freehand
Table to reopen the Editor.

b. From the Data Source panel, drag the ‘Total’ field to the
bottom-right corner cell of the table diagram. This adds the
‘Total’ field as a measure.
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c. Press the green ‘Apply’ button to close the binding dialog box.

9. Observe that the ‘Category’ row headers are currently sorted
alphabetically (e.g., Business, Educational, Games, etc.). To sort
the categories by the value of the corresponding aggregate total,
follow the steps below:

a. Press the ‘Edit’ button in the top-right corner of the Freehand
Table to reopen the Editor.

b. Click to select the grouped ‘Category’ cell (bottom-left cell).

c. Press the ‘Edit’ button adjacent to the ‘Group’ option. From the
‘Sort’ menu, select the option ‘By Value (Desc)’. 
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d. Press the green ‘Apply’ button. Observe that the categories are
now shown in descending order according to the totals (e.g.,
Business, Hardware, Personal, etc.).

10. Add a row of grand totals at the bottom of the Freehand Table.
Follow the steps below:

a. Press the ‘Edit’ button in the top-right corner of the Freehand
Table to reopen the Editor.

b. Right-click on any cell in the bottom row of the table diagram,
and select ‘Insert Rows/Columns’. This opens the ‘Insert Rows/
Columns’ dialog box.
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c. Configure the settings to insert one row ‘After the Selection’,
and press ‘OK’. This inserts a new row into the table diagram.

d. Right-click on one of the ‘Total’ cells, and select ‘Copy’ from
the context menu.

e. Right-click in the empty cell below one of the ‘Total’ cells, and
select ‘Paste’ from the context menu. This places a copy of the
‘Total’ field into that cell.
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f. Repeat the above step for the empty below the other ‘Total’ cell.

g. Click to select the ‘Total’ cell at the center of the table diagram.
In the ‘Row Group’ and ‘Column Group’ menus, select the
‘default’ options, and press the green ‘Apply’ button.

The ‘Row Group’ and ‘Column Group’ settings for a cell
determine how the cell will respond to the expansion of other
cells. To anchor the selected cell to a expanding grouping cell
(so that the selected cell will observe the same grouping as it
expands), select the name of the desired grouping cell in the
‘Row Group’ or ‘Column Group’ menu. 

The ‘default’ option for ‘Row Group’ selects the nearest
candidate grouping cell (if one exists) in the same row and to the
left of the selected cell. In this example, the ‘Category’ cell
provides a candidate row grouping cell in the same row as the
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selected ‘Total’ field. Therefore, in this case the ‘default’ option
in the ‘Row Group’ menu is equivalent to ‘Category’.

The ‘default’ option for ‘Column Group’ selects the nearest
candidate grouping cell (if one exists) in the same column and
above the selected cell. In this example, the ‘State’ cell provides
a candidate column grouping cell in the same column as the
selected ‘Total’ field. Therefore, in this case the ‘default’ option
in the ‘Column Group’ menu is equivalent to ‘State’.

h. Specify the same ‘default’ options for the other ‘Total’ cells.

i. Double-click in the bottom-left cell of the table, and enter the
text “Totals”. Press the green ‘Apply’ button.

11. Expand the table as needed to show all rows and columns. 

4.2.3 Freehand Table Properties

The Freehand Table component’s ‘Properties’ dialog box provides
General, Advanced, and Script tabs. The next sections discuss the
component-specific properties available under these tabs.

See Also
Table Properties, for information about regular Table properties.
Properties Dialog Box, for information about common component
properties.
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Format Dialog Box, for information on the ‘Format’ dialog box.

Freehand Table Properties: General Tab 

The General tab in the ‘Freehand Table Properties’ dialog box is the same
as for regular tables.

See Also
General Tab, for information about common properties in the General tab
Table Properties, for information about general table properties.

Freehand Table Properties: Advanced Tab

The Advanced tab in the ‘Freehand Table Properties’ dialog box provides
the following freehand table-specific properties.

Header Rows The number of initial rows that should be treated as header 
rows when a table style is applied.

Header Columns The number of initial columns that should be treated as header 
columns when a table style is applied.

Trailer Rows The number of final rows that should be treated as trailer rows 
when a table style is applied.

Trailer Columns The number of final columns that should be treated as trailer 
columns when a table style is applied.

Shrink to Fit When enabled, this reduces the height of the table to match the 
number of records displayed. For example, if the original table 
height (as designed) was 10 rows, and the user then makes 
selections which restrict the result set to five rows, the bottom 
table border retracts or “shrinks” to eliminate any empty rows 
at the bottom of the table. 

Data Tip View A Viewsheet component is displayed when mouse hovers over 
table area. The component is filtered based on the hover 
region. See Data Tip View for more details.

Flyover Views Allows you to select a set of Viewsheet components which will 
be adaptively filtered as the user hovers the mouse or clicks on 
the crosstab area. (Select ‘On Click Only’ if you want the 
filtered components to update when the user clicks.) Filtering 
is based on the grouping fields (dimensions) in the row and 
column on which the user hovers or clicks. See Flyover View 
for more details.
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4.3 Crosstabs
A crosstab, also known as a pivot table, contains one or more column
headers and one or more row headers, and displays aggregated measure
values at the row-column intersections. 

For example, a train schedule displays dates horizontally across (column
header), station names vertically down (row header), and departure times
(measure) at the intersections. Not every row-column combination need
have an associated measure value; for example, there may be combinations
of date and station for which there is no corresponding train departure.

In general, the values at the row-column intersections of a crosstab
represent summary information of a measure, rather than point values. For
example, a crosstab with row headers representing ‘Salesperson’ and
column headers representing ‘Month of Year’ might contain values at the
intersections representing ‘Average Sale Price’ or ‘Maximum Sale Price’.
The measure in both cases is ‘Sale Price’. The summarization method is,
respectively, Average or Maximum. By effectively using summarization,
crosstabs can display large amounts of data in a compact form.

4.3.1 Creating a Crosstab

To add a crosstab to a Viewsheet, follow the steps below:

1. Drag the Crosstab element from the Component tree into the
Viewsheet grid. 

2. Move the mouse over the top right corner of the crosstab, and click
the ‘Edit’ button. 
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This opens the Crosstab Editor.

The panel displays all
OLAP cubes defined
on the data source. 

3. In the Data Source panel, expand a data block, query, data model,
or OLAP cube (hierarchical model) to display the available
dimensions and measures.

4. Drag the desired columns or cube dimensions into the ‘Column
Headers’ and ‘Row Headers’ regions. 

You can change the
order of multiple
headers or measures
by dragging them up
or down.

5. Drag the desired columns or cube measures into the region labeled
‘Measures’.
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For more information
about these dimen-
sion properties, see
Editing a Dimension.

6. (Optional) Specify group totals and ranking:

a. Click on a dimension in the row header or column header. This
displays the ‘Sort’, ‘Ranking’, and ‘Group Total’ controls in the
bottom panel. For a date-type dimension, a ‘Level’ property is
also provided.

b. In the ‘Sort’ menu, specify how the values in the field should be
ordered. ‘Ascending’ and ‘Descending’ sort the values in
alphabetical or reverse-alphabetical order. ‘By Value (Asc)’ and
‘By Value (Desc)’ sort the values according to the aggregate
measure selected in the adjacent menu. 

To specify an arbitrary sort order, select the ‘Manual’ option in
the ‘Sort’ menu, and press the ‘Edit’ button to open the ‘Manual
Ordering’ dialog box. To reorder an item in the ‘Manual
Ordering’ dialog box, drag the item up or down within the list or
select the item and press the ‘Up’ or ‘Down’ buttons. Press
‘OK’ to close the dialog box.
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c. In the ‘Group Total’ menu, specify whether group totals should
be shown.

d. In the ‘Ranking’ menu, Select the ‘Top’ or ‘Bottom’ filter, and
specify the (integer) number of top or bottom groups to select.
In the adjacent menu, specify the measure by which groups
should be ranked. 

e. In the ‘Level’ menu (for date-type field), select the desired
grouping for the dates. For more information about the available
level options, see Editing a Dimension.

f. Select ‘Group all others together’ to create an “Others” category
which represents (in aggregate) all the groups excluded by the
Top/Bottom-N filter.

These controls are
disabled for OLAP
cubes. Cube aggrega-
tions are defined in
the model itself. (See
OLAP Overlay – Multi-
dimensional Analysis
in the Advanced Data
Modeling.)

7. Click on a measure, and select the summarization method from the
‘Aggregate’ menu. 

a. To display a univariate measure (‘Sum’, ‘Count’, etc.) as a
percentage, select the basis for percentage in the ‘Percentage of’
menu. 

‘None’ displays the original aggregate measure values with no
percentages taken. ‘Group’ displays each aggregate measure
value as a percentage of the aggregate value computed on the
superordinate group (defined by the header one level above the
finest-granularity header). This option is only available when
two or more row headers or two or more column headers have
been specified. ‘GrandTotal’ displays each aggregate measure
value as a percentage of the aggregate value computed on the
full row or column.

b. If you choose a percentage representation, click the ‘Options’
button (at the top of the dialog box) to select the dimension
along which the percentage is computed (‘Rows’ or
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‘Columns’). Percentage by rows uses the row totals, and by
columns uses the column totals.

c. To display a bivariate aggregation measure (e.g., ‘Correlation’,
‘Weighted Average’, etc.), select the second operand (column)
from the ‘with’ menu. 

8. Press the green ‘Apply’ button to close the Editor.

9. If desired, expand the crosstab horizontally so that all of the column
headers are visible.

See Also
Crosstab Aggregation Methods for information on summarization options.
OLAP Overlay – Multidimensional Analysis, in Advanced Data Modeling,
for general information on hierarchical overlays. 

4.3.2 Crosstab Properties

The Crosstab component’s ‘Properties’ dialog box provides General,
Advanced, Hierarchy, and Script tabs. The next sections discuss the
component-specific properties available under these tabs.

See Also
Table Properties, for information about regular Table properties.
Properties Dialog Box, for information about common component
properties.
Format Dialog Box, for information on the ‘Format’ dialog box.

Crosstab Properties: General Tab 

The General tab in the ‘Crosstab Properties’ dialog box is the same as for
regular tables.

See Also
General Tab, for information about common properties in the General tab
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Table Properties, for information about general table properties.

Crosstab Properties: Advanced Tab

The Advanced tab in the ‘Crosstab Properties’ dialog box provides the
following crosstab-specific properties.

Fill Blank Cell 
With Zero

Places a zero value in measure cells corresponding to row and 
column heading combinations for which no records exist. 
Otherwise, these cells are simply left blank.

Summary Cells 
Side By Side

Places multiple aggregated measures side-by-side, rather than 
stacking them vertically.

Enable Drilling Allows the user to drill up and down in date or dimension 
fields. See Drilling Down into a Crosstab for more 
information.

Enable Ad Hoc 
Editing

Allow end users to access the Crosstab Editor and edit the 
table.

Shrink to Fit When enabled, this reduces the height of the table to match the 
number of records displayed. For example, if the original table 
height (as designed) was 10 rows, and the user then makes 
selections which restrict the result set to five rows, the bottom 
table border retracts or “shrinks” to eliminate any empty rows 
at the bottom of the table. 

Data Tip View A Viewsheet component is displayed when mouse hovers over 
crosstab area. The component is filtered based on the hover 
region. See Data Tip View for more details.

Flyover Views Allows you to select a set of Viewsheet components which will 
be adaptively filtered as the user hovers the mouse or clicks on 
the crosstab area. (Select ‘On Click Only’ if you want the 
filtered components to update when the user clicks.) Filtering 
is based on the grouping fields (dimensions) in the row and 
column on which the user hovers or clicks. See Flyover View 
for more details.
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Crosstab Properties: Hierarchy Tab

The Hierarchy tab in the ‘Crosstab Properties’ dialog box allows you to
specify the hierarchy for a custom drill-down. The procedure for this is
the same as that for a Chart. See Chart Properties: Hierarchy Tab for
details.

For information on how to navigate a crosstab with drill-downs, see
Drilling Down into a Crosstab.

4.3.3 Crosstab Aggregation Methods

In general, there are many data records that correspond to a given row and
column heading in the crosstab. The values of the measures for these
records must therefore be aggregated to yield the single scalar value that
appears at a given row-column intersection. The aggregation method
specified by the ‘Aggregate’ menu determines the way in which this
summarization is done. 

Aggregation Example

As an example of crosstab aggregation, consider the crosstab configuration
below.

In this configuration:

• Row dimension is a ‘Region’/’State’ hierarchy

• Column dimension is a ‘Category’/’Product’ hierarchy

• Measure is ‘Quantity Purchased’

The ‘Aggregate’ menu specifies ‘Sum’, which indicates that each value in
the crosstab will represent the sum of ‘Quantity Purchased’ taken over all
records matching the given row and column headings. Thus, for the row
region heading ‘USA East’ and the column category heading ‘Business’,
the summary value of the measure shown in the crosstab represents the
summed quantity of all ‘Business’ category products purchased by ‘USA
East’ region customers. 
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In the same way, if you set the ‘Aggregate’ menu to ‘Max’, the summary
value shown in the crosstab for the above row and column combination
would represents the maximum quantity of ‘Business’ category products
purchased by any ‘USA East’ region customer.

See Also
Crosstab Properties: Hierarchy Tab, for information on how to specify a
custom drill-down hierarchy.

Aggregation Options

The table below lists the available crosstab aggregation measures. You can
choose to display univariate aggregations (e.g., ‘Sum’, ‘Count’) as a
percentage value by selecting the percentage basis (e.g., ‘Group’,
‘GrandTotal’) from the accompanying ‘Percentage of’ menu. 

For the bivariate aggregation methods (e.g., ‘Correlation’, ‘Weighted
Average’), you will need to select a variable (column) to use as the second
operand in the computation. Make this selection in the menu labeled ‘with’.

Table 3.     Aggregation Measures.

AGGREGATE
MEASURE

DESCRIPTION

Sum Displays the sum of the measure values for the 
given row and column headings

Average Displays the average of the measure values for the 
given row and column headings

Max Displays the maximum of the measure values for 
the given row and column headings

Min Displays the minimum of the measure values for the 
given row and column headings

Count Displays the total count of measure values for the 
given row and column headings. This represents the 
total number of records corresponding to the given 
row and column headings, and is the same value for 
any selected measure.



DATA MASHUP

454 of 1397

4.3.4 Grouping Crosstab Headers into Named Groups

You can agglomerate data from different crosstab header values into larger
categories called named groups. For example, you can combine column
header labels designating individual states MA, CT, NY, NJ, etc., into
larger groups such as ‘New England’ and ‘Mid-Atlantic’. 

Named groups cannot be defined for date fields. 

To create named groups for crosstab header labels, follow the steps below:

1. Ctrl-click to select the individual crosstab header labels (from the
same heading level) that you want to combine into a single group.

Distinct Count Displays the count of unique measure values for the 
given row and column headings. 

First Displays the first value for the measure (for the 
given row and column headings) when sorted based 
on the values in a second column, specified by the 
menu labeled ‘by’.

Last Displays the last value for the measure (for the 
given row and column headings) when sorted based 
on the values in a second column, specified by the 
menu labeled ‘by’.

Correlation Displays the Pearson correlation coefficient for the 
correlation between the measure values (for the 
given row and column headings) and the 
corresponding values in a second column, specified 
by the menu labeled ‘with’.

Covariance Displays the covariance between the measure values 
(for the given row and column headings) and the 
corresponding values in a second column, specified 
by the menu labeled ‘with’.

Variance Displays the (sample) variance of the measure 
values for the given row and column headings. 

Std Deviation Displays the (sample) standard deviation of the 
measure values for the given row and column 
headings.

Variance (Pop) Displays the (population) variance of the measure 
values for the given row and column headings. 

Std Deviation (Pop) Displays the (population) standard deviation of the 
measure values for the given row and column 
headings.

Weighted Average Displays the weighted average of the measure 
values for the given row and column headings. The 
weights are given by the corresponding values in a 
second column, which is specified by the menu 
labeled ‘with’.

AGGREGATE
MEASURE

DESCRIPTION
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You can group exist-
ing groups to make
larger groups.

2. Right-click on one of the selected labels, and select ‘Group’ from
the context menu. This opens the ‘Group Name’ dialog box.

3. Enter a name for the new group in the ‘Group Name’ dialog box,
and click ‘OK’.

This replaces the selected labels with the label for the named
grouping, and agglomerates the data corresponding to the original
labels under the new label.

4. Repeat the above steps to add additional named groups.

To decompose an existing name group, right-click on the header label and
select ‘Ungroup’ from the context menu.
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See Also
Grouping Chart Labels into Named Groups, to create groupings in a chart.

4.3.5 Drilling Down into a Crosstab

When a crosstab header displays a date field or a cube dimension, the
crosstab automatically provides the user with the ability to drill down to
finer levels of resolution of the date or dimension.

To drill down into a date or cube dimension on a crosstab header, follow
these steps:

The ‘+’ symbol is
only visible when you
hover over the
crosstab.

1. Hover the mouse over the crosstab. For headers that represent date
or cube dimension data, this will display a ‘+’ symbol at the left
side of the header. 

2. Click the ‘+’ symbol to drill down to the next level of the date or
dimension.

3. Repeat the above steps to drill down to deeper levels of the
hierarchy.



DATA MASHUP

457 of 1397

4. To drill up to a higher level of the date or dimension hierarchy,
hover the mouse over the crosstab. This displays a ‘–’ symbol at the
left side of expanded headers.

5. Click the ‘–’ symbol to drill up to the higher level of the date or
dimension hierarchy.

To disable the drilling feature for a particular crosstab, deselect the ‘Enable
Drilling’ option in the Advanced tab of the ‘Crosstab Properties’ dialog
box. To specify a custom drill hierarchy, including custom date levels, see
Crosstab Properties: Hierarchy Tab.

See Also
Crosstab Properties: Hierarchy Tab, for information on how to create a
custom drill-down.
Drilling Down into a Chart, to perform the drill operation on a chart
dimension.

4.3.6 Exporting Crosstab Data

To export the aggregated data displayed in a Crosstab to an Excel file, see
Exporting Table Data for Viewing.

To view or export the detail data on which the aggregations are based,
follow the steps below: 

1. Select the desired aggregates by clicking the appropriate cells,
rows, or columns in the Crosstab.

2. Click the ‘Show Details’ button at the top-right of the Crosstab.
This opens a panel containing the detail data.
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To close the data panel, click the red ‘X’ in the top-right corner.

Exporting Detail Data

To export the detail data, press the ‘Export’ button in the data panel. 

Formatting Detail Data

To format values in the data panel, right-click on the column you wish to
format, and select ‘Format’ from the context menu.
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This opens the ‘Format’ dialog box, which allows you to set the format for
the column. See Format Tab for information about the available options.

Formatting that you specify is saved with the Viewsheet, and is
automatically applied to the column whenever the ‘Show Details’ option is
used, both in Visual Composer and the User Portal.

4.4 Charts
A chart displays a graphical view of summarized data (the graphical
equivalent of a crosstab). Viewsheet charts are interactive. You can zoom in
and out, view chart details, and “brush” the chart to track data in multiple
views.

4.4.1 Creating a Chart

This section explains the basic procedure for creating and editing a chart,
including binding the chart to data, setting ranking order, aggregation
method, and chart style.

Creating a New Chart

To add a chart to a Viewsheet, drag and drop the Chart element from the
Component tree into the grid. Use the mouse to move and resize the chart
as desired. 

To bind the Chart to data, follow the steps below:

1. Click on an axis of the chart, or click the ‘Edit’ button in the top-
right corner. This opens the Chart Editor on the left side of Visual
Composer.
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Tip: You can drag
fields from the Data
Source panel directly
onto the Viewsheet
grid to create a Filter
component that filters
the chart data.

2. From the Data Source panel in the Chart Editor, drag a dimension
onto the ‘X’ field in the Data panel. 

Note: When binding hierarchical cube dimensions, chart labels will
include all hierarchical components. To avoid this, ask an
administrator to set the property olap.table.originalContent=false
in sree.properties.

This dimension provides the chart’s X-axis data, and the dimension
name is automatically used as the axis label.

To rank a dimension
based on a measure
that is not displayed in
the chart, see Adding a
Non-Displaying Mea-
sure to a Chart.

3. Click the ‘Edit Dimension’ button, and select the desired ordering
and ranking for the X-axis data.
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Tip: You can drag a
measure field from
the Data Source panel
directly onto the
Viewsheet grid to cre-
ate a Range Slider
component that filters
the chart data.

4. From the Data Source panel, drag a measure onto the ‘Y’ field in
the Data panel. 

This measure provides the Chart’s Y-axis data, and the measure
name is automatically used as the axis label.

5. Click the ‘Edit Measure’ button, and select the desired aggregation
method for the Y-axis data.

6. For a line-type chart or map-type chart (see Setting the Chart Style),
optionally drag a field to the ‘P’ region. The values in this path
field are used to assign the sort order for the plotted data.
Connecting lines are drawn between points which are adjacent in
the path sort order, rather than between points which are adjacent
on the axis.

See the following sections for information about changing other aspects of
the chart, including visual properties, labeling, and sub-series.

See Also
Creating a Map Chart, for information on how to create a map chart.
Editing a Dimension, for more information on ranking and ordering.
Editing Chart Formats, for information on changing chart labels.
Adding a Sub-Series, for information on using the Visual panel.
Creating Selection List from Chart Data Source, for information on adding
a Selection List.
Creating a Selection Tree from Chart Data Source, for information on
adding a Selection Tree.
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Positioning a Component, for information on moving and resizing a chart.

Editing an Existing Chart

To edit an existing chart, click the ‘Edit’ button in the top-right corner of
the Chart. This opens the chart editor on the left side of Visual Composer.

Note: If Ad Hoc editing is enabled, end-users can also access the
Chart Editor to modify the chart.

A green outline designates the chart that is currently active in the editor.

Exiting the Chart Editor

To exit the Chart Editor, do one of the following:

• Click the Chart’s ‘Edit’ button a second time.

• Right-click the Chart and select ‘Exit Editing’ from the context menu.

• Click the ‘Exit Editing’ button at the top of the Chart Editor.

See Also
Chart Properties: Advanced Tab, for information on enabling Ad Hoc
editing.

Setting the Chart Style

To set the style of the chart (for all datasets on the chart), follow the steps
below:

Note: The ‘Auto’
chart type automati-
cally selects an appro-
priate chart type for
the provided data.

1. In the Data panel of the Chart Editor, click the ‘Select Chart Type’
button.
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2. Click a chart type to select it, and then click the ‘Apply’ button.
(You can also double-click the desired chart type.)

To apply distinct styles to the different datasets on the chart, see Setting a
Chart Style for an Individual Dataset.

Chart Examples

The following sections provide examples of how to create charts in
different styles.

Creating a Pie Chart

This example illustrates how to create a pie chart. Follow the steps below to
create a pie chart that displays Total Sales according to Year.

This Worksheet can
be found in the ‘Tuto-
rial’ folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘ProductSales’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Drag a Chart component from the Component tree to the
Viewsheet, and click the center of the Chart to open the Chart
Editor.

3. In the Chart Editor, drag the ‘Total’ field from the Data Source
panel to the ‘Y’ region of the Data panel.

4. In the Chart Editor, drag the ‘Date’ field from the Data Source
panel to the ‘Color’ region of the Visual panel.
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5. Click the ‘Select Chart Type’ button in the Data panel, and choose
‘Pie’. This converts the chart into a pie-chart representation.

6. Add the respective year values to the pie slices: Drag the ‘Date’
field from the Data Source panel to the ‘Text’ region of the Visual
panel.

7. Remove the legend (if desired). Right-click on the legend, and
select ‘Hide Legend’ from the context menu.
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The pie chart is now complete. To place a small gap between the slices, set
the ‘Explode Pie’ plot property. See Editing Plot Properties for more
information.

¢

Creating a Candle Chart

A candle chart displays four different measures, “low,” “high,” “opening,”
and “closing,” and is most often used to plot trading information. A candle
chart is functionally similar to a stock chart.

To create a candle chart that displays the averaged high, low, opening, and
closing prices by quarter, follow the steps below:

This query can be
found in the ‘Stock
History’ folder under
‘Other Data Sources’,
or in the ‘Orders
Examples’ data set
folder in Agile Edi-
tion.

1. Create a new Viewsheet based on the ‘Stock Prices’ query. 

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Add a new Chart component to the Viewsheet, and open the Chart
Editor.

3. Drag the ‘Date’ field from the ‘Stock Prices’ data block to the ‘X’
region of the Data panel.

4. Press the ‘Edit Dimension’ button next to the ‘Date’ field, and
choose ‘Quarter’ from the ‘Level’ menu. Then press the green
‘Apply’ button.
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5. Drag the ‘High’ field of the ‘Stock Prices’ query to the ‘Y’ region
of the Data panel.

6. Press the ‘Select Chart Style’ button in the Data panel, and select
the ‘Candle’ style. Press the green ‘Apply’ button.

Note that the Data panel now provides binding regions for ‘High’,
‘Close’, ‘Open’, and ‘Low’.

7. Drag the ‘Close/Last’, ‘Open’, and ‘Low’ measures from the
‘Stock Prices’ data block to the appropriate regions of the Data
panel, as shown below.
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8. Press the ‘Edit Measure’ button next to the ‘High’ field, and choose
‘Average’ from the ‘Aggregate’ menu. Then press the green
‘Apply’ button.

9. Repeat the above step to set the aggregate to ‘Average’ for the other
measures: ‘Close/Last’, ‘Open’, and ‘Low’.

10. Preview the chart.

11. To observe the structure of the chart more closely, use the Zoom
tool to view a more limited date range.
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Note that for each quarter, the values of each of the measures (High, Low,
Close/Last, Open) have been independently averaged. The “high” and
“low” measures are represented by the extremes of the candle “wick,” and
the “open” and “close” measures are represented by the extremes of the
candle “body.” Candles for which the “open” measure exceeds the value of
the “close” measure are shown filled. Candles for which the “close”
measure exceeds the value of the “open” measure are shown unfilled. 

¢

See Also
Setting a Chart Style for an Individual Dataset, to set dataset-specific
styles.

Creating a Table-Chart Hybrid

This example illustrates how to create a chart that has features of a table, in
particular, a columnar display of data. Follow the steps below:

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘Sales Explore’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Drag a Chart from the Component panel into the Viewsheet grid,
and resize the Chart to be wider and taller.

3. Click the ‘Edit’ button on the Chart to open the Chart Editor.
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4. In the Chart Editor, drag the ‘Total’ field from the ‘Measures’
folder in the Data Source panel to the ‘X’ region of the Data
panel.

5. Drag the ‘Category’ field from the ‘Dimensions’ folder of the Data
Source panel to the ‘Y’ region of the Data panel.

6. Drag the ‘Quantity Purchase’ field from the ‘Measurers’ folder in
the Data Source panel to the ‘Y’ region of the Data panel (under
‘Category’).

7. Press the ‘Edit Measure’ button next to ‘Quantity Purchased’. Set
the ‘Aggregate’ property to ‘Sum’ and enable the ‘Discrete’ option.
This allows the measure to behave as a dimension.

8. Press the green ‘Apply’ button. 

Observe that the chart now displays a column of values giving the
aggregated ‘Quantity Purchased’ value for each ‘Category’ group.
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9. Drag the ‘Discount’ field from the ‘Measures’ folder in the Data
Source panel to the ‘Y’ region of the Data panel (under ‘Quantity
Purchased’).

10. Press the ‘Edit Measure’ button next to ‘Discount’. Set the
‘Aggregate’ property to ‘Average’ and enable the ‘Discrete’ option.
This again allows the measure to behave as a dimension

11. Press the green ‘Apply’ button. 

Observe that the chart now displays a column of values giving the
aggregated ‘Discount’ value for each ‘Category’ group.

12. Right-click in the plot area and select ‘Plot Properties’ from the
context menu. This opens the ‘Plot Properties’ dialog box.

13. Enable the ‘Show Table Grid’ option, and press ‘OK’. This
displays grid lines around the plot area, and around each text
column.
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14. Adjust the spacing between the columns by dragging on the
boundaries between columns. 

15. Click on each column of text in turn and set the desired formatting.
(You can do this by using the toolbar buttons or by using the
‘Format’ dialog box. See Format Dialog Box for more
information.) 

For example, set a number format for the ‘Quantity Purchased’
column and set a percent format for the ‘Discount’ column. Center-
align both of these columns, and left-align the ‘Category’ column. 

16. Right-click the X-axis title, and select ‘Hide Title’ from the context
menu. Do the same for the Y-axis title.

17. Resize the chart as desired. Add text elements above the chart to
provide any desired column headers.
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Creating a Dot Plot

A dot plot represents a measure by its individual data points (without
aggregation). This type of chart can be useful when the dataset is very
small, with fewer than approximately 20 data points for each dimension
value.

Note: If the dataset contains too many records, the chart will not
be able to display all of the data points.

In this example, you will create a dot plot that displays the companies in
each state. Follow the steps below:

This query can be
found in the ‘Sample
Queries’ folder, or in
the ‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘customers’ query.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Drag a Chart from the Component panel into the Viewsheet grid.
Press the ‘Edit’ button on the Chart to open the Chart Editor.

3. In the Chart Editor, drag the ‘state’ field from the ‘Dimensions’
folder in the Data Source panel to the ‘X’ region of the Data
panel.

4. Drag the ‘customer_id’ field from the ‘Measures’ folder of the
Data Source panel to the ‘Break By’ region of the Data panel.

Alternatively, you can drag the ‘customer_id’ field to the ‘Color’,
‘Shape’, or ‘Size’ regions of the Visual panel if you wish to
distinguish the data points using a visual format. 

5. Press the ‘Select Chart Style’ button in the Data panel. Select the
‘Point’ type chart, and enable the ‘Stack’ option. Press the green
‘Apply’ button.
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6. Press the ‘Edit Measure’ button next to ‘customer_id’. Set the
‘Aggregate’ property to ‘None’, and press the green ‘Apply’
button.

You have now created a basic dot plot.

7. (Optional) Right-click on the Y-axis title and select ‘Hide Title’
from the context menu.

8. (Optional) Drag the ‘company_name’ field from the ‘Dimensions’
folder of the Data Source panel to the ‘Break By’ region of the
Data panel. Place it under the existing ‘customer_id’ field.
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This allows the chart tooltip to display both the ‘customer_id’ and
‘company_name’ values.

To further customize the tooltip, see Custom Tooltip.

4.4.2 Editing a Dimension

The Chart Editor and Crosstab Editor automatically categorize non-
numerical fields of a data block as “dimensions,” unless otherwise
specified. Typically, dimensions are represented on the X-axis or expressed
as a subseries (i.e., ‘Visual’ binding). Dimensions can also be used in the
‘Break By (Dimension) / Tooltip (Measure)’ field of the Data panel.

To edit the representation of a dimension, click the ‘Edit Dimension’ button
in the Data panel. This opens the options panel. 

Note: A measure must
be defined in order to
rank or sort by value.

The following settings are available. Note that a field of type Date has
additional grouping level options.

Sort Change the ordering of the X-axis labels:
None: Use the label order as defined within the data block or cube.
Ascending: Place the labels in alphabetically ascending order.
Descending: Place the labels alphabetically descending order.
By Value(Asc): Place the labels in ascending order based on the 
selected measure.
By Value(Desc): Place the labels in descending order based on the 
selected measure.
Manual: Click the ‘Edit’ button to open the ‘Manual Ordering’ 
dialog box, and manually reorder the X-axis labels.
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The image below illustrates the effect of enabling the ‘As time series’
option.

See Also
Sorting a Chart Dimension by Value, for a quick way to sort chart groups
by value.

4.4.3 Editing a Measure

The Chart Editor and Crosstab Editor automatically categorize numerical
fields of a data block as “measures.” Typically, measures are represented
on the Y-axis or expressed using one of the ‘Visual’ bindings. Measures
can also be used in the ‘Break By (Dimension) / Tooltip (Measure)’ field of
the Data panel.

To edit the representation of a measure, click the ‘Edit Measure’ button in
the Data panel. This allows you to change the method of aggregation and
calculation.

Ranking Filter the axis labels by aggregate measure value. 
None: No ranking of X-axis labels.
Top: Select the top N X-axis labels based on the selected measure.
Bottom: Select the bottom N X-axis labels based on the selected 
measure.

Group all 
others 
together

For Top/Bottom-N ranking, creates an “Others” category which 
represents (in aggregate) all the groups excluded by the Top/
Bottom-N filter.

Level Set the grouping level for dates. (If the date field is already grouped 
by the database, select ‘None’.) Note the distinction between 
options such as ‘Month’ and ‘Month of Year’: The ‘Month’ option 
groups each date according to composite month and year, e.g., Jan 
2007, Feb 2007, Jan 2008, Feb 2008, etc. The ‘Month of Year’ 
option groups each date strictly on the month component, e.g., Jan, 
Feb, which means that each group may include data from multiple 
years. The first day of the week (Sunday or Monday) for ‘Day of 
Week’ grouping is determined by the user locale.

As time 
series

Specifies that gaps in Date data should be retained. For example, if 
the data in the chart is grouped by month, and there is no data for the 
month of June, the ‘As time series’ property ensures that the month 
of June is still retained in the chart. To change the way that the gap 
is displayed, see Editing Plot Properties.
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The following settings are available:

Calculating a Measure Representation

There are many different ways to represent an aggregated measure on a
chart. For example, you can represent the aggregated measure (for an X-
axis group or subseries group) in terms of its percentage of a total, or by its
difference from a preceding group, or by a moving average based on
adjacent groups, etc. 

To use one of these representations, set the appropriate calculation method.
Follow the steps below:

1. Click the ‘Edit Measure’ button next to a measure (either in the
Data panel or Visual panel). This opens a pop-up panel.

Select ‘None’
(default) to use the
raw aggregate. Select
‘Custom’ to create a
new calculation
method.

2. Select one of the calculation methods from the ‘Calculate’ menu in
the pop-up panel.

Aggregate The method by which measure data should be aggregated. See 
Aggregation Options for a description of the methods.

With For bivariate aggregations (such as ‘Covariance’ and ‘Correlation’), 
this specifies the second operand. 

Calculate The computation that determines how values are represented on the 
chart (i.e., moving average, percentage, difference, etc.). See 
Calculating a Measure Representation.
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3. Click the ‘Edit’ button. This opens the ‘Calculation’ dialog box,
which allows you to modify the properties of the calculation
method. To do this, follow the steps below:

a. From the ‘Calculate’ menu, select a type of calculation:
‘Percent’, ‘Change’, ‘Running’, or ‘Sliding’.

b. Select any additional options to fully specify the calculation
method. (The options vary for the different methods. See
Calculation Methods for more detail.)

c. Click ‘OK’ to close the dialog box. This adds the new method to
the ‘Calculate’ menu.

4. Click the green ‘Apply’ button.

The aggregated measure will now be displayed on the chart using the
particular representation that you have specified.

See Also
Calculation Methods, for details on configuring the various methods.
Charts, for step-by-step instructions on creating a chart.

Calculation Methods

There are three basic types of calculations: ‘Percent’, ‘Change’, ‘Running’,
and ‘Sliding’. These methods are described in greater detail below.



DATA MASHUP

478 of 1397

Percent Calculation

The ‘Percent’ calculation allows you to express the measure based on
‘Grand Total’, ‘Subtotal’, or a particular dimensional group.

• Dimension: Expresses the value of the aggregated measure for each
group as a percentage of the measure aggregated across the selected
dimension.

• Grand Total: Expresses the value of the aggregated measure for each
group as a percentage of the measure aggregated across all groups.

• Subtotal: For a facet-type chart (i.e., a chart with both a measure and
dimension on the same axis or with multiple dimensions on the same axis), this
expresses the value of the aggregated measure for each group as a
percentage of the measure aggregated across all groups on the same sub-
chart.

Example: 
Percent 
Calculation

In this example, you will create a chart that displays the quantity of
products sold for different categories, regions, and states. You will display
the aggregated measure for each subgroup as a percentage of the total
aggregate for the category. Follow the steps below:

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘Sales Explore’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).
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2. Drag a Chart component onto the Viewsheet grid. 

3. Click the center of the Chart (or click the ‘Edit’ button at the top-
right). This opens the Chart Editor. 

4. In the Chart Editor, make the following selections:

a. From the ‘Dimensions’ node in the Data Source panel, drag the
‘Category’ dimension to the ‘X’ field in the Data panel.

b. From the ‘Measures’ node in the Data Source panel, drag the
‘Quantity Purchased’ measure to the ‘Y’ field in the Data panel. 

c. From the ‘Dimensions’ node in the Data Source panel, drag the
‘Region’ dimension to the ‘Y’ field in the Data panel, and drop
it above the ‘Quantity Purchased’ measure. (This creates a facet
chart containing multiple sub-graphs.)

d. From the ‘Dimensions’ node in the Data Source panel, drag the
‘State’ dimension to the ‘Color’ field in the Visual panel. This
creates a subseries based on the ‘State’ field.

5. Drag the Chart handles to enlarge the Chart as desired.

6. From the ‘Dimensions’ node in the ‘Data Source’ tree, drag the
‘State’ dimension onto the Viewsheet grid. This creates a ‘State’
Selection List.

7. Select the following states in the ‘State’ selection list: ‘AZ’, ‘CA’,
‘NJ’, ‘NY’.

8. Right-click the plot area of the chart, and select ‘Plot Properties’
from the context menu. This opens the ‘Plot Properties’ dialog box.

9. Enable the ‘Show Values’ option, and click ‘OK’. 
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This displays the aggregated measure value for each group on the
chart.

10. In the Data panel of the Chart Editor, click the ‘Edit Measure’
button next to the ‘Quantity Purchased’ measure. This opens a pop-
up panel.

11. In the ‘Calculate’ menu of the pop-up panel, select the ‘Custom’
option. 
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12. Click the ‘Edit’ button to open the ‘Chart Calculation’ dialog box.

13. In the ‘Chart Calculation’ dialog box, select ‘Percent’ from the
‘Calculate’ menu.

14. Select ‘Category’ from the ‘Of’ menu, and click ‘OK’ to close the
dialog box.

15. Press the green ‘Apply’ button in the pop-up panel to apply the
change.

The aggregated measure for each group is now represented as its
percentage of the total aggregate for the corresponding category.

Experiment with the other available representations for the group
aggregates:

• Grand Total: The aggregated measure for each group is represented as
its percentage with respect to the entirety of chart data.

• Subtotal: The aggregated measure for each group is represented as its
percentage with respect to the entirety of data on the same sub-graph
(i.e., the region, ‘USA East’ or ‘USA West’).
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• Region: The aggregated measure for each group is represented as its
percentage with respect to its entire region (same as ‘Subtotal’ for this
example).

• State: The aggregated measure for each group is represented as its
percentage with respect to its entire state.

¢

Change Calculation

The ‘Change’ calculation allows you to express the group aggregate in
terms of its deviation (or percent deviation, if ‘As percent’ is selected) from
the preceding, succeeding, first, or last group in the series. The ‘From’
menu specifies the baseline value.

• First: Expresses the value of the aggregated measure for each group as a
difference from the corresponding first value for the parent group
selected in the ‘Value of’ menu.

• Previous: Expresses the value of the aggregated measure for each group
as a difference from the corresponding previous value for the parent
group selected in the ‘Value of’ menu.

• Next: Expresses the value of the aggregated measure for each group as a
difference from the corresponding next value for the parent group
selected in the ‘Value of’ menu.

• Last: Expresses the value of the aggregated measure for each group as a
difference from the corresponding last value for the parent group
selected in the ‘Value of’ menu.

Running Calculation

The ‘Running’ calculation allows you to express each group aggregate as
an accumulation of previous aggregate values in the series. The method of
accumulation is specified by the ‘Aggregate’ menu in the ‘Calculation’
dialog box. (See Aggregation Options for more about the different
methods.) 
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The ‘Reset at’ option, available for date fields, allows you to specify the
date interval (e.g., year, quarter, week, etc.) at which the accumulation
should be cleared.

Example: 
Running Average

In this example, you will create a chart that computes total quantities sold
by month, and displays these values as a running average. The running
average will be reset on a yearly basis. Follow the steps below:

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘Sales Explore’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Drag a Chart component onto the Viewsheet grid, and enlarge the
Chart as desired by dragging the handles.

3. Click the center of the Chart (or click the ‘Edit’ button at the top-
right). This opens the Chart Editor. 

4. In the Chart Editor, from the ‘Dimensions’ node in the Data
Source panel, drag the ‘Date’ dimension to the ‘X’ field in the
Data panel.

5. From the ‘Measures’ node in the Data Source panel, drag the
‘Quantity Purchased’ measure to the ‘Y’ field in the Data panel. 

6. In the Data panel of the Chart Editor, click the ‘Edit Dimension’
button next to the ‘Date’ measure. This opens a pop-up panel.

7. From the ‘Level’ menu select ‘Month’, and click the green ‘Apply’
button. This groups the date data (i.e., X-axis labels) by month.
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8. In the Data panel of the Chart Editor, click the ‘Edit Measure’
button next to the ‘Quantity Purchased’ measure. This opens a pop-
up panel.

Note: Leave the
‘Aggregate’ option in
the pop-up panel set
to the default ‘Sum’.

9. In the ‘Calculate’ menu of the pop-up panel, select the ‘Custom’
option. 

10. Click the ‘Edit’ button to open the ‘Chart Calculation’ dialog box.
Make the following settings:

a. From the ‘Calculate’ menu, select ‘Running’.

b. From the ‘Aggregate’ menu, select ‘Average’.

c. From the ‘Reset at’ menu, select ‘Year’. 

d. Click ‘OK’ to close the dialog box.

11. Click the green ‘Apply’ button in the pop-up panel to apply the
change.
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The time series now shows a running average for the summed
quantity purchase, re-initialized at each new year.

¢

See Also
Sliding Calculation, to accumulate values over a limited sliding range.

Sliding Calculation

The ‘Sliding’ calculation allows you to express each group’s value as an
accumulation of neighboring aggregate values in the series, specified by a
rectangular sliding window. This generally has the effect of smoothing
(low-pass filtering) the displayed data.

The method of accumulation is specified by the ‘Aggregate’ menu in the
‘Calculation’ dialog box. (See Aggregation Options for more information
about the different methods.) The ‘Previous’ and ‘Next’ values specify the
span of the sliding window as the number of preceding and succeeding
groups, respectively, to include in the calculation. All included groups have
equal weight in the calculation.

The ‘Include current value’ options incorporates each group’s aggregate
value into its own calculation. When this option is not enabled, the
calculation for a group uses only its neighboring groups’ values. For
example, assume the chart displays sales totals for March, April, May,
June, and July, and the sliding window is 3 units wide (‘Previous’=1 and
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‘Next’ =1). If ‘Include current value’ is enabled, the displayed value for
May is aggregated from three months’ data, April, May, and June.
However, if ‘Include current value’ is not enabled, the displayed value for
May is aggregated from two months’ data, April and June.

The ‘Null if not enough values’ option suppresses chart points for which
the sliding window does not obtain the required span. For example, assume
the chart displays sales totals for March, April, May, June, July, August,
and September, and that the sliding window is 5 units wide (‘Previous’=2
and ‘Next’ =2). If ‘Null if not enough values’ is enabled, then no points are
displayed on the chart for the months of March and April because the
calculation cannot be performed for these groups as specified (there is no
data available preceding March.) However, if ‘Include current value’ is not
enabled, the aggregates for March and April will be computed and
displayed using the data available within the sliding window. 

See Also
Running Calculation, to accumulate values from the start of the series.

Setting a Geographical Field

To set a field as a geographical field (for use with Map Charts), follow the
steps below:

1. Right-click the field in the tree, and select ‘Set Geographic’ from
the context menu. This places a “star” icon next to the field name,
and opens the geographical level editor.

The map that you
select for a geo-
graphic field applies
to all other geographi-
cal fields.

2. In the level editor, select the desired region from the ‘Map’ menu:
Asia, Canada, Europe, Mexico, U.S., or World. 

3. From the ‘Layer’ menu, select the geographical layer that
corresponds to the data in the selected field. 

This specifies the layer of the geographical database against which
field values should be matched (e.g., city names should be matched
against the city layer, etc.). The options available in the ‘Layer’
menu depend on the previously selected ‘Map’ option.
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4. From the ‘Mapping’ menu, select the desired map database. 

The Chart Editor attempts to resolve values in the selected
geographic field against the corresponding layer in the map
database. If all data values are successfully matched, a green check
mark is displayed. If some data values cannot be matched, a red
question mark is displayed.

5. To resolve any unmatched names, click the red question mark. This
opens the ‘Geographical Mapping’ dialog box. See Resolving
Geographical Data for further instructions.

6. Click the ‘Apply’ button.

To modify the settings for an existing geographical field, right click the
field, and select ‘Edit Geographic’ from the context menu. This opens the
geographical level editor described above.

To remove the geographical status of a field, right click the field, and select
‘Clear Geographic’ from the context menu.

See Also
Resolving Geographical Data, for information on specifying a new
mapping.
Map Charts, for information about representing geographical data on a
map.

Converting between Measure and Dimension

By default, dimensions are displayed as discrete values, whereas measures
are aggregated and displayed as a continuous range. 
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To convert a dimension to a measure, right-click the dimension in the tree,
and select ‘Convert to Measure’ from the context menu. The new measure
is automatically moved to the correct branch of the tree.

To convert a measure to a dimension, right-click the measure in the tree,
and select ‘Convert to Dimension’ from the context menu.The new
dimension is automatically moved to the correct branch of the tree.

To specify that a particular measure be displayed using discrete values
(rather than a continuous spectrum), see Displaying a Measure as Discrete
Values.

Displaying a Measure as Discrete Values

By default, dimensions are displayed as discrete values, and measures are
displayed as a continuous range. 

To force a measure to display as discrete values, follow the steps below:

1. Press the ‘Edit Measure’ button next to the measure name. This
opens the ‘Edit Measure’ panel.

2. Enable the ‘Discrete’ option, and press the green ‘Apply’ button.

The measure will now display as discrete values rather than as a continuous
spectrum.
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To convert a measure to a dimension, see Converting between Measure
and Dimension.

4.4.4 Editing Chart Formats

You can alter almost every aspect of a chart’s display. The following
sections explain how to modify titles, axes, legends, and the plot area.

See Also
Chart Properties, for information about global chart properties.

Editing an Axis Title

Viewsheet Charts do
not posses a “chart
title.” To add a chart
title, use a text com-
ponent.

To edit the text and rotation of an axis title, follow the steps below:

1. Right-click the title text on the Chart, and select ‘Title Properties’
from the context menu. This opens the ‘Title Properties’ dialog
box.

2. In the ‘Title’ field, enter the title for the axis. (The title text you
enter will persist even if you later change the axis data.) 

To add the default axis name into your custom title, insert a
placeholder such as {0} in the title. For example, if the chart
displays two measures on the y-axis, ‘Total’ and ‘Quantity’, you
can enter a custom title such as “{0} and {1} for all Employees” to
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display the following y-axis title: “Sum(Total) and Sum(Quantity)
for all Employees”.

3. Press ‘OK’ to close the dialog box and apply the changes.

To change the formatting of an axis title, follow the steps below:

1. Right-click the title text on the Chart, and select ‘Format’ from the
context menu. This opens the ‘Title Properties’ dialog box.

2. Select a font, color, alignment, etc., for the axis title. See Format
Dialog Box for more information about the options.

3. Click ‘OK’ to close the dialog box and apply the changes.

Editing a Chart Axis

To edit the labels and line format of an axis, right-click the axis or axis
label, and select ‘Axis Property’ from the context menu. This opens the
‘Axis Properties’ dialog box. 

Note: To hide axis line and labels, right-click the axis and choose
‘Hide Axis’ from the context menu. To reveal a hidden axis, right-
click the chart and select ‘Show All Axes’ from the context menu.

The Label tab of the ‘Axis Properties’ dialog box offers the following
options:

Show Axis Labels Display text labels on the axis.
Rotation The angle of the label text.
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The Line tab of the ‘Axis Properties’ dialog box offers the following
options:.

Logarithmic 
Scale

Set logarithmic scaling for the axis. (The logarithm base 
is selected automatically.)

Reverse Orient the axis with maximum at bottom, minimum at 
top.

Shared Range For a facet-type chart (i.e., a chart with both a measure 
and dimension on the same axis or with multiple 
dimensions on the same axis), this specifies that sub-
charts in the same column share the same X-axis scaling, 
and sub-charts in the same row share the same Y-axis 
scaling. Otherwise, sub-charts are individually scaled.

Ignore Null For Date/Time and Categorical axes, ‘Ignore Null’ 
suppresses the display of null dimension values. When 
‘Ignore Null’ is disabled, null values are represented 
without labels.

Truncate Long 
Labels

When enabled, truncates labels that exceed 1/3 of the 
total chart width or height (using ellipses to indicate 
omitted text). When disabled, truncates labels only if 
they exceed 2/3 of the total chart width or height.

Show Axis Line Display the axis line, in the specified color.
Show Ticks Display tick marks on the axis line.
Axis Line & Tick 
Color

Color of the axis line and tick markers.

Minimum Lowest value shown on axis
Maximum Highest value shown on axis 
Minor Increment The interval between axis tick marks
Major Increment The interval between axis labels. For a date/time field 

which is represented as a time-series (e.g., when ‘As 
time series’ is selected in the ‘Edit Dimension’ panel), 
the increment is specified in terms of the prevailing time 
unit (weeks, months, etc.)
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The Alias tab is avail-
able for dimension
(categorical) axes.

The Alias tab of the ‘Axis Properties’ dialog box allows you to change the
labels displayed on the axis. To modify the labels of a categorical axis,
follow the steps below.

1. Right-click the axis, and select ‘Axis Properties’. This opens the
‘Axis Properties’ dialog box.

2. Click the Alias tab. This displays a table containing the mapping
between original axis labels and new axis labels.

3. Double-click the cells in the ‘Alias’ column that correspond to the
axis labels that you wish to rename, and enter the desired
replacement text.

4. Click ‘OK’ to close the dialog box. This updates the axis labels
with the specified replacement text.
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See Also
Editing a Chart Legend, for information about modifying legend labels.

Editing a Chart Legend

To edit a legend, right-click the legend, and select ‘Legend Properties’
from the context menu. This opens the ‘Legend Properties’ dialog box. 

Note: To hide a legend, right-click the legend and choose ‘Hide
Legend’ from the context menu. To show all legends, right-click the
chart and select ‘Show Legend’ from the context menu.

The General tab of the ‘Legend Properties’ dialog box offers the following
options:

The Content tab of the ‘Legend Properties’ dialog box offers the following
options:

Title The text to display in the legend title bar.
Visible Sets the visibility of the legend title bar.
Legend Border The line style and color of the legend boundary.
Legend Position Sets the position of the legend on the plot. Legend position 

can also be changed by dragging with the mouse.
Ignore Null Ignore null values when generating the legend.

Font The font and color of the legend content text.
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The Scale tab is avail-
able for measure
(numerical) legends.

The Scale tab of the ‘Legend Properties’ dialog box offers the following
two options:

The Alias tab is avail-
able for dimension
(categorical) legends.

The Alias tab of the ‘Legend Properties’ dialog box allows you to change
the labels displayed in the legend. To modify the labels of a legend, follow
the steps below.

1. Right-click the legend, and select ‘Legend Properties’. This opens
the ‘Legend Properties’ dialog box.

2. Click the Alias tab. This displays a table containing the mapping
between original legend labels and new legend labels.

3. Double-click the cells in the ‘Alias’ column that correspond to the
legend labels that you wish to rename, and enter the desired
replacement text.

4. Click ‘OK’ to close the dialog box. This updates the legend labels
with the specified replacement text.

Format The format of the legend contents. For information about the 
available format specifications, see the Format Tab section.

Logarithmic Scale Set logarithmic scaling for the legend scale. (The logarithm 
base is selected automatically.)

Reverse Orient the scale with maximum at left, minimum at right.
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See Also
Adding a Sub-Series, for information about adding a sub-series and legend.

Positioning a Chart Legend

To change the position of a chart legend, click the legend title and drag it to
the desired location. You can place the legend at the left, right, top, or
bottom.

You can also change the legend position from the General tab of the
‘Legend Properties’ dialog box. See Editing a Chart Legend for more
information.

See Also
Adding a Sub-Series, for information about adding a sub-series and legend.

Editing Plot Properties

To edit plot properties, right-click body of the chart, and select ‘Plot
Property’ from the context menu. This opens the ‘Plot Properties’ dialog
box, which contains two tabs: Line and Options. 

The following properties are found under the Line tab of the ‘Plot
Properties’ dialog box. (The properties shown depend on the chart style.)

X Grid The line style and color of the X-axis grid.
Y Grid The line style and color of the Y-axis grid.
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Quadrant Grid The style and color for a set of perpendicular line segments which 
divide the plot area into quadrants.

Diagonal Line The style and color for a line segment which originates at the 
lower-left corner of the plot area and terminates at the upper-right 
corner of the plot area.

Show Table 
Grid

For a facet-type chart (i.e., a chart with both a measure and 
dimension on the same axis or with multiple dimensions on the 
same axis), displays a solid line around the entire plot area 
and displays a solid axis line to separate the dimension 
and measure axis labels. Use the adjacent color chip to 
select the color for the line surrounding the plot area. To 
set the color of the axis separator line, right click on the 
line and select ‘Axis Properties’ from the context menu. 
See Editing a Chart Axis for details about setting the axis 
color.

Trend Line Specifies whether an interpolated trend line is displayed, and the 
method by which the trend line should be fit to the data (linear, 
quadratic, etc.). The menu and color chip below the ‘Trend Line’ 
menu specify the trend line style and color. If there is a dimension 
associated with the chart’s ‘Color’ binding, select the ‘One Per 
Color’ option to create an independent trend line for each color 
group. (The trend line colors are matched to the corresponding 
data colors unless you explicitly specify a trend line color. In that 
case, all trend lines share the same color.)

Project 
Forward

Specifies the number of axis units that the trend line should 
extend beyond the final data point. Not available for the 
following chart types: Waterfall, Pie, 3D Pie, Radar, Filled Radar, 
Map. Not available for the following data types: String, Boolean. 
Projection requires that axis values be a linear and complete 
series of either numbers or dates.

Background 
Color

The fill color of the plot area on the chart.
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The following properties are found under the Options tab of the ‘Plot
Properties’ dialog box. (The properties shown depend on the chart style.) 

Show 
Reference 
Line

Displays horizontal and vertical reference lines when the user 
moves the mouse over a data point.

Explode Pie Displays a pie chart with small gaps between the slices.
Alpha Sets transparency for the chart elements. If disabled, the default 

transparency for the particular chart type is used.
Show Values Displays the aggregate measure values on the chart. If the chart 

also possesses a ‘Text’ binding, then the values displayed by 
‘Show Values’ and those displayed by the ‘Text’ binding appear 
on different lines. Use a ‘Text’ format to individually format the 
values. For example, if the top value represents a date and the 
bottom value represents a number, you can apply the following 
text format: “Date: {0,date,yyyy}\nAmount: {1,number,$#}”. 
(Note: By default, measure values are also displayed as a tooltip 
when the user hovers the mouse over the chart. Tooltips are 
visible when the Viewsheet is previewed or viewed in the Portal.)

Stack Value Displays a single aggregate value for each primary (X-axis) 
grouping, rather than for each individual subseries grouping.

Show Points For a Line-type chart, adds markers at the locations of the 
individual data points.

Show Lines Displays line segments connecting the points on the chart. To 
display a fitted line, use the ‘Trend Line’ option instead.

Fill Time-
Series Gaps

When the ‘As time series’ option is set for a dimension (see 
Editing a Dimension), the ‘Fill Time-Series Gaps’ option 
specifies how missing data should be represented on the chart. 
When the option is disabled, plotted lines simply ignore the 
missing data and connect adjacent points. When the option is 
enabled, you can choose to represent gaps with either ‘Null’, 
which leaves an empty space at the location, or with ‘Zero’, 
which inserts a numerical value of 0 at the location.

Keep Element 
in Plot

Automatically extend the chart boundaries to display chart 
elements (including target lines) that exceed the specified axis 
maximum.

Always Show 
Color in Map

When a column is bound to the ‘Color’ field of the Visual panel 
in the Chart Editor, this setting ensures that the color is always 
used to fill the map regions. Otherwise, if another column is 
simultaneously bound to the ‘Shape’, ‘Size’, or ‘Text’ fields of 
the Visual panel, the color generated for the ‘Color’ binding will 
be applied to the plotted points rather than to the map regions.

Banding Adds alternating colored bands to a specified categorical or 
timescale axis. Select the desired band color from the color 
picker. The band ‘Size’ setting is an integer indicating the 
number of category groups (for a categorical axis) or the 
number of date groups (for a timescale axis) to be 
spanned by each band.
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See Also
Editing Chart Formats, for information about editing axis data.
Setting the Chart Style, for information on switching chart styles.
Changing the Chart View, for information about editing axis data.
Color Tab, for information on setting component fill and transparency.
Chart Properties, for general properties of the Chart component.

4.4.5 Changing the Chart View

The following sections explain how to zoom in on a particular region of the
chart, and how to explore the data underlying the chart.

Selecting Chart Data

You can select contiguous or non-contiguous data in a chart. There are
several ways to select data:

• Drag the mouse across the data you wish to select. Ctrl-drag to add
additional regions to the selection.

• Ctrl-click the data you wish to select. 

• Ctrl-click the X-axis labels to select the corresponding data.

• Ctrl-click the legend labels to select the corresponding data (subseries).

See Also
Zooming a Chart, for information on zooming in on selected chart data.
Showing Detail Data, for information on viewing records of selected data.
Brushing a Chart, for information about highlighting selected data across
charts.

Zooming a Chart

To zoom in on a particular region of the chart, follow the steps below:

1. Select the group(s) on the chart that you wish to zoom. (See
Selecting Chart Data.)
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2. Click the ‘Zoom’ button in the toolbar. This zooms the chart to
display only the data selected.

3. Repeat the above steps to zoom in further. 

4. To return to the original chart view, press the ‘Clear Zoom’ button.

Example: 
Zooming a Chart

The figures below shows a variety of different selections, and the zoomed
results.

Zooming on Subseries Categories (Legend Labels)

Zooming on X-axis Categories (Labels)
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Zooming on Arbitrary Categories

¢

See Also
Excluding Data From a Chart, to create a zoomed view by excluding
groups.
Selecting Chart Data, for information on methods of selecting chart data.
Filter Conditions, and Filtering a Chart in Visualizing with Dashboards or
Example: Filtering Data (Visualize Free), for information on filtering chart
data.
Adding Highlights to a Chart, for information on conditional formatting. 
Brushing a Chart, for information on highlighting data across multiple
views.

Excluding Data From a Chart

The Zoom feature (Zooming a Chart) allows you focus in on a selected set
of groups by specifying the groups to include in the zoomed view. In some
cases, however, you might find it easier to create the desired view by
specifying particular groups to exclude from the zoomed view.

To exclude particular groups from a chart display, follow the steps below:

1. Select the group(s) in the chart that you wish to exclude. (See
Selecting Chart Data.)

2. Press the ‘Exclude Data’ button in the toolbar. This removes the
selected data from the chart.
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3. Repeat the above steps to exclude further data. 

4. To return to the original chart view, press the ‘Clear Zoom’ button.

See Also
Zooming a Chart, to create a zoomed view by including groups.
Selecting Chart Data, for information on methods of selecting chart data.
Filter Conditions, and Filtering a Chart in Visualizing with Dashboards or
Example: Filtering Data (Visualize Free), for information on filtering chart
data
Adding Highlights to a Chart, for information on conditional formatting. 
Brushing a Chart, for information on highlighting data across multiple
views.

Drilling Down into a Chart

When a chart axis displays a date field or a cube dimension, the chart
automatically provides the user with the ability to drill down to finer levels
of resolution of the date or dimension.

To drill down into a date or cube dimension on a chart axis, follow these
steps:

The ‘+’ symbol is
only visible when you
hover over the axis.

1. Hover the mouse over the chart axis that you want to display at
greater resolution. For axes that represent date or cube dimension
data, this will display a ‘+’ symbol at the left side of the axis. 
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2. Click the ‘+’ symbol to drill down to the next level of the date or
dimension.

3. Repeat the above steps to drill down to deeper levels of the
hierarchy.

4. To drill up to a higher level of the date or dimension hierarchy,
hover the mouse over the chart axis that you want to display at
reduced resolution. This displays a ‘–’ symbol at the left side of the
axis.

5. Click the ‘–’ symbol to drill up to the higher level of the date or
dimension hierarchy.

To disable the drilling feature for a particular chart, deselect the ‘Enable
Drilling’ option in the Advanced tab of the ‘Chart Properties’ dialog box.
To specify a custom drill hierarchy, including custom date levels, see Chart
Properties: Hierarchy Tab.

See Also
Chart Properties: Hierarchy Tab, for information on custom drill
hierarchies.
Drilling Down into a Crosstab, to perform the drill operation on a crosstab
dimension.
Walkthrough: Interactive Chart Drilldown, in Advanced Dashboard
Scripting, to implement a combined drill-and-filter operation.
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Filter Conditions, and Filtering a Chart in Visualizing with Dashboards or
Example: Filtering Data (Visualize Free), for information on filtering chart
data.
Adding Highlights to a Chart, for information on conditional formatting. 
Brushing a Chart, for information on highlighting data across multiple
views.

Maximizing a Chart

The ‘Max Mode View’ button at the top-right corner of the chart allows
you to detach the chart from the Viewsheet grid. This causes the chart to
“float” above the grid as a separate window that you can freely move and
resize. 

To reattach a floating chart to the Viewsheet grid, click the close button in
the top-right corner of the floating window.

The ‘Max Mode View’ feature is available to end-users as well, which
allows you to create smaller charts (“thumbnails”) that the user can enlarge
as needed.

See Also
Positioning a Component, for information on scaling and moving
components.

Showing Chart Data

Tip: To copy the con-
tents of a chart label,
click on the label.

To display a chart’s (summarized) data in tabular form, press the ‘Show
Data’ button at the top-right of the chart. To close the data panel, press the
red ‘X’ in the top-right corner.
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Exporting Chart Data

To export the chart data, click the ‘Export’ button.

Formatting Chart Data

To format values in the data panel, right-click on the column you wish to
format, and select ‘Format’ from the context menu.

This opens the ‘Format’ dialog box, which allows you to set the format for
the column. See Format Tab for information about the available options.
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Formatting that you specify is saved with the Viewsheet, and is
automatically applied to the column whenever the ‘Show Data’ option is
used, both in Visual Composer and the User Portal.

See Also
Showing Detail Data, for information on viewing underlying detail
records.

Showing Detail Data

To display the detail records corresponding to the chart’s (summarized)
data, follow the steps below:

1. Select the data to display by clicking the appropriate element in the
chart.

2. Click the ‘Show Details’ button at the top-right of the chart.
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To close the data panel, click the red ‘X’ in the top-right corner.

Exporting Detail Data

To export the data, click the ‘Export’ button. 

Formatting Detail Data

To format values in the data panel, right-click on the column you wish to
format, and select ‘Format’ from the context menu.
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This opens the ‘Format’ dialog box, which allows you to set the format for
the column. See Format Tab for information about the available options.

Formatting that you specify is saved with the Viewsheet, and is
automatically applied to the column whenever the ‘Show Details’ option is
used, both in Visual Composer and the User Portal.

See Also
Showing Chart Data, for information on viewing summarized chart data.
Selecting Chart Data, for information on methods of selecting chart data.

Rotating a Chart

To rotate a chart (switch the X- and Y-axes), click the ‘Swap XY’ button in
the Data panel title bar.

This will position the X-axis vertically, and position the Y-axis horizontally.
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Sorting a Chart Dimension by Value

To sort chart groups based on a measure, hover the mouse over the desired
measure axis. This displays the ‘Sort’ button next to the axis. Click the
button once to sort the groups in ascending order by measure value, click a
second time to sort in descending order by measure value, and click a third
time to restore the original order.

When multiple dimensions are represented on the chart (as in the image
above), the ‘Sort’ button operates on the innermost dimension. 

See Also
Editing a Dimension, to select from additional sorting options.

Clearing Chart Data

To clear all data binding information from a chart, right-click the chart, and
select ‘Clear All Data’ from the context menu. This restores the chart to the
its initial blank state.

See Also
Editing a Chart Axis, for information on hiding axes.

Manually Refreshing a Chart

By default, a chart is refreshed automatically whenever you make a change
to the chart binding. In cases where the automatic refresh creates an
undesirable delay, you can disable the automatic refresh feature.

To disable automatic refresh for a chart (and perform the refresh operation
manually), follow these steps:

1. Press the ‘Edit’ button on the chart to open the Chart Editor. 

2. Press the ‘Auto Refresh’ button in the chart toolbar to disable the
auto-refresh feature.
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3. To manually refresh the chart, press the ‘Refresh’ button.

To re-enable the auto-refresh feature, press the ‘Manual Refresh’ button on
the chart.

See Also
Editing a Chart Axis, for information on hiding axes.

Changing Chart Element Spacing

To change the vertical or horizontal spacing of elements on a chart, follow
the steps below:

1. Hover the mouse into an empty region between the chart elements.
The “arrow” pointer will change into a “move” pointer.
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2. Click and drag to change the element spacing. Drag left or right to
change horizontal spacing. Drag up or down to change vertical
spacing. 

The chart will automatically enable scroll bars as required to accommodate
the new spacing.

Changing Chart Axis Spacing

To change the position of a chart axis or control spacing among axes on a
compound chart, follow the steps below:

1. Hover the mouse over the horizontal or vertical axis you want to
move. The “arrow” pointer will change into a “move” pointer.

2. Click and drag to move the axis. Drag left or right to change
horizontal spacing. Drag up or down to change vertical spacing. 
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The chart will automatically enable scroll bars as required to accommodate
the new spacing.

Grouping Chart Labels into Named Groups

You can agglomerate data from different chart groups (axis groups, legend
groups) into larger categories called named groups. For example, you can
combine X-axis labels designating individual states MA, CT, NY, NJ, etc.,
into larger groups such as ‘New England’ and ‘Mid-Atlantic’. 

Named groups cannot be defined for date fields. 

To create named groups for chart axis labels or legend labels, follow the
steps below:

1. Ctrl-click to select the individual axis labels or legend labels that
you want to combine into a single group.

You can group exist-
ing named groups to
make larger groups.

2. Right-click on one of the selected labels, and choose ‘Group’ from
the context menu. This opens the ‘Group Name’ dialog box.
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3. Enter a name for the new group in the ‘Group Name’ dialog box,
and press ‘OK’.

This agglomerates the data corresponding to the original labels and
replaces the original labels with the named grouping label.

4. Repeat the above steps to add additional named groups.

To rename an existing group, right-click the group label, and select
‘Rename’ from the context menu. Alternatively, select ‘Axis Properties’ or
‘Legend Properties’ from the context menu, and change the label’s alias on
the Alias tab of the ‘Properties’ dialog box. (See Editing a Chart Axis or
Editing a Chart Legend for more details.)
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To decompose an existing named group, right-click on the group label and
select ‘Ungroup’ from the context menu.

Example: 
Creating Named 
Groups

In the following example, you will create a chart that displays total sales by
state. You will then group the states into one of six standard regions: New
England, Mid-Atlantic, Midwest, South, Mountain, and Pacific. Follow the
steps below:

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘Sales Explore’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Drag a Chart element from the Component panel into the
Viewsheet grid.

3. Click the ‘Edit’ button on the Chart to open the Chart Editor.

4. In the Data Source panel, expand the ‘Sales’ data block. From the
‘Dimensions’ node, drag the ‘State’ field to the ‘X’ region of the
Data panel.

5. From the ‘Dimensions’ node, drag the ‘Total’ field to the ‘Y’
region of the Data panel.
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6. Click the ‘CT’ label on the Chart’s X-axis to select it. Ctrl-click on
the ‘MA’ label to select it also.

7. Right-click on either of the selected labels, and choose ‘Group’
from the context menu.

This opens the ‘Group Name’ dialog box.

8. In the ‘Group Name’ dialog box, enter the label for the new
composite group: “New England”.
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This adds ‘New England’ as a new X-axis label, and agglomerates
the data from ‘MA’ and ‘CT’ into this new composite group.

9. Repeat the above steps to create the following additional named
groups:

a. “Mid-Atlantic,” including states ‘NY’, ‘PA’, ‘NJ’.

b. “South,” including states ‘MD’, ‘TX’, ‘FL’.

c. “Mountain,” including states ‘AZ’, ‘CO’, ‘NV’.

d. “Pacific,” including states ‘CA’, ‘WA’.

All states are now grouped into larger regions, except for ‘IL’,
which belongs to the Midwest region. You cannot create a named
group for ‘Midwest’ on the basis of a single label. Instead, if you
need a group labeled ‘Midwest’, you can simply rename the ‘IL’
label as described in the next step.

10. (Optional) Rename the ‘IL’ label to “Midwest”. Follow the steps
below:

a. Right-click the ‘IL’ label on the X-axis, and select ‘Axis
Properties’ from the context menu. This opens the ‘Axis
Properties’ dialog box.
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b. In the ‘Axis Properties’ dialog box, select the Alias tab. Double-
click in the ‘Alias’ column next to the ‘IL’ label, and enter the
text “Midwest”.

c. Click ‘OK’ to close the dialog box. The Chart now displays all
states grouped by region.

¢

See Also
Grouping Crosstab Headers into Named Groups, to create groupings in a
crosstab.

Creating a Chart Legend

To create a chart legend, do one of the following:

• Drag a measure or dimension to one of the regions in the Visual panel of
the Chart Editor (‘Color’, ‘Shape’, or ‘Size’). See Working with
Multiple Measures and Subseries for more information.
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• Drag two or more measures to the ‘X’ or ‘Y’ regions in the Data panel
of the Chart Editor.

For information about modifying the legend, see Editing a Chart Legend.

See Also
Editing a Chart Legend, for information about modifying a chart legend.
Positioning a Chart Legend, for information about moving a chart legend.

4.4.6 Brushing a Chart

A Viewsheet often contains multiple charts representing the same data in
different ways. In this case, it is often useful to highlight corresponding
data in different plots. You can do this easily with a technique called
“brushing.” 
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To brush a single subgroup, double-click the desired entity (axis label,
legend label, or subgroup). To brush a set of subgroups, follow the steps
below:

1. Select the desired subgroups, adjacent or nonadjacent. See
Selecting Chart Data.

2. Click the ‘Brush’ button in the chart toolbar.

The corresponding data in all charts is highlighted in red, allowing you to
immediately identify key data relationships. Data represented in tables and
output elements (e.g., gauges) is also filtered by the brushing operation.

Brushing data: Companies in CT and IL for 2007.

Example: 
Brushing

Brushing is a powerful tool that helps you quickly understand your data. In
this example, you will create two charts, and then use brushing on both
charts to answer particular business questions.

This Worksheet can
be found in the ‘Tuto-
rial’ folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘Analysis’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. To create the first chart, follow the steps below:
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a. Add a Chart component, and click the ‘Edit’ button. This opens
the Chart Editor.

b. In the Data Source panel, expand the ‘OrdersAndReturns’ data
block.

c. From the ‘Dimensions’ node in the Data Source panel, drag the
‘State’ field to the ‘X’ field of the Data panel.

d. From ‘Dimensions’ node in the Data Source panel, drag the
‘Last Name’ field to the ‘Color’ field of the Visual panel.

e. From the ‘Measures’ node in the Data Source panel, drag the
‘TotalPurchased’ field to the ‘Y’ field of the Data panel. 

This automatically creates a stacked bar chart.

f. Enlarge the chart (if desired) by dragging the handles.

3. To create the second chart, follow the steps below:

a. Add a Chart component, and click the ‘Edit’ button. This opens
the Chart Editor.

b. In the Data Source panel, expand the ‘OrdersAndReturns’ data
block.

c. From the ‘Dimensions’ node of the Data Source panel, drag the
‘Date’ field to the ‘X’ field of the Data panel.
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d. From the ‘Measures’ node of the Data Source panel, drag the
‘TotalPurchased’ field to the ‘Y’ field of the Data panel.

e. Next to the ‘X’ field, click the ‘Edit Dimension’ button. Select
‘Month’ for ‘Level’.

f. On the new chart, right-click an X-axis label and select ‘Format’
from the context menu. This opens the ‘Format’ dialog box,
where you will set the axis format to match the grouping level.

g. In the ‘Format’ dialog box, click the Format tab, and select the
‘Date’ option. Enter “MMM-yy” as the format, and click ‘OK’.
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h. On the chart, right-click an X-axis label and select ‘Axis
Properties’ from the context menu. This opens the ‘Axis
Properties’ dialog box.

i. In the Label tab of the ‘Axis Properties’ dialog box, select a
slanted label orientation and small font size. This will allow the
labels to better display.

4. Use brushing to answer the following question: “In what month did
salesperson Eric Heggenbart have his peak sales?”

a. Double-click the ‘Heggenbart’ label in the legend to brush
Heggenbart’s sales in both charts.

It is now obvious that Heggenbart’s greatest sales month was
December of 2006, when he sold over $400,000.
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b. Press the ‘Clear Brushing’ button to return to the normal view.

5. Use brushing to answer the following question: “Which states had
the greatest sales numbers during the best four months?”

a. In the second chart, Ctrl-click to select the four highest peaks on
the plot.

b. Press the ‘Brush’ button on the chart toolbar to highlight all the
data corresponding to these months.
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It is clear that the four peak months saw sales chiefly in the
states NJ, TX, and MA.

6. The data indicate a steep overall decline in sales for September
2008. Use brushing to answer the following question: “Which
salesperson’s sales defied this trend, and what state’s sales most
significantly accounted for this?”

a. Successively double-click the names in the legend to display the
sales by data for each salesperson. Note that only the data for
Heggenbart defy the September sales decline.

b. Successively double-click each of Heggenbart’s states, and
observe the September sales movement. Note that only the
Heggenbart sales in MA and NY show significant growth in this
period.

¢

See Also
Zooming a Chart, for information on zooming in on selected data.
Adding Highlights to a Chart, for information on adding conditional
formatting.
Flyover View, to use chart selections to filter the data in other components.
Selecting Chart Data, for information on methods of selecting chart data.

4.4.7 Working with Multiple Measures and Subseries

To plot multiple datasets on the same chart, simply drag multiple measures
into the ‘Y’ field of the Data panel. To break out a dataset into a subseries,
drag the desired subseries dimension into one of the fields in the Visual
panel (‘Color’, ‘Shape’, ‘Size’, ‘Text’).
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The following sections explain various aspects of working with multiple
datasets and subseries.

Setting a Chart Style for an Individual Dataset

To set the chart style for an individual dataset on a multi-dataset chart,
follow the steps below:

Note: The ‘Auto’
chart type automati-
cally selects an appro-
priate chart type for
the provided data.

1. In the Data panel of the Chart Editor, press the ‘Select Chart Type’
button. This opens the chart styles panel.

2. In the chart styles panel, enable the ‘Multiple Styles’ option (below
the chart style options), and press ‘Apply’.

3. Press the ‘Select Chart Type’ button next to dataset you wish to
change. 

This opens the chart styles panel for the specified dataset.
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Note: Only certain compatible style combinations can be selected
(e.g., Pie style and Line style are incompatible).

4. Click a chart type to select it, and then click the ‘Apply’ button.
(You can also double-click the desired chart type.) 

See Also
Setting the Chart Style, for information on setting a single style for all
datasets.

Plotting Measures on a Single Axis

By default, when you add two or more measure fields on the Y-axis, the
selected datasets are plotted on adjacent sets of axes, as shown below:

In some cases you may want to display the measures on the same axis. The
following example illustrates how to do this.

Walkthrough This example illustrates how to switch from a multiple axis view to a
single-axis view. Follow the steps below:
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This Worksheet can
be found in the ‘Tuto-
rial’ folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the sample ‘Analysis’
Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Add a Chart component, and press the ‘Edit’ button. This opens the
Chart Editor.

3. In the Data Source panel, expand the ‘OrdersAndReturns’ data
block.

4. From the ‘Dimensions’ node, drag the ‘State’ field to the ‘X’ field
of the Data panel.

5. In the ‘Measures’ node, Ctrl-click to select both the
‘TotalPurchased’ field and the ‘TotalReturnedNeg’. 

6. Drag both fields together to the ‘Y’ field of the Data panel. 

This automatically creates two axes, one for each dataset. Note the
scrollbar indicators that appear on the chart. (Enlarge the chart
component if you cannot see both axes.)
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7. Press the ‘Switch to Single Graph’ button in the Data panel of the
Chart Editor. This fits both datasets on the same set of axes.

8. If desired, edit the Y-axis label to fit on the chart.

See Also
Plotting Measures on a Secondary Y-Axis, for instructions on how to create
a double-axis chart.
Editing an Axis Title, for information on changing the axis title properties.

Plotting Measures on a Secondary Y-Axis

By default, when you add two or more measure fields on the Y-axis, the
selected datasets are plotted on adjacent sets of axes, as shown below:

In some cases, you may want to use a double Y-axis to represent these
measures, as shown below:
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To display a dataset on the right-side (secondary) Y-axis, follow these
steps:

1. Press the ‘Switch to Single Graph’ button in the Data panel of the
Chart Editor.

This places all measures on the same Y-axis rather than on adjacent
axes.

2. Press the ‘Edit Measure’ next to the measure that you wish to
display against the secondary Y-axis. 

3. Enable the ‘Secondary Axis’ option at the bottom of the panel.

4. Press the ‘Apply’ button (green arrow).
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To return to the multiple axis style, press the ‘Switch to Separate Graph’
button.

Controlling Axes in Separate Chart View

In the ‘Separate Graph’ view, you can scroll the chart using vertical and
horizontal scrollbars. To see the scrollbars, hover the mouse over the
bottom or right of the chart.

To control the spacing of the labels on the chart axes, right-click the chart,
and select one of the following options from the context menu:

• Increase Width

• Increase Height

• Decrease Width 

• Decrease Height

These options change the axis scale by a small increment. To make a larger
change, select the desired option repeatedly.

Adding a Sub-Series

A sub-series represents an additional level of grouping within an individual
dataset or measure. Beyond the level of grouping implied by the X-axis
labels, the subseries breaks an individual measure down into a secondary
level of categories.

A subseries can be created with or without visual formatting.
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Adding a Visually-Formatted Subseries

To add a visual-formatted subseries to an existing chart, follow the steps
below:

1. Select the chart, and click the ‘Edit’ button to open the Chart
Editor.

2. Expand the ‘Dimension’ node in the Data Source panel. 

3. Drag the desired subseries dimension to one or more of the fields in
the Visual panel at the bottom of the Chart Editor.

a. Drag the dimension to the ‘Color’ field to discriminate the
subgroups by color.

b. Drag the dimension to the ‘Shape’ field to discriminate the
subgroups by data point shape or fill pattern.

c. Drag the dimension to the ‘Size’ field to discriminate the
subgroups by the thickness of the representation element (bar,
line, etc.).

d. Drag the dimension to the ‘Text’ field to discriminate the
subgroups by placing appropriate text labels.

4. Click the ‘Edit Dimension’ button, and select the desired ordering
and ranking for the coded values.
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5. Click the appropriate ‘Edit’ button (‘Edit Color’, ‘Edit Shape’,
‘Edit Size’, ‘Edit Text’), and select the desired representation. For
more information, see Representing Data With Color,
Representing Data With Shape, Representing Data with Size, and
Representing Data With Text.

Creating a sub-series automatically creates a corresponding legend. For
information on controlling the legend display, see Positioning a Chart
Legend. For information on further modifying the visual format of the
subseries, see Representing Data with Visual Formats.

Example: Adding 
a Subseries

Assume that you want to plot ‘Total Purchased’ vs. ‘State’ for a dataset.
Additionally, you want break down the sales in each region according to
‘Category’. In this case, ‘State’ is the top level of grouping, represented by
the labels on the X-axis, and ‘Category’ will be the subseries.

Follow the steps below:

This Worksheet can
be found in the ‘Tuto-
rial’ folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the sample ‘Analysis’
Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Add a chart component, and click the ‘Edit’ button on the chart to
open the Chart Editor.
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3. In the ‘Data Source’ pane, expand the ‘OrdersAndReturns’ data
block.

4. From the ‘Dimensions’ node in the Data Source panel, drag the
‘State’ dimension onto the ‘X’ field in the ‘Data’ panel.

5. From the ‘Measures’ node in the Data Source panel, drag the
‘TotalPurchased’ measure onto the ‘Y’ field in the Data panel.

This displays ‘Total Purchased’ vs. ‘State’, as desired. You will
now add the subseries.

6. From the ‘Dimensions’ node in the Data Source panel, drag the
‘Category’ dimension onto the ‘Color’ field in the Visual panel.

This creates the ‘Category’ subseries, discriminating the different
categories using color, and automatically creates a corresponding
legend. Resize the chart as desired to show all the data.

Notice that there are seven colors, one for each product category.

¢
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See Also
Adding a Non-Formatted Subseries, for information on subseries without
format.
Positioning a Chart Legend, for information on controlling the legend
display.
Editing a Chart Legend, for information on changing the display of a
legend.
Representing Data with Visual Formats, for information about ordering
styles.

Adding a Non-Formatted Subseries

To add a subseries to an existing chart without visual formatting, follow the
steps below:

1. Select the chart, and click the ‘Edit’ button to open the Chart
Editor.

2. Expand the ‘Dimension’ node in the Data Source panel. 

3. Drag the desired subseries dimension to the ‘Break By
(Dimension) / Tooltip (Measure)’ field in the Data panel.

This creates a subseries without visual formatting and without a legend.
This is useful when you want to represent an additional dimension on the
chart without complicating the presentation. The example below provides
an illustration.

Example: Adding 
a Subseries

Assume that you want to plot ‘Total Purchased’ vs. ‘State’ for a dataset.
Additionally, you want break down the sales in each region according to
‘Date’ (year). In this case, ‘State’ is the top level of grouping, represented
by the labels on the X-axis, and ‘Date’ will be the subseries. 
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In addition to the ‘Date’ subseries, you would also like to see (for each state
and each year) the names of the individuals who made those sales. You will
present this information as a non-formatted subseries.

Follow the steps below:

This Worksheet can
be found in the ‘Tuto-
rial’ folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the sample ‘Analysis’
Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Add a Chart component, and click the ‘Edit’ button on the chart to
open the Chart Editor.

3. In the Data Source panel, expand the ‘OrdersAndReturns’ data
block.

4. From the ‘Dimensions’ node in the Data Source panel, drag the
‘State’ dimension onto the ‘X’ field in the Data panel.

5. From the ‘Measures’ node in the Data Source panel, drag the
‘TotalPurchased’ measure onto the ‘Y’ field in the Data panel.

This displays ‘Total Purchased’ vs. ‘State’, as desired. You will
now add the visually-formatted subseries.

6. From the ‘Dimensions’ node in the Data Source panel, drag the
‘Date’ dimension onto the ‘Color’ field in the Visual panel.
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This creates the ‘Date’ subseries, formatting the different years
using color, and creating a corresponding legend. (Resize the chart
to show all the data.) In the next step, you will further break down
the data by salesperson name.

7. From the ‘Dimensions’ node in the Data Source panel, drag the
‘Last Name’ dimension onto the ‘Break By (Dimension) / Tooltip
(Measure)’ field in the Data panel.

Note: You can also
create an additional
subseries by binding a
vacant field in the
‘Visual’ panel. This
will add another for-
matted subseries and
legend.

This creates the ‘Last Name’ subseries without any additional
formatting. Each ‘Year’ subgroup is now further broken down by
salesperson name.

8. Preview the Viewsheet. Hover the mouse over the various chart
elements to view the salesperson for each subgroup.

¢

See Also
Adding a Visually-Formatted Subseries, for information on subseries with
format.

Adding a Non-Displaying Measure to a Chart

In some cases, you may wish to add a non-displaying measure to a chart.
This is useful when you want to utilize the measure for purposes of ranking
or as part of a tooltip, but do not wish the measure to be displayed on the
chart itself.

To add a non-displaying measure to a chart, simply drag the desired
measure field to the ‘Break By (Dimension) / Tooltip (Measure)’ region.
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This will add the measure to the chart tooltip, and make the measure
available for ranking.

See Also
Custom Tooltip, for information on customizing the text in a tooltip.
Editing a Dimension, for information on ranking dimension values.

4.4.8 Chart Properties

The Chart component’s ‘Properties’ dialog box provides the following
tabs: General, Advanced, Hierarchy, Script. The next sections discuss
the chart-specific properties available under these tabs.

See Also
Properties Dialog Box, for information about common component
properties.

Chart Properties: General Tab

The General tab in the ‘Chart Properties’ dialog box provides the
following chart-specific properties.

Tip Tooltip: Value is displayed as tooltip when mouse hovers over 
corresponding chart area. To display custom HTML in the tooltip, 
see Custom Tooltip.
Data Tip View: A Viewsheet component is displayed when mouse 
hovers over chart area. The component is filtered based on the hover 
region. See Data Tip View for more details.
Flyover Views: Allows you to select a set of Viewsheet 
components which will be adaptively filtered as the user hovers the 
mouse or clicks on the chart area. (Select ‘On Click Only’ if you 
want the filtered components to update when the user clicks.) 
Filtering is based on the group in the chart on which the user hovers 
or clicks. See Flyover View for more details.
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See Also
General Tab, for information about common properties in the General tab.
Crosstab Properties, for information about the General tab.
Format Dialog Box, for a listing of format options.

Custom Tooltip

You can create a custom tooltip by using HTML markup to style the tooltip
text. The tooltip can incorporate data values in java.text.MessageFormat
format. 

To create a custom tooltip, follow the steps below:

1. Right-click the chart, and select ‘Properties’ from the context
menu. This opens the ‘Chart Properties’ dialog box. 

2. Select the General tab.

3. Select the ‘Tooltip’ option, and press the ‘Customize’ button. This
opens the ‘Customize Tooltip’ dialog box.

4. Select the ‘Custom’ option, and enter the desired tooltip markup
into the edit box. The names and indices for the data fields are
listed at the bottom of the dialog box. You can insert a value into
the tooltip by using either the index or the field name within curly
braces, e.g., {1} or {Sum(Total)}. (You can mix indices and names
within a single tooltip.) 

http://download.oracle.com/javase/7/docs/api/index.html?java/text/MessageFormat.html
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For example, the following tooltips are equivalent for the fields
shown in the dialog box above:

<b>Month</b>: {0,date, MMMM yyyy}
<b>Total</b>: {1} -- <b>Quantity</b>: {2}

<b>Month</b>: {Month(Date),date, MMMM yyyy}
<b>Total</b>: {Sum(Total)} -- <b>Quantity</b>: 
{Sum(Quantity Purchased)}

See Chart Properties:
Advanced Tab to
enable or disable the
Ad Hoc Editing fea-
ture.

If you expect end-users to make changes to the chart using the Ad
Hoc Editing feature, you should use field names rather than
indices. Indices may not work correctly after a user makes ad hoc
changes to the chart.

You can use HTML tags to style the text (e.g., <b>, <i>, <u>,
<font>) and to create line breaks (<br/>), etc. Use
java.text.MessageFormat to format the inserted data. For example:

See Format Tab for
information about for-
mat masks.

<b>Date</b>: {0, date, MMM-yy}
<b>Sales</b>: {1, number, $#,###.00}

5. Press ‘OK’ to save the custom tooltip.

To create even more complex text-based tooltips, you can use the Data Tip
View, and specify a group of text elements as the data view assembly to
display.

Example: 
Custom Tooltip

In this example, you will create a chart that displays quantity purchased by
company. When the user hovers the mouse over a given company (e.g.,
“Rutgers Bank”), the Chart will display a tooltip similar to the following: 

Rutgers Bank
27 units purchased

Follow the steps below:

http://download.oracle.com/javase/7/docs/api/index.html?java/text/MessageFormat.html
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This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘Sales Explore’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Drag a Chart element onto the Viewsheet grid. 

3. Click the center of the Chart (or click the ‘Edit’ button at the top-
right). This opens the Chart Editor. Make the following selections:

a. From the ‘Dimensions’ node in the Data Source panel, drag the
‘Company’ dimension to the ‘X’ field in the Data panel.

b. From the ‘Measures’ node in the Data Source panel, drag the
‘Quantity Purchased’ measure to the ‘Y’ field in the Data panel.
This creates a chart that displays quantity purchased for each
company. 

c. Press the ‘Edit Dimension’ button, and select ‘Ranking’ to
display only the top 10 companies. Click the ‘Apply’ button.

d. Resize the chart as desired.

4. Right-click the Chart, and select ‘Properties’ from the context
menu. This opens the ‘Chart Properties’ dialog box. 

a. Under the General tab, select the ‘Tooltip’ option, and click
‘Custom’. This opens the ‘Customize Tooltip’ dialog box.
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b. Select the ‘Custom’ option and enter the following in the text
field:

<b>{0}</b><br />{1} units purchased

c. Press ‘OK’ to close the ‘Customize Tooltip’ dialog box, and
press ‘OK’ again to close the ‘Chart Properties’ dialog box.

When you hover the mouse over the bars on the chart, you will now see the
custom tooltip you specified.

¢

See Also
Data Tip View, to create complex tooltips using Viewsheet components.
Adding a Non-Displaying Measure to a Chart, to utilize a measure in the
tooltip which is not displayed on the chart.

Data Tip View

For a Table data-tip,
enable ‘Shrink to Fit’
in the Table Proper-
ties to minimize the
data-tip footprint.

A Data Tip displays information about the current chart or table region
using another Viewsheet component, such as another chart, text, Gauge, or
Organization Components. The data tip is displayed as a tooltip (next to the
pointer), and is adaptively filtered to show only data corresponding to the
particular region of the chart or crosstab where the pointer is positioned. If
the data tip utilizes a table or chart, the export features of the table or chart
remain available in data tip view.

Walkthrough In this example, you will create a chart that displays quantity purchased by
company. When the user hovers the mouse over a given company, the
Chart will display a Gauge as a Data Tip. This Gauge will display the
average quantity purchased by the individual company.

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘Sales Explore’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
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Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Drag a Gauge from the Component tree into the Viewsheet. 

3. Configure the Gauge to display the average quantity purchased.
Follow the steps below:

a. From the ‘Sales’ data block (top of the Component tree), drag
the ‘Quantity Purchased’ field onto the Gauge. This binds the
Gauge to the data block.

b. Right-click the Gauge, and select ‘Gauge Properties’ from the
context menu. This opens the ‘Properties’ dialog box for the
Gauge. 

c. Under the General tab, change the ‘Name’ property to
“QuantityGauge”.

d. Set the following limits: ‘Maximum’=200, ‘Minor
Increment’=10, ‘Major Increment’=25.

e. Under the Data tab, select ‘Count’ from the ‘Aggregate’ menu.
This will allow the gauge to display the number of records
(orders) for each company.

f. Press ‘OK’ to close the ‘Gauge Properties’ dialog box.

g. Resize the Gauge to be about half the default size.

4. Drag a Chart element onto the Viewsheet grid. This opens the
Chart Editor. (If the Chart Editor is not open, press the ‘Edit’ button
at the top right corner of the chart.)

5. Make the following selections:

a. From the ‘Dimensions’ node in the Data Source panel, drag the
‘Company’ dimension to the ‘X’ field in the Data panel.

b. From the ‘Measures’ node in the Data Source panel, drag the
‘Quantity Purchased’ measure to the ‘Y’ field in the Data panel.
This creates a chart that displays quantity purchased for each
company. 

c. Press the ‘Edit Dimension’ button, and select ‘Ranking’ to
display only the top 10 companies. Press the ‘Apply’ button.
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d. Resize the chart as desired.

6. Right-click the Chart, and select ‘Properties’ from the context
menu. This opens the ‘Chart Properties’ dialog box. 

a. Under the General tab, select ‘Data Tip View’. From the
adjacent menu, select the ‘QuantityGauge’ component.

b. To adjust the transparency of the data tip component (Gauge),
enter a value in the ‘Alpha’ menu (or choose one of the preset
values). A value of 0% indicates complete transparency; a value
of 100% indicates complete opacity.
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c. Press ‘OK’ to close the ‘Chart Properties’ dialog box.

Note: Data tips are not
active in the Design
view. Preview the
Viewsheet to see
them.

7. Preview the Viewsheet, and hover the mouse over different
companies in the Chart to view the corresponding Data Tip (i.e.,
number of orders).

Note that the Gauge is not displayed as part of the Viewsheet layout. The
Gauge appears only when you hover the mouse over one of the companies
in the chart, and it displays only the data for that particular company.

You can use a single component in both a Data Tip view and a Flyover
View. If you designate a Data Tip component for Flyover duty, the
component always remains visible on the Viewsheet.

See Also
Flyover View, to adaptively filter Viewsheet components based on mouse
position.

Flyover View

A flyover filters the information displayed in selected Viewsheet
components when the user moves the mouse over (or clicks on) particular
regions of a chart, table, or crosstab. This effectively allows a Chart, Table,
or Crosstab to behave as a selection element. Flyover is similar to the Data
Tip View, except that the filtered components remain in their original
positions (rather than following the mouse).

Walkthrough In this example, you will create a chart that displays quantity purchased by
company. When the user click a given company, the Chart will display a
Gauge as a Data Tip. This Gauge will display the average quantity
purchased by the individual company.

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘Sales Explore’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).
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2. Drag a Gauge from the Component tree into the Viewsheet. 

3. Configure the Gauge to display the average quantity purchased.
Follow these steps:

a. From the ‘Sales’ data block (top of the Component tree), drag
the ‘Quantity Purchased’ field onto the Gauge. This binds the
Gauge to the data block.

b. Right-click the Gauge, and select ‘Properties’ from the context
menu. This opens the ‘Properties’ dialog box for the Gauge. 

c. Under the General tab, change the ‘Name’ property to
“QuantityGauge”.

d. Set the following limits: ‘Maximum’=200, ‘Minor
Increment’=10, ‘Major Increment’=25.

e. Under the Data tab, select ‘Count’ form the ‘Aggregate’ menu.
This will display the number of records (orders) for each
company.

f. Press ‘OK’ to close the ‘Gauge Properties’ dialog box.

4. Drag a Table component onto the Viewsheet grid. Follow the steps
below to configure the Table:

a. In the ‘Sales’ data block (top of the Component tree), select the
following fields: ‘Category’, ‘Company’, ‘Name’.

b. Drag the selected fields onto the Table component. This adds
the three columns to the Table. Resize the Table as desired.

c. Right-click the Table, and select ‘Properties’ from the context
menu. This opens the ‘Table Properties’ dialog box. 

d. Under the General tab, change the ‘Name’ property to
“CompanyTable”.

e. Under the Advanced tab, select ‘Shrink to Fit’. This
automatically sizes the table to the number of records displayed.
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f. Press ‘OK’ to close the dialog box.

5. Drag a Chart element onto the Viewsheet grid. This opens the
Chart Editor. (If the Chart Editor does not open, press the ‘Edit’
button at the top-right corner of the chart.) 

6. Make the following selections:

a. From the ‘Dimensions’ node in the Data Source panel, drag the
‘Company’ dimension to the ‘X’ field in the Data panel.

b. From the ‘Measures’ node in the Data Source panel, drag the
‘Quantity Purchased’ measure to the ‘Y’ field in the Data panel.
This creates a chart that displays quantity purchased for each
company. 

c. Click the ‘Edit Dimension’ button, and select ‘Ranking’ to
display only the top 10 companies. Click the ‘Apply’ button.

d. Resize the chart as desired.

7. Right-click the Chart, and select ‘Properties’ from the context
menu. This opens the ‘Chart Properties’ dialog box. 

a. Select the General tab. 

b. In the ‘Flyover’ panel, click to select the two available
components: ‘CompanyTable’ and ‘QuantityGauge’.
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c. (Optional) Select ‘On Click Only’ if you want the filtered
components (‘CompanyTable’ and ‘QuantityGauge’) to update
only when the user clicks on the chart. Otherwise, the
components will update whenever the user hovers the mouse
over the chart.

d. Press ‘OK’ to close the ‘Chart Properties’ dialog box.

Note: Data tips are not
active in the Design
view. Preview the
Viewsheet to see
them.

8. Preview the Viewsheet, and hover the mouse (or click) over
different companies in the Chart. Observe that both the Table and
Gauge are filtered to display only the corresponding data.
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9. To lock the selection to a particular company (or set of companies),
click on the Chart to select the desired company (or Ctrl-click to
select a set of companies). This will lock the filter in place until the
selection is removed.

You can use a single component in both a Data Tip View and a Flyover
view. If you designate a Data Tip component for Flyover duty, the
component always remains visible on the Viewsheet.

See Also
Brushing a Chart, to use Chart selections to highlight (rather than filter)
other components.

Chart Properties: Advanced Tab

The Advanced tab in the ‘Chart Properties’ dialog box provides the
following chart-specific properties.

Apply Effect Applies a 3D effect to the Chart as a whole.
Enable Ad Hoc 
Editing

Allow end users to access the Chart Editor and edit the chart.

Sparkline Hides all axes and legends. For a line chart, the ‘Sparkline’ also 
adds a point to the end of the line, and for a bar chart, displays 
negative values in red. 

Enable Drilling Allows the user to drill up and down in date or dimension 
fields. See Drilling Down into a Chart for more information.

Target Lines Specify marker lines, bands, or statistical regions to be placed 
in the plot area. See Adding a Target Line, Adding a Target 
Band, and Adding a Statistical Measure for more information.
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See Also
Editing an Axis Title, for information about altering title text.
Editing a Chart Axis, for information about hiding chart axes.

Adding a Target Line

A target line is a horizontal or vertical line drawn on the chart that
generally denotes either an ideal value (goal or threshold) or representative
value (average, minimum, etc.). Regions above and below the target value
can be assigned independent colors.

To add a target line, follow the steps below:

1. Right-click the Chart, and select ‘Properties’ from the context
menu. This opens the ‘Chart Properties’ dialog box.

2. Select the Advanced tab of the ‘Properties’ dialog box. In the
‘Target Lines’ panel, press the ‘Add’ button. This opens the ‘Add
Target’ dialog box. 

3. Select the Line tab.

4. In the ‘Field’ menu, select the chart measure to which you want to
add the target line.

5. In the ‘Value’ field, type a numerical value at which to place the
target line for the selected measure, or choose one of the following
options to compute the target value from the data: ‘Average’,
‘Minimum’, ‘Maximum’, ‘Median’, ‘Sum’. (For example, select
‘Average’ to place the target line at the average value of the
selected measure.)
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6. (Optional) If you select one of the available target line
computations (‘Average’, ‘Minimum’, etc.), enable the ‘Entire
Chart’ option to compute the target value based on measure data
from the entire chart. Disable the ‘Entire Chart’ option to compute
the target value for each sub-chart based only on measure data from
the same sub-chart. 

The following illustration demonstrates the effect of the ‘Entire
Chart’ setting (‘Value’ is set to ‘Maximum’ in both cases).

7. From the ‘Label’ menu, select one of the following label options:
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a. Select ‘Enter a Value’ to type a custom label for the target line.

b. Select ‘(Target Value)’ to insert the numerical value of the target
line as the label.

c. Select ‘(Target Formula)’ to insert the name of the computation
method (‘Average’, ‘Minimum’, etc.) as the label, if applicable.

d. Select ‘(Field Name)’ to insert the field name for the selected
measure as the label; for example, “Sum(Total)”.

Note: The custom-
ized label supersedes
any previous selec-
tion from the ‘Label’
menu.

8. (Optional) To further customize the label, press the ‘Edit’ button
next to the ‘Label’ field. This opens a panel in which you can
manually enter the label. Press the green ‘Apply’ button when you
have finished entering the label.

If desired, you can add the target value, target formula, and field
name into the label by inserting the corresponding codes
({0},{1},{2}) shown at the bottom of the panel. You can apply
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formats to the inserted values by using the same syntax for Custom
Tooltip. Some examples are shown below:

{1} = {0,number,$#,##0} yeilds “Average = $383,485”
{1} of monthly {2} yeilds “Average of monthly 
Sum(Total)”

9. Select a ‘Line Style’ and ‘Line Color’ in which to display the target
line.

10. (Optional) Select a ‘Fill Above’ color and ‘Fill Below’ color to fill
the regions of the chart above and below the target line
respectively.

11. Press ‘OK’ to close the dialog box.

By default, the target line appears on the chart even if its value is greater
than the largest data point. This may sometimes cause the data points on the
chart to be compressed into a small region of the plot area, which makes the
chart difficult to read. To correct this, turn off the ‘Keep Element in Plot’
option in the ‘Plot Properties’ dialog box. See Editing Plot Properties for
more information.

See Also
Adding a Target Band, to demarcate a specified data region on the chart.
Adding a Statistical Measure, to display statistical measures on the chart.
Adding Property Script (Expressions), in Advanced Dashboard Scripting,
to set target line values and labels through expressions.
Dynamic Properties, set target line values and labels through Form
Components.

Adding a Target Band

A target band is a horizontal or vertical band drawn on the chart that
generally denotes either an ideal range (e.g., goal zone) or representative
range (e.g., span of maximum to minimum). The region within the target
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band, as well as the regions above and below, can be assigned independent
colors.

To add a target band, follow the steps below:

1. Right-click the Chart, and select ‘Properties’ from the context
menu. This opens the ‘Chart Properties’ dialog box.

2. Select the Advanced tab of the ‘Properties’ dialog box. In the
‘Target Lines’ panel, press the ‘Add’ button. This opens the ‘Add
Target’ dialog box. 

3. Select the Band tab.

4. In the ‘Field’ menu, select the chart measure to which you want to
add the target band.

5. In the ‘From Value’ field, enter a numerical value at which to place
the lower band range for the selected measure, or choose one of the
following options to compute the lower band range from the data:
‘Average’, ‘Minimum’, ‘Maximum’, ‘Median’, ‘Sum’. (For
example, select ‘Average’ to place the lower band boundary at the
average value of the selected measure.)
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6. In the ‘From Label’ menu, select one of the following label
options:

a. Select ‘Enter a Value’ to type a custom label for the lower band
boundary.

b. Select ‘(Target Value)’ to insert the numerical value of the lower
band boundary as the label.

c. Select ‘(Target Formula)’ to insert the name of the computation
method (‘Average’, ‘Minimum’, etc.) as the lower band
boundary label, if applicable.

d. Select ‘(Field Name)’ to insert the field name of the selected
measure as the lower band boundary label, e.g., “Sum(Total)”.

Note: The custom-
ized label supersedes
any previous selec-
tion from the ‘From
Label’ menu.

7. (Optional) To further customize the label, press the ‘Edit’ button
next to the ‘From Label’ field. This opens a panel in which you can
manually enter the label. Press the green ‘Apply’ button when you
have finished entering the label.
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If desired, you can add the target band value, target band formula,
and field name into the label by inserting the corresponding codes
({0},{1},{2}) shown at the bottom of the panel. You can format
the inserted values using the same syntax as Custom Tooltip. Some
examples are shown below:

{1} = {0,number,$#,##0} yeilds “Average = $383,485”
{1} of monthly {2} yeilds “Average of monthly 
Sum(Total)”

8. (Optional) If you select one of the available target band
computations (‘Average’, ‘Minimum’, etc.), enable the ‘Entire
Chart’ option to compute the target band value based on measure
data from the entire chart. Disable the ‘Entire Chart’ option to
compute the target band value for each sub-chart based only on
measure data from the same sub-chart. 

The following illustration demonstrates the effect of the ‘Entire
Chart’ setting. (In both cases, ‘From Value’ is set to ‘Minimum’
and ‘To Value’ is set to ‘Maximum’).
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9. Repeat the previous steps to set the ‘To Value’ and ‘To Label’
properties, which specify the position and label of the upper band
boundary.

10. Select a ‘Line Style’ and ‘Line Color’ in which to display the upper
and lower target band boundaries.

11. (Optional) Press the ‘Fill Band’ button and select a background
color to fill the band between the lower and upper boundaries.
Select a ‘Fill Above’ color and ‘Fill Below’ color to fill the regions
of the chart above and below the band boundaries, respectively.

12. Press ‘OK’ to close the dialog box.

By default, the target band appears on the chart even if its upper or lower
range values are greater than the largest data point. This may sometimes
cause the data points on the chart to be compressed into a small region of
the plot area, which makes the chart difficult to read. To correct this, turn
off the ‘Keep Element in Plot’ option in the ‘Plot Properties’ dialog box.
See Editing Plot Properties for more information.

See Also
Adding a Target Line, to place a target line or representative line on the
chart.
Adding a Statistical Measure, to display statistical measures on the chart.
Adding Property Script (Expressions), in Advanced Dashboard Scripting,
to set target line values and labels through expressions.
Dynamic Properties, set target line values and labels through Form
Components.

Adding a Statistical Measure

A statistical measure is represented by one or more lines drawn on the
chart to indicate the values of statistical quantities derived from the data
(confidence intervals, percentages, percentiles, quantiles, or standard
deviation). 
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To add a statistical measure, follow the steps below:

1. Right-click the Chart, and select ‘Properties’ from the context
menu. This opens the ‘Chart Properties’ dialog box.

2. Select the Advanced tab of the ‘Properties’ dialog box. 

3. In the ‘Target Lines’ panel, press the ‘Add’ button. This opens the
‘Add Target’ dialog box. 

4. Select the Statistics tab.

5. In the ‘Field’ menu, select the chart measure to which you want to
add the statistical measure.

6. In the ‘Computation’ field, select one of the following options to
compute statistics from the data: ‘Confidence Interval’,
‘Percentages’, ‘Percentile’, ‘Quantiles’, ‘Standard Deviation’. (See
explanations below.)

7. To modify the statistical measure, press the ‘Edit’ button. The
following settings are available:

a. Confidence Interval: For the ‘Confidence Interval’ option,
enter a value as a percentage. 
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The resulting top and bottom confidence bounds indicate the
interval of values in which the “true” value is expected to be
found. For example, the “true” temperature in the chart below
would be expected to fall within the displayed confidence
interval in 99 out of 100 such samples. (In other words, the true
temperature is expected to be outside the confidence bounds
purely by chance in 1 out of 100 samples.)

b. Percentages: For the ‘Percentages’ option, enter a value or
comma-separated list of values as percentages. In the ‘Of’ field,
specify the basis on which the percentage should be computed.
You can type a fixed value or select from the following presets:
‘Average’, ‘Minimum’, ‘Maximum’, ‘Median’, ‘Sum’.

For example, to display percentage lines at 70% and 90% of the
Maximum, enter “70,90” in the ‘Percentages’ field and select
the ‘Maximum’ option from the ‘Of’ field.
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c. Percentiles: For the ‘Percentiles’ option, enter a value or
comma-separated list of values as percentages. 

The resulting percentile lines indicate the levels below which
the specified percentages of values are found. For example,
percentile lines at 70% and 90% (“70,90” in the ‘Percentages’
field) designate the levels, respectively, below which 70% and
90% of the data are found.

d. Quantiles: For the ‘Quantiles’ option, enter the number of
quantiles to display. 

The resulting quantile lines are evenly distributed between 0%
and 100% and indicate the levels below which the specified
percentage of values are found. For example, enter “4” as the
‘Number of Quantiles’ to generate lines designating the levels
below which 25%, 50%, and 75% of the data are found. This
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creates four regions in the data: 0-25%, 25%-50%, 50%-75%,
and 75%-100%.

e. Standard Deviation: For the ‘Standard Deviation’ option, enter
a comma-separated list of factors. Each successive pair of
factors represents, respectively, the lower and upper multipliers
for the standard deviation.

For example, enter “-1,1,-2,2” in the ‘Factors’ field to draw
lines, respectively, at 1 standard deviation below the mean, 1
standard deviation above the mean, 2 standard deviations below
the mean, and 2 standard deviations above the mean.

Select the ‘Sample’ option to compute the sample standard
deviation or select the ‘Population’ option to compute the
population standard deviation. (The distinction between sample
and population standard deviation can be found in any statistical
reference.)

8. (Optional) Enable the ‘Entire Chart’ option to compute the
statistical values based on measure data from the entire chart.
Disable the ‘Entire Chart’ option to compute the statistical values
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for each sub-chart based only on measure data from the same sub-
chart. 

The following illustration demonstrates the effect of the ‘Entire
Chart’ setting (‘Computation’ is set to ‘Standard Deviation’ in both
cases).

9. From the ‘Label’ menu, select one of the following label options:

To enter a literal
comma in the label,
escape the comma
with a backslash (e.g.,
“Q1\,25% below, Q2\,
50% below, Q3\,75%
below”).

a. Select ‘Enter a Value’ to type custom labels for the statistical
measures. Labels for individual lines should be separated by
commas. For example, if you are generating the 4-quantile
(which creates three lines), enter three labels separated by
commas, e.g., “Q1: 25% below, Q2: 50% below, Q3: 75%

below”. 
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If you enter only a single label, this label will be attached to all
of the lines. This can be useful when you include customization
codes in the label, as described below.

b. Select ‘(Target Value)’ to insert the numerical value of the lines
as the labels.

c. Select ‘(Target Formula)’ to insert the name of the computation
method (e.g., ‘Quantile 1’, ‘Quantile 2’, etc.) as the label, if
applicable.

d. Select ‘(Field Name)’ to insert the field name for the selected
measure as the label, e.g., “Sum(Total)”.

Note: The custom-
ized label supersedes
any previous selec-
tion from the ‘Label’
menu.

10. (Optional) To further customize the labels, press the ‘Edit’ button
next to the ‘Label’ field. This opens a panel in which you can
manually enter the labels. Press the green ‘Apply’ button when you
have finished entering the labels.

To enter a literal
comma in the label,
escape the comma
with a backslash (e.g.,
“Q1\,25% below, Q2\,
50% below, Q3\,75%
below”).

Labels for individual lines should be separated by commas. For
example, if you are generating the 4-quantile (which creates three
lines), enter three labels separated by commas, e.g., “Q1: 25%

below, Q2: 50% below, Q3: 75% below”.
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If desired, you can add the target value, target formula, and field
name into a label by inserting the corresponding codes
({0},{1},{2}) shown at the bottom of the panel. You can format
the inserted values using the same syntax as Custom Tooltip. Some
examples are shown below:

{1} = {0,number,$#,##0} yeilds “70% of Max = $383,485”
{1} for monthly {2} yeilds “70% of Max for monthly 
Sum(Total)”

11. Select a ‘Line Style’ and ‘Line Color’ in which to display the
statistical lines.

12. (Optional) Press the ‘Fill Band’ button to open a color picker and
select a set of colors for the specified bands (i.e., the regions
between the statistical lines). Select one color for each band. The
colors are applied to the bands from left to right; the left-most color
is applied to the lowest band, and so on. When you have selected
the desired colors, press the green ‘Apply’ button.

For more information about the features of the color-picker, see
Adding Color Coding to Dimensions.

13. (Optional) Select a ‘Fill Above’ color and ‘Fill Below’ color to fill
the regions of the chart above and below the maximum and
minimum statistical lines, respectively.
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14. Press ‘OK’ to close the dialog box.

By default, a statistical line appears on the chart even if its value is greater
than the largest data point. This may sometimes cause the data points on the
chart to be compressed into a small region of the plot area, which makes the
chart difficult to read. To correct this, turn off the ‘Keep Element in Plot’
option in the ‘Plot Properties’ dialog box. See Editing Plot Properties for
more information.

See Also
Adding a Target Line, to place a target line or representative line on the
chart.
Adding a Target Band, to demarcate a specified data region on the chart.
Adding Property Script (Expressions), in Advanced Dashboard Scripting,
to set target line values and labels through expressions.
Dynamic Properties, set target line values and labels through Form
Components.

Chart Properties: Hierarchy Tab

The Hierarchy tab in the ‘Chart Properties’ dialog box allows you to
specify the hierarchy for a custom drill-down. 

To create a custom drill-down hierarchy, follow the steps below:

1. Right-click the Chart, and select ‘Properties’ from the context
menu. This opens the ‘Chart Properties’ dialog box.

2. Select the Hierarchy tab. The ‘Columns’ panel displays the fields
available in the Chart’s binding.
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3. Click on a field that you want to include in the hierarchy, and drag
the field to the ‘Hierarchy’ panel.

Drilling on date fields
is enabled by default.
Use the Hierarchy tab
to customize the drill
sequence.

4. (Optional) If the added field is a date field, select the desired date
representation from options below the ‘Hierarchy’ panel. The
options are ‘Year’, ‘Month of Year’, ‘Day of Week’, ‘Quarter of
Year’, ‘Day of Month’, and ‘Hour of Day’.

Observe that after you add a date field to the ‘Hierarchy’ panel, the
date field still remains available in the ‘Columns’ panel. This
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allows you to add the same date field to the hierarchy at multiple
levels, giving each level a different date representation. In this way,
you can control the date-drilling sequence. For example, the
following hierarchy produces the drill-down sequence ‘Year’ >
‘Month’ > ‘Day’.

A horizontal green
line indicates the posi-
tion where the field
will be placed within
the hierarchy

5. Click on another field that you want to include in the hierarchy, and
drag it over the existing fields in the ‘Hierarchy’ panel. Drop the
field into the desired position in the hierarchy.

6. Repeat the previous step to add additional fields to the hierarchy, as
desired.

To remove a specific field from the hierarchy, simply drag the field
from the ‘Hierarchy’ panel back to the ‘Columns’ panel. To
remove all fields from the hierarchy, press the ‘Clear’ button.

7. (Optional) To create an additional independent hierarchy, drag a
field from the ‘Columns’ panel to the region labeled ‘Drag here to
add a hierarchy’. Then repeat the previous steps to add additional
fields to this independent hierarchy.
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8. Press ‘OK’ to close the dialog box.

Note that there may not be any immediate change to the Chart. However,
by configuring a hierarchy as described above, you achieve the following
effect: Whenever you (or the end user) adds a field listed on the hierarchy
to the ‘X’ or ‘Y’ region of the Chart Editor, the Chart will automatically
implement an appropriate drill-down feature based on the specified
hierarchy. 

For example, consider the following hierarchy:

Category
Name
Company 

After you have specified this hierarchy in the ‘Hierarchy’ panel, if you then
bind the ‘Category’ field to the ‘X’ or ‘Y’ region in the Chart Editor, the
Chart automatically makes a full drill-down hierarchy (‘Category’ >
‘Name’ > ‘Company’) available to users. Likewise, if you bind the ‘Name’
field to the ‘X’ or ‘Y’ region in the Chart Editor, the Chart automatically
makes the appropriate partial drill-down hierarchy (‘Name’ > ‘Company’)
available to users.

For information on how to navigate a chart with drill-downs, see Drilling
Down into a Chart.

See Also
Drilling Down into a Chart, for information on using default drill-down
features.

4.4.9 Representing Data with Visual Formats

You can represent data values using the following visual formats: Color,
pattern, size, or text. These formats can be applied to an entire dataset or to
a subseries within a dataset.

The following sections explain how to add visual formats to a dataset. For
information on adding formats to subseries, see Adding a Sub-Series.
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Adding a Fixed Visual Format

To add a fixed visual format (not keyed to data), follow the steps below:

1. If the chart contains multiple measures with individual styles, click
on one of the arrows in the ‘Visual’ panel title bar to select the
particular measure that you want to format. (Or click the area
between the arrows to select the measure from a menu.)

If desired, select ‘all’ to apply visual formatting (selected in the
next step) to all measures.

2. Press the ‘Edit’ button in one of the format fields in the ‘Visual’
pane: ‘Color’, ‘Shape’, ‘Size’.

Note: The available
shape options vary
depending on the
Chart type.

The following shapes are available for point-type charts:

To hide a measure’s data points in cases where the measure is being used to
anchor text on the chart, press the ‘Clear’ button on the ‘Shape’ panel. (The
‘Clear’ button is only available when the ‘Text’ field is in use.) See
Representing Data With Text for an example.
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An administrator can make custom shapes available by placing image files
(png, gif, jpg) in the WEB-INF/classes/portal/shapes directory on the
server. The icons are sorted alphabetically by file name. Custom shape
images should be 18x18 pixels, and will be scaled according to the ‘Size’
setting in the Chart Editor.

See Also
Setting a Chart Style for an Individual Dataset, to assign individual styles
to multiple measures.
Adding Formats to Dimensions, for information on keying formats to
grouping.
Adding Formats to Measures, for information on keying formats to data
values.
Adding a Sub-Series, for information on using format to create groupings.

Adding Formats to Dimensions

To add a visual format to a dimension, follow the steps below:

1. If the chart contains multiple measures with individual styles, click
on one of the arrows in the ‘Visual’ panel title bar to select the
particular measure that you want to format. (Or click the area
between the arrows to select the measure from a menu.)

If desired, select ‘all’ to apply visual formatting (selected in the
next step) to all measures.

2. Drag the desired dimension from the ‘Data Source’ tree to the
desired format field in the ‘Visual’ pane (‘Color’, ‘Shape’, ‘Size’,
or ‘Text’).

If the dimension is not already used on the chart X-axis, this creates a new
subseries using the specified formatting for the selected measure.
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See Also
Converting between Measure and Dimension, to convert a dimension to a
measure.
Setting a Chart Style for an Individual Dataset, to assign individual styles
to multiple measures.
Positioning a Chart Legend, for information on controlling the legend
display.
Editing a Chart Legend, for information on changing the display of a
legend.
Adding a Sub-Series, for information on using format to create groupings.

Adding Formats to Measures

To add a visual format to a measure, follow the steps below:

1. If the chart contains multiple measures with individual styles, click
on one of the arrows in the ‘Visual’ panel title bar to select the
particular measure that you want to format. (Or click the area
between the arrows to select the measure from a menu.)

If desired, select ‘all’ to apply visual formatting (selected in the
next step) to all measures.
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2. Drag the measure (i.e., the measure that will supply the formatting
values) from the ‘Data Source’ tree to the desired format field in
the ‘Visual’ pane (‘Color’, ‘Shape’, ‘Size’, or ‘Text’). 

By default, string-type measures are represented categorically. Other
measures are represented linearly unless you select the ‘Discrete’ option.
See Displaying a Measure as Discrete Values for more information.

See Also
Converting between Measure and Dimension, to convert a measure to a
dimension.
Setting a Chart Style for an Individual Dataset, to assign individual styles
to multiple measures.
Adding Color Coding to Measures, for information on changing the color
representation.
Adding Shape Coding to Measures, for information on changing the shape
representation.

Representing Data With Color

To represent data using color, drag a dimension or measure from the Data
Source panel to the ‘Color’ field in the Visual panel. 

See Also
Adding Formats to Dimensions, for information on using format to
categorize.
Adding Formats to Measures, for information on using format to code data.
Adding a Sub-Series, for information on using format to create groupings.



DATA MASHUP

571 of 1397

Adding Color Coding to Dimensions

To specify the order in which the colors are applied to the levels of a
dimension, follow the steps below:

1. Press the ‘Edit’ button next to the ‘Color’ field. This opens the
color panel.

2. (Optional) Press the ‘Select Palette’ button to open the ‘Select
Palette’ dialog box.

If the selected palette
does not contain
enough colors to rep-
resent all of the dis-
tinct data groups,
additional groups will
be represented by col-
ors from the default
palette.

3. Choose the desired palette from the ‘Select Palette’ menu. If
desired, select the ‘Reverse’ option to reverse the order of the
palette colors.

Press ‘OK’. 

4. Click on the color chips to create the desired color order. 

5. Press ‘Apply’ to finalize the setting.

To reset the color order, click the ‘Reset’ button on the color menu. To
synchronize the color mapping to that of other charts (in the Viewsheet)
which display the same dimension, click the ‘Shared’ button in the color
panel.
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To specify one or more custom palettes using your own color choices,
create a file called colorpalettes.xml in the portal directory of SREE Home
(WEB-INF\classes\portal, by default). The structure of the file should be as
follows:

<?xml version="1.0" encoding="UTF-8"?>
<palettes>
<palette name="MyPalette_1">
<colors>
<color value="#ff0000"/>
<color value="#00ff00"/>
<color value="#0000ff"/>

...
<color value="#00ffff"/>

</colors>
</palette>
<palette name="MyPalette_2">
<colors>
<color value="#000000"/>
<color value="#222222"/>
<color value="#444444"/>

... 
<color value="#eeeeee"/>

</colors>
</palette>

</palettes>

If you designate a custom palette which has the same “palette name” as
one of the built-in palettes, the custom palette will be used in place of the
built-in palette.

To assign palette colors based on CSS, use the ChartPalette selector. See
CSS Tab for more information about the ChartPalette selector.

See Also
Adding Formats to Dimensions, for information on using format to
categorize.
Adding Formats to Measures, for information on using format to code data.
Adding a Sub-Series, for information on using format to create groupings.

Adding Color Coding to Measures

To specify the manner in which colors are used to code the measure values,
follow the steps below:

1. Click the ‘Edit’ button next to the ‘Color’ field. This opens the
color selection menu.
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2. Select a gradient style for the color coding. If required, click the
color chip to specify the desired color.

3. Click ‘Apply’ to finalize the setting.

See Also
Adding Formats to Dimensions, for information on using format to
categorize.
Adding Formats to Measures, for information on using format to code data.
Adding a Sub-Series, for information on using format to create groupings.

Representing Data With Shape

To represent data using fill pattern or shape, drag a dimension or measure
from the Data Source panel to the ‘Shape’ field in the Visual panel. 

See Also
Adding Formats to Dimensions, for information on using format to
categorize.
Adding Formats to Measures, for information on using format to code data.
Adding a Sub-Series, for information on using format to create groupings.

Adding Shape Coding to Dimensions

To specify the order in which the patterns/shapes are applied to the levels
of a dimension, follow the steps below:

1. Click the ‘Edit’ button next to the ‘Shape’ field. This opens the
shape selection menu.



DATA MASHUP

574 of 1397

Note: The available
shape options vary
depending on the
Chart type.

2. Click on the individual shape menus to create the desired pattern/
shape order. The following shapes are available for point-type
charts:

An administrator can make custom shapes available by placing the
image files (png, gif, jpg) in the WEB-INF/classes/portal/shapes
directory on the server. The icons are sorted alphabetically by file
name. Custom shape images can be any size, and are scaled
according to the ‘Size’ setting in the Chart Editor.

3. Press ‘Apply’ to finalize the setting.

To reset the shape order, click the ‘Reset’ button on the shape menu. To
synchronize the shape mapping to that of other charts (in the Viewsheet)
which display the same dimension, click the ‘Shared’ button in the shape
panel.

See Also
Adding Formats to Dimensions, for information on using format to
categorize.
Adding Formats to Measures, for information on using format to code data.
Adding a Sub-Series, for information on using format to create groupings.

Adding Shape Coding to Measures

To specify the manner in which shapes are used to code the measure
values, follow the steps below:

1. Click the ‘Edit’ button next to the ‘Shape’ field. This opens the
shape selection menu.

Note: The available
shape options vary
depending on the
Chart type.

2. Select a pattern style for the value coding. 



DATA MASHUP

575 of 1397

For the ‘Left Tilt’, ‘Right Tilt’ and ‘Grid’ options, the density of the
pattern represents the measure value. For the ‘Orientation’ option,
the angle of the hashing represents the measure value.

3. Click ‘Apply’ to finalize the setting.

See Also
Adding Formats to Dimensions, for information on using format to
categorize.
Adding Formats to Measures, for information on using format to code data.
Adding a Sub-Series, for information on using format to create groupings.

Representing Data with Size

To represent data using size, drag a dimension or measure from the Data
Source panel to the ‘Size’ field in the Visual panel. 

To specify the range of sizes that should be used in representing the levels
of a dimension or values of a measure, follow the steps below:

1. Click the ‘Edit’ button next to the ‘Size’ field. This opens a size
range slider.

2. Adjust the slider to select the smallest and largest element size.

3. Click ‘Apply’ to finalize the setting.

See Also
Adding Formats to Dimensions, for information on using format to
categorize.
Adding Formats to Measures, for information on using format to code data.
Adding a Sub-Series, for information on using format to create groupings.

Representing Data With Text

To display a dimension or measure values using text, drag the dimension or
measure from the Data Source panel to the ‘Text’ field in the Visual
panel. 
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Note: By default,
dimension and mea-
sure values are auto-
matically displayed
by tooltip when the
Viewsheet is pre-
viewed or deployed.

To format the text displayed for the dimension or measure, follow the steps
below:

1. Press the ‘Edit’ button next to the ‘Text’ field. 

This opens the ‘Text Format’ dialog box.

2. Select the text size, font, and color.

3. Select the format for the displayed text. See Format Tab for an
explanation of the format options.
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4. Press ‘OK’ to close the dialog box.

Alternatively, you can click the text on the chart to select it, and then press
the desired toolbar buttons to change the formatting.

See Also
Adding Formats to Dimensions, for information on using format to
categorize.
Adding Formats to Measures, for information on using format to code data.
Adding a Sub-Series, for information on using format to create groupings.

Example: 
Superimposing 
Measure Values 
Over a Bar Chart

When you display a measure on a chart as text, the text is placed next to the
corresponding data points. For example, in the chart below, the ‘Text’
binding displays the ‘Quantity Purchased’ values as text next to the bars. 

In some cases, it may be desirable to display the ‘Quantity Purchased’
value superimposed on top of the bars instead, as shown below:

To do this, follow the steps below:
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1. Right-click on the chart and select ‘Properties’. This opens the
‘Chart Properties’ dialog box.

2. Select the Script tab, and enter the following script, and press
‘OK’.

graph.getElement(0).setLabelPlacement(Chart.LEFT);

If the chart has the dimension on the X-axis and measure on the Y-
axis, use the following script instead:

graph.getElement(0).setLabelPlacement(Chart.BOTTOM);

3. Press ‘OK’ to close the Script Editor.

¢

4.4.10 Adding Highlights to a Chart 

You can highlight chart elements based on the values that they contain. To
add highlights to a chart, follow these steps:

1. Right-click on a data group in the chart, and select ‘Highlight’ from
the context menu. This opens the ‘Highlight’ dialog box.
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2. In the ‘Highlight’ dialog box, define the desired highlight. See the
Highlights section for details on how to do this. 

Example: Chart 
Highlighting

In this example, you will create a chart to display ‘Quantity Purchased’ vs.
‘State’, and use highlighting to draw attention to values that exceed 5000 or
fall below 1000. Follow the steps below:

This Worksheet can
be found in the ‘Tuto-
rial’ folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the sample ‘Analysis’
Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Add a chart component, and click the ‘Edit’ button. This opens the
Chart Editor.

3. In the Data Source panel, expand the ‘OrdersAndReturns’ data
block.

4. From the ‘Dimensions’ node, drag the ‘State’ field to the ‘X’ field
of the Data panel.

5. From the ‘Measures’ node, drag the ‘Quantity Purchased’ field to
the ‘Y’ field of the Data panel. This creates the desired chart.
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6. Right-click in any bar on the chart, and select the ‘Highlight-
Quantity Purchased’ option from the context menu. This opens the
‘Highlight’ dialog box.

7. Click the ‘Add’ button to open the ‘Name’ dialog box. 

8. Enter ‘Under1000’ as the name of the first highlight. Click ‘OK’ to
close the dialog box. The new highlight name appears in the
highlight list.

9. Click the highlight name in the list to select it. From the ‘Color’
palette, select the color red (rgb value “FF0000”).

10. In the ‘Condition’ panel, click the ‘Edit’ button to open the
‘Condition’ dialog box. Enter the following condition, and click
‘OK’.

[Sum of Quantity Purchased][is][less than][1000]

11. Repeat Steps 7-10 to add the following conditions and formats:

a. Name = ‘Over5000’, rgb value = ‘AAFFAA’

[Sum of Quantity Purchased][is][greater than][5000]

b. Name = ‘Between1000and5000’, rgb value = ‘B0B0B0’

[Sum of Quantity Purchased][is][between][1000,5000]
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12. Press ‘OK’ to exit the ‘Highlight’ dialog box.

The chart table now shows the value-keyed highlighting you
specified. In particular, the very large and very small order
quantities have been highlighted in green and red, respectively.

¢

See Also
Highlights, for information on defining a highlight.
Brushing a Chart, for information on highlighting data across multiple
charts.
Crosstabs, for information on creating crosstabs.

4.4.11 Adding Hyperlinks to a Chart

In charts, hyperlinks can be attached to the chart graphical elements (e.g.,
the bars in a bar chart). To create hyperlinks on a chart, follow the steps
below:

1. Right-click on a chart element to add hyperlinks to the chart
elements (e.g., bars), or right-click on a chart dimension label to
add hyperlinks to the labels.
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2. Select ‘Hyperlink’ from the context menu. This opens the
‘Hyperlink’ dialog box.

3. In the ‘Hyperlink’ dialog box, define the desired hyperlink. See the
Hyperlinks section for details on how to do this. 

See Also
Hyperlinks, for information on the ‘Hyperlink’ dialog box.

4.5 Map Charts
A map is a type of chart, and displays summarized data grouped by
physical location in the form of a geographical map. It has many of the
same properties of other chart types, but also differs in some ways. The
following sections explain how to create and modify map charts.

See Also
Creating a Custom Map, in Advanced Server Administration, to create a
map based on a custom shapefile.

4.5.1 Creating a Map Chart

To add a map chart to a Viewsheet, drag and drop the Chart component
from the Component tree into the grid. Use the mouse to move and resize
the chart as desired. 

To bind the Chart to geographical data, follow the steps below:

1. Press the ‘Edit’ button in the top-right corner of the chart to open
the Chart Editor.



DATA MASHUP

583 of 1397

2. In the Chart Editor’s Data panel, click ‘Select Chart Style’, and
choose the ‘Map’ chart type. Click the ‘Apply’ button (or double-
click the ‘Map’ icon).

The the Data panel changes to display a ‘Geographic’ field.

If your columns con-
tain longitude and lat-
itude data (in decimal
format) rather than
location names, use
the ‘Longitude’ and
‘Latitude’ fields of the
‘Data’ panel.

3. From the Data Source panel in the Chart Editor, drag a geographic
dimension onto the ‘Geographic’ field in the Data panel. (See
Setting a Geographical Field to declare a field as geographical.)

The chart updates to display the locations contained in the
geographic field.

4. Repeat the previous step to bind additional ‘Geographic’ levels.
For example, you can bind ‘City’ and ‘State’ fields.
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5. From the Data Source panel, drag a measure onto one of the fields
in the Visual panel (‘Color’, ‘Shape’, ‘Size’, or ‘Text’). 

This binding will display the measure on the chart using the
particular visual coding you selected, and automatically creates a
corresponding legend. See Adding a Sub-Series for more
information on using the Visual panel.

6. Click the ‘Edit Measure’ button, and select the desired aggregation
method for the measure.

7. (Optional) For any geographical fields that you specified, click the
‘Edit Dimension’ button, and select the desired ranking for the
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geographical data. For example, you can display just the top three
states according to the measure.

8. (Optional) To create a particular trajectory through the points on
the chart, drag a path field to the ‘P’ region. The values of this field
are used to assign the sort order for the plotted data so that
connecting lines are drawn between points which are adjacent in
the path sort order.

9. (Optional) Set the initial map view by selecting a region, and
clicking the ‘Zoom’ button. See Zooming a Chart for more details.

See Also
Creating a Custom Map, in Advanced Server Administration, to create a
map based on a custom shapefile.
Setting a Geographical Field, for information on declaring a field
geographical.
Editing Chart Formats, for information on changing chart labels.
Adding a Sub-Series, for information on using the Visual panel.
Creating Selection List from Chart Data Source, for information on adding
a Selection List.
Creating a Selection Tree from Chart Data Source, for information on
adding a Selection Tree.
Positioning a Component, for information on moving and resizing a chart.
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Resolving Geographical Data

When Visual Composer cannot automatically match your geographical
data to the locations in the geographical database, you can use the
‘Geographic Mapping’ dialog box to manually create the correct mapping.

To set the mapping for geographical data, follow the steps below.

1. In the Chart Editor, right-click the desired geographical field, and
select ‘Edit Geographic’ to open the editing panel. (See Setting a
Geographical Field for more information.)

The Chart Editor attempts to resolve values in the selected
geographic field against the corresponding layer in the map
database. If all data values are successfully matched, a green check
mark is displayed. If some data values cannot be matched, a red
question mark is displayed.

2. To resolve any unmatched names, click the red question mark. This
opens the ‘Geographical Mapping’ dialog box. In the
‘Geographical Mapping’ dialog box, follow the steps below:

a. Select one of the unmatched names in the top left panel. The
right panel will display a list of candidate matches. (If the list is
very long, type a portion of the name in the search box above
the panel to limit the results.)

b. If the list does not contain the intended match, select another
matching method from the ‘Algorithm’ menu.

c. Select the correct match and click the ‘Add’ button.
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This creates the desired mapping between the data value and the
geographical information in the map database. (You can match
multiple data values to a single geographical location.)

3. Repeat the above steps until all values have been matched. 

To reuse a custom
mapping, create and
save the mapping in
Style Studio. See
Resolving Geographi-
cal Data in Advanced
Report Design for
more details.

4. When you have completed making all matches, and the left panel is
empty, click ‘OK’ to close the dialog box.

5. Click the ‘Apply’ button in the geographical editing panel.

Example: 
Resolving 
Geographical 
Data

In this example, you will create a Worksheet data block that contains state
names that have an unusual format. Because of the unusual format, you
will need to manually map these state name to the correct geographical
locations. 

This example assumes that you are familiar with Data Worksheets,
and requires some scripting. See Creating an Expression/Formula
Column in Advanced Data Mashup for complete information.

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Open the ‘Sales Explore’ Worksheet. 

For information on how to open a Data Worksheet, see Editing a
Data Worksheet in Visual Composer (Style Scope or Style
Intelligence) or Editing a Data Set (Style Scope Agile Edition).

2. Save a copy of the Worksheet as ‘Sales Explore Copy’.

3. To see actual data in the ‘Sales’ data block, press the ‘Change
View’ button in the title bar and select ‘Live preview’.



DATA MASHUP

588 of 1397

4. In the ‘Sales Explore Copy’ Worksheet, create a formula column
that contains variations of the state names in the ‘State’ column. To
do this, follow the steps below:

a. Press the ‘Create Expression’ button in the title bar of the
‘Sales’ table. 

b. When Visual Composer prompts you for the expression name,
enter ‘New State’ for ‘Expression Name’. Press ‘OK’ to open
the Formula Editor.

c. Select the ‘Script’ option at the tope of the Editor. (The formula
will use JavaScript syntax rather than SQL.)

d. In the Formula Editor, enter an expression that will change two
of the names in the ‘State’ column:

if (field['State'] == 'NJ') {
'Jersey';

}
else if (field['State'] == 'CT') {

'Conn';
}
else {

field['State']
}
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This simply changes the values ‘NJ’ and ‘CT’ to ‘Jersey’ and
‘Conn’ in the expression column, respectively, leaving all other
state values the same.

e. Press ‘OK’ to exit the Formula Editor. This creates the new
column called ‘New State’. 

5. Save the Worksheet.

6. Create a new Viewsheet based on this ‘Sales Explore Copy’
Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

7. Add a Chart to the new Viewsheet. (If the Chart Editor does not
open after adding the Chart, press the ‘Edit’ button on the Chart). 

8. In the Data panel of the Chart Editor, click the ‘Select Chart Style’
button, and choose the ‘Map’ type.

9. In the Data Source panel of the Chart Editor, right-click the ‘New
State’ field, and select ‘Set Geographic’. 

10. Right-click on the ‘New State’ field, and select ‘Edit Geographic’.
This opens the geographical editing panel.
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11. Click the red question mark. 

This opens the ‘Geographical Mapping’ dialog box. Observe that
in the left panel of the ‘Geographical Mapping’ dialog box, two
states are not mapped: ‘Jersey’ and ‘Conn’.

12. Resolve these unmatched states manually. Follow the steps below:

If the suggestions are
unsatisfactory, select
a different matching
method from the
‘Algorithm’ menu.

a. In the left panel, select the state ‘Conn’. In the right panel,
Visual Composer suggests a set of matches. 

b. Select the correct match (‘Connecticut’), and press ‘Add’.

This creates a new mapping between the value ‘Conn’ and the
location ‘Connecticut’, and removes ‘Conn’ from the left panel.
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a. Click ‘Jersey’ in the left panel. In the right panel, Visual
Composer suggests a set of matches. 

You can start typing
“Jersey” in the search
box to limit the
results.

b. Select the correct match (‘New Jersey’), and press ‘Add’. This
creates a new mapping between the value ‘Jersey’ and the
location ‘New Jersey’, and removes ‘Jersey’ from the left panel.

13. Since all unmatched locations have now been resolved, press ‘OK’
to close the ‘Geographic Feature Names’ dialog box.

14. Press ‘Apply’ in the geographical editing panel for the ‘New State’
field.

15. Drag the ‘New State’ field from the Data Source panel to the
‘Geographic’ region of the Chart Editor Data panel.

16. Drag the ‘Quantity Purchased’ measure from the Data Source
panel to one of the Visual panel regions (‘Color’, ‘Shape’, etc.) to
complete the chart.

¢

Using Latitude and Longitude Data

You can use raw latitude and longitude to designate location, rather than
specifying place names (city, state, etc.). The following example provides
an illustration.

Walkthrough In this example, you will label a map with a list of landmarks along
Historic Route 66. The locations of the landmarks are provided by a
Worksheet data block containing raw latitude and longitude. Follow the
steps below:

This Worksheet can
be found in the ‘Tuto-
rial’ folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘Map Points’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Add a Chart component to the Viewsheet. (If the Chart Editor does
not open, press the ‘Edit’ button on the Chart to open the Chart
Editor.)

3. In the Data panel, press the ‘Select Chart Style’ button. Select the
‘Map’ type, and press the green ‘Apply’ button.
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The ‘Lat’ field con-
tains latitude values.

4. In the Data Source panel, right-click the ‘Lat’ measure, and select
‘Set Geographic’ from the context menu.

5. From the ‘Map’ menu, select ‘U.S.’, and press the green ‘Apply’
button.

The ‘Long’ field con-
tains longitude values.

6. Repeat the above steps to set the ‘Long’ measure as a geographic
field.

7. Drag the ‘Long’ field to the ‘X’ region of the Data panel.

8. Drag the ‘Lat’ field to the ‘Y’ region of the Data panel.
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Data points now appear on the map to mark the locations specified
by the latitude and longitude data, and outline the progression of
Historic Route 66.

9. To add the landmark labels to the points on the map, drag the
‘Name’ field from the Data Source panel to the ‘Text’ field in the
Visual panel.

Note: By default, the
landmark names are
displayed as tooltips.

The labels appear fairly crowded because of the long landmark
names. You can zoom the chart to see the labels more clearly. See
Zooming a Chart for instructions.

Transforming Longitude/Latitude for Alaska and Hawaii

For convenience, the default ‘U.S.’ map does not display Alaska and
Hawaii in their geographical locations, but shifts and (in the case of Alaska)
re-scales them to an inset position below California. For this reason, you
should transform your raw latitude and longitude data for Alaska and
Hawaii prior to generating the chart.

To remap your raw longitude and latitude data, [long lat], to the corrected
values, [long' lat'], apply the following matrix transformations:
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Transformation for Alaska

Transformation for Hawaii

4.5.2 Map Chart Properties

The map chart is a type of chart, and provides most of the same properties
as other chart types. See Chart Properties for more information.

See Also
Properties Dialog Box, for information about common component
properties.
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5 Data View Features

The following sections present features that facilitate display and analysis
of data by Data View components (Charts, Tables, Crosstabs). These
features include highlighting, filtering, hyperlinking, and calculation.

5.1 Highlights
You can apply conditional formatting to table columns, images, text
elements, crosstabs, and charts, so that the element formatting changes
based on the data bound to the element. These conditional formats are
called highlights. They are very useful for calling attention to an element
when its associated data meets (or fails to meet) some specified condition.

5.1.1 Creating a Highlight

To apply a highlight to a table column, image, text element, chart, or
crosstab, follow these steps:

1. Right-click the element you wish to highlight. (For a Table, right-
click a data cell in column to which you want the highlight to be
applied.) 

2. Select ‘Highlight’ from the right-click context menu. This opens
the ‘Highlight’ dialog box.

3. Click the ‘Add’ button. This opens the ‘Name’ dialog box.

4. Enter a name for this highlight, and click ‘OK’ to close the dialog
box. 
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5. Repeat the previous steps to enter any additional highlights, and
then follow the steps below for each individual highlight.

6. Select the highlight in the list that you want to edit.

7. In the ‘Properties’ panel, select the highlight format. The
formatting is applied when the data meets the highlight condition
(specified below):

a. Click the ‘Foreground’ color chip to set the text color.

b. Click the ‘Background’ color chip to set the fill color.

c. Click the ‘Edit’ button next to the ‘Font’ field to open the ‘Font’
dialog box. Make the desired font selections and press ‘OK’.
(Press ‘Reset’ to restore the original settings.)

Cell-based highlights
take precedence over
row-based highlights.

8. For a Table, select ‘Apply to Row’ if you wish to apply the
specified formatting to the entire table row. Otherwise, the
formatting applies only to the selected table column.

9. Click the ‘Edit’ button below the ‘Conditions’ box. This opens the
‘Conditions’ dialog box. 

Note: To use aggregate fields in a highlight condition for a
Freehand Table, first assign a ‘Cell Name’ to the aggregate field
in the Freehand Table Editor. See Freehand Tables for more
information.

10. Follow the steps below to specify the condition expression for this
highlight:

a. Select the operand and type of comparison from the menus at
the top of the dialog box, e.g., “[Company][is not][one of]”
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For table highlights, the operand is one of the table column
names. For text and image highlights, the operand is called
‘value’, which is the aggregate value associated with the
element, as configured in the Data tab of the element’s
‘Properties’ dialog box. 

b. For table highlighting, select ‘Value’, ‘Field’, or ‘Variable’
from the ‘Change Value Type’ popup menu (triangle).

c. If you select the ‘Field’ option, in the adjoining menu, choose
the table column for comparison. (The two columns will be
compared row by row, and the specified highlight will be
applied to every row where the condition holds true.)

d. If you select the ‘Value’ option, either enter the comparison
value into the provided text field, or select ‘Browse Data’ to
choose the comparison value from a list.

e. If you select the ‘Variable’ option, select one of the Form
Components listed in the menu to provide the value at runtime.
(See Dynamic Properties for further details.)

f. If you select the ‘Expression’ option, press the ‘js’/’sql’ button
to select JavaScript or SQL syntax, and then press the ‘Edit’
button. This opens the Script Editor where you can enter your
expression. (See Adding Property Script (Expressions) in
Advanced Dashboard Scripting for details on using
expressions.)

g. When you have fully specified the condition, click ‘Append’.

h. To create a compound condition, repeat Steps a-g above, using
the ‘and’ and ‘or’ operators to composite the conditions. See
Modifying a Filter/Highlight Condition for more details.

i. Click ‘OK’ to exit the ‘Conditions’ dialog box and return to the
‘Highlight’ dialog box.

When you add a highlight to a table column or crosstab, the highlight
condition is tested individually for each cell. When the condition is
satisfied, the corresponding highlight format is applied to the cell or row (if
‘Apply to Row’ is selected).

You can use multiple highlights in combination to produce composite
formats. For example, if you specify a red-foreground highlight for the
condition “Discount is greater than 0,” and you also specify a bold font
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highlight for the condition “State is equal to NJ,” values which meet both
conditions will appear highlighted in red and bold.

See Also
Adding Highlights to a Table, for information on the table ‘Highlight’
dialog box.
Adding Highlights to Text, for information on the text ‘Highlight’ dialog
box.
Adding Highlights to an Image, for information on the image ‘Highlight’
dialog box.
Adding Highlights to a Chart, for information on highlighting charts.
Filtering Operators, in Advanced Data Mashup, for explanation of the
operators.
Advanced Dashboard Scripting, for more sophisticated conditional
formatting.

5.1.2 Modifying a Filter/Highlight Condition

You can make a variety of modifications to conditions in the ‘Conditions’
dialog box. The following sections discuss these options.

See Also
Highlights, for information about highlighting conditions.
Filter Conditions, for information about filtering conditions.

Inserting a Filter/Highlight Condition

To insert a new condition (clause) into an existing condition set, follow
these steps:

1. In the ‘Conditions’ dialog box, select an existing condition. The
new condition will be inserted above the selected condition. (To
reorder the condition after insertion, see Nesting/Ordering a Filter/
Highlight Condition.)

2. Construct the new condition as described in Step 9 of the
Highlights section.

3. Select the desired connector, ‘and’ or ‘or’, by which the new
conditions should be connected with the previous conditions.

4. Press ‘Insert’.

See Also
Highlights, for information about highlighting conditions.
Filter Conditions, for information about filtering conditions.

Modifying a Filter/Highlight Condition or Connector

To modify an existing condition, follow these steps:
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1. In the ‘Conditions’ dialog box, select the existing condition
(clause) you wish to modify.

2. Edit the condition as desired using the menus at the top of the
dialog box.

3. Press ‘Modify’

To modify the connector between conditions (clauses), follow these steps:

1. In the ‘Conditions’ dialog box, select the connector (‘and’ or ‘or’)
you wish to change.

2. Select the desired connecting using the ‘and’ and ‘or’ buttons at the
top of the dialog box.

3. Press ‘Modify’.

To delete a condition (clause), select the condition, and click ‘Delete’. To
delete all conditions (clauses), click ‘Clear’.

See Also
Highlights, for information about highlighting conditions.
Filter Conditions, for information about filtering conditions.

Nesting/Ordering a Filter/Highlight Condition

To specify that a particular operation (clause evaluation) should be
performed before others, follow these steps:

1. Select the connector (‘and’ or ‘or’) that you wish to evaluate first.

2. Click ‘Indent’.

The connector and its accompanying clauses are indented to indicate that
they will be evaluated first. Indenting is equivalent to placing parentheses
around the specified clauses.

Reordering a Filter/Highlight Condition

To change the position of a clause in the condition, select the desired
clause, and click ‘Up’ or ‘Down’. 

If the condition contains both ‘and’ and ‘or’ connectors, in general, the
reordering of clauses will change the meaning of the condition.

See Also
Highlights, for information about highlighting conditions.
Filter Conditions, for information about filtering conditions.
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5.2 Filter Conditions
You can filter the values displayed in a Data View component (Chart,
Table, Crosstab) or Output component (Gauge, Text) to match specified
criteria by setting a Condition on the component. For example, you can
filter a chart or a table so that it displays only data for a particular sales
employee or region. 

Condition-based filtering applies on the component level, and is different
than filtering provided by Filter Components. Filter components filter the
Viewsheet’s underlying query or data block, and therefore affect all data
view elements in the Viewsheet that use the same query or data block. In
contrast, a condition that you place on a particular component affects only
that component.

See Also
Filtering a Table and Filtering a Chart in Visualizing with Dashboards or
Example: Filtering Data (Visualize Free), for an alternative method of
filtering tables and charts.
Filtering, in Advanced Data Mashup, for information on setting data block
conditions.
Filter Components, for dynamic filtering of data view components.

5.2.1 Creating a Filter Condition

To apply a condition to a data view or output component, follow these
steps:

1. Right-click the element, and select ‘Condition’ from the context
menu. This opens the ‘Condition’ dialog box.

2. Select the operand and type of comparison from the menus at the
top of the dialog box, e.g., “[Company][is not][one of]”
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3. From the ‘Change Value Type’ popup menu (triangle), select
‘Value’, ‘Field’, ‘Variable’, or ‘Session Data’.

a. If you select the ‘Field’ option, in the adjoining menu, choose
the column for comparison. (The two columns will be
compared row by row; rows that satisfy the condition will be
preserved.)

b. If you select the ‘Value’ option, either enter the comparison
value into the provided text field, or select ‘Browse Data’ to
choose the comparison value from a list.

c. If you select the ‘Variable’ option, select one of the Form
Components listed in the menu to provide the value at runtime.
(See Dynamic Properties for further details.)

d. If you select the ‘Expression’ option, press the ‘js’/’sql’ button
to select JavaScript or SQL syntax, and then press the ‘Edit’
button. This opens the Script Editor where you can enter your
expression. (See Adding Property Script (Expressions) in
Advanced Dashboard Scripting for details on using
expressions.)

Note that the adjacent
menu automatically
chooses the ‘equal to’
or ‘one of’ operator to
match your selection.

e. If you select the ‘Session Data’ option, choose one of ‘User’,
‘Roles’, or ‘Groups’. These parameters return information about
the user who is currently viewing the Viewsheet; respectively,
the user name, the array of roles to which the user belongs, and
the array of groups to which the user belongs.

4. When you have fully specified the condition, click ‘Append’.

5. To create a compound condition, repeat Steps 2-4 above, using the
‘and’ and ‘or’ operators to compose the condition clauses. See
Modifying a Filter/Highlight Condition for more details.

6. Click ‘OK’ to exit the ‘Condition’ dialog box.

The component will only display data that is compatible with the selections
and satisfies the condition.

See Also
Filtering a Table and Filtering a Chart in Visualizing with Dashboards or
(Visualize Free), for an alternative method of filtering.
Filtering Operators, in Advanced Data Mashup, for explanation of the
operators.
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5.3 Hyperlinks
You can add hyperlinks to Data View component and Output components.
(Data View components include Tables, Crosstabs, and Charts. Output
components include Text and Gauge.)

Do not attach hyper-
links to a component
that already has an
onClick script.

Hyperlinks can target reports, Viewsheets, or web pages. When parameters
are associated with a hyperlink, the parameter values are automatically
passed to the targeted report, Viewsheet, or web page. Parameters can
represent any of the attributes (columns) bound to the table or chart.

Note: You can also add hyperlinks to Viewsheets from within the
Data Modeler. See Auto-Drilldown, in Advanced Data Modeling, for
details on adding model-level and query-level hyperlinks. 

The following example illustrates how to add hyperlinks to a table. Adding
hyperlinks to other components is the same. 

See Also
Adding Hyperlinks to a Table, to access the ‘Hyperlink’ dialog box for
tables.
Adding Hyperlinks to a Chart, to access the ‘Hyperlink’ dialog box for
charts. 
Adding Hyperlinks to Output Components, to access the ‘Hyperlink’ dialog
box for output components.

5.3.1 Creating a Hyperlink to a Report or Viewsheet
Hyperlinks to reports are not supported in Style Scope Agile
Edition.

In this example, you will create a Viewsheet containing the ‘Customer’
table from ‘Order Model’, and add hyperlinks to the ‘Company’ attribute.
The ‘Company’ attribute contains the names of companies, and the
company names will be hyperlinked to the appropriate company-specific
information in the ‘OrderList’ report (in the classes/inetsoft/demos
directory). 

The ‘OrderList’ report is designed to accept five parameters. The
‘customer’ parameter represents the company name of the customer. You
will configure the hyperlinks that you add to the ‘Customer’ > ‘Company’
attribute in the Viewsheet to pass the company name into the ‘OrderList’
report’s ‘customer’ parameter. 

1. Create a new Viewsheet based on the ‘Order Model’ data source.

2. From the Component panel, drag the entire ‘Customer’ entity into
the Viewsheet grid. This creates a table with all the columns from
the ‘Customer’ entity.
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Double-click a col-
umn header to
rename. Drag a col-
umn header to move
the column.

3. Rename and rearrange (if necessary) the columns as shown below:

4. Save the new Viewsheet as ‘HyperlinkExampleView’.

Add hyperlinks to the names in the ‘Company’ column. These hyperlinks
will pass the company name as parameter to the ‘OrderList’ report. Follow
the steps below:

5. Right-click any cell in the ‘Company’ column, and select the
‘Hyperlink’ option.

6. This opens the ‘Hyperlink’ dialog box for the ‘Company’ column.

7. In the ‘Hyperlink’ dialog box, click the ‘Asset Link’ radio button. 

8. Select ‘OrderList’ from the ‘Link’ menu.

9. Optional: Enter a tooltip in the ‘Tool Tip’ field. (In the example we
use “View company information” as the tooltip.) 

The tooltip is displayed when the end-user hovers the mouse over a
hyperlink. If there are multiple hyperlinks for a given attribute
(which may be due to auto-drills added at the model level or query
level), the tooltip is displayed when the end-user hovers the mouse
over the name of the hyperlink in the menu of hyperlink options.

10. Deselect the ‘Self’ option, and enter the name “ReportFrame” in
the ‘Target Frame’ field.

Note: The 'Self' setting is not applied during preview in Visual
Composer, and is not available for hyperlinked Viewsheets. (All
hyperlinked Viewsheets open in a separate browser tab.)
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This will cause the hyperlinked report to open in a window called
“ReportFrame” (i.e., this is the browser DOM ‘name’ attribute). If
you want the report to open in the original Viewsheet frame,
replacing the Viewsheet, leave the ‘Self’ checkbox selected. 

To delete an existing
parameter, select the
parameter and press
‘Remove’. To edit an
existing parameter,
press ‘Edit’.

11. Press the ‘Add’ button in the bottom panel. This opens the
‘Parameter’ dialog box.

12. Select the ‘customer’ parameter in the ‘Name’ menu. This is the
name of the target parameter in the OrderList report.

13. Select the ‘Company’ field from the ‘Value’ menu. This is the
name of the table column whose value should be passed into the
report parameter when the user clicks the hyperlink.

14. Press ‘OK’.

15. (Optional) Enable ‘Send viewsheet parameters’ to pass all existing
viewsheet parameters to the drill-down report, Viewsheet, or URL.
The viewsheet parameter names must exactly match those defined
in the target report, Viewsheet, or URL. See Defining and Editing
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Report Parameters in Advanced Report Design, and parameter in
Advanced Dashboard Scripting, for more information. 

16. (Optional) Select ‘Disable parameter prompt’ to suppress the
parameter dialog box ordinarily produced by the drill-down report
upon launch. (Prompting is automatically suppressed for
parameters passed in the hyperlink itself.)

17. (Optional) Select ‘Send selections as parameters’ to send the values
of any Viewsheet Filter components (Selection Lists, Range
Sliders, etc.) to the target report. These values are passed into
parameters in the target report that have the same name as the Filter
component. 

For example, a Selection List named “SelectionList1” passes
selected values into an array called ‘SelectionList1’. A Selection
Tree named “SelectionTree1” passes the selected values into an
array called ‘SelectionTree1’. Selections at inner levels of the tree
hierarchy are prepended with their parent labels and a caret (^)
symbol, e.g., “Northeast^Massachusetts^Boston”. A Calendar
named “Calendar1” passes a list of starting dates and ending dates
into arrays ‘Calendar1_dateStart’ and ‘Calendar1_dateEnd’,
respectively. A Range Slider named “RangeSlider1” passes the
selected start date and end date into variables called
‘RangeSlider1_start’ and ‘RangeSlider1_end’, respectively.

18. Press ‘OK’ to complete the hyperlink configuration.
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To display hyperlink
underlining by
default, set hyper-
link.indicator=true in
sree.properties. 

19. Add any desired visual formatting to the hyperlinks (e.g.,
underlining).

20. Save the Viewsheet.

When the user views this Viewsheet in the User Portal, they will now see
hyperlinks on all the names in the ‘Company’ column. (The ‘State’ column
also shows hyperlinks because this attribute was pre-configured with an
auto-drill.) Clicking one of the ‘Company’ hyperlinks launches the
‘OrderList’ report in a new browser window, and the ‘OrderList’ report
now displays only the orders for the specific company clicked.

See Also
pviewsheet, in Advanced Dashboard Scripting, for information on how to
access properties of a parent Viewsheet from within a hyperlinked report or
Viewsheet.
parameter, in Advanced Dashboard Scripting, for information on reading
and writing Viewsheet parameters.
Parameterization, in Advanced Report Design, for information on
configuring report parameters.

5.3.2 Creating a Hyperlink to a Web Page
Walkthrough In this example, you will create hyperlinks that target a web page rather

than a report or Viewsheet.

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘Sales Explore’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. From the Component panel, drag the entire ‘Sales’ data block into
the Viewsheet grid. This creates a table with all the columns from
the ‘Sales’ data block.

3. Save the new Viewsheet as ‘HyperlinkExampleView’.
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Add hyperlinks to the names in the ‘Company’ column. These hyperlinks
will pass the company name to the Google search engine. Follow the steps
below:

4. Right-click any cell in the ‘Company’ column, and select the
‘Hyperlink’ option.

5. This opens the ‘Hyperlink’ dialog box for the ‘Company’ column.

6. In the ‘Hyperlink’ dialog box, press the ‘Web Link’ radio button. 

You can also specify a
table column to pro-
vide the URL links by
selecting the desired
“hyperlink:column”
from the ‘Link’ menu.

7. In the ‘Link’ field, enter the URL of the hyperlink destination with
parameters omitted. For example, if the hyperlink is to pass a value
as parameter to the Google search engine, the ‘Link’ field should
specify “http://www.google.com/search”. 

8. Optional: Enter a tooltip in the ‘Tool Tip’ field. (In the example we
use “View company information” as the tooltip.) 

Note: The 'Self' setting is not applied during preview in Visual
Composer. 

9. Optional: If you want the target web page to be displayed in a
particular browser window, enter the name of the desired window
in the ‘Target Frame’ field. (The specified name becomes the
DOM ‘name’ attribute.) To open the target web page in the User
Portal frame, select the ‘Self’ checkbox. 

10. Press the ‘Add’ button. This opens the ‘Parameter’ dialog box.

11. Enter ‘q’ in the ‘Parameter Name’ field. This name will be the
parameter name used in the URL that is automatically constructed.
(The parameter name “q” is the parameter name expected by the
Google search engine.)

12. Select ‘Company’ from the ‘Value for Parameter’ menu. 
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13. Press ‘OK’ to close the ‘Parameter’ dialog box.

14. Press ‘OK’ to complete the hyperlink configuration. The final
configuration of the ‘Hyperlink’ dialog box is shown below. 

To display hyperlink
underlining by
default, set hyper-
link.indicator=true in
sree.properties. 

15. Add any desired visual formatting to the hyperlinks (e.g.,
underlining).

16. Save the Viewsheet.

The hyperlinks constructed by this configuration will be of the form 

http://www.google.com/search?q={CompanyName} 

where {CompanyName} is the value of the ‘Name’ attribute clicked by the
user. 

5.3.3 Passing Multiple Parameters in a Hyperlink

The previous examples described how to pass a single parameter to a
specified report or web page. It is also possible to pass multiple parameters
in a hyperlink.
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The procedure for creating multiple-parameter hyperlinks is the same as
described in the previous section. If there are multiple attributes listed in the
‘Value’ panel of the ‘Hyperlink’ dialog box, these can all be selected and
mapped to different parameter names. 

If the hyperlinks are targeting a report, the multiple parameter names
specified in the ‘Hyperlink’ window must be identical to the corresponding
parameter names specified in the report. If the hyperlinks are targeting a
web page, the multiple parameter names specified in the ‘Hyperlink’
window will be the parameter names used in the hyperlink URL, with
parameter-value pairs separated by the ampersand (&) symbol, for
example, 

http://
remotehost?param1={value1}&param2={value2}&param3={value3}

where param1, param2, param3 are the parameter names specified in the
‘Hyperlink’ window, and {value1}, {value2}, {value3} are the values of
the attributes selected in the ‘Value’ panel. 

5.4 Calculated Fields
You can perform calculations on existing data fields within a Viewsheet to
create new “calculated” data fields. You can then use these calculated
fields in the bindings of Charts, Crosstabs, and other elements. 

This is especially useful for Viewsheets that are not based on Worksheet
data sources (such as Viewsheets based on queries or data models) and do
not have access to the Worksheet’s computational tools. In such cases, the
Viewsheet’s calculated field feature provides an equivalent to the
Worksheet’s expression column feature. The Viewsheet’s calculated field
feature also aids in calculations that require access to post-aggregate
quantities, such as rates and ratios, which can be challenging to configure
within a Worksheet.

Note: For Worksheet-based Viewsheets, you can make detail-level
calculations within the Worksheet itself. (See Creating an
Expression/Formula Column in Advanced Data Mashup.) To perform
aggregate-level calculations, use the Viewsheet methods described
below.

There are two different kinds of calculated field:

• Calculated field based on detail data: A calculated field based on
detail data can be used as either a dimension or measure (see Converting
between Measure and Dimension) in the same manner as any other data
field. See Creating a Calculated Field from Detail Data for more
information.
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• Calculated field based on aggregate data: A calculated field based on
aggregate data can be used only as a measure. This type of calculated
field cannot be bound to Filter Components (Range Slider, etc.). See
Creating a Calculated Field from Aggregate Data for more
information.

The following sections explain how to create these two types of fields. 

5.4.1 Creating a Calculated Field from Detail Data

To create a new calculated field from detail data, follow the steps below:

1. In the Viewsheet Component panel, right-click on the data block,
data model, or query to which you want to add the calculated field.
Select ‘New Calculated Field’ from the context menu.

This opens the ‘Calculated Field’ dialog box.

Note: The selection of 'Detail' or 'Aggregate' is a one-time
choice. You cannot convert between these two types at a later time. 

2. In the ‘Name’ field, enter a name for the new calculated field. 

3. Select the ‘Detail’ option, and click ‘OK’. This opens the Formula
Editor.

4. In the ‘Return Data Type’ menu, select the data type that the
calculated field will return.

5. Enable the ‘SQL’ option to construct the formula using SQL
syntax. Disable the ‘SQL’ option to construct the formula using
JavaScript syntax.
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In general, SQL expressions perform better than JavaScript
expressions because SQL expressions can be optimized for
processing on the database whereas JavaScript expressions must be
post-processed by the server. However, JavaScript provides greater
programmatic flexibility and allows construction of expressions
that are difficult or impossible to implement within the constraints
of SQL.

Click on an available
detail field in the
panel to add it to the
expression.

6. Enter the desired calculation into the formula field at the bottom of
the dialog box. The available detail fields are listed in the top-left
panel.

7. Click ‘OK’ to close the Formula Editor. This adds the new
calculated field to the data source tree in the Component panel.

You can now bind this calculated field to a Viewsheet component (Output
Components, Data View Components, etc.) in the same way that would
bind any other data field.

Example: Detail-
Level Calculation

Consider a Viewsheet that is based on the sample ‘Sales Explore’
Worksheet. In this example, you will analyze how total after discount
varies according to product category. Note that “total after discount” is not
available as a field of the data block. You will create this data in the
Viewsheet as a calculated field. 
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Follow the steps below:

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘Sales Explore’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Right-click the ‘Sales’ node in the Component panel, and select
‘New Calculated Field’ from the context menu.

This opens the ‘Calculated Field’ dialog box.

3. In the ‘Name’ field of the ‘Calculated Field’ dialog box, enter the
text “Total After Discount”.

4. Select the ‘Detail’ option and press ‘OK’. 

This opens the Formula Editor.

5. In the Formula Editor, enter the formula field['Total']*(1-
field['Discount']). To enter the field names (‘Total’ and
‘Discount’) into the formula, click on the field names in the top-left
‘Fields’ list.
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6. In the ‘Return Data Type’ menu, select ‘Double’.

7. Press ‘OK’ to close the Editor. This adds the new ‘Total After
Discount’ calculated field to the ‘Sales’ data block.

8. From the Component panel, drag a Chart component into the
Viewsheet. (If the Chart Editor does not open, press the ‘Edit’
button on the Chart to open the Chart Editor.)

9. Drag the ‘Category’ field from the Data Source panel to the ‘X’
region in the Data panel.

The 'Total After Discount' calculated field appears by default
under the 'Measures' folder because it has a numerical data type.

10. Drag the ‘Total After Discount’ field from the Data Source panel
to the ‘Y’ region in the Data panel.

The Chart now displays the total after discount for each category.
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¢

5.4.2 Creating a Calculated Field from Aggregate Data

To create a new calculated field from aggregate data, follow the steps
below:

1. In the Viewsheet Component panel, right-click on the data block,
data model, or query to which you want to add a calculated field.
Select ‘New Calculated Field’ from the context menu.

This opens the ‘Calculated Field’ dialog box.

Note: The selection of 'Detail' or 'Aggregate' is a one-time
choice. You cannot convert between these two types at a later time. 

2. In the ‘Name’ field, enter a name for the new calculation field. 

3. Select the ‘Aggregate’ option and click ‘OK’. This opens the
Formula Editor.

The ‘SQL’ option is
disabled because
aggregate-based cal-
culations require Java-
Script syntax.

4. In the ‘Return Data Type’ menu, select the data type that the
calculated field will return.

5. In the top-left panel, click the ‘New Aggregate’ button.
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This opens the ‘Aggregate’ dialog box.

6. In the ‘Field’ menu of the ‘Aggregate’ dialog box, select the field
that you wish to aggregate for purposes of the calculation.

7. In the ‘Aggregate’ menu, select the desired aggregation method.
(See Aggregation Options for information about the available
methods.)

8. For a bivariate aggregation method, select the second field from the
‘With’ menu.

9. Click ‘OK’ to close the ‘Aggregate’ dialog box. The Formula
Editor now displays the newly defined aggregate quantity in the
top-left panel.
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10. (Optional) Click the ‘New Aggregate’ button again, and repeat the
above steps to add as many additional aggregates as desired.

Click an aggregate
field in the top-left
panel to add it to the
expression.

11. Once you have defined the required aggregates in the top-left
panel, enter the desired calculation (using the aggregate fields) in
the formula field at the bottom of the dialog box.

12. Click ‘OK’ to close the Formula Editor. This adds the new
calculated field to the data source tree in the Component panel.
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You cannot bind an aggregate-based calculated field to Filter
Components.

You can bind this calculated field to Output Components or Data View
Components in the same way that would bind any other data field. 

Example: 
Aggregate-Level 
Calculation

Consider a Viewsheet that is based on the sample ‘Sales Explore’
Worksheet. In this example, you will analyze how the percentage of paid
orders varies according to different dimensions (company, state, date, etc.). 

Observe that “percentage of paid orders” for a given group is an aggregate
quantity. It represents the ratio of paid orders to total orders for the group,
and therefore requires a count (aggregate) of both the paid orders and total
orders for every individual group. These counts are not static, but will vary
dynamically based on the requested dimension (state, company, date, etc.).

In many cases it is difficult to configure an underlying Worksheet to
produce these aggregate results in a manner conducive to dynamic
Viewsheet analysis. Though a Worksheet provides all of the required
aggregation features, multi-dimensional aggregations within a Worksheet
often require the creation of multiple data blocks, and this ultimately limits
the interactivity of the Viewsheet. Therefore, it is best to implement
aggregate-based calculations at the Viewsheet level.

Follow the steps below to create a Viewsheet that implements aggregate
calculations to express the percentage of paid orders for various groupings.

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘Sales Explore’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. In the Viewsheet Component panel, right-click the ‘Sales’ data
block and select ‘New Calculated Field’ from the context menu.
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This opens the ‘Calculated Field’ dialog box.

3. In the ‘Name’ field of the ‘Calculated Field’ dialog box, enter the
text “Percent Paid”.

4. Select the ‘Aggregate’ option and click ‘OK’. This opens the
Formula Editor.

5. In the Formula Editor, follow the steps below:

If a chart or crosstab
exists in the Views-
heet, you will see the
existing chart and
crosstab aggregates
listed.

a. In the top-left panel, expand the ‘Fields’ node, and click ‘New
Aggregate’.

This opens the ‘Aggregate’ dialog box.

The ‘Paid’ field con-
tains a “1” (order
paid) or a “0” (order
not paid). This sum
therefore provides the
absolute number of
paid orders.

b. In the ‘Field’ menu of the ‘Aggregate’ dialog box, select the
‘Paid’ field. This is the field whose values you will sum to
obtain the number of paid orders.
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c. In the ‘Aggregate’ menu, select ‘Sum’. 

d. Press ‘OK’ to close the ‘Aggregate’ dialog box. The Formula
Editor displays the newly defined “Sum(Paid)” aggregate field
under the ‘Fields’ node in the top-left panel.

e. Click ‘New Aggregate’ again.

f. In the ‘Field’ menu of the ‘Aggregate’ dialog box, again select
the ‘Paid’ field.

The ‘Count’ provides
the total number of
paid and unpaid
orders.

g. In the ‘Aggregate’ menu, select ‘Count’ and press ‘OK’. 

The Formula Editor displays the newly defined ‘Count(Paid)’
aggregate field in the top-left panel together with the existing
‘Sum(Paid)’ field.

h. In the top-left panel, click on the ‘Sum(Paid)’ field to enter the
field into the expression.

i. Type a division (“/”) symbol, or select this symbol from the top-
right ‘Operators’ panel (under the ‘Arithmetic’ group).

j. In the top-left panel, click on the ‘Count(Paid)’ field to enter the
field into the expression.
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k. In the ‘Return Data Type’ menu, select ‘Float’.

l. Press ‘OK’ to close the Editor. This adds the new ‘Percent Paid’
calculated field to the ‘Sales’ data block.

6. From the Component panel, drag a Chart component into the
Viewsheet. (If the Chart Editor does not open, press the ‘Edit’
button on the new Chart to open the Chart Editor.)

7. In the Data Source panel, expand the ‘Dimensions’ folder under
the ‘Sales’ data block. 

8. Drag the ‘Category’ field from the Data Source panel to the ‘X’
region in the Data panel.

Note: An aggregate-based calculated field is always considered a
measure.

9. In the Data Source panel, expand the ‘Measures’ folder. 
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10. Drag the ‘Percent Paid’ field from the Data Source panel to the
‘Y’ region in the Data panel. The Chart Y-axis now displays the
fraction of orders paid on a category-by-category basis. 

11. To change the Y-axis labels to a “percent” representation, right-
click the axis labels, and select ‘Format’ from the context menu.
This opens the ‘Format’ dialog box.

12. In the ‘Format’ dialog box, click the Format tab, and select the
‘Percent’ option. Click ‘OK’ to close the dialog box. This displays
the labels in percent format.

You can use the Chart Editor to bind other dimensions to the X-axis. For
example, drag ‘Name’ from the Data Source panel to the ‘X’ region of the
Data panel to analyze the percent paid according to product name. Drag
both the ‘State’ and ‘City’ fields to the ‘X’ region to analyze percent paid
on a geographical basis. 

If you provide the end user with access to the Chart Editor (see Enabling
End-User Chart and Crosstab Editing), they can use exactly the same
method to analyze the data. However, to make the analysis even easier for
the user, you can add a menu that allows the user to directly select the
desired dimension for the X-axis. To do this, continue with the steps below:

13. Close the Chart Editor. (Click the red ‘X’ in the top-right corner.)
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14. From the Viewsheet Component panel, drag a ComboBox
component into the Viewsheet.

15. Right-click on the new ComboBox, and select ‘Properties’ from
the context menu. This opens the ‘ComboBox Properties’ dialog
box.

16. In the ‘Name’ field, enter ‘Dimension’.

17. In the ‘List Values’ region, select the ‘Embedded’ option, and click
the ‘Edit’ button. This opens the ‘Embedded List Values’ dialog
box.

18. Enter the following labels/values: ‘Category’, ‘Date’, ‘Company’,
‘Name’, ‘City’, and ‘State’. 
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19. Press ‘OK’ to close the ‘Embedded List Values’ dialog box. Press
‘OK’ to close the ‘ComboBox Properties’ dialog box.

20. Press the ‘Edit’ button on the Chart to reopen the Chart Editor.

21. In the Data panel, press the arrow button next to the ‘X’ region,
and select ‘Variable’ from the menu. This enables the variable
menu in the ‘X’ region.

22. From the variable menu, select the ‘$(Dimension)’ option. This
will use the ComboBox to set the dimension displayed on the X-
axis.

Explore the data by making different selections in the ComboBox.
Investigate how percent paid varies according to dimensions such as state,
city, category, date, etc. When you analyze the data along the ‘Date’
dimension, try drilling down to explore finer levels of resolution (e.g.,
month). See Drilling Down into a Chart for more details.

¢

Example: 
Calculation with 
String Return 
Value

You can create an aggregate calculation to return a string-valued measure.
You can then bind this measure to a ‘Visual’ region (color, shape, size) to
produce a categorical visual grouping.
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Follow the steps below to create a Viewsheet that uses a string-valued
measure to categorize groups as having a low average discount rate (less
than 1.5%) or high discount rate (greater than 1.5%).

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘Sales Explore’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. In the Viewsheet Component panel, right-click the ‘Sales’ data
block and select ‘New Calculated Field’ from the context menu.

This opens the ‘Calculated Field’ dialog box.

3. In the ‘Name’ field of the ‘Calculated Field’ dialog box, enter the
text “Discount Class”.

4. Select the ‘Aggregate’ option and click ‘OK’. This opens the
Formula Editor.

5. In the Formula Editor, follow the steps below:

a. In the top-left panel, expand the ‘Fields’ folder and click the
‘New Aggregate’ button.



DATA MASHUP

625 of 1397

This opens the ‘Aggregate’ dialog box.

The ‘Paid’ field con-
tains a “1” (order
paid) or a “0” (order
not paid). This sum
therefore provides the
absolute number of
paid orders.

b. In the ‘Field’ menu of the ‘Aggregate’ dialog box, select the
‘Discount’ field. This is the field whose values you will average
to obtain the average discount.

c. In the ‘Aggregate’ menu, select ‘Average’. 

d. Click ‘OK’ to close the ‘Aggregate’ dialog box. The Formula
Editor displays the newly defined “Average(Discount)”
aggregate field in the top-left panel.
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Hint: Click the ‘Aver-
age(Discount)’ field
in the top-left panel to
enter the field into the
expression.

e. Enter the following script in the Script Editor:

if (field['Average([Discount])']<.015) {
'Low';

}
else {
'High';

} 

f. In the ‘Return Data Type’ menu, select ‘String’.

g. Click ‘OK’ to close the Editor. This adds the new ‘Discount
Class’ calculated field to the ‘Sales’ data block.

6. From the Component panel, drag a Chart component into the
Viewsheet.

7. Click the ‘Edit’ button on the new Chart to open the Chart Editor.

8. In the Data Source panel, expand the ‘Dimensions’ folder under
the ‘Sales’ data block. 
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9. Drag the ‘Category’ field from the Data Source panel to the ‘X’
region in the Data panel.

Note: An aggregate-based calculated field is always considered a
measure.

10. In the Data Source panel, expand the ‘Measures’ folder. 

11. Drag the ‘Quantity Purchased’ field from the Data Source panel to
the ‘Y’ region in the Data panel. 

12. Drag the ‘Discount Class’ field from the Data Source panel to the
‘Color’ region in the Visual panel. This discriminates groups based
on the string values returned by the ‘Discount Class’ calculated
field. 

¢

5.4.3 Editing a Calculated Field

To edit an existing calculated field, follow the steps below:

1. In the Viewsheet Component panel, right-click the calculated field
in the data source tree, and select ‘Edit’ from the context menu.

You cannot convert a
detail-based calcu-
lated field into a
aggregate-based cal-
culated field, or vice
versa.

This opens the Formula Editor to display the existing formula.

2. Edit the formula as desired, and click ‘OK’.
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To remove an existing calculated field, right-click on the calculated field in
the data source tree in the Component panel, and select ‘Remove’ from the
context menu.
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6 Filter Components

Filter components provide both input and output capability, and are
therefore crucial for analysis. 

Filter controls are
optimized for perfor-
mance. They do not
modify the original
dataset, and do not
cause re-execution of
queries. 

• Filter components control and filter data for data view and output
components. By adding multiple selection elements, you exponentially
increase possible views. 

• Filters interact with one another to provide you with instant feedback on
which choices are consistent and which are incompatible.

This dual nature of selections makes them an indispensable analytic
component for most Viewsheets.

See Also
Filtering a Table and Filtering a Chart in Visualizing with Dashboards, for
an approach to filtering data without separate Filter components.
Filter Conditions, to set fixed conditions on data view and output
components.
Output Components, for information about graphical data representation.
Form Components, for information on manipulating variables.
Data View Components, for information about tables and graphs.

6.1 Selection List
A Selection List displays every unique value from a data field. By selecting
one or more of these values, the end-user can filter the data displayed by
the Viewsheet, both within output elements and other selection elements.

See Also
Visualizing with Dashboards or Using a Visualization (Visualize Free), for
information on using dashboards.
Using Selection Lists and Trees, for details on Filter element symbols.
Selection Tree, for information on providing nested selection options.

6.1.1 Creating a Selection List

There are four ways to create a Selection List, discussed in the following
sections.

Creating Selection List from Data Block

To create a Selection List, follow these steps: 

1. Expand a data block (table) or cube dimension in the Component
tree. 

Note: When binding hierarchical cube dimensions, Selection Lists
will include all hierarchical components. To avoid this, ask an
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administrator to set the property olap.table.originalContent=false
in sree.properties.

2. Select one column from the data block, or one level from the cube
dimension, and drag it onto the Viewsheet grid.

This creates a Selection List based on the data in the selected column or
dimension.

Creating Selection List from Selection List Component

To create a Selection List follow these steps:

1. Drag a Selection List element from the Component tree onto the
Viewsheet grid. This creates an empty Selection List element. 

You can also drag and
drop a single column
directly onto the
empty Selection List
element.

2. Right-click on the Selection List, and select ‘Properties’ from the
context menu. This opens the ‘Selection List Properties’ dialog
box.

3. Select the Data tab.

4. In the ‘Table’ list, expand a data block or cube, and select the
column or dimension that should be used to populate the Selection
List. 
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5. Press ‘OK’.

This creates a Selection List based on the data in the selected column or
dimension. Each unique item in the column or dimension is represented as
a distinct selection box in the Selection List. 

Creating Selection List from a Table Column

To create a Selection List from a table column, click anywhere in the table
column, and drag the column to an empty region of the grid. 

This creates a new Selection List based on the values in the column.

Creating Selection List from Chart Data Source

To create a Selection List from a chart Data Source tree, follow these steps: 

1. Expand a ‘Dimension’ node in the Data Source tree. (This can
belong to either a data block or cube.) 

2. Select one column from the ‘Dimension’ node, and drag it onto the
Viewsheet grid.
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This creates a Selection List based on the data in the selected field.

See Also
Creating a Selection Tree from Chart Data Source, for information on the
Selection Tree.
Creating a Chart, for information on using the Chart Editor. 

6.1.2 Selection List Properties

The Selection List component’s ‘Properties’ dialog box provides General
and Data tabs. The next sections discuss the component-specific properties
available under these tabs.

See Also
Properties Dialog Box, for information about common component
properties.
Format Dialog Box, for information on the ‘Format’ dialog box.

Selection List Properties: General Tab 

The General tab in the ‘Selection List Properties’ dialog box provides the
following Selection List-specific properties.

Show as The appearance of the Selection List:
List: A scrollable list
Dropdown: An expandible dropdown box. The ‘List Height’ sub-
option sets the number of rows to which the box should expand.

Sort The sort order for the values in the Selection List:
Ascending: Display all values in alphabetical or increasing order, 
including incompatible selections.
Descending: Display all values in reverse-alphabetical or decreasing 
order, including incompatible selections.
Hide Others: Display values in alphabetical or increasing order, but 
hide incompatible selections under the label ‘Others’.
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See Also
General Tab, for information about common properties in the General tab.

Selection List Properties: Data Tab

The Data tab in the ‘Selection List Properties’ dialog box provides the
following Selection List-specific properties.

Action Submit on Change: Immediately update data in the Viewsheet when 
any selection is made. If ‘Submit on Change’ is disabled, the 
Selection List only updates data in the Viewsheet when the user 
clicks ‘Apply’.
Single Selection: Allows only one item to be selected at a given time. 
(For a Selection Tree, this allows only one item on the lowest level to 
be selected.) 
Suppress Empty Value: Removes empty values (caused by nulls in 
the data set) from the Selection List.

Table The column or dimension that should be used to populate the 
Selection List

Measure The field to aggregate and display next to the Selection List values.
Aggregate The method of aggregation to be used for the ‘Measure’ field.
Text Specifies that the aggregated measure is displayed as plain text.
Bar Specifies that the aggregate measure is displayed graphically as a 

proportional bar.
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6.1.3 Changing the Column Layout in a Selection List

Columns within a Selection List always have equal width. This width is
determined by the overall width of the Selection List component (see
Resizing a Component) and by the number of columns specified.

To specify the number of columns in the Selection List component, follow
the steps below:

1. Click a cell in any column to select the cell. (The right side of the
selected cell displays a handle).

2. Drag the cell handle to the left or right to increase or decrease the
number of columns. 

See Also
Resizing the Dashboard Grid, for information on changing the global grid
spacing.

6.1.4 Displaying Aggregate Data in Selection List

To display summarized data next to the dimension values in a Selection
List or Selection Tree, follow the steps below:
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1. Create the Selection List (or Selection Tree) as desired.

2. Right-click the Selection List, and select ‘Properties’ from the
context menu. This opens the ‘Selection List Properties’ dialog
box.

3. From the ‘Measure’ menu, select the field that you wish to
summarize. 

4. From the ‘Aggregate’ menu, select the method of summarization.
(See Crosstab Aggregation Methods for more information about
the methods.)

5. (Optional) Enable the ‘Text’ option to display the aggregate values
as plain text next to the corresponding dimension values.

6. (Optional) Enable the ‘Bar’ option to graphically display the
aggregate values as proportional bars next to the corresponding
dimension values.

7. Click ‘OK’ to close the dialog box. The summarized values are
now displayed next to the Selection List dimension values.

You can also adjust
the Viewsheet grid
width to facilitate dis-
play. See Resizing the
Dashboard Grid.

8. (Optional) Improve the appearance of the Selection List by making
the following adjustments to the layout:

a. Adjust the column layout to provide the needed space by
dragging the handle at the right side of column. See Changing
the Column Layout in a Selection List.
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b. Adjust the width of the aggregate text region by dragging the
handle at the left side of the text.

c. Adjust the width of the aggregate bar region by dragging the
handle at the left side of the bar.

You can also use the
format controls on the
Viewsheet toolbar to
adjust the text and bar
formatting.

9. (Optional) To format the aggregate text, right-click on the
aggregate text and select ‘Format’ from the context menu. This
opens the ‘Format’ dialog box. (See Format Dialog Box for more
information about the available options.)

10. (Optional) To format the aggregate bar, right-click on the aggregate
bar and select ‘Format’ from the context menu. This opens the
‘Format’ dialog box. (See Format Dialog Box for more
information about the available options.)

6.2 Selection Tree
A Selection Tree is a hierarchical Selection List, and displays selection
choices in tree form. This allows the user to select values at multiple levels
in the hierarchy. The selections that the user makes in a Selection Tree filter
data displayed by Output Components, Data View Components, and other
Filter Components. The Selection Tree is especially useful for data that is
intrinsically hierarchical, such as cities and states, but it can also be used for
independent data.

You can define a Selection Tree by specifying an arbitrary hierarchy
among individual columns or by referencing predefined parent-child
relationships (recursive hierarchy). See the following sections for details on
these two approaches:
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• Creating a Selection Tree from Individual Columns

• Creating a Selection Tree from Recursive Hierarchy

6.2.1 Creating a Selection Tree from Individual Columns

There are several ways to create a Selection Tree from individual columns.
In most cases these columns should possess an implied inclusion
relationship (e.g., cities and states) but they can also be independent.

The following sections discuss various methods for creating a Selection
Tree from individual columns.

Creating a Selection Tree from Data Block Columns

To create a Selection Tree from data block columns, follow these steps: 

1. Expand a data block (table) in the Component tree. 

2. Ctrl-click or Shift-click to select multiple columns in the data block. 

3. Drag the selected columns onto the Viewsheet grid.

This creates a Selection Tree based on the data in the selected columns,
with the nesting order determined by the order in which you selected the
fields in the Component tree.

See Also
Adding Hierarchy Levels to a Selection Tree, to add levels to an existing
Tree.
Selection Trees, for a walkthrough on using Selection Trees.
Using Selection Lists and Trees, for details on Filter element symbols.
Selection List, for information on creating non-hierarchical selection
options.

Creating a Selection Tree from Cube Dimensions

To create a Selection Tree from cube dimension levels, follow these steps: 

1. Expand a cube dimension in the Component tree. 

2. Ctrl-click or Shift-click to select multiple levels in the cube
dimension. 
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To include all levels
of a dimension, sim-
ply drag the dimen-
sion node onto the
Viewsheet.

3. Drag the selected levels onto the Viewsheet grid.

This creates a Selection Tree based on the data in the selected levels, with
the nesting order determined by the order in which you selected the levels
in the Component tree.

See Also
Adding Hierarchy Levels to a Selection Tree, to add levels to an existing
Tree.
Selection Trees, for more information about using Selection Trees.
Using Selection Lists and Trees, for details on Selection element symbols.
Selection List, for information on creating non-hierarchical selection
options.

Creating a Selection Tree from Selection Tree Component

To create a Selection Tree from individual columns, follow the steps
below:

1. Drag a Selection Tree component from the Component tree onto
the Viewsheet grid. This creates an empty Selection Tree element. 

You can also drag-
and-drop columns
directly onto a Selec-
tion Tree element.
Each new column you
add is placed at the
innermost level of the
hierarchy.

2. Right-click the Selection Tree, and select ‘Properties’ from the
context menu. This opens the ‘Selection Tree Properties’ dialog
box.

3. Select the Data tab.

4. At the top of the dialog box, select the ‘Columns’ option.
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5. In the ‘Table’ menu, expand the desired data block to reveal its
columns, or expand a cube dimension to reveal its levels.

6. Select the column or level that you want to be the outer-most level
of the Selection Tree hierarchy. 
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To add all columns or
levels from a data
block or cube dimen-
sion, select the desired
data block or dimen-
sion, and click ‘Add’.

7. Click ‘Add’. This adds the column or level to the ‘Level’ list. 

8. Repeat to add all desired levels of the hierarchy. To change the
hierarchy ordering, use the ‘Move Down’ and ‘Move Up’ buttons.
The order from top to bottom represents the nesting order of the
Selection Tree, from outer to inner.

9. Click ‘OK’ to close the dialog box.

The Selection Tree is now populated based on the selected columns or
dimension levels. The inner levels of the hierarchy show only the unique
items compatible with corresponding outer level data. For example, the
companies nested within the outer-level ‘CA’ node are only those
companies whose corresponding state is CA.

See Also
Creating a Selection Tree from Recursive Hierarchy, to create a Selection
Tree using parent and child IDs.
Adding Hierarchy Levels to a Selection Tree, to add levels to an existing
Tree.
Visualizing with Dashboards or Using a Visualization (Visualize Free), for
information on using dashboards.
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Using Selection Lists and Trees, for details on Selection element symbols.
Selection List, for information on creating non-hierarchical selection
options.

Creating a Selection Tree from Chart Data Source

To create a Selection Tree from a chart Data Source tree, follow these
steps: 

1. Expand a ‘Dimension’ node in the Data Source tree. (This can
belong to either a data block or cube.) 

To include all levels
of a cube dimension,
simply drag the
dimension node onto
the Viewsheet.

2. Select two or more columns from the ‘Dimension’ node, and drag
them together onto the Viewsheet grid.

This creates a Selection Tree based on the data in the selected fields.

See Also
Walkthrough: Interactive Chart Drilldown, in Advanced Dashboard
Scripting, to adapt the X-axis binding based on user selection.
Creating Selection List from Chart Data Source, for information on the
Selection List.
Creating a Chart, for information on using the Chart Editor. 

6.2.2 Creating a Selection Tree from Recursive Hierarchy

You can create a Selection Tree from recursive hierarchy information. For
example, consider the following data. The “Child ID” is the ID of the node
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itself, while the “Parent ID” is the ID of the node’s immediate parent.
Nodes that lack a “Parent ID” comprise the top level of the tree.

The columns above represents the following tree structure. 

The “Parent ID” and “Child ID” columns indicate that nodes 5 and 6 share
node 1 as parent, nodes 7 and 8 share node 2 as parent, nodes 9, 10, and 11
share node 3 as parent, and nodes 12 and 13 share node 4 as parent.

To create a Selection Tree from a recursive hierarchy defined by “Parent
ID” and “Child ID” columns, follow the steps below:

1. Drag a Selection Tree component from the Component tree onto
the Viewsheet grid. This creates an empty Selection Tree element. 

2. Right-click the Selection Tree, and select ‘Properties’ from the
context menu. This opens the ‘Selection Tree Properties’ dialog
box.

3. Select the Data tab.

PARENT
ID

CHILD ID LABEL

1 Northeast
2 Midwest
3 South
4 West

1 5 New England
1 6 Mid-Atlantic
2 7 East North Central
2 8 West North Central
3 9 South Atlantic
3 10 East South Central
3 11 West South Central
4 12 Mountain
4 13 Pacific

1

Northeast

2

Midwest

3

South

4

West

5

New
England

7

East
North

Central

13

Pacific

6

Mid-
Atlantic

8

West
North

Central

9

South
Atlantic

10

East
South

Central

11

West
South

Central

12

Mountain
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4. At the top of the dialog box, select the ‘Parent/Child IDs’ option.

5. In the ‘Table’ menu, expand the desired data block to reveal its
columns.

6. In the ‘Parent ID’ field, select the column that contains the parent
node IDs.

7. In the ‘ID’ field, select the column that contains the child node IDs.

8. In the ‘Label’ column select the column that contains the labels
corresponding to the child node IDs.
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9. (Optional) Enable ‘Auto Select Children’ if you want the selection
of a parent to automatically select the parent’s children.

10. Press ‘OK’ to close the dialog box.

The Selection Tree is now populated based on the selected “Parent ID” and
“Child ID” columns.

See Also
Creating a Selection Tree from Individual Columns, to create a Selection
Tree using nested columns.
Adding Hierarchy Levels to a Selection Tree, to add levels to an existing
Tree.
Selection Trees, for information on how to use Selection Trees.
Using Selection Lists and Trees, for details on Selection element symbols.
Selection List, for information on creating non-hierarchical selection
options.

6.2.3 Selection Tree Properties

The Selection Tree component’s ‘Properties’ dialog box provides General
and Data tabs. The next sections discuss the component-specific properties
available under these tabs.

See Also
Properties Dialog Box, for information about common component
properties.
Format Dialog Box, for information on the ‘Format’ dialog box.

Selection Tree Properties: General Tab

The properties in the General tab in the ‘Selection Tree Properties’ dialog
box are the same as those of the Selection List component. 

See Also
Selection List Properties: General Tab, for information on the General
tab.
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Selection Tree Properties: Data Tab

The Data tab in the ‘Selection Tree Properties’ dialog box provides the
following Selection Tree-specific properties.

Table The column or dimension that should be used to populate the 
Selection Tree

Level The order of dimension nesting in the Selection Tree. Outer hierarchy 
levels are listed above inner hierarchy levels. See Adding Hierarchy 
Levels to a Selection Tree for instructions on altering the Selection 
Tree hierarchy.

Columns Create the Selection Tree by using column information. See Creating 
a Selection Tree from Individual Columns.

Parent/
Child IDs

Create the Selection Tree by using recursive hierarchy. See Creating 
a Selection Tree from Recursive Hierarchy.

Auto 
Select 
Children

For Selection Tree based on recursive hierarchy, specifies that user 
selection of a parent also selects all the parent’s children.

Parent ID For Selection Tree based on recursive hierarchy, column that contains 
the parent node IDs.

ID For Selection Tree based on recursive hierarchy, column that contains 
the child node IDs.

Label For Selection Tree based on recursive hierarchy, column that contains 
the labels corresponding to the child node IDs.

Measure The field to aggregate and display next to the Selection Tree values.
Aggregate The method of aggregation to be used for the ‘Measure’ field.
Text Specifies that the aggregated measure is displayed as plain text. See 

Displaying Aggregate Data in Selection List for more information. 
Bar Specifies that the aggregate measure is displayed graphically as a 

proportional bar. See Displaying Aggregate Data in Selection List for 
more information.
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6.2.4 Adding Hierarchy Levels to a Selection Tree

There are two ways to add additional hierarchy levels to a Selection Tree.
The following sections explain both methods.

Adding Hierarchy Levels from Component Tree

To add levels to an existing Selection Tree hierarchy, follow these steps:

1. Expand a data block (table) or cube dimension in the Component
tree. 

2. Ctrl-click or Shift-click to select one or more columns in the data
block or one or more levels in the cube dimension. 

3. Drag the selected columns or levels onto an existing Selection Tree
that is bound to the same data block or cube dimension. (Drop the
columns or levels onto the Selection Tree when the green highlight
appears.)
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This adds the selected fields to the bottom (inner-most levels) of the
Selection Tree hierarchy. The nesting order for the new levels is determined
by the order in which you selected the fields in the Component tree.

Adding Hierarchy Levels from Properties Dialog Box

To add hierarchy levels to a Selection Tree, follow these steps:

You can also drag and
drop a single column
directly onto the
empty Selection List
element.

1. Right-click on the Selection Tree, and select ‘Properties’ from the
context menu. This opens the ‘Selection Tree Properties’ dialog
box.

2. Select the Data tab.

3. From the ‘Table’ list, select the data block column or cube
dimension that you wish to add to the hierarchy. 

4. Click ‘Add’.

5. Repeat to add any additional levels to the hierarchy. To change the
hierarchy ordering, use the ‘Move Down’ and ‘Move Up’ buttons.
The order from top to bottom represents the nesting order from
outer to inner.

6. Click ‘OK’ to close the dialog.

6.3 Selection Container
The Selection Container component serves two purposes: 
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• A Selection Container can display all of the selections (filters) that are
currently operating on the Viewsheet. See Displaying Filters.

• A Selection Container can hold Selection List and Range Slider
components. This allows end-users to add new filter components to a
Viewsheet. See Containing Filter Components.

You can use a single Selection Container for both purposes.

See Also
Selection List, for a description of Selection Lists (discrete selections).
Range Slider, for information on Range Sliders (continuous selections).

6.3.1 Displaying Filters

A Selection Container can display all of the selections (filters) that are
currently specified in the Viewsheet. These include selections in Selection
List, Selection Tree, Range Slider, or Calendar components.

To display all current selections within a Selection Container, follow the
steps below:

1. Drag a Selection Container component from the Component tree
onto the Viewsheet grid. This creates an empty Selection Container
element. 

2. Right-click on the Selection Container, and select ‘Properties’ from
the context menu. This opens the ‘Selection Container Properties’
dialog box.

3. In the ‘Options’ panel, enable ‘Show Current Selections’.

4. Press ‘OK’.
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The Selection Container will now display the currently selected values for
any Selection List, Selection Tree, Range Slider, or Calendar components
in the Viewsheet.

6.3.2 Containing Filter Components

A Selection Container can hold Selection List and Range Slider
components. To add filter components to a Selection Container, follow the
steps below:

1. Drag a Selection Container component from the Component tree
onto the Viewsheet grid. This creates an empty Selection Container
element. 

2. Drag a data field onto the Selection Container. (Use the green
highlight to place the field as desired.) You can obtain this field
from two sources:

a. Drag a field from the data block in the Component tree onto the
Selection Container.

b. Drag a field from the Chart Editor onto the Selection Container.
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This adds the chosen field to the Selection Container as a Selection
List (categorical field) or a Range Slider (numerical or date field). 

3. (Optional) Right-click on the Selection Container, and select
‘Properties’ from the context menu. This opens the ‘Selection
Container Properties’ dialog box.

4. (Optional) To permit the end-user to drag new fields from the Chart
Editor to the Selection Container, enable ‘Allow New Selections in
Viewer’.

6.3.3 Selection Container Properties

The ‘Selection Container Properties’ dialog box provides only the General
tab. It offers the following unique properties for the Selection Container.

Show Current 
Selections

Enables the Selection Container to display the current 
state of all Viewsheet selection controls.

Allow New 
Selections in Viewer

Enables the end-user to drag new fields from the Chart 
Editor to the Selection Container.
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See Also
Properties Dialog Box, for information about common component
properties.
General Tab, for General tab properties that are common among
components.

6.4 Using Selection Lists and Trees
Selection Lists and Selection Trees are simultaneously both input elements
and output elements. When two or more Selection Lists or trees are linked
to the same data block, query, or data model, the inputs to one of the lists or
trees will modify the display in the other trees.

This section explains how to make and clear selections, and explains the
meaning of the Selection List symbols.

Selection List Toolbar

See Also
Selection Lists/Selection Trees or Selection Lists/Selection Trees (Style
Scope Agile Edition), for information on how to use these components.

6.4.1 Submitting a Selection

To submit a selection, follow these steps:
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1. Check the desired options in the Selection List or Tree.

2. Hover the mouse over the list or tree to make the top-right toolbar
visible.

3. Click the ‘Apply’ button.

When ‘Submit on
Change’ is enabled,
you can Ctrl-click to
make multiple simul-
taneous selections. 

If the ‘Submit on Change’ option is set in the ‘Properties’ dialog box
(enabled by default, see Selection List Properties: General Tab), you do
not need to click the ‘Apply’ button. The selection is submitted each time
you select or deselect one of the options.

6.4.2 Filtering Selections

When a Selection List or Selection Tree contains a large number choices,
you may find it helpful to restrict or filter the available choices. This
reduces the amount of list scrolling required, and saves time. 

To filter a Selection List or Tree, follow the steps below:

1. Click the ‘Search’ button in the title bar of the Selection List. This
opens a search box.

2. In the search box, type a portion of the choice that you wish to
select.
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As you type, the Selection List restricts the choices to that which
match (at any location) the text you have entered.

3. When you have sufficiently restricted the available choices, make
the desired selections by clicking the boxes. Note that the clear and
reverse functions will only apply to the filtered choices, and all
values not displayed in the filtered list will be unaffected.

To exit the search box and restore all Selection List choices, click the ‘X’
button at the right side of the box. When the Selection List is currently
filtered by a search term, the ‘Search’ button displays a unique icon in the
title bar, shown below. Click it to modify or remove the search filter.

6.4.3 Clearing a Selection

To clear a selection, follow these steps:

1. Hover the mouse over the list or tree to make the top-right toolbar
visible.

2. Click the ‘Clear Selection’ button.

This deselects all currently selected options.

6.4.4 Reversing a Selection

The Selection List offers a ‘Reverse Selection’ toolbar option. This inverts
the current selection, selecting unchecked items, and deselecting checked
items.

6.4.5 Selection List Symbols

The table below explains the five icons used in Selection Lists: 

Data selected and included.
The user has explicitly selected this item, and the corresponding 
records are included in the returned data set.
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6.5 Range Slider
The Range Slider element filters data to fall within a specified range. It can
be used on both Date fields and Numeric fields, and provides the ability to
filter data by consecutive dates or numbers.

6.5.1 Creating a Range Slider

To create a Range Slider, follow the steps below:

1. Drag a Range Slider element from the Component tree into the
Viewsheet grid.

2. Drag a data block column (from Repository Tree or Viewsheet
Table) the onto the Range Slider element. This binds the Range
Slider to the selected column.

3. Adjust the selection range by dragging the slider end-handles. (You
can also click on an end-handle and press the arrow keys on the
keyboard.)

4. To enter precise values for the start-point or end-point, right-click
on the Range Slider and select ‘Edit’ from the context menu. In the
‘Edit’ dialog box, enter the desired values and press ‘OK’.

Data selected but not included. 
The user has explicitly selected this item, but more recent 
explicit selections in other Selection Lists have now made this 
selection incompatible. The corresponding data is therefore not 
included in the returned data set.
Data included but not selected. 
The user has not explicitly selected this item, but has made other 
selections that implicitly select this item as well. The 
corresponding records are included in the returned data set (as a 
result of those other selections). 
Data compatible but not included. 
The user has not explicitly selected this item, and the item 
remains compatible with existing user selections. This item can 
therefore be selected to add additional records to the returned 
data set.
Data incompatible. 
The user has not explicitly selected this item, and this item is 
incompatible with existing selections. (It appears listed under 
‘Others’). Selecting this clears all other selections and starts 
fresh.
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5. To quickly set the right side of the range to its maximum, double-
click on the right end-handle. To quickly set the left side of the
range to its minimum, double-click on the left end-handle. To
quickly set the entire range to its full extent, double-click on the
slider body.

You can also bind the Range Slider to a field by using the Data tab of the
‘Range Slider Properties’ dialog box. This approach also allows you to
filter aggregated data displayed in Chart and Crosstab components. See
Range Slider Properties: Data Tab for more information.

See Also
Range Slider Properties: Data Tab, for information about the Data tab.

Example: 
Range Slider

In this example you will use a Range Slider to filter sales based on both
date and quantity. Follow the steps below:

This Worksheet can
be found in the ‘Tuto-
rial’ folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘ProductSales’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Drag a ‘Range Slider’ element from the Component tree into the
Viewsheet grid.

3. Expand the ‘SalesByDate’ data block, select the ‘Date’ field, and
drag it onto the Range Slider element.

4. Adjust the size of slider unit by dragging the outer handles.
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5. Adjust the selection range by dragging the slider endpoints.

¢

6.5.2 Filtering Post-Aggregate Data with a Range Slider

You can use a Range Slider to filter the post-aggregate data displayed by a
Chart, Crosstab, or Freehand Table. To do this, follow the steps below:

1. Drag a ‘Range Slider’ element from the Component tree into the
Viewsheet grid.

2. Right-click on the Range Slider and select ‘Properties’ from the
context menu. This opens the ‘Range Slider Properties’ dialog box.

3. Select the Data tab. In the ‘Table’ panel, expand the ‘Assemblies’
node, and select the component and aggregated field that you want
to filter.

4. Press ‘OK’ to close the dialog box.

This Range Slider will now filter the post-aggregate values in the selected
Chart, Crosstab, or Freehand Table. 

See Also
Filtering a Table/Filtering a Chart or Filtering a Table/Filtering a Chart
(Style Scope Agile Edition), to filter data without adding a separate Range
Slider.
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6.5.3 Range Slider Properties

The Range Slider component’s ‘Properties’ dialog box provides General,
Data, and Advanced tabs. The next sections discuss the component-
specific properties available under these tabs.

See Also
Properties Dialog Box, for information about common component
properties.
Format Dialog Box, for information on the ‘Format’ dialog box.

Range Slider Properties: General Tab 

The General tab in the ‘Range Slider Properties’ dialog box provides only
the common properties.

See Also
General Tab, for information about common properties in the General tab.

Range Slider Properties: Data Tab

The Data tab in the ‘Range Slider Properties’ dialog box provides the
following Range Slider-specific properties:

Composite Value

The ‘Composite Value’ option allows you to filter data using the composite
of two or more columns of any type. All data types are supported. To set
the composite value option, follow the steps below. 

Single 
Value

Filter data based on one field from the data block (default). Only 
numeric and date type fields are supported.

Composite 
Values

Filter data based on the composition of two or more fields from the 
data block. See Composite Value for more information.
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1. Right-click on the Range Slider, and select ‘Properties’ from the
context menu. 

2. Under the Data tab, select ‘Composite Value’. 

3. Select two or more columns to form the composite values for
filtering. Click OK.

Example: Range 
Slider Composite 
Value

As an example, consider the following data block:

Using the composite value of these two fields, the Range Slider values are
the following tuples:

{(2000,Jan),(2000,Feb),(2004,Mar),(2006,Feb)(2008,Mar)}

Selecting the composite value (2000,Jan), for example, filters the data set
based on the constraint (Year=2000, Month=Jan).

¢

YEAR MONTH

2000 Jan
2000 Feb
2008 Mar
2004 Mar
2006 Feb
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Range Slider Properties: Advanced Tab

To create a coarser
range selection (e.g.,
date based on “quarter
of year” or string
based on “first let-
ter”,) create the appro-
priate groupings using
in the Data Work-
sheet.

The Advanced tab in the ‘Range Slider Properties’ dialog box provides the
following Range Slider-specific properties.

The ‘Slider Size’ can also be adjusted graphically in the Viewsheet by
dragging the slider endpoints. See Creating a Range Slider for an example. 

Slider Size The range of data that is displayed at a given time. There are three 
cases:
String: For string-type fields, the ‘Slider Size’ specifies the 
number of “periods,” i.e., the number of consecutive 
(alphabetically ordered) values that should be simultaneously 
selected.
Numeric: For numeric-type fields, the ‘Slider Size’ specifies the 
number of ‘Min Range Size’ periods spanned by the slider. The 
total numerical range simultaneously selected is therefore ‘Slider 
Size’ * ‘Min Range Size’.
Date: For date-time type fields, ‘Slider Size’ specifies the number 
of periods to be simultaneously selected, where the period 
duration is given by the adjacent popup menu: ‘Year’, ‘Month’, 
‘Day’, ‘Hour’, or ‘Minute’. For date type fields, the options are 
‘Year’, ‘Month’, and ‘Day’. For time type fields, the options are 
‘Hour’ and ‘Minute’. 
Note: For ‘Day’, ‘Hour’, and ‘Minute’ settings, if the number of 
ticks exceeds 1500, the range size is automatically adjusted to 
yield a smaller number of ticks.

Min Range 
Size

For numeric-type fields, this is the smallest amount by which the 
range can be adjusted.

Max Range 
Size

Specifies the largest range that the user can specify. The units are 
the same as the ‘Slider Size’.

Upper 
Bound 
Inclusive

Specifies that the upper bound of the selected range is included in 
the selection. (For example, if the user sets the slider upper limit to 
“10”, the result set includes data with values of “10” for this field).

Logarithmic 
Scale

Sets logarithmic scaling for the slider, which is useful for 
traversing large numerical ranges. The logarithm base is selected 
automatically. 

Label The labels to display on the Range Slider:
Tick: Show the increments by which the slider can be adjusted.
Current Value: Permanently display the slider value above the 
slider.
Minimum: Show the minimum slider value at the left of the 
slider.
Maximum: Show the maximum slider value at the right of the 
slider.
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See Also
Grouping, in Advanced Data Mashup, for information in creating groups.

6.6 Calendar
A Calendar allows you to select data by time range, measured in weeks or
months. It also facilitates comparative aggregation, for example, the side-
by-side comparison of total quantity purchased during the months of Dec.
2005 and Dec. 2006.

See Also
Calendars or Calendars (Style Scope Agile Edition), for information on
how to use a Calendar.

6.6.1 Creating a Calendar

To create a calendar, follow the steps below:

1. Drag a ‘Calendar’ element from the Component tree onto the
Viewsheet grid. This creates a new Calendar element. 

2. Drag a date column from a data block (on the tree) and drop it onto
the calendar. This links the calendar to the data represented by the
selected date field.
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3. Set properties of the Calendar using the ‘Calendar Properties’
dialog box (see Calendar Properties) or by using the mini-toolbar
(see Calendars).

6.6.2 Calendar Properties

The Calendar component’s ‘Properties’ dialog box provides General,
Data, and Advanced tabs. The next sections discuss the component-
specific properties available under these tabs.

See Also
Calendars or Calendars (Style Scope Agile Edition), for information on
using the Calendar component.
Properties Dialog Box, for information about common component
properties.
Format Dialog Box, for information on the ‘Format’ dialog box.

Calendar Properties: General Tab 

The General tab in the ‘Calendar Properties’ dialog box provides only the
common general properties.

See Also
General Tab, for information about common properties in the General tab.

Calendar Properties: Data Tab

The Data tab in the ‘Calendar Properties’ dialog box allows you to choose
the date field on which Calendar selections operate. Only columns with
date formatting are displayed.
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Calendar Properties: Advanced Tab

The Advanced tab in the ‘Calendar Properties’ dialog box provides the
following Calendar-specific properties

OPTION DESCRIPTION

‘Show’ Calendar: Displays the calendar as a traditional wall calendar. 
Dropdown: Displays the calendar as a drop-down list.

‘View Type’ Simple View: Displays a single calendar unit.
Range/Comparison: Displays two calendars side by side, 
facilitating date comparison.

 ‘View 
Mode’

Yearly: Displays all twelve months in a single calendar. 
Monthly: Displays a single month. 
Day Selection: Enables selection of individual days on the 
calendar.
Single Selection: Prevents the user from selecting multiple date 
units on the Calendar. (This property is not supported for 
Viewsheets displayed using HTML, such as those on iPad.)
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7 Output Components

Gauges and Text components display summarized data using a familiar
interface, which makes them an ideal way to present key performance
indicators (KPIs). The data displayed in these Output components can be
filtered by Selection components. 

7.1 Gauge
Gauges display a summarized value for a single column in a Worksheet
data block, query, or model. 

7.1.1 Creating a Gauge

To add an Gauge component to a Viewsheet, follow the steps below:

1. Drag the Gauge component from the Component tree into the
grid. 

2. Drag a column from the data block (at the top of the Components
tree), and drop it onto the Gauge.

This binds the Gauge to the data block column so that the
component displays a summary of the values in that column.

3. To specify the summarization method, follow these steps:

a. Right-click the Gauge, and select ‘Properties’. This opens the
‘Properties’ dialog box for the Gauge.

b. In the Data tab of the ‘Properties’ dialog box, select a
summarization method from the ‘Aggregate’ menu, and click
‘OK’.

7.1.2 Gauge Properties

The ‘Gauge Properties’ dialog box provides the following tabs: General,
Data, and Advanced. The next sections discuss the output-specific
properties available under these tabs.
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See Also
Properties Dialog Box, for information about common component
properties.

Gauge Properties: General Tab

The General tab in the ‘Gauge Properties’ dialog box provides the
following unique properties.

Note: If you are connecting to the server via “https” in Internet Explorer,
you may need to change the following Internet Explorer setting in order for
the ‘Face’ property to update correctly: In Internet Explorer, open the
‘Internet Options’ dialog box, and click the ‘Browsing History Settings’
button to open the ‘Temporary Internet Files’ dialog box. Select ‘Every
time I visit the web page’ under ‘Check for newer versions of stored
pages’.

See Also
General Tab, for General tab properties that are common among
components.

Number 
Range

Minimum: The starting value on the display.
Maximum: The ending value on the display.
Minor Increment: The minimum resolution on the display.
Major Increment: The points at which the values are displayed.

If you leave the Number Range properties blank, the Gauge will 
automatically create a scale appropriate to the data.

Face The visual form of the element. Click on the desired skin to select it.
Shadow Adds a drop shadow to the component.
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Gauge Properties: Data Tab

The Data tab in the ‘Gauge Properties’ dialog box provides only the
common data properties.

See Also
Data Tab, for information about common properties in the Data tab.

Gauge Properties: Advanced Tab

The Advanced tab in the ‘Gauge Properties’ dialog box provides the
following properties:

Setting Ranges for a Gauge

To set multiple ranges for a Gauge, follow the steps below:

1. Open the Advanced tab of the ‘Gauge Properties’ dialog box. In
the ‘Range’ panel you will see three editable drop-down lists.

2. Enter a value for ‘Range 1 to’ and choose a color from the pop-up
menu. This sets the region from the minimum value on the scale to
the specified value. 

3. Enter a value into ‘Range 2 to’ and choose a color from the pop-up
menu. This sets the region from the end of ‘Range 1’ to the
specified value. 

Range A set of colored zones to display on the Gauge. See Setting Ranges for 
a Gauge.

Show 
Value

Provides a digital display of the current value shown on a Gauge.
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4. Repeat the above steps to add any additional thresholds.

5. (Optional) Select ‘Gradient’ to smoothly blend the zone colors, if
desired. 

6. (Optional) If you have selected ‘Gradient’, choose a color for the
final blend. 

7.2 Text
Text elements can be used to display static labels as well as summarized
data for a single column in a Worksheet data block, query, or data model. 

7.2.1 Creating a Text Element 

To add a text into a Viewsheet, drag a Text component from the
Component panel into the Viewsheet grid. Use the mouse to move and
resize the element. 

Double-click inside the Text element to edit the text. The text that you enter
will automatically wrap to fit within the component boundaries. If you set
the ‘Auto Size’ property (see Text Properties: General Tab), the Text
component will expand vertically to display the entirety of the text that you
enter.

To bind a text element to a data column, drag the desired column from the
data block (at the top of the Component panel) and drop it onto the
element.

7.2.2 Text Properties

The Text component’s ‘Properties’ dialog box provides the following tabs:
General and Data. The next sections discuss the text-specific properties
available under these tabs.

See Also
Properties Dialog Box, for information about common component
properties.
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Text Properties: General Tab

The General tab in the ‘Text Properties’ dialog box provides the following
text-specific property.

See Also
General Tab, for information about common properties in the General tab.
Advanced Dashboard Scripting, to replace the fixed text with a formula.

Text Properties: Data Tab

The Data tab in the ‘Text Properties’ dialog box provides only the common
data properties.

See Also
Data Tab, for information about common properties in the Data tab.

7.2.3 Adding Highlights to Text

To add a highlight to a text element, right-click the text element, and select
‘Highlight’ from the context menu. This opens the ‘Highlight’ dialog box.

Text Display a label, or specify a single calculated value.
Shadow Adds a drop shadow to the component. (Drop shadow for a Text 

component is not preserved on export.)
Pop 
Component

Select an individual component or Container to display as a pop-up 
interface. When the user clicks the text, the selected component is 
displayed at the location of the text. Otherwise, the selected 
component is not visible in the Viewsheet.

Alpha Sets the transparency of the pop-up component or group. An 
‘Alpha’ value of 100% indicates complete opacity. An ‘Alpha’ 
value of less that 100% allows underlying components to be 
partially visible through the popped-up component or group.

Auto Size Allows the bottom border of the Text component to expand 
vertically so that all of the text in the component is visible.
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See Also
Highlights, for instructions on how to use the ‘Highlight’ dialog box.

7.2.4 Displaying Data in a Text Component Graphically

To display a numerical value in a Text component using a graphical
representation such as a colored bar or QR code, follow the steps below. 

1. Right-click on a Text component that displays a numerical value,
and select ‘Format’ from the context menu.

2. On the Format tab of the ‘Format’ dialog box, select a desired
graphical representation from the ‘Presenter’ menu.

3. Press the ‘Options’ button to open the ‘Presenter’ dialog box.

4. Specify the desired values for the presenter options, and press
‘OK’.
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See Presenter for more information about the options.

5. Press ‘OK’ to close the ‘Format’ dialog box. This applies the
presenter to the Text component.

See Also
Displaying Table Cell Values Graphically, to use a presenter in a table.
Presenter, for more information about presenters.

7.3 Image
An Image element displays an image file (gif, jpg, png) on the Viewsheet. 

7.3.1 Creating an Image

To add an Image element to a Viewsheet, follow the steps below:

1. Drag an Image element from the Component tree onto the
Viewsheet grid. Use the handles to move and resize the element.

2. Right-click the image element, and select ‘Properties’. This opens
the ‘Image Properties’ dialog box. Select the General tab.
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Uploaded image files
are stored in the
asset.dat file or
asset.dat.d directory
together with the
Viewsheet.

3. To upload a local image file, click the ‘Upload’ button at the
bottom of the dialog box, and choose the file. The uploaded file is
now listed under the ‘Uploaded’ folder. 

To specify an image that already exists on the server (in a directory
on the classpath), enter the resource path (e.g. ‘/library/image.gif’)
as an expression in the ‘Dynamic Image Selection’ field, under the
Advanced tab. 

4. Select the desired image from the ‘Uploaded’ folder, and click
‘OK’.

The image is added to the Viewsheet. By default, the image appears at its
full size. To scale the image to the Image container, select ‘Scale Image’
from the Advanced tab.

See Also
Scaling an Image, for information on scaling an image in the Viewsheet.
Creating a Shape, for information on creating primitive shapes.
Changing Images with Script, in Advanced Dashboard Scripting, for
information on changing image content using script.

7.3.2 Image Properties

The Image component’s ‘Properties’ dialog box provides the following
tabs: General, Data, and Advanced. The next sections discuss the image-
specific properties available under these tabs.
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See Also
Properties Dialog Box, for information about common component
properties.

Image Properties: General Tab

The General tab in the ‘Image Properties’ dialog box provides the
following image-specific property.

See Also
General Tab, for information about common properties in the General tab.
Changing Images with Script, in Advanced Dashboard Scripting, for
information on specifying an image file through scripting.
Creating an Image, for instructions on how to upload an image.

Pop 
Component

Select an individual component or Container to display as a pop-
up interface. When the user clicks the image, the selected 
component is displayed at the location of the image. Otherwise, 
the selected component is not visible in the Viewsheet.

Alpha Sets the transparency of the pop-up component or group. An 
‘Alpha’ value of 100% indicates complete opacity. An ‘Alpha’ 
value of less that 100% allows underlying components to be 
partially visible through the popped-up component or group.

Static Image Select an existing server image, or ‘Upload’ an image to the server. 
The ‘Skins’ folder provides a few predefined images which are 
useful as backgrounds. The ‘Theme Background’ has the special 
property of automatically adapting to match the prevailing color 
scheme of the User Portal.

Shadow Adds a drop shadow to the component.
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Image Properties: Data Tab

The Data tab in the ‘Image Properties’ dialog box provides the common
data properties. The ‘Aggregate’ value that you specify here is used as the
value for the Image highlight condition. 

See Also
Adding Highlights to an Image, for information on conditional formatting.
Data Tab, for information on common properties in the Data tab.

Image Properties: Advanced Tab

The Advanced tab in the ‘Image Properties’ dialog box provides the
following image-specific properties.

Dynamic 
Image 
Selection

Specifies a method for dynamically setting the image. See 
Changing Images with Script, in Advanced Dashboard 
Scripting, for more information.

Scale Image When selected, specifies that images should be scaled to the 
containing component boundary. The following options are 
available:
Maintain Aspect Ratio: The image’s width to height ratio is 
preserved when the image is resized, preventing the image from 
being distorted.
Scale: The image is divided into nine regions, which scale 
independently. See Scaling an Image.

Tile Tiles (repeats) the image horizontally and vertically within the 
component boundaries.

Preview Displays a thumbnail of the image as it will appear with the 
applied scaling.
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7.3.3 Scaling an Image

To scale an image, you need to enable image scaling, and then choose the
method by which images should scale. Follow the steps below:

1. Right-click the Image component, and select ‘Properties’ from the
context menu. This opens the ‘Image Properties’ dialog box.

2. Click the Advanced tab, and enable the ‘Scale Image’ option.

3. To keep image proportions constant during scaling, select
‘Maintain Aspect Ratio’. This allows the image to scale without
distortion.

4. To selectively scale only parts of the image (e.g., the middle of the
image), select ‘Scale (9-Cell Grid)’. 

Tip: For an image
with a border, you
may want to keep the
border width constant
as the image is scaled.
To do this, set the
pixel values slightly
greater than the bor-
der thickness.

This divides the image into a 3x3 grid of cells, shown below. The
‘Top’ and ‘Bottom’ cells are scaled only horizontally. The ‘Left’
and ‘Right’ cells are scaled only vertically. The corner cells are not
scaled, and maintain their original size. The middle (gray) cell is
scaled in both horizontal and vertical directions. 

5. If you have selected ‘Scale (9-Cell Grid)’, enter the desired sizes of
the ‘Top’, ‘Bottom’, ‘Left’, and ‘Right’ regions in pixels.

6. Click ‘OK’ to close the dialog box.

The image will now be scaled in the specified manner when you adjust the
Image boundaries.

See Also
Creating a Dashboard Background, to use an image as Viewsheet or
component background.

7.3.4 Adding Highlights to an Image

To add a highlight to an image element, right-click the image element, and
select ‘Highlight’ from the context menu. This opens the ‘Highlight’ dialog
box.
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See Also
Highlights, for instructions on how to use the ‘Highlight’ dialog box.

7.3.5 Tinting an Image

To add colored tint to an image, follow the steps below:

1. Right-click the image, and select ‘Format’ from the context menu.
This opens the ‘Format’ dialog box.

2. Select the Color tab.

3. In the ‘Text’ panel, select a color from the menu.

4. Click ‘OK’ to close the dialog box.

The color you selected is now used to tint the image.

See Also
Color Tab, for more information about the options on the Color tab.

7.4 Adding Hyperlinks to Output Components
In output components, hyperlinks can be attached to the component body
(e.g., the entire Gauge). To create hyperlinks on an output component,
right-click the component and select ‘Hyperlink’ from the context menu.
This opens the ‘Hyperlink’ dialog box.

See Also
Hyperlinks, for information on the ‘Hyperlink’ dialog box.
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8 Form Components

Note: The Viewsheet’s onRefresh Handler script is re-executed each
time the user makes a selection from an Form Component.

You can enter data into Viewsheets using the form components provided in
the toolbox (Slider, Spinner, Combo Box, etc.) Form elements, unlike
selection elements, do not merely filter a fixed set of data. Instead, they
cause re-execution of queries and modify the original result set.

See Also
Output Components, for information on graphical presentation of data.
Filter Components, for information on filtering the data view display. 
Data View Components, for information on tables and charts. 

8.1 Using Form Components
Form components enable the user to enter values into a Viewsheet. There
are three ways that you can use the entered form values:

Note: You can also
add a Worksheet
Embedded Table as a
Viewsheet compo-
nent, so that users can
directly enter values.
See Creating an
Embedded Table.

• Pass the form values to an Embedded Table in the linked Worksheet:
Embedded Tables in a Data Worksheet are often linked (via joins, etc.)
to other data blocks in such a way that changing values in the Embedded
Table alters the data contained in those other blocks. This allows the
user to perform what-if analysis, manipulating the values in the
Embedded Table to see how a hypothetical scenario would impact their
real data. 

Note: A form compo-
nent that is not linked
to a Variable can still
be referenced in
Worksheet script as a
parameter having the
name of the compo-
nent.

• Pass the form values to a Variable in the linked Worksheet: Variables in
a Data Worksheet are used in data block conditions, which effectively
filter the data contained in a given data block.

• Pass the form values to set component properties or conditions in the
Viewsheet.

Note: The CheckBox
control does not sup-
port the Embedded
Table interface.

The following sections discusses the Embedded Table and Variable
interfaces. Viewsheet form components (Slider, Radio Button, etc.)
provide a way to alter the values set within the Worksheet’s Embedded
Table or Variable without accessing the Worksheet directly. This allows
you to explore the same data by making intuitive control adjustments,
rather than by typing in numbers.

For information on using form components to dynamically adjust
component properties and conditions, see Dynamic Properties.

See Also
Creating an Embedded Table, in Advanced Data Mashup, for basic
concepts.
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Creating a Variable, in Advanced Data Mashup, for information on
Variables.

8.1.1 Configuring an Embedded Table

To pass inputs from a Viewsheet to the underlying Worksheet, the
Worksheet must contain an Embedded Table. Follow the steps below to
add and configure the Embedded Table in the Worksheet.

1. In the Worksheet, click the ‘New Object’ button in the toolbar, and
select the ‘Embedded Table’ option. The pointer changes to a
crosshair.

Any cell in the
Embedded Table can
receive its value from
a Viewsheet control.

2. Drag the mouse across the Worksheet grid to create the new
Embedded Table. Create as many rows and columns as needed for
the application.

3. Right-click the Embedded Table, and select ‘Properties’ from the
context menu. This opens the ‘Properties’ dialog box.

4. In the ‘Name’ field, enter a name for the Embedded Table. This is
the name by which you will identify the table in the Viewsheet. 

5. Click ‘OK’ to close the ‘Properties’ dialog box. 

6. Edit the column names, if desired. (Meaningful column names
make it easier to bind the Viewsheet form control.)

7. Enter default values into the cells of the Embedded Table. 

A cell that is linked to a Viewsheet control will be dynamically
updated to the value set in the control. A cell that is not linked to a
Viewsheet control will retain the fixed value you enter.

The Embedded Table
is usually connected
to other data blocks
by one or more joins.

8. Connect the Embedded Table to other data blocks in the
Worksheet, as desired. 

See Also
Changing a Dashboard Data Source, for an application example.
Creating an Embedded Table, in Advanced Data Mashup, for basic
concepts.
Joining Tables, in Advanced Data Mashup, for information on creating
joins.
Renaming a Column, in Advanced Data Mashup, to set column names.

8.1.2 Passing Inputs to an Embedded Table or Variable

To link a Viewsheet form control (other than a Check Box) to an
Embedded Table or Variable in the Worksheet, follow these steps:
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1. Right-click on the form control, and select ‘Properties’. 

2. Select the Data tab.

Multiple controls can
be linked to the same
Embedded Table.

3. Open the ‘Target’ menu:

a. To access an Embedded Table, expand the ‘Table’ node, and
select the desired Embedded Table data block of the Worksheet. 

b. To access a Variable, expand the ‘Variable’ node, and select the
desired Variable asset in the Worksheet. Skip to the final step
below.

4. For an Embedded Table, click the ‘Browse’ button next to the
‘Table’ field. This displays a representation of the Embedded
Table.

5. In the displayed Embedded Table, click to select the table cell into
which form values should be passed. This automatically populates
the ‘Column’ and ‘Row’ menus with the corresponding cell
indices.

The ‘Row’ menu dis-
plays the format “row:
row value.” For exam-
ple, “1:25” indicates
that form values are
passed to the second
row of the Embedded
Table, which cur-
rently contains the
value “25.”

Alternatively, specify the target cell directly from the provided
menus:

a. From the ‘Column’ menu, select the appropriate field of the
Embedded Table data block. 

b. From the ‘Row’ menu, select the row of the table to which the
form element should provide data. 

6. Press ‘OK’ to exit the ‘Properties’ dialog box.

To set the options dis-
played by the Form
control, see Creating a
Radio Button/Check
Box/Combo Box.

The control is now linked to the Worksheet’s Embedded Table or Variable,
and changes you make using the control will alter the values in the
specified Embedded Table cells or Variable.
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See Also
Form Components, for information on controls for Embedded Table input.
Creating an Embedded Table, for directly entering data into an Embedded
Table.
Creating an Embedded Table, in Advanced Data Mashup, for basic
concepts.
Creating a Variable, in Advanced Data Mashup, for basic concepts.
What-If Analysis, in Advanced Data Mashup, for an application example.
Dynamic Properties, to control properties from form elements.

8.2 Slider and Spinner
Sliders and Spinners are interactive form elements that can supply
numerical data to Embedded Tables and Variables in the underlying
Worksheet and Viewsheet component properties. Sliders and Spinners
differ from one another only in appearance.

See Also
Passing Inputs to an Embedded Table or Variable, to manipulate the
Worksheet.
Dynamic Properties, to manipulate Viewsheet properties. 

8.2.1 Creating a Slider or Spinner

To create a Spinner, follow the steps below. (The Slider is identical.)

1. Drag the ‘Spinner’ element from the Component tree into the
Viewsheet grid. This creates an empty Spinner in the Viewsheet
grid. 

2. Right-click on the Spinner, and select ‘Properties’ from the context
menu. This opens the ‘Spinner Properties’ dialog box.

3. Under the General tab, specify the ‘Minimum’ and ‘Maximum’
values.

4. If you will use the Spinner to control dynamic properties of another
element, follow these steps:

a. Enter a ‘Name’ for the control. This is the name by which the
control is identified in dynamic property menus. (See Dynamic
Properties.)

b. Click ‘OK’ to finish. 
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Note: If you plan to use the Slider or Spinner to set dynamic
properties, you do not need to specify an Embedded Table or
Variable in the Data tab.

5. If you will use the Spinner to control values in a Worksheet
Embedded Table or Variable, follow the steps below:

a. Select the Data tab.

b. In the ‘Target’ list, expand the ‘Tables’ or ‘Variables’ node, and
select an Embedded Table or Variable from the linked
Worksheet. 

The format shown is
“row: value.” The left
number is the row
index, the right num-
ber is the current
value in that row (i.e.,
the default value).

c. For an Embedded Table, select the desired column from the
‘Column’ list and the desired row from the ‘Row’ list. The row
and column together define the cell to which the Spinner
provides data. 

d. Press ‘OK’.

Example: 
Spinner Control 
of Embedded 
Table

In this example, you will use a Spinner control to display only values in a
table that exceed the specified Spinner value.

1. Create a new Worksheet.

For information on how to create a Data Worksheet, see Creating a
Data Worksheet (Style Scope and Style Intelligence) or Creating a
Data Set by Mash-Up (Style Scope Agile Edition).

2. In the following steps, add a new Embedded Table containing a
single numeric data cell:
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a. Press the ‘New Object’ button on the toolbar, and select
‘Embedded Table’. 

b. Drag across the Worksheet grid to select three vertical cells, and
release. 

This creates a new Embedded Table named ‘Query1’, with just
one data cell.

c. Double-click the column header cell (‘col0’), and change the
name to “Quantity”.

d. In the data cell of the Embedded Table, enter the value “15.” 

e. Right-click the column header cell (‘Quantity’), and select
‘Column Type’ from the context menu. 

This opens the ‘Column Type’ dialog box.

f. In the ‘Column Type’ dialog box, set ‘Type’ to ‘Integer’. Click
‘OK’.

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

3. From the Asset panel, drag the ‘Sales Explore’ Worksheet onto the
current Worksheet. This creates a new table called ‘Sales1’.

4. In the following steps, join the Embedded Table to the ‘Sales1’
table. The tables will be joined on the ‘Quantity Purchased’ column
using an inequality join condition:

Note that a Range
Slider provides a very
simple way to filter
based on value, with-
out requiring Embed-
ded Tables.

a. Select both of the tables (Shift-click).

b. Press the ‘Join Table’ button on the toolbar, and select ‘Inner
Join’. This opens the ‘Inner Join’ dialog box.
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c. On the left side, select ‘Query1.Quantity’ from the top menu.

d. On the right side, select ‘Sales1.Quantity Purchased’ form the
top menu.

e. From the center menu (comparison operator), select ‘<=’, as
shown below.

f. Press ‘OK’.

The tables are now joined on the ‘Quantity Purchased’ column,
creating a new table called ‘Query2’. The values shown in the
‘Quantity Purchased’ column of joined table ‘Query2’ will only
be those which equal or exceed the ‘Quantity’ value in the
Embedded Table.

5. Verify that the joined table is filtered correctly:

a. Press the ‘Change View’ button in the toolbar of the ‘Query2’
table and select ‘Live Preview’. Expand the table to show all the
data. (Only values of ‘Quantity Purchased’ greater than or equal
to 15 are shown.)

b. Enter “20” as the value in the Embedded Table, and observe
how the data in table ‘Query2’ is filtered accordingly.
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6. Prepare the joined table to be displayed in a Viewsheet:

a. Right-click the ‘Query2’ table title bar and select ‘Properties’
from the context menu. Change the name of the joined table to
“Result Table”. 

b. Right-click the ‘Query2’ table title bar, and select ‘Set As
Primary’ to make this the primary data block.

c. Press the ‘Change View’ button in the toolbar, and select
‘Default’ to exit live-data mode. 

d. In the left-most table column named ‘Quantity’, press the
‘Visibility’ button to hide the column. (This column shows the
value from the Embedded Table, and does not need to be
displayed in the Viewsheet.)

e. Save the Worksheet as “Large Quantity”.

7. In the following steps, create a new Viewsheet to display the
‘Result Table’ from the Worksheet:

a. Create a new Viewsheet based on the ‘Large Quantity’
Worksheet.

b. From the Component tree, drag the ‘Result Table’ data block
onto the Viewsheet grid. This creates a table called ‘Result
Table’.
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c. Drag the table handles to make the table taller, so that about 10
rows are shown.

8. Add a Spinner element to control the value in the Embedded Table
(thus filtering the displayed ‘Result Table’):

a. Drag a Spinner from the Component tree onto the Viewsheet
grid.

b. Right-click the Spinner, and select ‘Properties’ from the context
menu. This opens the ‘Spinner Properties’ dialog box.

The ‘Row’ menu
shows a single row
because the Embed-
ded Table has only
one row. The value
shown is the current
value of the Embed-
ded Table cell, which
was specified earlier.

c. Select the Data tab. In the ‘Target’ menu, expand the ‘Table’
node, and select ‘Query1’. (This is the ID of the Embedded
Table in the Worksheet.)

d. Select the General tab. In the ‘Number Range’ panel, set
‘Maximum’ to “20.”

e. Press ‘OK’.

9. Test the Spinner by entering different values. Observe how the
values in the table change: The table only displays records for
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which ‘Quantity Purchased’ is greater than the value you choose in
the Spinner.

¢

See Also
Using Form Components, for details on the Embedded Table interface.
Creating a New Data Worksheet, in Advanced Data Mashup.
Creating a New Embedded Table, in Advanced Data Mashup.
Dynamic Properties, to control properties with form elements.

8.2.2 Slider and Spinner Properties

The ‘Properties’ dialog box for Slider and Spinner components provides
the following tabs: General, Data, and Advanced. The next sections
discuss the form-specific properties available under these tabs.

See Also
Properties Dialog Box, for information about common component
properties.

Slider and Spinner Properties: General Tab

The General tab in the Slider and Spinner ‘Properties’ dialog box provides
the following unique properties.

Submit on 
Change

When enabled (default), submits the selected value immediately 
upon selection. Otherwise, a separate ‘Submit’ button is required.

Number 
Range

Minimum: The starting value
Maximum: The ending value
Increment: The points at which the values are displayed
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See Also
General Tab, for General tab properties that are common among
components.

Slider and Spinner Properties: Data Tab

The Data tab in the ‘Properties’ dialog box for form components provides
the following form-specific properties:

See Using Form Components for details on setting and using these
properties.

See Also
Data Tab, for Data tab properties that are common among components.

Target An Embedded Table or Variable in the Worksheet. The ‘Browse’ 
button to the right allows you to interactively select the row and 
column of the Embedded Table.

Column The column of the Worksheet Embedded Table into which the form 
value should be passed. 

Row The row of the Worksheet Embedded Table into which the form 
value should be passed. (The ‘Row’ menu displays the format “row: 
row value.”) 
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Slider and Spinner Properties: Advanced Tab

The Advanced tab in the ‘Properties’ dialog box for the Slider component
provides the following specific property:

8.3 Radio Button, Check Box, Combo Box
Radio Buttons, Check Boxes, and Combo Boxes are used to enter numeric
or non-numeric data into an Embedded Table or Variable in the underlying
Worksheet. They can also be used to set dynamic properties of other
Viewsheet components, e.g., visibility, color, etc.

Radio Buttons, Check Boxes, and Combo Boxes offer similar functionality.
Radio Buttons and Combo Boxes allow only a single item to be selected,
while Check Boxes allow multiple items to be selected.

See Also
Using Form Components, for details on Embedded Table and Variable
interfaces.
Dynamic Properties, to control properties using form elements.
Creating a Slider or Spinner, for an Embedded Table usage example.

8.3.1 Creating a Radio Button/Check Box/Combo Box

To create a Radio Button/CheckBox/ComboBox, follow the steps below. 

1. Drag a Radio Button/CheckBox/ComboBox control from the
Component tree onto the Viewsheet grid.

2. Right-click the control and select ‘Properties’ from the context
menu. This opens the Radio Button/CheckBox/ComboBox
‘Properties’ dialog box.

3. If you will use the Radio Button/CheckBox/ComboBox to set
dynamic properties for another element, follow these steps:

a. Select the General tab, and enter a ‘Name’ for the control. This
is the name by which the control is identified in dynamic
property menus. (See Dynamic Properties.)

Label The labels to display on the Slider:
Tick: Show tick marks along the slider scale.
Current Value: Display the current value above the slider when 
dragging.
Labels: Show value labels along the slider scale. (‘Tick’ must be 
enabled.)
Minimum: Show the minimum slider value at the left of the slider. 
(Enabled by default when ‘Labels’ is enabled.)
Maximum: Show the maximum slider value at the right of the slider. 
(Enabled by default when ‘Labels’ is enabled.)
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b. Click ‘OK’ to finish.

Note: If you plan to use the form control to set dynamic
properties, you do not need to specify an Embedded Table under the
Data tab.

4. If you will use the Radio Button/CheckBox/ComboBox to set
values in a Worksheet Embedded Table or Variable, follow the
steps below. (See Passing Inputs to an Embedded Table or
Variable for more details.)

a. Select the Data tab.

b. From the ‘Target’ list, select an Embedded Table data block or
Variable in the linked Worksheet. 

The format shown is
“row: value.” The left
number is the row
index, the right num-
ber is the current
value in that row (i.e.,
the default value).

c. For an Embedded Table, from the ‘Column’ list, select the
desired field of the Embedded Table. From the ‘Row’ list, select
the row of the table to which the form control should provide
data.

d. Click ‘OK’.

5. Select the General tab, and populate the Radio Button/CheckBox/
ComboBox control with the values it will display. There are three
methods:

a. Manually enter a list of values and labels: See Populating Label/
Value Pairs Manually.
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b. Specify a query to generate a list of values and labels: See
Populating Label/Value Pairs from Query.

c. For ComboBox only, you can acquire the input via a calendar
widget. See Acquiring Date Input Using a Calendar Control.

6. Click ‘OK’ to close the dialog box.

See Also
Using Form Components, for details on Embedded Table and Variable
interfaces.
Dynamic Properties, to control properties from form elements.
Populating Label/Value Pairs Manually, to manually enter values/labels.
Populating Label/Value Pairs from Query, to obtain values/labels from
query.

Populating Label/Value Pairs Manually

Applies to Radio But-
tons, Check Boxes, and
Combo Boxes. 

To manually enter label/value pairs for a Radio Button, Check Box, or
Combo Box, follow the steps below:

1. Right-click the form control, and select ‘Properties’ from the
context menu. This opens the ‘Properties’ dialog box. 

2. Select the General tab.

3. Under the heading ‘List Values’, select the ‘Embedded’ option, and
click on the ‘Edit’ button. This opens the ‘Embedded List Values’
dialog box. 

4. Click the ‘Add’ button. This will populate the list with ‘Label’ and
‘Value’. 

5. Double click on the list elements, and enter a desired Label and
Value.

6. To insert more elements, repeat the above steps.
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7. Click ‘OK’ when you are finished adding items.

8. In the ‘Data Type’ field, specify the data type of the values you
entered in the ‘Value’ column.

9. In the ‘Options’ panel, specify how the labels in the list should be
ordered. ‘Ascending’ and ‘Descending’ sort the labels in
alphabetical/increasing order or reverse-alphabetical/decreasing
order, respectively. 

The ‘None’ option retains the original ordering of the embedded
list. If you are populating the list from both a query and an
embedded list (see Populating Label/Value Pairs from Both a
Query and Embedded List), select ‘List Embedded Items Last’ to
place the items from the embedded list following the query items.
Otherwise, the embedded items are listed before the query items.

10. Press ‘OK’ to exit the ‘Properties’ dialog box.

To use data field names as the label/value pairs for the form control, simply
drag the field names from the Component panel onto the form component
in the desired sequence. 
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This approach is preferable to manually typing the field names in the
embedded list, because it protects you from entering misspelled field
names. After adding the fields to the list this way, you can modify the labels
by editing the embedded list as described previously.

Populating Label/Value Pairs from Query

Applies to Radio But-
tons, Check Boxes, and
Combo Boxes. 

To populate a Radio Button, Check Box, or Combo Box using label/value
pairs from a query, follow the steps below:

1. Right-click on the form control, and select ‘Properties’ from the
context menu. This opens the ‘Properties’ dialog box. 

2. Select the General tab.

3. Under the heading ‘List Values’, select the ‘Query’ option, and
click on the ‘Edit’ button. This opens the ‘List Values Selection’
dialog box. 

4. Select a data block from the list on the left side. Select the
appropriate fields from the drop-down lists titled ‘Label’ and
‘Value’. 

5. Enable the ‘Apply Selection’ option to filter the query values based
on Filter components in the Viewsheet. For example, if an form
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control displays query values drawn from the ‘Category’ field, and
the Viewsheet also contains a Selection List based on the
‘Category’ field, selections that the user makes in the ‘Category’
Selection List will filter the categories shown in the form
component.

6. Press ‘OK’ to close the ‘List Values Selection’ dialog box.

7. In the ‘Options’ panel, specify how the labels in the list should be
ordered. ‘Ascending’ and ‘Descending’ sort the labels in
alphabetical/increasing order or reverse-alphabetical/decreasing
order, respectively. The ‘None’ option retains the original ordering
provided by the query.

8. Press ‘OK’ to close the ‘Properties’ dialog box.

Populating Label/Value Pairs from Both a Query and Embedded List

Applies to Radio But-
tons, Check Boxes, and
Combo Boxes. 

To populate a Radio Button, Check Box, or Combo Box using label/value
pairs from both a query and an embedded list, enable both the ‘Query’ and
‘Embedded’ options in the ‘Properties’ dialog box. (See Populating Label/
Value Pairs from Query and Populating Label/Value Pairs Manually.)

This will merge together the labels/values retrieved from both sources into
a single list. If the ‘Sort’ property is set to ‘Ascending’ or ‘Descending’, the
query items and embedded items are sorted together as a single list. If the
‘Sort’ property is set to ‘None’, the embedded items can be placed either
before or after the query items. See Populating Label/Value Pairs
Manually for more information.

Acquiring Date Input Using a Calendar Control

Applies to Combo
Boxes only. 

To acquire date input from the user using a calendar control, follow the
steps below:

1. Drag a ComboBox from the Components panel to the Viewsheet.
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2. Right-click the ComboBox, and select ‘Properties’ from the
context menu. This opens the ‘Properties’ dialog box. 

3. Select the General tab.

4. Under the heading ‘List Values’, select the ‘Embedded’ option, and
click on the ‘Edit’ button. 

5. In the ‘Data Type’ field, select the ‘Date’ option.

6. Enable the ‘Calendar’ option.

7. Press ‘OK’ to exit the dialog box.

This creates a calendar control in which user the user can select an arbitrary
date.

8.3.2 Radio Button/Check Box/Combo Box Properties 

The ‘Properties’ dialog box for Radio Button, Check Box, or Combo Box
provides General and Data tabs. The next sections discuss the form-
specific properties available under these tabs.
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See Also
Properties Dialog Box, for information about common component
properties.

Radio/Check/Combo Properties: General Tab

The General tab in the ‘Properties’ dialog box provides the following
unique properties for Radio Button, Check Box, and Combo Box.

See Also
Populating Label/Value Pairs Manually, to manually enter label-value
pairs.
Populating Label/Value Pairs from Query, to populate from a query.
General Tab, for information on common properties in the General tab.

Submit on 
Change

When enabled (default), submits the selected value immediately 
upon selection. Otherwise, a separate ‘Submit’ button is required.

List Value Specifies the method for populating control labels and values:
Embedded: Manually enter label-value pairs. 
Query: Populate from a query (data block). 
See Creating a Radio Button/Check Box/Combo Box for information 
on how to use these options.

Editable Allows the user to enter an arbitrary string into the Combo Box (in 
addition to selecting from the list options).

Number of 
Rows

For a ComboBox, this specifies the number of items concurrently 
displayed when the ComboBox is expanded. If the actual number of 
items is greater than this value, the ComboBox displays a scrollbar to 
access the additional items. If the actual number of items is less than 
this value, the ComboBox shrinks to fit the available items.
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Radio/Check/Combo Properties: Data Tab

The Data tab in the ‘Properties’ dialog box for Radio Button, Check Box,
or Combo Box is the same as for Sliders and Spinners.

See Also
Slider and Spinner Properties: Data Tab, for information on the Data tab.

8.4 Submit Button
The Submit button provides a way for the user to trigger a scripted action in
the Viewsheet. This action is performed by a script that you place in the
‘onClick’ handler of the Submit button.

One common use of the Submit button is to write data from an editable
table or TextInput component to a database. The submitted table data may
include records that the user has added, deleted, or edited in a table.

For information on how to create a database update script, see Committing
User-Modified Data to Database (Database Write-Back) in Advanced
Dashboard Scripting.

See Also
confirm(message), in Advanced Dashboard Scripting, to confirm user
submissions using script.
Committing User-Modified Data to Database (Database Write-Back) in
Advanced Dashboard Scripting, to submit information to the database.
TextInput, for a component that allows arbitrary user text entry and
validation.
Table Properties: Advanced Tab, to configure a table to be editable by
users. 

8.4.1 Creating a Submit Button

To create a Submit button, follow the steps below. 

1. Drag the ‘Submit’ element from the Component tree into the
Viewsheet grid. This creates a new Submit button in the Viewsheet
grid. 

2. Right-click on the Submit button, and select ‘Properties’ from the
context menu. This opens the ‘Submit Properties’ dialog box.
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3. Select the General tab. In the ‘Label’ field, enter the text to appear
on the button face.

4. Select the Script tab. Enter the desired ‘onClick’ script. See
Committing User-Modified Data to Database (Database Write-
Back) in Advanced Dashboard Scripting for more information.

5. Press ‘OK’ to close the dialog box.

8.4.2 Submit Button Properties

The ‘Properties’ dialog box for Slider and Spinner components provides
the following tabs: General and Script. The next sections discuss the
form-specific properties available under these tabs.

See Also
Properties Dialog Box, for information about common component
properties.

Submit Button Properties: General Tab

The General tab in the Submit button ‘Properties’ dialog box provides the
following unique property.

See Also
General Tab, for General tab properties that are common among
components.

Label The text to be displayed on the button face.
Refresh Viewsheet 
after Submit

Refresh the Viewsheet data when the user presses the 
‘Submit’ button. 
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Submit Button Properties: Script Tab

The Script tab is common to most components. See Advanced Dashboard
Scripting for information on writing Viewsheet scripts.

8.5 TextInput
The TextInput component allows a user to enter arbitrary data in the form
of text, date, integer, or floating point values. This component is commonly
used together with the Submit Button to commit user edits to the database
or assign values to parameters.

See Also
Submit Button, for information about submitting user input.

8.5.1 TextInput Properties

The ‘Properties’ dialog box for the TextInput component provides the
following tabs: General, Option, and Script. The next sections discuss the
form-specific properties available under these tabs.

See Also
Properties Dialog Box, for information about common component
properties.

TextInput Properties: General Tab

The General tab in the ‘Properties’ dialog box provides the following
unique properties.

Submit on 
Change

When enabled (default), submits the entered value when user 
presses ‘Enter’ or clicks away. Otherwise, a separate ‘Submit’ 
button is required.

Default Text Specifies the text to appear within the TextInput field when it is 
first displayed. (This is often a hint to the user about what data 
should be entered). This default text is automatically removed 
when the user begins entering data.

Inset Border 
Style

Specifies a dimensional “inset” (rather than flat) appearance for the 
component border.

Multiple 
Lines

When enabled, allows the user to enter multiple lines of text into 
the text area.
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See Also
General Tab, for General tab properties that are common among
components.

TextInput Properties: Option Tab

The Option tab in the ‘Properties’ dialog box allows you to select an
“Input Editor” which specifies the control interface and validation for user
input. See Validating User Input for details on the available editors.

TextInput Properties: Script Tab

The Script tab is common to most components. See Advanced Dashboard
Scripting for information on writing Viewsheet scripts.

8.6 Upload
The Upload component allows a user to upload a local file to the server. A
script function, getFileName(), provides the full path to the uploaded file on
the server. A script function, isLoaded(), provides verification that a file
was uploaded.

8.6.1 Upload Properties

The ‘Properties’ dialog box for the Upload component provides the
following tabs: General and Script. The next sections discuss the form-
specific properties available under these tabs.

See Also
Properties Dialog Box, for information about common component
properties.
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Upload Properties: General Tab

The General tab in the ‘Properties’ dialog box provides the following
unique properties.

See Also
General Tab, for General tab properties that are common among
components.

Upload Properties: Script Tab

The Script tab is common to most components. See Advanced Dashboard
Scripting for information on writing Viewsheet scripts.

See Also
Upload, in Advanced Dashboard Scripting, for related script functions.

Submit on 
Change

When enabled (default), uploads the selected file immediately. 
Otherwise, a separate ‘Submit’ button is required.

Label Specifies the label to appear on the button.
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9 Shape Components

Note: Shapes cannot be exported to Excel format.

Shape components allow you to add simple geometric shapes to a
Viewsheet. You can use these shapes to provide frames and backgrounds
for other components, and to improve the aesthetic appearance of the
Viewsheet.

9.1 Creating a Shape
You can draw several shapes on the Viewsheet grid, including lines,
rectangles, and ovals. To draw a shape on the Viewsheet grid, follow the
steps below:

1. From the ‘Shape’ node on the Component tree, drag the desired
shape onto the Viewsheet grid.

2. Click the shape to select it. 

3. Drag the body of the shape (or the “move” handle) to reposition the
shape as desired.

4. Drag the border handles to resize the shape as desired.

See Also
Creating an Image, for information on adding images to the Viewsheet.
Creating a Dashboard Background, for information on creating a
Viewsheet background.
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9.2 Shape Properties
The ‘Properties’ dialog box for shape components provides General and
Shape tabs. The next sections discuss the shape-specific properties
available under these tabs.

See Also
Properties Dialog Box, for information about common component
properties.

9.2.1 Shape Component Properties: General Tab

The General tab in the ‘Properties’ dialog box for shape components
provides only the common properties.

See Also
General Tab, for General tab properties that are common among
components.

9.2.2 Shape Component Properties: Shape Tab

The Shape tab in the ‘Properties’ dialog box for shape components
provides slightly different properties for each shape type, as explained
below

Line: Style
Line: Color

Sets the line type (thickness, etc.) and color for shape 
borders. Available for all shapes.

Fill: Color
Fill: Alpha

Sets the color and transparency of Oval and Rectangle 
shape interiors. An ‘Alpha’ value of 100% indicates 
complete opacity. An ‘Alpha’ value of less that 100% 
allows underlying components to be partially visible 
through the shape.

Shape: Round Corners Sets the radius (in pixels) for circularized corners on 
Rectangle shapes. Larger pixel values yield more gentle 
corners.
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9.3 Anchoring a Line to a Component
You can anchor or glue the end of a Line component to a handle of any
other component. This is useful when you are using the line as a connector
between components. When you anchor the end of a line, it remains
attached to the anchoring component even when the anchoring component
is moved.

To anchor the end of a Line component to another component, follow the
steps below:

1. Drag a new Line component from the Components panel into the
Viewsheet.

2. Set the Line properties as desired. (See Shape Component
Properties: Shape Tab.)
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3. Click on one of the handles of the Line that you want to anchor.

4. Drag the Line handle over the component to which it should be
anchored. This causes the handles of the anchoring component to
be displayed. 

Note: A green high-
light is shown around
the handle when the
end of the Line is in
the correct position.

5. Drop the Line handle onto one of the handles of the anchoring
component.

6. (Optional) Repeat the above steps to anchor the other end of the
Line.

The end of the Line that is anchored will remain attached to the anchoring
component even when the anchoring component is moved.

To free the end of the line from its anchor, follow the steps below: 

1. Click the Line to select it.

2. Click the handle at the end of the Line, and drag it away from its
anchor.
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10Organization Components

There are several components whose function is to organize other
components, allowing you to structure the components within a Viewsheet.
These organizational components are listed below:

• Container: The Container component is used to group a set of
components, allowing you to positioned them together as a single unit. 

• Tabbed Interface: The Tabbed Interface component is used to stack
components onto distinct pages (accessed by tabs), allowing you to
make more efficient use of Viewsheet real estate. 

• Nesting Viewsheets: The Nested Viewsheet component is created when
you import an external Viewsheet. This allows you to modularize your
dashboard design.

The following sections present detailed information about these
components’ properties.

See Also
Grouping Components, for information on how to create a group. 
Selecting Components, for information on how to select multiple
components.

10.1 Container
The Container component is a container for other elements. It is
automatically created whenever you group a set of components together.
See Grouping Components.

The Container component can hold only individual components, not other
Containers. If you group together multiple Containers, the result is a single
new Container that holds all of the constituent group’s components.

10.1.1 Creating a Container

The Container component is not accessible from the Viewsheet
Component tree. To create a Container component, simply group together
a set of Viewsheet components. See Grouping Components for further
details.

10.1.2 Container Properties

The Container component’s ‘Properties’ dialog box provides General and
Advanced tabs. The next sections discuss the Container-specific properties
available under these tabs.
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See Also
Properties Dialog Box, for information about common component
properties.
Format Dialog Box, for information on the ‘Format’ dialog box.

Container Properties: General Tab 

The General tab in the ‘Container Properties’ dialog box is the same as
that for the Image component, and allows you also to specify an image to
be used as the group background. See Image Properties: General Tab for
details on how to select the image.

See Also
Format Dialog Box, for information on setting background colors.
General Tab, for information about common properties in the General tab.

Container Properties: Advanced Tab

The Advanced tab in the ‘Container Properties’ dialog box is the same as
that for the Image component, and allows you to set the scaling properties
of the group background image. See Image Properties: Advanced Tab for
details on image scaling.
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10.2 Tabbed Interface
A Tabbed Interface allows you to stack individual components or groups
into distinct cards or pages, accessed by tabs. This is an effective way to
conserve screen real estate if components do not need to be accessible at
the same time.

10.2.1 Creating a Tabbed Interface

The Tabbed Interface component is not accessible from the Viewsheet
Component tree. To create a tabbed interface, follow the steps below.

1. Drag and drop one component (or group) onto another component
(or group). This opens the ‘Layout Option’ dialog box. 
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2. Choose the ‘Place component into tabbed interface’ option. This
places the two components (or groups) into a tabbed interface.

Note that each component is placed at the top-left corner within its
own tab. To display a component at a different location within its
tab, first group the component together with a background (e.g., an
Image component or one of the Shape Components), and then use
the group as the contents of the tab. See Grouping Components for
more information.

Any of the following components can be placed into a tabbed interface:

• Individual components (e.g., Calendar, Table, Chart, Selection
Container)

• Grouped components (i.e., a Container element) 

• Nested Viewsheets

To add an additional component to an existing tabbed interface, simply
drag the component (or group) onto the tabbed interface. This will create a
new tab containing the component (or group).

To remove a particular tab from the tabbed interface, follow these steps:

1. Click the tab you wish to remove.

2. Select the component or group within that tab.

You can also delete
the component, if
desired.

3. Drag the selected component out of the tabbed interface (or Cut
and Paste) onto an empty region of the Viewsheet. This will
remove the component from the interface (and delete the
corresponding tab).

To remove the entire tabbed interface, follow the steps below:

1. Click on the row of tabs to select the tabbed interface (as a whole).

2. Right-click, and select ‘Remove’ from the context menu (or click
‘Delete’ on the keyboard). 
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This deletes the tabbed interface, and returns all of the tabbed components
to normal positions on the Viewsheet.

See Also
Grouping Components, for information on how to create a group.
Selecting Components, for more information on how to select a
component.
Deleting a Component, for information on how to remove a component.
Moving a Component, for information on moving an element.

10.2.2 Tabbed Interface Properties
Note: To open the
Tabbed Interface
‘Properties’ dialog
box, right-click in the
tab region, and select
‘Properties’.

The Tabbed Interface component’s ‘Properties’ dialog box provides only a
General tab. This allows you to assign labels to the different tabs and
modify their order.

To change a tab label, select the desired tab in the ‘Tab’ list, enter the new
label text in the ‘Label’ field, and click ‘OK’. To change the position of the
selected tab, click ‘Move Up’ or ‘Move Down’.

See Also
Properties Dialog Box, for information about common component
properties.
Format Dialog Box, for information on setting background colors.
General Tab, for information about common properties in the General tab.

10.3 Nesting Viewsheets 
A nested Viewsheet is an external Viewsheet that is embedded within the
current Viewsheet. This nested Viewsheet can be positioned within the
current Viewsheet as though it were a single component, and it has its own
‘Properties’ dialog box.
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See Nesting a Viewsheet for information on creating a Nested Viewsheet
component.

See Also
Nesting a Viewsheet, for information on embedding Viewsheets.
Opening a Nested Viewsheet, for information on editing a nested
Viewsheet.

10.3.1 Nested Viewsheet Properties

The nested Viewsheet’s ‘Properties’ dialog box provides only a General
tab. See General Tab for information on these common properties.

See Also
Properties Dialog Box, for information about common component
properties.
General Tab, for information about common properties in the General tab.
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11Dynamic Properties 

Every component in a Viewsheet has certain properties that can be made
“dynamic,” or dependent on other components. These properties can be set
either by an form component or by a logical expression. For example, you
can use a radio button to specify the Y-axis field in a chart, or use an
expression to add highlights to cells of a table. 

The following sections explain how you can use form controls to
parameterize component formatting and data presentation, as well as data
filtering. By associating a form control such as a RadioButton or
ComboBox with the property setting for a component, you allow the user
to adjust that setting by manipulating the corresponding control.

For information on using expressions, see Adding Property Script
(Expressions) in Advanced Dashboard Scripting.

See Also
Adding Property Script (Expressions), in Advanced Dashboard Scripting,
to control property values with expressions.

11.1 Parameterizing a Property using an Form 
Control
To parameterize a component property using an form control, follow these
steps:

1. Create and configure the form control. Follow the steps below:

a. Add the desired form control (RadioButton, CheckBox, etc.) to
the Viewsheet.

b. Right-click the form component, and select ‘Properties’ from
the context menu. This opens the ‘Properties’ dialog box for the
form component.

c. Under the General tab, use the ‘Name’ field to assign the form
component a meaningful name. This is the name used to refer to
the component. 

d. Specify the ‘List Values’ for the form component by manually
entering ‘Embedded’ values or by specifying a ‘Query’ to
provide the values. (See Form Components for further details.)

e. Press ‘OK’ to close the form component ‘Properties’ dialog
box.
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2. Link the form control to the component property you want to
manipulate. Follow the steps below:

a. Right-click the component you wish to control, and select
‘Properties’ from the context menu. This opens the ‘Properties’
dialog box for the controlled component.

You can specify a
form control for any
property that offers
the ‘Variable’ option. 

b. Locate the property that you wish to control, and select
‘Variable’ from the adjacent pop-up menu. 

c. From the corresponding pop-up menu, select the form
component that should control the property.

d. Click ‘OK’ to close the ‘Properties’ dialog box for the
controlled component.

The specified form control will now provide the value of the selected
property. 

Example: 
Property as a 
Parameter

In this example, you will add a RadioButton that allows the user to set the
Y-axis field of a chart to either ‘Quantity Purchased’ or ‘Total Revenue’.

This Worksheet can
be found in the ‘Tuto-
rial’ folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘ProductSales’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Add a radio button to the Viewsheet, with two embedded values
(‘Quantity Purchased’ and ‘Total’).
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3. Add a chart to the Viewsheet and bind it to the ‘SalesByDate’ data
block. Add the ‘State’ field as the X-axis and the ‘Quantity
Purchased’ field as the Y-axis.

4. Press the triangle button next to ‘Quantity Purchased’, and choose
the ‘Variable’ option. The menu displays the available variable
names.

5. From the list of variables, choose ‘$(RadioButton)’.

6. Now press the radio buttons. Note that the chart displays the Y-axis
field that you choose using the radio button control.

¢

See Also
Matching Dynamic Values to Property Values, for input value constraints.
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11.2 Parameterizing a Condition using a Form 
Control
Form components allow a user to manipulate a filter or highlight condition
applied to a data view component (Chart, Table, Crosstab). To control such
a condition using an form component, follow these steps:

1. Create and configure the form control, following the steps below:

a. Add the desired form control (RadioButton, CheckBox, etc.) to
the Viewsheet.

b. Right-click the form component, and select ‘Properties’ from
the context menu. This opens the ‘Properties’ dialog box for the
form component.

c. Under the General tab, use the ‘Name’ field to assign the form
component a meaningful name. This will be the name used to
refer to the component. 

d. Specify the ‘List Values’ for the form component by manually
entering ‘Embedded’ values or by specifying a ‘Query’ to
provide the values. (See Form Components for further details.)

e. Click ‘OK’ to close the form component ‘Properties’ dialog
box.

2. Link the form control to the filter condition or highlight condition
of the data view component that you want the user to manipulate.
Follow the steps below:

a. Right-click the data view component you wish to highlight or
filter, and select ‘Highlight’ or ‘Condition’ (as desired) from the
context menu. This opens the ‘Highlight’ or ‘Condition’ dialog
box for the component.

b. Create the left side of the condition as described under
Highlights and Filter Conditions, e.g., “[State][is][one of]”.

c. From the ‘Change Value Type’ popup menu (triangle) select
‘Variable’. This enables an adjacent pop-up menu.
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d. From the adjacent pop-up menu, select the form component that
you want to control the value.

e. Click ‘Append’ to add the condition, and click ‘OK’ to close the
‘Condition’ dialog box.

The specified form control will now provide the value for the right side of
the condition. 

Example: 
Condition as a 
Parameter

In this example, you will add a CheckBox that allows the user to highlight
specified states within a table.

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Create a new Viewsheet based on the ‘Sales Explore’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Drag a CheckBox component from the Component panel to the
Viewsheet. Right-click the component, and select ‘Properties’ from
the context menu. This opens the ‘CheckBox Properties’ dialog
box.
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3. In the ‘CheckBox Properties’ dialog box, make the following
changes:

a. Change the ‘Name’ to “StateSelector”.

b. In the ‘List Values’ panel, select the ‘Query’ option. Click the
‘Edit’ button to open the ‘List Values Selection’ dialog box.

c. In the ‘List Values Selection’ dialog box, select the ‘Sales’ data
block in the left panel, and then select ‘State’ in both the ‘Label’
and ‘Value’ menus.

d. Click ‘OK’ to close both dialog boxes. This binds the
CheckBox component to the ‘State’ field of the data block.
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4. On the Viewsheet grid, select the CheckBox component. Drag the
handles to expand the component so that all state options are
visible.

5. Drag a Table component from the Component panel to the
Viewsheet grid. 

6. Expand the ‘Sales’ data block at the top of the Component panel,
and drag the following fields into the Table: ‘Category’,
‘Company’, ‘City’, ‘State’, ‘Total’.

7. Enlarge the table so that at least 10 rows are visible.

8. Right-click a cell in the ‘City’ field of the Table, and select
‘Highlight’ from the context menu. This opens the ‘Highlight’
dialog box for the ‘City’ field.

9. In the ‘Highlight’ dialog box, click the ‘Add’ button, and enter the
name “CityHighlight”.

10. For the ‘Background’ property, select yellow.

11. In the ‘Conditions’ panel, click the ‘Edit’ button to open the
‘Conditions’ dialog box.



DATA MASHUP

716 of 1397

12. In the ‘Conditions’ dialog box, create the left side of the condition
by making the following menu selections: “[State][is][one of]”.

13. From the ‘Change Value Type’ popup menu (triangle), select
‘Variable’. This enables an adjacent pop-up menu.

14. From the adjacent pop-up menu, select the “StateSelector” form
component.

15. Click ‘Append’ to add the condition, and click ‘OK’ to close the
‘Conditions’ dialog box.

16. Click ‘OK’ to close the ‘Highlight’ dialog box.

On the Viewsheet, make selections in the CheckBox form component, and
observe how this highlights the cities in the Table that correspond to the
selected states. 
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¢

See Also
Matching Dynamic Values to Property Values, for input value constraints.

11.3 Matching Dynamic Values to Property Values
When you link a form control with a component property, you should
ensure that the form control evaluates to a permissible value for the
particular property. There are three main cases.

• Property Requires a Numerical Value: If a property requires a
numerical value, the form control should provide an appropriate
numerical value. For example, the ‘Ranking’ property in the Chart data
binding requires an integer value. An appropriate control for this
property would therefore be a Spinner with ‘Increment’ property set to
an integer value.

• Property Requires a Boolean Value: If a property has a ‘True’ or
‘False’ setting, the form control should provide a Boolean value. For
example, the ‘Enabled’ property expects a Boolean value ‘true’ or
‘false’. An appropriate control for this property would therefore be a
RadioButton with embedded list values {true, false}, and with ‘Data
Type’ set to ‘Boolean’.

• Property Requires a String Value: If a property requires one of a fixed
set of strings, the form control should provide a string from the set. For
example, the ‘Visible’ property requires one of the strings ‘Show’,
‘Hide’, or ‘Hide on Print and Export’. The form control must therefore
return one of these strings. An appropriate control for this property
would therefore be a RadioButton with embedded list values {‘Show’,
‘Hide’, ‘Hide on Print and Export’}, and with ‘Data Type’ set to
‘String’.
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Requires String
Requires Boolean

Requires Integer
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12Viewsheet Toolbar

The table below describes the Visual Composer toolbar buttons available
for editing Viewsheets

BUTTON FUNCTION

New Worksheet: Create a new Data Worksheet. (In Style Scope 
Agile Edition, this button is called ‘New Data Set’.)

New Viewsheet: Create a new Viewsheet based on a Worksheet, 
query, data model, or database table. (In Style Scope Agile Edition, 
this button is called ‘New Dashboard’.)
Save: Save the changes to Viewsheet (Ctrl-S).

Save As: Save the Viewsheet under a new name or scope.

Options: Settings for the Viewsheet as a whole.

Preview: View the Viewsheet as the user does.

Undo: Undo the last operation. (Ctrl-Z)

Redo: Redo the last operation that was undone. (Ctrl-Y)

Format Painter: Copy text formatting from one object to another.

Currency Format: Apply a currency format.

Percentage Format: Apply a percentage format.

Comma Style: Apply a number format.

Increase Decimal: Increase the number of decimal places.

Decrease Decimal: Decrease the number of decimal places.

Borders: Apply borders to selected objects.

Font color: Select text color.

Fill color: Select background color of objects

Close: Close Visual Composer
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Advanced Data Mashup

The Data Worksheet is a powerful and easy-to-use tool that enables you to
rapidly build complex queries for demanding tasks such as “what-if” and
cross-domain analysis. 
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1 Introduction

A Data Worksheet is a powerful and easy-to-use tool that enables you to
rapidly build complex data sets for tasks such as “what-if” and cross-
domain analysis. Using the simple mouse-driven interface, you can
mashup diverse data sources and local data. The data blocks you create in
the Data Worksheet can be used in publishable reports, analytic
dashboards, and as components of other Data Worksheets.

See Also
Assets: Reusable Worksheet Components, for information on creating data
blocks and using assets in Worksheets.

1.1 Style Studio and Visual Composer
Note: The screen images shown in this guide are generally from the
Visual Composer.

In Style Scope and Style Intelligence, you can create and edit Worksheets
using either the desktop Style Studio or the web-based Visual Composer.
These tools provide identical functionality, although there are some minor
differences in appearance.

If you are using Style Scope Agile Edition, see Creating a Data Set by
Mash-Up for information on how to create a new Worksheet.

See Also
Saving an Asset, for information about asset storage.
Editing Data Worksheets, for information on opening and creating
Worksheets.

1.1.1 Editing a Data Worksheet in Style Studio
Style Studio is not available in Style Scope Agile Edition.

To edit a Worksheet in Style Studio, open the Asset panel and expand the
Worksheet node. Double-click the desired worksheet.

To create a new Worksheet in Style Studio, click the ‘New’ button in
toolbar. This opens the ‘New Asset’ dialog box. Select the ‘Worksheet’
node in the left-side tree, and click ‘OK’.
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You can now proceed to edit the Worksheet. See Editing Data Worksheets
for more information.

1.1.2 Editing a Data Worksheet in Visual Composer
If you are using Style Scope Agile Edition, see Creating a Data Set
by Mash-Up to create a new Worksheet.

To launch the web-based Visual Composer, follow these steps:

1. Open a web browser, and log in to the User Portal. 

The default URL for the User Portal is http://hostname:8080/
sree/Reports, where ‘hostname’ is the computer running the Portal
software. Consult your administrator for the correct address and
login information.

2. Select the Design tab at the top of the User Portal.

3. Press the ‘Visual Composer’ link under the Design tab. This
launches Visual Composer in a separate browser window.

Once you have launched the Visual Composer, you can create new
Worksheets or open existing Worksheets for editing. See Editing Data
Worksheets for more information.
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1.2 Editing Data Worksheets
This section provides basic information about working with Worksheets.

1.2.1 Creating a New Data Worksheet 
If you are using Style Scope Agile Edition, see Creating a Data Set
by Mash-Up to create a new Worksheet.

To create a new Worksheet (in Style Studio or Visual Composer), press the
‘New Worksheet’ button in the toolbar. 

This opens a blank Worksheet named ‘Untitled’.

See Also
Assets: Reusable Worksheet Components, for adding content to a
Worksheet.
Appendix A:Toolbar Buttons, for information on the Worksheet toolbar.

1.2.2 Creating a Local Worksheet
Local Worksheets are not available for Style Scope Agile Edition.

A local Worksheet is a Worksheet that is embedded within a report, rather
than being stored in the common asset.dat file or asset.dat.d directory.
Embedding a Worksheet data source within a report enhances report
portability. However, because a local Worksheet is available only to the
particular report in which it is embedded, embedding is most useful in
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cases when the Worksheet is unique to the report and will not be reused for
other reports. 

Creating a Local Worksheet

To create a local Worksheet, you must first open a report in Style Studio.
Follow these steps:

1. In Style Studio, open the report into which you want to embed the
local Worksheet.

2. Expand the Style Studio Asset panel. 

3. Expand the ‘Report’ node, and right-click the ‘Local Worksheet’
folder. Select ‘New Worksheet’ from the context menu. 

Note: The ‘Local Worksheet’ folder is only available when a report
is open for editing in Style Studio.

4. Design the new Worksheet as desired, and save the Worksheet.
(See the other sections of this guide for information on designing
Worksheets.)

The saved Worksheet is displayed under the ‘Local Worksheet’ folder, and
is embedded within the current report. You can bind this Worksheet to a
report element in the same way that you bind any other data source. See
Walkthrough: Choosing the Binding Data Source in Advanced Report
Design for more information.

See Also
Creating a Local Query, in Advanced Data Modeling, for information on
embedding a query.

Exporting a Local Worksheet to the Global Repository

To export one or more local Worksheets to the global asset.dat file or
asset.dat.d directory so that they can be used in other reports, follow the
steps below:

1. In Style Studio, open the report that contains the local Worksheet(s)
that you want to export.

2. Expand the Style Studio Asset panel.
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3. Expand the ‘Local Worksheet’ node in the tree. 

4. Expand the desired target folder under the ‘Worksheet’ tree node.

5. To copy the Worksheet(s) to the desired folder under the
‘Worksheet’ tree node (and leave the originals as embedded local
Worksheets), follow these steps:

Alternatively, drag-
and-drop the Work-
sheet to the desired
location while holding
down the Ctrl key.

a. Select the desired Worksheet(s) in the ‘Local Worksheet’
folder, right-click, and select ‘Copy’ from the context menu.

b. Right-click the desired folder under the ‘Worksheet’ tree node,
and select ‘Paste’ from the context menu.

6. To move the Worksheet(s) to the desired folder under the
‘Worksheet’ tree node (and remove them from their embedding the
report), follow these steps:

a. Select the desired Worksheet(s) in the ‘Local Worksheet’
folder.

b. Drag-and-drop the selected Worksheet(s) into the desired folder
under the ‘Worksheet’ tree node.

The selected Worksheets are added to the common asset registry. Elements
in the report that were previously bound to removed local Worksheets are
automatically re-bound to the newly-exported global Worksheets.

Importing a Local Worksheet from the Global Repository

To import one or more Worksheets from the common asset.dat file or
asset.dat.d directory into a specific report as local Worksheets, follow the
steps below:

1. In Style Studio, open the report into which you want to embed the
Worksheet(s). 

2. Expand the Style Studio Asset panel.
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3. Expand the ‘Report’ node, which contains the ‘Local Worksheet’
folder. 

4. Expand the folder under the ‘Worksheet’ tree node that contains
the Worksheet(s) that you wish to import.

5. To copy the Worksheet(s) to the ‘Local Worksheet’ folder (and
leave the originals in the common asset registry), follow these
steps:

Alternatively, drag-
and-drop the Work-
sheet to the desired
location while holding
down the Ctrl key.

a. Select the desired Worksheet(s), right-click, and select ‘Copy’
from the context menu.

b. Right-click on the ‘Local Worksheet’ folder, and select ‘Paste’
from the context menu.

6. To move the Worksheet(s) to the ‘Local Worksheet’ folder (and
remove them from the common asset registry), follow these steps:

a. Select the desired Worksheet(s).

b. Drag-and-drop the selected Worksheet(s) onto the ‘Local
Worksheet’ folder.

The Worksheet is now displayed under the ‘Local Worksheet’ folder and
embedded within the current report. You can bind this Worksheet to a
report element in the same way that you bind any other data source. See
Walkthrough: Choosing the Binding Data Source in Advanced Report
Design for more information

Report elements that were previously bound to the removed global
Worksheet are automatically re-bound to the newly-created local version. 

1.2.3 Opening a Data Worksheet
If you are using Style Scope Agile Edition, see Editing a Data Set
to open a Worksheet.

To open a saved Worksheet (in Style Studio or Visual Composer), follow
these steps:

1. Expand the ‘Global Worksheet’ or ‘User Worksheet’ node in the
Asset panel, and locate the desired Worksheet.

2. Double-click the Worksheet in the Asset tree, or right-click the
Worksheet and select ‘Open Sheet’.
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Visual Composer loads the Worksheet into a new page, and displays the
name of the Worksheet in the tab at the bottom. Visual Composer allows
you to keep many Worksheets (and Viewsheets) open simultaneously.

See Also
Assets: Reusable Worksheet Components, for information on editing a
Worksheet.

1.2.4 Saving a Data Worksheet

This section discusses Worksheet storage and scope.

Saving a New Version of an Existing Worksheet

To save a new version of an existing Worksheet, press the ‘Save’ button in
the toolbar, or press Ctrl-S on the keyboard. This replaces the older version
with the current version, retaining the same name.

To save the new version of the Worksheet under a different name, press the
‘Save As’ button. This opens the ‘Save Worksheet’ dialog box. Then
follow the instructions for saving a new Worksheet below.
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Saving a New Worksheet

To save a new Worksheet, follow these steps:

1. Press the ‘Save’ button in the toolbar, or press Ctrl-S on the
keyboard. 

In Style Scope Agile Edition, this is the ‘Save Data Set’ dialog
box.

This opens the ‘Save Worksheet’ dialog box. The dialog box in
Visual Composer appears as shown below:

The dialog box in Style Studio appears as shown below:
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2. Enter a name for the Worksheet in the ‘Name’ field. In Visual
Composer, this is available under the Repository tab.

3. Select a location in which to save the Worksheet:

a. If you are using Visual Composer, select the appropriate scope
for the saved Worksheet: ‘Global Worksheet’, ‘User
Worksheet’, or a sub-folder. The scope in which you save the
Worksheet determines the accessibility of the Worksheet to
different users. See Controlling Access to an Asset for further
details.

b. If you are using Style Studio, select the appropriate scope for the
saved Worksheet: ‘Worksheet’, a sub-folder under ‘Worksheet’,
or a report under ‘Report Repository’. The scope in which you
save the Worksheet determines the accessibility of the
Worksheet to different users. See Controlling Access to an Asset
for further details.

‘As data source to reports’ is not available in Style Scope Agile
Edition.

4. Select ‘As data source to reports’ to make the Worksheet result
(i.e., the Primary asset) available to reports as well as Viewsheets.
This will allow you to bind the Worksheet result to report elements
such as tables, charts, and sections. In Visual Composer, this
setting is available under the Options tab of the dialog box.

5. (Optional) If you are using Visual Composer, under the Options
tab, set the ‘Design mode sample data size’ to the maximum
number of rows that wish data blocks in the Worksheet to retrieve. 

6. Press ‘OK’ to save the Worksheet.

The Worksheet is saved to the asset repository, and appears in the Asset
tree under the specified scope. Saved Worksheets are stored in the asset.dat
file or asset.dat.d directory in the SREE Home directory. 

See Also
Controlling Access to an Asset, for information about scope rules.
Using an Asset, for information about binding worksheet results to
elements.
Showing Live Data in a Table, for information on setting maximum display
rows.
Repository Directory, in Advanced Server Administration, for information
on the SREE Home directory.
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Visibility of Saved Worksheet Assets

When you save a Worksheet, all of its constituent assets (data blocks,
named groups, variables, etc.) are saved together. However, only the asset
marked as “Primary” is accessible to reports and other Worksheets. See
Setting an Asset as Primary for information about setting the external
visibility of Worksheet assets. 

The asset marked “Primary” determines the appearance of the Worksheet
icon in the Asset tree. See Using an Asset for a list of icons.

1.2.5 Closing a Data Worksheet

To close a Worksheet, do one of the following:

• Press Ctrl-W on the keyboard.

• Click the ‘X’ in the Worksheet tab at the bottom of the screen.

If the Worksheet contains unsaved changes, you will be prompted to save
the Worksheet. See Saving a Data Worksheet for more information.

1.2.6 Navigating a Data Worksheet

The bottom left corner of the Visual Composer contains the Worksheet
Explorer. The Worksheet Explorer provides a hierarchical (tree) view of all
the data blocks in the current Worksheet. To select a particular data block
in the Worksheet, click the appropriate node in the tree.

The hierarchy reflects the composition structure of data blocks in the
Worksheet, with the participating (base) data blocks of each Composition
Table listed as sub-nodes under the result. 
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The icons in the tree indicate the type of operation performed to obtain the
resulting data block. Click on an icon to open the corresponding dialog box
(‘Conditions’, ‘Join Types’, etc.) and make modifications to the operation.

1.2.7 Setting Global Worksheet Options

To set global Worksheet options using Visual Composer, press the
‘Options’ button in the toolbar. 

To set global Worksheet options using Style Studio, select the ‘Worksheet
Properties’ option from the File menu.

ICON OBJECT/OPERATION

Cross Join.

Embedded table data block. (See Creating an Embedded Table.)

Inner Join.

Intersect.

Merge Join.

Minus.

Mirror data block. (See Mirroring a Table.)

Rotated data block. (See Rotating a Table.)

Data block used as subquery within condition. (See Using a Subquery 
in a Condition.)
Union.
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Some options are not available in Style Scope Agile Edition.

There are several global options available:

• ‘As data source to reports’ specifies that the Worksheet is accessible for 
data binding in reports, as well as for use by Viewsheets. 

• ‘Alias’ specifies a designation to be used in place of the actual 
Worksheet name. The alias replaces the Worksheet name in all contexts 
except the Objects tab and the ‘Export Assets’ page in Enterprise 
Manager. These always display the actual Worksheet name.

• ‘Description’ specifies a description for the Worksheet to appear in the 
Style Studio ‘Open’ dialog box and the Portal’s Ad Hoc Wizard.

• ‘Design mode sample data size’ globally limits the number of rows 
returned by any query or subquery for Live Preview mode, and for 
Viewsheet design view. 

If a data block in the Worksheet is composed from multiple sub-queries,
each individual subquery result will be capped at the specified ‘Design
mode sample data size’ maximum. This may prove efficient when the final
data block is itself row-limited. For example, if the final data block displays
only 20 rows in Live Preview mode, it may be unnecessary for the
component sub-queries to each retrieve thousands of rows, and restricting
these query result sets may be desirable. However, artificially limiting
queries in this way can also yield an unrepresentative Live Preview result
in some cases.

See Also
Using a Data Block in a Report, for details on report data binding.
Limiting the Number of Rows in a Table, for a survey of methods.
Viewing the SQL Query Plan of a Table, to inspect composition of the data
block query.
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2 Assets: Reusable Worksheet Components

An asset is a reusable Worksheet component. The three different types of
Worksheet assets are listed below.

When you save an asset in the asset repository, you can then use that asset
in multiple Worksheets and in multiple reports. This section covers the
basics of working with assets.

2.1 Using an Asset
The Asset tree on the left side of the Visual Composer displays all assets
that are within the scope of the current Worksheet. Each asset type is
shown with a different icon.

Assets listed under the ‘Global Worksheet’ folder are accessible to all
Worksheets, while assets listed under the ‘User Worksheet’ folder are
accessible only to the user who originally saved those assets. (See
Controlling Access to an Asset for information about setting access scope.)

You can use assets in both reports and Viewsheets, as well as in other
Worksheets. This section explains the various methods of using assets.

2.1.1 Using a Data Block

You can use a data block from the Asset tree in a Viewsheet, report, or
within another Worksheet.

Using a Data Block in a Viewsheet

A Viewsheet can be based on a Worksheet. The Viewsheet will have
access to all of the data blocks its underlying Worksheet, regardless of
whether the data blocks are marked as Primary. 

In Style Scope Agile Edition, see Creating a New Dashboard.

ASSET DESCRIPTION

Data Block An data table (array) of data drawn from a data 
source.

Named Grouping A reusable classification (grouping) structure.
Variable A reusable interface for acquiring user input.

Data Block

Named Group

Variable
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To create a new Viewsheet based on an existing Worksheet, follow these
steps:

In Style Scope Agile
Edition, press the
‘New Dashboard’ but-
ton.

1. Press the ‘New Viewsheet’ button in the Visual Composer toolbar.
This opens the ‘New Viewsheet’ dialog box.

2. In the ‘New Viewsheet’ dialog box, expand the ‘Global
Worksheet’ or ‘User Worksheet’ folders, and select the Worksheet
on which the Viewsheet should be based.

3. Click ‘OK’ to close the dialog box and open the new Viewsheet.

Alternatively, right-click the desired Worksheet in the Asset tree, and
select ‘New Viewsheet’ from the context menu. 

To see which data blocks of the Worksheet are accessible to an existing
Viewsheet, follow these steps:

1. Open the Viewsheet in Visual Composer. 

2. Expand the top node in the ‘Component’ tree. (This node has the
same name as the underlying Worksheet). 



DATA MASHUP

179 of 1397

The top node lists all of the data blocks in the underlying Worksheet.
Although you can insert these data blocks directly into the Viewsheet, it is
more typical to bind the data blocks to Viewsheet input and output controls
that provide visualization and exploration capabilities. 

For more information on using Worksheet data within a Viewsheet, see
Advanced Dashboard Design.

Using a Data Block in a Report

This feature is not available in Style Scope Agile Edition.

To use a Worksheet data block in a report, follow the steps below. 

1. Press the ‘Options’ button in the Worksheet toolbar, and verify that
‘As data source to reports’ is enabled. This makes the Worksheet
visible for data binding in reports. 

2. In Style Studio, open the report template in which you want to
access the Worksheet data block.
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3. Open the ‘Data Binding’ dialog box for the report element (Table,
Chart, Section, etc.) that you want to bind to the Worksheet data
block. (See Data Binding, in Advanced Report Design for
information.)

4. In the Data tab of the ‘Data Binding’ dialog box, expand the
‘Worksheet’ node on the tree. 

The ‘Worksheet’ node shows data blocks belonging to the ‘Global’
and ‘Report’ scopes of the asset repository. Data blocks belonging
‘User’ scope are not available for binding. 

5. Select the desired data block, and proceed with the data binding.

Note that only the data block marked as ‘Primary’ in a Worksheet is
displayed under the ‘Worksheet’ node of the ‘Data Binding’ window. 

See Also
Data Binding, in Advanced Report Design, for details about binding.
Setting Asset Scope, for information about the different Worksheet scopes.
Setting an Asset as Primary, for details on making a data block the Primary
asset.
Setting Global Worksheet Options, to make Worksheets accessible to
reports.

Using a Data Block within a Worksheet

To use a data block from the Asset tree in a Worksheet, follow these steps: 

1. Open the Worksheet in which you want to use the data block.

2. Drag the data block from the Asset tree into the Worksheet. 
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This adds the data block to the Worksheet as a new data block.
Note that only the Primary data block of the Worksheet in the
Repository is added to the new Worksheet. 

3. Rename the new table as desired. 

The new data block remains linked to the original Worksheet, and columns
of the new table can therefore not be deleted. If ‘Auto Update’ is set on the
new table, changes made to the original table will automatically propagate
to the new table. 

See Also
Setting an Asset as Primary, for information on exposing a Worksheet
asset.
Renaming an Asset in the Worksheet, for information on changing a table
name.
Automatically Updating an Asset, to set updating for linked assets.

Example: Using 
a Data Block

The sample ‘ProductSales’ Worksheet contains a joined table,
‘LimitedProducts’, that returns products in a particular price range. To use
this data block within another Worksheet, follow the steps below:

This Worksheet can
be found in the ‘Tuto-
rial’ folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Open the ‘ProductSales’ Worksheet in Visual Composer.

For information on how to open a Data Worksheet, see Editing a
Data Worksheet in Visual Composer (Style Scope or Style
Intelligence) or Editing a Data Set (Style Scope Agile Edition).

2. Right-click the ‘LimitedProducts’ data block, and select ‘Set as
Primary’ from the context menu. This makes the ‘LimitedProducts’
data block visible to other Worksheets.
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3. Save the ‘ProductSales’ Worksheet.

4. Create a new Data Worksheet.

5. Select the ‘ProductSales’ Worksheet in the ‘Global Worksheet’
tree, and drag it onto one of the empty cells in the new Worksheet.
This adds the ‘LimitedProducts’ data block to the new Worksheet,
and renames it to ‘LimitedProducts1’.

You can use the ‘LimitedProducts1’ data block in the new Worksheet in
the same way as any other data block.

¢

2.1.2 Using a Named Grouping

To use a Named Grouping from the asset repository in a Worksheet table,
follow these steps:

1. Drag the Named Grouping from the Asset tree into the Worksheet
where it will be used.
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2. Select the Named Grouping from the grouping options in the
‘Group and Aggregate’ dialog box. 

To use a Named Grouping from the asset repository in the data binding
grouping of a Report, select the Named Grouping from the ‘Predefined
Named Group’ menu. 

See Also
Grouping and Aggregating Data for information about the ‘Group and
Aggregate’ dialog box.
Data Binding, in Advanced Report Design, to bind report elements.
Creating a Named Grouping, to create Named Groups.

2.1.3 Using a Variable

You can use a Variable from the asset repository in the filtering condition
of a Worksheet data block or Named Grouping. Follow these steps:

1. Drag the Variable from the Asset tree into the Worksheet where it
will be used.

2. Open the ‘Conditions’ dialog box for the table or Named Grouping. 

3. Select the ‘Variable’ option, and choose the desired Variable from
the menu. 

When you bind a Variable to a table in a Worksheet (either directly through
the table’s filtering condition, or indirectly through a Named Group that is
linked to the table), a user will be prompted to supply the Variable value
when they do one of the following things:

• Open the Worksheet in Visual Composer or Style Studio

• Save the Worksheet in Visual Composer or Style Studio

• Click the ‘Enter Parameters’ button in the Worksheet toolbar

• Open or preview a Viewsheet linked to the Worksheet (only if 
Viewsheet’s ‘Disable Prompt Parameter’ option is deselected, and no 
default is specified for the Variable)

• Open or preview a report that uses the table linked to the Variable

See Also
Filtering, for details on setting conditions.
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Setting Dashboard Options, in Advanced Dashboard Design, to enable
Viewsheet prompting.
Creating a Named Grouping, for details on Named Groups.

Example: Using 
a Variable

This example continues the example in Defining a Variable. Assume you
have a table listing order data for all states, but you are interested in
working with the data for only one particular state at a time. To do this, you
will add a filtering condition on the ‘State’ field of the table based on the
‘State’ Variable. You will use the existing ‘State’ Variable from the asset
repository. (See Defining a Variable for instructions on how to create this
Variable).

1. Create a new Worksheet.

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

2. From the Asset panel, drag the ‘Sales Explore’ Worksheet onto an
empty cell on the Worksheet. This creates the data block ‘Sales1’. 

The Variable name is
shown in italics to
indicate that the asset
is referenced from
another Worksheet.

3. From the Asset panel, drag the ‘State’ Variable onto an empty cell
in the Worksheet. This imports the variable into the Worksheet as
‘state1.’

4. Press the ‘Define Condition’ button in the title bar of the ‘Sales1’
data block to open the ‘Condition’ dialog box. 

5. Press the ‘More’ button to add a new condition.

6. Select ‘State’ from the fields drop-down list.

7. Select “is equal to” as the condition operator.

8. In the right-side pop-up menu select ‘Variable.
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9. From the ‘Name’ menu, select ‘state’.

10. Press ‘OK’.

11. You will be prompted for the value of the ‘state’ Variable. Enter
“FL” and press ‘OK’.

12. Preview the table (see Previewing a Data Block), and note that
only the sales for the state of Florida are now shown.
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2.2 Saving an Asset
There are two ways to save an asset: Save the Worksheet as a whole, or
drag the individual asset to the repository. The following sections explain
the two methods.

2.2.1 Saving an Asset by Saving the Worksheet

To save an asset (e.g., Variable) to the asset repository, follow these steps:

1. Mark the asset as Primary. 

2. Save the Worksheet containing the asset.

The asset marked as Primary determines the appearance of the saved
Worksheet in the Repository, and how it can be used. 

See Also
Setting an Asset as Primary, for details on marking the Primary asset.
Saving a Data Worksheet, for details on saving the current Worksheet.
Using an Asset for more information on asset appearance and usage.

2.2.2 Saving an Asset by Dragging to the Repository

To save an asset (e.g., Variable) to the asset repository, follow these steps: 

1. Click the small icon in the top-left corner of the asset title bar.
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2. Drag the icon over a Global Worksheet or User Worksheet folder,
and release. This opens the ‘Enter Asset Name’ dialog box.

3. In the ‘Enter Asset Name’ dialog box, enter the name under which
the asset should appear in the Repository, and click ‘OK’.

The asset is added to the repository in the desired folder under the specified
name. See Using an Asset for information about how assets can be used in
Worksheets.

2.2.3 Deploying an Asset

In Style Studio, you can easily deploy an asset to a repository other than the
working repository (i.e., a remote repository) or to a JAR file for later use.
See Deploying an Asset for more information.

2.3 Renaming an Asset
You can rename an asset inside the Worksheet that contains it. You can
also rename an entire Worksheet in the Asset panel.

2.3.1 Renaming an Asset in the Worksheet

To change the name of a table or other asset (Variable, Named Group, etc.)
in a Worksheet, follow these steps:

1. Right-click the asset title row, and select ‘Properties’ from the
context menu.

2. In the ‘Table Properties’ dialog box, edit the ‘Name’ field and click
‘OK’.

All of the assets in a given Worksheet must have unique names.
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2.3.2 Renaming an Asset in the Asset Repository

To change the name of a Worksheet in the asset repository, follow these
steps:

1. Right-click the asset in the Repository, and select ‘Rename’ from
the context menu.

2. Type the desired name for the asset in the provided field. 

3. Click away to save the change. 

2.4 Deleting an Asset 
You can delete an asset inside the Worksheet that contains it. You can also
delete an entire Worksheet in the asset repository.

2.4.1 Deleting an Asset in the Worksheet

To delete a table or other Worksheet asset, follow these steps:

1. Click the asset title bar to select the asset.

2. Right-click the asset title bar to open the context menu.

3. Select ‘Remove’ from the context menu.
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Alternatively, press the ‘Delete’ key on the keyboard to remove the
assembly.

2.4.2 Deleting an Asset in the Asset Repository

To delete an asset in the asset repository, do one of the following things:

Note: If an asset is used by other reports, the asset cannot be
deleted.

• Select the asset name from the tree and press the Delete key on the 
keyboard.

• Right-click on the asset name in the tree and select the ‘Remove’ option.

For Style Scope Agile Edition, see also Deleting an Asset.

2.5 Editing a Non-Tabular Asset
To modify a non-tabular asset (Named Grouping or Variable), right-click
the asset title bar, and select ‘Properties’ from the context menu. See
Creating Non-Tabular Assets for full details about asset properties.

2.6 Setting an Asset as Primary
To mark an asset as the Primary asset, right-click on the asset’s title row,
and select ‘Set as Primary’ from the context menu. The Primary asset is
displayed with a bold title.

The Primary asset is the “main result” of the Worksheet. It is this Primary
asset that you will access from within reports or other Worksheets. 
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When you save a Worksheet, the Primary asset determines the appearance
of the Worksheet in the Asset panel, and how the Worksheet can be used.
See Using an Asset for more information about accessing Worksheet
assets.

2.7 Automatically Updating an Asset
When you drag an asset from the Asset panel into a Worksheet, the
imported asset is a copy that remains linked to its own defining Worksheet.
When you make changes to the original asset, the changes are propagated
to all linked copies. This default behavior is called “Auto Update.”

• To disable Auto Update, click the ‘Disable Auto Update’ button in the 
asset title bar.

• To re-enable Auto Update, click the ‘Enable Auto Update’ button in the 
asset title bar.

2.8 Controlling Access to an Asset
Assets can be assigned a specific scope, which determines their
accessibility to different users. 

2.8.1 Setting Asset Scope
Style Scope Agile Edition only supports global scope.

Assets can be stored under one of the following three scopes:

• Global scope: Assets saved under the Global scope are available to all 
of the users and reports in the system.

• User scope: Assets saved under the User scope can be accessed only by 
the reports and Data Worksheets that share the same user scope. User 
scope is only available in Visual Composer.

• Report scope: Assets saved under Report scope can be accessed only 
by the associated report. See Editing a Data Worksheet in Style Studio 
for details.

In the Global scope only, assets can be further organized into domains, for
example: 
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  – Shared assets
  – Sales domain
  – Marketing domain 
  – R&D domain
  – Support domain
  – Financial domain

Each domain can be assigned different access rights. See Component/
Object Permissions in the Advanced Server Administration for more
information on setting Global security for Worksheets.

2.8.2 Changing Asset Scope
Style Scope Agile Edition only supports global scope.

To change the scope of an asset in the Asset panel tree, drag it to the branch
of the tree that corresponds to the desired scope. The following rules apply:

• The user should have write permission to the target scope.

• If an asset is used in a report that is not owned by the current user, it 
cannot be moved to the User or Report scope.

• If an asset is used in more than one report, it cannot be moved to the 
Report scope.

Note that Report scope is only available in Style Studio, and User scope is
only available in Visual Composer.
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3 Creating a Data Block

You can combine data from multiple queries and different data sources into
a data block, producing a single dataset that contains meaningful and useful
information. Tables have many different roles; see Using a Data Block for
more information.

Many data block operations create and maintain links between the
component data blocks, conditions, expressions, etc. These links are
displayed graphically by dashed lines connecting the assets. When the
configuration or value of a linked asset is changed, the impact of the
change propagates to all its dependent components. This dynamic data
updating makes it easy to explore the data and to perform cause and effect
analysis.

3.1 Creating a Regular Data Block
This section discusses the various ways to create a regular data block.

3.1.1 Creating a Data Block from a New Query

To create a data block by defining a new query, follow the steps below:

1. Press the ‘New Object’ button in the toolbar and select ‘Database
Query’.

This opens the ‘Database Query’ dialog box.

2. In the ‘Select a Data Source’ menu, choose the database that you
want to supply data to the data set.
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3. Select the database fields that you want to retrieve by dragging
them from the left panel into the ‘Columns’ area.

4. Define any required joins. To do this, follow the steps below:

a. Press the ‘New’ button next to the ‘Joins’ area to open the ‘Add
Join’ dialog box.

b. Select a table from the top-left menu, and select the join field for
that table from the bottom-left menu. Select a table from the
top-right menu, and select the join field for that table from the
bottom-right menu. From the center menu, select the join
operator (equi-join or inequality join). 
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For full information
about specifying
joins, see Changing
the Join Type.

c. (Optional) Select the ‘All’ option on the left side to retain all
records from the left table, even those for which there is no
match in the right table (left outer join). Select the ‘All’ option
on the right side to retain all records from the right table, even
those for which there is no match in the left table (right outer
join). Select both ‘All’ options to retain all rows from both
tables (full outer join).

d. Press ‘OK’ to add the join. The join is now displayed in the
‘Joins’ area.

e. To add an additional join, press the ‘New’ button again to open
the ‘Add Join’ dialog box. Repeat as necessary to add all desired
joins.

f. To change an existing join, press the ‘Edit’ button next to the
join.
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g. To delete an existing join, press the ‘Delete’ button next to the
join.

For full information
about specifying con-
ditions, see Filtering.

5. (Optional) Press the ‘Edit’ button next to the ‘Conditions’ area to
open the ‘Conditions’ dialog box. Use the menus to enter a desired
filter condition and press ‘Insert’. Then press ‘OK’.

Note: If you make manual edits to the SQL string, you will no
longer be able to modify the query using the 'Columns', 'Joins',
and 'Conditions' panels.

6. (Optional) To make manual edits to the SQL string that will be sent
to the database, press the ‘Edit’ button next to the ‘SQL’ area to
open the ‘SQL’ panel for editing. Make the desired edits.
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7. Press ‘OK’ to close the ‘Database Query’ dialog box. This creates a
new data block based on the specified query.

8. To edit the query further, press the ‘Edit Query’ button in the title
bar. This reopens the ‘Database Query’ dialog box.

3.1.2 Creating a Data Block from an Existing Query or Data 
Model
Style Scope Agile Edition does not support data models. See
Creating a Data Set from Database Query for information on how to
create a data block from a query.

To create a regular data block from a query or data model, drag one of the
following assets from the Asset tree into the Worksheet:

• Query

• Query column
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• Data model entity

• Data model attribute

This creates a new data block in the Worksheet. If you drag a query column
or a data model attribute into the Worksheet, then a table with just one
column is created. If you drag a full query or a data model entity to the
Worksheet, then a table is created which contains all the columns in the
selected query or all the attributes in the selected entity.

The new data block displays a single data row containing the table’s
metadata, a representation of the table column’s contents (e.g., “XXXX”
for text, “9999” for integer, etc.). To view the table data, see Showing Live
Data in a Table and Previewing a Data Block.

Example: 
Creating a Data 
Block from a 
Query

Assume that you want to create a table for the ‘sales by state’ query from
the ‘Orders’ data source. Follow the steps below.

1. Create a new Worksheet by pressing the ‘New Worksheet’ button.

For Style Scope Agile Edition, see Creating a Data Set from
Database Query for information on how to create a data block from a
query.

2. In the Asset panel, expand the ‘Data Source’ node, the ‘Orders’
node, and the ‘Sample Queries’ node.

3. Drag the ‘sales by state’ query from the tree to an empty cell in the
Worksheet. A new table named ‘sales by state1’ is created with two
columns, ‘State’ and ‘Sales’.



DATA MASHUP

198 of 1397

4. Right-click on the table title row and select ‘Preview’ from the
context menu.

¢

3.1.3 Creating a Data Block from Database Tables
To create a data block in Style Scope Agile Edition, see Creating a
Data Set by Mash-Up.

In most cases, you should access data from a relational database only via
queries and data models. (See Advanced Data Modeling for information on
creating queries and data models.) However, you can also directly access
the underlying database tables. 

Note: Whenever possible, use queries or data models to create
Worksheet assets. Only use database tables directly if this is
absolutely necessary.

To create a Worksheet table or column directly from a database table,
follow these steps:

1. Expand the ‘TABLE’ folder under the desired data source in the
Asset panel. The database tables are listed in the tree. 
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If the ‘TABLE’ folder is empty or nonexistent, your administrator
may have disabled the listing of the physical fields. If the ‘TABLE’
folder does not reflect recent changes to the database schema, your
administrator may need to refresh the metadata. See Specifying
Data Source Information in Advanced Server Administration.

2. Drag and drop a table or table column into the Worksheet. (This is
the same as adding a query or query column to the Worksheet. See
Creating a Regular Data Block and Adding a Table Column for
details.)

3.1.4 Creating a Data Block from Existing Table Columns

You can create a new data block by copying the columns of an existing
regular data block. Follow the steps below:

1. Select the columns to copy. (Ctrl-click the header cells to select
multiple columns. Continue holding the Ctrl key after selecting the
last column.)

2. While still holding down the Ctrl key, drag the selected columns
out of the table and drop them into an empty Worksheet cell.

This creates a new table containing just the selected columns. The order of
the columns is the order in which they were selected.

To add columns to an existing table, see Adding a Table Column. To copy
an entire table, see Copying a Table.

3.2 Creating an Embedded Table
Instead of creating a regular table from a query or data model, you can
create a data block by manually typing values into the Worksheet. Such a
table is called an Embedded Table. 

There are three ways to generate an embedded table:

• Create a new embedded table using the ‘Embedded Table’ option in the 
‘New Object’ menu.

• Upload data from a file into a new embedded table.

• Convert a regular data block into an embedded table.

After you generate an embedded table, you can use it in the same way as a
regular data block. Embedded tables also provide a means for Viewsheets
to filter the data returned by Worksheet queries, enabling straightforward
what-if analysis. 
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See Also
Creating a Regular Data Block, to create a table from a query or data
model.
What-If Analysis, to use embedded tables in exploratory analysis.
Using Form Components, in Advanced Dashboard Design, for information
on the embedded table interface to Viewsheets.

3.2.1 Creating a New Embedded Table

To create a new embedded table, follow the steps below:

1. Press the ‘New Object’ button, and select ‘Embedded Table’. 

The cursor changes to a crosshairs.

2. Click and drag the cursor across the cells that you want to compose
the table. The cells are highlighted as you drag across them.

When you release the cursor, the highlighted cells are converted
into an embedded table. The top row of cells becomes the title row
of the table, the second-to-top row becomes the column header row
of the table, and any remaining rows of highlighted cells become
the data rows of the table.

3. To edit a column header, double-click on the header and enter the
desired text.

4. To edit a data cell, click in the cell and enter text directly. You can
enter both numeric and non-numeric values. (See Changing the
Column Type in an Embedded Table.)

Example: 
Creating a New 
Embedded Table

Assume that you want to create a table of values to be used in a formula for
some other table on the Worksheet. (Refer to What-If Analysis for such an
application of the embedded table.) In the following example you will
create an embedded table with three rows and three columns of data.
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If you are using Style Scope Agile Edition, see Creating a Data Set
by Mash-Up to create a new Worksheet.

1. Create a new Worksheet by pressing the ‘New Worksheet’ button.

2. Press the ‘New Object’ button, and select ‘Embedded Table’. The
cursor changes to a crosshairs.

3. Drag across the Worksheet to highlight five rows and three
columns. When you release the mouse, the selected range of the
empty grid cells becomes part of the new table called ‘Query1’; the
first row of the selected range becomes the header row, and the
second row becomes the column header row.

4. All the cells of this newly created table are editable. Double-click
on the ‘col0’ header cell. The cell switches to editing mode, and
you can now type in the cell to change the text.

5. Change the column names for ‘col0’, ‘col1’ and ‘col2’ to ‘A’, ‘B’
and ‘C’, respectively.

6. Enter any numeric values in the nine data cells. Note that both
numeric and non-numeric values can be entered in the table.

¢

See Also
Adding or Removing a Row from an Embedded Table, to change the table
length.

3.2.2 Converting a Regular Table to an Embedded Table

To convert a regular data block to an embedded table, follow these steps:

1. In the table title bar, click the ‘Change View’ button. Select ‘Live
Preview’ from the menu. This will populate the table with data.

2. Right-click the title bar of the table, and select ‘Convert to
embedded Table’. 
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This creates a new table with the name of ‘Query’. Once the table is
converted into an embedded table, it cannot be reverted back to a regular
table.

Example: 
Converting to an 
Embedded Table

In the following example, the ‘Sales’ data block of the ‘Sales Explore’
Worksheet is converted to an editable embedded table.

If you are using Style Scope Agile Edition, see Creating a Data Set
by Mash-Up to create a new Worksheet.

1. Create a new Worksheet by pressing the ‘New Worksheet’ button.

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

2. From the Asset panel, drag the ‘Sales Explore’ Worksheet onto an
empty cell on the Worksheet. This creates the data block ‘Sales1’. 

3. Expand the table vertically so that more rows are visible.

4. Press the ‘Change View’ button in the table title bar, and select
‘Live Preview’ from the menu.
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5. Right-click on the title row and select ‘Convert to Embedded
Table’. 

A new table will be created with name ‘Query1’. Expand the num-
ber of rows so that all rows are visible.

6. Click on any of the cells of the ‘Query1’ table. Notice that all of the
cells in this table are editable.

¢
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3.2.3 Importing Data Into an Embedded Table

If you have created a new blank Worksheet, press the ‘Upload File’ button
in the center of the Worksheet to upload text or Excel data into an
embedded table.

This opens the ‘Import Data File’ dialog box. For information about using
this dialog box, see below.

The ‘Upload File’
button is only avail-
able when the Work-
sheet is first created.

If you do not see the ‘Upload File’ button in the center of the Worksheet,
follow the steps below to upload data from a text or Excel file into an
embedded table:

1. Create a new embedded table (see Creating a New Embedded
Table), or select an existing embedded table. Note that any existing
data and column names in the embedded table will be overwritten
by the imported data.

2. Press the ‘Import Data File’ button in the title bar of the embedded
table.

This opens the ‘Import Data File’ dialog box.
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3. Click ‘Select File’, and choose the desired text file. (By default,
only files with the extension “.csv” are shown. To view all file
types, enter “*.*” in the ‘File Name’ field, and press Enter.)

4. From the ‘Encoding’ menu, select the encoding of the text file. 

5. In the ‘Delimiter’ field, enter the character that is used in the text
file to separate entries. The default delimiter character is a comma.
For tab-delimited files, select the ‘Tab’ option.

6. Adjust any of the following optional settings to modify the way the
file data is interpreted:

a. Select ‘First Row as Header (Regular Table)’ to use the entries
in the first row of the text file as the column header text.
Otherwise, default column names are used (“col0,” “col1,” etc.).

You can only unpivot
a crosstab that has a
single level of col-
umn headers.

b. (Optional) Select ‘Unpivot Data (Crosstab Table)’ if the data in
the file is in crosstab table form, and you wish to convert the
crosstab table into a regular table within the Worksheet. This
option will convert the column header row into a “dimension”
column and convert the crosstab cells into a “measure” column.
If the crosstab table in the file contains multiple levels of row
headers, enter the number of levels in the ‘Header Columns’
field.

c. (Optional) Select ‘Remove Quotation Marks’ to strip quotation
marks out of the text file upon import.

The delimited text is imported into the embedded table, and the table
resizes itself to the correct number of columns. 
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See Also
Unpivoting a Table, to unpivot an arbitrary Worksheet crosstab.
Creating a New Embedded Table, for instructions on adding a new table.
Text Data Source, in Advanced Data Modeling, for more extensive text
capabilities.

3.3 Adding a Table Column
You can expand an existing table in the Data Worksheet by adding
additional columns. This allows you to gather data from multiple entities
into a single table. You can also create new columns that contain complex
calculations. 

This section discusses various methods for adding table columns.

3.3.1 Adding a Column to a Regular Table

To add a new column to a regular table in the Worksheet (from the same
query or data model), follow these steps:

1. In the Asset tree, select the query column or a model attribute that
you want to add to the existing table.

2. Drag the query column or model attribute over the column header
row in the existing table. (A green bar shows the location in the
table where the new column will be placed.)

3. Drop the column into the table at the desired location.

See Also
Joining Tables, to integrate columns from different queries or models. 

Example: 
Adding a Column 
to a Regular 
Table

In the following example, you will add a single attribute (salesperson last
name) as a new column in an existing table.

Style Scope Agile Edition does not support data models.

1. Drag the ‘Order Model’ > ‘Order’ entity to an empty cell on the
Worksheet. This creates a new ‘Order1’ table.

2. Drag the ‘Last Name’ attribute from ‘Order Model’ >
‘Salesperson’ entity over any column header in the existing
‘Order1’ table. (A green bar indicates where the new column will
be placed.)
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3. Release the mouse button when the green bar appears in the
location you wish to place the new column. The column is then
added to the table.

¢

3.3.2 Adding a Column to an Embedded Table

To add a new column to an embedded table, right-click a column header.
Choose ‘Insert Column’ to insert a blank column to the left of the column
you clicked, or choose ‘Append Column’ to append a blank column to the
right of the column you clicked. All cells in the new column can be edited.

See Also
Adding or Removing a Row from an Embedded Table, to change the table
length.

3.3.3 Adding or Removing a Row from an Embedded Table

To add a new row to an embedded table, follow these steps: 

1. Deselect the table. (Click the Viewsheet grid away from the table.)

2. Right-click a table row, and choose ‘Insert Row’ or ‘Append Row’
from the context menu. This inserts a blank row above the row you
clicked or appends a blank row below the row you clicked,
respectively.

To remove an existing row from an embedded table, follow these steps: 

1. Deselect the table. (Click the Viewsheet grid away from the table.)

2. Right-click on the table row you want to delete, and choose
‘Remove Row’ from the context menu. This removes the row you
clicked, and shifts subsequent rows upward in the table.

3.3.4 Creating an Expression/Formula Column

An expression column, or formula column, is a column whose data is
generated from a script (expression) by processing existing data in the
table. The expression can use either SQL or JavaScript syntax, and can
reference any other columns within the data block. 
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To add an expression column to a table, follow these steps:

1. Click the ‘Expression’ button (labeled ‘fx’) located in the title row
of the data block. This opens the ‘Expression’ dialog box.

2. Enter a name for the new column in the dialog box, and click ‘OK’.

This adds the formula column to the right side of the table, and
opens the Formula Editor.

3. In the Formula Editor, click the ‘SQL’ button to enter an
expression using SQL syntax, or press the ‘Script’ button to enter
an expression using JavaScript syntax. Select the appropriate data
type from the ‘Return Data Type’ menu.

4. Enter the desired formula expression in the bottom text field. 

JavaScript expression columns can make full use of the built-in
scripting functions in the script library. You can reference the value
of a Viewsheet input component, Viewsheet parameter, report
parameter, or Worksheet variable by using the component name or
variable name as a parameter. For example, if a Viewsheet input
control has name ‘RadioButton1’, you can reference the input’s
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value within a Worksheet expression by using syntax “parame-
ter.RadioButton1”.

See Form Components in Advanced Dashboard Design for more
information.

5. Click ‘OK’ to exit the Formula Editor. The data in the new column
will reflect the results of the specified expression. 

Example: 
Creating an 
Expression 
Column

Use the data in the sample ‘Sales Explore’ Worksheet to compute the
revenue for each sale:

If you are using Style Scope Agile Edition, see Creating a Data Set
by Mash-Up to create a new Worksheet.

1. Create a new Worksheet by pressing the ‘New Worksheet’ button.

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

2. From the Asset panel, drag the ‘Sales Explore’ Worksheet onto an
empty cell on the Worksheet. This creates the data block ‘Sales1’. 

3. Press the ‘Expression’ button in the title bar of the ‘Sales1’ data
block. This opens the ‘Expression’ dialog box.

4. Enter “Revenue” as the name of the new expression column.

5. Press ‘OK’. This appends a new ‘Revenue’ column to the right side
of the data block, and opens the Formula Editor.

6. In the ‘Return Data Type’ menu, select the ‘Float’ option.

7. Enter the following formula in the text area and press ‘OK’:

You can click on a
field name in the left
panel to add it to the
expression area.

field['Total'] * (1-field['Discounts']);
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Refer to
Appendix B:Accessin
g Table Cells in Script
for information on
how to reference the
current table cell, row,
and column in the
expressions. 

8. (Optional) To edit the expression again at a later time, click the ‘fx’
button in the expression column header (not the table title bar). This
reopens the Formula Editor.

9. Preview the ‘Sales1’ data block and note the new ‘Revenue’
column.

¢

See Also
Editing an Expression Column, to modify the formula of an expression
column.
Appendix B:Accessing Table Cells in Script, to reference table data in
expressions. 
Appendix JS:General JavaScript Functions, for further information. 

3.3.5 Automatically Substituting JavaScript For SQL

There are certain conditions that may prevent a SQL expression from being
executed properly (for example, if your particular database does not honor
the data block ‘Maximum Rows’ setting or the administrative ‘Query
Maximum Row Count’ setting). To prevent the expression script from
failing in such cases, you can provide a fall-back JavaScript expression to
be evaluated when the SQL script cannot be executed. 
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To include a fall-back JavaScript expression, simply enclose the desired
JavaScript expression within /*script [...] script*/ tags. For example: 

CASE WHEN field['Returns.Return Total'] IS NULL THEN 
field['Orders.Order Total']
ELSE field['Orders.Order Total']-field['Returns.Return 
Total']
END

/*script
if(field['Returns.Return Total'] == null) {

field['Orders.Order Total']
}
else {

field['Orders.Order Total']-field['Returns.Return 
Total']
}
script*/

In this case, the JavaScript version of the expression within the /*script
[...] script*/ tags will be executed only if the SQL version cannot be
executed.

3.3.6 Creating a Numeric Range Column (Binning)

A numeric range column groups numeric data into a predefined set of bins
or ranges, for example: 

  – Less than 5
  – 5 to 10
  – 10 to 15
  – 15 to 20
  – Greater than 20

You can create a range column for any numeric column in a data block. To
create a range column, follow these steps:

1. Right-click the header of the column for which you want to create a
range column, and select the ‘New Range Column’ option from the
context menu. This opens the ‘Range Name’ dialog box

2. Enter a name for the new range column, and click ‘OK’. This
opens the ‘Numeric Range Option’ dialog box. Here you can
specify the different benchmarks defining the range. 
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To customize a bench-
mark label, double-
click the benchmark
value. to enable edit-
ing.

3. Enter a benchmark value into the ‘Value Range’ field, and click the
‘Add’ button. Repeat until all desired benchmarks have been
entered.

4. Select the ‘Less Than Min’ checkbox to create a bin for all values
that fall below the minimum benchmark. If you do not select this
option, those values are classified as “Others.”

5. Select the ‘Greater Than Max’ checkbox to create a bin for all
values that fall above the maximum benchmark. If you do not
select this option, those values are classified as “Others.”

6. Press ‘OK’ to close the dialog box.

Example: 
Creating a 
Numeric Range 
Column

Consider the sample ‘ProductSales’ Worksheet, which contains a data
block ‘SalesByDate’ that returns month-by-month sales. You can define a
range column for the ‘Total’ field that places each amount into a predefined
range or bin.

This Worksheet can
be found in the ‘Tuto-
rial’ folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

1. Open the ‘ProductSales’ Worksheet in Visual Composer.

For information on how to open a Data Worksheet, see Editing a
Data Worksheet in Visual Composer (Style Scope or Style
Intelligence) or Editing a Data Set (Style Scope Agile Edition).

2. Right-click the ‘SalesByDate’ data block and select ‘Set as
Primary’ from the context menu. This makes the ‘SalesByDate’
data block visible to other Worksheets.

3. Save the ‘ProductSales’ Worksheet.

4. Create a new Worksheet.
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5. Select the ‘ProductSales’ Worksheet in the Asset tree, and drag it
onto one of the empty cells in the new Worksheet. This adds the
‘SalesByDate’ data block to the new Worksheet, and renames it to
‘SalesByDate1’.

6. Right-click the ‘Total’ column, and select the ‘New Range
Column’ option. This opens the ‘Range Name’ dialog box.

7. Enter the name “Revenue Range” and press ‘OK’. This creates the
new column and opens the ‘Numeric Range Option’ dialog box,
which allows you to specify the desired thresholds. 

 

8. Deselect the ‘Less Than Min’ and ‘Greater Than Max’ options.

9. Enter the first threshold, 0, into the ‘Value Range’ field and press
‘Add’.

10. Enter the next three thresholds, pressing ‘Add’ after each one:
10000, 50000, 100000. 
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This creates the three ranges: (1) 0-10,000, (2) 10,000-50,000, and
(3) 50,000-100,000.

11. Double-click the ‘0-10,000’ label and enter the new label “Low”.

12. Repeat the above step to relabel the 10,000-50,000 range as
“Medium” and the 50,000-100,000 range as “High”.

13. Press ‘OK’ to close the dialog box.

14. Preview the data block. Note that each cell in the ‘Total’ column
has a corresponding range in the ‘Revenue Range’ column. The
values that lie outside the specified ranges are labeled ‘Others’.
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15. (Optional) Instead of defining a fixed minimum and maximum
value (750,000-10,000,000), you can keep the numeric range open-
ended. Follow the steps below:

a. Open the ‘Numeric Range Option’ dialog box by pressing the
range button in the column header (see Editing a Range
Column). 

b. Select the ‘Greater than Max’ option, and press ‘OK’.
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c. Preview the data block and note that the values outside the
specified range (formerly labelled ‘Others’) are now labelled
‘>100000’.

¢

See Also
Creating a Named Grouping, for another way of partitioning column data. 
Creating a Date Range Column for partitioning date information. 

3.3.7 Creating a Date Range Column

A date range column groups dates into a fixed set of date bins. You can
create a range column for any date column in a data block. 

To create a range column, follow these steps:

1. Right-click the header of the column for which you want to create a
range column, and select the ‘New Range Column’ option from the
context menu. This opens the ‘Date Range Name’ dialog box.

2. Enter a name for the new column in the ‘Date Range Name’ dialog
box, and press ‘OK’. This opens the ‘Date Range Option’ dialog
box.

3. Select the desired partitioning (year, month, quarter, etc.), and press
‘OK’.

See Creating a Numeric Range Column (Binning) for doing a similar
partitioning on numeric columns.

Available Date Ranges

There are five date ranges available for the date range column:

• ‘Year’: A number in the range 0000-9999

• ‘Quarter’: A number in the range 1-4
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• ‘Month’: A number in the range 0-11

• ‘Day of Week’: A number in the range 1-7

• ‘Day of Month’: A number in the range 1-31

3.4 Editing a Data Block Column
This section describes various ways to change the column properties of a
table. Column sorting options are discussed in the Sorting section of
Manipulating Tabular Data.

3.4.1 Renaming a Column
Warning: If there is a Viewsheet that uses on this Worksheet
column, renaming the column will cause the Viewsheet to lose its
reference. 

To change a column name, double-click the column header and enter the
desired text.

3.4.2 Reordering a Column

To change the position of a column, click on the column header cell, and
drag the column to the desired location in the table. A green bar shows the
location where the column will be inserted.

In the figure below, the ‘Order Date’ column is positioned between the
‘Discount’ and ‘Paid’ columns.

3.4.3 Showing and Hiding a Column

To change the visibility of a column (show or hide), click the ‘visibility’
button next to the column name in the column header cell. 

In the figure below, the ‘Order Date’ column is hidden.

To show all data block columns, right-click on any column header and
choose ‘Show All Columns’ from the context menu.
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3.4.4 Changing the Column Type in an Embedded Table

By default, all manually created columns in an embedded table are of type
‘String’. To change the type of an embedded table column, follow these
steps:

1. Right-click the column header, and select ‘Column Type’ from the
context menu. This opens the ‘Column Type’ dialog box.

2. Select the desired data type from the ‘Type’ menu. If you select a
numeric or date type, a secondary ‘Parse Format’ menu appears
below.

This allows the
Embedded Table to
convert the data to a
standard representa-
tion.

3. (Optional) In the ‘Parse Format’ menu, select the format in which
you have entered your data. For example, if you have entered dates
in the form “1/13/1995,” select or type “MM/d/yyyy” as the parse
format. 

4. Click ‘OK’ to close the ‘Column Type’ dialog box.

After you have specified a data type for a column of an Embedded Table,
any additional data you enter into the column must match this specified
type.

Example: 
Changing the 
Column Type

In the following example, you will change the data type of an embedded
table column from ‘String’ to ‘Integer’:

1. Create a new Worksheet.

2. Create a new embedded table with four rows and four columns.
See Creating an Embedded Table for instructions on how to create
an embedded table.

3. Right-click a header cell and select ‘Column Type’ from the
context menu. This opens the ‘Column Type’ dialog box.
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4. Select ‘Integer’ from the ‘Type’ menu and click ‘OK’.

¢

See Also
Date and Time Formats, in Advanced Report Design, for more information
on formats.
Format Tab, in Advanced Dashboard Design, for more information on
Viewsheet formatting.

3.4.5 Editing an Expression Column

To change the formula of an expression column, follow these steps: 

1. Click the column header to select it.

2. Press the ‘Formula’ button in the column header. This opens the
Formula Editor.

3. Make the desired changes to the formula, and press ‘OK’. 

See Creating an Expression/Formula Column for more information about
using the Formula Editor.
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3.4.6 Editing a Range Column

To edit a date range column or numeric range column, follow these steps:

1. Click the column header to select it.

2. Press the Date Range or Numeric Range button in the column
header.

This opens the ‘Numeric Range Option’ or ‘Date Range Option’ dialog
box. See Creating a Numeric Range Column (Binning) and Creating a
Date Range Column for more details about using these dialog boxes.

3.5 Deleting a Table Column
To delete a column or multiple columns from a table, follow these steps:

1. Click the header of the first column to delete. This selects the
column.

2. Ctrl-click the headers of any other columns to delete. These
columns are also selected.

3. Right-click on any of the selected column headers, and choose
‘Delete column(s)’ from the context menu. The columns are
deleted from the table.

Deleted columns are removed from the query. To hide rather than delete a
column, see Showing and Hiding a Column. To add a column, see Adding
a Table Column.

3.6 Copying a Table
To eliminate repetitive work, an existing table may be copied to create a
new one. To copy and paste a table, follow these steps:
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1. Right-click the title row of the table to copy, and select ‘Copy’
from the right-click menu. This copies the table to the clipboard. 

2. Right-click on an empty cell in the Data Worksheet where you
would like to paste the copy. Select ‘Paste’ from the right-click
menu to paste the clipboard copy into the Worksheet. 

A new table is created in the Worksheet at that location. Although the
newly created table is a copy of the existing table, the two tables are
completely independent of each other. Therefore, changes made to one
table do not affect the other table.

To create a table copy that remains linked to the original table, see
Mirroring a Table.

3.7 Mirroring a Table
A mirrored table looks just like a copied table (see Copying a Table), but
remains linked to the original table. This link is one-way only: Changes
made to the original table are propagated to the mirrored table, but changes
made to the mirrored table are not propagated to the original table. 

To create a mirrored table, right-click the title row of the table to mirror,
and select ‘Mirror’ from the right-click menu. 

The new mirrored table is created, and a graphical link to the original table
is drawn to indicate the dependency. 

A mirrored table is useful when you want to manipulate data in a table
without affecting dependent assets. For example, if a table is being used as
a component of a Composition Table, manipulation of the table’s data
would propagate to the dependent Composition Table as well. To prevent
this propagation, you can mirror the original table and then work with the
mirrored copy instead of the original.

Like a Composition Table, a mirrored table has a Hierarchical mode and an
Editable mode; see Editing a Composition Table for more information.

3.8 Table Operations
This section explains the basic operations you can perform on tables. 
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3.8.1 Setting Table Query and Display Properties

You can change various properties of a data block, such the table
description, maximum number of rows retrieved and displayed, and the
handling of duplicate rows. 

To change table properties, follow these steps:

1. Right-click the title row, and select ‘Properties’ from the context
menu. This opens the ‘Table Properties’ dialog box.

2. Change the desired properties, and click ‘OK’ to exit the dialog
box.

The table properties are described below.

PROPERTY DESCRIPTION

Description The description text is displayed as a tooltip when the mouse 
hovers over the Table icon in the table’s title row, and when the 
table is selected in Style Studio. (See Using a Data Block for 
information about binding tables.)

Max Rows The maximum number of rows to retrieve from the database at 
runtime and to display in table preview. This is also the 
maximum number shown in Live Preview mode when ‘Max 
Rows’ is less than ‘Max Display Rows’. (See Previewing a 
Data Block and Showing Live Data in a Table.)

Return Distinct 
Values

Display only distinct rows in the table. (Remove duplicate 
rows.)
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3.8.2 Viewing the SQL Query Plan of a Table

To view the SQL statements that a table will attempt to execute (the query
plan), right-click the title bar, and select ‘Show Plan’ from the context
menu. This opens the ‘Query Plan’ dialog box.

The ‘Query Plan’ dialog box displays the queries that will be sent to the
database at runtime. Additionally, it shows the data operations that the
Worksheet will perform in post-processing, after the data is retrieved from
the database. The plan also shows the source information for parameterized
conditions.

By default, the Worksheet attempts to create a single SQL query that fully
generates the table’s data. This is typically the most efficient approach
because it allows the database to perform all the needed data operations
(joins, filtering, etc.). However, you can override this behavior for a

Merge SQL When selected, the Worksheet attempts to generate the table by 
forming a single SQL query, thus delegating all of the data 
manipulations to the database. If this option is not selected, or 
if the unified SQL statement cannot be formed, the table is 
generated in post-processing. (See Viewing the SQL Query 
Plan of a Table for information on viewing a table’s query.) In 
certain cases, you can improve Viewsheet performance by 
disabling the ‘Merge SQL’ option.

 Live Preview Display live data in the table, rather than meta-data. When 
displaying live data, it is recommended that you set the ‘Max 
Rows’ property to prevent the query from returning a very 
large number of records. Live Preview can also be enabled 
from the ‘Change View’ button on the table title bar. See 
Showing Live Data in a Table.

Max Display 
Rows

Maximum number of table rows to retrieve and display in Live 
Preview mode. (See Showing Live Data in a Table.) This 
property does not affect the number of records retrieved from 
the database at runtime or during preview. If ‘Max Rows’ 
specifies a smaller value, the ‘Max Rows’ value is used as the 
Live Preview maximum.

PROPERTY DESCRIPTION
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particular table by deselecting the ‘Merge SQL’ option in the ‘Table
Properties’ dialog box, and in some cases this may improve performance.
See Setting Table Query and Display Properties for more information.

Example: 
Viewing the SQL 
Query Plan

This example illustrates how you can control the SQL query that a table
sends to the database.

This data source is not available in Style Scope Agile Edition.

1. Expand the ‘TABLE’ > ‘SA’ node of the ‘Orders’ data source.

2. Drag the ‘PRODUCTS’ table to an empty location on the
Worksheet.

3. Drag the ‘CATEGORIES’ table to an empty location on the
Worksheet.

4. Drag the ‘CATEGORY_ID’ column header from the
‘CATEGORIES’ table onto the ‘CATEGORY_ID’ column header
of the ‘PRODUCTS’ table, and release when the ‘join’ symbol
appears.

This creates a new table called ‘Query’ that contains the inner join
between the two tables based on the ‘CATEGORY_ID’ columns.
(See Inner Join for more details.)

5. Right-click the title bar of the ‘Query’ table, and select ‘Show
Plan’. This displays the ‘Query Plan’ dialog box.

The ‘Query Plan’ dialog box displays the query that the table will send to
the database. The statement below the query indicates that this query
(including the instructions to join the two tables) will be sent to the
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database as a single SQL statement, which is also indicated by the single
icon in the top panel.

To override the default single-query behavior, follow the steps below:

1. Right-click the title row of the ‘Query’ table again, and select
‘Properties’ from the context menu. This opens the ‘Table
Properties’ dialog box.

2. Deselect ‘Merge SQL’ and click ‘OK’ to exit the dialog box.

3. Right-click the table title bar, and select ‘Show Plan’ again. 

The query plan is again displayed, but the top panel now shows an
expandable hierarchy of queries. The ‘PRODUCTS’ and ‘CATEGORIES’
queries are each individually executed as single queries, but the inner join
that generates the final ‘Query’ table is performed by the Worksheet in
post-processing.

¢

3.8.3 Editing a Composition Table

Joined Tables and Concatenated Tables are considered Composition
Tables. A Composition Table, as well as a Mirrored Table, has two modes:
Composition view and Default view.

• Composition view shows the exact composition of the table. It displays 
graphical links between the tables and columns involved in the 
composition, and indicates the type of concatenation or join being used. 
You cannot edit a table’s columns when the table is in Composition 
view. 
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• Default view allows you to edit column attributes, such as sorting order, 
visibility, etc. When a Composition Table is in Default view, it looks 
similar to a regular data block. All of the table’s composition 
information, such as join links, concatenation types, constituent tables, 
etc., is hidden from view. 

To toggle a Composition Table to Composition view, click the ‘Change
View’ button in the table title bar, and select ‘Composition’ from the menu.
To toggle a Composition Table to Default view, click the ‘Change View’
button in the table title bar, and select ‘Default’ from the menu.

Example: 
Editing a 
Composition 
Table

Assume that you have a Composition Table which is a union of two tables,
one returning customers who purchased the Fast Go Game product and one
returning customers who purchased the Wireless Mouse product. Both of
these tables have a column named ‘Zip’ that you would like to hide. They
also both have a column named ‘Customers’ that you would like to rename
to ‘Company’. 

To create this Composition Table, and then hide and rename columns,
follow the steps below:

1. Create a new Worksheet.

These data sets can be
found in the ‘Sample
Queries’ folder, or in
the ‘Orders Examples’
data set folder in
Agile Edition.

2. Drag the ‘Fast Go Game’ query from the Asset panel onto one of
the empty cells in the Worksheet. This creates a new data block,
named ‘Fast Go Game1’.

3. Drag the ‘Wireless Mouse’ query from the Asset panel onto one of
the empty cells in the Worksheet. This creates a new data block,
named ‘Wireless Mouse1’.

You can also drag the
‘Fast Go Game’ block
immediately above or
below the ‘Wireless
Mouse’ block.
Release when you see
the ‘union’ symbol
appear.

4. Drag across both data blocks to select them. Press the ‘Concatenate
Table’ button in the toolbar and select ‘Union’.
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This creates a new Concatenated Table, ‘Query1’. Notice that the
‘Query1’ table is in the ‘Composition’ view since the ‘union’ sym-
bol is visible on the left of the table, indicating its type, and the
table’s title row lists all of the tables participating in the union oper-
ation.

5. Press the ‘Change View’ button in the table title bar, and select
‘Default’ from the menu. 

This changes the view to default view, which allows editing of col-
umns.

6. Press the ‘Visibility’ button in the ‘Zip’ cell header to hide the
column.

7. Double-click the ‘Customers’ header, and change the name to
‘Company’. 
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8. Switch back to Composition view by pressing the ‘Change View’
button in the title bar. Select ‘Composition’ from the menu. 

Notice that the column name change does not appear in the Com-
position view. This is because the Composition view displays the
base table information and the column name has not been changed
for the base tables.

9. Preview the table. Notice that the ‘Zip’ field is hidden and the
‘Customer’ column header has been renamed to ‘Company’.

¢

3.8.4 Changing the Source of a Composition Table

When you select a Composition Table (Joined Table or Concatenated
Table), the Worksheet displays a set of arrows that indicate the table’s
dependencies. For example, when you click on a Joined Table, the lines
and arrows indicate the two data blocks are joined to produce the selected
table.
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In some cases, you may need to change the source of a Composition Table
after you have already created the table. For example, when you originally
created the Composition Table, you might have used a source data block
(e.g., Embedded Table) containing some prototype or placeholder data.
Later, when the production data is available, you need to replace this
prototype data block with the data block containing real data.

To change the source of a Composition Table from one data block to
another, follow the steps below:

Note: The new data block must be compatible with the data block it
replaces. See below.

1. Add the new (replacement) source data block to the Worksheet. 

2. Click the Composition Table to select it. This displays the lines and
arrows that show the Composition dependencies.

3. Click the arrow that connects the Composition Table to the old
source data block (the data block you wish to replace). This
highlights the arrow.

4. Drag and drop the arrow over the new (replacement) data block.

This rebinds the Composition Table to the new (replacement) data
block.

To preserve the existing composition operation with the replacement data
block, the replacement data block must be compatible with old data block
in the following manner:

• For a Joined Table, the name of the original join column must match a 
column name in the replacement data block in order to preserve the join. 
Otherwise, the resultant join type will default to a cross-join until you 
define a new relationship.
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• For a Concatenated Table, the number of columns and the data types in 
the replacement data block must match the old data block.

See Also
Changing the Join Type, to change the existing join operator.
Changing the Concatenation Type, to change the existing concatenation
operator.

3.8.5 Previewing a Data Block

To preview a data block, right-click the title bar, and select ‘Preview’ from
the context menu. This opens the Preview tab, which displays all visible
columns of the table. 

You can only preview one table at a time. In the table preview tab, click the
table title bar to see table information, including the record numbers being
displayed. Click outside the table to see information about the Worksheet.

See Also
Showing and Hiding a Column, to limit the number of columns displayed.
Setting Table Query and Display Properties, to limit the number of rows
retrieved. 
Showing Live Data in a Table, to display tabular data within the Worksheet
itself.
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3.8.6 Showing Live Data in a Table

A new table by default displays only metadata. However, the table can also
display “live data” drawn from the database. This often provides a useful
alternative to Preview.

For a large table, before entering Live Preview mode, you should set the
‘Max Display Rows’ in the ‘Table Properties’ dialog box to a reasonable
value. Note that for Live Preview mode, filtering conditions are only
applied to the sample data retrieved from the database, which is limited by
the ‘Max Rows’ and ‘Max Display Rows’ settings (as well as by the global
‘Design mode sample data size’ and administrator-set limits). Therefore,
Live Preview may not accurately represent the results of table filtering. 

To view live data in a table, follow these steps:

1. Click the ‘Change View’ button in the table title bar, and select
‘Live Preview’.

2. Drag the bottom border of the table downward to display more
rows.

3. To scroll the table, move the mouse over the arrow symbol in the
last column. 

This displays the scroll bar, which you can use to scroll the data.
The indices of the rows currently displayed in the table are shown
in the information bar at the bottom of the screen. 

To toggle the table back to Meta Data mode, press the ‘Change View’
button in the table title bar and select ‘Default’ from the menu. You can
also toggle Live Preview mode from the ‘Table Properties’ dialog box. 

See Also
Creating a Regular Data Block, for information about creating a new table.
Previewing a Data Block, for information about displaying the full table
data.
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Setting Table Query and Display Properties, for details about ‘Table
Properties’.
Displaying the Length of a Table, for methods of determining table length.

3.8.7 Limiting the Number of Rows in a Table

There are several ways to limit the number of rows (records) presented in a
table:

• To limit the number of rows retrieved and displayed by a particular table 
in Live Preview mode only, set the ‘Max Display Rows’ property in the 
table ‘Table Properties’ dialog box. 

• To limit the number of rows retrieved from the database at runtime (and 
displayed in Preview and Live Preview modes), set the ‘Max Rows’ 
property in the table ‘Table Properties’ dialog box. 

• To globally limit the number of rows returned by all queries and sub-
queries, set the ‘Design mode sample data size’ in the ‘Worksheet 
Options’ dialog box.

• To retrieve only the rows of a table matching some specified criteria, set 
a filtering condition on the table. 

• To retrieve only the rows of a table that have some specified relationship 
to the data of another table, create a joined table. 

See Tailoring Server Performance in the Advanced Server Administration
for other methods of limiting query size and duration.

See Also
Setting Table Query and Display Properties, for details about ‘Table
Properties’. 
Setting Global Worksheet Options, for details on ‘Design mode sample
data size’.
Tailoring Server Performance, in Advanced Server Administration, for
global limits.
Filtering, for information on how to set a filtering condition on a table.
Joining Tables, for limiting rows displayed by comparison with another
table.

3.8.8 Displaying the Length of a Table

The length of a table is the number of records that the table retrieves from
the database. You can check this length in two ways, by using Live Preview
mode or by using Preview.

Displaying Table Length in Preview

To check the length of a table using Preview, follow these steps:
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1. Select the table, and click ‘Preview’ in the toolbar. This opens the
‘Preview’ tab.

2. Click on the table title bar. The information bar at the bottom of the
page shows the number of records in the table.

Displaying Table Length in Live Preview Mode

To check the length of a table using Live Preview, follow these steps:

1. Press the ‘Change View’ button in the table title bar, and select
‘Live Preview’ from the menu.

2. Open the ‘Table Properties’ dialog box. 

3. Make sure the ‘Max Rows’ field is empty. (This ensures that there
is no artificial limit on the number of records retrieved. However,
limits can also be set by an administrator.)

4. Click ‘OK’ to close the ‘Table Properties’ dialog box.

5. Click the table title bar to select the table.

6. Consult the information bar at the bottom of the window (just
above the tab). 

The information bar displays the total number of records retrieved, as well
as the record numbers currently being displayed. If the information display
reads “maximum exceeded,” this means that Live Preview mode is unable
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to display the full table. In this case, use the Preview method to assess the
table length.

See Also
Showing Live Data in a Table, for information on Live Preview mode.
Setting Table Query and Display Properties, for details about ‘Table
Properties’.

3.8.9 Rotating a Table

To rotate a table, right-click on the table’s title row and select ‘Rotate’ from
the context menu. 

This creates a rotated copy of the table, which is linked back to the original
table. In the rotated copy, each row of the original table becomes a column,
and each column of the original table becomes a row. The first column of
the original table is the column header row of the rotated table, and the
column header row of the original table is the first column of the rotated
table. 

3.8.10Unpivoting a Table

In some cases it is useful to unpivot a table from crosstab form into normal
“flat” form. This operation converts the column headers into an additional
‘Dimension’ column.

To unpivot a crosstab, follow the steps below:

1. Right-click the table title bar, and select ‘Unpivot’ from the context
menu. This opens the ‘Unpivot Data’ dialog box.

2. In the ‘Levels of Row Headers’ field, enter the number of columns
containing row headers.

3. Press ‘OK’ to close the dialog box.

This creates a new table which contains the same data from the original
crosstab, but in flattened form (i.e., with column headers converted to an
independent ‘Dimension’ column). The unpivoted table remains linked to
the original crosstab so that changes to data in the crosstab are
automatically propagated to the new table.

Example: 
Unpivoting a 
Crosstab

To understand how to unpivot a crosstab, first create a crosstab by
following the steps below:

If you are using Style Scope Agile Edition, see Creating a Data Set
by Mash-Up to create a new Worksheet.

1. Create a new Worksheet by pressing the ‘New Worksheet’ button.
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This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

2. From the Asset panel, drag the ‘Sales Explore’ Worksheet onto an
empty cell on the Worksheet. This creates the data block ‘Sales1’. 

You will use this table to create a crosstab.

3. Press the ‘Group and Aggregate’ button in the table’s title bar. This
opens the ‘Group and Aggregate’ dialog box.

4. Press the ‘Switch to Crosstab’ button at the bottom of the dialog
box. This updates the dialog box to display the crosstab binding
interface.

5. In the ‘Row Header’ region, select the following two fields:
‘Category’ and ‘Company’.

6. In the ‘Column Header’ region, select the ‘Date’ field.

7. In the menu next to the ‘Date’ field, select ‘Year’.

8. In the ‘Measure’ region, select the ‘Total’ field.
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9. Press ‘OK’. This converts the data block to a crosstab.

10. In the crosstab title bar, press the ‘Change View’ button, and select
‘Live Preview’ from the menu. 

11. Drag the bottom border of the table to expand the table.

This crosstab has two levels of row headers (‘Category’ and ‘Company’),
and one level of column headers (‘Order Date’, broken out by year). 

You will now unpivot the crosstab to create a flat table that contains the
same data. Follow the steps below:

1. Right-click the crosstab title bar, and select ‘Unpivot’ from the
context menu. This opens the ‘Unpivot Data’ dialog box.

2. In the ‘Unpivot Data’ dialog box, enter a value of “2” for the
‘Levels of row headers’ value. (The two levels are ‘Category’ and
‘Company’.)
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3. Press ‘OK’ to close the dialog box. This creates a new table
containing the unpivoted (flattened) data.

4. In the table title bar, press the ‘Change View’ button and select
‘Live Preview’. 

5. Drag the bottom border of the table to expand the table.

Observe that the unpivoting operation transforms the values of the column
header in the crosstab (‘Date’) into a new column called ‘Dimension’. The
new unpivoted table retains the row headers of the original crosstab in the
first two columns (‘Category’ and ‘Company’), but now repeats each
combination of ‘Category’ and ‘Company’ for each value of ‘Date’.

The data presented in the unpivoted table is exactly the same as the data
presented in the original crosstab. However, the flattened version may be
more conducive to certain data operations such as trending.

¢

See Also
Importing Data Into an Embedded Table, for information on unpivoting a
crosstab table during import.
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4 Combining Data Blocks

One of the Data Worksheet’s most powerful capabilities is combining
tables from different data sources into unified data blocks. This section
explores the different ways that data blocks can be combined. 

4.1 Concatenating Tables
A Concatenated Table is a table generated by one of the following set
operations: Union, Intersect, and Minus. These set operations are called
concatenations. Candidate tables for concatenation should have the same
number of columns, and corresponding columns of each table should have
the same data type. A Concatenated Table is a type of Composition Table.
See Editing a Composition Table for information about other properties of
Composition Tables.

You can only concatenate two tables at a time, but any Concatenated Table
can be used in further concatenations. To concatenate multiple base tables,
first concatenate two of the base tables, and then concatenate the resulting
Concatenated Table with the third base table, and so on.

4.1.1 Creating a Concatenated Table

To create a Concatenated Table, follow these steps:

1. Select two tables to concatenate. (Ctrl-click the table title rows to
select them.)

The order in which you select the tables may influence the result.
See the Minus, Union, and Intersect sections for more details.

2. Click the ‘Concatenate Table’ button in the Worksheet toolbar and
select the desired concatenation: ‘Union’, ‘Intersect’, or ‘Minus’. 

See Changing the Concatenation Type for information about switching the
concatenation type of an existing Concatenated Table.
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4.1.2 Union

By default, the union of two tables contains all of the unique rows from the
two tables. The first table you select is the table whose distinct rows will
appear first in the result. By default, no duplicate rows are retained in the
union table. For information on how to preserve duplicate rows in the
union table, see Changing the Concatenation Type. 

For information on how to create a union table, see Creating a
Concatenated Table or the example below.

Example: Union One query returns a list of customers who have purchased more than 100
pieces of ‘Wireless Mouse’ and a second query returns a list of customers
who have purchased more than 100 pieces of ‘Fast Go Game’. To see the
contact information of all customers who have purchased more than 100
pieces of either ‘Wireless Mouse’ or ‘Fast Go Game’ in a single data block,
perform a union. Follow the steps below:

If you are using Style Scope Agile Edition, see Creating a Data Set
by Mash-Up to create a new Worksheet.

1. Create a new Worksheet by clicking on the ‘New Worksheet’
button.

These data sets can be
found in the ‘Sample
Queries’ folder, or in
the ‘Orders Examples’
data set folder in
Agile Edition.

2. Drag the ‘Fast Go Game’ query from the Asset panel onto one of
the empty cells in the Worksheet. This creates a new data block,
named ‘Fast Go Game1’.

3. Drag the ‘Wireless Mouse’ query from the Asset panel onto one of
the empty cells in the Worksheet. This creates a new data block,
named ‘Wireless Mouse1’.

You can also drag the
‘Fast Go Game’ block
immediately above or
below the ‘Wireless
Mouse’ block.
Release when you see
the ‘union’ symbol
appear.

4. Drag across both data blocks to select them. Press the ‘Concatenate
Table’ button in the toolbar and select ‘Union’.

This creates a new Concatenated Table, ‘Query1’. Notice that the
‘Query1’ table is in the ‘Composition’ view since the ‘union’ sym-
bol is visible on the left of the table, indicating its type, and the
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table’s title row lists all of the tables participating in the union oper-
ation.

5. To preview ‘Query1’, right-click on the title bar and select
‘Preview’. The information for all customers who purchased more
than 100 pieces of either ‘Wireless Mouse’ or ‘Fast Go Game’ is
included in the table.

 

¢

4.1.3 Intersect

The intersection of two tables contains the unique set of common rows
shared by the two tables, ordered lexicographically. Only a single instance
of each shared row is retained in the intersection table; all duplicates are
removed. For information on how to create an intersection table, see
Creating a Concatenated Table or the example below.

Example: 
Intersection

Assume that you want a list of only those customers who have purchased
more than 100 pieces of both ‘Wireless Mouse’ and ‘Fast Go Game’. This
can be accomplished by taking the intersection of the ‘Wireless Mouse’
and ‘Fast Go Game’ queries.

If you are using Style Scope Agile Edition, see Creating a Data Set
by Mash-Up to create a new Worksheet.

1. Create a new Worksheet by clicking on the ‘New Worksheet’
button

These data sets can be
found in the ‘Sample
Queries’ folder, or in
the ‘Orders Examples’
data set folder in
Agile Edition.

2. Drag the ‘Fast Go Game’ query from the Asset panel onto one of
the empty cells in the Worksheet. This creates a new data block,
named ‘Fast Go Game1’.

3. Drag the ‘Wireless Mouse’ query from the Asset panel onto one of
the empty cells in the Worksheet. This creates a new data block,
named ‘Wireless Mouse1’.
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4. Drag across both data blocks to select them. Press the ‘Concatenate
Table’ button in the toolbar and select ‘Intersect’.

5. This creates a new table, ‘Query1’. Notice that the title row
includes the names of the tables participating in the concatenation
and the type of concatenation (an intersect symbol in this case). 

6. To preview ‘Query1’, right-click on the title bar and select
‘Preview’. Only those customers who purchased more than 100
pieces of both ‘Wireless Mouse’ and ‘Fast Go Game’ are included
in the table.

¢

4.1.4 Minus

The difference (minus) of two tables is the set of distinct rows found in one
table but not in the other. The first table selected is the table whose unique
rows are retained in the result. For information on how to create a Minus
table, see the Creating a Concatenated Table section or the example below.
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Example: Minus Assume you want a list of all the customers who purchased more than 100
pieces of ‘Fast Go Game’ but did not purchase more than 100 pieces of
‘Wireless Mouse’. Follow these steps to obtain that result.

If you are using Style Scope Agile Edition, see Creating a Data Set
by Mash-Up to create a new Worksheet.

1. Create a new Worksheet by pressing the ‘New Worksheet’ button.

These data sets can be
found in the ‘Sample
Queries’ folder, or in
the ‘Orders Examples’
data set folder in
Agile Edition.

2. Drag the ‘Fast Go Game’ query from the Asset panel onto one of
the empty cells in the Worksheet. This creates a new data block,
named ‘Fast Go Game1’.

3. Drag the ‘Wireless Mouse’ query from the Asset panel onto one of
the empty cells in the Worksheet. This creates a new data block,
named ‘Wireless Mouse1’.

For a Minus operation, the order in which you select the data
blocks is important.

4. First select ‘Fast Go Game1’ by clicking the table’s title bar.

5. Now select ‘Wireless Mouse1’ by Ctrl-clicking the table’s title bar
(It is important to select the ‘Wireless Mouse1’ table after selecting
the ‘Fast Go Game1’ table.)

6. Press the ‘Concatenate Table’ button in the toolbar and select
‘Minus’. This creates a new table, ‘Query1’. 



DATA MASHUP

243 of 1397

Notice that the title row includes the names of the tables participat-
ing in the concatenation and the type of concatenation (a minus
symbol in this case). 

7. To preview ‘Query1’, right-click on the title bar and select
‘Preview’. The information for all customers who purchased more
than 100 pieces of ‘Fast Go Game’ but did not purchase more than
100 pieces of ‘Wireless Mouse’ is included in the table.

¢

4.1.5 Changing the Concatenation Type

To change the concatenation type of a Concatenated Table, follow these
steps:

1. If the table is in Default view, switch the table to Composition
view. (Press the ‘Change View’ button in the table title bar, and
select ‘Composition’ from the menu. See Editing a Composition
Table for more details.)

2. Select and then right-click the concatenation symbol or the “link”
(the thin line) on the left side of the table, and select ‘Link
Properties’ from the context menu. This opens the ‘Concatenation’
dialog box.
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3. Select a new concatenation type from the menu in the
‘Concatenation’ dialog box. 

4. If you set the concatenation type to ‘Union’, you can choose ‘Keep
Duplicate Rows’ to prevent the removal of duplicate rows from the
result.

5. (Optional) If the data block contains multiple concatenations, select
‘Apply to all concatenations’ to simultaneously update all of the
links to the specified concatenation type. Leave this option disabled
to modify only the selected link.

See Also
Creating a Concatenated Table, to create a new Concatenated Table.
Union, Intersect, and Minus, for information on the concatenation types.

4.2 Joining Tables
A joined table is a composition of two tables that preserves a specified
relationship between the participating tables (base tables). 

The joined table contains all the columns from both base tables, but retains
only the rows satisfying a specified join condition. The join condition is a
relation between two columns, one from each base table. These two
columns are called the join columns. The joined table can be thought of as
the intersection of the two tables based on the join columns.

There are no restrictions on the nature of the base tables for joins, and
joined tables can themselves be used in subsequent join operations. There
is no limit to the number of tables that can be successively joined together
in this way. Additionally, two tables can be joined together using multiple
join conditions, that is, multiple pairs of join columns. This allows you to
construct a joined table that embodies a very complex relation between the
base tables. 

The next sections explain how to create various types of joined tables.

See Also
What-If Analysis, for an illustration of using multiple join conditions.
Changing the Join Type, for information on converting between join types. 
Editing a Composition Table, for Editable and Hierarchical modes of
tables.

4.2.1 Inner Join

The most commonly-used join type is the inner join. The inner join of two
tables can be described in the following way: “First pair every row of the
first base table with every row of the second base table (Cartesian product),
and then delete any row in the product where the values in the join columns
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do not satisfy the specified join condition.” See the Joining Tables section
for more general information about joins.

You can create an inner join either by dragging columns or by using the
‘Join Table’ button.

Creating a Inner Join by Dragging Columns

To create an inner join between two base tables by dragging columns,
follow these steps:

1. Identify the join columns, one from each table. These are the
columns to which the join condition is applied.

2. Drag the first join column header on top of the second join column
header. The cursor should change to a join symbol, and a green line
should appear in the second join column header.

3. When you see the join symbol and the green line, drop the column
header. 

This creates a new table that represents the inner join of the two
base tables. A graphical link is drawn between the two join col-
umns, and the join type symbol is displayed. By default, the “equal-
ity” join condition is used, producing the so-called “equi-join.” For
information on changing the join condition or join columns, see
Changing the Join Type.

4. If desired, repeat the above steps to implement multiple join
conditions.

Creating an Inner Join with the ‘Join Table’ Button

To create an inner join between two base tables, follow these steps:

1. Ctrl-click to select the two table that will participate in the join.

2. Click the ‘Join Table’ button in the toolbar, and select ‘Inner Join’. 
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This opens the ‘Inner Join’ dialog box.

3. Use the menus to select one column from each table, and choose
the join condition that the data must satisfy in order to appear in the
result set. The ‘=’ operator produces the “equi-join.” The inequality
operators produce their respective “non-equijoins.” 

4. (Optional) To convert an inner join to an outer join, select ‘include
all values’ for the left or right table, or for both tables. These
selections correspond, respectively, to the left outer join, the right
outer join, and the full outer join. 

Additional menus will
appear as needed to
specify the additional
joins.

5. Select additional columns and join conditions from the remaining
menus in the ‘Inner Join’ dialog box to create multiple join
conditions.

The outer join is a generalization of the inner join: In addition to the
matching rows preserved by the equi-join, the left outer join preserves all
the rows in the left table, while the right outer join preserves all the rows in
the right table. The full outer join preserves all the rows of both tables. 
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When you specify an outer join, the additional rows included from a table
(beyond those selected by the equi-join) do not have matching rows in the
other table. Therefore, outer-join tables generally exhibit empty cells
corresponding to these unmatched rows.

For information on changing the join condition or join columns after
creating the table, see Changing the Join Type.

Example: 
Creating an Inner 
Join

The sample ‘Sales Explore’ Worksheet contains individual order
information. If you want to add customer information such as addresses,
you need to join this data block to the data set returned by the sample
‘customers’ query. Follow the steps below:

If you are using Style Scope Agile Edition, see Creating a Data Set
by Mash-Up to create a new Worksheet.

1. Create a new Worksheet by pressing the ‘New Worksheet’ button.

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

2. From the Asset panel, drag the ‘Sales Explore’ Worksheet onto an
empty cell on the Worksheet. This creates the data block ‘Sales1’. 

This query can be
found in the ‘Sample
Queries’ folder, or in
the ‘Orders Examples’
data set folder in
Agile Edition.

3. From the Asset panel, drag the ‘customers’ query onto an empty
cell on the Worksheet. This creates the data block ‘customers1’. 

4. Drag the ‘Company’ column header from the ‘Sales1’ data block
onto the ‘company_name’ column header of the ‘customers1’ data
block. Notice that the cursor changes to a join icon.
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Notice that the con-
nector line on the bot-
tom row of the table
shows the join rela-
tionship by connect-
ing the join columns
together.

5. Drop the ‘Company’ column header on the ‘company_name’
column header to create the join. This creates a new joined table,
‘Query1’.

6. To preview the ‘Query1’ data block, right-click on the title row and
select ‘Preview’. 

¢

4.2.2 Outer Join

When you join two tables, the default join type created is an equi-join. This
join type preserves only the rows of the two tables that have matching
values on the join columns. 

Sometimes, in addition to preserving the matching rows, you may also
want to preserve all the rows of one or both base tables. A join which
preserves all rows of one or both base tables is called an outer join.

See Changing the Join Type to change an inner join to an outer join.



DATA MASHUP

249 of 1397

See Also
Inner Join, for information about the default equi-join.
Changing the Join Type, to change an inner join to outer join or change the
type of outer join.

4.2.3 Cross Join

Tables that do not share the same data model or query can be joined
together with a cross join. A cross-joined table contains the cross-product
(Cartesian product) of the data in the base tables. This means that every
row in the first table is paired together with every row in the second table.
The length of the new joined table is the product of the two base table
lengths.

To cross-join two tables in a Data Worksheet, follow these steps:

1. Drag the first table alongside the second table. 

2. Position the dragged table so that its border touches the border of
the second table. The join icon should appear.

3. When the cross-join icon appears, release the dragged table.

The two tables are cross-joined to create a new table. Filtering conditions
from both base tables are applied to the cross-joined table.

Example: Cross 
Join

The ‘customers’ query returns information about different companies.
Consider a case where you want to mash up this company information with
salesperson information such that each row of company data is repeated for
each of several different salespeople. This requires a cross-join, and will
yield a result whose length is equal to the product of the rows of the two
base tables.

If you are using Style Scope Agile Edition, see Creating a Data Set
by Mash-Up to create a new Worksheet.

1. Create a new Worksheet by pressing the ‘New Worksheet’ button.

This query can be
found in the ‘Sample
Queries’ folder, or in
the ‘Orders Examples’
data set folder in
Agile Edition.

2. From the Asset panel, drag the ‘customers’ query onto an empty
cell on the Worksheet. This creates the data block ‘customers1’. 
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3. Create an embedded table containing the salesperson information.
Follow the steps below:

a. Press the ‘New Object’ button in the toolbar, and select
‘Embedded Table’. The mouse changes to a crosshairs.

b. Drag with the crosshairs to highlight four rows and two columns
on the grid, and release.

This creates a new embedded table called ‘Query1’.

4. Double-click on the ‘col0’ column header, and edit the column
name to be ‘First Name’. Double-click on the ‘col1’ column header
and edit the column name to be ‘Last Name’.

5. In the first row of the ‘First Name’ column, enter “Sue”. In the first
row of the ‘Last Name’ column, enter “Marston”. In the second
row of the ‘First Name’ column, enter ‘Eric’. In the second row of
the ‘Last Name’ column, enter “Heggenbart”.

6. Join the two data blocks using a cross-join. To do this, click on the
title bar of the ‘Query1’ data block, and drag the entire data block
right next to the ‘customers1’ data block. 
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7. When the cross-join icon appears, release the mouse to create the
join. This creates a new joined table, ‘Query2’.

8. To preview the ‘Query2’ table, right-click on the title bar and select
‘Preview’. Notice that the ‘Query1’ table contains the cross-
product of the data from the ‘customers1’ and ‘Query1’ tables.
That is, every row in the ‘Query1’ table is paired with every row in
the ‘customers1’ table.

¢

4.2.4 Merge Join

The Merge Join is a special type of join that creates no relationship between
the two base tables. The base tables are simply merged into a single table
by collecting their columns together and placing corresponding rows side
by side. 

To create a merge join, follow these steps:
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1. Select both tables by Ctrl-clicking on each table’s title row, or by
dragging across both tables.

2. Press the ‘Join Table’ button in the Worksheet toolbar, and select
‘Merge Join’. 

A new merge-joined table is created. 

In the merge-joined table, the columns of the shorter table are padded with
empty rows to match the length of the longer table. The number of columns
in the final merge-joined table is the sum of the columns in the two base
tables.

Example: Merge 
Join

Place orders of Wireless Mouse and Fast Go Game side-by-side within a
dingle data block by using a merge join.

1. Create a new Worksheet.

These data sets can be
found in the ‘Sample
Queries’ folder, or in
the ‘Orders Examples’
data set folder in
Agile Edition.

2. Drag the ‘Fast Go Game’ query from the Asset panel onto one of
the empty cells in the Worksheet. This creates a new data block,
named ‘Fast Go Game1’.

3. Drag the ‘Wireless Mouse’ query from the Asset panel onto one of
the empty cells in the Worksheet. This creates a new data block,
named ‘Wireless Mouse1’.

4. Select both data blocks by holding down the Ctrl key and clicking
each one.

5. Press the ‘Join Table’ button on the toolbar and select ‘Merge
Join’. 
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This creates a new data block, ‘Query1’.

Since the merge join
does not create any
relationship between
the tables, there is no
connector shown.
This join type, there-
fore, cannot be
changed.

6. To preview ‘Query1’, right-click on the title bar and select
‘Preview’. Notice that since the ‘Wireless Mouse1’ table has more
rows than the ‘Fast Go Game1’ table, the number of rows of the
‘Query1’ table is equal to the number of rows of the ‘Wireless
Mouse1’ table. The ‘Fast Go Game1’ data is padded with an empty
row.

¢

4.2.5 Changing the Join Type

The join type can be changed for all joined tables except for Merge-joins
and Cross-joins. (Merge joins and cross joins do not define a relationship
between tables, so there is no relationship that can be changed.) 

To change the join type of a joined table, follow these steps:

1. If the joined table is in Default view, switch the table to
Composition view. (Press the ‘Change View’ button in the table
title bar, and select ‘Composition’ from the menu. See Editing a
Composition Table for more details.)
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2. Open the ‘Join Types’ dialog box. You can do this in any one of the
following ways:

a. Click the join connector link to select it. The selected link is
highlighted in blue. Right-click on the highlighted join
connector link and select ‘Join Properties’ from the context
menu. This opens up the ‘Join Types’ dialog box for the
selected join.

Additional menus will
appear as needed to
specify any addi-
tional joins.

b. Right-click on the title bar of the data block and selected ‘Join
Properties’. This opens up the ‘Join Types’ dialog box for all
joins.

c. Press the ‘Join’ symbol next to the data block name in the
Worksheet Explorer. (See Navigating a Data Worksheet for
more information about the Worksheet Explorer.) This opens up
the ‘Join Types’ dialog box for all joins.

3. In the ‘Join Types’ dialog box, select the join columns from the
drop-down menus for each table. 

4. Select the join condition operator from the middle menu. The ‘=’
operator produces the “equi-join.” The inequality operators
produce their respective “non-equijoins.” 
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5. (Optional) To convert an equi-join to an outer join, select ‘include
all values’ for the top or bottom table, or for both tables. 

These selections correspond, respectively, to the left outer join, the
right outer join, and the full outer join. In addition to the matching
rows preserved by the equi-join, the left outer join preserves all the
rows in the top table, while the right outer join preserves all the
rows in the bottom table. The full outer join preserves all the rows
of both tables.

When an outer join is specified, the additional rows included from a table
(beyond those selected by the equi-join) do not have matching rows in the
other table. Therefore, outer-join tables generally exhibit empty cells
corresponding to the unmatched rows.

Example: 
Changing the 
Join Type

Follow the steps below to change the join type of a joined table from inner
join to left outer join.

If you are using Style Scope Agile Edition, see Creating a Data Set
by Mash-Up to create a new Worksheet.

1. Create a new Worksheet by pressing the ‘New Worksheet’ button
in the toolbar.

This query can be
found in the ‘Sample
Queries’ folder, or in
the ‘Orders Examples’
data set folder in
Agile Edition.

2. Drag the ‘customers’ query from the Asset tree to an empty cell in
the Worksheet. This creates a new data block named ‘customers1’.

3. Drag the ‘NY Customers’ query from the Asset tree to an empty
cell in the Worksheet. This creates a new data block named ‘NY
Customers1’.

4. Drag the ‘customer_id’ column header from ‘customers1’ onto the
‘CUSTOMER_ID’ column header of ‘NY Customers1’. This
creates a new joined data block called ‘Query1’.
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5. Right-click on the title row of the ‘Query1’ table and select
‘Preview’ from the context menu. 

Notice that only the customers from the state of NY are listed,
because the join is currently an inner join.

6. In the Data Worksheet, click the join connector in table ‘Query1’ to
select it.

7. Right-click the connector and select ‘Join Properties’ from the
context menu. This opens the ‘Join Types’ dialog box.

8. Select ‘include all values’ for the ‘customers1’ table and press
‘OK’.
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9. Preview the table again. Notice that the two tables are now joined
using a left outer join.

¢
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5 Manipulating Tabular Data

This section discusses various techniques for manipulating the data within
a table. 

5.1 Sorting
Any column in a table can be sorted in ascending or descending order. You
can sort the table data based on a single column, or specify nested sorting
columns. If a column in the table is already sorted, sorting on a new column
clears the previous sorting.

5.1.1 Sorting a Single Column

To sort a single column, press the ‘Sort’ button in the column header. This
sorts the column in ascending order. Click the button again to sort the
column in descending order. Click a third time to return the column to its
original order.

When a column is sorted, its sort order is indicated by the small arrow next
to the column name in the column header cell. 

Example: 
Sorting a Single 
Column

Sort the data in the sample ‘Sales Explore’ Worksheet in ascending order
by state name. Follow these steps:

1. Create a new Worksheet.

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

2. From the Asset panel, drag the ‘Sales Explore’ Worksheet onto an
empty cell on the Worksheet. This creates the data block ‘Sales1’. 

3. Select the ‘State’ header cell.

4. Press the ‘Sort’ button in the column header cell. 
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Notice the up-arrow in the ‘State’ column header. This indicates
the current ascending sort order.

5. Preview the table.

6. Close the ‘Preview’ window, and select the ‘State’ column header
again.

7. Press the ‘Sort’ button again. Notice that the ‘State’ column is now
sorted in descending order, indicated by the down-arrow in the
column header. 

Press the ‘Sort’ button
a third time to return
the data to its original
order.

8. Preview the table. 

9. Now select the ‘Company’ column header cell.
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10. Press the ‘Sort’ button in the ‘Company’ column header. Notice
that the ‘Company’ column is now sorted in ascending order and
the ‘State’ column is no longer sorted.

11. Preview the table.

¢

5.1.2 Sorting Multiple Columns

To sort multiple columns in a hierarchical fashion, follow these steps:

1. Press the ‘Sort Column(s)’ button in the table title bar. 

This opens the ‘Sort Column’ dialog box. 

2. From the ‘Sort on’ drop-down menus, select the table columns that
you wish to sort. 

The hierarchical sort order of a column is determined by the verti-
cal position of the menu. The column specified in the top menu is
sorted first, the column specified in the second-to-top menu is
sorted second, and so on.

3. For each column, select the ‘Ascending’ or ‘Descending’ button to
determine the sorting direction.
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When a column is sorted, its sort order is indicated by the small arrow next
to the column name in the column header cell. To sort just a single column,
see Sorting a Single Column.

Example: 
Sorting Multiple 
Columns

Say you have a table listing the information of all of our customers and you
would like to sort the data based on the state first, and then the city. To sort
both the ‘state’ and the ‘city’ columns of the table, follow these steps:

1. Create a new Worksheet.

This query can be
found in the ‘Sample
Queries’ folder, or in
the ‘Orders Examples’
data set folder in
Agile Edition.

2. Drag the ‘customers’ query from the Asset tree to an empty cell in
the Worksheet. This creates a new data block named ‘customers1’.

3. Press the ‘Sort column(s)’ button in the table title bar. This opens
the ‘Sort Column’ dialog box.

4. Select ‘state’ from the first drop-down list, and ensure that the
‘Ascending’ radio button is selected.

5. Select ‘city’ from the second drop-down list, and ensure that the
‘Ascending’ radio button is selected.

6. Press ‘OK’. Notice that the up arrows next to the column names
‘state’ and ‘city’ indicate that both of those columns are sorted in
ascending order.
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7. Preview the table. Notice that the data is sorted by the ‘state’ and
the ‘city’ columns.

¢

5.2 Filtering
You can filter the data in a table by applying conditions to any of the table
columns. For example, you may want to display only products that have a
‘product price’ greater than $100, or that have an ‘order date’ within the
past year. When you specify conditions, the table will only display the data
records that satisfy those conditions.

See Also
Filter Conditions, in Advanced Dashboard Design, for information on
setting a Viewsheet condition.
Using a Subquery in a Condition, for generating condition criteria at
runtime. 
Concatenating Tables, for filtering rows of a table based on set operations.
Joining Tables, for filtering table rows by joining two tables. 
What-If Analysis, for implementing an adjustable filtering condition.

5.2.1 Defining Simple Conditions

Simple conditions are conditions defined on the pre-aggregate data, that is,
before any grouping or summarization. Simple conditions are always
joined together using the ‘AND’ operator. To gain greater flexibility, you
can use advanced conditions; see Defining Advanced Conditions.

Note: Filtering conditions are only applied to data that is
retrieved from the database. The amount of data (number of rows)
retrieved is determined by the ‘Max Rows’ setting and the global
‘Design mode sample data size’ setting. See Previewing a Data Block
and Showing Live Data in a Table for more information.

To define a simple condition, follow these steps:

1. Press the ‘Define Condition’ button on the title bar of a data block. 



DATA MASHUP

263 of 1397

This opens the ‘Condition’ dialog box.

2. Click the ‘More’ button to specify a new condition.

3. Use the menus in the ‘Edit’ pane to define the condition. See
Filtering Operators for details on the options.

4. Click ‘OK’ to save the condition and close the dialog box. Click
‘Modify’ to update the condition without closing the dialog box.

5. To delete a condition, select the condition in the list and click the
‘Fewer’ button. 

If the condition you specify references data model attributes that do not
already exist in the table, these attributes are automatically added to the
table as invisible columns. 

Example: 
Defining a Simple 
Condition

In the sample Sales Explore Worksheet, retrieve only orders with sales of at
least $1,000.

1. Create a new Worksheet.

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

2. From the Asset panel, drag the ‘Sales Explore’ Worksheet onto an
empty cell on the Worksheet. This creates the data block ‘Sales1’. 
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3. Press the ‘Define Condition’ button in the upper right corner of the
table’s title bar. 

This opens the ‘Conditions’ dialog.

4. Press the ‘More’ button to create a new condition.

5. Select ‘Total’ from the left menu.

6. Select ‘greater than’ from the center menu and select the ‘or equal
to’ option.

A Variable or another
field value can be
used in the condition
by selecting ‘vari-
able’ or ‘field’ and
specifying either the
Variable or the field
name. See Creating a
Variable for more
information.

7. Specify “1000” for the value.

8. Press ‘OK’.

9. Right-click the table title bar, and select ‘Preview’ from the context
menu.
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Note that only totals greater than $1000 are returned.

¢

5.2.2 Defining Advanced Conditions

To specify conditions on both pre-aggregate and post-aggregate data, as
well as group rankings, use the ‘Advanced Conditions’ dialog box.
Advanced conditions can additionally be joined using both ‘AND’ and
‘OR’ operations. If you only need pre-aggregate conditions and ‘AND’
operations, you can use simple conditions instead. See Defining Simple
Conditions for more information.

To define advanced conditions, follow these steps:

1. Press the ‘Define Condition’ button on the title bar of a data block. 

This opens the ‘Condition’ dialog box.

2. Select the ‘Advanced Conditions’ check box. 

The ‘Advanced Conditions’ check box can be used to toggle
between simple and advanced conditions. However, when switch-
ing from the ‘Advanced conditions’ mode to the ‘Simple Condi-
tions’ mode, if an advanced condition cannot be mapped to a
simple condition, it will be permanently removed from the list of
conditions. 
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3. Define a condition on pre-aggregate data, post-aggregate data, or
ranking by clicking on the corresponding ‘Edit’ button. See Pre-
aggregate, Post-aggregate, and Ranking Conditions below.

If the condition you specify references attributes that do not already exist in
the table, these attributes are automatically added to the table as invisible
columns. 

Pre-aggregate, Post-aggregate, and Ranking Conditions

Pre-aggregate conditions are applied to the detail rows of the table, whereas
post-aggregate conditions are applied to the data in the summary rows of
the table. (Pre-aggregate conditions are equivalent to conditions defined in
the ‘Where’ clause of the SQL statement, and post-aggregate conditions
are equivalent to conditions specified in the ‘Having’ clause of the SQL
statement.) Ranking conditions specify the Top N or Bottom N number of
rows that should be presented in the table. See Filtering Operators for
information about the filtering options.

Example: 
Defining an 
Advanced 
Condition

This example continues the example from the previous section, Defining
Simple Conditions. Adjust the condition you specified previously to return
only the top 10 totals. Follow the steps below:

1. Press the ‘Define Condition’ button located in the data block title
bar. 

This opens the ‘Conditions’ dialog box.
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2. Select the ‘Advanced Conditions’ option. Notice that the condition
added to the ‘Total’ field is included in the ‘Pre-aggregate’
conditions list.

3. Press the ‘Edit’ button next to the ‘Ranking Conditions’, and then
press the ‘More’ button.

4. From the left menu, select ‘Total’. 

A Variable value can
be used as the rank-
ing condition value by
selecting ‘variable’
from the drop-down
list to the right of the
value text box and
specifying the param-
eter name in the text
box. See Creating a
Variable for more
information.

5. In the right menu select ‘top’ and enter “10” as the value.

6. Press ‘OK’ to return to the ‘Conditions’ dialog box. 

7. Press ‘OK’ to apply all of the conditions to the table.
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8. Preview the data block. Data for only the top 10 values of ‘Total
Sales’ value are listed.

¢

5.2.3 Defining a Materialized View Update Condition

You can create conditions for a data block which determine how and when
the data block’s materialized view is updated. A materialized view is a
high-performance caching mechanism for dashboards. (See Incrementally
Updating a Materialized View in Advanced Server Administration for
background on incremental updates.) 

If you are using Style
Scope Agile Edition,
see Refreshing Data
in a Dashboard for
information about the
high-performance
cache.

To specify the materialized view update conditions for a data block, follow
the steps below:

1. Press the ‘Define Condition’ button located in the upper right
corner of the data block title bar. 

This opens the ‘Conditions’ dialog box.

2. Select the MV Update tab.
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3. (Optional) In the special case where you are using an unmergeable
query, enable the ‘Always append updates’ option. Otherwise,
leave it disabled. See Incrementally Updating a Materialized View
in Advanced Server Administration for information about using this
property for unmergeable queries.

4. Press the ‘Edit’ button corresponding to the type of update
condition you wish to create. The available options are as follows:

a. Append Records Matching Pre-aggregate Condition: Create
a condition which selects records to add to the existing
materialized view based on the pre-aggregate values of data
(prior to grouping and summarization).

b. Append Records Matching Post-aggregate Condition:
Create a condition which selects records to add to the existing
materialized view based on the post-aggregate values of data
(subsequent to grouping and summarization).

c. Delete Records Matching Pre-aggregate Condition: Create a
condition which selects records to delete from the existing
materialized view based on the pre-aggregate values of data
(prior to grouping and summarization).

d. Delete Records Matching Post-aggregate Condition: Create
a condition which selects records to delete from the existing
materialized view based on the post-aggregate values of data
(subsequent to grouping and summarization).
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When you press the desired ‘Edit’ button, this opens the ‘Condi-
tions’ dialog box. 

5. Use the menus to enter the desired condition. (See Defining Simple
Conditions for general information on specifying conditions.)

If you select the ‘Expression’ option for the right side of the condi-
tion, follow the additional steps below:

The ‘sql/js’ option is
not available for dele-
tions. Deletion
expressions must use
JavaScript syntax. 

a. For append operations, press the ‘sql/js’ button to select the
desired expression language, SQL or JavaScript.

b. Press the ‘Edit Expression’ button (fx). This opens the Formula
Editor.

c. Enter the desired expression. You can use any available
functions and operators, in addition to the special parameters
MV.LastUpdatedTime, MV.MaxValue, and MV.MinValue. See
Special Parameters for Materialized View Update Conditions
for more details.

Note: To prevent a delete condition from being applied on the
initial materialized view generation, add the following special
tag into the expression script: //@incrementalOnly.

d. Press ‘OK’ to close the Formula Editor.

6. Press ‘OK’ to close the ‘Condition’ dialog box.
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The specified condition(s) will be evaluated when any materialized view
based on this data block is regenerated. The materialized view will be
updated in accordance with the conditions specified. In general,
incrementally updating a materialized view in this way is significantly
faster than regenerating the materialized view in its entirety.

Special Parameters for Materialized View Update Conditions

The following special parameters are available for expressions in the
materialized view update condition.

• MV.LastUpdatedTime: This represents the time at which the materialized 
view for the data block was last updated. You can use this value in an 
condition expression to incrementally update the materialized view with 
records that have posted to the database since the last materialized view 
update. For example, the condition below updates the current 
materialized view with records having a “transaction date” subsequent 
to the previous materialization.

[transaction_date][is][greater than][MV.LastUpdatedTime]

• MV.MaxValue: This represents the maximum value of the field specified 
in the left-side menu of the materialized view condition. For example, in 
the condition below, MV.MaxValue represents the maximum value of the 
‘Total’ field.

• MV.MinValue: This represents the minimum value in the field specified 
in the left-side menu of the materialized view condition. 

5.2.4 Filtering Operators

The table below lists the operators available for use in filtering conditions.

OPERATOR DESCRIPTION

equal to True when the column value identically matches the specified 
criterion. (String matching is case-insensitive.)

in range For date fields, true when the column value (date) falls within 
the specified date range criterion. See Appendix C.1, Built-in 
Date Ranges for a list of available date ranges. 

one of True when the column value is a member of the set of criteria 
values. (String matching is case-sensitive.)

less than True when the column value is strictly less than the criterion 
value. Select the ‘or equal to’ check box to obtain a “less than or 
equal to” criterion. (Strings are compared based on their 
alphabetical ordering.)
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5.2.5 Using a Parameter in a Condition

You can use a variable or parameter as the test value in a filter condition.
By default, the user of the Worksheet (including users of linked Viewsheets
and reports) will be prompted at runtime to enter the value of the
parameter. 

The value of the variable can also be supplied from the following sources:

• Viewsheet input component. (See Passing Inputs to an Embedded Table 
or Variable in Advanced Dashboard Design.)

• User session data. (See SRPrincipal Properties in Advanced Server 
Integration.)

To use a variable or parameter in a filter condition, follow these steps:

1. Open the Worksheet containing the table you want to filter.

2. (Optional) To reference a a variable asset in the condition, first
create the Variable asset, or drag an existing Variable from the
Asset tree to an empty cell in the Worksheet. (See Defining a
Variable for more information.)

greater than True when the column value is strictly greater than the criterion 
value. Select the ‘or equal to’ check box to obtain a “greater than 
or equal to” criterion. (Strings are compared based on their 
alphabetical ordering.)

between True when the column value is within the interval specified by 
its upper and lower boundaries. The boundary values are 
included in the interval. (Strings are compared based on their 
alphabetical ordering.) For date fields, consider using the ‘in 
range’ operator in place of specifying fixed dates.

null True when the column value is ‘null’. (Nulls appear as empty 
cells in a table.)

top For grouped and aggregated data, true when the aggregated 
column value is among the top N aggregated values, according 
to the grouping specified by the secondary menu.

bottom For grouped and aggregated data, true when the aggregated 
column value is among the bottom N aggregated values, 
according to the grouping specified by the secondary menu.

starting with For numeric and string data, true when the column value begins 
with (i.e., the left-most characters match) the specified numerals 
or characters. String matching is case-insensitive.

contains For numeric and string data, true when the column value 
contains the exact sequence of specified numerals or characters. 
String matching is case-insensitive.

OPERATOR DESCRIPTION
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3. Press the ‘Define Condition’ button on the title bar of the table you
wish to filter. 

This opens the ‘Condition’ dialog box.

4. Open the edit field in either the ‘Simple Condition’ mode (click the
‘More’ button) or ‘Advanced Condition’ mode (click the pre-
aggregate or post-aggregate ‘Edit’ button).

5. To use a variable in the condition, select ‘Variable’ from the
rightmost popup menu. This opens a blank Combo Box on the right
side of the condition.

In the Combo Box, do one of the following:

a. Select an existing Worksheet Variable from the menu.

b. Type the name of a new parameter.

c. Type the name of a Viewsheet input component.

6. To use session data in the condition, select ‘Session Data’ from the
rightmost popup menu. This opens a menu on the right side of the
condition.
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Note that the adjacent
menu automatically
chooses the ‘equal to’
or ‘one of’ operator to
match your selection.

In the menu, choose one of ‘User’, ‘Roles’, or ‘Groups’. These
parameters return information about the user who is currently
accessing the Worksheet; respectively, the user name, the array of
roles to which the user belongs, and the array of groups to which
the user belongs.

7. Define the rest of the condition as described earlier. 

The default prompting for Variables and parameters is the same. However,
Variables provide additional control over the interface (radio button, menu,
etc.) and the set of choices presented to the user.

See Also
Filtering, for details on specifying filtering conditions.
Defining a Variable, for more information on defining a Variable.

5.2.6 Using a Field in a Condition

You can use table values as the test values in a filter condition. That is, you
can define a filter condition that compares two values in the same row of
the table. 

To use a table field in a filter condition, follow these steps:

1. Open the Worksheet containing the table you want to filter.

2. Press the ‘Define Condition’ button on the title bar of the table you
wish to filter. 

This opens the ‘Condition’ dialog box.

3. Open the edit field in either the ‘Simple Condition’ mode (click the
‘More’ button) or ‘Advanced Condition’ mode (click the pre-
aggregate or post-aggregate ‘Edit’ button).

4. Make the desired selections in the left three menus.

5. Select ‘Field’ from the right-most menu. This enables a Combo
Box on the right side of the condition.
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6. In the Combo Box, select the table column containing the values to
test. 

The condition compares corresponding values in the selected columns
(left-most menu and right-most menu), and preserves only rows where the
condition is met.

See Also
Filtering, for details on specifying filtering conditions.

5.2.7 Using an Expression in a Condition

The test values of a filtering condition can be a SQL or a JavaScript
expression. To filter a field in a data block based on an expression, follow
these steps:

1. Open the Worksheet containing the data block you want to filter.

2. Press the ‘Define Condition’ button on the title bar of the data
block you wish to filter. 

This opens the ‘Condition’ dialog box.

3. Select the field and the desired logical operator. 

4. Click on the arrow button to choose ‘Expression’ from the menu.

5. Click the ‘sql’ or ‘js’ button at the left of the expression text field to
choose the expression type. 
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Note: Use SQL expressions if possible. See SQL vs. JavaScript in
Expressions.

6. Press the ‘fx’ button to launch the expression edit dialog and enter
your expression.

For example, to retrieve orders placed before today, you can use one of the
following conditions:

// SQL:
[Order Date] [is] [less than] [CURRENT_TIMESTAMP]

// JavaScript:
[Order Date] [is] [less than] [CALC.today()]

SQL vs. JavaScript in Expressions

Expressions that use SQL syntax are processed by the database, while
expressions that use JavaScript syntax are post-processed by the
Worksheet. Because post-processing is CPU-intensive for the query
engine, and may additionally cause retrieval of a large amounts of raw data,
it is preferable to use SQL syntax when possible. Note, however, that SQL
functions are database-specific and vary from one database to another.

5.2.8 Using a Subquery in a Condition

When you add a filter to a table, you can choose to use a subquery to return
the test conditions. This allows you to design a filter with conditions that
are set at runtime based on current data. 

For example, consider a table with a column named ‘CompanyName’. You
want this table to display only companies in NY state, but the table has no
‘State’ column on which you can define the filter. If you knew in advance
which companies reside in NY, you could enter the condition explicitly; for
example,

[Company][is][one of][explicit list of companies in NY] 

However, if the set of companies in NY is not fixed, and can therefore
change whenever the underlying database is updated, any fixed list that you
enter in the condition will become outdated. In order to filter the table
correctly, you need to generate a list of “companies in NY” that is always
true to the current data.

You can do this by using a subquery to provide the current list of
“companies in NY.” The condition you place on the table will then have
the form 

[Company][is][one of][results of subquery]
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The list of “companies in NY” generated by the subquery will always be
up-to-date, because the subquery itself executes at runtime. 

To enter a subquery in a filter condition, follow these steps:

1. Open the Worksheet containing the table you want to filter.

2. Select the query you wish to use as a subquery in the condition.
Drag it from the Asset tree to an empty cell on the Worksheet. This
creates a new table with the name of the query. 

3. Press the ‘Define Condition’ button on the title bar of the table you
wish to filter. 

This opens the ‘Condition’ dialog box.

4. Open the edit field in either the ‘Simple Condition’ mode (click the
‘More’ button) or ‘Advanced Condition’ mode (click the pre-
aggregate or post-aggregate ‘Edit’ button).

5. Select ‘Subquery’ from the rightmost popup menu. This displays
the ‘Subquery’ button.

6. Click the ‘Subquery’ button. This opens the ‘Subquery’ dialog box.

7. In the ‘Subquery’ menu, specify the desired subquery table. (This
is the table created when you dragged the query to the Worksheet.)
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8. Select options in the lower three popup menus, as needed. 

You may not need to make every menu selection; this will depend
on how you want to use the subquery result set. The ‘In column’
menu specifies the subquery column that contains the result set to
use in the condition. The bottom two menus control table synchro-
nization for row-dependent conditions. 

9. Click ‘OK’ to close the ‘Subquery’ dialog box. 

10. After you have specified the subquery to use, define the rest of the
condition as described earlier.

See Also
Independent Query, in Advanced Data Modeling, for information on
queries.
Filtering, for details on specifying filtering conditions.
Specifying a Subquery, for more information on defining the subquery.

5.2.9 Specifying a Subquery

You may not need to specify every setting in the ‘Subquery’ dialog box.
The required menu choices depend on how you wish to use the subquery
result set. This section explains three different cases for using a subquery.

Subquery Returns a Fixed Value

If the subquery returns a single fixed value (i.e., the subquery table in the
Worksheet contains a single cell), then in the ‘Subquery’ dialog box you
only need to specify the name of the subquery. No further settings are
required.

Subquery Returns a Fixed List

If you want to use a particular column from the subquery as a fixed list in
the condition, you need to specify the query name in the ‘Subquery’ dialog
box, and then select the desired subquery column from the ‘In column’
menu. A subquery that returns a column is typically used in conjunction
with the ‘one of’ condition clause to filter values that are members (or non-
members) of the returned list. You do not need to make selections in the
‘Subquery column’ and ‘Current table column’ menus.

Example: 
Subquery 
Returns a Fixed 
List

Assume that you have a table of companies that purchased a ‘Wireless
Mouse’ product, and a second table of companies that purchased a ‘Fast Go
Game’ product. You would like to filter the ‘Wireless Mouse’ table to
show only the companies that did not purchased the ‘Fast Go Game.’ To do
this, define a condition on the ‘Wireless Mouse’ table that uses the ‘Fast Go
Game’ table as a subquery. Follow the steps below:

1. Create a new Worksheet.
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These data sets can be
found in the ‘Sample
Queries’ folder, or in
the ‘Orders Examples’
data set folder in
Agile Edition.

2. Drag the ‘Fast Go Game’ query from the Asset panel onto one of
the empty cells in the Worksheet. This creates a new data block,
named ‘Fast Go Game1’.

3. Drag the ‘Wireless Mouse’ query from the Asset panel onto one of
the empty cells in the Worksheet. This creates a new data block,
named ‘Wireless Mouse1’.

4. In the ‘Fast Go Game1’ table, rename the ‘Customers’ column to
‘Customers_FGG’. This will make the next steps more clear.

5. Press the ‘Define Condition’ button in the title bar of the ‘Wireless
Mouse1’ data block. 

6. This opens the ‘Conditions’ dialog box.

7. Uncheck the ‘Advanced Conditions’ option.

8. Press the ‘More’ button.

9. Use the menus to specify the following expression: 

[Customers][is not][one of]

10. In the right-side pop-up menu button select ‘Subquery’. 

11. Press the ‘Subquery’ button. This opens the ‘Subquery’ dialog box.

12. Select ‘Fast Go Game1’ from the ‘Subquery’ menu. This is the
name of the subquery table to use.
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13. Select ‘Customers_FGG’ from the ‘In column’ menu. This is the
column of the subquery which contains the list of values to use in
the condition expression.

14. Press ‘OK’ to close the ‘Subquery’ dialog box. (You do not need to
make selections from the bottom two menus.)

15. Press ‘OK’ to exit the ‘Condition’ dialog box. 

16. To view the results, press the ‘Change View’ button in the title bar
of each table and select ‘Live Preview’ from the menu.

The ‘Wireless Mouse1’ table has now been filtered to display only the
companies that did not purchase the ‘Fast Go Game’. Note that the two
tables are now graphically linked together by an arrow to indicate that the
‘Fast Go Game1’ table provides a subquery result to the ‘Wireless
Mouse1’ table. 

¢

Subquery Returns a Row-Dependent Value

A subquery can return a value that is dependent on the row of the main
table. Such a row-dependent subquery is useful when you want to filter
rows of the main table based on a comparison with corresponding rows of
another table (i.e., the subquery table).

For example, consider a case where one table displays sales by year for
NY, and a second table displays sales by year for CA. You want the NY
table to display records only for those years where sales were greater than
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sales in CA. For instance, you want the NY table to display the record for
year 2002 only if sales in NY for 2002 were greater than sales in CA for
2002. 

To configure a row-dependent subquery, follow these steps:

1. Select the table you wish to filter.

2. Open the ‘Condition’ dialog box, and then open the ‘Subquery’
dialog box. See the Filtering and Using a Subquery in a Condition
sections for detailed instructions on how to do this.

3. Select the subquery name in the ‘Subquery’ menu. (In the example
above, the subquery is the CA sales table.) 

4. Select the desired subquery column from the ‘In column’ menu.
This is the column of the subquery containing the actual values to
be tested in the condition. (In the example above, this would be the
‘sales’ column of the CA table, since this column contains the
values that the condition will test.)

5. From the ‘Subquery column’ menu, select the column in the
subquery table that indexes the subquery condition column
(selected in the previous step). The ‘Subquery column’ column is
the subquery join column; it will be used to “look up” the condition
values corresponding to a particular row in the main table. (In the
example above, the ‘Subquery column’ column would be the
‘year’ column of the CA table, since this is the column that indexes
the ‘sales’ column of the CA table.)

6. From the ‘Current table column’ menu, select the column in the
main table that contains the indexing values corresponding to those
in the ‘Subquery column’ of the subquery table. (In the example
above, the ‘Current table column’ would be the ‘year’ column of
the NY table, since this is the column that corresponds to the CA
‘year’ column.)

The ‘Subquery column’ and ‘Current table column’ serve to connect the
subquery table and main table. For each row in the main table, the value in
the ‘Current table column’ is matched against the values in the ‘Subquery
column’. The results returned by the subquery for each row are the values
of the condition ‘In column’ in the rows where the ‘Subquery column’
value is matched.

Example: 
Subquery 
Returns Row-
Dependent Value

This example illustrates how to use a row-dependent subquery. Suppose
you have the total sales information for all product categories, both for this
year and last year. However, you want to display only those product
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categories that have yielded more sales revenue this year than last year. To
do this, you can use last year’s total sales as a subquery to provide the data
for the condition you place on this year’s sales table.

1. Create a new Worksheet.

These data sets can be
found in the ‘Sample
Queries’ folder, or in
the ‘Orders Examples’
data set folder in
Agile Edition.

2. Drag the ‘Sales this year’ query from the Asset panel onto one of
the empty cells in the Worksheet. This creates a new data block,
named ‘Sales this year1’.

3. Drag the ‘Sales last year’ query from the Asset panel onto one of
the empty cells in the Worksheet. This creates a new data block,
named ‘Sales last year1’.

4. Rename the following columns in the ‘Sales last year1’ table: 

a. Rename ‘Category’ to ‘Category_LY’.

b. Rename ‘Total Sales’ to ‘Total_Sales_LY’.

This will make the following steps more clear.

5. Press the ‘Define Condition’ button in the title bar of the ‘Sales this
year1’ table. 

This opens the ‘Conditions’ dialog box.

6. Uncheck the ‘Advanced Conditions’ option.

7. Press the ‘More’ button.

8. Use the menus to specify the following expression: 

[Total Sales][is][greater than]

9. From the right-side menu select ‘Subquery’. 

10. Press the ‘Subquery’ button. This opens the ‘Subquery’ dialog box.
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11. Select ‘Sales last year1’ from the ‘Subquery’ menu.

12. Select ‘Total_Sales_LY’ from the ‘In column’ menu. This is the
column of the subquery containing the values to be used in the
condition test.

13. Select ‘Category_LY’ from the ‘Subquery column’ column. This is
the subquery column that will be matched up against the ‘Current
table column’ in the main table. (It is the “join column” of the
subquery table.)

14. Select ‘Category’ from the ‘Current table column’ menu. This is
the main table column that will be matched up against the
‘Subquery column’ in the subquery table. (It is the “join column”
of the main table.)

15. Press ‘OK’ to close the ‘Subquery’ dialog box.

16. Press ‘OK’ in the ‘Condition’ dialog box. The two tables are now
shown with a graphical link, indicating that the ‘Sales this year1’
table relies on subquery data from the ‘Sales last year1’ table. 

17. For each table, press the ‘Change View’ button in the title bar of
the table and select ‘Live Preview’ from the menu.

18. Expand the table borders as needed to view the results.

19. (Optional) Compare the filtered ‘Sales this year1’ table to the
original ‘Sales this year1’ table by dragging the ‘Sales this year’
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query (again) from the Asset tree to an empty Worksheet cell.
Rename it ‘Sales this year original’.

Note that the filtered ‘Sales this year1’ table now contains only the
categories for which sales were higher than the previous year. 

¢

5.3 Grouping
The ‘Group and Aggregate’ button in a table’s title bar allows you to create
groupings in the table. 

5.3.1 Grouping and Aggregating Data

To define grouping and aggregation columns (summary columns) for a
data block, follow these steps:

1. Press the ‘Group and Aggregate’ button in the table’s title bar. 

This opens the ‘Group and Aggregate’ dialog box.

2. Select the grouping columns by clicking the ‘Group’ check box
next to one or more column names. 

When you enable grouping for a column, by default each distinct
value in the column defines its own group. Aggregation is then
based on these groups. For example, if you group a column of state
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names, each distinct state name will define its own group, and
aggregate values will be computed for each of those groups.

3. (Optional) If a user-defined group matches the grouping column
data format (String, Double, etc.), you can select the user-defined
group from the right-side menu.

User-defined groups give you greater flexibility in partitioning the
entries in a column for grouping. If you select a user-defined
grouping from the menu, aggregations will be based on that user-
defined grouping. 

4. (Optional) If you specify grouping for a column that has a Date
format, you can select a predefined or user-defined Date grouping
(Year, Quarter, etc.) from the right-side menu. 

The actual date values in the grouping column will be replaced
with the new group labels, e.g., ‘1st Quarter’, ‘January’, etc. If the
dates are already grouped by the database, select ‘None’.

5. Click the ‘Aggregate’ check box for columns containing the
measures that you wish to aggregate (summarize).

6. For the aggregate columns, choose the method of aggregation
(Sum, Correlation, etc.). 

7. (Optional) For the univariate aggregation methods (Sum, Max,
etc.), select the ‘Percentage’ check box to display the aggregated
measure as a percentage of the grand total.

8. (Optional) For the bivariate aggregation methods (Correlation,
etc.), select the second operand (column) for the computation from
the ‘with’ menu.

9. Press ‘OK’ to close the ‘Group and Aggregate’ dialog box.

The table is now grouped. Only the table columns that are either grouping
columns or aggregate columns are shown in the grouped table. All other
columns are hidden. In the grouped table, each column has an icon
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indicating whether it is a grouping column or an aggregate column. Click
any of these icons to reopen the ‘Group and Aggregate’ dialog box.

See Also
Creating a Named Grouping, for more information on user-defined
groupings.
Appendix C.2, Built-in Date Groupings, for a list of predefined date
groupings. 
Crosstab Aggregation Measures, for more details about aggregation
methods.
Switching Between Detail and Aggregate View, to revert back to
ungrouped table. 
Creating a Numeric Range Column (Binning), to create a new grouping of
existing column.

Example: 
Grouping and 
Aggregating Data

The sample ‘Sales Explore’ Worksheet contains order information for
several products. Find the total sales for each individual product. To do
this, group the table data by product name and summarize by ‘Total’.
Follow the steps below:

1. Create a new Worksheet.

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

2. From the Asset panel, drag the ‘Sales Explore’ Worksheet onto an
empty cell on the Worksheet. This creates the data block ‘Sales1’. 

3. Press the ‘Group and Aggregate’ button in the title bar. 

This opens the ‘Group and Aggregate’ dialog box.
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4. Select ‘Group’ for the ‘Name’ column and ‘Aggregate’ for the
‘Total’ column.

5. Set the aggregate function for the ‘Total’ column to ‘Sum’.

6. Press ‘OK’ to apply the grouping and summarization.

7. Preview the table. Notice that only the ‘Product’ and ‘Total’ fields
are included in the table, and the table now provides the summed
total for each product. Columns that are not designated as ‘Group’
or ‘Aggregate’ columns have been removed.

¢

5.3.2 Defining a Crosstab Table

A crosstab table is also known as a pivot table. A Worksheet crosstab
contains one column header, one or more row headers, and one measure. 

The values at the row-column intersections of the crosstab table represent
summary (aggregate) information of the measure. For example, a crosstab
with row headers representing ‘Salesperson’ and column headers
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representing ‘Month of Year’ might contain values at the intersections
representing ‘Average Sale Price’ or ‘Maximum Sale Price’. The measure
in both cases is ‘Sale Price’. The summarization method is, respectively,
Average or Maximum. By using summarization, crosstab tables display
large amounts of data in a compact form.

To create a crosstab table from an existing data block, follow these steps. 

1. Press the ‘Group and Aggregate’ button in the table title bar. This
opens the ‘Group and Aggregate’ dialog box.

2. In the ‘Group and Aggregate’ dialog box, click ‘Switch to
Crosstab’. The ‘Group and Aggregate’ dialog box switches to the
crosstab view.

3. In the ‘Row Header’ panel, select one or more fields from the left
menus.

4. In the ‘Column Header’ panel, select a field from the left menu.

5. (Optional) For each selected field in the ‘Row Header’ and
‘Column Header’ panels, select a Named Grouping (if one exists)
from the corresponding right menu. 

6. In the ‘Aggregate’ panel, select a measure column from the left
menu. This is the column whose values will be summarized.

7. In the ‘Aggregate’ panel, select the aggregation method from the
right menu. 

If you select a bivariate aggregation measure (e.g., ‘Correlation’,
‘Weighted Average’, etc.), select the second operand (column)
from the ‘with’ menu. 
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8. (Optional) To display the measure as a percentage of the grant
total, select the ‘Percentage’ option. 

9. Click ‘OK’ to create the crosstab table.

See Also
Creating a Named Grouping, for more information on user-defined
groupings.
Crosstab Aggregation Measures, for more details about aggregation
methods.
Switching Between Detail and Aggregate View, to revert back to
ungrouped table. 

5.3.3 Crosstab Aggregation Measures

The table below shows the crosstab aggregation measures available for
table grouping.

AGGREGATE
MEASURE

DESCRIPTION

Sum Displays the sum of the measure values for the 
given row and column headings

Average Displays the average of the measure values for the 
given row and column headings

Max Displays the maximum of the measure values for 
the given row and column headings

Min Displays the minimum of the measure values for the 
given row and column headings

Count Displays the total count of measure values for the 
given row and column headings. This represents the 
total number of records corresponding to the given 
row and column headings, and is the same value for 
any selected measure.

Distinct Count Displays the count of unique measure values for the 
given row and column headings. 

First Displays the first value for the measure (for the 
given row and column headings) when sorted based 
on the values in a second column, specified by the 
menu labeled ‘by’.

Last Displays the last value for the measure (for the 
given row and column headings) when sorted based 
on the values in a second column, specified by the 
menu labeled ‘by’.

Correlation Displays the Pearson correlation coefficient for the 
correlation between the measure values (for the 
given row and column headings) and the 
corresponding values in a second column, specified 
by the menu labeled ‘with’.
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Example: 
Crosstab 
Aggregation

The sample ‘Sales Explore’ Worksheet contains order information for a
number of different customers. Display the total amount of money spent by
each customer on each of the products by using a crosstab table. Follow the
steps below:

1. Create a new Worksheet.

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

2. From the Asset panel, drag the ‘Sales Explore’ Worksheet onto an
empty cell on the Worksheet. This creates the data block ‘Sales1’. 

3. Press the ‘Group and Aggregate’ button in the title bar. 

This opens the ‘Group and Aggregate’ dialog box.

Covariance Displays the covariance between the measure values 
(for the given row and column headings) and the 
corresponding values in a second column, specified 
by the menu labeled ‘with’.

Variance Displays the (sample) variance of the measure 
values for the given row and column headings. 

Std Deviation Displays the (sample) standard deviation of the 
measure values for the given row and column 
headings.

Variance (Pop) Displays the (population) variance of the measure 
values for the given row and column headings. 

Std Deviation (Pop) Displays the (population) standard deviation of the 
measure values for the given row and column 
headings.

Weighted Average Displays the weighted average of the measure 
values for the given row and column headings. The 
weights are given by the corresponding values in a 
second column, which is specified by the menu 
labeled ‘with’.

AGGREGATE
MEASURE

DESCRIPTION
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4. Press the ‘Switch to Crosstab’ button. The view changes to enable
you to specify the column headers and the summary column.

5. Select ‘Company’ from the first drop-down list under the ‘Row
Header’. 

6. Select ‘Name’ from the ‘Column Header’ drop-down list.

7. Select ‘Total’ from the ‘Measure’ drop-down list and ensure that
the aggregate function is set to ‘Sum’. 

8. Press ‘OK’.

9. Preview the table.
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Observe that totals are shown for every combination of product and
company.

¢

5.3.4 Switching Between Detail and Aggregate View

When you define grouping or aggregation on a data block, the resulting
table is automatically placed in “aggregate view,” which shows only the
grouping and aggregation columns. 

• To switch a table from aggregate view to detail view (displaying all 
columns, without grouping and aggregation), press the ‘Change View’ 
button in the title bar and select ‘Full’ (meta-data) or ‘Detail Preview’ 
(live data).

• To switch a table from detail view to aggregate view (hiding all non-
aggregate and non-grouping columns), press the ‘Change View’ button 
in the title bar and select ‘Default’ (meta-data) or ‘Live Preview’ (live 
data).

Example: 
Switching 
Between Detail 
and Aggregate 
View

The following example illustrates how to toggle from detail to aggregate
view.

1. Create a new Worksheet.
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This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders Examples’
data set folder in
Agile Edition.

2. From the Asset panel, drag the ‘Sales Explore’ Worksheet onto an
empty cell on the Worksheet. This creates the data block ‘Sales1’. 

3. Press the ‘Group and Aggregate’ button in the title bar. 

This opens the ‘Group and Aggregate’ dialog box.

4. Select the ‘Group’ option for the ‘Name’ column and ‘Aggregate’
for the ‘Total’ column.

5. Ensure that the aggregate function for the ‘Total’ column is set to
‘Sum’.

6. Press ‘OK’ button to apply the grouping and summarization.

7. Press the ‘Change View’ button in the table title bar, and select
‘Live Preview’ from the menu. 
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Notice that since grouping and summarization is specified for this
table, only the summarized data is displayed in the table, and all of
the columns that are not included in the grouping or summarization
have been removed.

8. To switch to the detail view, press the ‘Change View’ button in the
title bar and select ‘Full’ (meta-data) or ‘Detail Preview’ (live
data). Notice that all of the columns are now displayed in the table,
but the group and aggregate columns are displayed with darker
headings.

9. To switch back to the summarized view of the data, press the
‘Change View’ button in the title bar and select ‘Default’ (meta-
data) or ‘Live Preview’ (live data).

¢
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6 Creating Non-Tabular Assets

Non-tabular assets include Named Groupings and Variables. Like tables,
they are reusable across multiple Worksheets and reports. This section
explains how to create each of these asset types.

For more information about working with assets and the asset repository,
see Assets: Reusable Worksheet Components.

6.1 Creating a Named Grouping
The default grouping procedure simply partitions a column based on its
distinct values. For example, if a column contains state abbreviations CA,
NY, and WA, then the default grouping produces one group for CA, one
group for NY, and one group for WA. 

If this default grouping is not satisfactory, you can create a different
partition with Named Grouping. A Named (User-Defined) Grouping is a
reusable set of custom conditions (i.e., rules) that partition the data into the
desired groups. 

To create a Named Grouping, follow these steps:

1. Press the ‘New Object’ button in the toolbar, and select
‘Grouping’. This opens the ‘Grouping’ dialog box.

2. In the ‘Name’ field, enter a name for the grouping assembly. This
is the title of the grouping object in the Worksheet. (After the
grouping object is created, you can edit the grouping name from
the text field at the top of the Worksheet.)

3. If you want the grouping to be accessible to all columns of a certain
data type, select the desired data type from the ‘Type’ menu.
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For example, you could use the ‘starting with’ operator to define a
grouping based on initial letter (i.e., A, B, C, etc.). If you specified
type ‘String’ for this grouping, you could apply the grouping to any
column of that type in a Worksheet or report. This would allow you
to reuse the same alphabetical grouping for customer names, com-
pany names, product descriptions, and any other column that has
‘String’ type data.

4. If you want the grouping to be applicable only to a particular
column or attribute of a particular data source, select the desired
data source from the ‘Only for’ menu. Select the desired column
from the ‘Attribute’ menu.

You can select a column or attribute from any accessible data
source, not restricted to those in the current Worksheet. The group-
ing defined for this column or attribute will then be available wher-
ever the column or attribute is used in a Worksheet or report.

You can now specify the conditions that define membership in each group
of the User defined Grouping. 

5. Press the ‘Add’ button to add a new group. This opens the ‘Add
Condition List’ dialog box. (This is the same as the dialog box used
for adding advanced conditions to tables.)

6. In the ‘Group Name’ field, enter the name of the group you wish to
define. (For example, “East Coast states”.)

7. Enter the conditions that define membership in this particular
group, and click ‘OK’. 

8. Repeat the above three steps for each group you wish to add to the
grouping: 

9. In the ‘Grouping’ dialog box, choose ‘Group all others together’ to
create a default group called “Others” that will contain all column
values that do not satisfy any of the specified group conditions.
Otherwise, select ‘Leave others in their own group’.

10. Click ‘OK’ to exit the ‘Grouping’ dialog box. 

The Named Grouping is now shown in the Worksheet as a table whose title
is the group name, and whose rows are individual group names. (You can
drag the bottom border of the table to see all the group names.) 

See Also
Grouping, for information on default grouping operations.
Defining Advanced Conditions, for information on specifying conditions.
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Saving an Asset, to save the defined grouping to the Repository.
Using a Named Grouping, to use the grouping in other Worksheets and
reports.

Example: 
Creating a 
Named Grouping

Suppose you want to create a group for all the states on the west coast, so
that every time the customer data is displayed in either a table, chart, or
section element in the report, all of the customers from the west coast states
are grouped together. 

Follow these steps to create the ‘WestCoast’ group.

1. Create a new Worksheet.

2. Press the ‘New Object’ button, and select the ‘Grouping’ option. 

This opens the ‘Grouping’ dialog box.

3. Specify “WestCoast” as the name.
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4. For the ‘Type’ select ‘String’.

5. Press the ‘Add’ button to specify the conditions which the data has
to satisfy in order to qualify to be a part of this new group. This
opens the ‘Add Condition List’ dialog.

6. Specify ‘WestCoast’ as the Group Name.

7. Specify the following condition, and click the ‘Append’ button.

[this][is][one of][WA,OR,CA]

8. Press the ‘OK’ button to exit the ‘Add Condition List’ dialog and
go back to the ‘Group’ dialog.
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9. Press the ‘OK’ button.

10. Right-click on the title for the ‘WestCoast’ group and select ‘Set as
Primary’.

11. Press the ‘Save’ button in the top toolbar. The ‘Save as Worksheet’
dialog appears.

12. Specify “WestCoast” as the name of the asset and select ‘Global
Worksheet’ as its scope.
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13. Press ‘OK’ to save the newly created user-defined grouping.
Notice that the name of the grouping on the Asset tree is prepended
with a ‘Grouping’ icon, indicating that the asset is of the ‘Named
Group’ type.

¢

6.2 Creating a Variable
Variables provide a way to prompt the user to enter specific filtering
conditions for tables in the Worksheet. You can use Variables in conditions
on tables and Named Groups.

See Saving an Asset and Using a Variable for more information about
working with Variables.

6.2.1 Defining a Variable

To create a new Variable, follow these steps:

1. Press the ‘New Object’ button in the top toolbar, and select
‘Variable’. 
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This opens the ‘Variable Properties’ dialog box.

2. Enter a ‘Name’ for the new Variable asset. This is the name that
appears in the title bar of the Variable asset.

3. Enter a ‘Label’ for the Variable. This is the label that appears in the
parameter dialog box that prompts the user.

4. Select the data type of the Variable from the ‘Type’ menu. This is
the data type of the values that the Variable will provide to the
filtering condition.

5. In the ‘Selection List’ panel, specify the source of the Variable
data:

a. Select ‘None’ to prompt the user with an empty text field (no
choices).

b. Select ‘Embedded’ to enter a fixed list of choices. 



DATA MASHUP

302 of 1397

c. Select ‘Query’ to populate the list of choices with the data in an
existing table column. 

6. In the ‘Display Style’ panel, select the type of list to display to the
user. 

The ‘Combo Box’ and ‘Radio Buttons’ options allow the user to
make a single selection. The ‘List’ and ‘Checkboxes’ options allow
the user to make multiple selections. (Multiple selections can be
used in conjunction with the ‘one of’ condition operator.)

7. Click ‘OK’ to exit the dialog box. 

See Also
Creating an Embedded Variable List, to manually specify the Variable
values.
Creating a Query-Based Variable List, to automatically generate Variable
values.

Example: 
Defining a 
Variable

Say you have multiple Data Worksheets including the order and contact
information pertaining to all customers. It would be helpful to have a
Variable that provided a specific state value in order to filter the data so that
only information pertaining to the customers in the specified state was
included in the data analysis. 

Instead of creating the ‘state’ Variable for all of the Data Worksheets, you
can create it once and save it as a ‘Variable’ asset in the asset repository.
Then, you can reuse the Variable in all of the relevant Data Worksheets.
Follow these steps to create a Variable asset:

1. Create a new Worksheet.

2. Press the ‘New Object’ button located in the top toolbar, and select
the ‘Variable’ option. 

This opens the ‘Variable Properties’ dialog box.
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3. Specify “state” as the name of the Variable.

4. Specify “State” as the Label.

5. Select ‘String’ from the drop-down list for Type.

6. Uncheck the ‘None’ check box next to ‘Default Value’, and enter
“CA” as the default value.

7. Ensure that ‘None’ is selected for the Selection List.

8. Press ‘OK’.

9. Right-click on the Variable’s title and select ‘Set as Primary’.
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10. Press the ‘Save’ button in the top toolbar. This opens the ‘Save as
Worksheet’ dialog.

11. Specify “State” as the asset name and select ‘Global Worksheet’ as
its scope.

12. Press ‘OK’ to add the ‘State’ Variable to the Asset tree. Notice that
the name of the asset on the Asset tree is shown with a Variable
icon indicating that the asset is of the ‘Variable’ type.

This example is continued in Using a Variable, where the ‘state’ Variable
is used in another Worksheet.

¢
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6.2.2 Creating an Embedded Variable List

To create an embedded list for a Variable, follow these steps:

1. Right-click the Variable asset, and select the ‘Properties’ option
from the context menu. This opens the ‘Variable Properties’ dialog
box. 

2. In the ‘Selection List’ panel of the ‘Variable Properties’ dialog box,
select the ‘Embedded’ option.

3. Press the ‘Edit’ button to open the ‘List’ dialog box. 

4. Press ‘Add’ to create a new label/value pair. A label/value pair
defines a particular choice that will be shown to the user in the
input dialog box.

5. In the ‘Label’ field, enter the text that should be displayed to the
user for this particular choice. 

6. In the corresponding ‘Value’ field, enter the text that should be
used in the filtering condition for this particular choice. (If the
‘Type’ option in the ‘Variable Properties’ dialog box specifies a
numeric type, you can only enter numerical values.)

7. Repeat the previous three steps to add all the choices that should be
presented to the user.

8. To change the position of a item in the list, select the item, and
press the ‘Up’ or ‘Down’ arrow button.

9. Click ‘OK’ to exit the ‘List’ dialog box.
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6.2.3 Creating a Query-Based Variable List

To populate the Variable selection list with data obtained from a query
(table), follow these steps:

1. In the ‘Selection List’ panel of the ‘Variable Properties’ dialog box,
select the ‘Query’ option.

2. Click the ‘Select’ button to open the ‘Table’ dialog box. 

3. From the list box on the left side, select the table that contains the
data you wish to use.

4. From the ‘Value Column’ menu, select the column that contains
the data to be used in the filtering condition. Each row of the
‘Value Column’ represents a possible value of the Variable.

5. In the ‘Label Column’ menu, select the column that contains the
labels to be displayed to the user. 

Each row of the ‘Label Column’ should contain the label for the
corresponding row of the ‘Value Column’. These labels are used to
designate the available options in the ‘Enter Parameters’ dialog box
that will be displayed to the user. When the user selects a particular
option, the value corresponding to the selected label is applied to
any filter conditions that use the Variable

6. Click ‘OK’ to exit the ‘Table’ dialog box.
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7 Applications

This section describes high-level procedures used to approach certain tasks
using the Data Worksheet. 

These examples are not available in Style Scope Agile Edition.

These examples describe the general steps needed to apply Worksheet
tools to an application. The example Worksheets can be found in the
‘Global Worksheet’ > ‘Tutorial’ folder. For specific details on how to carry
out individual constituent tasks, e.g., grouping, concatenating tables, etc.,
please refer to those specific chapters in this guide.

7.1 User Conference Mailing
Compiling a custom mailing list for an upcoming conference is a
necessary, but laborious, task. The functions provided by the Data
Worksheet simplify this task. Say you are hosting a conference for select
customers and you would like to send them printed invitations. Seating is
limited, so sending an invitation to every customer would not be cost
effective. Therefore, to narrow down the list of the customers to whom you
will send the invitation, you can use their order history. Suppose you decide
to send an invitation only to the following customers:

• The top 3 customers this year

• The customers who have purchased at least one of our products in the 
last four weeks

This example is not available in Style Scope Agile Edition.

In this example, you will make use of the following components and
methods:

• Advanced conditions (see Defining Advanced Conditions)

• Concatenated table options (see Concatenating Tables)

• Group and aggregate options (see Grouping)

• A table value in the filter conditions (see Filtering)

The completed example is called ‘UserConferenceMailing’, and can be
found in the ‘Global Worksheet’ > ‘Tutorial’ folder.

Example: User 
Conference 
Mailing

Assume you have two tables: A table of order information for each
customer, called ‘OrderInfo’, and a table of contact information for each
customer, called ‘ContactInfo’.

To build the desired invitation list, follow these steps:
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1. Generate a list of all customers who have purchased at least one of
our products in the last four weeks. 

To do this, apply an ‘in range’ filter condition on the ‘OrderInfo’
table that restricts the data to ‘Last 4 Weeks’. Name this new table
‘RecentCustomers’. The ‘RecentCustomers’ table will to have two
columns, ‘Customer Company’ and ‘Order Date’. You require the
‘Order Date’ field to specify the date condition, but the column can
then be hidden. 

2. Generate a list of the top 3 customers for this year. To do this, apply
a ranking condition to the ‘OrderInfo’ table so that it only lists the
top 3 customers based on the sum of the ‘Total’ sales for each
customer.

3. Once you have both of these tables, you can unite them into a
single table. Create a Composition table using the ‘union’ set
operation. This requires that both base tables have the same number
of columns, so hide all the columns of both tables except for the
‘Company Name’ columns. Name this new Concatenated table
‘CustomerList’. This table contains the list of Company names to
whom you wish to send invitations.

4. You now need to retrieve the corresponding contact information
for these companies. Specify a subquery-based filtering condition
on the ‘Company’ field of the ‘ContactInfo’ table, so that a record
is only displayed if the company is “one of” the companies in the
‘CustomerList’ table.

Figure 1. The ‘User Conference Mailing’ example

¢
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7.2 What-If Analysis
What-if analysis is the exploration of cause and effect relationships in data.
This is one of the greatest strengths of the Data Worksheet, making use of
the following features:

• Embedded tables (see Creating an Embedded Table)

• Cell references in formulas (see Appendix B:Accessing Table Cells in 
Script)

• Dynamic table updating

Suppose that all of our big customers have been requesting discounts, and
you therefore decide to give a 5% discount on all large orders. Since you
need to recover the lost revenue incurred by this discount, you will
simultaneously need to increase the sales total on all smaller orders by 5%. 

To implement this discount plan, you need to decide where to place the
boundary between “large order” and “small order” so as to maintain the
company’s total revenue. This ‘price break’ value can be discovered
through what-if analysis.

This example is not available in Style Scope Agile Edition.

In the example below, you will make use of the following components and
methods:

• Embedded Table (see Creating an Embedded Table)

• Joined Table (see Joining Tables)

• Concatenated Table (see Concatenating Tables)

• Group and aggregate options (see Grouping)

• Expression fields (see Creating an Expression/Formula Column)

The completed example is called ‘PriceBreakWhatIf’, and can be found in
the ‘Global Worksheet’ > ‘Tutorial’ folder.

Example: 
What-If Analysis

Assume you have a Worksheet table called ‘Revenue’. The ‘Revenue’
table includes the fields ‘Order Num’ and ‘Product Total’, listing the total
value of each order. Follow the steps below to analyze this data and detect
the proper ‘price break’ threshold for classifying orders as “large” or
“small”:

1. Create a new Embedded Table with one data cell, and name this
table ‘PriceBreak’. It will contain the ‘price break’ value that you
experiment with. In the table cell, enter 40000 as the first guess for
the price break value. This indicates that all orders with a total of
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$40,000 qualify as “large orders”, and all orders with a total equal
to or less than $40,000 qualify as “small orders”.

Next, you will calculate the total sales of all of the large or ‘High End’
orders, and the total sales of all the small or ‘Low End’ orders, both before
and after the discounts/increases are taken into account. You do this in
order to compare the sales revenue before and after the discount model is
put into effect.

2. In the ‘Revenue’ table, group the data by ‘Order Num’ and
summarize by ‘Product Total’ so that you have the total sales
amount for each order.

The data in the ‘Revenue’ table can now be split into two separate tables,
‘HighEnd’ and ‘LowEnd’.

3. To obtain the ‘HighEnd’ table, specify a join between the ‘Product
Total’ column and the ‘PriceBreak’ table, and set the join type to: 

Revenue.Total >= PriceBreak.PriceBreak

4. To obtain the ‘LowEnd’ table, specify a join between ‘Product
Total’ and ‘PriceBreak’ and set the join type to:

Revenue.Total < PriceBreak.PriceBreak

5. For the ‘HighEnd’ table, create an expression field named
‘Discount’ to calculate the new order total with the 5% discount
applied. The SQL formula for the ‘Discount’ expression field
should be set to

field['Total']*0.95

6. For the ‘LowEnd’ table, create an expression field named
‘Increase’ to calculate the new order total with the 5% increase
applied. The SQL formula for the ‘Increase’ expression field
should be set to

field['Total']*1.05

Now that you have the new sales total values for the large and small orders,
you can analyze the benefits of the current ‘price break’ value by
comparing the difference between the original sales total and the new sales
total. 

7. Create a union of the ‘HighEnd’ table and the ‘LowEnd’ table, and
name this Concatenated Table ‘SalesComparison’. Name the right
column ‘NewTotal’, because it contains the totals with discounts
and increases applied.
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8. Apply summarization on the ‘Total’ and ‘NewTotal’ fields of the
‘SalesComparison’ table to produce the final total revenue
numbers.

Now every time you change the ‘price break’ value in the ‘PriceBreak’
embedded table, the values in the ‘SalesComparison’ table are
automatically recalculated. After experimenting with a few numbers, you
learn that $50,000 is the optimal ‘price break’ for applying the new
discount model without affecting the total company revenue.

Figure 2. Price break “What-If’ exploration

In addition to performing what-if experimentation by entering values
manually into an embedded table, you can also adjust table values
graphically by using a Viewsheet input element (slider, spinner, etc.). For
more information about the embedded table interface to Viewsheets, see
Using Form Components in Advanced Dashboard Design.

¢
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APPENDIX A: Toolbar Buttons

Table 1.     Toolbar buttons

BUTTON FUNCTION

Create a new Data Worksheet.

Save the current Data Worksheet.

Save the current Data Worksheet with a different name and 
possibly in a different scope.

Set options relating to the entire Worksheet, such as table size 
limit and availability of data to reports.

Preview the table that is set as Primary in the current Data 
Worksheet.
Undo the changes.

Reapply changes that were undone.

Automatically lay out Worksheet assets with dependent 
elements immediately above their required assets.
Prompt for all input parameters.

Insert a new object into the Worksheet: Embedded Table, 
Variable, or Grouping.

Apply a concatenation to two selected tables: Union, 
Intersection, or Minus.
Apply a join to two selected tables: Merge Join, Cross Join, or 
Inner Join.

Close the Visual Composer window.
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APPENDIX B: Accessing Table Cells in Script

The power of a Worksheet comes from the ability to connect multiple
assets together using drag and drop methods. However, you also provide a
reference-based model for communication between assemblies, and this
allows you to use arbitrary table values within expressions. (See Creating
an Expression/Formula Column for more information about expressions.)
This section describes this simple model for referencing table columns and
cells.

B.1 Cell on the Current Row

Formulas run in the scope of the current row. Each cell value on the current
row can be accessed by indexing into the ‘field’ array using the appropriate
column name or column index. The syntax is as follows:

field['column name']
e.g., 
field['quantity']

field[column idx]
e.g., 
field[3]

For example, if ‘quantity’ and ‘price’ are two columns in the current table,
a formula column in the same table can use the expression

field['quantity'] * field['price']

to produce the product “quantity*price” for every row of the ‘quantity’ and
‘price’ columns. To access the cell values of a different table, see
Appendix B.4, Cell of Any Table.

B.2 Cell on a Previous Row

You can reference the values of preceding rows by their relative offset
from the current row. This feature is useful when creating differential
formulas. The syntax is as follows:

field[relative position]['column name']

e.g.,
field[-1]['Total Sales'] // previous row, in 'Total Sales'
field[-3][3] // three rows above, in column 3

To reference a cell by its absolute position, see Cell of Any Table.

B.3 Column of Any Table

A column with name ‘columnheader’ in a data block with name
‘Tablename’ can be referenced as follows:

Tablename[columnheader]
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B.4 Cell of Any Table

There are several ways to reference a cell in a table. To simply reference a
cell in the current row of the current table, see Appendix B.1, Cell on the
Current Row. 

Referencing by Row Index

To reference an arbitrary cell in any table, you can specify the row location
with a numeric index:

worksheet['Table Name']['columnheader'][row_ix]

If the table has no spaces in its name, you can use the simpler syntax below:

Tablename['columnheader'][row_ix]

For example, the reference 

Customers['CompanyName'][5]

specifies the value in the 5th row (using 0-based indexing) of the
‘CompanyName’ column in the ‘Customers’ table.

Referencing by Value Lookup

Since most data blocks are dynamic, referencing a cell by row index (see
above) should only be used when a table contains a single row, or when
rows are ranked. It is generally more useful to reference a cell by lookup
using the table’s primary key, as shown here:

Tablename["columnheader? primary_key == key_value"]

The “?” should be read as “where,” so the above expression can be read as
follows: “Look in the table named ‘Tablename’, and return the value in the
column named ‘columnheader’ where the primary key is equal to
‘key_value’.”

For example, if a table named ‘Customers’ has ‘customer_id’ as its primary
key, you can reference the cell in the ‘CompanyName’ column having key
‘customer_id’ by using the following expression:

Customers["CompanyName? customer_id == 123"]

Instead of using a fixed key value such as “123” for comparison, you can
also use the field value of the current row in the current table. (See
Appendix B.1, Cell on the Current Row, for the basic field syntax.) For
example, consider a table named ‘Customers’, which contains columns
named ‘CompanyName’ and ‘customer_id’ (the primary key). You can
access values in the ‘CompanyName’ column as follows:

Customers["CompanyName? customer_id == field.local_id"]
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This formula says: “Look in the ‘Customers’ table, and return the value in
the column ‘CompanyName’ where the ‘customer_id’ key is equal to the
value of the current cell in the ‘local_id’ column.”

Example: 
Reference Cell

This example illustrates how you can reference the cells of another table
from within a formula column. You will use the tables in the ‘TABLE’ >
‘SA’ folder of the ‘Orders’ data source to create the table below, which has
columns for product ID, product name, category ID, and category name.

This data source is not available in Style Scope Agile Edition.

1. In the Asset panel, expand the ‘Data Source’ node, the ‘Orders’
node, and the ‘TABLE’ node.

2. Drag the following fields from the ‘TABLE’ > ‘SA’ >
‘PRODUCTS’ table to an empty cell on the Worksheet. (Option-
click the field names to select them all, and then drag them
together.)

PRODUCT_ID
PRODUCT_NAME
CATEGORY_ID 

This creates a new table named ‘PRODUCTS1’.

3. Rename the ‘CATEGORY_ID’ column as ‘CAT_ID’. This will
help to distinguish it from the table you will add next.

4. Drag the ‘TABLE’ > ‘SA’ > ‘CATEGORIES’ table to the
Worksheet. This creates a new table named ‘CATEGORIES1’.

You now want to add a column to the ‘PRODUCTS1’ table that will
contain the category name corresponding to each entry in the ‘CAT_ID’
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column. The best way to do this is by joining the tables (see the Joining
Tables section), but to practice using cell references, you will create this
new column as a formula column. 

5. Press the ‘fx’ button in the ‘PRODUCTS1’ table title row. This
opens the ‘Expression’ dialog box. (See Creating an Expression/
Formula Column for more information.)

6. Enter ‘CAT_NAME’ as the name of the new expression column,
and click ‘OK’. This opens the Formula Editor.

7. In the Formula Editor, enter the following formula:

CATEGORIES1["CATEGORY_NAME? CATEGORY_ID==field['CAT_ID']"]

This formula says: “Look in the ‘CATEGORIES1’ table, and
return the value in the column ‘CATEGORY_NAME’ where the
‘CATEGORY_ID’ key is equal to the value of the current cell in
the ‘CAT_ID’ column.”

8. Uncheck the ‘SQL’ option at the top-right of the Editor.

9. Click ‘OK’ to close the Formula Editor. The two tables are now
connected by a graphical link to indicate that the ‘PRODUCTS1’
table references the ‘CATEGORIES1’ table.

10. For each table, press the ‘Change View’ button in the table title bar,
and select ‘Live Preview’ from the menu. Expand the table borders
as needed to view the results.

As desired, the formula column in the ‘PRODUCTS1’ table now
displays the category name corresponding to each entry in the
‘CAT_ID’ column.
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APPENDIX C: Built-in Ranges and Groupings

This appendix lists various predefined ranges and groups.

C.1 Built-in Date Ranges

The following built-in date ranges are available in filtering conditions for
data blocks. See the Filtering section for information about using these
predefined ranges. 

The explanation of the last five ranges is as follows:

• Year to date last year: The same date range provided by the ‘Year to 
date’ option (i.e., beginning of year to present date), but offset to the 
previous year. For example, if today is Nov. 8, 2011, the range selected 
by ‘Year to date last year’ is Jan. 1, 2010–Nov. 8, 2010.

• Month to date last month: The same date range provided by the ‘Month 
to date’ option (i.e., beginning of month to present date), but offset to the 
previous month. For example, if today is Nov. 8, 2011, the range 
selected by ‘Month to date last month’ is Oct. 1, 2011–Oct. 8, 2011.

• Quarter to date last quarter: The same date range provided by the 
‘Quarter to date’ option (i.e., beginning of quarter to present date), but 

Last year Last month last year Last July
This year This month last year Last August
Last quarter This January Last September
This quarter This February Last October
Last quarter last year This March Last November
This quarter last year This April Last December

1st Quarter this year This May Last week

2nd Quarter this year This June This week

3rd Quarter this year This July Week before last week

4th Quarter this year This August Last 7 days

1st Quarter last year This September Last 8-14 days

2nd Quarter last year This October Last 4 weeks

3rd Quarter last year This November Last 5-8 weeks

4th Quarter last year This December Last 30 days

1st half of this year Last January Last 31-60 days

2nd half of this year Last February Year to date last year

1st half of last year Last March Month to date last month 

2nd half of last year Last April Quarter to date last quarter 

Last month Last May Month to date last year
This month Last June Quarter to date last year
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offset to the previous quarter. For example, if today is Nov. 8, 2011, the 
range selected by ‘Quarter to date last quarter’ is July. 1, 2011–Aug. 8, 
2011.

• Month to date last year: The same date range provided by the ‘Month to 
date’ option (i.e., beginning of month to present date), but offset to the 
previous year. For example, if today is Nov. 8, 2011, the range selected 
by ‘Month to date last year’ is Nov. 1, 2010–Nov. 8, 2010.

• Quarter to date last year: The same date range provided by the ‘Quarter 
to date’ option (i.e., beginning of quarter to present date), but offset to 
the previous year. For example, if today is Nov. 8, 2011, the range 
selected by ‘Quarter to date last quarter’ is Oct. 1, 2010–Nov. 8, 2010.

C.2 Built-in Date Groupings

The following built-in date groupings are available for columns with a Date
format. 

Table 2.     Built-in date grouping

See the Grouping section for information about using these predefined
groupings. See Creating a Named Grouping for information about creating
alternative groupings.

DATE GROUP VALUE IN THE GROUP COLUMN

Year Date grouped at the year level
Quarter Date grouped at the quarter level
Month Date grouped at the month level
Week Date grouped at the week level
Day Date grouped at the day level
Hour Date grouped at the hour level
Minute Date grouped at the minute level
Second Date grouped at the second level
Quarter of Year Ordinal number: 1st, 2nd, 3rd, 4th
Month of Year Month name: Jan, Feb, etc.
Week of Year Numbers 1-52
Day of Month Numbers 1-31
Day of Week Day of week name: Sun, Mon, etc.
Hour of Day Numbers 0-23
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Advanced Dashboard 
Scripting 

Certain dashboard applications require you to implement a degree of
intelligence and adaptability that would be difficult or impossible to design
using only basic Viewsheet components. For example, you may wish to
hide or show certain dashboard components under particular conditions,
such as when a user’s selection return no data. Likewise, you might wish to
present an alert message if a certain key indicator does not meet its target.

For these purposes, Style Intelligence provides an embedded scripting
environment for Viewsheets. The scripting environment allows you to
implement event-driven logic that adaptively modifies dashboard
appearance and behavior based on retrieved data, inputs from users, or
other factors such as day, time, locale, etc. The scripting language is
intended to be simple but powerful, requiring only minimal programming
knowledge.

The scripting language is based on the ECMA-262 (JavaScript) standard.
Since there are many outstanding books on JavaScript and the full
specification of the language is available online, this Guide does not
attempt to be a JavaScript reference. Instead, it provides a short
introduction to JavaScript, but concentrates on the host Viewsheet
environment and examples of common Viewsheet scripting.

http://www.ecma-international.org/publications/standards/Ecma-262.htm
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1 Introduction to JavaScript Programming

Netscape originally introduced JavaScript as the scripting language for its
Navigator web browser. The scripting language allows code to be
embedded in HTML pages and executed inside a browser, which acts as
the host environment for the scripts. The browser exposes HTML page
elements and browser controls to the scripts as host objects and functions.
By manipulating these host objects, JavaScript is able to control the
behavior of the browser and add interactivity to the web pages.

Since the release of Netscape Navigator 2.0 and Microsoft Internet
Explorer 3.0, JavaScript has established itself as the standard browser
scripting language. Subsequent standardization efforts have produced the
specification known as ECMA-262, which is the standard implemented in
Style Intelligence.

As a standardized scripting language, JavaScript provides an excellent
foundation for report scripting needs. Its origin as a web scripting language
makes it ideal for the reporting environment. The integration of JavaScript
with Style Intelligence therefore combines two powerful paradigms for
report generation and gives developers maximum flexibility in controlling
reports and user interactions.

The purpose of this section is to provide a broad overview of JavaScript
programming, and how JavaScript can be embedded in Viewsheets. A
simple JavaScript reference is provided in Appendix JS: General
JavaScript Functions. To find more complete coverage, please refer to a
JavaScript book or tutorial website (e.g., http://www.w3schools.com/js). 

If you are already familiar with the JavaScript language, you can skip
ahead to Adding Script to a Viewsheet, which explains the different areas of
a Viewsheet to which you can add script.

1.1 Server-Side vs. Client-Side Scripting
In Web development, JavaScript is used to add client-side scripting to
HTML pages. Scripts are embedded into the contents of a Web page and
executed inside the client browser. Traditionally, these client-side scripts
deal exclusively with user-browser interactions, and have limited server-
side actions (e.g., HTTP requests).

In contrast, Viewsheet scripting is server-side scripting. The scripts
contained in a report are executed as part of the report generation process
on the server. Style Intelligence scripts can also control certain client-side
interactions through event handlers and hyperlinks. 

http://www.ecma-international.org/publications/standards/Ecma-262.htm
http://www.w3schools.com/js/
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1.2 Object-Oriented Concepts
JavaScript is an object-oriented programming (OOP) language, and
provides various objects and methods, as well as the ability to create user-
defined methods. To use JavaScript effectively, it is important to
understand the following concepts:

• Properties: Properties are predefined attributes associated with an 
object. You can ‘get’ or ‘set’ these properties to observe or alter the 
corresponding aspects of the object. 

• Methods: Methods are predefined functions associated with an object. In 
general, these functions operate on the object itself.

• Events: Events are predefined actions that are recognized by an object, 
such as a mouse movement or clicking.

1.3 JavaScript Language Basics
JavaScript syntax is very similar to that of C++ and Java. It uses the same
construct for all loops and has similar syntax for operators. The following is
a typical script:

var total = 0;

for(var i = 1; i < Table1.table.length; i++) {
total += parseInt(Table1.table[i][1]);

}

text = (total / Table1.table.length).toFixed(2);

This section covers the basics of programming with JavaScript.

Comments and Names

JavaScript uses double slashes ‘//’ to start a single line comment and ‘/* */’
to enclose a multi-line comment.

// single line comment
/* multi-line

comment */

The semicolon is used as a statement separator: 

var n = 0;
k = parseInt(123);

Variable names can only contain alphanumeric characters plus the
underscore character (_). They cannot start with a digit and cannot use
reserved JavaScript words. 

All symbols in JavaScript are case-sensitive.
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Declaration and Assignment 

JavaScript is a weakly-typed language. This means variables are not
assigned a type. A variable can be assigned any value. “The type of the
variable is determined by the value currently assigned to it. Consequently, a
local variable does not need to be declared before it is used.

var variable_name= "Hello"; // -- recommended
message1= "Hello"; // -- will also work
var count = 100; 

If a variable is used as a report level variable, it must be declared using the
‘var’ keyword.

// put this in onRefresh handler
var pageTotal = 0;

After the variable is declared, it can be used everywhere as a shared report
instance variable.

Object Types and Scopes

JavaScript is object-based. This means that every value in JavaScript is an
object. As with any Object Oriented language, the properties and methods
are associated with each object and need to be invoked by qualifying the
names with the object name. 

// the following statements are equivalent
var name = first_name.concat(last_name);
name = first_name + last_name;

As is the case in C++ and Java, if a script is running inside an object scope,
it can reference its properties and methods without qualifying the name.
There is a global scope in JavaScript, which provides the common
methods. Since every script is running inside a global scope, those methods
do not need to be qualified. 

// parseInt() is a global method
var num = parseInt(parameter['count']);
// toFixed() is a number method, so it needs to be 
qualified
var int_num = num.toFixed(0);

Number Type 

JavaScript does not have an integer type and a float type. All numbers are
treated as float by default.

var total = 2 + 3;
text = total; // this will convert the number to 5.0

To force a number to be treated as an integer, use the toFixed() method of
number object and give a decimal point of zero:
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text = total.toFixed(0); // this generates a string 5

Number constants can be in decimal format, hexadecimal format if it starts
with ‘0x’, and octal format if it starts with ‘0’.

decimal_number = 255 // -- Decimal is the default
hex_number = 0xff
fp_number = 2.456 // -- Floating point number 

Numbers can be used in computation using the usual operators, +, *, /, -.
The increment and decrement operators (++, --) are also available in Java.

Boolean Type

A Boolean has a value of true or false.

while(true) {
}

All undefined values are treated as false Boolean values when used in the
context of a condition. You can check if a value is defined by using the
value in the if() condition as in

if(parameter['start_time']) {
// do something

}

String Type

Enclose String constants with a single or double quote: 

var mystring = "InetSoft Technology Corp."
mystring = 'InetSoft Technology Corp.'

Strings can be concatenated using the plus operator:

var str = 'Total: ' + total;

If a value concatenated to a string is of a different type, it is converted to a
string automatically. Strings have many methods, with the most frequently
used including: substring(), toLowerCase(), toUpperCase() and indexOf(). 

var str = 'abcd';
str = str.toUpperCase(); // converts to ABCD
var bIdx = str.indexOf('B'); //return 1
str = str.substring(1, 2); // return 'B'

Strings have built-in support for regular expressions. You can find a regular
expression in a string using the match() or search() method:

str = 'this is a test of regular expression';
re = /test/; // create a regular expression
var idx = str.search(re); // return the position of the 
regular expression
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Date Type

Date is represented as milliseconds since EPOC (Equipment Point of
Connection). Creating a date object with no parameter gives the current
time:

var now = new Date();

A date can be converted to a string using a global function, formatDate().

str = formatDate(now, 'yyyy-MM-dd'); // 2002-02-21

The date format uses the same syntax as in java.text.SimpleDateFormat.

Arrays

An array literally is a list contained in a single variable. Each item in the list
is known as an array element and is enclosed in square brackets ([]). When
you create an array, it is initialized with the specified values as its elements.
Its length is set to the number of elements specified. The following
example creates the coffeelist array with three elements and a length of
three:

coffeelist = ["French Roast", "Columbian", "Kona"];

Multidimensional Arrays are represented by an array of arrays. A
multidimensional array (rows and columns) may be created as follows:

monthly_rain = [['Jan', 'Feb', 'Mar'],
[100,10,30],
[30,10,300], 
[10,10,10]]; 

Conditionals

The if/else statement requires a boolean expression to decide between two
alternative actions. 

if (x > 0) {
reg = event.region;

}
else {
reg = event.firstRegion;

} 

For Loop

A for loop instructs the computer to repeat an action a specific number of
times. 

//for (initial, condition-check, increment)
for (var j = 1; j < 10; j++) {
total = parseFloat(report['Table'].table[reg.y + j][3]);

}

http://docs.oracle.com/javase/8/docs/api/java/text/SimpleDateFormat.html
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The first expression in the loop initializes the loop variable. The second
expression is a condition used to check when to terminate the loop (when it
is false). The third expression is the increment that is evaluated at the end of
every iteration.

While Loop

The while loop iterates until the condition becomes false. 

var n = 5;
Text1.text = "The factorial of " + n;
var fact = 1;

// -- Compute n!, where n is a non-negative integer
while (n > 1) {
fact = fact * n;
n = n -1;

}

Text1.text += " is " + fact; 

The break command can be used inside any loop to terminate the loop and
‘continue’ can be used to skip to the next iteration.

Switch Statement

A switch statement chooses a branch to be executed based on a value. One
or more values can be listed on each case. A ‘break’ must be included at the
end of each case to terminate the switch statement.

switch(action) {
case 'A':
text = 'Add';
break;

case 'D':
text = 'Default';
break;

default:
text = "N/A";
break;

}

The default label at the end serves as a catch-all phrase. If the switch value
does not match any of the listed values, the default section is processed.

Functions

JavaScript, like most programming languages, has facilities for creating
subprograms to modularize or divide programs into distinct functions.
When required, a function can be called to carry out a particular task. 

JavaScript functions behave a little differently than you might expect:

• There is no value reference distinction

• There is no data type distinction
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• Return values do not have data types and are optional

function max(a,b) // -- Multiple Returns
{
if (a > b)
return(a); // -- Return a because it is larger

else
return(b); // -- Return b because it is larger

} 

To create and save a custom JavaScript function, see Using the Script
Library in Advanced Report Scripting.

1.4 Useful Text/String Functions
Two common string operations are changing case and searching for
substrings.

1.4.1 Changing a String to Upper/Lower Case

To change a string to upper/lower case, use the ‘toUpperCase()’ and
‘toLowerCase()’ functions respectively. For example:

var s = 'John Lennon';
Text1.text = s.toLowerCase();

To change the header cells of a table to upper case, add the following lines
to the table-level script:

for(var col = 0; col <Table1.table.size; col++) {
Table1.table[0][col] = 

Table1.table[0][col].toUpperCase();
}

1.4.2 Searching Within a String

To find one string within another string, use the ‘indexOf()’ function. The
‘indexOf’ function returns the starting index of the substring within the
parent string. If the substring is not found, it returns a value of -1. For
example:

var state = 'New Jersey';

if(state.indexOf('New') > -1) {
Text1.text = 'With New';

}
else {
Text1.text = 'Without New';

}

1.5 Useful Date Functions
This section discusses several basic date functions.
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1.5.1 Finding Difference Between Dates 

The ‘dateDiff()’ function is used to find the difference between two dates in
days/months/years.

dateDiff('d', fromDate, toDate); // days
dateDiff('m', fromDate, toDate); // months
dateDiff('yyyy', fromDate, toDate); // years

For example, if you have a table bound to a query which contains the date
field ‘Birth Date’, you can create a formula field (in the data binding
dialog) that calculates the age of this Birth Date in years by subtracting the
birthday from the current date. The script of this formula field is shown
below.

dateDiff('yyyy', field['Birth Date'], CALC.today())

1.5.2 Calculating a Past or Future Date

The ‘dateAdd()’ function is used to find a date which is n number of days/
months/years before/after another date. 

// 1 day before today
dateAdd('d', -1, CALC.today()); 

// 5 months after today
dateAdd('m', 5, CALC.today());    

// 3 years before Order Date
dateAdd('yyyy', -3, field['Order Date']);

For example, wish to run a query in script; this query takes in two date
parameters namely ‘StartDate’ and ‘EndDate’. You want the query to
always fetch data which is 15 days before the today and 15 days after today. 

var sd =   dateAdd('d', -15, CALC.today());
var ed =   dateAdd('d',  15, CALC.today());
var q = runQuery('Order Bookings', [['StartDate', 
sd],['EndDate', ed]]);

1.5.3 Extracting a Date Component

When extracting calendar elements within a date (year, month, quarter,
etc.) use the date functions within the CALC function library. For example:

//extracting the current date and time
var todDate = CALC.today(); //e.g., Feb-21-2007

//extracting the year
var y = CALC.year(todDate); // 2007

//extracting the quarter
var q = CALC.quarter(todDate); // 1

//extracting the day of the week
var dow = CALC.weekdayname(todDate); // Wednesday



DATA MASHUP

729 of 1397

//extracting the date
var d = CALC.day(todDate); // 21

//extracting the month
var m = CALC.month(todDate); // 2

1.5.4 Formatting a Date

Date fields can be formatted in script using the ‘formatDate()’ function. For
example:

var d = CALC.today();  // e.g., Feb-21-2007
Text1.text = 'Today Is: ' + formatDate(d, 'MM-dd-yy');
// Today Is: 02/21/07

1.6 Protecting a Viewsheet from Script Errors
Because scripts are executed when the Viewsheet is generated on the
server, a script error can cause Viewsheet generation to fail. To prevent this
from happening, you should wrap error-prone code inside a “try-catch”
block, which allows you to trap errors before they affect Viewsheet
execution. See Appendix JS.5.4, The ‘try-catch’ Statement, for more
information.

See Also
Debugging a Viewsheet Script, for information on locating errors.

1.7 Debugging a Viewsheet Script
When you attempt to debug a Viewsheet script, it is often helpful to view
the current values of variables and objects. To do this, use the alert()
function, which opens a dialog box to display a specified string.

alert('string to display')

Note: The alert() function does not pause script execution.

For example:

var arr = ['Sue','Robert','Eric'];
alert(arr.join(","))

You can also use the alert() dialog box to display critical information to a
user (e.g., that the user’s selections have resulted in an empty dataset being
returned).
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See Also
Protecting a Viewsheet from Script Errors, to improve Viewsheet
robustness.
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2 Adding Script to a Viewsheet

There are three levels at which you can attach script in a Viewsheet:

1. Property level: Attach script as a property expression to
dynamically modify property values (e.g., visibility, color, etc.) of
the host component. See Adding Property Script (Expressions). 

2. Component level: Attach script to an individual component
(Chart, Gauge, etc.) to modify component properties, including
properties that cannot be set by an expression, or to implement
other logic. See Adding Component Script.

3. Viewsheet level: Attach script in one of two global domains, the
onInit Handler or the onRefresh Handler. See Adding Viewsheet
Script for more information.

2.1 Script Evaluation Order
Unlike conventional JavaScript on web pages, JavaScript that you embed
in a Viewsheet is executed as part of the Viewsheet generation process on
the server, not the client browser. However, scripts can control client-side
interactions through event handlers and hyperlinks. 

The overall sequence of Viewsheet script evaluation is as follows.

1. Execute the onInit Handler. 

2. Execute the onRefresh Handler. 

3. Execute all component-level scripts. (See Adding Component
Script.)

The onInit Handler executes only once, when the Viewsheet is first loaded.
It can be used to initialize variables and define parameters. The onRefresh
Handler re-executes each time the Viewsheet is refreshed by a user
operation. 

Component scripts and property expressions are re-executed whenever the
particular component is refreshed due to a user operation (on the
component itself, or on a related component). Because the order in which
individual component scripts are initially executed is not determined, you
should avoid setting properties of one element from within a script attached
to a different element.
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2.2 Accessing Java in Script
You can call both JavaScript and Java functions from within Viewsheet
scripts. However, scripts are executed in a restricted environment that
provides access only to the following Java packages: java.awt, java.text,
java.util, java.sql, inetsoft.graph.*, inetsoft.report,
inetsoft.report.lens, inetsoft.report.filter, inetsoft.uql, and
inetsoft.report.painter. 

To permit scripts to access Java packages other than those listed, an
administrator can set the javascript.java.packages property in the
sree.properties file to specify additional packages. To add package contents
to the current namespace, use importPackage('packageName'). For
example, importPackage('java.lang') or importPackage(java.lang)

allows scripts to refer to object names without full qualification (i.e.,
'String' rather than 'java.lang.String').

2.3 Adding Property Script (Expressions)
You can enter a script in any property field that provides an ‘Expression’
option.

For example, to add a script to a component expression field, follow the
steps below:

1. Right-click the component, and select ‘Properties’ from the context
menu. This opens the ‘Properties’ dialog box.
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2. In the ‘Properties’ dialog box, find the property you wish to
dynamically change. (In the example, we use the ‘Visible’ property
under the General tab.)

3. Click the arrow button next to the property you want to modify, and
select ‘Expression’ from the menu. This enables a small ‘Edit’
button.

4. Press the ‘Edit’ button. This opens the Formula Editor.

Note: The script must
return one of the
options in the
property menu. For
example, return
values for the
‘Visible’ property
must be one of
“Show,” “Hide,” or
“Hide on Print and
Export.” (To achieve
“Show on Print and
Export” behavior, use
the special expression
“!visible”.)

5. In the Formula Editor, enter the desired script. For example, the
following script hides the component if the user has selected ‘Hide’
from a RadioButton control, and the current month is March (i.e.,
the third month).

if ((RadioButton1['selectedObject']=='Hide') & 
(CALC.today().getMonth() == 3)) {
"Hide"

}
else {

"Show"
}

To automatically insert a function (such as CALC.today()), click the
corresponding option in the ‘Functions’ list above the edit area. To
automatically insert a reference to another component’s property,
click the corresponding option in the ‘Component’ list above the
edit area
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6. Click ‘OK’ to close the Formula Editor, and click ‘OK’ to close the
‘Properties’ dialog box.

Note: An expression script can reference properties of its hosting
component without full qualification. For example, in a script
placed on component Chart1, 'Chart1.selectedObject' and
'selectedObject' refer to the same property.

Expressions must always return permissible values for the corresponding
property. For example, if a property requires an integer, an expression that
sets that property must evaluate to an integer. If a property requires one of a
fixed set of options, e.g., {‘Rows’, ‘Columns’}, then the expression that
sets that property must evaluate identically to one of those strings (‘Rows’
or ‘Columns’).

See Also
Dynamic Properties, in Advanced Dashboard Design, to set properties
with Input components.
Matching Dynamic Values to Property Values, in Advanced Dashboard
Design, for required return values.
Introduction to JavaScript Programming, for information on JavaScript
programming.

2.4 Adding Component Script
Note: Text element script does not re-execute when the user makes
Viewsheet selections. To re-execute script that modifies a Text
element, place the script in the onRefresh Handler.

A script attached to a Viewsheet component is evaluated whenever the
component is refreshed, which includes initial Viewsheet loading, and user
interactions with the component. The script can change the properties of
the element, including visibility. 

Properties set in script override properties set in the component
‘Properties’ dialog box.
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In fact, a component script can access any component in the Viewsheet.
However, it is not good practice to modify the properties of one element
from within the script of another element. See Debugging a Viewsheet
Script for alternative approaches.

To attach a script to a Viewsheet component, follow the steps below. 

1. Right-click the desired component, and select ‘Properties’ from the
context menu. This opens the ‘Properties’ dialog box.

2. Select the Script tab to open the Script Editor.

Do not attach an onClick script to a component that already has a
hyperlink.

3. Select the Script or onClick radio button at the bottom of the
dialog box. 

Note: An expression script can reference properties of its hosting
component without full qualification. For example, in a script
placed on component Chart1, 'Chart1.selectedObject' and
'selectedObject' refer to the same property.

4. Type the desired script in the text field, and press ‘OK’.

5. (Optional) To disable a script (without deleting it entirely), uncheck
the ‘Enable Script’ option at the bottom right corner of the Script
Editor.

Components with script are shown with a blue asterisk. Click on the
asterisk to open the script in the Script Editor.
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See Also
Script Evaluation Order, for the order of script evaluation.

2.4.1 Common Component Properties

All elements share a basic set of properties, including foreground,
background, font, alignment, visibility, etc. The following sections explain
how to use these properties.

Color Property

Color properties (foreground/text and background/fill) are frequently used
to highlight a text or textbox element. The simplest way to specify a color
property is to assign a string containing one of the constants from the
java.awt.Color class: black, blue, cyan, darkGray, gray, green, lightGray,
magenta, orange, pink, red, white, and yellow.

foreground = 'red';

Since color is a Java type, the class name must be fully qualified.

You can also specify a color as java.awt.Color object, an integer (e.g.,
hexadecimal) representing the RGB value of a color, an array of RGB
values, or a JSON object.

foreground = java.awt.Color.red;
background = 0xFF0000; // RRGGBB
foreground = [255, 0, 0];
foreground = {r:255,g:0,b:0};

Alternatively, you can create a color object by calling the constructor with
the ‘new’ operator. 

foreground = new java.awt.Color(0.5, 1, 0);

Note that the parameters to the color constructor have type float. Because
JavaScript treats all numbers as float by default, you have to explicitly
convert them to integer if you want to specify the RGB values in the range
of 0-255. The default float parameters pass the RGB value in the range of
0-1, where 1 is equivalent to 255 in the integer version. 

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
http://json.org/


DATA MASHUP

737 of 1397

Font Property

You can specify the font property with a string containing the font name,
style, and size, separated by dashes, or by creating a java.awt.Font object.

font = 'Verdana-BOLD-12';
font = new java.awt.Font('Verdana', java.awt.Font.BOLD, 12);

The name of the font can be a TrueType font name, or a logical font name.
Logical font names are not recommended, however, because the logical
font may be replaced by a different font in the runtime environment. 

There are three font styles, Font.PLAIN, Font.BOLD and Font.ITALIC. The
styles can be combined with a bitwise OR.

font = new java.awt.Font('Verdana', java.awt.Font.BOLD | 
java.awt.Font.ITALIC, 12);

The final parameter specifies the size of the font. Style Intelligence
provides an extended font that supports additional styles:

Table 4.     Font Styles

To create an extended font, you must use the fully qualified name of
inetsoft.report.StyleFont class.

font = new inetsoft.report.StyleFont('Verdana',
java.awt.Font.BOLD | 
inetsoft.report.StyleFont.UNDERLINE, 12,
StyleConstant.THIN_LINE);

The final parameter specifies the line style used to draw the underline. 

See Also
Appendix JS.4, StyleConstant Object, for commonly-used constant values.

Visibility Property

You can dynamically hide or show an element using script. Typically, you
would test a condition or user input at runtime, and then hide one or more
elements to present an appropriate view.

FONT STYLE DESCRIPTION

Underline Draw an underline below the text. The line style can be 
any one of the Style Intelligence Line Styles.

Strikethrough Draw a line through the text in the middle.
Superscript Draw the text at the upper corner of the previous text.
Subscript Draw the text at the lower corner of the previous text.
Smallcaps Draw all letters in capital letter, but draw the lowercase 

letters in a smaller size.
Allcaps Convert all letters to uppercase.
Shadow Draw the text with a shadow effect.

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Font.html


DATA MASHUP

738 of 1397

if(field['discount'] == 0) {
Text8.visible = false;

}

As for all element properties, you should change the visibility of an
element only from within a script attached to the same element, or from
within the onRefresh Handler. Otherwise, the location of the element in the
report may influence the outcome.

See Also
Debugging a Viewsheet Script, for information on making scripts self-
contained.
Script Evaluation Order, for information about order of evaluation and its
effects.

Alignment Property

To align text within
Text elements, use the
Report Designer
alignment controls.

The Alignment property controls both the horizontal and vertical alignment
of report elements in the page layout. The horizontal alignment is specified
by the alignment constants H_LEFT, H_CENTER, and H_RIGHT. (See
Alignments.)

alignment = StyleConstant.H_CENTER;

The vertical alignment property can be combined with the horizontal
alignment property by using the bitwise OR.

alignment = StyleConstant.H_CENTER | 
StyleConstant.V_CENTER;

The four vertical alignment options are V_TOP, V_CENTER, V_BOTTOM, and
V_BASELINE.

See Also
Appendix JS.4, StyleConstant Object, for commonly-used constant values.
Text, for more information about Text properties.

2.5 Adding Viewsheet Script
To create a global Viewsheet script, follow the steps below:

1. Click ‘Options’ button in the toolbar to open the ‘Viewsheet
Options’ dialog box. 

2. Click the Script tab. This opens the Script Editor. 
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3. Using the radio buttons at the bottom, select either onInit or
onRefresh.

4. Enter the desired script, and press ‘OK’.

To temporarily disable a script (without deleting it entirely), uncheck the
‘Enable Script’ option at the bottom right corner of the Script Editor.

The following sections provide additional information about the onInit
Handler and onRefresh Handler.

See Also
Adding Script to a Viewsheet, for information about scripting elements.

2.5.1 onInit Handler

A Viewsheet’s onInit script is executed only once, when the Viewsheet it
first loaded. It is ideal for one-time initialization tasks, such as defining
Viewsheet parameters and variables.

A variable declared in onInit script will have global scope, and be
accessible to individual component scripts. To declare a local variable with
the same name elsewhere, use the ‘var’ keyword in the declaration to
remove ambiguity.

See Also
onRefresh Handler, to declare report-level variables, or validate user
parameters.
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2.5.2 onRefresh Handler
The onRefresh script
does not execute
when you refresh a
Preview by clicking
the Preview tab. To
run the onRefresh
script, create a new
Preview. (See
Previewing a
Dashboard in
Advanced Dashboard
Design.)

The onRefresh handler is similar to the onInit handler, and is executed
following onInit upon Viewsheet loading. However, unlike onInit, an
onRefresh script is executed every time the Viewsheet is refreshed. Because
the Viewsheet is refreshed in response to most user interactions, including
selections, the onRefresh handler gives you the ability to dynamically
modify multiple elements from a central location.

A variable declared in onRefresh script will have global scope, and will be
accessible to individual component scripts. To declare a local variable with
the same name elsewhere, use the ‘var’ keyword in the declaration to
remove ambiguity.

See Also
Chart bindingInfo Property, for information on data binding for Charts.
onInit Handler, to declare session-level variables or report parameters.
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3 Accessing User Input in Script

Tabs have a property
‘selectedIndex’ which
returns the numeric
representation of the
active tab.

You can access the state of different components within the Viewsheet
using the selectedObject, selectedObjects, and drillMember keywords.
See Walkthrough: Accessing User Selections for an example using
selectedObject. See Walkthrough: Interactive Chart Drilldown for an
example using drillMember.

• selectedObject, selectedLabel: The selected value or label of the 
component: Applies to single value input elements (Sliders, Radio 
Buttons, etc.) and the tabs of co-located components. For example, to 
return the value or label selected in a radio button control:

radioButton.selectedObject
radioButton.selectedLabel

• selectedObjects, selectedLabels: An array of values or labels selected in 
a component: Applies to multi-value input elements (e.g., Check Boxes) 
and selection elements (Selection Lists and Trees). For example, to 
return the first selected item or label in a Selection List:

SelectionList.selectedObjects[0];
SelectionList.selectedLabels[0];

• drillMember: For Selection Trees, the name of the field that resides one 
level in the hierarchy below the user’s lowest selected level:

SelectionTree.drillMember;

You can manually type these references into your script, or enter them
automatically by clicking the appropriate node on the ‘Component’ tree of
the Script Editor.

See Also
Accessing User-Modified Data in a Table, for information on accessing
user table edits. 
Accessing the Most Recent User Modification, for information on
accessing the last user edit.
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3.1 Walkthrough: Accessing User Selections
Walkthrough This example uses a RadioButton to give the user a choice of two input

options, a Selection List, and a Range Slider. Follow the steps below:

This Worksheet can
be found in the ‘Tuto-
rial’ folder, or in the
‘Orders’ data set
folder in Agile Edi-
tion.

1. Create a new Viewsheet based on the ‘ProductSales’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Add a table, Selection List, and Range Slider. To do this, follow the
steps below:

a. Drag the ‘SalesByDate’ Data Block into the Viewsheet. This
creates a new table called ‘SalesByDate’. Resize the table as
desired.

b. From the ‘SalesByDate’ Data Block in the Component tree,
drag the ‘State’ column to an empty region on the Viewsheet.
This creates a new Selection List named ‘State’.

c. From the Component tree, drag a Range Slider control into the
Viewsheet. This creates a new Range Slider.

d. From the ‘SalesByDate’ Data Block in the Component tree,
drag the ‘Date’ column onto the Range Slider. This binds the
Range Slider to the Date field.

3. Create a control to allow the user to select the input method. Follow
the steps below:

a. From the Component tree, drag a Radio Button control into the
Viewsheet. This creates a new Radio Button.

b. Right-click the RadioButton, and select ‘Properties’ from the
context menu. This opens the ‘Properties’ dialog box.

c. In the RadioButton ‘Properties’ dialog box, enter the text
“DateOrState” in the ‘Name’ field. Enter the text ‘Selection’ in
the ‘Title’ field.

d. In the ‘List Values’ panel of the ‘Properties’ dialog box, select
‘Embedded’ and click the ‘Edit’ button. This opens the
‘Embedded List Values’ dialog box.

e. Click ‘Add’. For the first ‘Label’ enter the text “Select Date
Range.” For the corresponding ‘Value’, enter the text “Date”. 
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f. Click ‘Add’ again. For the second ‘Label’ enter the text “Select
States.” For the corresponding ‘Value’, enter the text “State”.

g. Click ‘OK’ in both dialog boxes. This creates a Radio Button
with two choices from which the user can select the input
method.

4. Add expression scripts to the Selection List and the Range Slider so
that the appropriate control is enabled for the given user selection.
Follow the steps below:

a. Right-click the Selection List, and select ‘Properties’ from the
context menu to open the ‘Properties’ dialog box.

b. For the ‘Enabled’ option, click the right-side pop-up menu, and
select ‘Expression’. Then click the ‘Edit’ icon to open the
Formula Editor.
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c. In the Formula Editor for the Selection List, enter the following
script:

if (DateOrState.selectedObject=='Date') {
false

}
else {

true
}

This indicates that the Selection List control should be disabled
whenever ‘Date’ is selected in the “DateOrState” RadioButton,
and enabled otherwise.

d. Click ‘OK’ twice to exit the Formula Editor and the ‘Properties’
dialog box.

e. Repeat the above steps for the Range Slider, and set the
‘Enabled’ script as follows:

if (DateOrState.selectedObject=='Date') {
true

}
else {

false
}

f. Click ‘OK’ twice to exit the Formula Editor and the ‘Properties’
dialog box.

5. Preview the Viewsheet, and experiment with the controls.
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You can hide the
control completely by
adding similar scripts
(returning values
‘Show’ and ‘Hide’) to
the ‘Visibility’
property.

Note that when you choose ‘Select Date Range’, only the Range Slider is
enabled, and when you choose ‘Select States’, only the Selection List is
enabled.

3.2 Walkthrough: Interactive Chart Drilldown
Walkthrough In this example, you will create a Selection Tree that filters the

geographical regions displayed on a Chart. You will use the drillMember
property of the Selection Tree to dynamically adapt the Chart X-axis to
display the appropriate geographical level (Region, State, or City), based
on user selections.

Follow the steps below:

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders’ data set
folder in Agile Edi-
tion.

1. Create a new Viewsheet based on the ‘Sales Explore’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. From the Component panel, drag a Chart component into the
Viewsheet grid. Resize the Chart as desired.

3. From the Component panel, drag a Selection Tree component into
the Viewsheet grid.

4. Add a three-level geographical hierarchy to the Selection Tree.
Follow the steps below:

a. Expand the ‘Sales’ Data Block in the Component panel.

b. Drag the ‘Region’ field from the Data Block onto the Selection
Tree. This adds the ‘Region’ data to the tree.

c. Drag the ‘State’ field from the Data Block onto the Selection
Tree. This adds the ‘State’ data to the tree.

d. Drag the ‘City’ field from the Data Block onto the Selection
Tree. This adds the ‘City’ data to the tree.

e. Resize the Selection Tree so that it can display a reasonable
number of options.
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5. Press the ‘Edit’ button on the Chart to open the Chart Editor.

6. From the Data Source panel of the Chart Editor, drag the ‘Total’
field (Under ‘Measures’) to the ‘Y’ region in the Data panel.

7. From the Data Source panel of the Chart Editor, drag the ‘Region’
field (Under ‘Dimensions’) to the ‘X’ region in the Data panel.

8. Configure the Chart to adapt the X-axis binding based on the user’s
selection in the Selection Tree. To do this, follow the steps below:

a. Press the “arrow” button next to the ‘Region’ dimension in the
Data panel. In the pop-up menu, select the ‘Expression’ option.

b. Press the ‘Edit’ button to open the Script Editor.

c. In the top-left panel of the Script Editor, expand the
‘SelectionTree1’ node, and click ‘drillMember’. This adds the
SelectionTree1.drillMember property in the editing area.
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The drillMember property returns the name of the field that
resides one level (in the Selection Tree hierarchy) below the
lowest level that the user has selected. Thus, if the user has
selected one or more states in the Selection Tree,
SelectionTree1.drillMember returns the string ‘City’.

d. Press ‘OK’ in the Chart Editor. The output of
SelectionTree1.drillMember is now assigned to the Chart X-
axis binding.

9. Verify that the X-axis binding adapts to the user’s selections:

a. Press the ‘Clear Selection’ button in the Selection Tree to
remove any existing selections. Observe that the Chart X-axis
now represents the ‘Region’ dimension, the top level of the
Selection Tree hierarchy.

b. Select the ‘USA East’ option in the Selection Tree. Observe that
the Selection Tree now filters the Chart to display only data
from the ‘USA East’ region. In addition, the Selection Tree
drillMember property changes the X-axis binding to represent
the ‘State’ dimension, which is one level below ‘Region’ in the
Selection Tree hierarchy.

c. Select the ‘CT’ and ‘MA’ options in the Selection Tree. Observe
that the Selection Tree now filters the Chart to display only data
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from the states of ‘CT’ and ‘MA’. In addition, the Selection Tree
drillMember property changes the X-axis binding to represent
the ‘City’ dimension, which is one level below ‘State’ in the
Selection Tree hierarchy.

See Also
drillMembers, to show multiple geographical levels simultaneously on the
map.
Drilling Down into a Chart, for information on the built-in drill-down
feature.
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4 Accessing Component Data

For Table, Crosstab, and Selection List components, expression scripts can
acquire actual data values from the component using relative or absolute
references.

4.1 Accessing Table Data
There are two key properties for accessing the values in a table, table and
data.

• table – A two-dimensional array containing the table data as displayed. 
The array includes header rows as well as data rows.

• data – A two dimensional array containing the raw table data (prior to 
grouping and summarization). It does not include header rows.

Two sub-properties that are especially useful when looping through the
rows or columns of tables are ‘length’ and ‘size’.

Note: A table that returns no data still displays the column header
row. Therefore, table.length is 1 in the no-data case.

• table.length/table.size – The number of rows and columns 
(respectively) in the table, as displayed, including column header row. 

• data.length/data.size – The number of rows and columns 
(respectively) in the original table (prior to grouping and 
summarization), including column header row.

As an example, consider the following table script, which iterates through
all data rows (beginning with row index 1, the first data row) and columns
of a table, and cumulatively sums these values.

var tot = 0;
for(var row = 1; row < table.length; row++) {

for(var col = 0; col < table.size; col++) {
tot = tot + table[row][col];

}
}

See Also
Accessing User-Modified Data in a Table, for information on how to
access an editable table.
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4.2 Accessing Data With Relative References 
The keywords below allow you to access cells within a table or Selection
List by using relative indexing (i.e., reference in relation to current cell).

You can type these keywords manually into your script, or you can click
the appropriate node on the ‘Component’ tree in the Script Editor.

The following sections illustrate how to access data using these keywords.

See Also
Accessing Data With Absolute/Mixed References, for information on
absolute references.

4.2.1 Accessing Data in the Current Cell (‘value’)

The value keyword refers to the value in the current cell. The value
keyword is the equivalent of the index expression table[row][col].

Walkthrough This example sets the text colors and fill colors of table cells based on data
values within the table. If a price is greater than $1000, the price displays in
red text, otherwise, in blue text. 

This Worksheet can
be found in the ‘Tuto-
rial’ folder, or in the
‘Orders’ data set
folder in Agile Edi-
tion.

1. Create a new Viewsheet based on the ‘ProductSales’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style

SYNTAX DESCRIPTION
field['col_name'] Value in the current row of column named 

“col_name.”
row Row index of the current cell.
col Column index of the current cell.
data[rowIx][colIx] Value of the data at index [rowIx,colIx] in the raw data 

(before grouping or summarization). Indices may use 
keywords ‘row’ and ‘col’ to create relative references.

table[rowIx][colIx] Value of the data at [rowIx,colIx] in the table (as 
displayed). Indices may use keywords ‘row’ and ‘col’ 
to create relative references.

value Value of the current cell.



DATA MASHUP

751 of 1397

Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. Drag and drop the ‘ProductInfo’ Data Block from the Component
pane into the Viewsheet. Expand the table so that you can see more
rows.

3. Select any data cell under the ‘Price’ column. Right-click and
choose the ‘Format’ option. This opens the ‘Format’ dialog box.

4. Select the Color tab. 

5. From the ‘Text Color’ menu select the ‘Expression’ option, and
click the ‘Edit’ button. This opens the Formula Editor.

6. Enter the following script in the Formula Editor: 

if (value > 1000) {
[255,0,0]; // red

} else {
0x0000FF; // blue

}

Note: A color can be specified as an ordered triple, or as a
hexadecimal number.

7. Click ‘OK’ to exit the Formula Editor, and then click ‘OK’ to exit
the ‘Format’ dialog box. 
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Note: You can apply
conditional formatting
without using script.
See Highlights in the
Advanced Dashboard
Design.

Notice that the cells in the ‘Price’ column are colored red if the value is
greater than 1000 and blue otherwise. The script affects the entire ‘Price’
column, and can be edited from the ‘Format’ dialog box of any cell in the
column. This example continues in Accessing Data in the Same Row
(‘field’).

See Also
value, for reference information.

4.2.2 Accessing Data in the Same Row (‘field’)

You can access the value in the current row of another column by using the
field keyword. For example, field['col_name'] refers to the value in the
current row of a column named “col_name.” 

Walkthrough This example continues from Accessing Data in the Current Cell (‘value’).
It will set the color of the ‘Name’ column based on the value of the ‘Price’
column:

1. Select a cell in the ‘Name’ column. Right-click and choose ‘For-
mat’.

2. Select the Color tab. From the ‘Text Color’ menu select the
‘Expression’ option, and click the ‘Edit’ button. This opens the
Formula Editor.

3. In the Formula Editor, enter the following expression:

if (field['Price'] > 1000) {
[255,0,0];

} else {
[0,0,255];

}

4. Click ‘OK’ to exit the Formula Editor, and then click ‘OK’ to exit
the ‘Format’ dialog box. 
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The values in the ‘Name’ column are now highlighted based on the
corresponding values in the ‘Price’ column. This example continues in
Accessing Data in Different Row or Column (‘row’/‘col’).

See Also
field, for reference information.

4.2.3 Accessing Data in Different Row or Column (‘row’/
‘col’)

To access any cell in a table by relative reference, use the indexing
expression table[rowIx][colIx] or data[rowIx][colIx]. 

Predefined variables row and col allow you to refer to the row and column
of the current cell, that is, the cell whose format is being modified. You can
use these variables to construct the desired offsets from the current cell.

For example:

• table[row][col]: Value in current cell (same as value keyword).

• table[row][col-1]: Value in current row, one column to left.

• table[row-1][col]: Value in current column, one row above.

• table[row+1][col]: Value in current column, one row below.

The data and table constructs yield the same results for tables, but may
produce different results when used in charts/crosstab tables. The data
syntax references the data prior to any summarization, while the table
syntax references the tabular data as displayed.

Walkthrough This examples continues from Accessing Data in the Same Row (‘field’). It
highlights every price that is less than the price immediately above it in the
table, and uses the row and col variables to create relative references:

1. Select any data cell under the ‘Price’ column. Right-click and
choose the ‘Format’ option. 
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2. Select the Color tab. From the ‘Fill Color’ menu select the
‘Expression’ option, and click the ‘Edit’ button. This opens the
Formula Editor.

3. In the Formula Editor, enter the following script:

if (row > 1) {
if (value < table[row-1][col]){
[255,255,0];

}
}

4. Click ‘OK’ to exit the Formula Editor, and then click ‘OK’ to exit
the ‘Format’ dialog box. 

The cells in which the value is less than the previous row’s price are now
highlighted in yellow.

See Also
row, col, for reference information.

4.3 Accessing Data With Absolute/Mixed 
References
The following expressions allow you to access any cell in a table by
absolute reference. 

table[rowIx][colIx]
data[rowIx][colIx]

Simply set the rowIx and colIx indexes to specify the position of the
desired cell. For example:

• table[0][0]: Value in first row, first column.

• table[2][4]: Value in third row, fifth column.

The “table.length” property yields the total number of rows in the table.
The data and table constructs yield the same results for tables, but may
produce different results when used in crosstab tables. The data syntax
references the data prior to any summarization, while the table syntax
references the tabular data as displayed.
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You can type these keywords manually into your script, or you can click
the appropriate node on the ‘Component’ tree in the Script Editor.

You can use absolute and relative references in the same statement, as the
following example illustrates.

Example: Using 
Absolute and 
Relative 
References

This example continues from Accessing Data in Different Row or Column
(‘row’/‘col’). It will set the header cell of the ‘Price’ column to show a red
background if there exists a price exceeding $2000, and will otherwise
show a green background. This requires a loop structure, as well as mixed
absolute and relative references:

1. Select the header cell in the ‘Price’ column. Right-click and choose
‘Format’.

2. Select the Color tab. From the ‘Fill Color’ menu select the
‘Expression’ option, and click the ‘Edit’ button. This opens the
Formula Editor.

3. Add the following script in the Formula Editor. 

for (i=1; i<table.length; i++) {
if (table[i][col] > 2000) {

[255,0,0];
break;

}
else {

[0,255,0];
}

}

4. Click ‘OK’ to exit the Formula Editor, and then click ‘OK’ to exit
the ‘Format’ dialog box. 
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The header cell is red because a price exists that exceeds $2000. To test the
header cell script, add a Range Slider to filter the values in the table. Follow
these steps:

5. Drag a Range Slider from the Component tree into the Viewsheet.
This creates a new Range Slider.

6. From the ‘ProductInfo’ Data Block in the Component tree, drag the
‘Price’ field onto the Range Slider. This binds the Range Slider to
the ‘Price’ field.

7. Drag the right side of the Range Slider to vary the prices included
in the dataset. Observe the color of the header cell as the dataset
changes.

¢

See Also
Accessing Data With Relative References, for information on relative
references.

4.4 Accessing User-Modified Data in a Table
Editable tables are not available in Style Scope Agile Edition.

When you configure a Viewsheet table to be “editable” (see Table
Properties: Advanced Tab), this allows users to insert, delete, or modify
data in the table. Changes that the user makes to the table, however, do not
persist after the Viewsheet is closed.

To allow user modifications to persist beyond the current session, you must
commit the modified records to the database. (The following section,
Committing User-Modified Data to Database (Database Write-Back),
provides a full example.) The getFormRows table function provides you
with records that have been modified.
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• Table1.getFormRows(ADDED): Provides a two-dimensional array 
containing the new rows that have been inserted by the user. The length 
of the array is equal to the number of inserted rows, and the width of the 
array is equal to the number of columns in the table.

• Table1.getFormRows(CHANGED): Provides a two-dimensional array 
containing the rows that have been modified by the user. The length of 
the array is equal to the number of modified rows, and the width of the 
array is equal to the number of columns in the table.

• Table1.getFormRows(DELETED): Provides a two-dimensional array 
containing the rows that have been deleted by the user. The length of the 
array is equal to the number of deleted rows, and the width of the array 
is equal to the number of columns in the table.

• Table1.getFormRow(idx): Provides the row designated by index idx. 

See Adding
Component Script for
information about the
onClick handler.

These functions are typically called within the onClick handler of a Submit
Button, as shown in the following section.

When a user adds or changes a row in an editable table, the new or
modified row is highlighted in color. To clear the highlight on these rows
and remove them from the corresponding array returned by getFormRows,
use the table’s commit(type) function.

• Table1.commit(ADDED): Clears highlights on added rows, and removes 
them from array returned by getFormRows(ADDED).

• Table1.commit(CHANGED): Clears highlight on changed rows, and 
removes them from array returned by getFormRows(CHANGED).

• Table1.commit(DELETED): Removes deleted rows from array returned by 
getFormRows(DELETED).

• Table1.commit(idx): Removes the row returned by getFormRows(idx) 
from the array of modified rows.

See Also
Accessing Table Data, for information on how to access data in a regular
table.
Accessing the Most Recent User Modification, to retrieve a value that the
user has just entered.
getFormRow(row), for function reference information.
getFormRows([type]), for function reference information.
Table Properties: Advanced Tab, in Advanced Dashboard Design, for
information on setting a table as editable.
Validating User Input, in Advanced Dashboard Design, for information on
restricting the values that a user can enter.
Committing User-Modified Data to Database (Database Write-Back), for
information on updating the database with modified information.
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4.5 Accessing User-Modified Data from TextInput
To acquire the data that a user has entered in a TextInput component,
simply reference the component’s value property:

TextInput1.value

To commit this acquired data to the database, see Committing User-
Modified Data to Database (Database Write-Back).

See Also
Accessing the Most Recent User Modification, to retrieve a value that the
user has just entered.
Validating User Input, in Advanced Dashboard Design, for information on
restricting values a user can enter.
Committing User-Modified Data to Database (Database Write-Back), for
information on updating the database with modified information.

4.6 Accessing the Most Recent User Modification
Editable tables are not available in Style Scope Agile Edition.

When a user makes a modification to an editable table or Input component,
the change triggers the Viewsheet’s onRefresh Handler script to re-
execute. The onRefresh handler offers an ‘event’ object which you can use
to detect the user’s action and make an appropriate response. The event
object provides access to the following Viewsheet events:

• Name and region of the Editable Table in which the user has just made a 
modification.

• Name and type of an Input Component in which the user has just made a 
selection.

For an editable table, the ‘event’ object provides the following properties:

Example: 
Recalculating 
Table Data

The following example illustrates how you can use the ‘event’ object to
dynamically update table data in response to user modifications. You will
create a table that contains the fields ‘Name’, ‘Price’, ‘Quantity’, and
‘Total’. You will enable the user to modify the ‘Price’ and ‘Quantity’ fields,
and use script to automatically update the ‘Total’ field with the
corresponding data (i.e., the product of ‘Price’ and ‘Quantity’).

name The name of the table component.
type The type of the component, always ‘table’.
row The index of the modified row in the table.
column The index of the modified column in the table.
source A reference to the table object which can be used to access table 

properties.
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To create this example, follow the steps below:

1. Create a new Viewsheet based on the ‘Order Model’ data model.
To do this, follow the steps below:

a. Press the ‘New Viewsheet’ button in the toolbar. This opens the
‘New Viewsheet’ dialog box.

b. Expand the ‘Data Source’ node, and then expand the ‘Orders’
node.

c. Select the ‘Order Model’ entry, and press ‘OK’. This creates a
new Viewsheet based on the ‘Order Model’ data model.

2. From the Viewsheet Component panel, drag a Table component to
the Viewsheet grid.

3. Expand the ‘Order Model’ node at the top of the Component
panel, and drag the following fields into the Table component:

Product.Name
Product.Price
Product.Quantity Purchased
Product.Total

4. Resize the table as desired.

5. Right-click the table and select ‘Properties’. This opens the ‘Table
Properties’ dialog box.

6. Under the Advanced tab, select ‘Enable Table Editing’ and press
‘OK’.

7. In the table, right-click the ‘Product:Name’ header and select
‘Column Option’ from the context menu.

8. Deselect the ‘Enable Column Editing’ option, and press ‘OK’. This
prevents the user from editing the product name.
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9. In the table, right-click the ‘Product:Total’ header and select
‘Column Option’ from the context menu.

10. Deselect the ‘Enable Column Editing’ option, and press ‘OK’. This
prevents the user from manually editing the total. (The total will be
calculated by script.)

11. Press the ‘Options’ button in the Viewsheet toolbar. This opens the
‘Viewsheet Options’ dialog box.

12. Select the Script tab. Press the ‘onRefresh’ radio button to select
the onRefresh handler.

13. Enter the following script into the Editor:

if(event != null) {
var tableObject = event.source;
var row = event.row;
var column = event.column;

if(column == 1 || column == 2) {
var editedRow = tableObject.getFormRow(row);
var price = editedRow[1]; // second column = Price
var quant = editedRow[2]; // third column = Quantity

if(price != null && quant != null) {
tableObject.setObject(row, 3, price*quant); // fourth 

column = Total
}
else {
tableObject.setObject(row, 3,'');

}
}

}

Observe that event.row and event.column are used together with
getFormRow to acquire the particular value that the user has entered,
and setObject is used to write the calculated data into the table.

14. Press ‘OK’ to close the Script Editor.

15. Preview the Viewsheet.

Edit various values in the ‘Price’ and ‘Quantity Purchased’ columns, and
observe how the ‘Total’ column is automatically updated. Note, however,
that changes a user makes to the table (including calculated values) do not
persist across sessions unless they are committed to the database. See
Committing User-Modified Data to Database (Database Write-Back) for
more details.

¢
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See Also
Table Properties: Advanced Tab, in Advanced Dashboard Design, for
information on how to make a table editable.

4.7 Committing User-Modified Data to Database 
(Database Write-Back)
Database write-back is not available in Style Scope Agile Edition.

The previous section, Accessing User-Modified Data in a Table, described
how you can acquire the records in a table which have been modified
(inserted, deleted, or changed) by the user. If you want the user’s changes to
persist across sessions, you must commit these changes to the database.
This is known as database write-back.

In most cases, you should commit records to the database by placing a
script within the onClick handler of a Submit Button. The script should
perform the following operations:

1. Create a connection to the database:

var conn = 
createConnection('datasource','username','password');

If the specified data source does not require credentials, replace the
username and password with empty strings ('').

2. Prepare the desired SQL statement, using placeholders for values to
be inserted.

var pstmt = conn.prepareStatement("insert into table1 values 
(?,?,?)");

The quoted string should be a valid SQL statement which will
perform the desired database operation when values are inserted
each placeholder (“?”) in the next step.

See Accessing User-
Modified Data in a
Table for more
information about the
getFormRows()
function.

3. Insert values for SQL placeholders. In most cases, these values will
be taken from the arrays returned by the table functions
getFormRows(ADDED), getFormRows(CHANGED), and
getFormRows(DELETED). For example:

pstmt.setInt(1,rowsAdded[i][0]); // first substitution
pstmt.setString(2,rowsAdded[i][1]); // second 
substitution
pstmt.setString(3,rowsAdded[i][2]); // third substitution

The integer parameter in each of the above functions is a reference
to the corresponding placeholder (“?”) in the SQL statement; for
example, the parameter value “1” indicates a substitution for the
first “?”, “2” indicates a substitution for the second “?”, and “3”
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indicates a substitution for the third “?”. The row of the array is
indexed by variable “i” above because the array is generally
accessed iteratively within a loop structure.

4. Update the database tables by executing the SQL statement:

pstmt.executeUpdate();

Note that this does not yet commit any changes to the database.
Changes are not committed until the ‘commit’ function is called
(next step).

5. Commit the changes:

conn.commit();

6. If necessary (in case of an error), roll back the changes:

conn.rollback();

7. Close the connection to the data source:

conn.close();

The Submit Button onClick script below provides a complete example,
which updates a database table with rows which have been added, deleted,
and changed. 

Example: 
Committing User 
Edits to Database

The following sample Viewsheet, based on the sales_employees table in
the ‘Orders’ database, contains an editable table with five columns. The
Viewsheet table, also named sales_employees, contains all of the columns
from sales_employees table in the Orders data source. 

User editing is enabled only for the first_name, last_name, and quota
columns. (See Table Properties: Advanced Tab and Validating User Input
in Advanced Dashboard Design for details on configuring table and
column editing features.)

Note: The ‘Orders’ data source used in this example is a Microsoft
Access database, different than the ‘Orders’ data source installed
by default. The default Derby database is not writable, so it
cannot be used for this example.
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The following script acquires the rows that were added, deleted, or
changed, and then commits the modifications back to the database. The
script is placed in the onClick handler of the Submit button.

try{
// Create the connection to data source (no credentials)
var conn=createConnection('Orders','','');

   
// Find new rows added by user
var rowsAdded = sales_employees.getFormRows(ADDED);

// Find existing rows changed by user
var rowsChanged = sales_employees.getFormRows(CHANGED);

// Find existing rows deleted by user
var rowsDeleted = sales_employees.getFormRows(DELETED);

//---------- ADDING ROWS ----------//
if(rowsAdded!=null){
// Iterate through array of added rows
for(var i = 0; i<rowsAdded.length; i++){

// Prepare SQL statement with placeholders
var pstmt=conn.prepareStatement("insert into 

sales_employees values (?,?,?,?,?)");

// Insert placeholder values from ith row of array
pstmt.setInt(1,rowsAdded[i][0]); // row i, column 1
pstmt.setString(2,rowsAdded[i][1]); // row i, column 

2
pstmt.setString(3,rowsAdded[i][2]); // row i, column 

3
pstmt.setInt(4,rowsAdded[i][3]); // row i, column 4
pstmt.setInt(5,rowsAdded[i][4]); // row i, column 5

// Execute the SQL statement
pstmt.executeUpdate();

// Commit the changes
conn.commit();

}
}

//---------- DELETING ROWS ----------//
if(rowsDeleted!=null){
// Iterate through array of deleted rows
for(var i = 0; i<rowsDeleted.length; i++){

// Prepare SQL statement with placeholders
var pstmt = conn.prepareStatement("delete from 

sales_employees where employee_id=?");

// Insert placeholder value from ith row of array
pstmt.setInt(1,rowsDeleted[i][0]); // row i, column 1

// Execute the SQL statement
pstmt.executeUpdate();

// Commit the changes
conn.commit();

}
}
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//---------- CHANGING ROWS ----------//
if(rowsChanged!=null){
// Iterate through array of changed rows
for(var i = 0; i<rowsChanged.length; i++){

// Prepare SQL statement with placeholders
var pstmt = conn.prepareStatement("update 

sales_employees set first_name=?, last_name=?, quota=? 
where employee_id=?");

// Insert placeholder values from ith row of array
pstmt.setString(1,rowsChanged[i][1]); // row i, 

column 2
pstmt.setString(2,rowsChanged[i][2]); // row i, 

column 3
pstmt.setInt(3,rowsChanged[i][3]); // row i, column 4
pstmt.setInt(4,rowsChanged[i][0]); // row i, column 1

// Execute the SQL statement
pstmt.executeUpdate();

// Commit the changes
conn.commit();

}
}

}

// In case of error, roll-back changes.
catch(e) {
conn.rollback();

}

// Close the data source connection
finally{
conn.close();

}
¢



DATA MASHUP

765 of 1397

5 Accessing Worksheet Data

In both chart and property scripting, you have explicit access to the data
contained in the Worksheet Data Block. The following sections explain the
syntax for accessing the Worksheet data.

See Also
Running a Query from Script, for information on how to access data from
an arbitrary query or Worksheet.
Adding Property Script (Expressions), for information on setting
component properties.
Adding Component Script, for information on manipulating charts with
script.

5.1 Referencing Data in the Worksheet Data Block
Within a Viewsheet script, you can use the standard Worksheet syntax to
access data from any Worksheet Data Block within the linked Worksheet.
For example, to access a value in a Worksheet Table or Embedded Table
called ‘TopSales’, use one of the syntaxes below. Note the use of the
worksheet keyword when the data block name contains spaces.

Note: In general, Data Block operations should be performed in the
Worksheet rather than the Viewsheet. 

• TopSales[2][4]: 
Third row, fifth column of the Data Block ‘TopSales’.

• TopSales[2]['Price']: 
Third row of the ‘Price’ field in the Data Block ‘TopSales’.

• TopSales['Price']: 
Array of all values in ‘Price’ field in the Data Block ‘TopSales’.

• worksheet['Top Sales'][2][4]: 
Third row, fifth column of the Data Block ‘TopSales’ (with space in 
name). 

You can type these keywords manually into your script, or you can insert
them by clicking the appropriate node on the ‘Data’ tree in the Script
Editor.
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See Also
Grouping, in Advanced Data Mashup, for information on aggregating data. 
Accessing Table Cells in Script, in Advanced Data Mashup, for
information on referencing Data Blocks. 

5.2 Aggregating Data in the Worksheet Data Block
To aggregate data from the Worksheet’s Data Block within Viewsheet
script, use the following syntax:

aggregateMethod(DataBlockName['ColumnName'])

Note: In general, Data Block operations should be performed in the
Worksheet rather than the Viewsheet. 

For example, to obtain the sum or average of the Data Block column
‘Price’, use the following expressions:

var sumPrice = Sum(TopSales['Price'])
var avePrice = Average(TopSales['Price'])

To reference a Data Block that has a space in the name (e.g., “Top Sales”),
use the worksheet keyword as follows:

var avePrice = Average(worksheet["Top Sales"]['Price'])

See Also
Grouping, in Advanced Data Mashup, for information on aggregating data. 
Accessing Table Cells in Script, in Advanced Data Mashup, for
information on referencing Data Blocks. 
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6 Accessing Query Data

You can access data from an arbitrary query or Data Worksheet by using
the runQuery() command. The following sections explain different ways
that you can extract data from a query or Worksheet.

6.1 Running a Query from Script
Note: runQuery does
not retrieve data from
data models.

To run a query or Data Worksheet, use the runQuery(query_name
[,parameters]) command.

// Run a query:
var q = runQuery('total sales');

// Run the query for primary Data Block in a Worksheet:
var q = runQuery('ws:global:{Folder1/Folder 2/.../
}worksheetName');

// Run the query for non-primary Data Block in a Worksheet:
var q = runQuery('ws:global:{Folder1/Folder 2/.../
}worksheetName:tableName');

For Data Worksheets, qualify the name as ‘ws:global:path’ or
‘ws:user_name:path’ for global or user scope, respectively.

The runQuery() command should generally be placed in the onInit Handler
so that it only executes the first time the Viewsheet loads. (See Adding
Viewsheet Script for more information on how to add onInit script.) The
result set is returned as a two-dimensional array whose first row contains
the column headers. You can access the query values using standard array
indexing.

// Assign data in first column, first row to Text 
component:
Text1.value = q[1][0];

To extract only query data that meets certain conditions, see Referencing
Query Data.

Query parameters (if any) can be passed as part of the runQuery call. For
example, to pass the Viewsheet ‘start_time’ parameter to the query as
‘start_time’ and pass the current date/time as ‘end_time’:

var q = runQuery('total sales', [['start_time', 
parameter.start_time],['end_time', new Date()]]);

See Also
Binding Data to a Chart in Script, for various approaches to binding data to
a chart.
runQuery(query_name [,parameters]), for additional information on
runQuery.
Accessing Worksheet Data, to access data in the underlying Worksheet.
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6.2 Referencing Query Data
Once you have executed the query (Running a Query from Script), you can
access specific ranges of the query result set. The data-referencing syntax
explained in the following sections allows you to also group and filter the
results, and to create expressions. 

6.2.1 Referencing a Query Column

To retrieve an array of all values in a given field (column) from a query
result set q, use the field name:

q['state'];

The following example illustrates this approach.

Walkthrough Consider the sample ‘customers’ query. In this example, you will extract all
the values under the ‘state’ column and use them to populate a Freehand
table. Follow the steps below.

1. Press the ‘New Viewsheet’ button in the Visual Composer toolbar.
This opens the ‘New Viewsheet’ dialog box.

2. Press the ‘Options’ button in the toolbar, and select the Script tab.
Select the ‘onInit’ option at the bottom and enter one of the
following scripts:

// Style Scope or Style Intelligence
var q = runQuery('customers') 

// Style Scope Analytic Edition
var q = runQuery('ws:global:Examples/Orders Examples/
customers') 



DATA MASHUP

769 of 1397

This executes the ‘customers’ query in the onInit script. (See
Running a Query from Script for more details.)

3. Press ‘OK’ to close the ‘Viewsheet Options’ dialog box.

4. Drag the ‘Freehand Table’ component from the Component panel
into the Viewsheet grid. This opens the Table Editor.

5. Click on cell[1,0] in the Table (second row, first column) to select
it. 

6. Select the ‘Formula’ option Data panel and press the ‘Edit’ button.

7. Enter the following formula in the Formula Editor: 

q['state']

This extracts the entire ‘state’ column from the ‘customers’ query
to populate the table. 

8. Press ‘OK’ to close the Formula Editor.

9. Select ‘Expand Cell’ and choose ‘Vertical’. (This causes the
extracted data to fill down vertically.)
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10. Press the green ‘Apply’ button to close the Table Editor.

11. Observe that the table is populated with all of the records from the
‘state’ column of the ‘customers’ query.

To return just the unique values in the ‘state’ column, change the script
from q['state'] to toList(q['state']).
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6.2.2 Deriving a Result Set from Query Columns

In some cases you may want to perform operations on existing query
columns to obtain the desired result. To do this, modify the formula by
placing ‘=’ in front of the expression string. The following example
illustrates this approach.

Walkthrough Consider the sample ‘customers’ query. In this example, you will create a
derived result that concatenates the value in the ‘state’ field with the value
in the ‘zip’ field within a Freehand Table. Follow the steps below.

1. Press the ‘New Viewsheet’ button in the Visual Composer toolbar.
This opens the ‘New Viewsheet’ dialog box.

2. Press the ‘Options’ button in the toolbar, and select the Script tab.
Select the ‘onInit’ option at the bottom and enter one of the
following scripts:

// Style Scope or Style Intelligence
var q = runQuery('customers') 

// Style Scope Analytic Edition
var q = runQuery('ws:global:Examples/Orders Examples/
customers') 

This executes the ‘customers’ query in the onInit script. (See
Running a Query from Script for more details.)

3. Press ‘OK’ to close the ‘Viewsheet Options’ dialog box.

4. Drag the ‘Freehand Table’ component from the Component panel
into the Viewsheet grid. This opens the Table Editor.
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5. Click on cell[1,0] in the table (second row, first column) to select
it. 

6. Select the ‘Formula’ option in the Data panel and press the ‘Edit’
button.

7. Enter the following formula in the Formula Editor: 

q['=state + ", " + zip'];

This concatenates the values in the ‘state’ column with the
corresponding values in the ‘zip’ column. 

8. Press ‘OK’ to close the Formula Editor.

9. Select ‘Expand Cell’ and choose ‘Vertical’. (This causes the
extracted data to fill down vertically.)

10. Press the green ‘Apply’ button to close the Table Editor.



DATA MASHUP

773 of 1397

11. Observe that the table is populated with the concatenated values of
‘state’ and ‘zip’.

6.2.3 Referencing a Query Column With Field Filtering

You can filter values of a field (column) based on the values of other fields
in the result set. To do this, use ‘@’ as the delimiter between the column
name and the filtering expression and ‘:’ to introduce the values to filter.

For example, to extract all values in a ‘company_name’ field where the
corresponding value in the ‘state’ field is ‘NJ’, use the following formula:

q['company_name@state:NJ'];

This will yield a list of all the companies in New Jersey.

Note: To retrieve a
sub-table rather than
an array, add an initial
asterisk:
q['*@state:NJ'];

To filter based on multiple fields, use ‘;’ as the delimiter between the
filtering expressions. For example, to find all the companies within a
certain city (New Brunswick) and state (NJ), adapt the formula as follows:

q['company_name@state:NJ;city:New Brunswick'];

If the filtering expression is based on a derived field (Deriving a Result Set
from Query Columns), place ‘=’ in front of the expression. For example, to
find all the companies within a certain ‘state, zip’ pair, adapt the formula as
follows:

q['company_name@=state + ", " + zip:NJ, 08854'];

If the column name contains a space, use the rowValue operator:

q['company_name@=rowValue["US State"] + ", " + zip:NJ, 
08854'];

The above examples use literal values (e.g., ‘NJ’, ‘New Brunswick’) in the
condition. To use cell references in place of literal values, see Referencing
a Cell for Column Filtering.

6.2.4 Referencing a Column With Expression Filtering

You can filter values in a column based on a conditional expression. Use
‘‘?” as the delimiter between the filtering expression and the column name. 
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For example, to extract all the values in the ‘company_name’ field where
the corresponding value in the ‘customer_id’ field is between 20 and 30,
use the following formula: 

q['company_name?customer_id > 20 && customer_id < 30'];

Note, however, that while expression filtering can often be used to achieve
the same result as field filtering, field filtering is better optimized. See
Referencing a Query Column With Field Filtering for more details.

6.2.5 Referencing a Column with Positional (Index) 
Filtering

You can filter values in a column based on a range of row indices. For
example, to extract the first five records from a ‘company_name’ column, use
the following formula:

q['[0,company_name]:[4, company_name]'];

An asterisk ‘*’ in place of the row index represents the last row in the result
set.

6.3 Cell Referencing
You can assign a name to any cell within a Freehand Table. This allows you
to use the cell’s name to reference the value of the cell from within another
formula. Refer to the value in a cell by using syntax “$cell_name”, where
cell_name is the name assigned in the ‘Cell Name’ field for the cell being
referenced.

You can insert this reference easily by selecting the field name from the
‘Cell’ folder in the editor.
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The following sections provide examples of more advanced usage.

6.3.1 Referencing a Cell for Column Filtering

When extracting data from a query, you can use cell references as the
filtering parameters. This is particularly useful when the table has multiple
levels of row/column headers and you want to filter the child level based on
the parent level. 

Walkthrough In this example, you will create a Freehand Table (based on the ‘customers’
query) with a two-level row header consisting of states and the cities within
each state. Follow the steps below:

1. Press the ‘New Viewsheet’ button in the Visual Composer toolbar.
This opens the ‘New Viewsheet’ dialog box.

2. Press ‘OK’ to close the dialog box and create the new Viewsheet.
(Do not select any data source in the ‘New Viewsheet’ dialog box.)

3. Press the ‘Options’ button in the toolbar, and select the Script tab.
Select the ‘onInit’ option at the bottom and enter one of the
following scripts:

// Style Scope or Style Intelligence
var q = runQuery('customers') 

// Style Scope Analytic Edition
var q = runQuery('ws:global:Examples/Orders Examples/
customers') 
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This executes the ‘customers’ query in the onInit script. (See
Running a Query from Script for more details.)

4. Press ‘OK’ to close the ‘Viewsheet Options’ dialog box.

5. Drag the ‘Freehand Table’ component from the Component panel
into the Viewsheet grid. This opens the Table Editor.

6. Right-click on the rightmost column and select ‘Append Column’
from the menu. The table should now have three columns.

7. Right-click on the bottom row and select ‘Insert Rows/Columns’
from the menu. Insert two rows at the bottom of the table.

The table should now have four rows and three columns.

8. Click on cell[1,0] in the Table (second row, first column) to select
it. 

9. Select the ‘Formula’ option in the Data tab and press the ‘Edit’
button.
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10. Enter the following formula in the Formula Editor: 

q['state']

This extracts the entire ‘state’ column from the ‘customers’ query
to populate the table. 

11. Press ‘OK’ to close the Formula Editor.

12. Select ‘Expand Cell’ and choose ‘Vertical’. (This causes the
extracted data to fill down vertically.)

13. In the ‘Cell Name’ field, enter ‘st’ as the cell name.
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14. Select cell[1,1] in the table (second row, second column).

15. Select the ‘Formula’ option, and enter the following formula in the
Formula Editor: 

q['city']

This extracts the entire ‘city’ column from the ‘customers’ query. 

16. Select ‘Expand Cell’ and choose ‘Vertical’.

17. In the ‘Cell name’ field, enter ‘ct’ as the cell name.
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18. Press the green ‘Apply’ button to close the Table Editor.

19. Observe that the table is now populated with states and cities.

However, the second column lists all of the cities next to each state,
not only the cities that reside within the specific state. To filter the
cities based on the state values, include a field-filtering condition
with a reference to the cell ‘st’, as described below.

20. Press the ‘Edit’ button in the table title bar to reopen the Table
Editor.

21. Select cell[1,1] and change the formula from q['city'] to

q['city@state:$st']. This returns only values from the ‘city’ field
where the corresponding ‘state’ value is equal to the value in the
table cell named ‘st’.
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Note: When making
comparisons with
'null', use the syntax
“$st['.']” to ref-
erence the cell value.

22. Press the ‘Apply’ button and view the resulting table.

Notice that the table now lists only those cities that correspond to the given
state. To further restrict the table’s data to display only unique values of city
and state (i.e., to remove duplicates), modify the two formulas to use the
toList() function:

Cell[1,0]: toList(q['state'])
Cell[1,1]: toList(q['city@state:$st'])

6.3.2 Referencing Cells in Summary Formulas

This section provides an example of using cell references in summary
formulas.

Walkthrough Consider the formula table from the example in Referencing a Cell for
Column Filtering. It consists of a two-level row header listing states and
cities within each state. In the following example, you will add a formula to
count the number of customers within each city.

1. Press the ‘Edit’ button in the table title bar to reopen the Table
Editor.
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2. Select cell[1,2] (second row, third column), select the ‘Formula’
option in the Data tab, and add the following formula:

count(q['customer_id@state:$st;city:$ct'])

This formula counts all the customers within the given city and
state. 

3. Select the ‘Expand Cell’ option and choose the ‘Vertical’ option.

4. Press the green ‘Apply’ button to close the Table Editor. The table
now displays a count of customer IDs within each city and state.

6.3.3 Group Numbering

To obtain the sequence number of an element within an expanding cell, use
the ‘#’ qualifier. (This is useful when you wish to add numbering to row/
column headers.) 

Walkthrough For example, consider the formula table from the example in Referencing
Cells in Summary Formulas. You will now add numbering for the
expanding row header cell ‘st’. 
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1. Press the ‘Edit’ button in the table title bar to reopen the Table
Editor.

2. Right-click any cell in the first column and select ‘Column’ >
‘Insert Column’ from the context menu. This adds a new column to
the left.

3. Select cell[1,0] (second row) in the newly inserted column, select
the ‘Formula’ option in the Data tab, and add the following
formula:

$st['#'] + 1

Do not set any cell expansion. Note that group indexing starts
with 0. The formula adds 1 to the index so that the first group has
value 1. 

4. Press the green ‘Apply’ button to close the table Editor. The table
now displays the state group number in the first column. (You may
need to resize the table to see all the columns.)

Note that the groups numbers are repeated for each instance of the
state. To merge these repeated instances together, continue with the
steps below.

5. Press the ‘Edit’ button in the table title bar to reopen the Table
Editor.

6. Select cell[1,0] (second row, first column).

7. Select the Option tab. Enable ‘Merge expanded cells’, and select
‘st’ from the ‘Row Group’ menu.
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8. Select cell[1,1] (second row, second column).

9. Select the Option tab. Enable ‘Merge expanded cells’, and select
‘st’ from the ‘Row Group’ menu.

10. Press the green ‘Apply’ button to close the editor. Note how
repeated states and group numbers have been merged together.
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11. To vertically align these values within their cells, right-click on a
cell and select ‘Format’ from the menu. In the ‘Format’ dialog box,
select the ‘Align’ tab and choose ‘Middle’ from the ‘Vertical’
alignment property and press ‘OK’.

6.3.4 Referencing a Cell with Relative Parent Group 
Reference

Relative cell referencing is used primarily when comparing different
summary cells with respect to their header cell. For example, you might
want find the difference between the total sales for the current year and the
previous year. 

The syntax for relative cell referencing is as follows:

$cellName['grpName:+/-relative_index']

e.g., $sales['state:-1']
$sales['yr:+1']

Here, $cellName is the name of the cell/column containing the value(s) to
be compared, and grpName is name of the cell/column that indexes the
different values.

Walkthrough In this example, you will find the difference in sales between successive
fiscal years. Follow the steps below:

1. Press the ‘New Viewsheet’ button in the Visual Composer toolbar.
This opens the ‘New Viewsheet’ dialog box.

2. Press ‘OK’ to close the dialog box and create the new Viewsheet.
(Do not select any data source in the ‘New Viewsheet’ dialog box.)
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3. Press the ‘Options’ button in the toolbar, and select the Script tab.
Select the ‘onInit’ option at the bottom and enter one of the
following scripts:

// Style Scope or Style Intelligence
var q = runQuery('ws:global:Sales/Sales Explore') 

// Style Scope Analytic Edition
var q = runQuery('ws:global:Examples/Orders Examples/Sales 
Explore') 

This executes the ‘Sales Explore’ Worksheet in the onInit script.
(See Running a Query from Script for more details.)

4. Press ‘OK’ to close the ‘Viewsheet Options’ dialog box.

5. Drag the ‘Freehand Table’ component from the Component panel
into the Viewsheet grid. This opens the Table Editor.

6. Right-click on the rightmost column and select ‘Append Column’
from the menu. The table should now have three columns.

7. Right-click on the bottom row and select ‘Append Row’ from the
menu. The table should now have three rows and three columns.

8. Click on cell[1,0] in the table (second row, first column) to select
it. 

9. Select the ‘Formula’ option in the Data tab and press the ‘Edit’
button.
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10. Enter the following formula in the Formula Editor: 

toList(q['Date'],'date=year')

This extracts the entire ‘Date’ column from the ‘Sales Explore’
Worksheet and groups the dates by year. 

11. Press ‘OK’ to close the Formula Editor.

12. Select ‘Expand Cell’ and choose ‘Vertical’. (This causes the
extracted data to fill down vertically.)

13. In the ‘Cell Name’ field, enter ‘yr’ as the cell name.
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14. Select cell[1,1] in the table (second row, second column). Select
the ‘Formula’ option in the Data tab, and enter the following
formula:

sum(q['Total@=year(field["Date"]):$yr'])

This formula means “For each year in cell ‘yr’, find the values in
the ‘Date’ field within that year, and sum the ‘Totals’ for those
dates.” Effectively, this calculates the total revenue generated for a
given year.

15. In the ‘Cell Name’ field, enter ‘tot’ as the cell name.

16. Select cell[1,2] (second row, third column). Select the ‘Formula’
option in the Data tab, and enter the following formula. 

$tot - $tot['yr:-1']
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This formula uses relative cell referencing to calculate the
difference between the total revenue (computed in the column
named ‘tot’) of the current year and the previous year. The table
should appear as shown below.

17. Press the green ‘Apply’ button to close the Table Editor. The
resulting table displays totals by year, as well as the difference
between successive years’ totals.

6.3.5 Referencing a Cell with Absolute Parent Group 
Reference

To refer to a summary cell in another header group, use the absolute value
of the header group, as shown below:

$cellName['grpName:absolute_value']

e.g., $sales['state:NJ']
$sales['yr:"2011"'] (specify numeric values in quotes)

Here, $cellName is the name of the cell/column containing the value(s) to
be compared, and grpName is name of the cell/column that indexes the
different values.

Walkthrough In this example, you will find the relative sales for each year compared to
the fixed year 2011. Follow the steps below:

1. Press the ‘New Viewsheet’ button in the Visual Composer toolbar.
This opens the ‘New Viewsheet’ dialog box.
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2. Press ‘OK’ to close the dialog box and create the new Viewsheet.
(Do not select any data source in the ‘New Viewsheet’ dialog box.)

3. Press the ‘Options’ button in the toolbar, and select the Script tab.
Select the ‘onInit’ option at the bottom and enter one of the
following scripts:

// Style Scope or Style Intelligence
var q = runQuery('ws:global:Sales/Sales Explore') 

// Style Scope Analytic Edition
var q = runQuery('ws:global:Examples/Orders Examples/Sales 
Explore') 

This executes the ‘Sales Explore’ query in the onInit script. (See
Running a Query from Script for more details.)

4. Press ‘OK’ to close the ‘Viewsheet Options’ dialog box.

5. Drag the ‘Freehand Table’ component from the Component panel
into the Viewsheet grid. This opens the Table Editor.

6. Right-click on the rightmost column and select ‘Append Column’
from the menu. The table should now have three columns.

7. Right-click on the bottom row and select ‘Append Row’ from the
menu. The table should now have three rows and three columns.

8. Click on cell[1,0] in the table (second row, first column) to select
it. 
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9. Select the ‘Formula’ option in the Data tab and press the ‘Edit’
button.

10. Enter the following formula in the Formula Editor: 

toList(q['Date'],'date=year')

This extracts the entire ‘Date’ column from the ‘Sales Explore’
Worksheet and groups the dates by year. 

11. Press ‘OK’ to close the Formula Editor.

12. Select ‘Expand Cell’ and choose ‘Vertical’. (This causes the
extracted data to fill down vertically.)

13. In the ‘Cell Name’ field, enter ‘yr’ as the cell name.
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14. Select cell[1,1] in the table (second row, second column). Select
the ‘Formula’ option in the Data tab, and enter the following
formula:

sum(q['Total@=year(field["Date"]):$yr'])

This formula means “For each year in cell ‘yr’, find the values in
the ‘Date’ field within that year, and sum the ‘Totals’ for those
order dates.” Effectively, this calculates the total revenue generated
for a given year.

15. In the ‘Cell Name’ field, enter ‘tot’ as the cell name.

16. Select cell[1,2] (second row, third column). Select the ‘Formula’
option in the Data tab, and enter the following formula. 

$tot - $tot['yr:"2011"']
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This formula uses absolute cell referencing to calculate the
difference between the total revenue (computed in the column
named ‘tot’) of the current year and the year 2011. The table
should appear as shown below:

17. Press the green ‘Apply’ button to close the Table Editor. The
resulting table displays totals by year, as well as the difference
between each year’s total and the total for 2011.

See Also
Referencing a Cell with Relative Parent Group Reference, to compare
based on relative location.

6.3.6 Referencing a Cell with Parent Group Reference as 
an Expression

To specify a referenced group using a JavaScript expression, prefix the
expression string with ‘=’, as shown below: 

$company['state:=iif($type == "T", $state, $province)']

The syntax of the iif function used above is CALC.iif(condition,
value_if_true, value_if_false).

See Also
Referencing a Column With Expression Filtering, for another use of
expressions.
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CALC.iif(condition, value_if_true, value_if_false), for more information
about the iif syntax.

6.4 Special Functions
The functions listed below are commonly used to populate cells in a
Freehand Table.

6.4.1 inArray

The inArray() function determines whether a value is part of an array. 

inArray(array, value);                                                                                              
e.g., inArray([1,2,3], $num);

This function is useful as a condition check together with the iif operator.

6.4.2 toArray

The toArray() function converts a tableLens object or a delimited string to
a JavaScript array. 

toArray(tableLens);
toArray(delimString);
e.g., var a = toArray(Table1.tableLens);

var a = toArray('1,2,3');

You can use the returned JavaScript array to access table data in the usual
manner: 

e.g., a[1][2] is the data in 2nd row, 3rd column

6.4.3 rowList

The rowList() function generates a list of values from a result set with
column grouping, conditional filtering, and other sorting options.

rowList(query, 'condition spec', 'options   string');                            
e.g., rowList(q, 'quantity ? discount > 0','sort=asc');

Here, condition spec is the column name with grouping or conditional
specifications, and the options string values are as follows (multiple
options are delimited by a comma):

• sort=asc/desc/false: Sort the values in ascending or descending order. 
Default is false.

• distinct=true/false: Retrieve only distinct values. Default is false.

• maxrows=num: Limit the number of elements returned.

• sortcolumn=column_name: Sort data according to a specific query 
column which is not returned in the list.
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The variable ‘q’ contains the results of a query. This is usually generated in
onInit Handler script by the runQuery function. For example:

var q = runQuery('All Sales')

The rowList() function also adds the fields of the result set to the formula
scope of the table cells, so that they can be accessed as field['colName'].
Therefore, you can use rowList() to extract a portion of a query result set,
and then fill out the table with other fields of the result set which
correspond to the records of the extracted rows:

Walkthrough Consider a Freehand Table based on the ‘Sales Explore’ Worksheet.
Extract all of the values in the ‘Date’ field where the sales are greater than
$10,000, and then fill the adjacent cell with the category associated with the
order. Follow the steps below:

1. Press the ‘New Viewsheet’ button in the Visual Composer toolbar.
This opens the ‘New Viewsheet’ dialog box.

2. Press ‘OK’ to close the dialog box and create the new Viewsheet.
(Do not select any data source in the ‘New Viewsheet’ dialog box.)

3. Press the ‘Options’ button in the toolbar, and select the Script tab.
Select the ‘onInit’ option at the bottom and enter one of the
following scripts:

// Style Scope or Style Intelligence
var q = runQuery('ws:global:Sales/Sales Explore') 

// Style Scope Analytic Edition
var q = runQuery('ws:global:Examples/Orders Examples/Sales 
Explore') 
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This executes the ‘Sales Explore’ Worksheet in the onInit script.
(See Running a Query from Script for more details.)

4. Press ‘OK’ to close the ‘Viewsheet Options’ dialog box.

5. Drag the ‘Freehand Table’ component from the Component panel
into the Viewsheet grid. This opens the Table Editor.

6. Click on cell[1,0] in the table (second row, first column) to select
it. 

7. Select the ‘Formula’ option in the Data tab and press the ‘Edit’
button.

8. Enter the following formula in the Formula Editor: 

rowList(q,'Date? Total >10000');

This extracts values from the ‘Date’ column of the ‘Sales Explore’
Worksheet where the corresponding ‘Total’ value is greater than
$10000. It also makes the other fields of the data block available
via the field syntax, e.g., field['Category'].

9. Press ‘OK’ to close the Formula Editor.

10. Select ‘Expand Cell’ and choose ‘Vertical’. (This causes the
extracted data to fill down vertically.)
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11. Select cell[1,1] in the table (second row, second column). Select
the ‘Formula’ option in the Data tab, and enter the following
formula:

field['Category']

This returns the value in the ‘Category’ column corresponding to
the date in the first column.

12. Press the green ‘Apply’ button to close the Table Editor. The
resulting table displays the date for all orders greater than $10,000,
and the corresponding category.
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¢

6.4.4 mapList

The mapList() function groups a list of values according to a specified
mapping (named grouping). The mapping array consists of hybrid
alternating name-value pairs or [name array]-value pairs.

mapList(list, mapping_array, 'options string')
e.g., 
mapList(q['State'],[['AZ','CA'],'West',['NY','NJ'],'East'])

The options string values are as follows (multiple options are separated by
a comma delimiter):

• others=groupOthers/leaveOthers: Group all unmapped values in a 
generic group called ‘Others’ (groupOthers), or display each unmapped 
value as its own group (leaveOthers). Default is ‘groupOthers’.

• sort=asc/desc/false: Sort the values in ascending or descending order. 
Default is false.

• remainder: Specifies the label for the ‘Others’ group. If not specified, 
the ‘Others’ group is not displayed.

• distinct=true/false: Retrieve only distinct values. Default is false.

6.4.5 toList

The toList() function is the most commonly used Freehand Table
function. It generates a unique, sorted, and grouped list from the values in a
JavaScript array. 

In most cases, you will use toList() to obtain distinct values from a query
when you create header rows/columns. For example, toList(q['state'])
obtains a distinct list of states in ascending order from query variable q.

The full syntax of the function is

toList(list, 'options string');

where options string values are as follows (multiple options are separated
by a comma delimiter):
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• sort = asc/desc/false: Sort the values in ascending or descending 
order. Default is asc. 

• sorton: Sort the values according to a specified measure, e.g., 
sorton=sum(Total). Sorting by sorton is applied before Top/Bottom-N 
filtering implemented by maxrows.

• sorton2: Sort the values according to a specified measure, e.g., 
sorton2=sum(Total). Sorting by sorton2 is applied after Top/Bottom-N 
filtering implemented by maxrows.

• remainder: Specifies the label for the ‘Others’ group when Top/Bottom-
N filtering is in effect. If not specified, the ‘Others’ group is not 
displayed.

• maxrows = num: Limits the number of rows returned.

• distinct = true/false: Retrieve only distinct values. Default is true. 

• date = year/quarter/month/week/day/hour/minute/second/weekday/

monthname/weekdayname: Group date values according to specified 
period, and return the period designation.

• rounddate = year/quarter/month/week/day/hour/minute/second/ 

weekday/monthname/weekdayname: Group date values according to 
specified period, and return the rounded date value. 

The rounddate option is useful when you want to group by month and year,
(e.g., Jan 2005 and Jan 2006, etc.). For example, if the ‘Order Date’ field in
a query has the following values,

[Jan-2-2002, Feb-21-2004, Feb-25-2004, Nov-25-2005]

the toList function with a rounddate grouping of month,

toList(q['Order Date'], 'rounddate=month'); 

returns a unique list of dates containing the first day of the month of the
given year:

[Jan-1-2002, Feb-1-2004, Nov-1-2005]

See Also
Referencing a Cell with Relative Parent Group Reference, for a complete
example.
Running a Query from Script, to extract query data into a JavaScript Array.
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7 Changing Images with Script

You can dynamically set the image file (GIF, JPG, etc.) of an image
component using a variable or an expression. Follow the steps below:

1. Add an image element into the Viewsheet. Right-click and select
the ‘Properties’ option. This opens the ‘Image Properties’ dialog
box.

2. Select the Advanced tab and select ‘Dynamic Image Selection’.

3. From the drop-down menu, select ‘Expression’ or ‘Variable’,
depending on the mechanism you wish to use to set the image
property. 

.

4. If you choose ‘Expression’, click the ‘Formula Editor’ button, and
add a script in the text area. A typical script might take the
following form: 

if(condition) {
'image1.gif';

} else {
'image2.gif';

}

You can specify an image by the uploaded image name (e.g.,
'image1.gif'), a resource path on the server (e.g., '/library/
image1.gif'), or a URL (e.g., “http://www.google.com/images/
logos/ps_logo2.png”).
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5. Click ‘OK’ to close the Formula Editor, and then click the ‘OK’ to
close the ‘Image Properties’ dialog box. 

The Image component now displays the specified image file.

See Also
Image, for scripting functions related to Images.
getImage(string), for another approach to setting images dynamically.
Creating an Image, in Advanced Dashboard Design, for information on
uploading and referencing images.
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Appendix VS: Viewsheet Object Reference

This appendix describes all objects in the Viewsheet environment.

See Also
Common Reference, for general JavaScript and charting functions.
Advanced Report Scripting, for functions specific to the reporting
environment.

VS.1 Global Functions and Properties

The Viewsheet environment provides a few global functions and properties
in addition to those defined by the standard JavaScript runtime (see
Appendix JS: General JavaScript Functions). This section presents the
additional functions.

VS.1.1 thisViewsheet

This section presents global Viewsheet functions that address Viewsheet
appearance and scheduling.

thisViewsheet.ADDACTION(ICON,LABEL,ACTION)

Adds a button to the Viewsheet toolbar to perform a scripted action. 

See Localizing/
Internationalizing a
Dashboard in
Advanced Dashboard
Design for more
information about the
SreeBundle file.

Parameters
icon The file containing the button image (21x21), 
a resource, file path, or URL (see below)
label A string specifying the button label or an ID 
that maps to a label in the SreeBundle file
action A Viewsheet script that executes when the 
button is pressed (e.g., the name of a function to execute)

Example
thisViewsheet.addAction('dateButton.png','Get 
date...',"alert(formatDate(CALC.today(),'MMMM dd, yyyy'))")

The icon parameter can specify a file name, resource path, file path, or
URL. If specified as a resource, the image must be located on the classpath.
If the icon parameter specifies a simple file name, the server will search for
the file in the following locations:

• The image directory specified on the ‘Presentation’ > ‘Viewsheet’ > 
‘Toolbar Icons’ page of Enterprise Manager. (See Viewsheet Toolbar 
Icons in Advanced Server Administration.)

• The directory webapps\sree\WEB-INF\classes\inetsoft\fl\images, if the 
Flash version of the Viewsheet is displayed.

• The directory webapps\sree\WEB-INF\classes\inetsoft\html\images, if 
the HTML version of the Viewsheet is displayed.



DATA MASHUP

802 of 1397

The button image should be square with sides of length 21 pixels. If the
server cannot find the image, a default button image will be substituted.

thisViewsheet.SCHEDULEACTION(BOOLEAN[,EMAILS])

Specifies whether the Viewsheet should be executed as part of a scheduled
task. Set to true to allow the Viewsheet to run as scheduled. Set to false to
override the scheduled task setting and suppress Viewsheet execution.

Parameters
Boolean true (default): execute task

false: do not execute task
emails Array of emails

You can use the scheduleAction function to conditionalize the execution of
a scheduled Viewsheet task based on actual Viewsheet data. For example,
the following script uses the value of a Gauge component to determine
whether the Viewsheet task should execute as scheduled.

Example
if (Gauge1.value > 10000) {
thisViewsheet.scheduleAction(true)

}
else {
thisViewsheet.scheduleAction(false)

}

If the scheduled action is a user notification (for example), then the user
will receive the alert only when the value of the Gauge component exceeds
the threshold.

Use the optional second parameter, emails, to dynamically set the list of
emails for the ‘Deliver To Emails’ scheduled action. The list that you
provide in the emails array supersedes any emails specified on the
Scheduler Action tab (both for user-scheduled tasks and administrator-
scheduled tasks), and automatically enables the ‘Deliver To Emails’ task
action.

Example
if (Gauge1.value > 10000) {
emails = ['joe@inetsoft.com', 'sue@inetsoft.com', 

'mark@inetsoft.com'];
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}
else {
emails = ['joe@inetsoft.com'];

}
thisViewsheet.scheduleAction(true, emails);

See Also
Setting an Alert, in Using the Portal, for end-user alert specification.
Setting an Alert, in Advanced Server Administration, to set an alert based
on highlight or range condition.
Scheduling a Dashboard, for information on Scheduling Viewsheets.

thisViewsheet.ISACTIONVISIBLE(NAME)

Returns the visibility setting for the specified toolbar button. 

Parameters
name name of toolbar button (String):

'Previous'
'Next'
'Refresh'
'Bookmark'
'Annotation'
'Email' 
'Print'
'Export'
'Import'
'Edit'
'Schedule'
'Close'
'Full Screen'
'Toolbar'

Example
if (!thisViewsheet.isActionVisible("Export")) {
alert('Some features are disabled.');

}

thisViewsheet.SETACTIONVISIBLE(NAME,BOOLEAN)

Sets the visibility of Viewsheet toolbar buttons. To hide a button, set the
value to false. 

Note: The
setActionVisible
property for individual
components is
documented with the
other component
properties.

Parameters
name name of toolbar button (String): 

'Previous'
'Next'
'Refresh'
'Bookmark'
'Annotation'
'Email' 
'Print'
'Export'
'Import'
'Edit'
'Schedule'
'Close'
'Full Screen'
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'Toolbar'
boolean false: hide the specified button

true: show the specified button

Example
thisViewsheet.setActionVisible("Export", false);

thisViewsheet.UPDATETIME

Returns the date/time at which data was most recently obtained by the
Viewsheet.

• If a materialized view is in effect for the Viewsheet (see Materialized 
Views in Advanced Server Administration), thisViewsheet.updateTime 
returns the date/time at which the most recent materialized view was 
generated for the Viewsheet. 

• If a materialized view is not in effect, thisViewsheet.updateTime 
returns the date/time of the most recent query execution for the 
Viewsheet.

Type
Date Date/time at which data was obtained

Example
Text1.text = 'Last Updated at ' + 
formatDate(thisViewsheet.updateTime,'MMM dd, h:mm a'); 

See Also
Materialized Views, in Advanced Server Administration, for information
about scheduling materialized views.

VS.1.2 parameter

The parameter property allows you to read and write Variables that have
been defined in a Worksheet (Creating a Variable in Advanced Data
Mashup) or Input controls that have been defined in a Viewsheet. The
syntax is 

parameter.variableName

where variableName is the name of the Variable asset defined in the
Worksheet or the Input component defined in the Viewsheet. 

Example
parameter.stateSelector
parameter.RadioButton1

You can also define new parameters within the Viewsheet itself.

Example
parameter.myParamName = 'Hello';
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See Also
Form Components, in Advanced Dashboard Design, for more information
on Input controls.
Creating a Variable, in Advanced Data Mashup, for more on using
Variable assets.

parameter._GROUPS_

Returns an array of groups to which the current user belongs.

Type
Array of Strings Groups to which currennt user belongs

Example
alert('User belongs to: ' + parameter._GROUPS_.join(', '))

parameter._ROLES_

Returns an array of roles possessed by the current user.

Type
Array of Strings Roles possesed by current user

Example
alert('User roles: ' + parameter._ROLES_.join(', '))

parameter._USER_

Returns the user name of the current user.

Type
String User name of current user

Example
alert('Logged in as ' + parameter._USER_)

parameter.__PRINCIPLE__

Returns the SRPrincipal object, which contains session information.

Type
Object SRPrincipal object

Example
var p = parameter.__principal__;
p.setParameter('State', ['NJ', 'NY', 'CT']);

See Also
Accessing the User Session with SRPrincipal, in Advanced Server
Integration, for details on writing user data to SRPrincipal.
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parameter.LENGTH

Returns the number of currently defined parameters.

Type
Integer Number of currently defined parameters

Example
alert(parameter.length)

parameter.PARAMETERNAMES

An array containing the current parameter names.

Type
String Parameter Name

Example
alert(parameter.parameterNames[0])

VS.1.3 Special Functions

The next sections describe some special purpose functions.

PVIEWSHEET

For a Viewsheet that is accessed via drilldown (hyperlink or auto-drill)
from another Viewsheet, the pviewsheet property provides access to the
current settings of components within the parent Viewsheet. 

For example, if the parent Viewsheet contains a Selection List named
‘Company’, you can obtain the array of currently selected companies in the
‘Company’ Selection List within the drilldown Viewsheet script by using
the following syntax.

pviewsheet.Company.selectedObjects

See Also
Viewsheet Object Reference, for a list of accessible Viewsheet component
properties.
Hyperlinks, in Advanced Dashboard Design, for information on Viewsheet
drilldowns.
Auto-Drilldown, in Advanced Data Modeling, for information on
configuring data-level hyperlinks.
pviewsheet in Advanced Report Scripting, to access component settings
from within a drilldown report.
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EVENT

User interactions with
editable tables, Input
components, and
Selection components
automatically re-
execute the Viewsheet
onRefresh handler.

The event object can be used within an onRefresh Handler script to provide
information about the user’s most recent action in editable Tables, Form
Components, and Filter Components (Selection List, Selection Tree, Range
Slider, Calendar). The event object is instantiated at runtime when a user
makes an interaction of the appropriate type, so you should test for its
existence before attempting to access its properties. For example:

if(event!=null) {
// access 'event' properties, such as...
// event.name, event.type, event.source, etc.

}

For an editable Table, the event object provides the following properties:

For an Input component or Selection component, the event object provides
the following properties:

See Also
Accessing the Most Recent User Modification, for additional discussion of
‘event’ object.

RUNQUERY(QUERY_NAME [,PARAMETERS])

Returns a result set as a two-dimensional array that can be used within
Viewsheet script. 

Parameters
query_name a string containing the query name
parameters (optional) a two dimensional string array,

each row containing a name-value pair 
that corresponds to a query parameter

event.name The name of the table component.
event.type The type of the component, always ‘table’.
event.row The index of the row in the table which the user modified.
event.column The index of the column in the table which the user modified.
event.source A reference to the table object which can be used to access table 

properties.

event.name The name of the component, e.g., “SelectionList1”
event.type The type of the component: ‘radiobutton’, ‘checkbox’, 

‘combobox’, ‘textinput’, ‘selectionlist’, ‘selectiontree’, 
‘rangeslider’, ‘calendar’

event.source A reference to the component which can be used to access 
component properties, e.g., event.source.title='New 
Title'.
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Example
var rs = 
runQuery('orders',[['category','Business'],['price',100]]);

See Also
Running a Query from Script, for examples of executing Worksheet
queries.

GETIMAGE(STRING)

Loads an image from a Java resource, URL, or database BLOB (binary
large object).  The getImage() function checks whether the argument
specifies a valid resource. If it does not specify a resource, then getImage()
treats the parameter as an encoded image. Both ASCII Hex and ASCII85
are supported (useful for XML data).

To retrieve a BLOB from a database, first use a Data Worksheet to create a
data block with a column bound to the image data field. Then use
getImage() to reference the desired data block cell, as shown in the
example below. 

Parameters
string image file resource path or URL

or
data block cell containing BLOB data 
(ascii hex/ascii85 gif/jpeg image data)

Example
// resource path
Image1.image = getImage('/com/mypackage/icon.gif');

Example
// URL
Image1.image = getImage('http://visualizefree.com/images/
inetsoft.png');

Example
// 'picture' column in data block 'Query1' contains BLOBs
Image1.image = getImage(Query1[1]['picture']);

See Also
Changing Images with Script, for another approach to dynamically setting
images.

ALERT(MESSAGE)

Opens a dialog box to display a specified message. This function does not
pause script execution.

Parameters
message a string containing the message to display
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Example
var arr = ['Sue','Robert','Eric'];
alert(arr.join(","))

See Also
confirm(message), to prompt the user with a choice dialog box.

CONFIRM(MESSAGE)

See Adding
Component Script for
information about the
onClick handler.

The confirm() function opens a dialog box to provide the user with a
choice to continue or cancel an operation. For example, you can use the
confirm() function in the onClick script of a ‘Submit’ button to verify the
user’s intension to submit.

The confirm function does not suspend script processing. Rather, a script
containing the confirm function is automatically executed either once or
twice: 

1. On the first execution of the script, the property
confirmEvent.confirmed is set to false.

2. On the second execution of the script, which occurs only if the user
presses ‘Yes’ in the ‘Confirm’ dialog box, the property
confirmEvent.confirmed is set to true.

This repeated script execution allows you to invoke different operations
depending on the user’s response to the confirmation prompt. For example,
the script below asks the user to confirm that they want to continue
submission even though they have not provided values for both TextInput
components.

if(!confirmEvent.confirmed) { 
if((TextInput1.value==null) || (TextInput2.value==null)) 
{
confirm('You have not entered all values.  Continue?')

}
}
else {
parameter.val1 = TextInput1.value;
parameter.val2 = TextInput2.value;
alert('Input has been submitted.')

}
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The script executes a first time when a user presses the ‘Submit’ button.
During this first execution, confirmEvent.confirmed is false, so the
TextInput values are tested and the ‘Confirm’ dialog box is generated.

If the user presses ‘No’, the dialog box is closed and no action is taken. If
the user presses ‘Yes’, the script executes a second time with
confirmEvent.confirmed set to true, which commences the action in the
else block. (In this case, the desired action is simply to assign the TextInput
values to corresponding Viewsheet parameters.)

See Also
alert(message), to display a dialog box message to the user.
Submit Button, in Advanced Dashboard Design, for information on how to
create a Submit button.

REFRESHDATA()

Clears all cached Viewsheet data. 

Example
refreshData();

VS.2 Common Properties

This section describes basic properties that are shared by most of the
Viewsheet components. Exceptions are noted where appropriate.

ALIGNMENT

Specifies the horizontal and vertical alignment of an element. Its value is a
bitwise OR of a horizontal alignment option and a vertical alignment
option.

HORIZONTAL ALIGNMENT VERTICAL ALIGNMENT

StyleConstant.H_LEFT StyleConstant.V_TOP
StyleConstant.H_CENTER StyleConstant.V_CENTER
StyleConstant.H_RIGHT StyleConstant.V_BOTTOM
StyleConstant.H_CURRENCY StyleConstant.V_BASELINE
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Type
integer

Example
alignment = StyleConstant.H_CENTER | StyleConstant.V_CENTER;

See Also
Alignment Tab, for more information about alignments.

ALPHA

Specifies the transparency/opacity of the component’s fill color as a value
between 0 (completely transparent) and 100 (completely opaque).

Type
Number

Example
alpha = 35.5;

See Also
Color Tab, for more information about setting color.

BACKGROUND

Specifies the background color that fills the area of the element.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
background = java.awt.Color.lightGray;

See Also
Color Tab, for more information about setting color.

BORDERCOLORS

Specifies the element border colors as an array of four values in the
following order: [top,bottom,left,right]. Each color can be of one of the
types given below.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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Example
borderColors = [[255,0,0], 0x444444, 'blue', 'black'];

See Also
Color Tab, for more information about setting color.

BORDERS

Specifies the individual line styles for each border of the element, as an
array of form [top,left,bottom,right].

Type
Array of Line Styles

Example
borders = 
[StyleConstant.DOUBLE_LINE,StyleConstant.NO_BORDER,
StyleConstant.THIN_LINE, StyleConstant.NO_BORDER];

See Also 
Border Tab, for additional information on borders.

DATACONDITIONS

Returns the Flyover View conditions that are currently in effect on a filtered
component. The dataConditions property provides an array of attributes,
attr[], and an array of values, value[], that contain the conditions for all
flyover filters currently being applied to a specified component.

Type
dataConditions.attr[] Array of filtered dimension 
labels
dataConditions.value[] Array of filtered dimension 
values

Example
Consider a Chart that uses a flyover view to filter a Table named “Query1”.
If the ‘On Click Only’ option is set for the Chart flyover (and therefore
multiple Chart groups can be selected in the flyover), the Table’s
dataConditions.attr[] and dataConditions.value[] arrays will each
contain one item for every group the user selects on the Chart. You can
iterate through these arrays to obtain the currently selected dimensions and
values. 
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This script could also
be written as an
expression for the
‘Title’ property in the
General tab.

The script below is placed in the Script tab of the Table component
(“Query1”) that is being filtered, and modifies the ‘title’ property of the
Table.

var conds = Query1.dataConditions;
var txt = 'Filter: None'

if(!isNull(conds)) {
txt = 'Filter: ' + conds[0].attr + ' = ';
for(var i=0;i<conds.length;i++) {
txt += conds[i].value;
if(i != conds.length-1) {
txt += ', '

}
}

}

Query1.title = txt;

When the user selects groups on the Chart, the Table’s title bar indicates the
current flyover filter applied to the Table.
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See Also 
Flyover View, for additional information on flyover views.

ENABLED

Specifies whether the user can interact with the component. A disabled
component appears dimmed when the user opens the Viewsheet.

Type
Boolean true = enable, false = disable

Example
enabled = false;

See Also 
General Tab, for additional information on disabling a component.

FONT

Specifies the font for this element.

Type
java.awt.Font

Example
font = java.awt.Font('Verdana',java.awt.Font.BOLD, 35)

See Also
Font Tab, for more information about setting font.

FOREGROUND

Specifies the foreground (text) color of the component.

Type
java.awt.Color e.g., java.awt.Color.BLUE

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Font.html


DATA MASHUP

815 of 1397

number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
foreground = 'red';

See Also
Color Tab, for more information about setting color.

FORMAT

Sets the format. The available formats are shown below:

  – StyleConstant.DATE_FORMAT for date display
  – StyleConstant.DECIMAL_FORMAT for number display
  – StyleConstant.MESSAGE_FORMAT for text display
  – StyleConstant.PERCENT_FORMAT for fraction display 
  – StyleConstant.CURRENCY_FORMAT for locale-adapting currency display

To format cells or
columns of a Table,
use the tablelens
property.

For the Date, Decimal, and Message formats, use the formatSpec property
to assign a format specification using the appropriate masks. 

Example
// Number format
format = StyleConstant.DECIMAL_FORMAT;
formatSpec = "#,###.00";

Example
// Text format
format = StyleConstant.MESSAGE_FORMAT;
formatSpec = "{0} Inc."

FORMATSPEC

Specifies a formatting instruction to be used for representing data on the
screen. The formatting instruction is specific to the format type, Date,
Number, or Text.

To format cells or
columns of a Table,
use the tablelens
property.

Example
// Date format
format = StyleConstant.DATE_FORMAT;
formatSpec = "MM/dd/yyyy";

Example
// Number format
format = StyleConstant.DECIMAL_FORMAT;
formatSpec = "#,###.00";

Example
// Text format
format = StyleConstant.MESSAGE_FORMAT;
formatSpec = "{0} Inc."
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Date masks follow the
java.text.SimpleDateFo
rmat format.

Date Format: For date formatting, use the following date masks:

M = Month
d = date
y = year
E = day of the week

Example
For the date Nov 8, 2006:

M = 11; MM = 11; MMM = Nov; MMMM = November
d = 8; dd = 08;
yy = 06; yyyy = 2006
EEE = Wed
EEEE = Wednesday

Therefore, mask 'MMM-dd-yyyy' yields “Nov-08-2006.”

Numeric masks
follow the
java.text.DecimalForm
at format.

Number Format: For number formatting, use the following numeric
masks:

# = number 
0 = Number with zero padding

Example
For the number 124521.63:

#,###.## yields 124,521.63
#,###.000 yields 124,521.630

Text Format: For text formatting, use {0} as a placeholder for the string
data.

Example
For the string 'Susan':

Salesperson: {0} yields Salesperson: Susan
--{0}-- yields --Susan--

See Also
formatDate, for details on date formatting syntax.
formatNumber, for details on decimal formatting syntax.
Format Tab, for more information about format specifications.

POSITION

Specifies the position of the top-left corner of a component in terms of
Viewsheet grid cells, where the top-left corner of the grid is (0,0).
Fractional values for vertical and horizontal position are rounded down to
the next lowest integer. This property does not take effect in the design
view of Visual Composer and does not apply to components within a
Selection Container.

http://download.oracle.com/javase/7/docs/api/index.html?java/text/SimpleDateFormat.html
http://download.oracle.com/javase/7/docs/api/index.html?java/text/SimpleDateFormat.html
http://download.oracle.com/javase/7/docs/api/index.html?java/text/DecimalFormat.html
http://download.oracle.com/javase/7/docs/api/index.html?java/text/DecimalFormat.html
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Type
value a java.awt.Point object:

java.awt.Point(horizontal,vertical)

Example
// Table with top-left corner at column 4, row 9
TableView1.position = java.awt.Point(4,9) 

// Chart with top-left corner at column 2, row 25
Chart1.position = java.awt.Point(2,25) 

SELECTEDLABEL

Specifies the selected label of the component (not the value). Applies to
single value input elements (Slider, Spinner, Radio Button, Combo Box)
and the tabs of co-located components (Tabbed Interface). This property is
readable and writable.

Type
String label of the selected option

Example
RadioButton1.selectedLabel = 'New Jersey';

See Also
lables, to access the labels displayed in the component.
selectedObject, to access the value corresponding to the label.
selectedLabels, to access the currently selected labels in multi-valued
components.
Accessing User Input in Script, for more information about selectedLabel.

SELECTEDLABELS

Returns the selected labels (not the values) of the component as an array.
Applies to multi-value input elements (Check Boxes) and selection
elements (Selection Lists, Selection Trees, Range Slider, Calendars). This
is a read-only property.

Type
Array array of selected option labels 

Example
var num = SelectionList1.selectedLabels.length;
var msg = 'You selected ' + num + ' objects: ';
msg += SelectionList1.selectedLabels.join(', ');
alert(msg)

See Also
lables, to access the labels displayed in the component.
selectedObjects, to access the values corresponding to the labels.
selectedLabel, to access the currently selected label in single-valued
components.

http://docs.oracle.com/javase/7/docs/api/index.html?java/awt/Point.html
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Accessing User Input in Script, for more information about
selectedLabels.

SELECTEDOBJECT

Specifies the selected value of the component (not the label). Applies to
single value input elements (Slider, Spinner, Radio Button, Combo Box)
and the tabs of co-located components (Tabbed Interface). This property is
readable and writable.

Type
String value of the selected option

Example
RadioButton1.selectedObject = 'NJ';

See Also
values, to access the values presented in the component list.
Accessing the Most Recent User Modification, to retrieve the most recent
modified object.
selectedLabel, to access the label corresponding to the value.
selectedObjects, to access the current selection in multi-valued
components.
Accessing User Input in Script, for more information about
selectedObject.

SELECTEDOBJECTS

Specifies the selected values (not the labels) of the component as an array.
Applies to multi-value input elements (Check Boxes) and selection
elements (Selection Lists, Selection Trees, Range Slider, Calendars). 

This property is readable and writable for Selection Lists, Selection Trees,
and Calendars, and is read-only for other components. Script that reads the
value of the selectedObjects property can be placed either on the
component or in the onInit Handler/onRefresh Handler, while script that
writes the selectedObjects property must be placed in the onInit Handler/
onRefresh Handler.

Type
Array array of selected option values 

Example (Reading)
var num = SelectionList1.selectedObjects.length;
var msg = 'You selected ' + num + ' objects: ';
msg += SelectionList1.selectedObjects.join(', ');
alert(msg)

Example (Writing Selection List Default)
SelectionList1.selectedObjects=['CA','MA','TX'];
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Example (Writing Calendar Default)
var today = new Date();
var selection = "d" + (1900 + today.getYear()) + "-" + 
today.getMonth() + "-" + today.getDate();
Calendar1.selectedObjects = [selection];

See Also
values, to access the values presented in the component list.
Accessing the Most Recent User Modification, to retrieve the most recent
modified object.
selectedLabels, to access the labels corresponding to the values.
selectedObject, to access the current selection in single-valued
components.
Accessing User Input in Script, for more information about
selectedObjects.

SIZE

Specifies the width and height of a component in terms of Viewsheet grid
cells. Fractional values for width and height are rounded down to the next
lowest integer. This property does not take effect in the design view of
Visual Composer and does not apply to components within a Selection
Container.

Type
value a java.awt.Dimension object:

java.awt.Dimension(columns,rows)

Example
// Table spanning 7 grid columns, 4 grid rows
TableView1.size = java.awt.Dimension(7,4) 

// Chart spanning 6 grid columns, 20 grid rows
Chart1.size = java.awt.Dimension(6,20)

TITLE

Specifies the text that appears in the title bar of the component. This
property is only available for components that possess a title bar.

Type
String text to appear in title bar

Example
SelectionList1.title = "Company Selector"

See Also
General Tab, for more information on the title.

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Dimension.html
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VISIBLE

Specifies the visibility of the component. This property can be used to
dynamically hide elements in a Viewsheet.

Type
Boolean true: display the component

false: hide the component

Example
if (Gauge1.value > 200) {
Text1.text = 'Too high!';
Text1.visible = true;

}
else if (Gauge1.value < 50) {
Text1.text = 'Too low!';
Text1.visible = true;

}
else {
Text1.visible = false;

}

See Also
General Tab, for more information on visibility.

WRAPPING

Specifies whether text that exceeds its boundaries is wrapped or truncated.
This property is available for the following components: Table, Embedded
Table, Crosstab Table, Selection List, Selection Tree, and Text.

Type
Boolean true: wrap text

false: truncate text

Example
Table1.wrapping = true;

See Also
General Tab, for more information on visibility.

VS.3 Table

This section presents functions for Table operations.

See Also
Crosstab Table, for properties specific to pivot tables.

QUERY

Specifies the data block to be used by the Table component. The available
data blocks appear at the top of the Component panel in Visual Composer.
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Type
string

Example
TableView1.query = 'SalesByDate';
TableView1.fields = ['State','Company','Total'];

See Also
fields, to specify the fields to display in the table.

FIELDS

Specifies the fields of the data block to be displayed in the Table.

Type
array

Example
TableView1.query = 'SalesByDate';
TableView1.fields = ['State','Company','Total'];

See Also
query, to specify the data block from which to draw the fields.

COMMIT(TYPE)

When a user adds or changes a row in an editable table, the new or
modified row is highlighted in color. To clear the highlight on these rows
and remove them from the corresponding array returned by getFormRows,
use the table’s ‘commit’ function.

Parameters
type the type of rows to commit: ADDED, CHANGED,

DELETED, or the index of a particular row
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Example
// Clear highlights on added rows, and remove them from 
// array returned by getFormRows(ADDED).
Table1.commit(ADDED); 

// Clear highlights on changed rows, and remove them from 
// array returned by getFormRows(CHANGED).
Table1.commit(CHANGED);

// Remove deleted rows from array returned by 
// getFormRows(DELETED).
Table1.commit(DELETED);

// Remove the row returned by getFormRows(idx) from the 
// array of modified rows.
Table1.commit(idx);

See Also
Accessing User-Modified Data in a Table, for information on accessing
user edits.
Table Properties: Advanced Tab, for information on making a table
editable.

DATA

Two dimensional array containing the original table data (prior to grouping
and aggregation) If no grouping or summarization is defined for the table,
the ‘data’ property is the same as the ‘table’ property. Otherwise, ‘data’
holds the raw data and ‘table’ holds the summarized data. The data can be
referenced using the row number as the first array index and the column
number or label as the second array index. This property is read-only.

Type
Two-dimensional array

Example 1
for (var i=1; i<data.length; i++) {
if (Query1.data[i]['Name'] == 'Web Bridge') {
alert('Note: "Web Bridge" will be discontinued.'); 

}
} 

Example 2
Text1.text = 'Grand total is ' + sum(Query1.data['Total']);

See Also
Accessing Table Data, for information about working with table data.

DATA.LENGTH

Returns the number of rows in a table, prior to aggregation and
summarization. 
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Type
integer

Example
// Testing for empty result set:
if (Query1.table.length == 1) {
Text1.text = 'No data returned';

}

See Also
table.length, for the length of post-aggregate (as-displayed) results table.
Accessing Table Data, for information about working with table data.

DATA.SIZE

Returns the number of columns in a table, prior to grouping and
aggregation. 

Type
integer

See Also
table.size, for the width of post-aggregate (as-displayed) results table.
Accessing Table Data, for information about working with table data.

GETFORMROW(ROW)

For an editable table, retrieves the edited row specified by the index. Often
the index is provided by the event object for the editable table.

Parameters
row row index

Example
var changedRow = Table1.getFormRow(row);

See Also
Accessing the Most Recent User Modification, for an example of using
getFormRow().
Accessing User-Modified Data in a Table, for general discussion.
Table Properties: Advanced Tab, for information on making a table
editable.

GETFORMROWS([TYPE])

For an editable table, retrieves the rows that have been modified by the
user. The type parameter specifies the set of rows to return, and can be
provided in string form (e.g., 'added') or constant form (e.g., ADDED). Omit
the parameter to return all rows in table.
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Parameters
type ADDED: return new rows inserted by user

CHANGED: return old rows modified by user
DELETED: return old rows deleted by user
OLD: return all old rows

Example
var allRows = Table1.getFormRows();
var addedRows = Table1.getFormRows(ADDED);
var changedRows = Table1.getFormRows(CHANGED);
var deletedRows = Table1.getFormRows(DELETED);
var oldRows = Table1.getFormRows(OLD);

See Also
Accessing User-Modified Data in a Table, for general discussion.
Table Properties: Advanced Tab, for information on making a table
editable.

APPENDROW(ROW)

For an editable table, inserts a new blank row following the row specified
by integer parameter row, and adds this new row to the array returned by
getFormRows(ADDED).

Parameters
row integer row index

Example
// Add new row below row 4:
TableView1.appendRow(4);

// Set initial values in new row (row 5):
TableView1.setObject(5,0,'Enter Name')
TableView1.setObject(5,1,'Enter Price')
TableView1.setObject(5,2,'Enter Quantity')
TableView1.setObject(5,3,'Enter Total')

See Also
setObject(row,col,value), to write data into an editable table cell.
Accessing User-Modified Data in a Table, for general discussion.
Table Properties: Advanced Tab, for information on making a table
editable.

DELETEROW(ROW)

For an editable table, deletes the row specified by integer parameter row,
and adds this deleted row to the array returned by getFormRows(DELETED).

Parameters
row integer row index

Example
// Delete row 4:
TableView1.deleteRow(4);
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See Also
Accessing User-Modified Data in a Table, for general discussion.
Table Properties: Advanced Tab, for information on making a table
editable.

INSERTROW(ROW)

For an editable table, inserts a new blank row prior to the row specified by
integer parameter row, and adds this new row to the array returned by
getFormRows(ADDED).

Parameters
row integer row index

Example
// Add new row above row 4:
TableView1.insertRow(4);

// Set initial values in new row 4:
TableView1.setObject(4,0,'Enter Name')
TableView1.setObject(4,1,'Enter Price')
TableView1.setObject(4,2,'Enter Quantity')
TableView1.setObject(4,3,'Enter Total')

See Also
setObject(row,col,value), to write data into an editable table cell.
Accessing User-Modified Data in a Table, for general discussion.
Table Properties: Advanced Tab, for information on making a table
editable.

GETHIDDENCOLUMNVALUE(COL,ROW)

For a hidden column (often a primary key column) in an editable table,
retrieves the value in the specified row of the hidden column.

Parameters
col hidden column name
row row index

Example
for(var i=0; i<TableView1.table.length; i++) {
if(TableView1.getFormRow(i).rowState == CHANGED) {
var hiddenValue = 

TableView1.getHiddenColumnValue("columnName", i);
}

}

See Also
Hiding Table Columns, in Advanced Dashboard Design, to hide columns
of an editable table.
Accessing the Most Recent User Modification, for an example of using
getFormRow().
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Table Properties: Advanced Tab, for information on making a table
editable.

SETACTIONVISIBLE(NAME, BOOLEAN)

Sets the visibility/accessibility of end-user Table features. To disable a
feature, set the value to false.

Parameters
name name of table function (String): 

'Export'
'Show Details' (Freehand Table)
'Sort Column' (column header 'Sort' button)

boolean false: hide the specified function
true: show the specified function

Example
TableView1.setActionVisible("Show Details", false);

See Also
thisViewsheet.setActionVisible(name,Boolean), to show or hide Viewsheet
toolbar buttons.

ISACTIONVISIBLE(NAME)

Returns the visibility/accessibility of the specified end-user Table feature.

Parameters
name name of table function (String): 

'Export'
'Show Details' (Freehand Table)
'Sort Column' (column header 'Sort' button)

Example
if (TableView1.isActionVisible('Export')==true) {
Text1.text = 'Press toolbar button to export.';

}

See Also
thisViewsheet.isActionVisible(name), to return Viewsheet toolbar button
visibility.

SETHYPERLINK(ROW, COL, HYPERLINK)

Creates a hyperlink for an individual table cell.

Parameter
row row index
col column index
hyperlink string or 

inetsoft.report.Hyperlink.Ref object

Example
setHyperlink(1, 1, "Tutorial/Ad Hoc");
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setHyperlink(1, 1, null); // remove hyperlink

See Also
Hyperlinks, in Advanced Dashboard Design, for basic information on
hyperlinks.

SETCOLUMNWIDTH(COL, WIDTH)

Sets the width of the specified table column in pixels.

Parameter
col column index (first column is index 0)
width positive integer sets column width in pixels

-1 sets automatic width calculation (default)
0 sets zero width (column hidden)

Example
//Set third column width to 200 pixels
TableView1.setColumnWidth(2,100); 

SETROWHEIGHT(ROW, HEIGHT)

Sets the height of the specified table row in pixels. Row index 0 is the
column header row. Setting the height for any body row has the effect of
setting the same height for all body rows.

Parameter
row row index (column header row is index 0)
height positive integer sets row height in pixels

-1 sets automatic height calculation 
(default)

0 sets zero height (row hidden)

Example
//Set body row height to 30 pixels
TableView1.setRowHeight(1,30); 

SETOBJECT(ROW,COL,VALUE)

Sets the contents of an editable table cell to the specified value.

Parameter
row row index of cell to modify
col column index of cell to modify
value value to be placed into cell

Example
// Insert text “Robert” into third row, fourth column:
TableView1.setObject(2,3,'Robert');

See Also
Table Properties: Advanced Tab, in Advanced Dashboard Design, for
information on how to make a table editable.
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Accessing the Most Recent User Modification, to retrieve the most recent
modified object.
Accessing User Input in Script, for information about selectedObject.

SETPRESENTER(ROW,COL,PRESENTER)

Sets the contents of an table cell to the specified presenter. Built-in
presenters include the following: 

  – inetsoft.report.painter.BarPresenter
  – inetsoft.report.painter.IconCounterPresenter
  – inetsoft.report.painter.BooleanPresenter
  – inetsoft.report.painter.Bar2Presenter
  – inetsoft.report.painter.ButtonPresenter 
  – inetsoft.report.painter.ShadowPresenter

Parameter
row row index of cell to modify
col column index of cell to modify
presenter name of Presenter

Example
// Rotate the text in the top-left cell by 45 degrees:
Table1.setPresenter(0,0,"HeaderPresenter");

TABLE

Two dimensional array holding the table cell data as displayed (after any
grouping and aggregation). If no grouping or summarization is defined on
the table, the ‘table’ property is the same as the ‘data’ property. The data
can be referenced using the row number as the first array index and the
column number or name as the second array index. 

This property is read-only. To write data to an editable table, use
setObject(row,col,value).

Type
Two-dimensional array

Example 1
for (var i=1; i<table.length; i++) {
if (Query1.table[i]['Name'] == 'Web Bridge') {
alert('Note: "Web Bridge" will be discontinued.'); 

}
} 

Example 2
Text1.text = 'Grand total is ' + sum(Query1.table['Total']);

See Also
setObject(row,col,value), for information on modifying data in an editable
table.
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Accessing Table Data, for information about working with table data.

TABLE.LENGTH

Returns the number of rows in a table, as displayed. It counts the header
rows as well as the data rows.

Type
integer

Example
// Testing for empty result set:
if (Query1.table.length == 1) {
Text1.text = 'No data returned';

}

See Also
Accessing Table Data, for information about working with table data.
data.length, for number of rows prior to grouping and summarization.

TABLE.SIZE

Returns the number of columns in a table, as displayed.

Type
integer

See Also
Accessing Table Data, for information about working with table data.
data.size, for number of columns prior to grouping and summarization.

TABLESTYLE

Specifies a predefined style to be applied to the Table. 

Type
String

Example
Query1.tableStyle = 'Shaded'

See Also
Table Properties, for more information about Table propeties.

TABLELENS

Specifies the Table’s TableLens object, which allows you to access and
modify table attributes using API methods.

Type
inetsoft.report.lens.AttributeTableLens
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Example
TableView1.tablelens.setForeground(0, 2, 
java.awt.Color.red);

SHRINK

Reduces the height of the table to match the number of records displayed.
For example, if the original table height (as designed) was 10 rows, and the
user then makes selections which restrict the result set to five rows, the
table’s bottom border will retract upward or “shrink” to eliminate any
empty rows at the bottom of the table. 

Type
Boolean true: shrink table to fit contents

false: do not shrink table

Example
TableView1.shrink=true;

See Also
Table Properties: Advanced Tab, in Advanced Dashboard Design, for
information on setting the property without script.

VALUE

Returns the value in the cell currently referenced by a ‘Format’ expression
script. For example, if you specify a ‘Text Color’ expression in the
‘Format’ dialog box for a table header cell, you can use the value property
within the script to obtain the value in the targeted header cell. Likewise, if
you specify a ‘Text Color’ expression in the ‘Format’ dialog box for a
detail cell in a table column (which means that the expression will be
evaluated in turn for each detail cell in the column), you can use the value
property within the script to obtain the value of the currently referenced
detail cell.

Example
The script below can be used in a ‘Text Color’ or ‘Fill Color’ expression to
set color formatting on a table detail cell.

if (value > 1000) {
[255,0,0]

}
else {
[0,255,0]

}

See Also
Accessing Data in the Current Cell (‘value’), for further information.
Table Properties, for general information about the Table component.
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FIELD

Returns the value of the cell in the specified field (column) and same row
as the cell currently referenced by a ‘Format’ expression script. For
example, if you specify a ‘Text Color’ expression in the ‘Format’ dialog
box for a detail cell in a table column, you can use the field property
within the script to obtain the value of the detail cell in the corresponding
row of another column.

Example
The script below can be used in a ‘Text Color’ or ‘Fill Color’ expression to
set color formatting on a table detail cell.

if (field['Total'] > 400) {
[255,0,0];

} else {
[0,0,255];

}

See Also
Accessing Data in the Same Row (‘field’), for further information.
Table Properties, for general information about the Table component.

COL

Returns the column index of the cell currently referenced by a ‘Format’
expression script. For example, if you specify a ‘Text Color’ expression in
the ‘Format’ dialog box for a detail cell in a table, you can use the col
property within the script to obtain the index of the column. This, together
with table array and the row property allow you to construct relative
references to other cells in the table.

Example
The script below can be used in a ‘Text Color’ or ‘Fill Color’ expression to
set color formatting on a table detail cell. It assigns a red color if the value
in the cell is less than the value of the same cell in the row above, and
assigns a green color otherwise. 

if (row > 1) {
if (value < table[row-1][col]) {
[255,0,0]

}
else {
[0,255,0]

}
}

See Also
table, for more information about the ‘table’ array.
Accessing Data in Different Row or Column (‘row’/‘col’), for further
information.
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Table Properties, for general information about the Table component.

ROW

Returns the row index of the cell currently referenced by a ‘Format’
expression script. For example, if you specify a ‘Text Color’ expression in
the ‘Format’ dialog box for a detail cell in a table, you can use the row
property within the script to obtain the index of the row. (The index will
change as the expression is evaluated in turn for each detail cell in the
column.) This, together with table array and the col property allow you to
construct relative references to other cells in the table.

Example
The script below can be used in a ‘Text Color’ or ‘Fill Color’ expression to
set color formatting on a table detail cell. It assigns a red color if the value
in the cell is less than the value of the same cell in the row above, and
assigns a green color otherwise. 

if (row > 1) {
if (value < table[row-1][col]) {
[255,0,0]

}
else {
[0,255,0]

}
}

See Also
table, for more information about the ‘table’ array.
Accessing Data in Different Row or Column (‘row’/‘col’), for further
information.
Table Properties, for general information about the Table component.

CELLFORMAT

Specifies the Table cell data format as a two dimensional array. The
attribute can be referenced using the row number as the first index and the
column header or number as the second index, [row][col]. Column and
row indices start at 0.

Type
two dimensional array of formats

Example
cellFormat[5][3] = [Chart.DATE_FORMAT, "yy-MMMM-dd"];
cellFormat[2]['Total'] = [Chart.DECIMAL_FORMAT, 
"#,###.00"];

See Also
Table Properties, for general information about the Table component.
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COLFORMAT

Specifies the Table column data format as an array. The attribute can be
referenced using the column header or number. Column and row indices
start at 0.

Type
array of formats

Example
colFormat[5] = [Chart.DATE_FORMAT, "yy-MMMM-dd"];
colFormat['Total'] = [Chart.DECIMAL_FORMAT, "#,###.00"];

See Also
Table Properties, for general information about the Table component.

TIPVIEW

Sets the data tip for the Table. The data tip is a graphical form of tooltip
which uses an arbitrary Viewsheet component to adaptively display
summarized data when the user hovers the mouse over cells in the Table.
See Data Tip View in Advanced Dashboard Design for more details.

Type
String name of a Viewsheet component

Example
TableView1.tipView='Gauge1';

See Also
Data Tip View, in Advanced Dashboard Design, to set the property without
using script.

FLYOVERVIEWS(ARR)

Specifies an array of component names, representing the components to be
filtered by table flyover.

Parameters
arr array of component names (String) 

Example
TableView1.flyoverViews = ['Crosstab1','Gauge1'];

See Also
Flyover View, in Advanced Dashboard Design, to set the property without
using script.
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FLYONCLICK

Specifies that components filtered by a table flyover will be updated only
when the user clicks on the table.

Type
Boolean true: update on mouse click

false: update on mouse hover (default)

Example
TableView1.flyOnClick = true;

See Also
Flyover View, in Advanced Dashboard Design, to set the property without
using script.

HIGHLIGHTED(NAME)

Identifies whether a highlight with the specified name has been applied to
the table (i.e., whether the highlight condition has been satisfied.)

Parameter
name name of the highlight

Example
if(Table1.highlighted.lowSales) {
alert('lowSales highlight was applied')

}

See Also
Highlights, in Advanced Dashboard Design, for basic information on
highlights.

VS.4 Crosstab Table

This section presents functions specifically for Crosstab Table operations.
The Crosstab Table component also supports all of the properties of the
Table component.

See Also
Crosstabs, for general information about crosstab or pivot tables.

QUERY

Specifies the data block to be used by the Crosstab component. The
available data blocks appear at the top of the Component panel in Visual
Composer.
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See Crosstab bindingInfo Property for additional data binding properties.

Type
string

Example
Crosstab1.query = 'Sales';
Crosstab1.bindingInfo.rowFields = ['Category','Name'];
Crosstab1.bindingInfo.colFields = ['Region','State'];
Crosstab1.bindingInfo.measureFields = ['Total','Quantity 
Purchased'];

DRILLENABLED

Specifies whether the automatic drill-down feature is enabled for the
crosstab. If disabled, the ‘+’ and ‘–’ drill operators do not appear on the
Crosstab headers.

Type
Boolean true = enabled, false = disabled

Example
Crosstab1.drillEnabled = false;

See Also
Drilling Down into a Crosstab, in Advanced Dashboard Design, for
information on using the drill-down feature.



DATA MASHUP

836 of 1397

FILLBLANKWITHZERO

Populate empty cells of the crosstab table with zeros. (Empty data cells
occur when no results exist corresponding to the row and column
headings.) 

Type
Boolean true: use zeros in empty cells

false: leave empty cells blank

Example
fillBlankWithZero = true

SETACTIONVISIBLE(NAME, BOOLEAN)

Sets the visibility/accessibility of end-user Crosstab features. To disable a
feature, set the value to false.

Parameters
name name of table function (String): 

'Export'
'Show Details'
'Sort Column' (column header 'Sort' button)

boolean false: hide the specified function
true: show the specified function

The 'Sort Column' setting overrides the sort.crosstab.aggregate and
sort.crosstab.dimension property settings.

Example
Crosstab1.setActionVisible("Show Details", false);

See Also
thisViewsheet.setActionVisible(name,Boolean), to show or hide Viewsheet
toolbar buttons.

ISACTIONVISIBLE(NAME)

Returns the visibility/accessibility of the specified end-user Crosstab
feature.

Parameters
name name of table function (String): 

'Export'
'Show Details' (Freehand Table)
'Sort Column' (column header 'Sort' button)

Example
if (Crosstab1.isActionVisible('Export')==true) {
Text1.text = 'Press toolbar button to export.';

}
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See Also
thisViewsheet.isActionVisible(name), to return Viewsheet toolbar button
visibility.

SUMMARYSIDEBYSIDE

Display multiple measures side-by-side rather than stacked vertically (the
default).

Type
Boolean true: place measures side-by-side

false: stack measures vertically (default)

Example
summarySideBySide = true

VS.4.1 Crosstab bindingInfo Property

This section presents functions related to the bindingInfo property of the
Crosstab. The bindingInfo property provides scripted access to the
binding, grouping, and aggregation settings available within the Crosstab
Editor (shown below). 

BINDINGINFO.ROWFIELDS

Specifies the data block fields to be used as crosstab row headers. This is
equivalent to adding fields into the ‘Row Headers’ region of the Crosstab
Editor.
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Type
array

Example
Crosstab1.query = 'Sales';
Crosstab1.bindingInfo.rowFields = ['Category','Name'];
Crosstab1.bindingInfo.colFields = ['Region','State'];
Crosstab1.bindingInfo.measureFields = ['Total','Quantity 
Purchased'];

See Also
query, to specify the data block from which the query displays data.

BINDINGINFO.COLFIELDS

Specifies the data block fields to be used as crosstab column headers. This
is equivalent to adding fields into the ‘Column Headers’ region of the
Crosstab Editor.
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Type
array

Example
Crosstab1.query = 'Sales';
Crosstab1.bindingInfo.rowFields = ['Category','Name'];
Crosstab1.bindingInfo.colFields = ['Region','State'];
Crosstab1.bindingInfo.measureFields = ['Total','Quantity 
Purchased'];

See Also
query, to specify the data block from which the query displays data.

BINDINGINFO.MEASUREFIELDS

Specifies the data block fields to be used as measures. This is equivalent to
adding fields into the ‘Measures’ region of the Crosstab Editor.
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Type
array

Example
Crosstab1.query = 'Sales';
Crosstab1.bindingInfo.rowFields = ['Category','Name'];
Crosstab1.bindingInfo.colFields = ['Region','State'];
Crosstab1.bindingInfo.measureFields = ['Total','Quantity 
Purchased'];

See Also
query, to specify the data block from which the query displays data.

BINDINGINFO.SETFORMULA(MEASURE1,FORMULA, [MEASURE2])

Sets the aggregation formula for one of the measures specified by
bindingInfo.measureFields. This is equivalent to setting the aggregation
method for a measure in the Crosstab Editor.



DATA MASHUP

841 of 1397

Parameters
measure1 String: Name of a measure to aggregate
formula A StyleConstant Object. See Summarization 
Formulas.
measure2 String: Name of the secondary measure for 
bivariate aggregation formulas (e.g., correlation)

Example
Crosstab1.query = 'Sales';
Crosstab1.bindingInfo.rowFields = ['Category','Name'];
Crosstab1.bindingInfo.colFields = ['Region','State'];
Crosstab1.bindingInfo.measureFields = ['Total','Quantity 
Purchased'];
Crosstab1.bindingInfo.setFormula('Quantity 
Purchased',StyleConstant.SUM_FORMULA);
Crosstab1.bindingInfo.setFormula('Total',StyleConstant.AVE
RAGE_FORMULA);

BINDINGINFO.GETFORMULA(MEASURE)

Returns the aggregation formula for one of the measures specified by
bindingInfo.measureFields or set as the aggregation method for a measure
in the Crosstab Editor.

Parameters
measure String: Name of a measure
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Return
String  Name of aggregation method

Example
if(Crosstab1.bindingInfo.getFormula('Quantity 
Purchased')=='Sum')
{
Crosstab2.bindingInfo.setFormula('Quantity 

Purchased',StyleConstant.SUM_FORMULA);
}

BINDINGINFO.SETPERCENTAGETYPE(MEASURE,PCT)

Sets the percentage representation for one of the measures specified by
bindingInfo.measureFields. This is equivalent to setting the percentage
representation for a measure in the Crosstab Editor.

Parameters
measure String: Name of a measure to show as percent
pct StyleConstant.PERCENTAGE_OF_GRANDTOTAL 

or 
StyleConstant.PERCENTAGE_NONE

Example
Crosstab1.query = 'Sales';
Crosstab1.bindingInfo.rowFields = ['Category','Name'];
Crosstab1.bindingInfo.colFields = ['Region','State'];
Crosstab1.bindingInfo.measureFields = ['Total','Quantity 
Purchased'];
Crosstab1.bindingInfo.setFormula('Total',StyleConstant.SUM
_FORMULA);
Crosstab1.bindingInfo.setFormula('Quantity 
Purchased',StyleConstant.SUM_FORMULA);
Crosstab1.bindingInfo.setPercentageType('Total',StyleConst
ant.PERCENTAGE_OF_GRANDTOTAL);
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BINDINGINFO.GETPERCENTAGETYPE(MEASURE)

Returns the percent setting (as a StyleConstant Object integer) for one of
the measures specified by bindingInfo.measureFields or set as the percent
representation for a measure in the Crosstab Editor.

Parameters
measure String: Name of a measure

Return
Integer

0: No percent representation
2: Percent of grand total

Example
if(Crosstab1.bindingInfo.getPercentageType('Total')==Style
Constant.PERCENTAGE_OF_GRANDTOTAL)
{
Crosstab2.bindingInfo.setPercentageType('Total',StyleCon

stant.PERCENTAGE_OF_GRANDTOTAL);
}

BINDINGINFO.PERCENTAGEMODE 

Specifies the direction (row or column) for percentage computation. This is
equivalent to selecting ‘Percentage By’ in the Crosstab Editor.
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Type
StyleConstant Object:
StyleConstant.PERCENTAGE_BY_COL or 
StyleConstant.PERCENTAGE_BY_ROW

Example
Crosstab1.query = 'Sales';
Crosstab1.bindingInfo.rowFields = ['Category','Name'];
Crosstab1.bindingInfo.colFields = ['Region','State'];
Crosstab1.bindingInfo.measureFields = ['Total','Quantity 
Purchased'];
Crosstab1.bindingInfo.setFormula('Total',StyleConstant.SUM
_FORMULA);
Crosstab1.bindingInfo.setFormula('Quantity 
Purchased',StyleConstant.SUM_FORMULA);
Crosstab1.bindingInfo.setPercentageType('Total',StyleConst
ant.PERCENTAGE_OF_GRANDTOTAL);
Crosstab1.bindingInfo.percentageMode = 
StyleConstant.PERCENTAGE_BY_COL;

BINDINGINFO.SHOWROWTOTAL 

Specifies whether a trailing row containing totals should be displayed. This
is equivalent to setting ‘Row Total’ in the Crosstab Editor.
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Type
Boolean true: show row total

false: hide row total

Example
Crosstab1.query = 'Sales';
Crosstab1.bindingInfo.rowFields = ['Category','Name'];
Crosstab1.bindingInfo.colFields = ['Region','State'];
Crosstab1.bindingInfo.measureFields = ['Total','Quantity 
Purchased'];
Crosstab1.bindingInfo.setFormula('Total',StyleConstant.SUM
_FORMULA);
Crosstab1.bindingInfo.setFormula('Quantity 
Purchased',StyleConstant.SUM_FORMULA);
Crosstab1.bindingInfo.showRowTotal = true

BINDINGINFO.SHOWCOLUMNTOTAL 

Specifies whether a trailing column containing totals should be displayed.
This is equivalent to setting ‘Column Total’ in the Crosstab Editor.

Type
Boolean true: show column total

false: hide column total

Example
Crosstab1.query = 'Sales'; 
Crosstab1.bindingInfo.rowFields = ['Category','Name'];
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Crosstab1.bindingInfo.colFields = ['Region','State'];
Crosstab1.bindingInfo.measureFields = ['Total','Quantity 
Purchased'];
Crosstab1.bindingInfo.setFormula('Total',StyleConstant.SUM
_FORMULA);
Crosstab1.bindingInfo.setFormula('Quantity 
Purchased',StyleConstant.SUM_FORMULA);
Crosstab1.bindingInfo.showColumnTotal = true

BINDINGINFO.SETCOLUMNORDER(SORT_FIELD,HEADER,METHOD,[MEA
SURE])

Sets the sorting order for row or column header. This is equivalent to
setting the sorting for a header in the Crosstab Editor. The measure
parameter is required only when a “by value” sort is requested.

Parameters
sort_field String: Name of a column to sort
header StyleConstant.ROW_HEADER or 
StyleConstant.COLUMN_HEADER
method One of the following sort methods:

StyleConstant.SORT_NONE
StyleConstant.SORT_ASC
StyleConstant.SORT_DESC
StyleConstant.SORT_VALUE_ASC
StyleConstant.SORT_VALUE_DESC

measure String: Formula for by-value sorting:
'Sum(column_name)'
'Average(column_name)' 
'Max(column_name)' 
'Min(column_name)' 
'Count(column_name)' 
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'Distinct Count(column_name)' 
'First(column_name1,column_name2)' 
'Last(column_name1,column_name2)' 
'Correlation(column_name1,column_name2)' 
'Covariance(column_name1,column_name2)' 
'Variance(column_name)' 
'Median(column_name)' 
'Mode(column_name)' 
'Std Deviation(column_name)' 
'Variance(Pop)(column_name)' 
'Std Deviation(Pop)(column_name)' 
'Weighted Average(column_name1,column_name2)' 

Example
Crosstab1.query = 'Sales';
Crosstab1.bindingInfo.rowFields = ['Name'];
Crosstab1.bindingInfo.colFields = ['Region'];
Crosstab1.bindingInfo.measureFields = ['Total'];
Crosstab1.bindingInfo.setFormula('Total', 
StyleConstant.SUM_FORMULA)
Crosstab1.bindingInfo.showColumnTotal = true;
Crosstab1.bindingInfo.setColumnOrder('Name',StyleConstant.
ROW_HEADER,StyleConstant.SORT_VALUE_DESC,'Sum(Total)');

BINDINGINFO.GETCOLUMNORDER(SORT_FIELD,HEADER)

Returns the sorting order for a row or column header (as a StyleConstant
Object integer) specified by
bindingInfo.setColumnOrder(sort_field,header,method,[measure]) or set
by the ‘Sort’ option in the Crosstab Editor.



DATA MASHUP

848 of 1397

Parameters
sort_field String: Name of a sorted column
header StyleConstant.ROW_HEADER or 
StyleConstant.COLUMN_HEADER

Returns
Integer
Example
if(Crosstab1.bindingInfo.getColumnOrder('Category',StyleCo
nstant.ROW_HEADER)==StyleConstant.SORT_VALUE_DESC)
{
Crosstab2.bindingInfo.setColumnOrder('Category',StyleCon

stant.ROW_HEADER,StyleConstant.SORT_VALUE_DESC,'Sum(Total)
';
}

BINDINGINFO.SETTOPN(FIELD,HEADER,NUMBER)

Sets the number of row or column groups to preserve in the ranking. This is
equivalent to setting the number of ranking groups in the Crosstab Editor. 

This function should always be used in conjunction with
bindingInfo.setTopNSummaryCol(field,header,measure) and
bindingInfo.setTopNReverse(field,header,boolean).

Parameters
field String: Name of a column to rank
header StyleConstant.ROW_HEADER or 
StyleConstant.COLUMN_HEADER
number Integer: Number of groups to select

Example
Crosstab1.query = 'Sales'; 
Crosstab1.bindingInfo.rowFields = ['Name']; 
Crosstab1.bindingInfo.colFields = ['Region']; 
Crosstab1.bindingInfo.measureFields = ['Total']; 
Crosstab1.bindingInfo.setFormula('Total', 
StyleConstant.SUM_FORMULA);
Crosstab1.bindingInfo.showColumnTotal = true;
Crosstab1.bindingInfo.setTopN('Name',StyleConstant.ROW_HEA
DER,3);
Crosstab1.bindingInfo.setTopNSummaryCol('Name',StyleConsta
nt.ROW_HEADER,'Sum(Total)');
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Crosstab1.bindingInfo.setTopNReverse('Name',StyleConstant.
ROW_HEADER,false);

BINDINGINFO.GETTOPN(FIELD,HEADER)

Returns the number of row or column groups in the ranking specified by
bindingInfo.setTopN(field,header,number) or set by the ‘Ranking’ option
in the Crosstab Editor. 

Parameters
field String: Name of a column to rank
header StyleConstant.ROW_HEADER or 
StyleConstant.COLUMN_HEADER

Returns
Integer Number of row or column groups

Example
var numGroups = 
Crosstab1.bindingInfo.getTopN('Name',StyleConstant.ROW_HEA
DER);
Text1.text = 'Displaying top ' + numGroups + ' groups.'

BINDINGINFO.SETTOPNSUMMARYCOL(FIELD,HEADER,MEASURE)

Sets the measure to use in ranking groups. This is equivalent to setting the
measure in the Crosstab Editor. 
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This function should always be used in conjunction with
bindingInfo.setTopN(field,header,number) and
bindingInfo.setTopNReverse(field,header,boolean).

Parameters
field String: Name of a column to rank
header StyleConstant.ROW_HEADER or 
StyleConstant.COLUMN_HEADER
measure String: Formula for ranking

'Sum(column_name)'
'Average(column_name)' 
'Max(column_name)' 
'Min(column_name)' 
'Count(column_name)' 
'Distinct Count(column_name)' 
'First(column_name1,column_name2)' 
'Last(column_name1,column_name2)' 
'Correlation(column_name1,column_name2)' 
'Covariance(column_name1,column_name2)' 
'Variance(column_name)' 
'Median(column_name)' 
'Mode(column_name)' 
'Std Deviation(column_name)' 
'Variance(Pop)(column_name)' 
'Std Deviation(Pop)(column_name)' 
'Weighted Average(column_name1,column_name2)' 

Example
Crosstab1.query = 'Sales'; 
Crosstab1.bindingInfo.rowFields = ['Name']; 
Crosstab1.bindingInfo.colFields = ['Region']; 
Crosstab1.bindingInfo.measureFields = ['Total']; 
Crosstab1.bindingInfo.setFormula('Total', 
StyleConstant.SUM_FORMULA);
Crosstab1.bindingInfo.showColumnTotal = true;
Crosstab1.bindingInfo.setTopN('Name',StyleConstant.ROW_HEA
DER,3);
Crosstab1.bindingInfo.setTopNSummaryCol('Name',StyleConsta
nt.ROW_HEADER,'Sum(Total)');
Crosstab1.bindingInfo.setTopNReverse('Name',StyleConstant.
ROW_HEADER,false);
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BINDINGINFO.GETTOPNSUMMARYCOL(FIELD,HEADER)

Returns the measure set for ranking by
bindingInfo.setTopNSummaryCol(field,header,measure) or in the Crosstab
Editor. 

Parameters
field String: Name of ranked column
header StyleConstant.ROW_HEADER or 
StyleConstant.COLUMN_HEADER

Return
String Formula used for ranking

Example
var formula = 
Crosstab1.bindingInfo.getTopNSummaryCol('Name',StyleConsta
nt.ROW_HEADER);
Text1.text = 'Ranking by ' + formula + '.'

BINDINGINFO.SETTOPNREVERSE(FIELD,HEADER,BOOLEAN)

Specifies whether groups are selected from the top or bottom of the ranking
according to the given measure. When true, this is equivalent to selecting
‘Bottom’ in the ‘Ranking’ menu in the Crosstab Editor. When false, this is
equivalent to selecting ‘Top’ in the ‘Ranking’ menu in the Crosstab Editor.
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This function should always be used in conjunction with
bindingInfo.setTopN(field,header,number) and
bindingInfo.getTopNSummaryCol(field,header).

Parameters
field String: Name of a column to rank
header StyleConstant.ROW_HEADER or 
StyleConstant.COLUMN_HEADER
boolean true for 'Bottom', false for 'Top'

Example
Crosstab1.query = 'Sales'; 
Crosstab1.bindingInfo.rowFields = ['Name']; 
Crosstab1.bindingInfo.colFields = ['Region']; 
Crosstab1.bindingInfo.measureFields = ['Total']; 
Crosstab1.bindingInfo.setFormula('Total', 
StyleConstant.SUM_FORMULA);
Crosstab1.bindingInfo.showColumnTotal = true;
Crosstab1.bindingInfo.setTopN('Name',StyleConstant.ROW_HEA
DER,3);
Crosstab1.bindingInfo.setTopNSummaryCol('Name',StyleConsta
nt.ROW_HEADER,'Sum(Total)');
Crosstab1.bindingInfo.setTopNReverse('Name',StyleConstant.
ROW_HEADER,false);

BINDINGINFO.ISTOPNREVERSE(FIELD,HEADER)

Returns the value (true or false) set by
bindingInfo.setTopNReverse(field,header,boolean) or in the Crosstab
Editor.
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Parameters
field String: Name of a column to rank
header StyleConstant.ROW_HEADER or 
StyleConstant.COLUMN_HEADER

Returns
boolean true: bottom groups selected

false: top groups selected

Example
var reverse = 
Crosstab1.bindingInfo.isTopNReverse('Name',StyleConstant.R
OW_HEADER);
if(reverse) {
Text1.text = 'Displaying bottom groups.';

}
else {
Text1.text = 'Displaying top groups.';

}

BINDINGINFO.SETGROUPOTHERS(FIELD,HEADER,BOOLEAN)

Specifies whether groups excluded from the ranking should be grouped as
‘Others’. When true, this is equivalent to checking ‘Group all others
together’ in the Crosstab Editor.

Parameters
field String: Name of a column to rank
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header StyleConstant.ROW_HEADER or 
StyleConstant.COLUMN_HEADER
boolean true: group others together

false: suppress others (default)

Example
Crosstab1.query = 'Sales'; 
Crosstab1.bindingInfo.rowFields = ['Name']; 
Crosstab1.bindingInfo.colFields = ['Region']; 
Crosstab1.bindingInfo.measureFields = ['Total']; 
Crosstab1.bindingInfo.setFormula('Total', 
StyleConstant.SUM_FORMULA);
Crosstab1.bindingInfo.showColumnTotal = true;
Crosstab1.bindingInfo.setTopN('Name',StyleConstant.ROW_HEA
DER,3);
Crosstab1.bindingInfo.setTopNSummaryCol('Name',StyleConsta
nt.ROW_HEADER,'Sum(Total)');
Crosstab1.bindingInfo.setTopNReverse('Name',StyleConstant.
ROW_HEADER,true);
Crosstab1.bindingInfo.setGroupOthers('Name',StyleConstant.
ROW_HEADER,true);

BINDINGINFO.ISGROUPOTHERS(FIELD,HEADER)

Returns the value (true or false) set by
bindingInfo.setGroupOthers(field,header,boolean) or by the Crosstab
Editor.

Parameters
field String: Name of ranked column
header StyleConstant.ROW_HEADER or 
StyleConstant.COLUMN_HEADER

Returns
boolean true: others are grouped together

false: others are not displayed
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Example
var others = 
Crosstab1.bindingInfo.isGroupOthers('Name',StyleConstant.R
OW_HEADER);
if(others) {
Text1.text = 'Others are grouped together.';

}
else {
Text1.text = 'Others are not displayed.';

}

BINDINGINFO.SETGROUPORDER(GROUP_FIELD,HEADER,LEVEL)

Sets the grouping level for a date-type field. This is equivalent to setting the
‘Level’ for a date-type field in the Crosstab Editor. 

Parameters
sort_field String: Name of a column to sort
header StyleConstant.ROW_HEADER or 
StyleConstant.COLUMN_HEADER
level StyleConstant object. See Date Grouping 
Levels.

Example
Crosstab1.query = 'Sales'; 
Crosstab1.bindingInfo.rowFields = ['Date']; 
Crosstab1.bindingInfo.colFields = ['Region']; 
Crosstab1.bindingInfo.measureFields = ['Total']; 
Crosstab1.bindingInfo.setFormula('Total', 
StyleConstant.SUM_FORMULA);
Crosstab1.bindingInfo.setGroupOrder('Date',StyleConstant.R
OW_HEADER,StyleConstant.QUARTER_OF_YEAR_DATE_GROUP);
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BINDINGINFO.GETGROUPORDER(GROUP_FIELD,HEADER)

Returns the date grouping level (as a StyleConstant Object integer)
specified by bindingInfo.setGroupOrder(group_field,header,level) or set
by the ‘Level’ option in the Crosstab Editor.

Parameters
group_field String: Name of a grouped date column
header StyleConstant.ROW_HEADER or 
StyleConstant.COLUMN_HEADER

Returns
Integer A StyleConstant Object integer.

Example
if(Crosstab1.bindingInfo.getGroupOrder('Date',StyleConstan
t.ROW_HEADER)==StyleConstant.QUARTER_OF_YEAR_DATE_GROUP)
{
Crosstab2.bindingInfo.setGroupOrder('Date',StyleConstant

.ROW_HEADER,StyleConstant.QUARTER_OF_YEAR_DATE_GROUP);
}

BINDINGINFO.SETGROUPTOTAL(FIELD,HEADER,BOOLEAN)

Specifies whether the subtotal for a given parent group should be
displayed. When true, this is equivalent to selecting ‘Show’ in the ‘Group
Total’ menu of the Crosstab Editor.
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Parameters
field String: Name of grouped column to total
header StyleConstant.ROW_HEADER or 
StyleConstant.COLUMN_HEADER
boolean true: display group total

false: suppress group total (default)

Example
Crosstab1.query = 'Sales'; 
Crosstab1.bindingInfo.rowFields = ['Region','State']; 
Crosstab1.bindingInfo.colFields = ['Category']; 
Crosstab1.bindingInfo.measureFields = ['Total']; 
Crosstab1.bindingInfo.setFormula('Total', 
StyleConstant.SUM_FORMULA);
Crosstab1.bindingInfo.setGroupTotal('Region',StyleConstant
.ROW_HEADER,true);

BINDINGINFO.GETGROUPTOTAL(FIELD, HEADER)

Returns true if the subtotal for the specified group is being displayed,
false otherwise. This property can be set by
bindingInfo.setGroupTotal(field,header,boolean) or in the Crosstab Editor.

Parameters
field String: Name of grouped column
header StyleConstant.ROW_HEADER or 
StyleConstant.COLUMN_HEADER
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Example
var showTotal = 
Crosstab1.bindingInfo.getGroupTotal('Region',StyleConstant
.ROW_HEADER);
if(showTotal) {
Text1.text = 'Subtotals are displayed for Region.';

}
 else {
Text1.text = 'Subtotals are not displayed.'; 

}

VS.5 Chart

This section presents Viewsheet-specific properties for Chart components.
See Chart Script Reference for details about properties available in both
Viewsheet and report Chart scripts.

See Also
Chart Script Tutorial, for examples of complex chart scripting.

DRILLENABLED

Specifies whether the automatic drill-down feature is enabled for the chart.
If disabled, the ‘+’ and ‘–’ drill operators do not appear on the chart axes.

Type
Boolean true = enabled, false = disabled

Example
Chart1.drillEnabled = false;

See Also
Drilling Down into a Chart, in Advanced Dashboard Design, for
information on using the drill-down feature.

FLYOVERVIEWS(ARR)

Specifies an array of component names, representing the components to be
filtered by chart flyover.

Parameters
arr array of component names (String) 

Example
Chart1.flyoverViews = ['TableView1','Gauge1'];

See Also
Flyover View, in Advanced Dashboard Design, to set flyover in the ‘Chart
Properties’ dialog box.
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FLYONCLICK

Specifies that components filtered by a chart flyover will be updated only
when the user clicks on the chart.

Type
Boolean true: update on mouse click

false: update on mouse hover (default)

Example
Chart1.flyOnClick = true;

See Also
Flyover View, in Advanced Dashboard Design, to set flyover in the ‘Chart
Properties’ dialog box.

TIPVIEW

Sets the data tip for the Chart. The data tip is a graphical form of tooltip
which uses an arbitrary Viewsheet component to adaptively display
summarized data when the user hovers the mouse over cells in the Chart.
See Data Tip View in Advanced Dashboard Design for more details.

Type
String name of a Viewsheet component

Example
Chart1.tipView='Gauge1';

See Also
Data Tip View, in Advanced Dashboard Design, to set the property without
using script.

SETACTIONVISIBLE(NAME,BOOLEAN)

Sets the visibility/accessibility of end-user Chart features. To disable a
feature, set the value to false.

Parameters
name name of chart function (String): 

'Brush'
'Clear Brushing'
'Edit'
'Maximize'
'Show Data'
'Show Details'
'Zoom'
'Exclude Data'
'Clear Zoom'
'Enable Manual Refresh'
'Enable Auto Refresh'
'Refresh'
'Properties' (right-click menu option)
'Format' (right-click menu option)
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'Save Image As' (right-click menu option)
'Annotate Component' (right-click menu 

option)
'Plot Properties' (right-click menu option)
'Axis Properties' (right-click menu option)
'Hide Axis' (right-click menu option)
'Title Properties' (right-click menu option)
'Hide Title' (right-click menu option)
'Group' (right-click menu option)
'Filter' (right-click menu option)
'Ungroup' (right-click menu option)
'Rename' (right-click menu option)
'Legend Properties' (right-click menu option)
'Hide Legend' (right-click menu option)
'Show All Titles' (right-click menu option)
'Show All Axes' (right-click menu option)
'Show Legend' (right-click menu option)

boolean false: hide the specified function
true: show the specified function

Example
Chart1.setActionVisible("Show Details", false);

See Also
thisViewsheet.setActionVisible(name,Boolean), to show or hide Viewsheet
toolbar buttons.

ISACTIONVISIBLE(NAME)

Returns the visibility/accessibility of the specified end-user Chart feature.

Parameters
name name of chart function (String): 

'Brush'
'Clear Brushing'
'Edit'
'Maximize'
'Show Data'
'Show Details'
'Zoom'
'Exclude Data'
'Clear Zoom'
'Enable Manual Refresh'
'Enable Auto Refresh'
'Refresh'
'Properties' (right-click menu option)
'Format' (right-click menu option)
'Save Image As' (right-click menu option)
'Annotate Component' (right-click menu 

option)
'Plot Properties' (right-click menu option)
'Axis Properties' (right-click menu option)
'Hide Axis' (right-click menu option)
'Title Properties' (right-click menu option)
'Hide Title' (right-click menu option)
'Group' (right-click menu option)
'Filter' (right-click menu option)
'Ungroup' (right-click menu option)
'Rename' (right-click menu option)
'Legend Properties' (right-click menu option)
'Hide Legend' (right-click menu option)
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'Show All Titles' (right-click menu option)
'Show All Axes' (right-click menu option)
'Show Legend' (right-click menu option)

Example
if (Chart1.isActionVisible('Edit')==true) {
Text1.text = 'Click the Edit button to open Chart 

Editor';
}

See Also
thisViewsheet.isActionVisible(name), to return Viewsheet toolbar button
visibility.

TOOLTIP

Specifies a tooltip to be displayed on chart elements. You can use
placeholders {0}, {1}, {2}, etc. to insert data values from the corresponding
fields into the tooltip text, and format the inserted data using
java.text.MessageFormat format. You may additionally use HTML
markup such as “<i>”, “<b>,” and “<br>” to format the tooltip contents.

Type
String The tooltip to display

Example
Chart1.toolTip = "<b>Company</b>: {0} <br><b>Total Sales</
b>: {1,number,$##,###.00}";

DATA

Two dimensional array containing the chart data. This array is readable and
writable.

Type
Two-dimensional array

Example
for (var i=1; i<data.length; i++) {
if (Chart1.data[i]['Name'] == 'Web Bridge') {
Chart1.data[i]['Sum(Quantity Purchased)'] = 0;
alert('Note: "Web Bridge" has been discontinued.'); 

}
}

To bind an unbound chart to a Data Block or cube in the Worksheet, use
the following syntax:

// Bind a Data Block:
Chart1.data="table_name";

// Bind a cube:
Chart1.data="cube::table_name";

http://download.oracle.com/javase/7/docs/api/index.html?java/text/MessageFormat.html
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See Also
Data, in Chart Script Reference, for information about working with chart
data.

HIGHLIGHTED(NAME)

Identifies whether a highlight with the specified name has been applied to
the chart (i.e., whether the highlight condition has been satisfied.).

Parameter
name name of the highlight

Example
if(Chart1.highlighted.lowSales) {
alert('lowSales highlight was applied')

}

See Also
Highlights, in Advanced Dashboard Design, for basic information on
highlights.

VS.6 Selection List and Tree

This section presents properties for Selection List and Selection Tree
components. The Selection Tree shares all of the properties of the Selection
List with the exception of singleSelection.

See Also
Selection List and Selection Tree, for more information about selection
elements.

QUERY

Specifies the data block to be used by the Selection Tree or Selection List
component. The available data blocks appear at the top of the Component
panel in Visual Composer.

Type
string
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Example
SelectionList1.query = 'SalesByDate';
SelectionList1.fields = ['State'];

See Also
Selection List Properties and Selection Tree Properties, for more
information.
fields, to specify the fields to display in the Selection List or Tree.

FIELDS

Specifies the field (Selection List) or fields (Selection Tree) of the data
block to be displayed by the Selection component. This is equivalent to
selecting fields under the Data tab of the component ‘Properties’ dialog
box.

Type
array

Example (Selection List)
SelectionList1.query = 'SalesByDate';
SelectionList1.fields = ['State'];

Example (Selection Tree)
SelectionTree1.query = 'SalesByDate';
SelectionTree1.fields = ['State','Company'];

See Also
query, to specify the data block from which to draw the fields.
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MEASURE

Specifies the measure field to be displayed by the Selection component.
This is equivalent to selecting a field from the ‘Measure’ menu under the
Data tab of the component ‘Properties’ dialog box.

Type
string

Example
SelectionList1.query = 'SalesByDate';
SelectionList1.fields = ['State'];
SelectionList1.measure ='Total'
SelectionList1.formula = StyleConstant.MAX_FORMULA;

FORMULA

Specifies the aggregation method for the measure displayed in the
Selection component. This is equivalent to selecting a method from the
‘Aggregate’ menu under the Data tab of the component ‘Properties’ dialog
box.
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Type
StyleConstant Object:
StyleConstant.COUNT_FORMULA 
StyleConstant.SUM_FORMULA
StyleConstant.MIN_FORMULA
StyleConstant.MAX_FORMULA
StyleConstant.NONE_FORMULA

Example
SelectionList1.query = 'SalesByDate';
SelectionList1.fields = ['State'];
SelectionList1.measure = 'Total'
SelectionList1.formula = StyleConstant.MAX_FORMULA;

SHOWTEXT

Specifies that the aggregated measure should be displayed as text. This is
equivalent to selecting ‘Text’ under the Data tab of the component
‘Properties’ dialog box.
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Type
Boolean true: show text

false: hide text

Example
SelectionList1.query = 'SalesByDate';
SelectionList1.fields = ['State'];
SelectionList1.measure = 'Total'
SelectionList1.formula = StyleConstant.MAX_FORMULA;
SelectionList1.showText = true;

SHOWBAR

Specifies that the aggregated measure should be displayed as a bar. This is
equivalent to selecting ‘Bar’ under the Data tab of the component
‘Properties’ dialog box.

Type
Boolean true: show bar

false: hide bar

Example
SelectionList1.query = 'SalesByDate';
SelectionList1.fields = ['State'];
SelectionList1.measure = 'Total'
SelectionList1.formula = StyleConstant.MAX_FORMULA;
SelectionList1.showBar = true;

DRILLMEMBER

Returns the name of the field one level below the deepest level in the
hierarchy at which the user has made a selection in a Selection Tree. For
example, consider a three-level Selection Tree hierarchy: ‘Region’ >
‘State’ > ‘City’. 



DATA MASHUP

867 of 1397

If the user’s most specific selection is at the level of region, then
drillMember returns 'State'. If the user’s most specific selection is at the
level of state, then drillMember returns 'City'. If the user’s most specific
selection is at the level of city, then because there is no lower level
drillMember again returns 'City'. If the user has not selected any values in
the Selection Tree, then drillMember returns the highest level, here
'Region'.

Type
String field name for child of deepest selected level

Example
var drillField = SelectionTree1.drillMember;

The drillMember property is useful for creating interactive chart
drilldowns. It does not apply to Selection Lists.

See Also
Walkthrough: Interactive Chart Drilldown, for an example usage.
Selection Tree Properties for more information.

DRILLMEMBERS

The drillMembers
property does not
apply to Selection
Lists.

Returns an array of the levels at which the user has made a selection. The
array includes all levels from the top level to one level below the current
selection. (The top level is included even when no selection is made.) For
example, consider a three-level Selection Tree hierarchy: ‘Region’ >
‘State’ > ‘City’.

If the user makes a selection at the level of region, drillMembers returns the
array ['Region','State']. If the user makes a selection at the level of state
or city, drillMembers returns the array ['Region','State','City']. This
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array is useful for displaying multiple geographical levels on a map, as
shown in the example below.

Type
Array array of field names for selected levels

Example
Follow the steps below to create a dynamic multi-level map drill:

This Worksheet can
be found in the ‘Sales’
folder, or in the
‘Orders’ data set
folder in Agile Edi-
tion.

1. Create a new Viewsheet based on the ‘Sales Explore’ Worksheet.

For information on how to create a new Viewsheet, see Creating a
New Dashboard in the User Portal (Style Scope or Style
Intelligence) or Creating a New Dashboard (Style Scope Agile
Edition).

2. From the Component panel, drag a Chart component into the
Viewsheet grid. Resize the Chart as desired.

3. From the Component panel, drag a Selection Tree component into
the Viewsheet grid.

4. Add a two-level geographical hierarchy to the Selection Tree.
Follow the steps below:

a. Expand the ‘Sales’ data block in the Component panel.

b. Drag the ‘State’ field from the data block onto the Selection
Tree. This adds the ‘State’ values to the tree.

c. Drag the ‘City’ field from the data block onto the Selection
Tree. This adds the ‘City’ values to the tree.

d. Resize the Selection Tree so that it can display a reasonable
number of options.

5. Press the ‘Edit’ button on the Chart to open the Chart Editor.
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6. Press the ‘Select Chart Style’ button in the Data panel, and choose
the ‘Map’ chart type.

7. In the Data Source panel, right click on the ‘State’ field, and select
‘Set Geographic’.

8. In the Data Source panel, right click on the ‘City’ field, and select
‘Set Geographic’. 

The red question mark
indicates that not all
cities in the ‘City’
field of this example
have mappings. 

9. In the pop-up panel, press the green ‘Apply’ button.

10. From the Data Source panel of the Chart Editor, drag the ‘Total’
measure to the ‘Color’ region in the Visual panel.

11. From the Data Source panel of the Chart Editor, drag the ‘State’
dimension to the ‘Geographic’ region in the Data panel.

12. Configure the chart to adapt the geographical level based on the
user’s selection in the Selection Tree. To do this, follow the steps
below:

a. Press the “arrow” button next to the ‘State’ dimension in the
Data panel. In the pop-up menu, select the ‘Expression’ option.

b. Press the ‘Edit’ button to open the Script Editor.
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c. In the top-left panel of the Script Editor, expand the
‘SelectionTree1’ node, and click ‘drillMembers’ (with a final
‘s’). This adds the SelectionTree1.drillMembers property in
the editing area.

If the user makes no selection in the Selection Tree, the
drillMembers property returns the array ['State'], which
displays the ‘Total’ measure on a state-basis. If the user selects
one or more states or cities in the Selection Tree, drillMembers
returns the array ['State','City'], which displays the ‘Total’
measure on a city-basis.

d. Press ‘OK’ to close the Script Editor. The output of
SelectionTree1.drillMembers is now assigned to the chart
Geographical binding.

13. Verify that the map adapts to the user’s selections:
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a. Press the ‘Clear Selection’ button in the Selection Tree to
remove any existing selections. Observe that the map represents
the measure on a state level, the top level of the Selection Tree
hierarchy.

b. Select the ‘CA’ option in the Selection Tree. Observe that the
Selection Tree filters the map to display only data from
California. In addition, drillMembers property changes the
geographical binding to represent the ‘City’ dimension, and the
measure is now displayed at the city-level. 

To automatically zoom a map to display only the regions that the user
selects, see the example for Coordinate.setFullMap(boolean).

See Also
drillMember, to create a dynamic drilldown for a single geographical level.
Walkthrough: Interactive Chart Drilldown, for an example usage.
Selection List Properties and Selection Tree Properties, for more
information.

DROPDOWN

Sets the Selection List to dropdown style, in which the Selection List is
compactly represented by just its title bar. When the user moves the mouse
over the List, The List automatically expands to display the available
options.
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Type
Boolean true: show compact title-bar only display

false: show normal List display (default)

Example
SelectionList1.dropdown = true;

See Also
Selection List Properties and Selection Tree Properties, for more
information.

SETACTIONVISIBLE(NAME,BOOLEAN)

Sets the visibility/accessibility of end-user Selection List or Selection Tree
features. To disable a feature, set the value to false.

Parameters
name name of toolbar button (String): 

'Search'
'Apply'
'Clear Selection', 
'Reverse Selection'
'Sort Selection'
'Show' (in Selection Container)
'Hide' (in Selection Container)
'Remove' (right-click menu item in Selection 

Container)
'Select Subtree' (right-click menu item)
'Clear Subtree' (right-click menu item)

boolean false: hide the specified function
true: show the specified function

Example
Selection1.setActionVisible("Reverse Selection", false);

See Also
thisViewsheet.setActionVisible(name,Boolean), to show or hide Viewsheet
toolbar buttons.

ISACTIONVISIBLE(NAME)

Returns the visibility/accessibility of the specified end-user Selection List
or Selection Tree feature.

Parameters
name name of toolbar button (String): 

'Search'
'Apply'
'Clear Selection', 
'Reverse Selection'
'Sort Selection'
'Show' (in Selection Container)
'Hide' (in Selection Container
'Remove' (right-click menu item in Selection 

Container)
'Select Subtree' (right-click menu item)
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'Clear Subtree' (right-click menu item)

Example
if (Selection1.isActionVisible('Apply')==true) {
Text1.text = 'Press the Apply button to submit';

}

See Also
thisViewsheet.isActionVisible(name), to return Viewsheet toolbar button
visibility.

SINGLESELECTION

Specifies that only a single choice can be selected in a Selection List. This
property does not apply to Selection Trees. 

Type
Boolean true: select only one item

false: select one or more items (default)

Example
SelectionList1.singleSelection = true

See Also
Selection List Properties for more information.

SORTTYPE

Specifies the sort order for the Selection List or Tree. You can list choices
in ascending (alphabetical) order, in descending (reverse alphabetical)
order, or display only compatible choices. This last option (the default)
hides incompatible choices, but allows a user to display them if desired.

Type
Integer order of items in Selection List:

StyleConstant.SORT_ASC: Ascending order
StyleConstant.SORT_DESC: Descending order
StyleConstant.SORT_HIDE_OTHERS: 
Hide incompatible choices

Example
SelectionList1.sortType = StyleConstant.SORT_ASC;

See Also
Selection List Properties and Selection Tree Properties, for more
information.

SUBMITONCHANGE

Specifies that user selections should be submitted immediately to the server
and the Viewsheet refreshed with updated data (default). When this feature
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is disabled, user selections are not submitted until the user explicitly click
the green ‘Apply’ button.

Type
Boolean true: submit user selections immediately 

false: submit user selection on 'Apply'

Example
SelectionList1.submitOnChange = false;

See Also
Selection List Properties and Selection Tree Properties, for more
information.

VS.7 Selection Container

This section discusses the properties that are unique to the Selection
Container.

See Also
Common Properties, for properties shared with other components.
Selection Container, for more information about Selection Containers.

ADHOCENABLED

Determines whether end users can add new selection fields (from the Chart
Editor) to the Selection Container.

Type
Boolean true: allow users to add new selections

false: prevent users from adding selections

Example
CurrentSelection1.adhocEnabled = false;

See Also
Selection Container Properties, for more information on user selection
editing.

SETACTIONVISIBLE(NAME,BOOLEAN)

Sets the visibility/accessibility of end-user features. To disable a feature, set
the value to false.

Parameters
name name of toolbar button (String): 

'Clear All Selection' 
boolean false: hide the specified function

true: show the specified function
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Example
SelectionContainer1.setActionVisible("Clear All Selection", 
false);

See Also
thisViewsheet.setActionVisible(name,Boolean), to show or hide Viewsheet
toolbar buttons.

ISACTIONVISIBLE(NAME)

Returns the visibility/accessibility of the specified end-user feature.

Parameters
name name of toolbar button (String): 

'Clear All Selection' 

Example
if (SelectionContainer1.isActionVisible('Clear All 
Selection')==true) {
Text1.text = 'Press the Clear button to clear all 

filters';
}

See Also
thisViewsheet.isActionVisible(name), to return Viewsheet toolbar button
visibility.

SHOWCURRENTSELECTION

Specifies whether the Selection Container displays the current state of all
Viewsheet selection components.

Type
Boolean true: display all current selections

false: do not display current selections

Example
CurrentSelection1.showCurrentSelection = false;

See Also
Selection Container Properties, for more information on user selection
editing.

VS.8 Range Slider

This section discusses the properties that are unique to the Range Slider.

See Also
Common Properties, for properties shared with other components.
Range Slider, for more information about Range Sliders.
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QUERY

Specifies the data block to be used by the Range Slider component. The
available data blocks appear at the top of the Component panel in Visual
Composer.

Type
string

Example
RangeSlider1.query = 'Sales';
RangeSlider1.fields = ['Date'];
RangeSlider1.composite = false;
RangeSlider1.rangeType = StyleConstant.DATE;

See Also
fields, to specify the fields to display in the Range Slider.

FIELDS

Specifies the field (for single value) or fields (for composite value) of the
data block to be displayed by the Range Slider component. This is
equivalent to selecting fields under the Data tab of the component
‘Properties’ dialog box.
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Type
array

Example 1
RangeSlider1.composite = false;
RangeSlider1.query = 'Sales';
RangeSlider1.fields = ['Date'];
RangeSlider1.rangeType = StyleConstant.DATE;

Example 2
RangeSlider1.composite = true;
RangeSlider1.query = 'Sales';
RangeSlider1.fields = ['Region','Category'];
RangeSlider1.rangeType = StyleConstant.STRING;

See Also
query, to specify the data block from which to draw the fields.

COMPOSITE

Specifies wether the Range Slider displays a single value or composite
value. This is equivalent to selecting ‘Single Value’ or ‘Composite Value’
in the Data tab of the component ‘Properties’ dialog box.
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Type
boolean

Example
RangeSlider1.query = 'Sales';
RangeSlider1.fields = ['Region','Category'];
RangeSlider1.composite = true;
RangeSlider1.rangeType = StyleConstant.STRING;

RANGETYPE

Specifies the display mode for the Range Slider. This is equivalent to
selecting a data type in the ‘Options’ panel of the Advanced tab in the
‘Properties’ dialog box.

Type
StyleConstant Object:
StyleConstant.STRING
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StyleConstant.NUMBER
StyleConstant.YEAR
StyleConstant.MONTH
StyleConstant.MEMBER // (for cubes)
StyleConstant.DAY
StyleConstant.HOUR
StyleConstant.MINUTE
StyleConstant.HOUR_OF_DAY
StyleConstant.MINUTE_OF_DAY

Example (Composite Value)
RangeSlider1.composite = true;
RangeSlider1.query = 'Sales';
RangeSlider1.fields = ['Region','Category'];
RangeSlider1.rangeType = StyleConstant.STRING;

Example (Single Value)
RangeSlider1.composite = false;
RangeSlider1.query = 'Sales';
RangeSlider1.fields = ['Date'];
RangeSlider1.rangeType = StyleConstant.MONTH;

CURRENTVISIBLE

Specifies that the value currently selected on the Range Slider is
numerically displayed at all times. Otherwise, the current value is only
numerically displayed while the user is actively dragging the slider. 

Type
Boolean true: display currently selected value

false: hide currently selected value

Example
RangeSlider1.currentVisible = false;

See Also
Range Slider Properties, for more information on user selection editing.

LENGTH

Specifies the initial slider range. For a numerical field, this gives the range
as a multiple of the minimum length rangeSize. For example, if length is 3
and rangeSize is 100, the initial slider range is 300. For a date field, the
units are specified by the rangeType setting (year, month, or day). In either
case, the user can subsequently readjust the range as desired.

Type
Number Slider size, as multiple of minimum length

Example
RangeSlider1.length = 3;

See Also
Range Slider Properties, for more information on user selection editing.
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RANGESIZE

Specifies the minimum slider range for a numerical field, the smallest
interval that the user is able to select when interactively adjusting the range. 

Type
Number Minimum slider range

Example
RangeSlider1.rangeSize = 1000;

See Also
Range Slider Properties, for more information on user selection editing.

MAXRANGESIZE

Specifies the maximum slider range, the largest interval that the user is able
to select when interactively adjusting the range. The units are the same as
those of the length property. 

Type
Number Maximum slider range

Example
RangeSlider1.maxRangeSize = 10;

See Also
Range Slider Properties, for more information on user selection editing.

MAX

Specifies the maximum slider value. If ‘Single Value’ is selected under the
Data tab of the ‘Range Slider Properties’ dialog box, the max value is a
single number or date (as appropriate for the data represented on the
Slider). If ‘Composite Value’ is selected under the Data tab, the max value
is an array.

Type
Number, Date, or Array

Examples
RangeSlider1.max = 10; // number
RangeSlider1.max = new Date("December 31, 2009"); // date
RangeSlider1.max = ["NJ", "Piscataway"]; // composite array

See Also
Range Slider Properties, for more information on user selection editing.
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MIN

Specifies the minimum slider value. If ‘Single Value’ is selected under the
Data tab of the ‘Range Slider Properties’ dialog box, the min value is a
single number or date (as appropriate for the data represented on the
Slider). If ‘Composite Value’ is selected under the Data tab, the min value
is an array.

Type
Number, Date, or Array

Examples
RangeSlider1.min = 10; // number
RangeSlider1.min = new Date("December 31, 2009"); // date
RangeSlider1.min = ["NJ", "Piscataway"]; // composite array

See Also
Range Slider Properties, for more information on user selection editing.

LOGSCALE

Specifies that the slider for a numerical field should use a logarithmic scale.
The base of the log is determined automatically.

Type
Boolean true: Use log scale

false: Use linear scale (default)

Example
RangeSlider1.logScale = true;

See Also
Range Slider Properties, for more information on user selection editing.

MAXVISIBLE

Specifies whether the slider’s maximum value is displayed.

Type
Boolean true: Display maximum (default)

false: Hide maximum

Example
RangeSlider1.maxVisible = false;

See Also
Range Slider Properties, for more information on user selection editing.

MINVISIBLE

Specifies whether the slider’s minimum value is displayed.
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Type
Boolean true: Display minimum (default)

false: Hide minimum

Example
RangeSlider1.minVisible = false;

See Also
Range Slider Properties, for more information on user selection editing.

SETACTIONVISIBLE(NAME,BOOLEAN)

Sets the visibility/accessibility of end-user features. To disable a feature, set
the value to false.

Parameters
name name of feature (String): 

'Clear Selection' 
'Show' (in Selection Container)
'Hide' (in Selection Container)
'Remove' (right-click menu item in Selection 

Container)
'Properties' (right-click menu item)
'Edit' (right-click menu item for numerical 

Range Slider)
boolean false: hide the specified function

true: show the specified function

Example
RangeSlider1.setActionVisible("Clear Selection", false);

See Also
thisViewsheet.setActionVisible(name,Boolean), to show or hide Viewsheet
toolbar buttons.

ISACTIONVISIBLE(NAME)

Returns the visibility/accessibility of the specified end-user feature.

Parameters
name name of feature (String): 

'Clear Selection' 
'Show' (in Selection Container)
'Hide' (in Selection Container)
'Remove' (right-click menu item in Selection 

Container)
'Properties' (right-click menu item)
'Edit' (right-click menu item for numerical 

Range Slider)

Example
if (RangeSlider1.isActionVisible('Clear Selection')==true) 
{
Text1.text = 'Press the Clear button to clear filter';

}
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See Also
thisViewsheet.isActionVisible(name), to return Viewsheet toolbar button
visibility.

TICKVISIBLE

Specifies whether tick marks are displayed on the slider scale.

Type
Boolean true: Display tick marks (default)

false: Hide tick marks

Example
RangeSlider1.tickVisible = false;

See Also
Range Slider Properties, for more information on user selection editing.

UPPERINCLUSIVE

Specifies whether the upper limit of the selection is included in the result
set. For example, if the upper limit of the Range Slider selection is 15, a
setting of upperInclusive=true (default) includes the value 15 in the result
set.

A setting of upperInclusive=false in this case excludes the value 15 from
the result set. 

Note that the range display on the slider reflects the status of the
upperInclusive property.

Type
Boolean true: Include upper limit in selection 
(default)

false: Exclude upper limit from selection

Example
RangeSlider1.upperInclusive=false;

See Also
Range Slider Properties, for more information on user selection editing.
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VS.9 Calendar

This section discusses the properties that are unique to the Calendar
component.

See Also
Common Properties, for properties shared with other components.
Calendar, for more information about Calendars.

QUERY

Specifies the data block to be used by the Calendar component. The
available data blocks appear at the top of the Component panel in Visual
Composer.

Type
string

Example
Calendar1.query = 'Sales';
Calendar1.fields = ['Date'];

See Also
fields, to specify the fields to display in the Calendar.

FIELDS

Specifies the field of the data block to be filtered by the Calendar
component. This is equivalent to selecting the field under the Data tab of
the component ‘Properties’ dialog box.



DATA MASHUP

885 of 1397

Type
array

Example
Calendar1.query = 'Sales';
Calendar1.fields = ['Date'];

See Also
query, to specify the data block from which to draw the fields.

DAYSELECTION

Specifies that the user can select individual days of the week (when the
Calendar is in ‘Monthly’ view mode). Otherwise, the user must select the
week in its entirety.

Type
Boolean true: enable individual day selection

false: disable day selection (default)

Example
RangeSlider1.daySelection = true;

See Also
Calendar Properties, for more information on user selection editing.

DOUBLECALENDAR

Specifies the calendar view type. The single-panel view shows one month
or one year (depending on yearView setting), while the double-panel view
shows two months or two years (depending on yearView setting).

Type
Boolean true: double-panel calendar

false: one-panel calendar
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Example
Calendar1.doubleCalendar = true;

See Also
Calendar Properties, for more information on user selection editing.

DROPDOWN

Specifies a collapsible style for the calendar.

Type
Boolean true: collapse calendar when not in use

false: do not collapse calendar (default)

Example
Calendar1.dropdown=true;

See Also
Calendar Properties, for more information on user selection editing.

PERIOD

Specifies whether the two panels of a Calendar in doubleCalendar mode
represent a period comparison or a simple date range.

Type
Boolean true: display date comparison

false: disable date range (default)

Example
Calendar1.period = true;

See Also
Calendar Properties, for more information on user selection editing.

YEARVIEW

Specifies whether the Calendar should be displayed in “year view” or
“month view”. Year view displays one or two years (depending on
doubleCalendar setting) and allows selections at the month level. Month
view displays one or two months (depending on doubleCalendar setting)
and allows selections at the week or day level (depending on daySelection
setting).

Type
Boolean true: display year view

false: disable month view (default)

Example
Calendar1.yearView=true;
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See Also
Calendar Properties, for more information on user selection editing.

SETACTIONVISIBLE(NAME,BOOLEAN)

Sets the visibility/accessibility of end-user features. To disable a feature, set
the value to false.

Parameters
name name of toolbar button (String): 

'Switch To Year View'
'Switch To Month View'
'Switch To Range/Comparison'
'Switch To Simple View'
'Switch To Comparison Mode'
'Switch To Date Range Mode’
'Clear Calendar'
'Apply'

boolean false: hide the specified function
true: show the specified function

Example
Calendar1.setActionVisible("Switch To Year View", false);

See Also
thisViewsheet.setActionVisible(name,Boolean), to show or hide Viewsheet
toolbar buttons.

ISACTIONVISIBLE(NAME)

Returns the visibility/accessibility of the specified end-user feature.

Parameters
name name of feature (String): 

'Switch To Year View'
'Switch To Month View'
'Switch To Range/Comparison'
'Switch To Simple View'
'Switch To Comparison Mode'
'Switch To Date Range Mode’
'Clear Calendar'
'Apply'

Example
if (Calendar1.isActionVisible('Apply')==true) {
Text1.text = 'Press the Apply button to apply filter';

}

See Also
thisViewsheet.isActionVisible(name), to return Viewsheet toolbar button
visibility.
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SINGLESELECTION

Prevents the user from selecting multiple date units on the Calendar. (This property is
not supported for Viewsheets displayed using HTML, such as those on iPad.).

Type
Boolean true: enable single selection

false: disable single selection (default)

Example
Calendar1.singleSelection=true;

See Also
Calendar Properties, for more information on user selection editing.

VS.10 Text
Note: Script placed on a Text element does not re-execute when the
user makes Viewsheet selections. To re-execute the script, place
the script in the onRefresh Handler.

This section discusses the properties that are unique to the Text component.

See Also
Common Properties, for properties shared with other components.
Text, for more information about the Text component.

QUERY

Specifies the data block to be used by the Text component. The available
data blocks appear at the top of the Component panel in Visual Composer.

Type
string

Example
Text1.query = 'Sales';
Text1.fields = ['Total'];
Text1.formula = StyleConstant.AVERAGE_FORMULA;

See Also
fields, to specify the fields to display in the Text element.
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FIELDS

Specifies the field of the data block to be displayed by the Text component.
This is equivalent to selecting fields under the Data tab of the component
‘Properties’ dialog box.

When you use a bivariate aggregation method (e.g., correlation), the fields
array should contain two field names. Otherwise, the array should contain
just a single field name.

Type
array

Example 1
Text1.query = 'Sales';
Text1.fields = ['Total'];
Text1.formula = StyleConstant.AVERAGE_FORMULA;

Example 2
Text1.query = 'Sales';
Text1.fields = ['Total','Quantity Purchased'];
Text1.formula = StyleConstant.CORRELATION_FORMULA;

See Also
query, to specify the data block from which to draw the fields.

FORMULA

Specifies the aggregation method for the measure displayed in the Text
component. This is equivalent to selecting a method from the ‘Aggregate’
menu under the Data tab of the component ‘Properties’ dialog box.
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Type
A StyleConstant Object. See Summarization Formulas.

Example
Text1.query='Sales';
Text1.fields=['Total'];
Text1.formula = StyleConstant.AVERAGE_FORMULA;

HYPERLINK

Specifies a hyperlink to a report, Viewsheet, or URL.

Type
String, or inetsoft.report.Hyperlink

Example
Text1.hyperlink = "Tutorial/Interactive";

See Also
Text Properties, for general information about the Text component.
Hyperlinks, in Advanced Dashboard Design, for basic information on
hyperlinks.

SHADOW

Adds a drop shadow to the component. (Drop shadow for a Text component is not
preserved on export.).

Type
Boolean true: add drop shadow

false: no drop shadow

Example
Text1.shadow = true;
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See Also
Text Properties, for general information about the Text component.

TEXT

Specifies the text contents of the Text component.

Type
String

Example
Text1.text = "Hello World";

See Also
Text Properties, for general information about the Text component.

VALUE

Specifies the contents displayed by the Text component in cases when the
component is bound to a data field (i.e., displaying an aggregate). If the
Text component is not bound to a data field, the value property is
undefined.

Type
Number

Example
if (Text1.value > 10000) {
Text1.value = 'Maximum exceeded';

}

See Also
Text Properties, for general information about the Text component.

VS.11 Image

This section discusses the properties that are unique to the Image
component.

See Also
Common Properties, for properties shared with other components.
Image, for more information about the Image component.

HYPERLINK

Specifies a hyperlink to a report, Viewsheet, or URL.

Type
String, or inetsoft.report.Hyperlink

Example
Image1.hyperlink = "Tutorial/Interactive";
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See Also
Image Properties, for general information about the Image component.
Hyperlinks, in Advanced Dashboard Design, for basic information on
hyperlinks.

IMAGE

Specifies an image file either by an uploaded image name (e.g.,
'image1.gif') a resource path on the server (e.g., '/library/image1.gif'),
a URL (e.g., “http://www.google.com/images/logos/ps_logo2.png”), or a
BLOB stored in a data block. See Image Properties for information on
uploading images.

Type
String name of image (e.g., '/myImage.jpg')

Example
Image1.image = '/library/image1.gif';

See Also
Changing Images with Script, for an approach to dynamically changing
images.
getImage(string), for another approach to dynamically changing images.
Image Properties, for more information on images.

MAINTAINASPECTRATIO

When scaleImage is enabled, maintainAspectRatio specifies that the
overall proportions of the image are maintained during scaling. When
disabled, the image will scale to the dimensions of the component
boundary using the 9-cell method (see scale9).

Type
Boolean true: keep proportions constant

false: allow image fill component boundary

Example
Image1.maintainAspectRatio = false;

See Also
Scaling an Image, for more information on aspect ratio.
Image Properties, for more information on images.

SCALE9

When scaleImage is enabled and maintainAspectRatio is disabled, scale9
specifies the number of pixels on each image boundary that should be left
unscaled, in the order [top left bottom right]. This permits you to scale
only the interior of an image, leaving edge treatments unmodified.
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Type
Array Pixels: [top left bottom right]

Example
Image1.scaleImage = true;
Image1.maintainAspectRatio = false;
Image1.scale9 = [3,2,4,4];

See Also
Image Properties, for more information on images.
Scaling an Image, for more information on 9-cell scaling.

SCALEIMAGE

Specifies that the image should be scaled to the Image component
dimensions. Scaling can be set to either preserve the image proportions
(maintainAspectRatio, default) or to resize just a selected portion of the
image (scale9).

Type
Boolean true: scale image to container

false: keep original image size

Example
Image1.scaleImage = true;

Note that the scaleImage and tile properties are mutually exclusive.

See Also
Image Properties, for more information on images.

SHADOW

Adds a drop shadow to the component. 

Type
Boolean true: add drop shadow

false: no drop shadow

Example
Image1.shadow = true;

See Also
Image Properties, for more information on images.

TILE

Specifies that the image should be repeated (tiled) vertically and
horizontally to fill the component boundaries. 

Type
Boolean true: tile the image
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false: do not tile

Example
Image1.tile = true;

Note that the tile and scaleImage properties are mutually exclusive.

See Also
Image Properties, for more information on images.

VS.12 Gauge

This section discusses the properties that are unique to the Gauge
component.

See Also
Common Properties, for properties shared with other components.
Gauge, for more information about Gauge components.

QUERY

Specifies the data block to be used by the Gauge component. The available
data blocks appear at the top of the Component panel in Visual Composer.

Type
string

Example
Gauge1.query = 'Sales';
Gauge1.fields = ['Total'];
Gauge1.formula = StyleConstant.AVERAGE_FORMULA;

See Also
fields, to specify the fields to display in the Gauge element.

FIELDS

Specifies the field of the data block to be displayed by the Gauge
component. This is equivalent to selecting fields under the Data tab of the
component ‘Properties’ dialog box.
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When you use a bivariate aggregation method (e.g., correlation), the fields
array should contain two field names. Otherwise, the array should contain
just a single field name.

Type
array

Example 1
Gauge1.query = 'Sales';
Gauge1.fields = ['Total'];
Gauge1.formula = StyleConstant.AVERAGE_FORMULA;

Example 2
Gauge1.query = 'Sales';
Gauge1.fields = ['Total','Quantity Purchased'];
Gauge1.formula = StyleConstant.CORRELATION_FORMULA;

See Also
query, to specify the data block from which to draw the fields.

FORMULA

Specifies the aggregation method for the measure displayed in the Gauge
component. This is equivalent to selecting a method from the ‘Aggregate’
menu under the Data tab of the component ‘Properties’ dialog box.
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Type
A StyleConstant Object. See Summarization Formulas.

Example
Gauge1.query = 'Sales';
Gauge1.fields = ['Total'];
Gauge1.formula = StyleConstant.AVERAGE_FORMULA;

HYPERLINK

Specifies a hyperlink to a report, Viewsheet, or URL.

Type
String, or inetsoft.report.Hyperlink

Example
Gauge1.hyperlink = "Tutorial/Interactive";

See Also
Gauge Properties, for general information about output components.
Hyperlinks, in Advanced Dashboard Design, for basic information on
hyperlinks.

LABELVISIBLE

Specifies whether the Gauge displays a digital representation of the current
reading. (This applies only to Gauge faces that support a digital display.)

Type
Boolean true: display digital measure (default)

false: hide digital display
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Example
Gauge1.labelVisible = false;

See Also
Gauge Properties, for more information on Gauges.

MAJORINC

Note: Increments that are too large or too small may result in
undesirable Gauge appearance.

Specifies the interval between display of labels on the Gauge. For example,
a value of 15 indicates that the gauge labels should be placed at positions of
0, 15, 30, 45, etc. The majorInc value should be larger than the minorInc
value

Type
Number Spacing between Gauge labels

Example
Gauge1.majorInc = 1000;

See Also
Gauge Properties, for more information on Gauges.

MAX

The value of the largest label displayed on the Gauge face.

Type
Number Value of highest gauge label

Example
Gauge1.max = 16000;

See Also
Gauge Properties, for more information on Gauges.

MIN

The value of the smallest label displayed on the Gauge face.

Type
Number Value of lowest gauge label

Example
Gauge1.min = -15;

See Also
Gauge Properties, for more information on Gauges.
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MINORINC

Note: Increments that are too large or too small may result in
undesirable Gauge appearance.

Specifies the interval between minor ticks on the Gauge. For example, a
value of 15 indicates that tick marks should be placed at positions of 0, 15,
30, 45, etc. The minorInc value should be smaller than the majorInc value.

Type
Number Spacing between minor tick marks

Example
Gauge1.minorInc = 100;

See Also
Gauge Properties, for more information on Gauges.

RANGECOLORS

Specifies an array of one to three colors to be used for the Gauge ranges
(color zones). The positions of the colors on the Gauge are determined by
the ranges array. Colors can be specified by any of the methods shown for
the background property.

Type
Array of colors See background for color syntax

Example
Gauge1.rangeColors = ['green','yellow','red'];
Gauge1.ranges = [5,10,15];

See Also
Gauge Properties, for more information on Gauges.

RANGEGRADIENT

Specifies smooth blending for range color boundaries. If disabled, the color
boundaries are sharp and well-defined.

Type
Boolean true: blend colors at boundaries (default)

false: do not blend colors

Example
Gauge1.rangeColors = ['green','yellow','red'];
Gauge1.ranges = [5,10,15]
Gauge1.rangeGradient = false;

See Also
Gauge Properties, for more information on Gauges.
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RANGES

Specifies an array of one to three values defining the upper boundaries of
the Gauge ranges (color zones). The colors corresponding to these
boundaries are determined by the rangeColors array. To use the max
Gauge value as the boundary for a range, simply omit the boundary value
for the desired range.

Type
Array Upper range boundaries

Example
// Omit 'red' boundary value to automatically use Gauge max
Gauge1.rangeColors = ['green','yellow','red'];
Gauge1.ranges = [5,10];

See Also
Gauge Properties, for more information on Gauges.

SHADOW

Adds a drop shadow to the component. 

Type
Boolean true: add drop shadow

false: no drop shadow

Example
Gauge1.shadow = true;

See Also
Gauge Properties, for more information on Gauges.

VALUE

If the output component is bound to a data field (i.e., displaying an
aggregate), value returns the value displayed by the component. If the
output component is not bound to a data field, the value property specifies
the value to display.

Type
Number

Example
if(Gauge1.value > 100) {
alert('Excessive value detected.')

}

See Also
Gauge Properties, for more information on Gauges.
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VS.13 Slider

This section discusses the properties that are unique to the Slider
component.

See Also
Common Properties, for properties shared with other components.
Slider and Spinner, for more information about Sliders.

CURRENTVISIBLE

Specifies that the value currently selected on the Slider is numerically
displayed at all times. Otherwise, the current value is numerically displayed
only while the user is actively dragging the Slider. 

Type
Boolean true: display currently selected value

false: hide currently selected value

Example
Slider1.currentVisible = false;

See Also
Slider and Spinner Properties, for more information on Slider settings.

INCREMENT

Specifies the interval between displayed labels on the Slider. For example,
a value of 15 indicates that the Slider labels should be placed at positions of
0, 15, 30, 45, etc. 

Type
Number Spacing between Slider labels

Example
Slider1.increment = 15;

See Also
Slider and Spinner Properties, for more information on Slider settings.

LABELVISIBLE

Specifies whether the labels on the Slider scale are displayed. 

Type
Boolean true: display scale labels

false: hide scale labels

Example
Slider1.labelVisible = false;
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See Also
Slider and Spinner Properties, for more information on Slider settings.

MAX

The value of the largest label displayed on the Slider scale.

Type
Number Value of highest scale label

Example
Slider1.max = 250;

See Also
Slider and Spinner Properties, for more information on Slider settings.

MAXVISIBLE

Specifies whether the Slider’s maximum value is displayed.

Type
Boolean true: Display maximum (default)

false: Hide maximum

Example
Slider1.maxVisible = false;

See Also
Slider and Spinner Properties, for more information on Slider settings.

MIN

The value of the smallest label displayed on the Slider scale.

Type
Number Value of lowest scale label

Example
Slider1.min = -50;

See Also
Slider and Spinner Properties, for more information on Slider settings.

MINVISIBLE

Specifies whether the Slider’s minimum value is displayed.

Type
Boolean true: Display minimum (default)

false: Hide minimum
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Example
Slider1.minVisible = false;

See Also
Slider and Spinner Properties, for more information on Slider settings.

TICKVISIBLE

Specifies whether tick marks are displayed on the Slider scale.

Type
Boolean true: Display tick marks (default)

false: Hide tick marks

Example
Slider1.tickVisible = false;

See Also
Slider and Spinner Properties, for more information on Slider settings.

VS.14 Spinner

This section discusses the properties that are unique to the Spinner
component.

See Also
Common Properties, for properties shared with other components.
Slider and Spinner, for more information about Sliders.

INCREMENT

Specifies the interval between the values when a user increments or
decrements the Spinner. For example, a value of 15 indicates the Spinner
should traverse values of 0, 15, 30, 45, etc. (assuming that min=0).

Type
Number Spinner increment

Example
Spinner1.increment = 20;

See Also
Slider and Spinner Properties, for more information on Slider settings.

MAX

The largest value that the Spinner can represent. The user will not be able
to use the Spinner to enter a larger value.

Type
Number Value of highest Spinner input
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Example
Spinner1.max = 250;

See Also
Slider and Spinner Properties, for more information on Slider settings.

MIN

The smallest value that the Spinner can represent. The user will not be able
to use the Spinner to enter a smaller value.

Type
Number Value of lowest Spinner input

Example
Spinner1.min = -50;

See Also
Slider and Spinner Properties, for more information on Slider settings.

VS.15 Check Box, Radio Button, Combo Box

This section discusses the properties that are unique to the Check Box,
Radio Button, and ComboBox components.

See Also
Common Properties, for properties shared with other components.
Radio Button, Check Box, Combo Box, in Advanced Dashboard Design,
for more information about the ComboBox component.

LABLES

Specifies the labels (as an array) displayed in a Check Box, Radio Button,
or ComboBox component. This property can be used only within
component-level script (see Adding Component Script), and the values
property must specify an array of the same length.

Type
Array

Example
ComboBox1.labels = ['Region','State','City'];
ComboBox1.values = [1,2,3];

See Also
Common Properties, for properties shared with other components.
selectedObject and selectedLabel, to access the current user selection.
Radio Button, Check Box, Combo Box, in Advanced Dashboard Design,
for more information about Input components.
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ROWCOUNT

Specifies the number of items displayed when a ComboBox is expanded.

Type
Number

Example
ComboBox1.rowCount = 10

See Also
Common Properties, for properties shared with other components.
Radio Button, Check Box, Combo Box, in Advanced Dashboard Design,
for more information about Input components.

VALUES

Specifies the values (as an array) for a Check Box, Radio Button, or
ComboBox component. This property can be used only within component-
level script (see Adding Component Script), and the lables property must
specify an array of the same length.

Type
Array

Example
ComboBox1.labels = ['Region','State','City'];
ComboBox1.values = [1,2,3];

See Also
Common Properties, for properties shared with other components.
selectedObject and selectedLabel, to access the current user selection.
Radio Button, Check Box, Combo Box, in Advanced Dashboard Design,
for more information about Input components.

VS.16 TextInput

This section discusses the properties that are unique to the TextInput
component.

See Also
Common Properties, for properties shared with other components.
TextInput Properties, in Advanced Dashboard Design, for more
information about the TextInput component.

VALUE

Specifies the contents displayed by the TextInput component.

Type
String or Number
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Example
if (TextInput1.value > 10000) {
TextInput1.value = 'Maximum exceeded';

}

See Also
Common Properties, for properties shared with other components.
TextInput Properties, for general information about the TextInput
component.

VS.17 Submit Button

This section discusses the properties that are unique to the Submit
component.

See Also
Common Properties, for properties shared with other components.
Submit Button Properties, in Advanced Dashboard Design, for more
information about the Submit Button component.

REFRESHAFTERSUBMIT

When true, refreshes the Viewsheet after submission. This is useful when
you want Viewsheet components to be immediately updated with the
submitted data (for example, when the new data is submitted from an
editable table to the database).

Type
Boolean true: refresh the Viewsheet after submission

false: do not refresh the Viewsheet

Example
refreshAfterSubmit = true;

See Also
Common Properties, for properties shared with other components.
Submit Button Properties, in Advanced Dashboard Design, to set ‘Refresh
Viewsheet after Submit’ in the dialog box.

VS.18 Upload

This section discusses the properties that are unique to the Upload
component.

See Also
Common Properties, for properties shared with other components.
Upload Properties, in Advanced Dashboard Design, for more information
about the Upload component.
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GETFILENAME()

Returns the full server path to a file uploaded on the server using the
Upload component.

Example
if (Upload1.isLoaded())) {
alert('File uploaded to ' + Upload1.getFileName())

}

The returned path and filename can be used, for example, to write the file to
a database. See Committing User-Modified Data to Database (Database
Write-Back) for information on how to construct a script that writes to a
database.

See Also
Common Properties, for properties shared with other components.
Upload Properties, in Advanced Dashboard Design, for general
information about the Upload component.

ISLOADED()

Returns true if a file has been successfully uploaded by the Upload
component.

Example
if (Upload1.isLoaded())) {
alert('File uploaded to ' + Upload1.getFileName())

}

When using the Upload component without an accompanying ‘Submit’
button, enable the ‘Submit on Change’ option in the ‘Upload Properties’
dialog box.

See Also
Common Properties, for properties shared with other components.
Upload Properties, in Advanced Dashboard Design, for general
information about the Upload component.

VS.19 Line

This section discusses the properties that are unique to the Line component.

See Also
Common Properties, for properties shared with other components.
Creating a Shape, for more information about Line.

BEGINARROWSTYLE

Specifies the style of arrow to place at the beginning of the line.
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Type
Integer 0: No arrow

StyleConstant.ARROW_LINE_1: Solid arrow
StyleConstant.ARROW_LINE_2: Stick arrow
StyleConstant.ARROW_LINE_3: Outline arrow

Example
Line1.beginArrowStyle = StyleConstant.ARROW_LINE_3;

See Also
Shape Component Properties: Shape Tab, for more information on Line
settings.

ENDARROWSTYLE

Specifies the style of arrow to place at the end of the line.

Type
Integer 0: No arrow

StyleConstant.ARROW_LINE_1: Solid arrow
StyleConstant.ARROW_LINE_2: Stick arrow
StyleConstant.ARROW_LINE_3: Outline arrow

Example
Line1.endArrowStyle = StyleConstant.ARROW_LINE_3;

See Also
Shape Component Properties: Shape Tab, for more information on Line
settings.

LINESTYLE

Specifies the style of the line.

Type
Integer one of the available Line Styles

Example
Line1.lineStyle = StyleConstant.THIN_LINE;

See Also
Shape Component Properties: Shape Tab, for more information on Line
settings.

SHADOW

Adds a drop shadow to the component. 

Type
Boolean true: add drop shadow

false: no drop shadow
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Example
Line1.shadow = true;

See Also
Shape Component Properties: Shape Tab, for more information on Line
settings.

VS.20 Rectangle

This section discusses the properties that are unique to the Rectangle
component.

See Also
Common Properties, for properties shared with other components.
Creating a Shape, for more information about Line.

LINESTYLE

Specifies the style of the line.

Type
Integer one of the available Line Styles

Example
Rectangle1.lineStyle = StyleConstant.THIN_LINE;

See Also
Shape Component Properties: Shape Tab, for more information on
Rectangle settings.

ROUNDCORNER

Specifies the radius of corner curvature in pixels.

Type
Integer corner curvature (pixels)

Example
Rectangle1.roundCorner = 30;

See Also
Shape Component Properties: Shape Tab, for more information on
Rectangle settings.

SHADOW

Adds a drop shadow to the component. 

Type
Boolean true: add drop shadow

false: no drop shadow
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Example
Rectangle1.shadow = true;

See Also
Shape Component Properties: Shape Tab, for more information on
Rectangle settings.

VS.21 Oval

This section discusses the properties that are unique to the Oval
component.

See Also
Common Properties, for properties shared with other components.
Creating a Shape, for more information about Line.

LINESTYLE

Specifies the style of the line.

Type
Integer one of the available Line Styles

Example
Oval1.lineStyle = StyleConstant.THIN_LINE;

See Also
Shape Component Properties: Shape Tab, for more information on Oval
settings.

SHADOW

Adds a drop shadow to the component. 

Type
Boolean true: add drop shadow

false: no drop shadow

Example
Oval1.shadow = true;

See Also
Shape Component Properties: Shape Tab, for more information on Oval
settings.

VS.22 Tabbed Interface

This section discusses the properties that are unique to the Tabbed
Interface.

See Also
Common Properties, for properties shared with other components.
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Creating a Tabbed Interface, for more information about Tabs.

LABELS

Specifies the text in the tab labels (as an array of Strings).

Type
Array of String tab label text

Example
Tab1.labels = ['Summary', 'Details'];
if (RadioButton1.selectedObject == 'City') {
Tab1.labels[1] = 'City Details';

}
else {
Tab1.labels[1] = 'State Details';

}

See Also
Tabbed Interface Properties, for more information on Tabbed Interface.

SELECTEDINDEX

Returns the index of the currently-selected tab. This property is read-only.

Type
Integer index of active tab

Example
if (Tab1.selectedIndex == 0) {
Gauge1.visible = true;

} 
else {
Gauge1.visible = false;

}

See Also
Tabbed Interface Properties, for more information on Tabbed Interface.

VS.23 Viewsheet

This section presents properties for an embedded Viewsheet. These
properties are set in the host Viewsheet.

See Also
Nesting Viewsheets in Advanced Dashboard Design for information on
embedding one Viewsheet within another.

ISACTIONVISIBLE(NAME)

Returns the value of the specified property for an embedded Viewsheet. 

Parameters
name name of property (String):
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'Open': user access to embedded Viewsheet

Example
if (!Viewsheet1.isActionVisible("Open")) {
alert('Embedded Viewsheet cannot be opened.');

}

See Also
Nesting Viewsheets in Advanced Dashboard Design for information on
embedding one Viewsheet within another.

SETACTIONVISIBLE(NAME,BOOLEAN)

Sets the value of the specified property for an embedded Viewsheet. The
‘Open’ property determines whether the embedded Viewsheet provides an
‘Open’ button to the end-user. (By default, this ‘Open’ button is visible
whenever the embedded Viewsheet contains hidden components.)

Parameters
name name of property (String): 

'Open'
boolean false: hide the 'Open' button

true: show the 'Open' button

Example
Viewsheet1.setActionVisible("Open",false);

See Also
Nesting Viewsheets in Advanced Dashboard Design for information on
embedding one Viewsheet within another.
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Common Reference

The following appendices discuss general functions that are useful across
multiple InetSoft products:

• General JavaScript Functions

Describes functions for processing and comparing text, dates, and
numbers, and discusses iteration and flow control structures
available in the JavaScript language.

• Chart Script Tutorial

Describes scripting techniques for creating charts, specifying sub-
series, setting axis information, decoration, and annotation.

• Chart Script Reference

Reference to objects, properties, and methods available for
scripting charts.

• Using Style Studio

Describes various configuration options in Style Studio.

See Also
Style Intelligence Object Reference, in Advanced Report Scripting for
functions specific to the reporting environment.
Advanced Dashboard Scripting, for functions specific to the Viewsheet
environment.
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APPENDIX JS:General JavaScript 
Functions

This section offers a
brief introduction to
common JavaScript
language constructs
and typical usage. It is
not a reference docu-
ment for JavaScript.
For more detailed
information on JavaS-
cript, please consult
the ECMA-262 speci-
fication or a JavaS-
cript book. You can
also find information
on JavaScript syntax
and constructs on the
Mozilla web site.

JavaScript is an object-oriented programming language for performing
computations and manipulating computational objects within a host
environment. An object is a collection of properties and functions. A
property can be a primitive type, a host object type, or a Java object. 

The primitive types are standard in every JavaScript runtime and are
independent of the host environment. These primitive object types include
the following:

• Global Object Functions

• String Object Functions

• Number Object Functions

• Date Object Functions

• Array Object Functions

• Math Object Functions

• Regular Expression Object Functions

In addition to the primitive types, this Appendix describes a number of
other functions and JavaScript constructs. Some of these functions require
knowledge of JavaScript arrays. See Array Object Functions for
information on how to use arrays. Columns within a table or Data
Worksheet can also be treated as arrays.

See Also
Style Intelligence Object Reference, in Advanced Report Scripting, for
more objects in a reporting environment.
Accessing Table Cells in Script, in Advanced Data Mashup, for
information on scripting for Worksheets.
Advanced Dashboard Scripting, for information on scripting for
Viewsheets.

JS.1 Java Objects (LiveConnect)

The JavaScript engine used in Style Intelligence supports the LiveConnect
feature, which allows a JavaScript script to access Java classes and objects.
This is particularly useful in Style Intelligence because the host
environment is running inside a Java virtual machine and many properties
of the report elements require Java objects.

A Java object can be created using the ‘new’ operator.

Text1.foreground = new java.awt.Color(0xFF0000);

http://www.ecma-international.org/publications/standards/Ecma-262.htm
http://www.ecma-international.org/publications/standards/Ecma-262.htm
http://devedge-temp.mozilla.org/central/javascript/index_en.html
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The Java class name must be fully qualified in the ‘new’ expression. Once
a Java object is created, its properties and methods can be accessed from
the script. The properties are discovered by search for the getter and setter
methods etc. A getter method is a non-void method starting with ‘get’ and
has an empty parameter list. A setter method is a void method starting with
‘set’ and accepts a single parameter. The name following the ‘get’ and ‘set’
is used as the property name with the first letter converted to lowercase.

If property has only a getter method, it is marked as a read-only property.
Assignment to the property is ignored.

var rgb = Text1.foreground.red; // Color.getRed()

Other public methods in the Java object are accessible as JavaScript
methods in a script.

Text1.foreground = Text1.foreground.darker(); 
// Color.darker()

JS.2 JavaScript Name/Value Pairs

You can use the following forms to create objects in JavaScript:

• color: {r:255, g:255, b:255}

• insets: {top:0, left:0, bottom:0, right:0}

• dimension: {width:2, height:2}

• point: {x:1, y:1} or {row:3, column:2}

• position: {x:3.3, y:1.2}

• size: {width:2.5, height:3.0}

• hyperlink: 

{link:"report2", target:"reportFrame", tooltip:"Hello", 
type:"report", sendReportParameters:true, state:"NJ", 
date:new Date()}

The type can be a report, web, or archive, and parameters can be added as
name/value pairs, e.g., state, date.

• shape: {type:rectangle, x:0, y:0, width:20, height:30}; Here, type 
can be an ellipse.

JS.3 JavaScript Operators

The operators in JavaScript are almost identical to the operators in Java:

JS.3.1 Assignment Operators

An assignment operator assigns a value to its left operand based on the
value of its right operand.
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x = y;

Arithmetic operators and bitwise operators can be combined with the
assignment operator as a short hand for performing a computation and
assigning the results to a variable.

x += y;

JS.3.2 Comparison Operators

A comparison operator compares two values and returns ‘true’ or ‘false’
depending on the comparison result.

JS.4 StyleConstant Object

The StyleConstant object is a static object that contains all definitions for
constants used in the Style Intelligence host environment. These constants
can be accessed without creating an instance of a StyleConstant object, as
shown below:

line = StyleConstant.DOUBLE_LINE

DATE GROUPING LEVELS

Date grouping levels are used for Chart and Crosstab binding.

OPERATOR DESCRIPTION

== Equal

!= Not equal

> Greater than

>= Greater than or equal to

< Less than

<= Less than or equal to

LEVEL DESCRIPTION

YEAR_DATE_GROUP Group by year
QUARTER_DATE_GROUP Group by quarter
MONTH_DATE_GROUP Group by month
WEEK_DATE_GROUP Group by week
DAY_DATE_GROUP Group by day
QUARTER_OF_YEAR_DATE_GROUP Group by quarter of year
MONTH_OF_YEAR_DATE_GROUP Group by month of year
WEEK_OF_YEAR_DATE_GROUP Group by week of year
DAY_OF_MONTH_DATE_GROUP Group by day of month
DAY_OF_WEEK_DATE_GROUP Group by day of week
HOUR_OF_DAY_DATE_GROUP Group by hour of day
HOUR_DATE_GROUP Group by hour
MINUTE_DATE_GROUP Group by minute



COMMON FUNCTION REFERENCE

916 of 1397

Type
integer

ALIGNMENTS

Alignment constants are defined for horizontal or vertical directions. By
using a bitwise OR of the values, the alignment options can be combined.

Type
integer

Example
alignment = StyleConstant.H_RIGHT | StyleConstant.V_CENTER;

See Also
Alignment Property, in Advanced Report Scripting, for more information
on setting report alignments.
Alignment Property, in Advanced Dashboard Scripting, for more
information on setting Viewsheet alignments.

DATA TYPES

The following data type constants available.

SECOND_DATE_GROUP Group by second
NONE_DATE_GROUP No date grouping

ALIGNMENT DESCRIPTION

H_LEFT Left alignment
H_CENTER Horizontal centered alignment
H_RIGHT Right alignment
V_TOP Top alignment
V_CENTER Vertical centered alignment
V_BOTTOM Bottom alignment
V_BASELINE Character baseline alignment
FILL Fill in whole space
LEFT Synonym for H_LEFT
CENTER Synonym for H_CENTER
RIGHT Synonym for H_RIGHT

TYPE DESCRIPTION

BOOLEAN true or false
BYTE single byte number
CHAR character
DATE date with no time component
DOUBLE double number
ENUM user-defined string constants
FLOAT float number
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Type
integer

Example
RangeSlider1.rangeType = StyleConstant.DATE;

CHART STYLES

The chart style constants specify how a chart presents its data. It is
recommended to access these constants through the Chart Styles property
of the Chart Constants.

Type
integer

INTEGER integer number
LONG long integer number
SHORT short integer number
STRING text string
TIME time
TIME_INSTANT time and date

CHART STYLE DESCRIPTION

CHART_AUTO Automatic style selection
CHART_PARETO Pareto chart.
CHART_LINE Line chart
CHART_LINE_STACK Stacked line chart
CHART_POINT Point chart
CHART_BAR 2D bar chart
CHART_BAR_STACK Stacked bar chart
CHART_PIE 2D pie chart
CHART_3D_BAR 3D bar chart
CHART_3D_BAR_STACK 3D stacked bar chart
CHART_3D_PIE 3D pie chart
CHART_STOCK High-low-closing chart
CHART_AREA Area chart
CHART_AREA_STACK Stacked area chart
CHART_RADAR Radar chart
CHART_FILL_RADAR Filled radar chart
CHART_CANDLE Candle chart
CHART_WATERFALL Waterfall chart
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LINE STYLES

The line style constants can be used in all properties requiring line style
constants, such as separator style, tab fill style, and table borders.

Type
integer

Example
style = StyleConstant.DOT_LINE;

SUMMARIZATION FORMULAS

The summarization formulas below are available for crosstab and chart
scripting. For charts, they can also be accessed through the Chart Constants
interface.

LINE STYLE DESCRIPTION

   NO_BORDER No line
   ULTRA_THIN_LINE Very thin line at ¼ of a point width
   THIN_THIN_LINE Very thin line at ½ of a point width
   THIN_LINE Thin line at one point width
   MEDIUM_LINE Medium width line
   THICK_LINE Thick width line
   DOUBLE_LINE Double line
   RAISED_3D Raised 3D line
   LOWERED_3D Lowered 3D line
   DOUBLE_3D_RAISED Raised double 3D line
   DOUBLE_3D_LOWERED Lowered double 3D line
   DOT_LINE Dotted line
   DASH_LINE Dash line
   MEDIUM_DASH Medium size dash line
   LARGE_DASH Large size dash line
   BREAK_BORDER A special line style that signals a page break in 

a table row. This line style can only be used in 
the table border.

NONE_FORMULA NTHMOSTFREQUENT_FORMULA
AVERAGE_FORMULA NTHSMALLEST_FORMULA
CONCAT_FORMULA POPULATIONSTANDARDDEVIATION_

FORMULA
CORRELATION_FORMULA POPULATIONVARIANCE_FORMULA
COUNT_FORMULA PRODUCT_FORMULA
COVARIANCE_FORMULA PTHPERCENTILE_FORMULA
DISTINCTCOUNT_FORMUL
A

STANDARDDEVIATION_FORMULA

MAX_FORMULA SUMSQ_FORMULA
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Type
integer

Example
style = StyleConstant.AVERAGE_FORMULA;

PAINTER LAYOUT

Painter element layout controls how a painter element is laid out when it is
bigger than the remaining space of a page.

Type
integer

Example
layout = StyleConstant.PAINTER_BREAKABLE;

POINT SHAPES

The point shape constants can be used to specify the shape used in a point
chart.

CIRCLE
TRIANGLE
SQUARE
CROSS
STAR
DIAMOND
X
FILLED_CIRCLE
FILLED_TRIANGLE
FILLED_SQUARE
FILLED_DIAMOND

Type
integer

MEDIAN_FORMULA_FORM
ULA

SUMWT_FORMULA

MIN_FORMULA SUM_FORMULA
MODE_FORMULA VARIANCE_FORMULA
NTHLARGEST_FORMULA WEIGHTEDAVERAGE_FORMULA

LAYOUT DESCRIPTION

 PAINTER_NON_BREAK If a painter is larger than the remaining page, 
advance to the next page. If the painter is 
larger than the entire page, draw the top 
portion in a page and ignore the remaining 
part.

 PAINTER_BREAKABLE If a painter is larger than the remaining page, 
print the portion that can fit in the available 
space and continue to the next page for the 
remaining part.
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Example
chartDescriptor.plotDescriptor.setPointStyle(0, 
StyleConstant.FILLED_CIRCLE);

TABLE LAYOUT

Table layout affects the table size calculation and table placement on a
report.

Type
integer

Example
layout = StyleConstant.TABLE_FIT_CONTENT_PAGE;

TEXTBOX SHAPES

The TextBox shape constants can be used to change the shape of a textbox.

BOX_RECTANGLE
BOX_ROUNDED_RECTANGLE

Type
integer

Example
shape = StyleConstant.BOX_ROUNDED_RECTANGLE;

WRAPPING STYLE

Wrapping style defines how contents flow around a painter object.

LAYOUT DESCRIPTION

TABLE_FIT_CONTENT Calculate the column width to fit the 
largest cell in each column

TABLE_FIT_PAGE Resize a table to fit the width of a page
TABLE_EQUAL_WIDTH Assign the same width to each column
TABLE_FIT_CONTENT_1PP Same as TABLE_FIT_CONTENT, but 

only put one table region on each page
TABLE_FIT_CONTENT_PAGE Same as TABLE_FIT_CONTENT, but 

resize the table segments to fit the width 
of a page after table has been broken up 
into regions.

WRAPPING STYLE DESCRIPTION

WRAP_NONE No wrapping. The painter element is printed as a 
background. The content flows on top of this 
painter.

WRAP_LEFT Allow contents to wrap around the painter on the 
left.
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Type
integer

Example
wrapping = StyleConstant.WRAP_RIGHT;

JS.5 JavaScript Statements

JavaScript statement syntax is very similar to Java statement syntax. Some
important language constructs are introduced in the following sections:

• Variable Definition

• Function Definition

• The ‘if’ Statement

• The ‘try-catch’ Statement

• Iteration Statements

• The ‘switch’ Statement

• The ‘with’ Statement

JS.5.1 Variable Definition

A variable statement inside a function declares a local variable. A variable
statement outside of a function body declares a global variable.

var val;
var array1 = [1, 2, 3];

JS.5.2 Function Definition

The ‘function’ keyword introduces a new function in the global scope.
Once a function is defined, it can be called in other parts of the script.

function sum(array1) {
var total = 0;

for(var idx = 0; idx < array1.length; idx++) {
total += array1[idx];

}

return total;
}

var total = sum(array2);

WRAP_RIGHT Allow contents to wrap around the painter on the 
right.

WRAP_BOTH Allow contents to wrap on both sides of the 
painter.

WRAP_TOP_BOTTOM No wrapping around either sides of the painter.
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JS.5.3 The ‘if’ Statement

The if conditional structure executes the statements within the ‘if’ block
only when the specified condition is true. Alternative conditions can be
tested by using one or more optional ‘else if’ blocks. An optional final
‘else’ block will be executed if all other conditions evaluate false.

if(condition0) {
statements to execute if condition0 is true

}
else if(condition1) {
statements to execute if condition1 is true

}
else if(condition2) {
statements to execute if condition2 is true

}
else if(condition3) {
statements to execute if condition3 is true

}
else {
statements to execute if all above conditions are false

}

See Also
Appendix JS.5.6, The ‘switch’ Statement, to conveniently test a larger set of
conditions.

JS.5.4 The ‘try-catch’ Statement

The “try-catch” construction allows you to catch a script error before it
causes report execution to fail. To catch an error, place the desired sequence
of code inside a “try” block. If any line of this “try” code generates an error,
program execution immediately jumps to the code in the “catch” block. 

try {
// Code to try

}
catch(err) {
// Alternative code for case of error

}
finally {
// Code to execute in either case

}

The “err” parameter contains the exception message that was generated by
the try block. The “finally” block contains code to be executed whether an
error occurred or not. The “catch” block and “finally” block are optional,
but cannot both be omitted.

JS.5.5  Iteration Statements

A ‘for’ loop consists of three optional expressions, enclosed in parentheses
and separated by semi-colons. 

for([init-expression];[condition];[increment-expression]) {
statements;

}
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The initial-expression is evaluated before the loop starts. It is normally used
to declare and initialize a counter variable. The condition statement is
evaluated at the beginning of every loop. If the condition is true, the
statements are executed. Otherwise, the loop terminates. The increment-
expression is executed after the body statements. It is normally used to
increment the counter variable.

for(var idx = 0; idx < array1.length; idx++) {
...

}

A special ‘for’ loop allows iteration through all properties of an object. If
the object is an array, each item in the array is treated as a property.

var props = "";
for(var item in obj) {
props += item + " = " + obj[item];

}

A ‘while’ statement is a loop with a single condition. The condition is
evaluated at the beginning of every loop. If the condition is true, the body
of the loop is executed. Otherwise, the loop is terminated.

while(condition) {
statements;

}

A slight variation of the ‘while’ statement is ‘do...while’. Instead of
evaluating the condition at the beginning of the loop, ‘do...while’ statement
evaluates the condition at the end of a loop. This guarantees the loop is at
least executed once.

do {
statements

} while(condition);

A loop can be terminated in the body by inserting a ‘break’ statement. A
‘break’ statement causes the execution to immediately transfer to the point
following the end of the loop.

Similarly, a ‘continue’ statement interrupts the execution of a loop and
transfer the execution to the end of the loop block.

JS.5.6 The ‘switch’ Statement

A ‘switch’ statement evaluates an expression and matches its result with a
list of choices. If a match is found, the statements under the choice are
executed. Otherwise, if a ‘default’ label exists, the statements in the default
block are executed.

switch(expression) {
case label:
statements;
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break;
case label:
statements;
break;
...

default:
statements;

}

See Also
Appendix JS.5.3, The ‘if’ Statement, to conveniently test a small set of
conditions.

JS.5.7 The ‘with’ Statement

A ‘with’ statement establishes an object as the default object for a set of
statements.

with(object) {
statements;

}

The properties and methods of the object can be referenced without
qualifying the names with the object name.

with(Text1) {
text = "contents of this text element";

}

JS.6 Global Object Functions

The Global object contains the properties and functions available for the
entire scripting environment. The values and functions can be accessed
anywhere as top-level properties and functions without any qualifier. 

// convert a text field to an integer
var val = parseInt(TextField1.text);

// assign the half of the value to another text element
Text2.text = (val * 1 / 2).toString();

FORMATDATE(DATE, STRING)

Formats a date according to a simple date format and returns the result as a
string.

Parameters
date a java or javascript date object
format string The format follows the Java

SimpleDateFormat specification 

Example
formatDate(new Date(), "hh 'o''clock' a, zzzz");

http://download.oracle.com/javase/7/docs/api/index.html?java/text/SimpleDateFormat.html
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The date format uses
the same syntax as in
java.text.SimpleDate-
Format.

A format string can be constructed using the characters listed in the table
below. 

Pattern letters can be repeated to obtain the desired date format. For the
symbols marked as ‘Text’ for its presentation, if the number of pattern
letters is 4 or more, the fill form is used; otherwise a short or abbreviated
form is used if available. For the symbols marked as ‘Number’ for its
presentation, the number of pattern letters is the minimum number of
digits, and shorter numbers are zero-padded to this amount. 

Some examples are shown below:  

FORMATNUMBER(NUMBER, FORMAT, ROUND)

Formats a number according to the format string.

SYMBOL MEANING PRESENTATION EXAMPLE

G era designator Text AD
y year Number 1996
M month in year Text & Number July & 07
d day in month Number 10
h hour in am/pm (1~12) Number 12
H hour in day (0~23) Number 0
m minute in hour Number 30
s second in minute Number 55
S millisecond Number 978
E day in week Text Tuesday
D day in year Number 189
F day of week in month Number 2 (2nd Web in July)
w week in year Number 27
W week in month Number 2
a am/pm marker Text PM
k hour in day (1~24) Number 24
K hour in am/pm (0~11) Number 0
z time zone Text Pacific Standard 

Time
‘ escape for text Delimiter
‘‘ single quote Literal ‘

DATE AND TIME PATTERN RESULT

“yyyy.MM.dd G ‘at’ HH:mm:ss 
z”

2006.08.07 AD at 02:19:35 PDT

“EEE, MMM d, ‘ ‘ yy” Mon, Aug 7, ‘06
“h:mm a” 12:08 PM
“hh ‘o’ ‘clock’ a, zzzz” 12 o’clock PM, Pacific Daylight Time
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Parameters
number The number to format
format A format string following Java 
DecimalFormat specification
round Specifies how the number is to be 
rounded (see below)

Example
formatNumber(3, '#,###.00','ROUND_HALF_UP');

Construct the number format string using the characters listed in the table
below. The syntax is the same as Java’s DecimalFormat.

The rounding options specified by the round parameter are the same as for
the Java BigDecimal class.

UNDEFINED

This value is returned if a non-existent object or property is referenced. It is
also the value of a variable before it is initialized.

SYMBOL MEANING

0 Digit
# Digit, zero shows as absent
. Decimal point
- Minus sign
, Grouping separator
E Separates mantissa and exponent in scientific notation
; Separates positive and negative sub-patterns
% Multiply by 100 and show as percentage

ROUND SETTING MEANING

ROUND_UP Round away from zero
ROUND_DOWN Round toward zero
ROUND_CEILING Round toward +
ROUND_FLOOR Round toward -
ROUND_HALF_UP Round toward nearest neighbor unless both 

neighbors are equidistant, in which case round up
ROUND_HALF_DOWN Round toward nearest neighbor unless both 

neighbors are equidistant, in which case round 
down

ROUND_HALF_EVEN Round toward nearest neighbor unless both 
neighbors are equidistant, in which case round to 
even neighbor

ROUND_UNNECESSARY Apply no rounding

http://docs.oracle.com/javase/8/docs/api/java/text/DecimalFormat.html
http://docs.oracle.com/javase/7/docs/api/java/math/BigDecimal.html
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EVAL(STRING)

Evaluate a string of JavaScript code without reference to a particular object.
This function is useful for executing dynamically created JavaScript
commands and expressions.

PARSEINT(STRING, RADIX)

Parse a string into integer. If the radix is omitted or undefined, it is assumed
to be 10, unless the string begins with ‘0x’ or ‘0X’, in which case 16 is
assumed.

PARSEFLOAT(STRING)

Parse a string into a decimal representation of a number.

PARSEDATE(STRING, FORMAT)

Parse a string into a date.

Parameters
string string representation of the date
format format string, or boolean value set to true 

for parsing a timeInstant object

Example
parseDate('2006-08-07', 'yyyy-MM-dd');

ENCODEURI(URI)

Produce a new URI with any special characters replaced by an appropriate
encoding.

DECODEURI(URI)

Produce a new URI with escape sequences or UTF-8 encoding replaced by
the characters they represent.

REGISTERPACKAGE(STRING)

Register the specified package to enable the use of all the classes in the
package. All packages starting with java, inetsoft, com, or org are
registered automatically. Packages may also be registered by setting the
javascript.java.packages property for the application.

Example
registerPackage('inetsoft.report');
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IMPORTPACKAGE(PACKAGE)

Enable the use of unqualified names for all the classes of the specified
package by searching for unqualified names as classes qualified by the
given package. The package can be a java package, an inetsoft package, or
any other package beginning with com or org.

Example
importPackage(java.awt);
font = new Font("Verdana", Font.ITALIC, 24);
foreground = Color.red;

TOLIST(LIST [,OPTIONS])

Remove duplicate entries from input array to yield a list of unique elements
with optional sorting and grouping.

Parameter
list array to filter 
options a comma-separated Options String specifying 

property-value pairs below:

Options String
sort Return sorted values {asc,desc,false}
sorton Measure by which to sort, e.g., sum(Total),

prior to filtering by maxrows
sorton2 Measure by which to sort, e.g., sum(Total),

after filtering by maxrows
remainder Label for 'Others' group in Top/Bottom-N

filtering. Omit option to suppress 'Others'.
maxrows Limits the number of rows returned.
distinct Return only distinct values {true,false}

The default is true.
date Return values grouped by date 

{year/quarter/month/week/day/hour/minute/
second/weekday/monthname/weekdayname}

rounddate Same as 'date', but returns an array of dates

Example
Array1 = [2,3,1,2,3,3,2,2,1,0]; 
Array2 = toList(Array1,'sort=desc'); // returns [3,2,1,0]

See toList in the Advanced Report Scripting for more information about
usage in reports. See Creating a Freehand Table in Advanced Dashboard
Design for usage in dashboards.

JS.7 String Object Functions

String is a built-in type in JavaScript. It holds a sequence of characters in
the Unicode character set. A string literal is created using a double quote or
a single quote strings.

var txt = 'Hello world'; // or "Hello world"
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Two strings can be concatenated by using the ‘+’ operator, as well as by
using the concat function. For example:

var txt = "Hello " + 'world';

field['Salesperson.First Name'].concat(" 
",field['Salesperson.Last Name'])

The following pages document some common string functions. Please
consult a JavaScript reference for details about other string functions.

LENGTH

The length property of a string returns the number of characters in the
string.

Example
var strLength = 'Hello'.length; // returns '5'

CONCAT(STRING2[,STRING3][,STRING4][,...])

Concatenate a given string with one or more additional strings. 

Examples
var txt = 'Hello'.concat(' ','and good morning.')

field['Salesperson.First 
Name'].concat(" ",field['Salesperson.Last Name'])

SUBSTRING(INDEXA, INDEXB)

Return a substring of a given string, where indexA is the starting position of
the substring in the original string and indexB is the position following the
last character in the substring. The index is zero based.

Example
var txt = 'Hello'.substring(1,3); // returns “el”

CHARAT(INDEX)

Return the character at the specified position in the string, indexed from 0.

Example
var txt = 'Hello'.charAt(4); // returns “o”

CHARCODEAT(INDEX)

Return the character code of the character at the specified position in the
string.

Example
var txt = 'Hello'.charCodeAt(4); // returns “111”
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INDEXOF(SEARCHVALUE[, FROMINDEX])

Search for the search value in the string and return the position of the sub-
string, or –1 if the search value is not found. The optional fromIndex
specifies the starting position of the search.

LASTINDEXOF(SEARCHVALUE[, FROMINDEX])

Search for the last occurrence of the search value and return the position or
–1 if not found. The optional fromIndex specifies the starting position of the
search.

REPLACE(REGEXP, NEWSTR)

Replace a regular expression in a string with the new string.

SEARCH(REGEXP)

Match a regular expression with a string. If successful, it returns the
position of the regular expression in the string, or –1 if no match is found.

TOLOWERCASE()

Convert all characters to lowercase.

TOUPPERCASE()

Convert all characters to uppercase.

Example
"a new string".toUpperCase();

SPLIT(SEPARATOR, LIMIT)

Split up the given string into an array of string values using the specified
delimiter. 

Parameter
Separator The characters to be used as delimiters when 

splitting the string. By default, space is 
used as the delimiter.

Limit The number of substrings to be returned.

Example
"abc,def".split(",",2);

SLICE(START, END)

Extract a certain portion of the string.
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Parameter
Start Index of the first character of the desired 

substring.
End Index of the character after the last 

character of the desired substring.

Example
"a new string".slice(2, 5) // returns 'new'

JS.8 Number Object Functions

All numeric values are number objects. The values are normally used for
computation using language operators such as multiplication, addition,
subtraction and division. There are a few useful methods for converting a
number to a string.

TOSTRING([RADIX])

Convert a number to a string. The optional radix is a number ranging from
2 to 36.

Example
(5).toString(2);   // 101 binary representation

TOFIXED(FRACTIONDIGITS)

Convert a number to a fixed decimal number. The fractionDigits
specifies the number of digits following the decimal point.

Example
(1/3).toFixed(2);

TOEXPONENTIAL(FRACTIONDIGITS)

Converts a number to be in scientific format. The fractionDigits specifies
the number of digits following the decimal point.

Example
(3251.234).toExponential(2); // returns 3.25e+3

TOLOCALESTRING()

Returns the localized value in the string format for the given number

TOPRECISION(PRECISION)

Returns the floor of the given number. The precision specifies the total
number of digits including the ones before and after the decimal points.

Example
(3.234).toPrecision(3); // returns 3.23
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JS.9 Date Object Functions

The JavaScript Date object is very similar to Java Date object. It stores the
time and date and can be used to manipulate dates and perform date
conversions. There are several ways to create a date object. Invoked
without arguments, the new date object contains the time and date of its
creation:

var now = new Date() // Thu Jun 12 15:14:51 EDT 2008

You can also create a Date object by specifying elapsed milliseconds from
January 1, 1970:

var due_date = new Date(800000000000);
// Tue May 09 02:13:20 EDT 1995

Alternatively, create the Date object from individual date components:

var due_date = new Date(1988,0,10); 
// Sun Jan 10 00:00:00 EST 1988

There are a number of methods in the Date object for manipulating date
fields. Since the scripts in Style Intelligence are primarily used to work
with Java objects, it is more common for a script to work with the
java.util.Date object. The use of Java objects is covered in Appendix JS.1,
Java Objects (LiveConnect). 

GETMILLISECONDS()

Return the milliseconds from epoch.

TOSTRING()

Return a string representation of the date.

TODATESTRING()

Return a string representation of the date portion of the date.

TOTIMESTRING()

Return a string representation of the time portion of the date.

Examples
(new Date()).toTimeString();

DATEADD(INTERVAL, AMOUNT, DATE)

Returns a new date that is created by adding the specified amount of time to
the specified interval of the given date.
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Parameters
interval The date interval to be modified. 
amount The amount of time to be added to the interval
date The date to be modified

Example
dateAdd(‘m’, 2, new Date())
// newDate is set to be 2 months from the current date.

All the valid date interval strings are listed in the table below.

DATEDIFF(INTERVAL, DATE1, DATE2)

Return the difference in the interval between the two given dates. For the
valid interval values, please refer to the table under dateAdd() function
discussion.

Parameters
interval The date interval for which the difference is 

to be calculated.
date1, date2 The dates to be compared.

Example
dateDiff(‘m’, new Date(), dateAdd(‘m’, 2, new Date())); 
// returns 2.

DATEPART(INTERVAL, DATE)

Extracts the specified date interval. For the valid interval values, please
refer to the table under the dateAdd() function discussion.

Parameters
interval The interval value to be extracted.
date The date from which the interval is to be 

extracted.

Example
datePart(‘m’, new Date()); // returns current month

INTERVAL STRINGS DATE INTERVAL IT REPRESENTS

yyyy Year
q Quarter
m Month
y Day of the year
d Day of the month
w Day of the week
ww Week of the year
h Hour
n Minute
s Second
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JS.10 Array Object Functions

JavaScript arrays are a non-fixed length arrays. A constant array can be
created using an array literal:

states = ["NJ", "NY", "CA"];

This is equivalent to the array constructor:

states = new Array("NJ", "NY", "CA");

The length of the array is dynamically adjusted when new items are added
to an array. If the newly added item leaves a gap in the existing array, the
items in the gap have an ‘undefined’ value.

states[50] = 'FL';

The length property of an array object returns the current array length.

for(var i = 0; i < states.length; i++) {
if(states[i] == 'NJ') {
...
}

}

Array objects also have functions to merge, slice, reverse, etc. 

CONCAT(ARRAY1, ARRAY2, …, ARRAYN)

Concatenate the arrays into one array.

num1 = [1,2,3] 
num2 = [4,5,6] 
num3 = [7,8,9] 
nums = num1.concat(num2,num3)

SLICE(BEGIN[, END])

Return a slice of the array as a new array.

SORT([COMPAREFUNCTION])

Sort the array items according to a compare function. If the function is not
supplied, all items are sorted as strings. A compare function is a function
that accepts two parameters. It returns a positive number if the first
parameter is greater than the second parameter, zero if the two parameters
are the same and a negative number if the first parameter is less than the
second parameter.

Examples
function compareInt(a, b) {
return a - b;

}
array1.sort(compareInt);
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JOIN(SEPARATOR)

Returns a string containing all the elements of the array separated by the
specified separator.

Example
[‘A’, ‘B’, ‘C’].join(‘&’); // returns "A&B&C"

REVERSE()

Reverses the order of the elements in the array.

Example
[‘A’, ‘B’, ‘C’].reverse(); // returns [‘C’, ‘B’, ‘A’]

JS.11 Math Object Functions

The Math object is a top-level object, and has some numerical constants as
properties (e.g. Math.PI returns 3.141592653589793). The complete list of
constants is: E, LN10, LN2, LOG10E, LOG2E, PI, SQRT1_2, SQRT2.

Math also provides many static functions. They can be accessed without an
instance of the object.

ABS(NUMBER)

Return the absolute value.

Example
Math.abs(-234.45); // returns 234.45

ACOS(NUMBER)

Return the inverse cosine (in radians) of a number between 0 and 1.

Example
Math.acos(0); // returns 1.570796 (90 degrees)

ASIN(NUMBER)

Return the inverse sine (in radians) of a number between 0 and 1.

Example
Math.asin(1); // returns 1.570796 (90 degrees)

ATAN(NUMBER)

Return the inverse tangent (in radians) of a number.

Example
Math.atan(1); // returns 0.785398 (45 degrees)
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CEIL(NUMBER)

Return the smallest integer greater than or equal to a number.

Example
Math.ceil(15.2); // returns 16 

COS(NUMBER)

Return the cosine (in radians) of a number.

Example
Math.cos(3.14159); // returns -0.9999 

EXP(NUMBER)

Return the value of e raised to the power of number.

Example
Math.exp(3); // returns 20.085

FLOOR(NUMBER)

Return the largest integer less than or equal to a number.

Example
Math.floor(15.2); // returns 15 

LOG(NUMBER)

Return a natural logarithm (base e) of a number.

Example
Math.log(2.71828); // returns 1

MAX(X, Y)

Return the maximum number, X or Y.

Example
Math.max(2,3); // returns 3

MIN(X, Y)

Return the minimum number, X or Y.

Example
Math.min(2,3); // returns 2

POW(BASE, EXPONENT)

Raise the base to the exponent power.
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Example
Math.pow(2,3); // returns 8 (23)

RANDOM()

Return a random number between 0 and 1.

Example
Math.random(); // returns 0.917008, for example

ROUND(NUMBER)

Return the value of a number rounded to the nearest integer.

Example
Math.round(15.8); // returns 16

SIN(NUMBER)

Return the sine of an angle in radians

Example
Math.sin(pi()/4); // returns 0.7071

SQRT(NUMBER)

Return the square root of a number.

Example
Math.sqrt(36.89); // returns 6.0737

TAN(NUMBER)

Return the tangent of an angle in radians

Example
Math.tan(0.785398); // returns 1 tan(45o)

JS.12 CALC Object Functions

The CALC object contains implementations of Excel-like spreadsheet
functions. All these functions are static and can be used without an instance
of the CALC object.

var avg = CALC.average([1,2,3]);

Many functions include an optional parameter basis to indicate the day
count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual
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• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

JS.12.1Date and Time Functions

The CALC object provides the date and time functions listed at right.

CALC.DATEVALUE(DATE)

Returns the number of days between the epoch (12/31/1899) and parameter
date.

Parameters
date a Date object

Example
CALC.datevalue(new Date(1900,0,2)); 
// returns 2

CALC.DAY(DATE)

Returns the day of the month corresponding to the Date object in parameter
date.

Parameters
date a Date object

Example
CALC.day(new Date()); 
// returns 28 (Assuming date was Dec 28, 2005)

CALC.DAYS360(START_DATE, END_DATE[, METHOD])

Return the number of days between the start_date and the end_date, using
12 months of 30 days. Set method to false to use the U.S. NASD method
(default); set method to true to use the European method.

Parameters
start_date Date object: date from which to begin counting
end_date Date object: date at which to end counting
method Boolean: false for US, true for European

Example
CALC.days360(new Date(2005,1,21), new Date(2006,0,18), 
false); 
// returns 327
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CALC.EDATE(DATE, MONTHS)

Returns a date that is the specified number of months before or after the
date. A negative value for months represents a date prior to the specified
date.

Parameters
date Date object: date from which to begin counting
months Positive integer: Number of months to count 
forward

Negative integer: Number of months to count 
backward

Example
Add one month to Jan 14, 2000:

CALC.edate(new Date(2000,0,14), 1); // returns Feb 14, 2000

CALC.EOMONTH(DATE, MONTHS)

Returns a date corresponding to the last day of the month that is a specified
number of months before or after the given date. A negative value for
months represents a date prior to the specified date.

Parameters
date Date object: date from which to begin counting
months Positive integer: Number of months to count 
forward

Negative integer: Number of months to count 
backward

Example
Last day of month for month following Jan 14, 2000:

CALC.eomonth(new Date(2000,0,14), 1); 
// returns 2/29/2000

CALC.FISCALYEAR(DATE, STARTMONTH [,STARTDAY,TIMEZONE])

For a fiscal calendar defined by an arbitrary start date, returns the fiscal
year corresponding to the specified date as a number, e.g., “2014”. The
startMonth and optional startDay determine the starting point of the fiscal
year.

Parameters
date Date object to be converted to fiscal year.
startMonth Integer specifying the starting month of the 
fiscal calendar.
startDay Integer specifying the starting day of the 
fiscal calendar (defaults to 1).
timeZone Time zone for fiscal year start date, a valid 
time zone identifier ("GMT", "GMT-8", "America/New_York"). 
Default is the JVM system default time zone.
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Example
Today’s year in fiscal year beginning April 16:

CALC.fiscalyear(CALC.today(), 4, 16)

CALC.FISCALYEAR445(DATE, STARTYEAR, STARTMONTH, STARTDAY, 
LEAPYEARS[,TIMEZONE])

For a 4-4-5 fiscal calendar, returns the fiscal year corresponding to the
specified date as a number, e.g., “2014”. The startYear, startMonth, and
startDay determine the starting point of the fiscal calendar. Leap years
must be explicitly specified by the array leapYears.

Parameters
date Date object to be converted to fiscal year.
startYear Integer specifying the starting year of the 
fiscal calendar.
startMonth Integer specifying the starting month of the 
fiscal calendar.
startDay Integer specifying the starting day of the 
fiscal calendar.
leapYears Array of years that contain 53 weeks.
timeZone Time zone for fiscal year start date, a valid 
time zone identifier ("GMT", "GMT-8", "America/New_York"). 
Default is the JVM system default time zone.

Example
Today’s year in fiscal calendar beginning Jan 30, 2000 with leap years in
2000, 2006, 2012, and 2017:

CALC.fiscalyear445(CALC.today(), 2000, 1, 30, [2000, 2006, 
2012, 2017])

In a 4-4-5 fiscal calendar, a typical year has 52 weeks totalling 364 days:

• The first month of each quarter is 4 weeks

• The second month of each quarter is 4 weeks

• The third month of each quarter is 5 weeks

Every few years (as specified by array leapYears), the fiscal calendar
requires a 53-week year in order to reconcile with the solar year. In any
such leap year, the final month of the last quarter has 6 weeks. 

CALC.FISCALYEAR454(DATE, STARTYEAR, STARTMONTH, STARTDAY, 
LEAPYEARS[,TIMEZONE])

For a 4-5-4 fiscal calendar, returns the fiscal year corresponding to the
specified date as a number, e.g., “2014”. The startYear, startMonth, and
startDay determine the starting point of the fiscal calendar. Leap years
must be explicitly specified by the array leapYears.
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Parameters
date Date object to be converted to fiscal year.
startYear Integer specifying the starting year of the 
fiscal calendar.
startMonth Integer specifying the starting month of the 
fiscal calendar.
startDay Integer specifying the starting day of the 
fiscal calendar.
leapYears Array of years that contain 53 weeks.
timeZone Time zone for fiscal year start date, a valid 
time zone identifier ("GMT", "GMT-8", "America/New_York"). 
Default is the JVM system default time zone.

Example
Today’s year in fiscal calendar beginning Jan 30, 2000 with leap years in
2000, 2006, 2012, and 2017:

CALC.fiscalyear454(CALC.today(), 2000, 1, 30, [2000, 2006, 
2012, 2017])

In a 4-5-4 fiscal calendar, a typical year has 52 weeks totalling 364 days:

• The first month of each quarter is 4 weeks

• The second month of each quarter is 5 weeks

• The third month of each quarter is 4 weeks

Every few years (as specified by array leapYears), the fiscal calendar
requires a 53-week year in order to reconcile with the solar year. In any
such leap year, the final month of the last quarter has 5 weeks. 

CALC.FISCALYEAR544(DATE, STARTYEAR, STARTMONTH, STARTDAY, 
LEAPYEARS[,TIMEZONE])

For a 5-4-4 fiscal calendar, returns the fiscal year corresponding to the
specified date as a number, e.g., “2014”. The startYear, startMonth, and
startDay determine the starting point of the fiscal calendar. Leap years
must be explicitly specified by the array leapYears.

Parameters
date Date object to be converted to fiscal year.
startYear Integer specifying the starting year of the 
fiscal calendar.
startMonth Integer specifying the starting month of the 
fiscal calendar.
startDay Integer specifying the starting day of the 
fiscal calendar.
leapYears Array of years that contain 53 weeks.
timeZone Time zone for fiscal year start date, a valid 
time zone identifier ("GMT", "GMT-8", "America/New_York"). 
Default is the JVM system default time zone.
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Example
Today’s year in fiscal calendar beginning Jan 30, 2000 with leap years in
2000, 2006, 2012, and 2017:

CALC.fiscalyear544(CALC.today(), 2000, 1, 30, [2000, 2006, 
2012, 2017])

In a 5-4-4 fiscal calendar, a typical year has 52 weeks totalling 364 days:

• The first month of each quarter is 5 weeks

• The second month of each quarter is 4 weeks

• The third month of each quarter is 4 weeks

Every few years (as specified by array leapYears), the fiscal calendar
requires a 53-week year in order to reconcile with the solar year. In any
such leap year, the final month of the last quarter has 5 weeks. 

CALC.FISCALQUARTER(DATE, STARTMONTH [,STARTDAY,TIMEZONE])

For a fiscal calendar defined by an arbitrary start date, returns the fiscal
quarter corresponding to the specified date as a number, e.g., “4”. The
startMonth and optional startDay determine the starting point of the fiscal
year.

Parameters
date Date object to be converted to fiscal quarter.
startMonth Integer specifying the starting month of the 
fiscal calendar.
startDay Integer specifying the starting day of the 
fiscal calendar (defaults to 1).
timeZone Time zone for fiscal year start date, a valid 
time zone identifier ("GMT", "GMT-8", "America/New_York"). 
Default is the JVM system default time zone.

Example
Today’s quarter in fiscal year beginning April 16:

CALC.fiscalquarter(CALC.today(), 4, 16)

If the start of the fiscal year is on the 29th, 30th, or 31st day of a month, the
actual last day of the month is used as the month boundary. For example, if
you specify March 31 as the start of the fiscal year, this designates March
31 as the first day of month 1. However, the first day of month 2 cannot be
April 31 because April has only 30 days. Therefore, the start of month 2 is
the actual last day of the month, April 30.
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CALC.FISCALQUARTER445(DATE, STARTYEAR, STARTMONTH, 
STARTDAY, LEAPYEARS[,TIMEZONE])

For a 4-4-5 fiscal calendar, returns the fiscal quarter corresponding to the
specified date as a number, e.g., “3”. The startYear, startMonth, and
startDay determine the starting point of the fiscal calendar. Leap years
must be explicitly specified by the array leapYears.

Parameters
date Date object to be converted to fiscal quarter.
startYear Integer specifying the starting year of the 
fiscal calendar.
startMonth Integer specifying the starting month of the 
fiscal calendar.
startDay Integer specifying the starting day of the 
fiscal calendar.
leapYears Array of years that contain 53 weeks.
timeZone Time zone for fiscal year start date, a valid 
time zone identifier ("GMT", "GMT-8", "America/New_York"). 
Default is the JVM system default time zone.

Example
Today’s quarter in fiscal calendar beginning Jan 30, 2000 with leap years in
2000, 2006, 2012, and 2017:

CALC.fiscalquarter445(CALC.today(), 2000, 1, 30, [2000, 
2006, 2012, 2017])

In a 4-4-5 fiscal calendar, a typical year has 52 weeks totalling 364 days:

• The first month of each quarter is 4 weeks

• The second month of each quarter is 4 weeks

• The third month of each quarter is 5 weeks

Every few years (as specified by array leapYears), the fiscal calendar
requires a 53-week year in order to reconcile with the solar year. In any
such leap year, the final month of the last quarter has 6 weeks. 

CALC.FISCALQUARTER454(DATE, STARTYEAR, STARTMONTH, 
STARTDAY, LEAPYEARS[,TIMEZONE])

For a 4-5-4 fiscal calendar, returns the fiscal quarter corresponding to the
specified date as a number, e.g., “3”. The startYear, startMonth, and
startDay determine the starting point of the fiscal calendar. Leap years
must be explicitly specified by the array leapYears.

Parameters
date Date object to be converted to fiscal quarter.
startYear Integer specifying the starting year of the 
fiscal calendar.
startMonth Integer specifying the starting month of the 
fiscal calendar.
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startDay Integer specifying the starting day of the 
fiscal calendar.
leapYears Array of years that contain 53 weeks.
timeZone  Time zone for fiscal year start date, a valid 
time zone identifier ("GMT", "GMT-8", "America/New_York"). 
Default is the JVM system default time zone.

Example
Today’s quarter in fiscal calendar beginning Jan 30, 2000 with leap years in
2000, 2006, 2012, and 2017:

CALC.fiscalquarter454(CALC.today(), 2000, 1, 30, [2000, 
2006, 2012, 2017])

In a 4-5-4 fiscal calendar, a typical year has 52 weeks totalling 364 days:

• The first month of each quarter is 4 weeks

• The second month of each quarter is 5 weeks

• The third month of each quarter is 4 weeks

Every few years (as specified by array leapYears), the fiscal calendar
requires a 53-week year in order to reconcile with the solar year. In any
such leap year, the final month of the last quarter has 5 weeks. 

CALC.FISCALQUARTER544(DATE, STARTYEAR, STARTMONTH, 
STARTDAY, LEAPYEARS[,TIMEZONE])

For a 5-4-4 fiscal calendar, returns the fiscal quarter corresponding to the
specified date as a number, e.g., “3”. The startYear, startMonth, and
startDay determine the starting point of the fiscal calendar. Leap years
must be explicitly specified by the array leapYears.

Parameters
date Date object to be converted to fiscal quarter.
startYear Integer specifying the starting year of the 
fiscal calendar.
startMonth Integer specifying the starting month of the 
fiscal calendar.
startDay Integer specifying the starting day of the 
fiscal calendar.
leapYears Array of years that contain 53 weeks.
timeZone  Time zone for fiscal year start date, a valid 
time zone identifier ("GMT", "GMT-8", "America/New_York"). 
Default is the JVM system default time zone.

Example
Today’s quarter in fiscal calendar beginning Jan 30, 2000 with leap years in
2000, 2006, 2012, and 2017:

CALC.fiscalquarter544(CALC.today(), 2000, 1, 30, [2000, 
2006, 2012, 2017])

In a 5-4-4 fiscal calendar, a typical year has 52 weeks totalling 364 days:
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• The first month of each quarter is 5 weeks

• The second month of each quarter is 4 weeks

• The third month of each quarter is 4 weeks

Every few years (as specified by array leapYears), the fiscal calendar
requires a 53-week year in order to reconcile with the solar year. In any
such leap year, the final month of the last quarter has 5 weeks. 

CALC.FISCALMONTH(DATE, STARTMONTH [,STARTDAY,TIMEZONE])

For a fiscal calendar defined by an arbitrary start date, returns the fiscal
month corresponding to the specified date as a number, e.g., “12”. The
startMonth and optional startDay determine the starting point of the fiscal
year.

Parameters
date Date object to be converted to fiscal month.
startMonth Integer specifying the starting month of the 
fiscal calendar.
startDay Integer specifying the starting day of the 
fiscal calendar (defaults to 1).
timeZone  Time zone for fiscal year start date, a valid 
time zone identifier ("GMT", "GMT-8", "America/New_York"). 
Default is the JVM system default time zone.

Example
Today’s month in fiscal year beginning April 16:

CALC.fiscalmonth(CALC.today(), 4, 16)

If the start of the fiscal year is on the 29th, 30th, or 31st day of a month, the
actual last day of the month is used as the month boundary. For example, if
you specify March 31 as the start of the fiscal year, this designates March
31 as the first day of month 1. However, the first day of month 2 cannot be
April 31 because April has only 30 days. Therefore, the start of month 2 is
the actual last day of the month, April 30.

CALC.FISCALMONTH445(DATE, STARTYEAR, STARTMONTH, 
STARTDAY, LEAPYEARS[,TIMEZONE])

For a 4-4-5 fiscal calendar, returns the fiscal month corresponding to the
specified date as a number, e.g., “8”. The startYear, startMonth, and
startDay determine the starting point of the fiscal calendar. Leap years
must be explicitly specified by the array leapYears.

Parameters
date Date object to be converted to fiscal month.
startYear Integer specifying the starting year of the 
fiscal calendar.
startMonth Integer specifying the starting month of the 
fiscal calendar.
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startDay Integer specifying the starting day of the 
fiscal calendar.
leapYears Array of years that contain 53 weeks.
timeZone  Time zone for fiscal year start date, a valid 
time zone identifier ("GMT", "GMT-8", "America/New_York"). 
Default is the JVM system default time zone.

Example
Today’s month in fiscal calendar beginning Jan 30, 2000 with leap years in
2000, 2006, 2012, and 2017:

CALC.fiscalmonth445(CALC.today(), 2000, 1, 30, [2000, 2006, 
2012, 2017])

In a 4-4-5 fiscal calendar, a typical year has 52 weeks totalling 364 days:

• The first month of each quarter is 4 weeks

• The second month of each quarter is 4 weeks

• The third month of each quarter is 5 weeks

Every few years (as specified by array leapYears), the fiscal calendar
requires a 53-week year in order to reconcile with the solar year. In any
such leap year, the final month of the last quarter has 6 weeks. 

CALC.FISCALMONTH454(DATE, STARTYEAR, STARTMONTH, 
STARTDAY, LEAPYEARS[,TIMEZONE])

For a 4-5-4 fiscal calendar, returns the fiscal month corresponding to the
specified date as a number, e.g., “11”. The startYear, startMonth, and
startDay determine the starting point of the fiscal calendar. Leap years
must be explicitly specified by the array leapYears.

Parameters
date Date object to be converted to fiscal month.
startYear Integer specifying the starting year of the 
fiscal calendar.
startMonth Integer specifying the starting month of the 
fiscal calendar.
startDay Integer specifying the starting day of the 
fiscal calendar.
leapYears Array of years that contain 53 weeks.
timeZone  Time zone for fiscal year start date, a valid 
time zone identifier ("GMT", "GMT-8", "America/New_York"). 
Default is the JVM system default time zone.

Example
Today’s month in fiscal calendar beginning Jan 30, 2000 with leap years in
2000, 2006, 2012, and 2017:

CALC.fiscalmonth454(CALC.today(), 2000, 1, 30, [2000, 2006, 
2012, 2017])

In a 4-5-4 fiscal calendar, a typical year has 52 weeks totalling 364 days:
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• The first month of each quarter is 4 weeks

• The second month of each quarter is 5 weeks

• The third month of each quarter is 4 weeks

Every few years (as specified by array leapYears), the fiscal calendar
requires a 53-week year in order to reconcile with the solar year. In any
such leap year, the final month of the last quarter has 5 weeks. 

CALC.FISCALMONTH544(DATE, STARTYEAR, STARTMONTH, 
STARTDAY, LEAPYEARS[,TIMEZONE])

For a 5-4-4 fiscal calendar, returns the fiscal month corresponding to the
specified date as a number, e.g., “11”. The startYear, startMonth, and
startDay determine the starting point of the fiscal calendar. Leap years
must be explicitly specified by the array leapYears.

Parameters
date Date object to be converted to fiscal month.
startYear Integer specifying the starting year of the 
fiscal calendar.
startMonth Integer specifying the starting month of the 
fiscal calendar.
startDay Integer specifying the starting day of the 
fiscal calendar.
leapYears Array of years that contain 53 weeks.
timeZone  Time zone for fiscal year start date, a valid 
time zone identifier ("GMT", "GMT-8", "America/New_York"). 
Default is the JVM system default time zone.

Example
Today’s month in fiscal calendar beginning Jan 30, 2000 with leap years in
2000, 2006, 2012, and 2017:

CALC.fiscalmonth544(CALC.today(), 2000, 1, 30, [2000, 2006, 
2012, 2017])

In a 5-4-4 fiscal calendar, a typical year has 52 weeks totalling 364 days:

• The first month of each quarter is 5 weeks

• The second month of each quarter is 4 weeks

• The third month of each quarter is 4 weeks

Every few years (as specified by array leapYears), the fiscal calendar
requires a 53-week year in order to reconcile with the solar year. In any
such leap year, the final month of the last quarter has 5 weeks. 

CALC.FISCALWEEK(DATE, STARTMONTH [,STARTDAY,TIMEZONE])

For a fiscal calendar defined by an arbitrary start date, returns the fiscal
week corresponding to the specified date as a number, e.g., “46”. The
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startMonth and optional startDay determine the starting point of the fiscal
year.

Parameters
date Date object to be converted to fiscal week.
startMonth Integer specifying the starting month of the 
fiscal calendar.
startDay Integer specifying the starting day of the 
fiscal calendar (defaults to 1).
timeZone  Time zone for fiscal year start date, a valid 
time zone identifier ("GMT", "GMT-8", "America/New_York"). 
Default is the JVM system default time zone.

Example
Today’s week in fiscal year beginning April 16:

CALC.fiscalweek(CALC.today(), 4, 16)

CALC.FISCALWEEK445(DATE, STARTYEAR, STARTMONTH, STARTDAY, 
LEAPYEARS[,TIMEZONE])

For a 4-4-5 fiscal calendar, returns the fiscal week corresponding to the
specified date as a number, e.g., “42”. The startYear, startMonth, and
startDay determine the starting point of the fiscal calendar. Leap years
must be explicitly specified by the array leapYears.

Parameters
date Date object to be converted to fiscal week.
startYear Integer specifying the starting year of the 
fiscal calendar.
startMonth Integer specifying the starting month of the 
fiscal calendar.
startDay Integer specifying the starting day of the 
fiscal calendar.
leapYears Array of years that contain 53 weeks.
timeZone  Time zone for fiscal year start date, a valid 
time zone identifier ("GMT", "GMT-8", "America/New_York"). 
Default is the JVM system default time zone.

Example
Today’s week in fiscal calendar beginning Jan 30, 2000 with leap years in
2000, 2006, 2012, and 2017:

CALC.fiscalweek445(CALC.today(), 2000, 1, 30, [2000, 2006, 
2012, 2017])

In a 4-4-5 fiscal calendar, a typical year has 52 weeks totalling 364 days:

• The first month of each quarter is 4 weeks

• The second month of each quarter is 4 weeks

• The third month of each quarter is 5 weeks



COMMON FUNCTION REFERENCE

949 of 1397

Every few years (as specified by array leapYears), the fiscal calendar
requires a 53-week year in order to reconcile with the solar year. In any
such leap year, the final month of the last quarter has 6 weeks. 

CALC.FISCALWEEK454(DATE, STARTYEAR, STARTMONTH, STARTDAY, 
LEAPYEARS[,TIMEZONE])

For a 4-5-4 fiscal calendar, returns the fiscal week corresponding to the
specified date as a number, e.g., “42”. The startYear, startMonth, and
startDay determine the starting point of the fiscal calendar. Leap years
must be explicitly specified by the array leapYears.

Parameters
date Date object to be converted to fiscal week.
startYear Integer specifying the starting year of the 
fiscal calendar.
startMonth Integer specifying the starting month of the 
fiscal calendar.
startDay Integer specifying the starting day of the 
fiscal calendar.
leapYears Array of years that contain 53 weeks.
timeZone  Time zone for fiscal year start date, a valid 
time zone identifier ("GMT", "GMT-8", "America/New_York"). 
Default is the JVM system default time zone.

Example
Today’s week in fiscal calendar beginning Jan 30, 2000 with leap years in
2000, 2006, 2012, and 2017:

CALC.fiscalweek454(CALC.today(), 2000, 1, 30, [2000, 2006, 
2012, 2017])

In a 4-5-4 fiscal calendar, a typical year has 52 weeks totalling 364 days:

• The first month of each quarter is 4 weeks

• The second month of each quarter is 5 weeks

• The third month of each quarter is 4 weeks

Every few years (as specified by array leapYears), the fiscal calendar
requires a 53-week year in order to reconcile with the solar year. In any
such leap year, the final month of the last quarter has 5 weeks. 

CALC.FISCALWEEK544(DATE, STARTYEAR, STARTMONTH, STARTDAY, 
LEAPYEARS[,TIMEZONE])

For a 5-4-4 fiscal calendar, returns the fiscal week corresponding to the
specified date as a number, e.g., “42”. The startYear, startMonth, and
startDay determine the starting point of the fiscal calendar. Leap years
must be explicitly specified by the array leapYears.
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Parameters
date Date object to be converted to fiscal week.
startYear Integer specifying the starting year of the 
fiscal calendar.
startMonth Integer specifying the starting month of the 
fiscal calendar.
startDay Integer specifying the starting day of the 
fiscal calendar.
leapYears Array of years that contain 53 weeks.
timeZone  Time zone for fiscal year start date, a valid 
time zone identifier ("GMT", "GMT-8", "America/New_York"). 
Default is the JVM system default time zone.

Example
Today’s week in fiscal calendar beginning Jan 30, 2000 with leap years in
2000, 2006, 2012, and 2017:

CALC.fiscalweek544(CALC.today(), 2000, 1, 30, [2000, 2006, 
2012, 2017])

In a 5-4-4 fiscal calendar, a typical year has 52 weeks totalling 364 days:

• The first month of each quarter is 5 weeks

• The second month of each quarter is 4 weeks

• The third month of each quarter is 4 weeks

Every few years (as specified by array leapYears), the fiscal calendar
requires a 53-week year in order to reconcile with the solar year. In any
such leap year, the final month of the last quarter has 5 weeks. 

CALC.HOUR(DATE)

Returns the hour of the day for the given date object.

Parameters
date Date object

Example
CALC.hour(new Date(2000,0,14,7,15,23)); 
// returns 7

CALC.MINUTE(DATE)

Returns the minute of the hour for the given date object.

Parameters
date Date object

Example
CALC.minute(new Date(2000,0,14,7,15,23)); 
// returns 15
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CALC.MONTH(DATE)

Returns the numeric month for the given date object. (January has value 1.)

Parameters
date Date object

Example
CALC.month(new Date(2000,1,21)); 
// returns 2 (February)

CALC.MONTHNAME(DATE)

Returns the name of the month for the given date object (e.g. “March”).

Parameters
date Date object

Example
CALC.monthname(new Date(1978,1,21)); 
// returns February

CALC.NETWORKDAYS(START_DATE, END_DATE[, HOLIDAY_ARRAY])

Returns the total number of working days between start_date and
end_date. If either start_date or end_date is itself a working day, that day
is also included in the total. Holiday_array is an optional array of dates to
be excluded from the working day count.

Parameters
start_date Date object: date on which to begin counting
end_date Date object: date on which to end counting
holiday_array Array of Dates to exclude from working day 
count

Example
Working days from Feb. 21, 1978 until today:

CALC.networkdays(new Date(1978,1,21), CALC.today()); 
// returns 9463 (assuming today is May 29, 2014)

CALC.NOW()

Returns the current date and time.

Example
CALC.now(); 
// returns current date and time (e.g., Thu May 29 15:45:59 
EDT 2014)

CALC.QUARTER(DATE)

Returns the quarter (1, 2, 3, or 4) corresponding to the given date.
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Parameters
date Date object

Example
CALC.quarter(new Date(2005, 11, 28));
// returns 4

CALC.SECOND(DATE)

Returns the seconds corresponding to the given date.

Parameters
date Date object

Example
CALC.second(CALC.today());
// returns 37 if CALC.today() is Thu May 29 16:12:37 EDT 
2014

CALC.TIME(HOUR, MINUTE, SECOND)

Returns a decimal between 0 and 1 representing the specified time as a
fraction of the 24-hour day. For example, time 0:00 has value 0.0, while
time 12:00 has value 0.5.

Parameters
hour Integer value for hour (24-hour time)
minute Integer value for minute
second Integer value for second

Example
CALC.time(0,0,0); // returns 0.0 (12am)
CALC.time(12,0,0); // returns 0.5 (12pm)
CALC.time(23,59,59)); // returns 0.9999884366989136
CALC.time(5,30,40); // returns 0.22962963581085205

CALC.TIMEVALUE(DATE)

Returns a decimal between 0 and 1 representing the time in the specified
date object as a fraction of the 24-hour day. For example, time 0:00 has
value 0.0, while time 12:00 has value 0.5.

Parameters
date Date object

Example
CALC.timevalue(new Date(2014,0,1,0,0,0)); // returns 0.0
CALC.timevalue(new Date(2014,0,1,12,0,0)) // returns 0.5
CALC.timevalue(new Date(2005,1,2,6,0,0)); // returns 0.25

CALC.TODAY()

Returns a date object containing the current date and time.
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Example
CALC.today();
// returns Tue Mar 17 17:43:02 EDT 2009 (for example)

CALC.WEEKDAY(DATE [,NUMBER])

Returns an integer representing the day of the week corresponding to the
specified date. Optional parameter number determines the value at which
indexing starts, and can have the following values:

• 1: Returns the day as a number representing Sunday (1) through 
Saturday (7). This is the default.

• 2: Returns the day as a number representing Monday (1) through 
Sunday (7).

• 3: Returns the day as a number representing Monday (0) through 
Sunday (6).

Parameters
date Date object
number A code (1,2,3) to specify starting index (see 
above)

Example
CALC.weekday(new Date(2006,0,18),2);
// returns 3 (Wednesday)

CALC.WEEKDAYNAME(DATE)

Returns the full name for the day of the week corresponding to the given
date (e.g., “Monday”).

Parameters
date Date object

Example
CALC.weekdayname(new Date(2006,0,18));
// returns Wednesday

CALC.WEEKNUM(DATE)

Returns the week number within the year for the given date. (The first
week of the year has index 1.)

Parameters
date Date object

Example
CALC.weeknum(new Date(2006,0,18));
// returns 3
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CALC.WORKDAY(DATE, DAYS, [HOLIDAY_ARRAY])

Returns a date representing the first workday following a period of working
days, specified by days, that begin on date. Optional parameter
Holiday_array specifies a list of dates to be excluded from the working day
count.

Parameters
date Date object: date on which to begin counting
days Number of working days to count
holiday_array Array of Dates to exclude from working day 
count

Example
First working day following six days from May 20, 2014:

CALC.workday(new Date(2014,4,20), 6) // returns Wed May 28

CALC.YEAR(DATE)

Returns the year corresponding to the given date.

Parameters
date Date object

Example
CALC.year(new Date(2005,11,1)); 
// returns 2005

CALC.YEARFRAC(START_DATE, END_DATE [, BASIS])

Returns a decimal value between 0 and 1 representing the number of days
between start_date and end_date as a fraction of the year. 

Parameters
start_date Date object: date on which to begin counting
end_date Date object: date on which to end counting
basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
CALC.yearfrac(new Date(2014,0,1), new Date(2015,0,1)); 
// returns 1.0
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CALC.yearfrac(new Date(2005,0,1), new Date(2005,5,30)); 
// returns 0.4972222149372101

JS.12.2Financial Functions

The CALC object provides the financial functions listed below.

CALC.ACCRINT(ISSUE, INTEREST, SETTLEMENT, RATE, PAR, FREQ [, 
BASIS])

Returns the accrued interest for a security that pays periodic interest. 

Parameters
issue Date object: The security’s issue date
interest Date object: The security’s first interest 
date
settlement Date object: The security’s settlement date
rate The security’s annual coupon rate
par The security’s par value
freq The number of coupon payments per year
basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
Interest accrued for a $1000 par value security with a 10% annual rate and
bi-annual payment, issue date of March 1, 2008, first interest date of
August 31, 2008, and settlement date of May 1, 2008.

CALC.accrint(new Date(2008,2,1), new Date(2008,7,31), new 
Date(2008,4,1), 0.1, 1000, 2); 
// returns 16.666666666666664

CALC.ACCRINTM(ISSUE, MATURITY, RATE, PAR, [BASIS])

Returns the accrued interest for a security that pays interest at maturity. 

Parameters
issue Date object: The security’s issue date
maturity Date object: The security’s maturity date
settlement Date object: The security’s settlement date
rate The security’s annual coupon rate
par The security’s par value
basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:
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• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
Interest accrued for a $1000 par value security with a 10% annual rate,
issue date of April 1, 2008, maturity date of June 15, 2008, using an Actual/
365 counting method.

CALC.accrintm(new Date(2008,3,1), new Date(2008,5,15), 0.1, 
1000, 3); 
// returns 20.54794520547945

CALC.AMORDEGRC(COST, DATE_PURCHASED, FIRST_PERIOD, 
SALVAGE, PERIOD, RATE, [BASIS])

Returns the depreciation of an asset for accounting year period on a
prorated basis according to the degressive method of the French accounting
system. This function is similar to the amorlinc() function except that the
depreciation coefficient is calculated based on the life of the asset:

• 0-2 years = 1

• 3-4 years = 1.5

• 5-6 years = 2

• > 6 years = 2.5

Parameters
cost Initial cost of the asset
date_purchased Date object: Asset purchase date
first_period Date object: End of the first period
salvage Salvage value at end of asset life
period Period (year) for which to return 
depreciation
rate Rate of depreciation
basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360
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Example
Depreciation over time of a $2400 asset purchased on August 19, 2008,
with first depreciation period ending December 31, 2008, end-of-life
salvage value of $300, 15% rate of depreciation, and Actual/360 counting
method.

var deprec = 0;
for(var period =0; period < 7; period++) {
deprec = CALC.amordegrc(2400, new Date(2008,7,19), new 

Date(2008,11,31), 300, period, 0.15, 2);
log('Period ' + period + ': Depreciation of ' + deprec);

}

// Returns:
// Period 0: Depreciation of 335
// Period 1: Depreciation of 774
// Period 2: Depreciation of 484
// Period 3: Depreciation of 303
// Period 4: Depreciation of 189
// Period 5: Depreciation of 158
// Period 6: Depreciation of 0

Depreciation during the first (fractional) period is given by:

cost * rate/100 * 
yearfrac(date_purchased,first_period,basis)

Depreciation during (whole) periods 1 and 2 is given by:

rate * cost

Depreciation during the final (fractional) period is the difference between
the asset’s value in the previous period and the asset’s salvage value. The
function returns 0 for periods after which the asset has already reached its
salvage value.

CALC.AMORLINC(COST, DATE_PURCHASED, FIRST_PERIOD, SALVAGE, 
PERIOD, RATE, [BASIS])

Returns the depreciation of an asset for accounting year period on a
prorated basis according to the linear depreciation method of the French
accounting system. This function is the same as the amordegrc() function
except in calculation of the depreciation coefficients. 

Parameters
cost Initial cost of the asset
date_purchased Date object: Asset purchase date
first_period Date object: End of the first 
depreciation period
salvage Salvage value at end of asset life
period Period (year index) for which to return 
depreciation. First period, from date_purchased to 
first_period, is index 0.
rate Rate of depreciation
basis Day count convention code (see above)
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Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
Depreciation over time on a $2400 asset purchased on August 19, 2008,
with first depreciation period ending December 31, 2008, end-of-life
salvage value of $300, 15% rate of depreciation, and Actual/360 counting
method.

var deprec = 0;
for(var period = 0; period < 10; period++) {
deprec = CALC.amorlinc(2400, new Date(2008,7,19), new 

Date(2008,11,31), 300, period, 0.15, 2);
log('Period ' + period + ': Depreciation of ' + deprec);

}

// Returns:
// Period 0: Depreciation of 133.99999737739563
// Period 1: Depreciation of 360
// Period 2: Depreciation of 360
// Period 3: Depreciation of 360
// Period 4: Depreciation of 360
// Period 5: Depreciation of 360
// Period 6: Depreciation of 166.00000262260437
// Period 7: Depreciation of 0
// Period 8: Depreciation of 0
// Period 9: Depreciation of 0

Depreciation during the first (fractional) period is given by:

cost * rate/100 * 
yearfrac(date_purchased,first_period,basis)

Depreciation during subsequent (whole) periods is given by:

rate * cost

Depreciation during the final (fractional) period is the difference between
the asset’s value in the previous period and the asset’s salvage value. The
function returns 0 for periods after which the asset has already reached its
salvage value.

CALC.COUPDAYBS(SETTLEMENT, MATURITY, FREQUENCY [,BASIS])

Returns the number of days from the most recent coupon date (preceding
settlement) to the settlement date.
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Parameters
settlement Date object: The security’s settlement 
date
maturity Date object: Security’s maturity date 
(date when security expires)
frequency Number of coupon payments per year 
(1=annual, 2=semi-annual, 4=quarterly)
basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
Number of days from coupon date to settlement date, where settlement date
is January 25, 2007, payments are made twice per year, maturity date is
November 15, 2008, and Actual/Actual counting convention is used.

CALC.coupdaybs(new Date(2007,0,25), new Date(2008,10,15), 
2, 1); 
// returns 71

With semi-annual payments, the coupon dates in this example are May 15
and November 15, hence the function returns the number of days from
coupon date November 15, 2006 to settlement date January 25, 2007,
equivalent to 

dateDiff('d',new Date(2006,10,15), new Date(2007,0,25))

CALC.COUPDAYS(SETTLEMENT, MATURITY, FREQUENCY, [BASIS])

Returns the number of days in the coupon period that contains the
settlement date. 

Parameters
settlement Date object: The security’s settlement 
date
maturity Date object: Security’s maturity date 
(date when security expires)
frequency Number of coupon payments per year 
(1=annual, 2=semi-annual, 4=quarterly)
basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual
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• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
Number of days in coupon period that includes settlement date of January
25, 2007, where payments are made twice per year, maturity date is
November 15, 2008, and Actual/Actual counting convention is used.

CALC.coupdays(new Date(2007,0,25), new Date(2008,10,15), 2, 
1); 
// returns 181

With semi-annual payments, the coupon dates in this example are May 15
and November 15, hence the function returns the number of days from
coupon date November 15, 2006 to coupon date May 15, 2007 (the span
that includes the settlement date).

CALC.COUPDAYSNC(SETTLEMENT, MATURITY, FREQUENCY, [BASIS])

Returns the number of days from the settlement date to the next coupon
date. 

Parameters
settlement Date object: The security’s settlement 
date
maturity Date object: Security’s maturity date 
(date when security expires)
frequency Number of coupon payments per year 
(1=annual, 2=semi-annual, 4=quarterly)
basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
Number of days from the settlement date of January 25, 2007 to the first
coupon date, where payments are made twice per year, maturity date is
November 15, 2008, and Actual/Actual counting convention is used.

CALC.coupdaysnc(new Date(2007,0,25), new Date(2008,10,15), 
2, 1); 
// returns 110
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With semi-annual payments, the coupon dates in this example are May 15
and November 15, hence the function returns the number of days from the
settlement date of January 25, 2007 to the first coupon date of May 15,
2007.

CALC.COUPNCD(SETTLEMENT, MATURITY, FREQUENCY, [BASIS])

Returns the first coupon date following the settlement date. 

Parameters
settlement Date object: The security’s settlement 
date
maturity Date object: Security’s maturity date 
(date when security expires)
frequency Number of coupon payments per year 
(1=annual, 2=semi-annual, 4=quarterly)
basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
First coupon date following settlement date of January 25, 2007, where
payments are made twice per year, maturity date is November 15, 2008,
and Actual/Actual counting convention is used.

CALC.coupncd(new Date(2007,0,25), new Date(2008,10,15), 2, 
1); 
// returns Tue May 15 00:00:00 EDT 2007

With semi-annual payments, the coupon dates in this example are May 15
and November 15, hence the function returns the first payment date of May
15, 2007.

CALC.COUPNUM(SETTLEMENT, MATURITY, FREQUENCY, [BASIS])

Returns the number of coupons payable between the settlement date and
maturity date, rounded up to the nearest whole coupon. 

Parameters
settlement Date object: The security’s settlement 
date
maturity Date object: Security’s maturity date 
(date when security expires)
frequency Number of coupon payments per year 
(1=annual, 2=semi-annual, 4=quarterly)



COMMON FUNCTION REFERENCE

962 of 1397

basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
Number of payments between settlement date of January 25, 2007 and
maturity date of November 15, 2008, where payments are made twice per
year, and Actual/Actual counting convention is used.

CALC.coupnum(new Date(2007,0,25), new Date(2008,10,15), 2, 
1); 
// returns 4

With semi-annual payments, the coupon dates in this example are May 15
and November 15, hence there are four payments issued between
settlement and maturity.

CALC.COUPPCD(SETTLEMENT, MATURITY, FREQUENCY, [BASIS])

Returns the coupon date that immediately precedes the settlement date. 

Parameters
settlement Date object: The security’s settlement 
date
maturity Date object: Security’s maturity date 
(date when security expires)
frequency Number of coupon payments per year 
(1=annual, 2=semi-annual, 4=quarterly)
basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
Coupon date preceding a settlement date of January 25, 2007, where
maturity date is November 15, 2008, payments are made twice per year,
and Actual/Actual counting convention is used.
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CALC.couppcd(new Date(2007,0,25), new Date(2008,10,15), 2, 
1); 
// returns Wed Nov 15 00:00:00 EST 2006

With semi-annual payments, the coupon dates in this example are May 15
and November 15, hence the coupon date preceding the settlement date is
November 15, 2006.

CALC.CUMIPMT(RATE, NPER, PV, START_PERIOD, END_PERIOD, TYPE)

Returns a negative value representing cumulative interest paid on a loan
between start_period and end_period, inclusive.

Parameters
rate Annual interest rate
nper Total number of monthly periods
pv Present value of loan
start_period Integer representing the initial period in the 
calculation
end_period Integer representing the final period in the 
calculation
type Timing of payment

0: payment at end of period
1: payment at start of period

Example
Cumulative interest paid on a 30-year loan taken at an annual rate of 9% for
periods 13 through 24, where each payment is made at the beginning of the
period.

CALC.cumipmt(0.09/12, 30 * 12, 125000, 13, 24, 1); 
// returns -11052.339583871808 

CALC.CUMPRINC(RATE, NPER, PV, START_PERIOD, END_PERIOD, TYPE)

Returns a negative value representing the cumulative principal paid on a
loan between start_period and end_period, inclusive. 

Parameters
rate Annual interest rate
nper Total number of monthly periods
pv Present value of loan
start_period Integer representing the initial period in the 
calculation
end_period Integer representing the final period in the 
calculation
type Timing of payment

0: payment at end of period
1: payment at start of period

Example
Cumulative principal paid on a 30-year loan taken at an annual rate of 9%
for periods 13 through 24, where each payment is made at the beginning of
the period.
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CALC.cumprinc(0.09/12, 30 * 12, 125000, 13, 24, 1); 
// returns -927.1534723780389

CALC.DB(COST, SALVAGE, LIFE, PERIOD, [MONTH])

Returns the depreciation of an asset for accounting year period using the
fixed-declining balance method. 

Parameters
cost Initial cost of the asset
salvage Salvage value at end of asset life
life Number of years of depreciation
period Period (year index) for which to return 
depreciation (in range 1 to life, inclusive)
month Number of months in the first year of 
depreciation (default=12)

Example
Depreciation on a $1,000,000 asset that has a lifetime of 6 years, and end-
of-life salvage value of $100,000, where the first year of depreciation
contains 7 months.

var deprec = 0;
for(var period = 1; period < 7; period++) {
deprec = CALC.db(1000000, 100000, 6, period, 7);
log('Period ' + period + ': Depreciation of ' + deprec);

}

// Returns:
// Period 1: Depreciation of 186083.33333333334
// Period 2: Depreciation of 259639.41666666666
// Period 3: Depreciation of 176814.44275000002
// Period 4: Depreciation of 120410.63551274998
// Period 5: Depreciation of 81999.64278418274
// Period 6: Depreciation of 55841.75673602846

The rate of depreciation is for a given year is

where numMonths is the number of months in the year. For the first
(fractional) year, numMonths is given by parameter month. For subsequent
full years, numMonths is 12.

Depreciation during the final (fractional) period is the difference between
the asset’s value in the previous period and the asset’s salvage value. The
function returns 0 for periods after which the asset has already reached its
salvage value.

CALC.DDB(COST, SALVAGE, LIFE, PERIOD, [FACTOR])

Returns the depreciation of an asset for accounting year period using the
double-declining balance method or some other factor. 

rate
numMonths

12
------------------------------- 
  1

salvage
cost

-------------------- 
  1 li fe

– 
 =
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Parameters
cost Initial cost of the asset
salvage Salvage value at end of asset life
life Number of years of depreciation
period Period (year index) for which to return 
depreciation (in range 1 to life, inclusive)
factor Rate at which the balance declines (default=2)

Example
Depreciation on a $1,000,000 asset that has a lifetime of 6 years and end-
of-life salvage value of $100,000.

var deprec = 0;
for(var period = 1; period < 7; period++) {
deprec = CALC.ddb(1000000, 100000, 6, period);
log('Period ' + period + ': Depreciation of ' + deprec);

}

// Returns:
// Period 1: Depreciation of 333333.3333333333
// Period 2: Depreciation of 222222.22222222225
// Period 3: Depreciation of 148148.14814814815
// Period 4: Depreciation of 98765.43209876546
// Period 5: Depreciation of 65843.62139917696
// Period 6: Depreciation of 31687.242798353895

The rate of depreciation for a given year is factor/life. If factor is
omitted, it is assumed to be 2 (the double-declining balance method).

CALC.DISC(SETTLEMENT, MATURITY, PR, REDEMPTION, [BASIS])

Returns the discount rate for a security. 

Parameters
settlement Date object: The security’s settlement date
maturity Date object: Security’s maturity date (date 
when security expires)
pr Security’s price per $100 face value
redemption Security’s redemption value per $100 face 
value
basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360
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Example
Discount rate for a security with price of $97.975, redemption value of
$100, settlement date of January 25, 2007, maturity date of June 15, 2007,
and Actual/Actual counting convention.

CALC.disc(new Date(2007, 0, 25), new Date(2007, 5, 15), 
97.975, 100, 1); 
// returns 0.0524202127659576 (approximately 5.24%)

The rate is calculated as follows:

rate = (redemption - pr) / (redemption * 
yearfrac(settlement; maturity; basis))

CALC.DURATION(SETTLEMENT, MATURITY, RATE, YLD, FREQUENCY, 
[BASIS])

Returns the Macaulay duration in years for a security with an assumed par
value of $100. Duration is the weighted average of the present value of the
cash flows and is used as a measure of a bond price’s response to changes
in yield. 

Parameters
settlement Date object: The security’s settlement date
maturity Date object: Security’s maturity date (date 
when security expires)
rate Security’s annual coupon rate
yld Security’s annual yield
frequency Number of coupon payments per year (1,2, or 4)
basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
Macaulay duration for a security with coupon rate of 8%, annual yield of
9%, settlement date of January 1, 2008, maturity date of January 1, 2016,
two coupon payments per year, and Actual/Actual counting convention.

CALC.duration(new Date(2008, 0, 1), new Date(2016, 0, 1), 
0.08, 0.09, 2, 1); 
// returns 5.993774955545185 (years)
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CALC.EFFECT(NOMINAL_RATE, NPERY)

Returns the effective annual interest rate, given the nominal annual interest
rate and the number of compounding periods per year. 

Parameters
nominal_rate Nominal interest rate
npery number of compounding periods per year

Example
Effective interest rate for a nominal rate of 5.25% with 4 compounding
periods per year.

CALC.effect(0.0525,4); 
// returns 0.05354266737075819 (approximately 5.35%)

CALC.FV(RATE, NPER, PMT, [PV], [TYPE])

Returns the future value of an investment based on periodic, constant
payments and a constant interest rate. 

Parameters
rate Interest rate per period
nper Total number of payment periods in an annuity
pmt constant payment made each period (default=0)
pv Present value (default=0)
type Timing of payment

0: payment at end of period (default)
1: payment at start of period

Typically, pmt contains principal and interest but no other fees or taxes. If
pmt is omitted (null), you must include the pv argument, the lump-sum
amount that a series of future payments is worth right now (for a loan, this
is the original loan amount). If pv is omitted (null), it is assumed to be 0
(typical for a bond) and you must include the pmt argument. 

Example
Future value of a $5000 loan with 6% annual interest rate, 10 payment
periods, and $300 payment at start of each period. (Note that payments are
entered as negative values.)

CALC.fv(0.06/12, 10, -300, 5000, 1); 
// returns -2171.9506981443483

The result indicates that payment of approximately $4762.75 will be
required at the end of the term. If no payments are made (pmt=0), then the
final payment will be $8954.24, as shown below.

CALC.fv(0.06/12, 10, 0, 5000, 1); 
// returns -5255.700660203947
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CALC.FVSCHEDULE(PRINCIPAL, SCHEDULE)

Returns the future value of an initial principal after applying a specified
series of compound interest rates. Use this function to calculate the future
value of an investment with a variable or adjustable rate.

Parameters
principal Present value
schedule Array of interest rates to apply

Example
Future value of a $5000 loan with variable rate of 5%, 6%, and 7% over the
three-year term. 

CALC.fvschedule(5000, [0.05,0.06,0.07]); 
// returns 5954.55

CALC.INTRATE(SETTLEMENT, MATURITY, INVESTMENT, REDEMPTION, 
[BASIS])

Returns the interest rate for a fully invested security without compounding. 

Parameters
settlement Date object: The security’s settlement date
maturity Date object: Security’s maturity date (date 
when security expires)
investment Amount paid for the security
redemption Security’s redemption value per $100 face 
value
basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
Effective interest rate without compounding for a security purchased at
$100 on January 1, 2008 and redeemed for $200 on January 1, 2016, with
Actual/Actual counting convention.

CALC.intrate(new Date(2008,0,1), new Date(2016,0,1), 100, 
200, 1)
// Returns 0.12525667351129363 (approximately 12.5%)
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CALC.IPMT(RATE, PER, NPER, PV, FV, TYPE)

Returns the interest in a given period’s payment for an investment based on
periodic constant payments and a constant interest rate. 

Parameters
rate Interest rate per period
per Period for which to return interest (between 1 
and nper)
nper Total number of payment periods in an annuity
pv Present value (positive for a loan, negative 
for an investment)
fv Desired cash balance after last payment
type Timing of payment

0: payment at end of period (default)
1: payment at start of period

The present value, pv, is the lump-sum amount that a series of future
payments is worth right now. The future value, fv, is a cash balance you
want to attain after the last payment is made (generally 0 for a loan). Use
CALC.ppmt(rate, per, nper, pv, fv, type) to calculate the portion of capital
in a given payment. Use CALC.pmt(rate, nper, pv, fv, type) to calculate the
total payment (capital and interest).

Example
Amount of interest in each of the first ten payments for an $8000 two-year
loan with 10% annual interest and payment at end of period. (The negative
values indicates that these are payments.)

for(var period=1; period<=10; period++){
log('Period ' + period +': ' + CALC.ipmt(0.1/12, period, 

12*2, 8000, 0, 0))
}

// Returns:
// Period 1: -66.66666666666667
// Period 2: -64.14589379972111
// Period 3: -61.60411449221768
// Period 4: -59.04115369048507
// Period 5: -56.45683488207135
// Period 6: -53.85098008358753
// Period 7: -51.223409828449675
// Period 8: -48.57394315451896
// Period 9: -45.902397591638874
// Period 10: -43.20858914906812

CALC.ISPMT(RATE, PER, NPER, PV)

Returns the interest paid during a given period for a fixed-rate investment
in which a constant amount of the principal is paid at the start of each
period. This function is provided for compatibility with Lotus 1-2-3. 

Parameters
rate Interest rate per period



COMMON FUNCTION REFERENCE

970 of 1397

per Period for which to return interest (between 1 
and nper)
nper Total number of payment periods in an annuity
pv Present value (positive for a loan, negative 
for an investment)

Example
Amount of interest in each of the first ten payments for an $8000 two-year
loan with 10% annual interest. (The negative values indicates that these are
payments.)

for(var period=1; period<=10; period++){
log('Period ' + period +': ' + CALC.ispmt(0.1/12, period, 

12*2, 8000))
}

// Returns:
// Period 1: -63.88888888888889
// Period 2: -61.111111111111114
// Period 3: -58.333333333333336
// Period 4: -55.555555555555564
// Period 5: -52.77777777777778
// Period 6: -50
// Period 7: -47.22222222222223
// Period 8: -44.44444444444445
// Period 9: -41.66666666666667
// Period 10: -38.88888888888889

CALC.MDURATION(SETTLEMENT, MATURITY, RATE, YLD, FREQUENCY, 
[BASIS])

Returns the modified Macaulay duration (in years) for a security with an
assumed par value of $100. This is the Macaulay duration divided by (1 +
yld/frequency), where Macaulay duration is given by
CALC.duration(settlement, maturity, rate, yld, frequency, [basis]).

Parameters
settlement Date object: The security’s settlement date
maturity Date object: Security’s maturity date (date 
when security expires)
rate Security’s annual coupon rate
yld Security’s annual yield
frequency Number of coupon payments per year (1,2, or 4)
basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360
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Example
Modified Macaulay duration for a security with coupon rate of 8%, annual
yield of 9%, settlement date of January 1, 2008, maturity date of January 1,
2016, two coupon payments per year, and Actual/Actual counting
convention.

CALC.mduration(new Date(2008, 0, 1), new Date(2016, 0, 1), 
0.08, 0.09, 2, 1); 
// returns 5.735669813918838 (years)

CALC.MIRR(VALUES, FINANCE_RATE, REINVEST_RATE)

Returns the modified internal rate of return for a series of periodic cash
flows. This function considers both the cost of the investment and the
interest received on reinvestment of cash. 

Parameters
values Array of numbers representing a series of 
payments (negative values) and income (positive values) 
occurring at regular periods. 
finance_rate Interest rate paid on money used in the cash 
flows
reinvest_rate Interest rate on reinvested cash flows 

The values array must contain at least one negative and one positive value.
Typically, for an investment, the first value is the (negative) amount of the
investment, and subsequent values are (positive) payments which are
reinvested at the reinvest_rate.

Example
Modified interest rate for an investment of $120,000 at a 10% interest rate,
where payments of $39,000, $30,000, $21,000, $37,000, and $46,000 are
reinvested at 12%.

CALC.mirr([-120000, 39000, 30000, 21000, 37000, 46000], 0.1, 
0.12); 
// returns 0.1260941303659051 (approximately 12.6%)

CALC.NOMINAL(EFFECT_RATE, NPERY)

Returns the nominal annual interest rate, given the effective compounded
rate and the number of compounding periods per year. 

Parameters
effect_rate Effective interest rate
nper Number of compounding periods per year

Example
Nominal rate for an investment with an effective rate of 5.3543%, where
interest is compounded four times per year.
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Example
CALC.nominal(0.053543, 4); 
// returns 0.052500319868356016 (approximately 5.25%)

CALC.NPER(RATE, PMT, PV, FV, TYPE)

Returns the number of periods for an investment based on periodic,
constant payments and a constant interest rate. 

Parameters
rate Interest rate per period
pmt Payment made each period; constant over life 
of annuity
pv Present value (positive for a loan, negative 
for an investment)
fv Desired cash balance after last payment
type Timing of payment

0: payment at end of period (default)
1: payment at start of period

Typically, pmt contains principal and interest but no other fees or taxes. The
present value, pv, is the lump-sum amount that a series of future payments
is worth right now. The future value, fv, is a cash balance you want to attain
after the last payment is made (generally 0 for a loan).

Example
Number of periods for an initial $1000 investment to grow to a future value
of $10,000 with 12% interest per period (compounded) and payments of
$100 at the start of each period. (Negative values indicate payments.)

CALC.nper(0.12, -100, -1000, 10000, 1); 
// returns 15.288014619990111 (approximately 15 periods)

CALC.NPV(RATE, VALUES)

Returns the net present value of an investment by using a discount rate and
a series of future payments (negative values) and income (positive values).

Parameters
rate Discount rate over a period
values Array of payment and income values

Example
Net present value of an investment, under an assumed discount rate of
10%, that has first period payment (investment) of $10,000, second period
income of $3000, third period income of $4200, and fourth period income
of $6800.

CALC.npv(0.10, [-10000, 3000, 4200, 6800]); 
// returns 1188.4434123352207 ($1,188.44 present value)
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CALC.PMT(RATE, NPER, PV, FV, TYPE)

Returns the periodic payment for a loan based on constant payments and a
constant interest rate. 

Parameters
rate Interest rate per period
nper Total number of monthly payments for the loan
pv Present value (positive for a loan, negative 
for an investment)
fv Desired cash balance after last payment
type Timing of payment

0: payment at end of period (default)
1: payment at start of period

Typically, pmt contains principal and interest but no other fees or taxes. The
present value, pv, is the lump-sum amount that a series of future payments
is worth right now. The future value, fv, is a cash balance you want to
attain after the last payment is made (generally 0 for a loan). Use
CALC.ppmt(rate, per, nper, pv, fv, type) to calculate the portion of capital
in a given payment. Use CALC.ipmt(rate, per, nper, pv, fv, type) to
calculate the portion of interest in a given payment.

Example
Payment at start of each period for a $10,000 2-year loan with 8% interest
per period. (Negative values indicate payments.)

CALC.pmt(0.08/12, 24, 10000, 0, 1); 
// returns -449.27772969719734 (approximately $449.28 per 
period)

CALC.PPMT(RATE, PER, NPER, PV, FV, TYPE)

Returns the capital in a given period’s payment for an investment based on
periodic constant payments and a constant interest rate. 

Parameters
rate Interest rate per period
per Period for which to return capital repayment 
(between 1 and nper)
nper Total number of payment periods in an annuity
pv Present value (positive for a loan, negative 
for an investment)
fv Desired cash balance after last payment
type Timing of payment

0: payment at end of period (default)
1: payment at start of period

The present value, pv, is the lump-sum amount that a series of future
payments is worth right now. The future value, fv, is a cash balance you
want to attain after the last payment is made (generally 0 for a loan). Use
CALC.ipmt(rate, per, nper, pv, fv, type) to calculate the portion of interest
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in a given payment. Use CALC.pmt(rate, nper, pv, fv, type) to calculate the
total payment (capital and interest).

Example
Amount of capital repaid in each of the first ten payments for an $8000
two-year loan with 10% annual interest and payment at end of period. (The
negative values indicates that these are payments.)

for(var period=1; period<=10; period++){
log('Period ' + period +': ' + CALC.ppmt(0.10/12, period, 

12*2, 8000, 0, 0))
}

// Returns:
// Period 1: -302.4927440334672
// Period 2: -305.0135169004128
// Period 3: -307.55529620791623
// Period 4: -310.1182570096488
// Period 5: -312.70257581806254
// Period 6: -315.3084306165464
// Period 7: -317.9360008716842
// Period 8: -320.58546754561496
// Period 9: -323.257013108495
// Period 10: -325.95082155106576

CALC.PRICE(SETTLEMENT, MATURITY, RATE, YLD, REDEMPTION, 
FREQUENCY, [BASIS])

Returns the clean price per $100 face value of a security that pays periodic
interest. 

Parameters
settlement Date object: The security’s settlement date
maturity Date object: Security’s maturity date (date 
when security expires)
rate Security’s annual coupon rate
yld Security’s annual yield
redemption Security’s redemption value per $100 face 
value
frequency Number of coupon payments per year (1,2, or 4)
basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
Clean price for a security with coupon rate of 5.75%, annual yield of 6.5%,
redemption price of $100, settlement date of February 15, 2008, maturity
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date of October 15, 2017, two coupon payments per year, and US 30/360
counting convention.

CALC.price(new Date(2008,1,15), new Date(2017,10,15), 
0.0575, 0.065, 100, 2, 0); 
// returns 94.63436162132213 (approximately $94.63)

CALC.PRICEDISC(SETTLEMENT, MATURITY, DISCOUNT, REDEMPTION, 
[BASIS])

Returns the price per $100 face value of a discounted security (zero-coupon
bond). 

Parameters
settlement Date object: The security’s settlement date
maturity Date object: Security’s maturity date (date 
when security expires)
discount Security’s discount rate
redemption Security’s redemption value per $100 face 
value
basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
Price for a bond with par value of $100, discount rate of 5.75%, settlement
date of February 15, 2008, maturity date of October 15, 2017, and US 30/
360 counting convention.

CALC.pricedisc(new Date(2008,1,15), new Date(2017,10,15), 
0.0575, 100, 0); 
// returns 43.9375 (approximately $43.94)

CALC.PRICEMAT(SETTLEMENT, MATURITY, ISSUE, RATE, YLD, [BASIS])

Returns the price per $100 face value of a security that pays interest at
maturity. 

Parameters
settlement Date object: The security’s settlement date
maturity Date object: Security’s maturity date (date 
when security expires)
issue Date object: Security’s issue date
rate Security’s annual coupon rate (paid at 
maturity)
yld Security’s annual yield
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basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
Price for a security with coupon rate of 6.1%, annual yield of 6.1%,
settlement date of February 15, 2008, maturity date of April 13, 2008, issue
date of November 11, 2007, and US 30/360 counting convention.

CALC.pricemat(new Date(2008,1,15), new Date(2008,3,13), new 
Date(2007, 10, 11), 0.061, 0.061, 0); 
// returns 99.98449887555694 (approximately $99.98)

CALC.PV(RATE, NPER, PMT, FV, TYPE)

Returns the present value of an investment. The present value, pv, is the
lump-sum amount that a series of future payments is worth right now. 

Parameters
rate Interest rate per period
nper Total number of payment periods in an annuity
pmt Fixed payment made each period
fv Desired cash balance after last payment
type Timing of payment

0: payment at end of period (default)
1: payment at start of period

Typically, pmt includes principal and interest but no other fees or taxes. The
future value, fv, is a cash balance you want to attain after the last payment
is made (generally 0 for a loan). 

Example
Present value of a 20-year loan with interest rate of 8% and payments of
$500 at the end of each period. (Payments are negative, income is positive.)

CALC.pv(0.08/12, 20*12, -500, 0, 0); 
// returns 59777.145851187764 (approximately $59,777.15)

CALC.RECEIVED(SETTLEMENT, MATURITY, INVESTMENT, DISCOUNT, 
[BASIS])

Returns the amount received at maturity for a fully invested security with
no interest payments. 
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Parameters
settlement Date object: The security’s settlement date
maturity Date object: Security’s maturity date (date 
when security expires)
investment Amount invested in the security
discount Security’s discount rate
basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
Amount received at maturity for a $1,000,000 investment made at 5.75%,
with settlement date of February 15, 2008, maturity date of May 15, 2008,
and Actual/360 counting convention.

CALC.received(new Date(2008,1,15), new Date(2008,4,15), 
1000000, 0.0575, 2); 
// returns 1014584.6544071021 (approximately $1,014,584.65)

CALC.SLN(COST, SALVAGE, LIFE)

Returns the straight-line depreciation of an asset for one period (year).

Parameters
cost Initial cost of the asset
salvage Salvage value at end of asset life
life Number of years of depreciation

Example
Depreciation on a $1,000,000 asset that has a lifetime of 6 years and end-
of-life salvage value of $100,000.

CALC.sln(1000000, 100000, 6);
// Returns 150000.0 ($150,000 depreciation per year)

CALC.SYD(COST, SALVAGE, LIFE, PER)

Returns the sum-of-years’ digits depreciation of an asset for a specified
period.

Parameters
cost Initial cost of the asset
salvage Salvage value at end of asset life
life Number of years of depreciation
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per Period for which to return depreciation (in 
range 1 to life, inclusive)

Example
Depreciation on a $30,000 asset that has a lifetime of 10 years and end-of-
life salvage value of $7,500.

for(var period=1; period<=10; period++){
log('Period ' + period +': ' + CALC.syd(30000, 7500, 10, 

period))
}

// Returns:
// Period 1: 4090.909090909091
// Period 2: 3681.818181818182
// Period 3: 3272.7272727272725
// Period 4: 2863.6363636363635
// Period 5: 2454.5454545454545
// Period 6: 2045.4545454545455
// Period 7: 1636.3636363636363
// Period 8: 1227.2727272727273
// Period 9: 818.1818181818181
// Period 10: 409.09090909090907

CALC.TBILLEQ(SETTLEMENT, MATURITY, DISCOUNT)

Returns the bond-equivalent yield (BEY) for a Treasury bill using the 360-
day year convention. 

Parameters
settlement Date object: T-bill’s settlement date
maturity Date object: T-bill’s maturity date
discount  T-bill’s discount rate

Example
Required bond yield (payable at maturity) to match a Treasury bill with
9.14% discount rate, settlement date of March 31, 2008, and maturity date
of June 1, 2008.

CALC.tbilleq(new Date(2008, 2, 31), new Date(2008, 5,1), 
0.0914); 
// returns 0.09415149356594303 (approximately 9.42%)

CALC.TBILLPRICE(SETTLEMENT, MATURITY, DISCOUNT)

Returns the issue price per $100 face value for a Treasury bill using the
360-day year convention. The settlement and maturity dates must be
within one calendar year of each other.

Parameters
settlement Date object: T-bill’s settlement date
maturity Date object: T-bill’s maturity date
discount  T-bill’s discount rate
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Example
Issue price of a Treasury bill with 9.14% discount rate, settlement date of
March 31, 2008, and maturity date of June 1, 2008.

CALC.tbillprice(new Date(2008, 2, 31), new Date(2008, 5,1), 
0.0914); 
// returns 98.42588888888889 (approximately $98.43 per $100 
face value)

CALC.TBILLYIELD(SETTLEMENT, MATURITY, PR)

Returns the yield for a Treasury bill using the 360-day year convention.
The settlement and maturity dates must be within one calendar year of
each other.

Parameters
settlement Date object: T-bill’s settlement date
maturity Date object: T-bill’s maturity date
pr T-bill’s issue price per $100 face value

Example
Yield for a Treasury bill purchased at $98.45 per $100 face value,
settlement date of March 31, 2008, and maturity date of June 1, 2008.

Example
CALC.tbillyield(new Date(2008, 2, 31), new Date(2008, 5,1), 
98.45); 
// returns 0.09141696292534264 (approximately 9.14%)

CALC.VDB(COST, SALVAGE, LIFE, START_PERIOD, END_PERIOD, 
FACTOR, NO_SWITCH)

Returns the depreciation of an asset over an arbitrary period using the
variable-declining balance method. 

Parameters
cost Initial cost of the asset
salvage Salvage value at end of asset life
life Number of years of depreciation
start_period Real number representing the initial period in 
the calculation (in range 0 to end_period, inclusive)
end_period Real number representing the final period in 
the calculation (in range start_period to life, inclusive)
factor Rate at which the balance declines (default=2)
no_switch true: always use variable-declining balance 
calculation

false: switch to straight-line depreciation 
when result is greater than declining-balance calculation 
(default)

The rate of depreciation for a given year is factor/life. If factor is
omitted, it is assumed to be 2 (the double-declining balance method).
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Example
Depreciation over the first 5 years (period 0 to period 5) for an asset
purchased at $2400, with salvage value of $300 after 10 years, and
depreciation factor of 1.5.

CALC.vdb(2400, 300, 10, 0, 5, 1.5); 
// returns 975.1072500000002 (approximately $975.11)

CALC.XNPV(RATE, VALUES, DATES)

Returns the net present value for a schedule of cash flows that is not
necessarily periodic, based on a 365-day year.

Parameters
rate Discount rate to apply to the cash flows
values Array of numbers representing a series of 
payments (negative values) and income (positive values) 
occurring at the specified dates
dates Array of dates on which payments are made 
(first value must be the earliest date)

The array of values must contain at least one positive value and one
negative value. Typically, for an investment, the first value is the (negative)
amount of the investment, and subsequent values are (positive) payments.

The dates array can list the dates in any order so long as the first item is the
earliest date in the series.

Example
Net present value for a $10,000 investment made on January 1, 2008 at a
9% interest rate, where the following subsequent payment are made: 

  – $2,750 on March 1, 2008
  – $4,250 on October 30, 2008
  – $3,250 on February 15, 2009
  – $2,750 on April 1, 2009

CALC.xnpv(0.09, [-10000, 2750, 4250, 3250, 2750],[new 
Date(2008, 0, 1),new Date(2008, 2, 1),new Date(2008, 9, 
30),new Date(2009, 1, 15), new Date(2009, 3, 1)]); 
// returns 2086.647602031535 (approximately $2,086.65)

CALC.YIELDDISC(SETTLEMENT, MATURITY, PR, REDEMPTION, [BASIS])

Returns the annual yield for a discounted security that does not pay interest. 

Parameters
settlement Date object: The security’s settlement date
maturity Date object: Security’s maturity date (date 
when security expires)
pr Security’s price per $100 face value
redemption Security’s redemption value per $100 face 
value
basis Day count convention code (see below)
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Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
Yield for a bond with price of $99.79, redemption value of $100, settlement
date of February 16, 2008, maturity date of March 1, 2008, and Actual/360
counting convention.

CALC.yielddisc(new Date(2008, 1, 16), new Date(2008, 2,1), 
99.79, 100, 2); 
// returns 0.054113638641144796 (approximately 5.41%)

CALC.YIELDMAT(SETTLEMENT, MATURITY, ISSUE, RATE, PR, [BASIS])

Returns the annual yield of a security that pays interest only at maturity.

Parameters
settlement Date object: The security’s settlement date
maturity Date object: Security’s maturity date (date 
when security expires)
issue Date object: Security’s issue date
rate Security’s interest rate at date of issue
pr Security’s price per $100 face value
basis Day count convention code (see below)

Optional parameter basis indicates the day count convention:

• 0: US 30/360 (default)

• 1: Actual/Actual

• 2: Actual/360

• 3: Actual/365

• 4: European 30/360

Example
Yield for a 6.25% bond with price of $100.00, issue date of November 8,
2007, settlement date of March 15, 2008, maturity date of November 3,
2008, and US 30/360 counting convention.

CALC.yieldmat(new Date(2008, 2, 15), new Date(2008, 10,3), 
new Date(2007, 10,8), 0.0625, 100.00, 0); 
// returns 0.06115169016476979 (approximately 6.12%)
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JS.12.3Logical Functions

The CALC object provides the logical functions listed below.

CALC.AND(BOOLEAN_1, BOOLEAN_2, …, BOOLEAN_N)

Returns true only if all arguments evaluate to true, otherwise returns
false. 

Parameters
boolean_1 Boolean, or expression that evaluates to 
Boolean
boolean_2 Boolean, or expression that evaluates to 
Boolean
boolean_n Boolean, or expression that evaluates to 
Boolean

Example
CALC.and((0<3),(-1>2),(5<6))
// returns false

CALC.IIF(CONDITION, VALUE_IF_TRUE, VALUE_IF_FALSE)

Returns value_if_true if condition evaluates to true, and returns
value_if_false if condition evaluates to false. This is similar to the
JavaScript ternary operator, which can also be used for this purpose.

Parameters
condition Logical condition to test
value_if_true Expression to evaluate if condition is true
value_if_falseExpression to evaluate if condition is false

Example
for(var value=-2; value<=2; value++) {
log(CALC.iif(value < 0, "less than 0", "greater than or 

equal to 0"))
}

// Returns: 
// less than 0
// less than 0
// greater than or equal to 0
// greater than or equal to 0
// greater than or equal to 0

CALC.NOT(BOOLEAN)

Reverses the value of the Boolean argument. This is similar to the
JavaScript “!” operator, which can also be used for this purpose.

Parameters
boolean Boolean value to reverse

Example
CALC.not(0<3)

https://developer.mozilla.org/en-US/docs/Web/JavaScript/Reference/Operators/Conditional_Operator
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// returns false

CALC.OR(BOOLEAN_1, BOOLEAN_2, ...., BOOLEAN_N)

Returns true if one or more of the arguments evaluate to true, otherwise
returns false. 

Parameters
boolean_1 Boolean, or expression that evaluates to 
Boolean
boolean_2 Boolean, or expression that evaluates to 
Boolean
boolean_n Boolean, or expression that evaluates to 
Boolean

Example
CALC.or((0<3),(-1>2),(5<6))
// returns true

JS.12.4Math Functions

This section presents the math functions provided by the CALC object.

CALC.ABS(NUMBER)

Returns the absolute value of a number.

Parameters
number A numerical value

Example
CALC.abs(-6)
// returns 6.0

CALC.ACOS(NUMBER)

Returns the inverse cosine of a number in radians.

Parameters
number A numerical value between -1 and 1

Example
CALC.acos(-1)
// returns 3.141592653589793 (pi radians)

CALC.ACOSH(NUMBER)

Returns the inverse hyperbolic cosine of a number.

Parameters
number A numerical value greater than or equal to 1

Example
CALC.acosh(10)



COMMON FUNCTION REFERENCE

984 of 1397

// returns 2.993222846126381

CALC.ASIN(NUMBER)

Returns the inverse sine of a number in radians.

Parameters
number A numerical value between -1 and 1

Example
CALC.asin(1); 
// returns 1.5707963267948966 (pi/2 radians)

CALC.ASINH(NUMBER)

Returns the inverse hyperbolic sine of an number.

Parameters
number A numerical value greater than or equal to 1

Example
CALC.asinh(77);
// returns 5.03699476537355

CALC.ATAN(NUMBER)

Returns the inverse tangent of a number in radians.

Parameters
number A numerical value

Example
CALC.atan(1);
// returns 0.7853981633974475 (pi/4 radians)

CALC.ATAN2(NUMBERX, NUMBERY)

Returns the inverse tangent of the point represented by the specified x and y
co-ordinates, in radians.

Parameters
numberX X coordinate
numberY Y coordinate

Example
CALC.atan2(1,1);
// 0.7853981633974475 (pi/4 radians)

CALC.ATANH(NUMBER)

Return the inverse hyperbolic tangent of a number in radians.
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Parameters
number A numerical value between -1 and 1 (exclusive)

Example
CALC.atanh(0.5);
// returns 0.5493061443340549

CALC.CEILING(NUMBER, SIGNIFICANCE)

Returns number rounded away from zero to the nearest multiple of
significance. Positive numbers are rounded up, negative numbers are
rounded down.

Parameters
number Number to round
significance Rounding interval (must have same sign as 
number)

Example
CALC.ceiling(4.43, 0.05);
// returns 4.45

CALC.COMBIN(TOTALNUMBER, GROUPNUMBER)

Returns the number of unique combinations in which a set of elements can
be combined into groups of a given size.

Parameters
totalNumber Total number of elements available to combine
groupNumber Size of groups into which elements are 
combined

Example
Number of unique ways that 10 items can be combined into groups of two:

CALC.combin(10, 2);
// returns 45.0

CALC.COS(NUMBER)

Returns the cosine of a number representing an angle in radians.

Parameters
number An angle in radians

Example
CALC.cos(pi())
// returns -1.0

CALC.COSH(NUMBER)

Return the hyperbolic cosine of any real number.
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Parameters
number A real number

Example
CALC.cosh(2.7)
// returns 7.473468618806294

CALC.DEGREES(NUMBER)

Converts a number representing an angle in radians to degrees.

Parameters
number An angle in radians

Example
CALC.degrees(pi()/2);
// returns 89.99999999999991 (approximately 90 degrees)

CALC.EVEN(NUMBER)

Rounds a number away from 0 to the nearest even integer. Positive values
are rounded up, negative values are rounded down.

Parameters
number A number to round

Example
CALC.even(14.1);
// returns 16

CALC.EXP(NUMBER)

Returns the value of the natural exponential function, ex, where e is the base
of the natural logarithm and x is a specified number.

Parameters
number Exponent

Example
CALC.exp(3.2);
// returns 24.532530197109352

CALC.FACT(NUMBER)

Returns the factorial of a number. (The factorial of 0 is 1 by definition.)

Parameters
number Non-negative value (n) for which to compute 
factorial (n!). Any fractional component is ignored.

Example
CALC.fact(5);
// returns 120.0 (5x4x3x2x1)
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CALC.FACTDOUBLE(NUMBER)

Returns the double factorial of a number, n. 

• If n is even, n!! = n(n-2)(n-4)...(4)(2). The double factorial of 0 is 1.

• If n is odd, n!! = n(n-2)(n-4)...(3)(1) 

Parameters
number Non-negative value (n) for which to compute 
double factorial (n!!). Any fractional component is ignored.

Example
CALC.factdouble(6);
// returns 48.0

CALC.FLOOR(NUMBER, SIGNIFICANCE)

Returns number rounded toward zero to the nearest multiple of
significance. Positive numbers are rounded down, negative numbers are
rounded up.

Parameters
number Number to round
significance Rounding interval (must have same sign as 
number)

Example
CALC.floor(4.43, 0.05);
// returns 4.4

CALC.GCD(ARRAY)

Returns the greatest common divisor of an array of non-negative numbers.
Non-integer values are truncated.

Parameters
array Array of non-negative numbers for which to 
find GCD

Example
CALC.gcd([24, 32, 16, 12]);
// returns 4

CALC.INTEGER(NUMBER)

Rounds number down to the nearest integer.

Parameters
number Number to round

Example
CALC.integer(15.9);
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// returns 15

CALC.LCM(ARRAY)

Returns the least common multiple of an array of non-negative numbers.
Non-integer values are truncated.

Parameters
array Array of positive integers for which to find 
LCM

Example
CALC.lcm([24, 32, 16, 12]);
// returns 96

CALC.LN(NUMBER)

Returns the natural logarithm of a positive number (base e).

Parameters
number Positive real number

Example
CALC.ln(Math.E); 
// returns 1.0

CALC.LOG(NUMBER, BASE)

Returns the logarithm of a positive number to the specified base.

Parameters
number Positive number
base Base of the logarithm, a positive real number

Example
CALC.log(64, 4); 
// returns 3.0

CALC.LOG10(NUMBER)

Returns the logarithm of a positive number to the base 10.

Parameters
number Positive real number

Example
CALC.log10(100); 
// returns 2.0

CALC.MDETERM(ARRAY)

Returns the matrix determinant of the specified square matrix (two-
dimensional array).
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Parameters
array A 2D array representing a square matrix

Example
CALC.mdeterm([[1,0,0],[0,1,0],[0,0,1]]);
// returns 1.0

CALC.MINVERSE(ARRAY)

Returns the inverse of a nonsingular square matrix (two-dimensional
array).

Parameters
array A 2D array representing a nonsingular square 
matrix

Example
var inv = CALC.minverse([[1,0,1],[0,1,1],[0,0,1]]);
for (var i=0;i<=2;i++){
log(inv[i].join(","))

}

// Returns:
// 1,0,-1
// 0,1,-1
// 0,0,1

CALC.MMULT(ARRAY1, ARRAY2)

Returns the product of two conformable matrices, array1*array2, each
represented as a two-dimensional array.

Parameters
array1 A 2D array representing the left matrix
array2 A 2D array representing the right matrix

Example
var matrixA = [[1,2],[3,4]];
var matrixB = [[5,6,7],[8,9,0]];
var prod = CALC.mmult(matrixA, matrixB);
for (var i=0;i<=1;i++){
log(prod[i].join(","))

}

// Returns:
// 21,24,7
// 47,54,21

CALC.MOD(NUMBER, DIVISOR)

Returns the remainder when number is divided by divisor.

Parameters
number Real number to be divided
divisor Real number by which to divide
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Example
log(CALC.mod(3, 2))
// Returns 1.0

CALC.MROUND(NUMBER, FACTOR)

Returns number rounded to the nearest multiple of factor.

Parameters
number Number to round
factor Number multiplied to obtain rounding 
increments

Example
CALC.mround(10, 3);
// returns 9

CALC.mround(10.1, 3.3);
// returns 9.899999999999999

CALC.MULTINOMIAL(ARRAY)

Returns the ratio of the factorial of a sum of values to the product of their
factorials. For three numbers a, b, and c the multinomial is given by

Non-integer values are truncated.

Parameters
array Array of positive integers for which to 
compute multinomial

Example
CALC.multinomial([2,3,4]);
// returns 1260.0

CALC.ODD(NUMBER)

Rounds a number away from 0 to the nearest odd integer. Positive values
are rounded up, negative values are rounded down.

Parameters
number A number to round

Example
CALC.odd(13.1);
// returns 15

CALC.PI()

Returns the number , accurate to 15 digits.

a b c+ + !
a!b!c!

----------------------------
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Example
CALC.pi();
// returns 3.14159265358979

CALC.POWER(NUMBER, POWER)

Returns the result of a number raised to a power, bn.

Parameters
number The base b
power The exponent n

Example
CALC.power(2,3);
// returns 8.0

CALC.PRODUCT(ARRAY)

Returns the product of all the elements in an array.

Parameters
array Array of elements to multiply

Example
CALC.product([2,3,4,5]);
// returns 120.0

CALC.QUOTIENT(NUMERATOR, DENOMINATOR)

Returns the integer portion of the quotient numerator/denominator.

Parameters
numerator The numerator
denominator The non-zero denominator

Example
CALC.quotient(5,2);
// returns 2

CALC.RADIANS(NUMBER)

Converts a number representing an angle in degrees to radians.

Parameters
number An angle in degrees

Example
CALC.radians(90);
// returns 1.5707963267948966 (/2 radians)

CALC.ROMAN(NUMBER)

Converts an Arabic numeral to Roman numeral, as text.
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Parameters
number An number in Arabic (standard) numerals

Example
CALC.roman(77);
// returns LXXVII

CALC.ROUND(NUMBER, NUM_DIGITS)

Rounds a number to a specified number of digits.

Parameters
number Number to round
num_digits Number of digits (to right of decimal point) 
to preserve after rounding

Example
CALC.round(2.15, 1);
// returns 2.2

CALC.ROUNDDOWN(NUMBER, NUM_DIGITS)

Rounds a number toward zero to a specified number of digits. Positive
number are rounded down, negative numbers are rounded up.

Parameters
number Number to round
num_digits Number of digits (to right of decimal point) 
to preserve after rounding

Example
CALC.rounddown(3.14159, 3);
// returns 3.141

CALC.ROUNDUP(NUMBER, NUM_DIGITS)

Rounds a number away from zero to a specified number of digits. Positive
number are rounded up, negative numbers are rounded down.

Parameters
number Number to round
num_digits Number of digits (to right of decimal point) 
to preserve after rounding

Example
CALC.roundup(3.14159, 3);
// returns 3.142

CALC.SERIESSUM(X, N, M, COEFFICIENTS)

Returns the following power series sum: 

a0x
n

a1x
n m+ 

a2x
n 2m+   aix

n im+ 
+ + + +
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Parameters
x The base x
n Integer exponent in first term
m Integer interval by which to increase exponent 
n in subsequent terms
coefficients Array of coefficients [a0, a1, a2, ..., ai]

Example
CALC.seriessum(2, 0, 1, [1,2,3]);
// returns 17.0

CALC.SIN(NUMBER)

Returns the sine of the given angle specified in radians.

Parameters
number An angle in radians

Example
CALC.sin(pi())
// returns 3.2310891488651735E-15 (approximately 0)

CALC.SINH(NUMBER)

Returns the hyperbolic sine of any real number.

Parameters
number A real number

Example
CALC.sinh(5.5)
// returns 122.34392274639096

CALC.SQRT(NUMBER)

Returns the square root of a positive number.

Parameters
number A positive number

Example
CALC.sqrt(5.5)
// returns 2.345207879911715

CALC.SQRTPI(NUMBER)

Returns the square root of a positive number multiplied by 
sqrt(number*pi()).

Parameters
number A positive number
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Example
CALC.sqrtpi(5.5)
// returns 4.156772737923478

CALC.SUBTOTAL(FUNCTIONNUMBER, ARRAY)

Returns the subtotal of an array based on the specified aggregation
function.

Parameters
functionNumber Aggregation function

1: Average of items
2: Count of items
3: Count of non-null items
4: Maximum value of items
5: Minimum value of items
6: Product of items
7: Sample standard deviation of items
8: Population standard deviation of 

items
9: Sum of items
10: Sample variance of items
11: Population variance of items

array Array of numbers

Example
CALC.subtotal(1, [1,2,3]);
// returns 2.0

CALC.SUM(ARRAY)

Returns the sum of all the elements in an array.

Parameters
array Array of elements to sum

Example
CALC.sum([2,3,4,5]);
// returns 14.0

CALC.SUMIF(ARRAY1, CONDITIONSTRING, ARRAY2)

Returns the sum of the elements in array2 corresponding to elements in
array1 that satisfy the condition given by conditionString. Examples of
valid condition strings are '>30000', '=4000', and '<3500'. 

Parameters
array1 Array of elements to test against 
condition
conditionString String: Condition to test
array2 Array containing values to sum

Example
Sum the values in array [1,2,3,4,5] having same positions as the values in
array [10,25,30,15,45] that are greater than 20.
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CALC.sumif([10,25,30,15,45], '> 20',[1,2,3,4,5]);
// returns 10.0 (i.e., 2+3+5)

CALC.SUMPRODUCT(2DARRAY)

Multiplies corresponding row components of a two-dimensional array
(matrix) and returns the sum of those products. For example, for a matrix

this returns the result adg+beh+cfi.

Parameters
2Darray 2D array of values

Example
CALC.sumproduct([[1,2,3],[2,1,2],[3,3,1]]);
// returns 18.0

CALC.SUMSQ(ARRAY)

Returns the sum of the squares of all the elements in the array.

Parameters
array Array of values

Example
CALC.sumsq([1,2,3]);
// returns 14.0

CALC.SUMX2MY2(ARRAY1, ARRAY2)

Returns the sum of the difference of squares of corresponding values in two
arrays. For arrays [a1,a2,a3,...,an] and [b1,b2,b3,...,bn], the result
gives

Parameters
array1 An array of values [a1,a2,...,an]
array2 An array of values [b1,b2,...,bn]

Example
CALC.sumx2my2([1,2,3],[4,5,6]);
// returns -63.0

a b c

d e f

g h i

a1
2

b1
2

–  a2
2

b2
2

–  a3
2

b3
2

–   an
2

bn
2

– + + + +
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CALC.SUMX2PY2(ARRAY1, ARRAY2)

Returns the sum of the sum of squares of corresponding values in two
arrays. For arrays [a1,a2,a3,...,an] and [b1,b2,b3,...,bn], the result
gives

Parameters
array1 An array of values [a1,a2,...,an]
array2 An array of values [b1,b2,...,bn]

Example
CALC.sumx2py2([2,3,9,1,8,7,5],[6,5,11,7,5,4,4]);
// returns 521.0

CALC.SUMXMY2(ARRAY1, ARRAY2)

Returns the sum of squares of differences of corresponding values in two
arrays. For arrays [a1,a2,a3,...,an] and [b1,b2,b3,...,bn], the result
gives

Parameters
array1 An array of values [a1,a2,...,an]
array2 An array of values [b1,b2,...,bn]

Example
CALC.sumxmy2([2,3,9,1,8,7,5],[6,5,11,7,5,4,4]);
// returns 79.o

CALC.TAN(NUMBER)

Returns the tangent of a number representing an angle in radians.

Parameters
number An angle in radians

Example
CALC.tan(pi()/4)
// returns 0.9999999999999983 (approximately 1)

CALC.TANH(NUMBER)

Returns the hyperbolic tangent of a real number.

Parameters
number A real number

a1
2

b1
2

+  a2
2

b2
2

+  a3
2

b3
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+   an
2

bn
2

– + + + +
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Example
CALC.tanh(0.75)
// returns 0.6351489523872873

CALC.TRUNC(NUMBER, NUM_DIGITS)

Truncates a number to a specified number of digits. 

Parameters
number Number to truncate
num_digits Number of digits (to right of decimal point) 
to preserve after truncation

Example
CALC.trunc(2245.789, 2);
// returns 2245.78

JS.12.5Statistical Functions

This section presents the statistical functions provided by the CALC object.

CALC.AVEDEV(ARRAY)

Returns the average of the absolute deviations from mean of data in array.
This is a measure of the variability in the data set.

Parameters
array Array of real values for which to compute the 
average absolute deviation

Example
CALC.avedev([4,5,6,7,5,4,3]);
// returns 1.0204081632653061

CALC.AVERAGE(ARRAY)

Returns the average (arithmetic mean) of the data in array.

Parameters
array Array of real values to average

Example
CALC.average([4,5,6,7,5,4,3]);
// returns 4.857142857142857

See Also
CALC.averagea(array), to process text and Boolean values in addition to
numerical values.

CALC.AVERAGEA(ARRAY)

Returns the average (arithmetic mean) of the arguments. Text and Boolean
values are evaluated as follows:
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  – Text evaluates to 0 
  – true evaluates to 1 
  – false evaluates to 0

Parameters
array Array of numerical, text, and/or Boolean 
values to average

Example
CALC.averagea([1,2,3,4,’asd’,true,false]);
// returns 1.5714285714285714

CALC.BINOMDIST(NUMBER_S, TRIALS, PROBABILITY_S, 
[CUMULATIVE])

Returns the individual term binomial distribution probability. 

Parameters
number_s Number of successes in trials
trials Number of independent trials
probability_s Probability of success on each trial
cumulative Boolean:

true: Computes cumulative distribution 
function (probability of at most number_s successes)

false (default): Computes probability mass 
function (probability of number_s successes)

Example
Probability that a fair coin tossed 10 times will land on “heads” six or fewer
times.

CALC.binomdist(6, 10, 0.5, true);
// returns 0.828125

CALC.CORREL(ARRAY1, ARRAY2)

Returns the correlation coefficient of the values in array1 and array2. The
correlation coefficient indicates the degree of linear relationship between
two variables. It ranges from -1 (perfect negative linear relationship) to +1
(perfect positive linear relationship). A value of 0 indicates no linear
relationship.

Parameters
array1 Array of real values
array2 Array of real values

Example
CALC.correl([3,2,4,5,6],[9,7,12,15,17]);
// returns 0.9970544855015815

The result should be comparable to that obtained with
CALC.pearson(array1, array2).
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CALC.COUNT(ARRAY)

Returns the integer number of elements in array (both numeric and non-
numeric).

Parameters
array Array of numeric or non-numeric values

Example
CALC.count(['asd',true,3,2,4,5,6]);
// returns 7

CALC.COUNTA(ARRAY)

Counts the number of non-null and non-empty elements in array.

Parameters
array Array of numeric or non-numeric values

Example
CALC.counta(['asd',null,3,2,,5,6]);
// returns 5

CALC.COUNTBLANK(ARRAY)

Counts the number of null elements in array.

Parameters
array Array of numeric or non-numeric values

Example
CALC.countblank(['asd',null,3,2,null,5,6]);
// returns 2

CALC.COUNTDISTINCT(ARRAY)

Counts the number of distinct elements in array.

Parameters
array Array of numeric or non-numeric values

Example
CALC.countDistinct([3,3,2,4,4,5,6]);
// returns 5

CALC.COUNTN(ARRAY)

Counts the number of numeric elements in array.

Parameters
array Array of numeric or non-numeric values
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Example
CALC.countn(['asd',true,3,2,4,5,6]);
// returns 5

CALC.COUNTIF(ARRAY, CONDITION)

Counts the number of elements in the array that meet a certain condition,
such as “>100” or “==21” or “=='desk'”.

Parameters
array Array of numeric or non-numeric values
condition Condition against which elements should be 
compared

Example
CALC.countif([3,2,4,5,6], '> 4');
// returns 2

CALC.countif(['me','you','you','me','me'], '=="me"'))
// returns 3

CALC.COVAR(ARRAY1, ARRAY2)

Returns the covariance between the values in array1 and array2.
Covariance is the average of the products of deviations for each data point
pair.

Parameters
array1 Array of real values
array2 Array of real values

Example
CALC.covar([3,2,4,5,6],[9,7,12,15,17]);
// returns 5.2

CALC.DEVSQ(ARRAY)

Returns the sum of squares of deviations of values in array from their
sample mean.

Parameters
array Array of real values

Example
CALC.devsq([3,2,4,5,6]);
// returns 10.0

CALC.EXPONDIST(X, LAMBDA, CUMULATIVE)

Returns the value of the exponential distribution for specified value of
random variable x and rate parameter lambda. Value x typically represents
the time interval between events in a Poisson process. 
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Parameters
x Time interval for which to compute 
probability.
lambda Rate parameter (number of events per unit 
time)
cumulative Boolean: 

true: computes cumulative distribution 
function

false: computes probability density function

Example
Probability that the interval between successive events is at most 0.2
seconds for a Poisson process with a constant rate of 10 events per second.

CALC.expondist(0.2, 10, true);
// returns 0.8646647167633873 (approximately 86.5%)

CALC.FISHER(X)

Returns the Fisher z-transformation at numeric value x. This
transformation produces a function that is normally distributed rather than
skewed, and can be used to perform hypothesis testing on the sample
correlation coefficient. 

Parameters
x Value to transform

Example
CALC.fisher(0.75);
// returns 0.9729550745276566

CALC.FISHERINV(Z)

Returns the inverse of the Fisher transformation. 

Parameters
z Z-value for which to compute the inverse 
transformation.

Example
CALC.fisherinv(1);
// returns 0.7615941559557649

CALC.FORECAST(X, KNOWN_Y_VALUES, KNOWN_X_VALUES)

Predicts the future value of a function based on past values using linear
regression. 

Parameters
x Value at which to compute function
known_y_values Array of dependent (function) values 
corresponding to known_x_values
known_x_values Array of independent values 
corresponding to known_y_values
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Example
For a function with the following (x,y) pairs,
{(20,6),(28,7),(31,9),(38,15),(40,21)}, compute the function value at x=30.

CALC.forecast(30, [6,7,9,15,21],[20,28,31,38,40]);
// returns 10.607253086419755

CALC.FREQUENCY(DATA_ARRAY, BINS_ARRAY)

Returns an array representing the frequencies with which values in
data_array occur within the ranges specified by bins_array. For example,
if bins_array specifies four values, [value1, value2, value3, value4],
this groups the values in data_array into the following five ranges:

• x <= value1

• value1 < x <= value2

• value2 < x <= value3

• value3 < x <= value4

• x > value4

The returned array contains the count of the values in each of these five
bins.

Parameters
data_array Array of data to group and count
bins_array Array of thresholds defining the groups

Example
Compute the frequencies of values {79, 85, 78, 85, 50, 81, 95, 88, 97} in
the ranges {x70, 70<x79, 79<x89, x

var freq = 
CALC.frequency([79,85,78,85,50,81,95,88,97],[70,79,89]);
for (var i=0;i<freq.length;i++) {
log('Count in bin ' + i + ': ' + freq[i])

}

// Returns:
// Count in bin 0: 1
// Count in bin 1: 2
// Count in bin 2: 4
// Count in bin 3: 2

CALC.GEOMEAN(ARRAY)

Returns the geometric mean of values in array.

Parameters
array Array of positive values for which to compute 
geometric mean
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Example
CALC.geomean([4,5,8,7,11,4,3]);
// returns 5.476986969656962

CALC.HARMEAN(ARRAY)

Returns the harmonic mean of values in array. The harmonic mean is the
reciprocal of the arithmetic mean of reciprocals.

Parameters
array Array of positive values for which to compute 
harmonic mean

Example
CALC.harmean([4,5,8,7,11,4,3]);
// returns 5.028375962061728

CALC.HYPGEOMDIST(SAMPLE_S, NUMBER_SAMPLE, POPULATION_S, 
NUMBER_POPULATION)

Returns the value of the hypergeometric distribution, the probability of
sample_s successes in a sample of size number_sample (drawn without
replacement), where the population of size number_population has
population_s successes.

Parameters
sample_s Number of successes in sample
number_sample Sample size
population_s Number of successes in population
number_population Population size

Example
Probability of 1 success in a sample of size 4 (drawn without replacement),
where the population of size 20 has 8 successes:

CALC.hypgeomdist(1, 4, 8, 20);
// returns 0.3632610939112487 (approximately 36.3%)

CALC.INTERCEPT(ARRAY_Y, ARRAY_X)

Calculates the point at which the best-fit regression line for the values in
array_x and array_y intersects the y-axis.

Parameters
array_y Array of y values
array_x Array of x values

Example
CALC.intercept([8,11,14,17],[1,2,3,4]);
// returns 5.0
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CALC.KURT(ARRAY)

Returns the sample excess kurtosis of a data set, which indicates the
peakedness or flatness of the data relative to the normal distribution.
Positive kurtosis indicates relatively peaked, while negative kurtosis
indicates relatively flat.

Parameters
array Array of values

Example
CALC.kurt([4,5,8,7,8,4,5,3,7]);
// returns -1.6851311953352766 (relatively flat)

CALC.LARGE(ARRAY, K)

Returns the kth largest value in the array. Duplicate values are included in
the ranking. For example, ranking set {4,5,8,7,8,4,5,3,7} from greatest to
least yields {8,8,7,7,5,5,4,4,3}.

Parameters
array Array of values
k Rank of the value to obtain (k=1 is largest)

Example
The third-largest value in set {4,5,8,7,8,4,5,3,7}:

CALC.large([4,5,8,7,8,4,5,3,7],3);
// returns 7.0

CALC.MAX(ARRAY)

Returns the largest value in array. 

Parameters
array Array of numerical values

Example
Largest value in set {4,5,8,7,8,4,5,3,7}:

CALC.max([4,5,8,7,8,4,5,3,7]);
// returns 8.0

CALC.MAXA(ARRAY)

Returns the largest value in array, where Booleans are considered 1 if true
and 0 if false, and string values are considered 0.

Parameters
array Array of values (numeric, Boolean, or string)
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Example
Largest value in set {4,5,8,8,4,true,3,yesterday}:

CALC.maxa([4,5,8,8,4,true,3,'yesterday']);
// returns 8.0

CALC.MEDIAN(ARRAY)

Returns the median of the elements in array.

Parameters
array Array of numeric values

Example
CALC.median([1,2,3,4,5,6,7]);
// returns 4.0

CALC.MIN(ARRAY)

Returns the smallest value in array. 

Parameters
array Array of numerical values

Example
Smallest value in set {4,5,8,7,8,4,5,3,7}:

CALC.min([4,5,8,7,8,4,5,3,7]);
// returns 3.0

CALC.MINA(ARRAY)

Returns the smallest value in array, where Booleans are considered 1 if
true and 0 if false, and string values are considered 0.

Parameters
array Array of values (numeric, Boolean, or string)

Example
Smallest value in set {4,5,8,8,4,true,3,yesterday}:

CALC.mina([4,5,8,8,4,true,3,'yesterday']);
// returns 0.0 (value of string 'yesterday')

CALC.MODE(ARRAY)

Returns the most frequently occurring value in array. If there are several
elements that occur with the maximum frequency, the smallest of these is
returned.

Parameters
array Array of values 



COMMON FUNCTION REFERENCE

1006 of 1397

Example
CALC.mode([1,1,2,3,4,5,2,6,7]);
// returns 1

CALC.NEGBINOMDIST(NUMBER_F, NUMBER_S, PROBABILITY_S)

Returns the negative binomial distribution, the probability that there will be
number_f failures before the number_s-th success in a series of independent
Bernoulli trials, when the constant probability of a success is
probability_s.

Parameters
number_s Number of successes in trials
number_f Number of failures preceding the number_s-th 
success
probability_s Probability of success on each trial

Example
Probability that there will be 10 failures preceding the fifth success in a
series of trials having 25% chance of success on any given trial:

CALC.negbinomdist(10, 5, 0.25);
// returns 0.05504866037517786 (approximately 5.5%)

CALC.PEARSON(ARRAY1, ARRAY2)

Returns the Pearson product moment correlation coefficient of the values
in array1 and array2. The correlation coefficient indicates the degree of
linear relationship between two variables. It ranges from -1 (perfect
negative linear relationship) to +1 (perfect positive linear relationship). A
value of 0 indicates no linear relationship.

Parameters
array1 Array of real values
array2 Array of real values

Example
CALC.pearson([3,2,4,5,6],[9,7,12,15,17]);
// returns 0.9970544855015815

The result should be comparable to that obtained with
CALC.correl(array1, array2).

CALC.PERCENTILE(ARRAY, K)

Returns the k-th percentile of values in array. The k-th percentile is the
value below which fraction k of the data are found. For example, k=0.5
represents the value below which half (50%) of the data are found, also
known as the median.



COMMON FUNCTION REFERENCE

1007 of 1397

Parameters
array Array of real values
k Desired percentile

Example
CALC.percentile([9,7,5,3,1], 0.9);
// returns 8.2 (90 percent of values fall below 8.2)

CALC.percentile([9,7,5,3,1], 0.5);
// returns 5.0 (50 percent of values fall below 5, the 
median)

CALC.PERCENTRANK(ARRAY, X, [SIGNIFICANCE])

Returns the rank of a value x within the data provided in array. The rank is
given as a percentage indicating the percentage of values in array that fall
below value x.

Parameters
array Array of real values
x Value to test
significance Number of significant digits in the returned 
percentage value

Example
Where does the value 2 rank within the set {13,12,11,8,4,3,2,1,1,1}, to
three decimal places.

CALC.percentrank([13,12,11,8,4,3,2,1,1,1],2,3);
// returns 0.333 (approximately 33.3% of values are less 
than 2)

CALC.PERMUT(NUMBER, NUMBER_CHOSEN)

Returns the number of possible permutations in which number_chosen
objects can be selected from number of objects, where order is significant. 

Parameters
number Number of objects in complete set
number_chosen Number of objects in selected subsets

Example
The number of ways in which 2 objects can be selected from a set of 3,
where order is significant.

CALC.permut(3,2);
// returns 6.0

CALC.POISSON(X, LAMBDA, CUMULATIVE)

Returns the value of the Poisson distribution for specified value of random
variable x and rate parameter lambda. Value x typically represents the
number of events that occur over a period of time in an independently
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distributed random process, where lambda represents the expected
(average) number of events over such a period.

Parameters
x Number of events for which to compute 
probability
lambda Average number of events
cumulative Boolean: 

true: computes cumulative distribution 
function

false: computes probability density function

Example
Probability that 2 or fewer events occur in a random process during the
period of time when 5 events would occur on average.

CALC.poisson(2, 5, true);
// returns 0.12465201948308113 (approximately 12.5%)

CALC.PROB(ARRAY_X, ARRAYPROB, LOWER_LIMIT, [UPPER_LIMIT])

Returns the probability that a value falls between lower_limit and
upper_limit (inclusive) based on the discrete probabilities in arrayProb.

The probability is computed by adding together the probabilities in
arrayProb corresponding to the values in array_x that fall in the specified
range.

Parameters
array_x Array of values corresponding to probabilities 
in arrayProb
arrayProb Array of probabilities corresponding to values 
in array_x. Sum of probabilities must be 1 or less.
lower_limit Lower boundary of the range
upper_limit Upper boundary of the range. If omitted, 
equality with lower limit is tested.

If upper_limit is not supplied, the function returns the probability that
values in array_x are equal to lower_limit.

Example
Given values {0,1,2,3} with associated probabilities {0.2,0.3,0.1,0.4}, find
the probability that a value lies between 1 and 3 (inclusive).

CALC.prob([0,1,2,3], [0.2,0.3,0.1,0.4], 1, 3);
// returns 0.8 (the summed probability for values 1,2,3)

CALC.QUARTILE(ARRAY, QUART)

Returns the specified quartile for the values in array.

Parameters
array Array of real values
quart Desired quartile: 



COMMON FUNCTION REFERENCE

1009 of 1397

0 for minimum value
1 for first quartile (25th percentile)
2 for second quartile (50th percentile, 

median)
3 for third quartile (75th percentile)
4 for maximum value

Example
First quartile (25th percentile) for dataset {1,2,4,7,8,9,10,12}:

CALC.quartile([1,2,4,7,8,9,10,12], 1);
// returns 3.5

CALC.RANK(NUMBER, ARRAY, ORDER)

Returns the rank of number within the values in array. The rank is the
position of the value in the list after sorting in ascending or descending
order.

Parameters
number The value for which to find rank. This value 
must occur within array.
array Array of real values. Non-numeric values are 
ignored.
order 1: Find rank in ascending-sorted array

0: Find rank in descending-sorted array

Example
CALC.rank(7,[1,2,4,7,8,9,10,12],1); 
// returns 4 (value '7' is fourth from bottom)

CALC.rank(7,[1,2,4,7,8,9,10,12],0); 
// returns 5 (value '7' is fifth from top)

CALC.RSQ(ARRAY1, ARRAY2)

Returns the square of the Pearson product moment correlation coefficient
(r-squared) for the values in array1 and array2. The squared correlation
coefficient indicates the degree to which variance in array2 can be
accounted for by variance in array1 (or vice versa). An r-squared value
near 0 indicates that the values in array1 and array2 bear little linear
relationship. An r-squared value near 1 indicates that the values in array1
and array2 bear a strong linear relationship, such that the variance in
array2 can be largely explained by variance in array1 using a linear model.

Parameters
array1 Array of real values
array2 Array of real values

Example
CALC.rsq([3,2,4,5,6],[9,7,12,15,17]);
// returns 0.9941176470588233
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CALC.SKEW(ARRAY)

Returns the skewness of a data set, which indicates the asymmetry of a
distribution around its mean. Positive skewness indicates that the right-side
tail of the distribution is longer than the left, while negative skewness
indicates that the left-side tail of the distribution is longer than the right.

Parameters
array Array of values

Example
CALC.skew([3,4,5,2,3,4,5,6,4,7]);
// returns 0.3595430714067974

CALC.SLOPE(ARRAY_Y, ARRAY_X)

Calculates the slope of the best-fit regression line through the values in
array_x and array_y.

Parameters
array_y Array of y values
array_x Array of x values

Example
CALC.slope([8,11,14,17],[1,2,3,4]);
// returns 3.0

CALC.SMALL(ARRAY, K)

Returns the k-th smallest value in array. 

Parameters
array Array of real values
k Position (from smallest) in array of data to 
return

Example
CALC.small([1,2,4,7,8,9,10,12],3); 
// returns 4.0 (value '4' is third from smallest)

CALC.STANDARDIZE(X, MEAN, STANDARD_DEV)

Returns the standard score (z-score) for value x based on the distribution
characterized by population mean and standard_dev. The standardized
value is (x-mean)/standard_dev, and indicates the deviation of x from the
mean value in terms of the standard deviation.

Parameters
x Value to standardize
mean Mean of the distribution
standard_dev Standard deviation of the distribution
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Example
Standard score of value 42, where the population mean is 40 and standard
deviation is 1.5.

CALC.standardize(42, 40, 1.5);
// returns 1.3333333333333333 (42 is approximately 1.33 
standard deviations above the mean)

CALC.STDEV(ARRAY)

Returns the sample standard deviation for the values in array. Standard
deviation is the square root of the variance and provides a measure of how
widely the data are spread about the mean.

Parameters
array Array of real values. Text and Boolean values 
are ignored.

Example
CALC.stdev([1345,1301,1368,1322,1310,1370,1318,1350,1303,12
99]);
// returns 27.46391571984349 

CALC.STDEVA(ARRAY)

Returns the sample standard deviation for the values in array. Standard
deviation is the square root of the variance and provides a measure of how
widely the data are spread about the mean. Boolean values in array are
considered to be 1 if true and 0 if false.

Parameters
array Array of real or Boolean values. Boolean 
'true' evaluates to 1; 'false' evaluates to 0. String values 
are ignored.

Example
CALC.stdeva([true, 
false,1345,1301,1368,1322,1310,1370,1318,1350,1303,1299]);
// returns 517.5588021050011

CALC.STDEVP(ARRAY)

Returns the population standard deviation for the values in array. Standard
deviation is the square root of the variance and provides a measure of how
widely the data are spread about the mean.

Parameters
array Array of real values. Text and Boolean values 
are ignored.

Example
CALC.stdevp([1345,1301,1368,1322,1310,1370,1318,1350,1303,1
299]);
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// returns 26.054558142482477

CALC.STDEVPA(ARRAY)

Returns the population standard deviation for the values in array. Standard
deviation is the square root of the variance and provides a measure of how
widely the data are spread about the mean. Boolean values in array are
considered to be 1 if true and 0 if false.

Parameters
array Array of real or Boolean values. Boolean 
'true' evaluates to 1; 'false' evaluates to 0. String values 
are ignored.

Example
CALC.stdevpa([true, 
false,1345,1301,1368,1322,1310,1370,1318,1350,1303,1299]);
// returns 495.5248269932261

CALC.STEYX(ARRAY_Y, ARRAY_X)

Returns the standard error of the estimate for a regression model based on
independent values in array_x and dependent (function) values in array_y.
The standard error represents the average distance of values in array_y
from the regression line.

Parameters
array_y Array of y (dependent) values corresponding to 
values in array_x
array_x Array of x (independent) values corresponding 
to values in array_y

Example
CALC.steyx([2,3,9,1,8,7,5], [6,5,11,7,5,4,4]);
// returns 3.305718950210041

CALC.TRIMMEAN(ARRAY, PERCENT)

Returns the mean of the interior of a data set by excluding a percentage of
data points from the top and bottom tails. This provides a measure of the
mean that is not influenced by outliers.

Parameters
array Array of values to trim and average
percent Fraction of data points to exclude

Example
Mean of data set {4,5,6,7,2,3,4,5,1,2,3} after removing 20% of the most
extreme values (10% from each tail).

CALC.trimmean([4,5,6,7,2,3,4,5,1,2,3], 0.2);
// returns 3.7777777777777777 
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CALC.VARN(ARRAY)

Returns the sample variance for the values in array. Variance is the square
of the standard deviation and provides a measure of how widely the data
are spread about the mean.

Parameters
array Array of real values. Text and Boolean values 
are ignored.

Example
CALC.varn([1345,1301,1368,1322,1310,1370,1318,1350,1303,129
9]);
// returns 754.2666666666665 

CALC.VARA(ARRAY)

Returns the sample variance for the values in array. Variance is the square
of the standard deviation and provides a measure of how widely the data
are spread about the mean. Boolean values in array are considered to be 1
if true and 0 if false.

Parameters
array Array of real or Boolean values. Boolean 
'true' evaluates to 1; 'false' evaluates to 0. String values 
are ignored.

Example
CALC.vara([true,false,1345,1301,1368,1322,1310,1370,1318,13
50,1303,1299]);
// returns 267867.11363636365

CALC.VARP(ARRAY)

Returns the population variance for the values in array. Variance is the
square of the standard deviation and provides a measure of how widely the
data are spread about the mean. 

Parameters
array Array of real values. Text and Boolean values 
are ignored.

Example
CALC.varp([1345,1301,1368,1322,1310,1370,1318,1350,1303,129
9]);
// returns 678.8399999999999

JS.12.6Text Functions

This section presents the text functions provided by the CALC object.
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CALC.CHARACTER(NUMBER)

Returns the unicode character specified by a decimal value.

Parameters
number Positive integer specifying a character

Example
CALC.character(77);
// returns M

CALC.CODE(STRING)

Returns the numeric character code corresponding to the first character in
string.

Parameters
string A string whose first character should be 
evaluated

Example
CALC.code('jsd');
// returns 106 (code for 'j')

CALC.CONCATENATE(ARRAY)

Returns the strings in array joined into a single string.

Parameters
array An array of strings

Example
CALC.concatenate(['madam','i','am','adam']);
// returns madamiamadam

If the number of strings to concatenate is relatively small, you can also use
the JavaScript concatenation operator. For example:

'madam' + 'i' + 'am' + 'adam';
// returns madamiamadam

CALC.DOLLAR(NUMBER, DECIMALS)

Converts a numerical value to text format and applies a currency symbol.
Decimals is the number of digits to the right of the decimal point.

Parameters
number The value to convert to currency
decimals Number of digits to right of decimal point in 
the result

Example
CALC.dollar(12345.789, 2);
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// returns $12,345.79

CALC.EXACT(STRING1, STRING2)

Returns true if string1 is identical to string2, and returns false
otherwise. 

Parameters
string1 A string to compare
string2 A string to compare

Example
CALC.exact('hello','Hello');
// returns false (due to case mismatch)

You can also use the JavaScript identity operator for this purpose. For
example:

'hello' === 'Hello';
// returns false (due to case mismatch)

CALC.FIND(STRING1, STRING2, SEARCH_INDEX)

Returns the location of the first occurrence of string1 within string2,
starting the search from the position specified by search_index. 

Parameters
string1 A string to find
string2 The string in which to search
search_index Location at which to start search 
(first character has index 1)

Example
Searching within the string “asdqwertasd” starting with the sixth character
(“e”), at what index does the substring “asd” appear?

CALC.find('asd','asdqwertasd', 6);
// returns 9 

CALC.FIXED(NUMBER, DECIMALS, NO_COMMAS)

Returns a number rounded to the specified number of decimals and
formatted as text using a period and commas.

Parameters
number A numerical value to round and format as text
decimals The number of digits to right of decimal point
no_commas Boolean: 

true to suppress commas in result
false to allow commas in result

Example
CALC.fixed(1234.567, 2, false);
// returns 1,234.57



COMMON FUNCTION REFERENCE

1016 of 1397

CALC.LEFT(STRING, NUM_CHARS)

 Returns num_char number of characters from the left side of string.

Parameters
string A string from which to extract characters
num_chars Size of substring to extract, starting from 
left-most character

Example
CALC.left('abcdefghij', 4);
// returns abcd

To extract a substring with arbitrary starting and ending indexes, use
substring(indexA, indexB) or CALC.mid(String, start_num, num_chars).

CALC.LEN(STRING)

Returns the number of characters in a text string, which is generally the
same as string.length.

Parameters
string A string in which to count characters

Example
CALC.len('abc def ghij');
// returns 12

CALC.LOWER(STRING)

Converts all uppercase characters in string to lowercase characters. This is
generally the same as string.toLowerCase().

Parameters
string A string to convert to lowercase

Example
CALC.lower('abCdefgHIJ');
// returns abcdefghij

CALC.MID(STRING, START_NUM, NUM_CHARS)

Returns num_chars consecutive characters from string, starting with the
location given by start_num.

Parameters
string A string from which to extract characters
start_num Starting index of extracted string. (Index of 
first character is 1.)
num_chars Number of consecutive characters to extract, 
starting from start_num



COMMON FUNCTION REFERENCE

1017 of 1397

Example
CALC.mid('abcdefghij', 2, 4);
// returns bcde

To extract a substring with arbitrary starting and ending indexes, use
substring(indexA, indexB).

CALC.PROPER(STRING)

Capitalizes the first letter of each word in string.

Parameters
string A string to convert to initial capitals

Example
CALC.proper('my name is alex');
// returns My Name Is Alex

CALC.REPLACE(OLD_STRING, START_NUM, NUM_CHARS, NEW_STRING)

Replaces a segment of old_string with the entirety of new_string. The
segment replaced in old_string begins with index start_num and
continues for num_chars characters. 

Parameters
old_string A string in which to replace characters
start_num Starting index in old_string for replacement. 
(Index of first character is 1.)
num_chars Number of characters in old_string to replace
new_string String containing replacement text

Example
Replace the five characters “fghij” in string “abcdefghijkl” with the new
string ‘*’.

CALC.replace('abcdefghijkl',6,5,'*');
// returns abcde*kl 

This function replaces text that occurs at a specific location in old_string.
Use CALC.substitute(old_string, rep_string , new_string, instance_num) to
replace an occurrence of a particular substring in old_string.

CALC.REPT(STRING, NUMBER_TIMES)

Repeats string a given number of times (concatenating the string to itself).

Parameters
string String to repeat
number_times Integer number of times to repeat string

Example
CALC.rept('abcd',5);
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// returns abcdabcdabcdabcdabcd 

CALC.RIGHT(STRING, NUM_CHARS)

Returns num_char number of characters from the right side of string.

Parameters
string A string from which to extract characters
num_chars Size of substring to extract, starting from 
right-most character

Example
CALC.right('abcdefghij', 4);
// returns ghij

To extract a substring with arbitrary starting and ending indexes, use
substring(indexA, indexB) or CALC.mid(String, start_num, num_chars).

CALC.SEARCH(FIND_STRING, SEARCH_STRING, START_NUM)

Locates find_string within search_string and returns the index of the
location where find_string begins. The function returns -1 if the string is
not found.

Parameters
find_string The substring to locate within search_string
search_string The string in which to search
start_num Index in search_string at which to begin 
searching

Example
CALC.search('e','statements', 6);
// returns 7

CALC.SUBSTITUTE(OLD_STRING, REP_STRING , NEW_STRING, 
INSTANCE_NUM)

Replaces an instance of rep_string within old_string using replacement
text provided by new_string. 

Parameters
old_string A string containing one or more instances of 
rep_string
rep_string The string to replace within old_string
new_string String containing replacement text
instance_num Occurrence of rep_string instance to replace

Example
Replace the second instance of “/” in string “asd/pqr/xyz” with “-”.

CALC.substitute('asd/pqr/xyz','/','-', 2);
// returns asd/pqr-xyz



COMMON FUNCTION REFERENCE

1019 of 1397

This function replaces specific text within old_string. Use
CALC.replace(old_string, start_num, num_chars, new_string) to replace
text that occurs at a specific location in old_string.

CALC.T(VALUE)

Returns the string or date supplied by value. If value is numerical or
Boolean, the function returns an empty string.

Parameters
value String, date, numeric, or Boolean value. 
Strings are returned unchanged. Dates are converted to 
string format. Numeric and Boolean values return an empty 
string.

Example
CALC.t('asd');
// returns asd

Example
CALC.t(true)
CALC.t(56);
// returns ''

CALC.TEXT(VALUE, FORMAT)

Converts a numerical value to a string based on the specified format.

Parameters
value Numerical value to convert to text
format A valid number format. See below.

Example
CALC.text(2800, '$0.00');
// returns $2800.00

Construct the number format string using the characters in the table below.
The syntax is the same as Java’s DecimalFormat.

SYMBOL MEANING

0 Digit
# Digit, zero shows as absent
. Decimal point
- Minus sign
, Grouping separator
E Separates mantissa and exponent in scientific notation
; Separates positive and negative sub-patterns
% Multiply by 100 and show as percentage

http://docs.oracle.com/javase/8/docs/api/java/text/DecimalFormat.html
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CALC.TRIM(STRING)

Removes all white space characters from string except for single spaces
after words or punctuation.

Parameters
string A string from which to remove extra white 
space

Example
CALC.trim(' Mary had a little lamb.')
// returns Mary had a little lamb.

CALC.UPPER(STRING)

Converts all lowercase characters in string to uppercase characters. This is
generally the same as string.toUpperCase().

Parameters
string A string to convert to uppercase

Example
CALC.upper('abCdefgHIJ');
// returns ABCDEFGHIJ

CALC.VALUE(STRING)

Converts a formatted number string to the equivalent numerical value.

Parameters
string A string to convert

Example
CALC.value('$2800.00');
// returns 2800.0

JS.13 Regular Expression Object Functions

A regular expression object contains the pattern of a regular expression. It
has properties and methods for using the regular expression to find and
replace matches in strings. A regular expression can be created as a literal:

re = /.*JavA.*/i;

Alternatively, it can be used to created using the RegExp constructor:

re = new RegExp('.*JavA.*', 'i');

A regular expression can be used in the String.match() or String.search()
method to find the regular expression in a string, or evaluated against a
string using one of the RegExp methods.
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COMPILE(PATTERN[, FLAGS])

Compile a regular expression. 

EXEC(STR)

Execute the search for a match in a string and returns a result array

TEST(STR)

Execute the search for a match in a string and returns true if the match is
found and false otherwise.

Examples
var re = new RegExp(".*JavA.*", 'i');
var found = re.test(str);
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APPENDIX CT:Chart Script Tutorial

This appendix provides a set of chart examples to illustrate some common
chart scripting tasks, such as color-coding data, changing labels and axes,
and positioning chart annotations.

The scripts in this appendix can be used for both report Charts (using Style
Studio) and Viewsheet Charts (using Visual Composer). However, there
are some differences in how charts are configured in these different
environments. See the references for further information.

See Also
Advanced Dashboard Scripting, for information on scripting for
Viewsheets.
Advanced Report Scripting, for information on scripting for Reports.
Creating a Chart Using API Functions, for basic chart setup.
Appendix CR:Chart Script Reference, for complete information on all API
functions.

CT.1 Modifying Chart Properties
To modify the basic properties of a Chart element, simply specify the
desired property value in the onInit handler, onRefresh handler, or
component script. The following sections provide some basic examples of
property modifications.

Whenever possible, use the syntax auto-completion feature to enter
legitimate property names and values. (See Editing Script for reports, or
Adding Script to a Viewsheet for dashboards.)

See Also
onLoad Handler, in Advanced Report Scripting, for information on the
report handler.
onRefresh Handler, in Advanced Dashboard Scripting, for information on
the Viewsheet handler.
Element Script, in Advanced Report Scripting, for information on scripting
report elements
Adding Component Script, in Advanced Dashboard Scripting, for
information on scripting Viewsheet elements

CT.1.1Modifying the Chart Style

To modify the style of a chart in script (e.g., line, bar, pie, etc.), use the
chartStyle attribute: 

You can switch
between multiple-
style and single-style
in the ‘Select Chart
Style’ panel.

• For a multi-style chart, use chartStyle together with the name of the 
dataset you want to style, e.g., Chart1.chartStyle['Sum(Total)'].
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• For a single-style chart, use chartStyle without any modifiers, e.g., 
Chart1.chartStyle.

For example, if you want to parameterize the style of a chart, you could
prompt the user for a parameter called ‘Chart Style’. Then access this
parameter in the chart script and modify the chart style accordingly.

if (parameter['Chart Style'] == 'bar') {
Chart1.chartStyle=Chart.CHART_BAR;

}
else if (parameter['Chart Style'] == 'line') {

Chart1.chartStyle=Chart.CHART_LINE;
}

CT.1.2Modifying Axis Title Text

To modify axis title text, use xTitle.text (x2Title.text) and
yTitle.text, (y2Title.text). 

Use auto-complete for
correct syntax.

Chart1.xTitle.text = 'Text to go below bottom X-axis'
Chart1.x2Title.text = 'Text to go above top X-axis'

CT.1.3Modifying Axis Properties

To modify axis properties, including labels, visibility, tick marks, etc., use
the “axis” properties (axis.font, axis.minimum, axis.labelColor,
axis.format, etc.). 

Use auto-complete for
correct syntax. Type
“.” after “axis” to see
prompt.

Chart1.axis.Employee.font = 'Comic Sans MS-BOLD-12'
Chart1.axis.Employee.ticksVisible = false
Chart1.axis.Employee.labelColor = [0,0,255]
Chart1.axis['Sum(Total)'].logarithmic = true
Chart1.axis['Sum(Total)'].minimum = 10000
Chart1.axis['Sum(Total)'].format = [Chart.DECIMAL_FORMAT, 
"#,###.00"];

See Also
Appendix CR.1.2 , General Axis Properties, for general axis
characteristics.
Appendix CR.1.3 , Measure Axis Properties, for numeric axis
characteristics.
Appendix CR.1.4 , Title Properties, for axis title characteristics.
Appendix CR.1.5 , Plot Properties, for plot area characteristics.

CT.2 Modifying a Chart Data Binding
The bindingInfo property of a Chart provides access to the data binding
options in the Chart’s ‘Data Binding’ dialog box. This includes the binding
of fields to the X-axis, Y-axis, and VisualFrames (Color, Shape, etc.), as
well as grouping and summarization settings. 

Walkthrough In the following example, you will bind a chart to the ‘All Sales’ query, set
the axis bindings, define a subseries, and set grouping and summarization.
Follow the steps below:
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1. Create a new report or Viewsheet. (For a Viewsheet, select the ‘All
Sales’ query in ‘Orders’ > ‘Sample Queries’ as the data source.)

2. Add a new Chart element to the report or Viewsheet. 

Note: bindingInfo modifications must be made prior to query
execution. Therefore, attach bindingInfo scripts to the onLoad or
onRefresh handler.

3. Open the Script Editor:

a. For a report, right-click an empty area of the report and select
‘Script’ from the context menu to open the onLoad Handler. 

b. For a Viewsheet, press the ‘Options’ button in the toolbar to
open the ‘Viewsheet Options’ dialog box, then select the Script
tab to open the onRefresh Handler.

Note: The Viewsheet
must be based on the
‘All Sales’ query.

4. In the Script Editor, enter the commands below to bind the chart to
the ‘All Sales’ query.

Chart1.query = "All Sales";

5. Specify query fields to bind to the X-axis (‘Company’) and Y-axis
(‘Total’):

Chart1.bindingInfo.xFields = [["Company",Chart.STRING]];
Chart1.bindingInfo.yFields = [["Total",Chart.NUMBER]];

6. Set the aggregation/summarization method:

Chart1.bindingInfo.setFormula("Total",Chart.MAX_FORMULA)

7. Set the desired grouping options (e.g., top-N filtering):

Chart1.bindingInfo.setTopN("Company",5)
Chart1.bindingInfo.setTopNReverse("Company",false)
Chart1.bindingInfo.setTopNSummaryCol("Company",

"Max(Total)");

8. Specify the query fields to bind to a “VisualFrame,” (i.e., for visual
coding as subseries):

Chart1.bindingInfo.setColorField("Employee",Chart.STRING);

9. Close the Editor, an preview the report or Viewsheet.

The complete script is shown below:

Chart1.query = "All Sales";

Chart1.bindingInfo.xFields = [["Company",Chart.STRING]];
Chart1.bindingInfo.yFields = [["Total",Chart.NUMBER]];
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Chart1.bindingInfo.setFormula("Total",Chart.MAX_FORMULA)
Chart1.bindingInfo.setTopN("Company",5)
Chart1.bindingInfo.setTopNReverse("Company",false)
Chart1.bindingInfo.setTopNSummaryCol("Company","Max(Total)"
);
Chart1.bindingInfo.setColorField("Employee",Chart.STRING);

See Also
bindingInfo.xFields, bindingInfo.yFields
bindingInfo.setFormula(col, formula, binding)
bindingInfo.setTopN(col,N), bindingInfo.setTopNReverse(col,boolean)
bindingInfo.setTopNSummaryCol(col,agg)
bindingInfo.setColorField(col, type)
Bind Chart to Query or Worksheet (Report/Viewsheet), to reference an
arbitrary query or Worksheet.
Binding Data to a Chart Element, in Advanced Report Design, for
information on the ‘Data Binding’ dialog box.
Modifying a Chart Element using API Functions, to modify other aspects
of an existing chart.
Creating a Chart Using API Functions, to script a chart from the ground-
up.
Appendix CR.1.6 , Chart bindingInfo Property, for all binding properties.

CT.3 Modifying a Chart Element using API Functions
The Chart API provides access to charting engine commands using Java
object syntax. You can use these commands to directly modify the
graphical elements displayed by a Chart. 

Walkthrough In this example, you will first bind a chart to a data source, and then make
further modifications to the chart display by using Chart API commands.
Follow the steps below:

1. Create a new report or Viewsheet. (For a Viewsheet, select the ‘All
Sales’ query in ‘Orders’ > ‘Sample Queries’ as the data source.)

2. Add a new Chart element to the report or Viewsheet. 

3. For a report, click on the Chart to open the Chart Editor. For a
Viewsheet, press the ‘Edit’ button at the top-right of the Chart. 
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4. For a report, in the Data panel, expand the ‘Orders’ data source, the
‘Sample Queries’ folder, and the ‘All Sales’ query. For a
Viewsheet, in the Data Source panel, expand the ‘All Sales’ data
block.

5. Drag the ‘Employee’ field to the ‘X’ region.

6. Follow the steps below to bind the ‘Total’ field so that it provides
three different measures (maximum, minimum, and average) on
the chart:

a. From the ‘All Sales’ source, drag the ‘Total’ field to the ‘Y’
region.

b. Click the ‘Edit Measure’ button next to the ‘Total’ field. Set the
‘Aggregate’ to ‘Max’, and click the green ‘Apply’ button.

c. From the ‘All Sales’ source, drag the ‘Total’ field (a second
time) to the ‘Y’ region.

d. Click the ‘Edit Measure’ button next to the second ‘Total’ field.
Set the ‘Aggregate’ to ‘Min’, and click the green ‘Apply’
button.

e. From the ‘All Sales’ source, drag the ‘Total’ field (a third time)
to the ‘Shape’ region of the ‘Visual’ area. 

f. Click the ‘Edit Measure’ button next to the third ‘Total’ field.
Set the ‘Aggregate’ to ‘Average’, and click the green ‘Apply’
button.

7. Click the ‘Select Chart Style’ button. Double-click to select the
Point Style chart.
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The Chart Editor should now appear as shown below:

8. Click the ‘Preview’ button the toolbar to preview the report or
Viewsheet.

The chart shows maximum and minimum totals for each
employee, and the chart shape-coding (interior fill) displays the
average totals.

Note that the interior fill, ‘Average(Total)’, is the same for both datasets, so
it is not needed in both locations. In the next steps, you will change the
‘Min(Total)’ markers to a solid red arrow-shape. You will also increase the
size of the ‘Max(Total)’ markers so that the fill level is more visible. To
make these changes, you will use Chart API functions.

Note: Chart API script which operates on the Chart’s 'Egraph'
property should be placed in element-level script.
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9. Open the Script Editor as follows:

a. In a report, right-click on the chart and select ‘Script’ from the
context menu. 

b. In a Viewsheet, right-click the chart and select ‘Properties’ from
the context menu. Then select the Script tab.

10. Use script commands to create the required StaticShapeFrame,
StaticColorFrame, and StaticSizeFrame objects.

// Create arrow-shaped markers:
var shpframe = new StaticShapeFrame(GShape.ARROWBAR);

// Create static red color:
var colframe = new 
StaticColorFrame(java.awt.Color(0xFF0000));

// Create static size of 10 pixels:
var sizframe = new StaticSizeFrame(10);

11. Obtain a handle to each of the two datasets (element sets) by using
the EGraph.getElement(index) method.

var elem0 = graph.getElement(0); // Max point element
var elem1 = graph.getElement(1); // Min point element

12. Assign the visual frames to the appropriate data elements using the
element’s GraphElement.setShapeFrame(frame),
GraphElement.setColorFrame(frame), and
GraphElement.setSizeFrame(frame) properties.

elem1.shapeFrame = shpframe; // Min point element
elem1.colorFrame = colframe; // Min point element
elem0.sizeFrame = sizframe; // Max point element

13. Close the Script Editor, and preview the report or Viewsheet. 

The complete script is shown below, along with the resulting graph.

var shpframe = new StaticShapeFrame(GShape.ARROWBAR);
var colframe = new 
StaticColorFrame(java.awt.Color(0xFF0000));
var sizframe = new StaticSizeFrame(10);
var elem0 = graph.getElement(0); // Max point element
var elem1 = graph.getElement(1); // Min point element
elem1.shapeFrame = shpframe;
elem1.colorFrame = colframe;
elem0.sizeFrame = sizframe;
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See Also
Creating a Chart Using API Functions, to create a chart from the ground-
up using script.
Modifying a Chart Data Binding, to modify data binding information.
Appendix CT:Chart Script Tutorial, for examples of modifying chart
elements.
Appendix CR:Chart Script Reference, for information on objects and
attributes.
API Documentation for the inetsoft.graph.* packages.

CT.4 Creating a Chart Using API Functions
Previous sections explained how to modify the data binding and element
properties of an existing chart. This section explains how to create a new
chart (from the ground-up) using Chart API commands. 

Note that charts created by script do not provide end-user interactivity
features. Therefore, for script-based charts you should deselect ‘Enable Ad
Hoc Editing’ in the ‘Chart Properties’ dialog box (Advanced tab). 

Walkthrough In this example, you will create a new chart, define the chart data, and
display the data on the chart. Follow the steps below.

1. Add a new chart to the report or Viewsheet.

Note: Chart API script (which operates on the Chart’s 'Egraph'
property) should be placed in element-level script. 

2. Open the Script Editor as follows:

a. In a report, right-click on the chart and select ‘Script’ from the
context menu. 

b. In a Viewsheet, right-click the chart and select ‘Properties’ from
the context menu. Then select the Script tab.

Tip: To reference
chart data, use the
DataSet object.

3. Define the data: Define the dataset for the chart using the Chart’s
Data property.

data = runQuery("sales by state"); 

http://community.inetsoft.com/docs/12.0/apidoc/
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For reports, you will generally obtain the data from a query, Work-
sheet, or data model by using runQuery(). In Viewsheets, you can
additionally bind data from any available Data Block. You can also
define your own dataset in script by assigning a JavaScript array to
the data or dataset property. See Binding Data to a Chart in Script
for more details.

EGraph is the global
chart object, which
includes all axes, leg-
ends, visual elements,
etc.

4. Create the Chart object. Create a new graph using the EGraph
constructor. Assign it to the Chart’s graph property.

graph = new EGraph();

5. Create the chart data elements. Pass the field names (column
headers) to a GraphElement constructor. This creates the
representational elements for the chart. 

var elem = new IntervalElement("State", "Sales");

The IntervalElement is a particular type of GraphElement that cre-
ates “bars” or “intervals” as the representational elements. Other
GraphElements, such as PointElement and LineElement, generate
other kinds of chart types, such as scatter plots and line plots,
respectively.

6. Add the created elements to the Chart object. Pass the
GraphElement object to the Chart’s EGraph.addElement(elem)
method. This adds the “bar” elements to the existing Chart object.

graph.addElement(elem);

7. Close the Script Editor and preview the report or Viewsheet. 

These are the basic operations required to create a new chart (from the
ground-up) using the Chart API. The complete script is shown below,
along with the resulting chart.

data = runQuery("sales by state");
graph = new EGraph();
var elem = new IntervalElement("State", "Sales");
graph.addElement(elem);



COMMON FUNCTION REFERENCE

1031 of 1397

See Also
Modifying a Chart Element using API Functions, to modify an existing
chart.
Modifying a Chart Data Binding, to modify data binding information.
Appendix CT:Chart Script Tutorial, for examples of modifying chart
elements.
Appendix CR:Chart Script Reference, for information on objects and
attributes.
API Documentation for the inetsoft.graph.* packages.

CT.5 Binding Data to a Chart in Script
There are several ways to bind data to a chart using script. The following
sections present the various approaches.

CT.5.1Bind Chart Using Chart Editor (Report/Viewsheet)

The easiest way to bind data to a chart is to use the Chart Editor. After you
have bound data to the chart using the Chart Editor, you can proceed to
modify the chart using script operations. You can see an example of this
hybrid approach in Modifying a Chart Element using API Functions.

CT.5.2Bind Chart to Query or Worksheet (Report/
Viewsheet)
Use runQuery() only in element-level script.

To bind data to a chart from an arbitrary query or Data Worksheet in
element-level script, use the runQuery() function and assign the result to
the chart’s data or dataset property.

Chart1.data = runQuery("sales by state");
graph = new EGraph();
var elem = new IntervalElement("State", "Sales");
graph.addElement(elem);

You can see an example of this approach in Creating a Chart Using API
Functions. For details about the syntax of runQuery(), see Running a
Query from Script in Advanced Dashboard Scripting or Running a Query
from Script in Advanced Report Scripting.

If you want to access a data block in the Data Worksheet on which the
current Viewsheet is based, you can use the simpler data syntax shown
below:

Chart1.data = Sales; // “Sales” is the data block name
graph = new EGraph();
var elem = new IntervalElement("State", "Sales");
graph.addElement(elem);

If the data block name contains spaces, use the syntax viewsheet['Data
Block Name']. See Referencing Data in the Worksheet Data Block in
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Advanced Dashboard Scripting for more information about accessing
Worksheet data in Viewsheet script.

See Also
Modifying a Chart Data Binding, to configure the data binding of a chart.
Running a Query from Script in Advanced Dashboard Scripting details
about the syntax of runQuery().
Running a Query from Script in Advanced Report Scripting for details
about the syntax of runQuery().

CT.5.3Bind Chart to Query or Worksheet (Report Only)
Use the report 'query' property only in onLoad script.

To bind data to a chart from an arbitrary query or Data Worksheet in a
report onLoad script, use the chart’s query property. 

Chart1.query = 'sales by state';
Chart1.bindingInfo.xFields = [["State",Chart.STRING]];
Chart1.bindingInfo.yFields = [["Sales",Chart.NUMBER]];

You can see an example of this approach in Modifying a Chart Data
Binding.

To read Viewsheet
data, use the Views-
heet’s Data property.

CT.5.4Bind Chart to Data Block (Viewsheet Only)

To bind data to one of the Data Blocks available to the Viewsheet, use the
chart’s query property (in component-level or onRefresh script). 

For example, assume that ‘Orders And Returns’ is the name of a Data
Block.

The following component-level or onRefresh script binds this Data Block
to the chart.

Chart1.query = "Orders And Returns";
Chart1.bindingInfo.xFields = [["Company",Chart.STRING]];
Chart1.bindingInfo.yFields = [["Total",Chart.NUMBER]];

You can see an example of this approach in Modifying a Chart Data
Binding.

If you want to construct the chart using Chart API functions that operate on
the EGraph object (rather than using bindingInfo properties to construct
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the chart), use the chart’s data property instead of the query property. For
example:

Chart1.data = Sales; // “Sales” is the data block name
graph = new EGraph();
var elem = new IntervalElement("State", "Sales");
graph.addElement(elem);

If the data block name contains spaces, use the syntax viewsheet['Data
Block Name']. See Referencing Data in the Worksheet Data Block in
Advanced Dashboard Scripting for more information about accessing
Worksheet data in Viewsheet script.

CT.5.5Bind Chart to JavaScript Array (Report/Viewsheet)
Use array assignment only in element-level script.

You can define a chart dataset entirely in element-level script by setting a
JavaScript array as the data or dataset property. 

Chart1.data = [["State","Quantity"],["NJ",200],["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
graph.addElement(elem);

You can see an example of this approach in Changing Scaling for Chart
Axes.

CT.6 Accessing Chart Data in Script
You can access Chart data in scripts by referencing the Chart’s data or
table property. The table object contains the aggregate values displayed
on the chart (the same values shown by the ‘Show Data’ button in a
Viewsheet Chart). The table object is accessible as a two-dimensional
array, where each column represents a distinct dataset (measure). The first
column of the array, table[i][0], contains the X-axis labels. The first row
of the array, table[0][i], contains the dataset or measure titles.

For example, consider a chart with two aggregated datasets (measures), as
shown below: 
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The table object provides access to these aggregate values as the following
array:

table[0][0] = 'DayOfWeek(Day)'
table[0][1] = 'Sum(Measure1)'
table[0][2] = 'Sum(Measure2)'
table[1][0] = 'Sun'
table[1][1] = 1
table[1][2] = 4
table[2][0] = 'Mon'
table[2][1] = 2
table[2][2] = 5
etc.

You can index the datasets (columns) numerically, e.g., table[1][2], or by
using the dataset name, e.g., table[1]['Sum(Measure2)']). You can also
use more complex formula table syntax; see Data in Appendix CR:Chart
Script Reference.

In a Viewsheet chart, the data property and table property are identical. In
a report chart, the data property represents the chart data prior to grouping
and aggregation (i.e., the raw data).

Example: 
Accessing Chart 
Data

In this example, add a script to display data values on the chart only if the
measure falls below a certain threshold. 

1. Create a new report or Viewsheet. (For a Viewsheet, select the
‘Sales Explore’ Worksheet as the data source.)

2. Add a new Chart element to the report or Viewsheet. (For a
Viewsheet, click the ‘Edit’ button on the Chart to open the Chart
Editor.)

3. Bind the ‘Category’ field of the ‘Sales Explore’ Worksheet to the
chart’s X-axis.

4. Bind both ‘Total’ and ‘Quantity Purchased’ fields of the ‘Sales
Explore’ Worksheet to the chart’s Y-axis. This creates a facet chart
with two sets of axes. 

5. Resize the chart to show all data.

6. Open the Chart Script Editor:

a. For a report, right-click on the chart and select ‘Script’ from the
context menu. This opens the Script Editor. 
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b. For a Viewsheet, right-click on the chart and select ‘Properties’
from the context menu. This opens the ‘Chart Properties’ dialog
box. Select the Script tab

7. Add the following script:

var threshold = 5000;

// Step through the rows of chart data with index i
for (var i = 1; i < table.length; i++) {

// Obtain the ith value of 'Category' and 'Quantity'
var Xvalue = table[i][0];
var Yvalue = table[i]['Sum(Quantity Purchased)'];

// test the value of Quantity against the threshold
if(Yvalue < threshold) {
// Create the label object
var form = new LabelForm();

// Set the label to appear only on Quantity axes
form.setMeasure('Sum(Quantity Purchased)')

// Set the label text
form.setLabel(Yvalue);

// Set the label position and alignment
form.setValues([Xvalue,Yvalue]);
form.setAlignmentX(Chart.CENTER_ALIGNMENT);

// Add the label to the graph
graph.addForm(form)

}
}

8. Press ‘OK’ to close the Script Editor.

9. Preview the report or Viewsheet. 

Observe that values are shown for groups that have totals falling below the
threshold of 5000.

¢

See Also
Data, in Appendix CR:Chart Script Reference, for additional information.
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CT.7 Changing Chart Scaling
Some objects, such as
IntervalElement, create
an implicit Scale.

A Scale object determines how abstract data values are mapped to physical
chart representations such as position, color, shape, etc. The EGraph object
and the VisualFrame object both map data values to physical
representations, so both of these objects require a Scale. 

CT.7.1Changing Scaling for Chart Axes

To change the scaling of chart axes, simply assign a new Scale to the Chart
object. For example, consider the following chart:

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

dataset = [["State","Quantity"], ["CA",200], ["NY",3000]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
graph.addElement(elem);

Note that in this chart the IntervalElement object implicitly defines a linear
Y-axis scale. However, the data values on the chart are widely different in
magnitude, which suggests that a log scale might be more appropriate. 

To change the Y-axis to use a log scale, follow these steps:

1. Define the desired Scale object explicitly. In this case, create a
LogScale based on the ‘Quantity’ field.

var scale = new LogScale("Quantity");

2. Assign the new scale to the Y-axis of the chart object using the
setScale() method.

graph.setScale("Quantity",scale);

The complete script with the new chart scaling looks like this:

dataset = [["State","Quantity"], ["CA",200], ["NY",3000]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var scale = new LogScale("Quantity");
graph.addElement(elem);
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graph.setScale('Quantity',scale);

Example: 
Changing Axis 
Range

In this example (for Viewsheets), you will dynamically modify the axis
range to match the data displayed on the chart. In particular, you will adapt
the lower limit on the Y-axis so that it is always 75% of the lowest data
value shown on the chart.

Follow the steps below:

1. Create a new Viewsheet based on the ‘Sales’ > ‘Sales Explore’
Worksheet.

2. Add a Chart component to the Viewsheet, and click the center of
the chart to open the Chart Editor.

3. From the ‘Dimensions’ node of the ‘Data Source’ panel, drag the
‘State’ field to the ‘X’ region of the ‘Data’ panel.

4. From the ‘Measures’ node of the ‘Data Source’ panel, drag the
‘Total’ field to the ‘Y’ region of the ‘Data’ panel.

5. Click the ‘Edit Dimension’ button next to the ‘State’ field in the
‘Data’ panel. 

6. From the ‘Ranking’ option in the ‘Edit Dimension’ panel, specify
‘Top 5 of Sum(Total)’. Click the ‘Apply’ button.
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7. Right-click the Chart component on the Viewsheet grid, and select
‘Properties’ from the context menu. This opens the ‘Chart
Properties’ dialog box.

Note: To access the
data prior to chart
aggregation, see
Accessing Worksheet
Data in Dashboard
Scripting.

8. Select the Script tab, and enter the following script:

var dMin = 10000000; // Default minimum

// Get a handle to the chart's Y-axis Scale:
var yScale = graph.getCoordinate().getYScale(); 

// Find the minimum Y-value in the chart data:
for (var i=0; i<dataset.getRowCount(); i++) {
yVal = dataset.getData('Sum(Total)',i);
if(yVal < dMin) {
dMin = yVal;

}
}

// Set Y-axis lower limit to .75 of minimum value:
yScale.setMin(.75*dMin);

9. Click the ‘OK’ button to close the ‘Chart Properties’ dialog box.
Observe how the chart Y-axis updates so that the lower limit is 75%
of the smallest chart value.

10. From the ‘Data Source’ panel of the Chart Editor, drag the
‘Category’ field onto the Viewsheet grid. This creates a ‘Category’
selection list.
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11. Select different combinations of categories from the ‘Category’
selection list, and observe how the chart axis updates.

¢

See Also
Changing Axis Properties, for examples of other axis modifications.

CT.7.2Changing Scaling for a VisualFrame

A VisualFrame object contains information about how data values are
mapped to physical properties of chart elements. For example, a
BrightnessColorFrame contains information about how data values in a
field map to the brightness of corresponding chart elements. Mappings of
this type require a Scale.

To change the scaling of a VisualFrame object, simply assign a new Scale
to the VisualFrame. For example, consider the following chart:

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

var dataset = 
[["State","Quantity","Total"],["NJ",200,2500],["NY",300,150
0]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new BrightnessColorFrame();
frame.setField("Total");
frame.setColor(java.awt.Color(0xff0000));
elem.setColorFrame(frame);
graph.addElement(elem);
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Note that in this chart a linear scale is defined implicitly by the
BrightnessColorFrame object. The legend indicates that this default scale
runs from 1400 to 2600. To change the scaling to run from 500 to 3000
instead, you must explicitly define a new Scale object. 

Follow these steps:

1. Define the desired Scale object explicitly. In this case, create a
LinearScale based on the ‘Total’ field.

var scale = new LinearScale("Total");
scale.setFields("Total");

2. Set the minimum and maximum values of the new Scale object.

scale.setMax(3000);
scale.setMin(500);

3. Assign the new scale to the existing VisualFrame object.

frame.setScale(scale);

The complete script with the new VisualFrame scaling looks like this:

dataset = [["State","Quantity","Total"], 
["NJ",200,2500],["NY",300,1500]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new BrightnessColorFrame();
frame.setField("Total");
frame.setColor(java.awt.Color(0xff0000));
var scale = new LinearScale("Total");
scale.setFields("Total");
scale.setMax(3000);
scale.setMin(500);
frame.setScale(scale);
elem.setColorFrame(frame);
graph.addElement(elem);

CT.8 Changing the Appearance of Chart Elements
You can change the static appearance of chart elements by using a static
VisualFrame. For example, you can set static colors, sizes, and textures to
enhance the aesthetic appearance of a chart.
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Consider the script below:

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

dataset = 
[["State","Quantity","Total"],["NJ",200,2500],["NY",300,150
0]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
graph.addElement(elem);

This creates a basic point (scatter) chart displaying the dimensions ‘State’
and ‘Quantity’. However, the points are rather small and hard to see. To
increase the size of the points and assign them a bolder color, use a
StaticColorFrame and a StaticSizeFrame.

Follow these steps: 

1. Create a new StaticColorFrame object, and specify a static color
(red).

var cframe = new StaticColorFrame();
cframe.setColor(java.awt.Color(0xff0000)); // red

2. Create a new StaticSizeFrame object, and specify a static size.

var sframe = new StaticSizeFrame();
sframe.setSize(10);

3. Assign the StaticColorFrame and StaticSizeFrame objects to the
GraphElement object.

elem.setColorFrame(cframe);
elem.setSizeFrame(sframe);
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The complete script is shown below. The points are now large and red.

dataset = 
[["State","Quantity","Total"],["NJ",200,2500],["NY",300,150
0]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var cframe = new StaticColorFrame();
cframe.setColor(java.awt.Color(0xff0000)); // red
var sframe = new StaticSizeFrame();
sframe.setSize(10);
elem.setColorFrame(cframe);
elem.setSizeFrame(sframe);
graph.addElement(elem);

Because these are static VisualFrames, the color and size are not keyed to
the data. To represent data values using color, size, or other visual
attributes, see Representing Data with Shape, Color, Size.

See Also
Representing Data with Shape, Color, Size, to use dynamic VisualFrame
objects.
Adding Decorative Elements, for information on GraphForm objects.

CT.9 Changing Axis Properties
To alter the appearance of chart axes, use the Chart’s setScale() method to
assign a new Scale object. For example, you can replace a linear scale with
a logarithmic scale, show or hide tick marks, display axis labels at top or
right, change the label font and color, etc.

Consider the following example:

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

dataset = [["State","Quantity"], ["NJ",200], ["NY",3000]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
graph.addElement(elem);
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This creates a basic bar chart displaying the dimensions ‘State’ and
‘Quantity’. Follow the steps below to experiment with modifying the
chart’s axes:

1. Create a new logarithmic scale using the LogScale object,
specifying ‘Quantity’ as the field on which the scale is based.

var logscale = new LogScale('Quantity');

2. Set the color of the Y-axis lines and gridline to blue, and make the
gridlines dotted. To do this, create a new AxisSpec object, and
assign it to the Scale.

var yspec = new AxisSpec();
yspec.setLineColor(java.awt.Color(0x0000ff));
yspec.setGridColor(java.awt.Color(0x0000ff));
yspec.setGridStyle(Chart.DOT_LINE);
logscale.setAxisSpec(yspec);

3. Create a new CategoricalScale for the X-axis, specifying ‘State’ as
the field on which the scale is based.

var cscale = new CategoricalScale('State');

4. Remove the X-axis lines and tick marks. To do this, create a new
AxisSpec object, and assign it to the Scale.

var xspec = new AxisSpec();
xspec.setLineVisible(false);
xspec.setTickVisible(false);
cscale.setAxisSpec(xspec);

5. Move the X-axis labels above the chart area, and increase their size.
To do this, create a new TextSpec object, and assign it to the
AxisSpec. 

var tspec = new TextSpec();
tspec.setFont(java.awt.Font('Dialog',

java.awt.Font.BOLD, 14)); 
xspec.setTextSpec(tspec);
xspec.setAxisStyle(AxisSpec.AXIS_SINGLE2);
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6. Create a new TextFrame, and specify new axis labels to replace the
default labels (‘NJ’, ‘NY’) with the full state names. Assign the
new TextFrame to the AxisSpec object.

var tframe = new DefaultTextFrame();
tframe.setText('NJ','New Jersey');
tframe.setText('NY','New York');
xspec.setTextFrame(tframe);

7. Assign the two Scale objects to the appropriate axes of the graph
object.

graph.setScale('Quantity',logscale);
graph.setScale('State',cscale);

The complete script is shown below.

dataset = [["State","Quantity"], ["NJ",200], ["NY",3000]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var logscale = new LogScale('Quantity');
var yspec = new AxisSpec();
yspec.setLineColor(java.awt.Color(0x0000ff));
yspec.setGridColor(java.awt.Color(0x0000ff));
yspec.setGridStyle(Chart.DOT_LINE);
logscale.setAxisSpec(yspec);
var cscale = new CategoricalScale('State');
var xspec = new AxisSpec();
xspec.setLineVisible(false);
xspec.setTickVisible(false);
cscale.setAxisSpec(xspec);
var tspec = new TextSpec();
tspec.setFont(java.awt.Font('Dialog',java.awt.Font.BOLD, 
14)); 
xspec.setTextSpec(tspec);
xspec.setAxisStyle(AxisSpec.AXIS_SINGLE2);
var tframe = new DefaultTextFrame();
tframe.setText('NJ','New Jersey');
tframe.setText('NY','New York');
xspec.setTextFrame(tframe);
graph.setScale('Quantity',logscale);
graph.setScale('State',cscale);
graph.addElement(elem);



COMMON FUNCTION REFERENCE

1045 of 1397

CT.10Changing Legend Properties
When you assign a VisualFrame to a chart element to visually code data, a
corresponding legend is created automatically. You can change the
appearance of this legend by editing the VisualFrame’s LegendSpec.

Consider the following script:

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new CategoricalColorFrame("State");
elem.setColorFrame(frame);
graph.addElement(elem);

This creates a basic bar chart displaying the dimensions ‘State’ and
‘Quantity’. In this script, a CategoricalColorFrame distinguishes the
different states by color. Follow the steps below to experiment with
modifying the chart’s legend:

1. Change the legend border to a blue dotted line. To do this, create a
LegendSpec object and assign it to the ColorFrame.

var legend = new LegendSpec();
legend.setBorder(Chart.DOT_LINE);
legend.setBorderColor(java.awt.Color(0x0000ff));
frame.setLegendSpec(legend);

2. Change the legend title to say simply ‘State’, and make the text
bold. To do this, create a TextSpec object and assign it to the
LegendSpec.

var tspec = new TextSpec();
tspec.setFont(java.awt.Font('Dialog', 

java.awt.Font.BOLD, 14));
legend.setTitleTextSpec(tspec);
legend.setTitle('State');

3. Change the text inside the legend to display the full state names. To
do this, create a TextFrame object and assign it to the LegendSpec.
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var tframe = new DefaultTextFrame();
tframe.setText('NJ','New Jersey');
tframe.setText('NY','New York');
legend.setTextFrame(tframe);

4. Place the legend above the chart. Use the Graph’s legendLayout
property to do this.

graph.setLegendLayout(Chart.TOP);

The complete script is shown below.

dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new CategoricalColorFrame("State");
elem.setColorFrame(frame);

var legend = new LegendSpec();
legend.setBorder(Chart.DOT_LINE);
legend.setBorderColor(java.awt.Color(0x0000ff));
frame.setLegendSpec(legend);

var tspec = new TextSpec();
tspec.setFont(java.awt.Font('Dialog',java.awt.Font.BOLD, 
14));
legend.setTitleTextSpec(tspec);
legend.setTitle('State');

var tframe = new DefaultTextFrame();
tframe.setText('NJ','New Jersey');
tframe.setText('NY','New York');
legend.setTextFrame(tframe);
graph.setLegendLayout(Chart.TOP);

graph.addElement(elem);

See Also
Representing Multiple Measures, for information on legends for multiple
elements.
Representing Data with Shape, Color, Size, for more information on
VisualFrames.

CT.11Changing Chart Labels
When you assign a TextFrame to a chart element to represent data
textually, you can modify the labels by using
TextFrame.setText(value,text). The following example illustrates how you
can construct custom labels for the chart using script. The labels display the
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names of the companies represented on the chart together with each
company’s percentage of total sales.

Viewsheet

Follow the steps below if you are creating a Viewsheet. (For a report, skip
to the next set of steps below.)

1. Create a new Viewsheet based on the ‘All Sales’ query in the
‘Orders’ > ‘Sample Queries’ folder. (See Creating a Dashboard
for details.)

2. Drag a Chart component from the Component panel into the
Viewsheet grid. Click the ‘Edit’ button on the chart to open the
Chart Editor.

3. From the Data Source panel of the Chart Editor, drag the
‘Company’ field to the ‘X’ region of the Data panel.

4. From the Data Source panel of the Chart Editor, drag the ‘Total’
field to the ‘Y’ region of the Data panel.

5. Press the ‘Edit Dimension’ button next to the ‘Company’ field.
From the ‘Ranking’ menu, select “Top 5 of Sum(Total)” and press
the ‘Apply’ button.

6. Right-click the chart and select ‘Properties’ from the context menu.
This opens the ‘Chart Properties’ dialog box. 

7. Select the Script tab to access the Script Editor. 

8. Enter the script shown below.

Report

Follow the steps below if you are creating a a report:

1. Create a new report. (See for details.)

2. Drag a Chart element from the Toolbox panel into the report. This
adds the chart to the report and opens the Chart Binding panel.

3. In the Data panel, expand the ‘Orders’ node, the ‘Sample Queries’
folder, and expand the ‘All Sales’ node.

4. Drag the ‘Company’ field from the ‘All Sales’ query to the ‘X’
region of the Binding panel.
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5. Drag the ‘Total’ field from the ‘All Sales’ query to the ‘Y’ region
of the Binding panel.

6. Press the ‘Edit Dimension’ button next to the ‘Company’ field.
From the ‘Ranking’ menu, select “Top 5 of Sum(Total)” and press
the ‘Apply’ button.

7. Right-click the chart and select ‘Script’. This opens the Script
Editor.

8. Enter the script shown below. 

Viewsheet and Report

Enter the script shown below.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

// Create new TextFrame based on 'Company' field:
var tframe = new DefaultTextFrame('Company');

// Get a handle to the graph element (bars):
var elem = graph.getElement(0);

// Assign the TextFrame to the element. This adds the 
// category names above the bars (text-coding).
elem.setTextFrame(tframe)

// Compute the total amount of all companies: 
var sumTotal = sum(table['Sum(Total)']);

// Loop through companies on chart:
for(i=1;i<table.length;i++) {

// Get the original label (company):
var oldLabel = table[i][0];

// Compute the fractional value of corresponding 'Total':
var barFraction = table[i][1]/sumTotal;

// Format the fraction as a percent:
var barPercent = formatNumber(barFraction,'##.00%');

// Compose the new label, with form 'Company:Percent':
var newLabel = oldLabel + ':\n' + barPercent;

// Assign the new label in place of the old label:
tframe.setText(oldLabel,newLabel);

}

The above script uses a customized TextFrame to display the company
name together with the percentage of total represented by each company.
The TextFrame.setText(value,text) function is the key to replacing one set
of labels by a different set of labels.
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In this example you created a completely new TextFrame to display the
data, but you can use the same technique to modify an existing TextFrame.
For example, to modify the existing X-axis labels, you would first get a
handle to the existing X-axis TextFrame. For example.

var tframe = 
graph.getCoordinate().getXScale().getAxisSpec().getTextFram
e();

Because this TextFrame is already associated with the X-axis labels, there
is no need to assign the TextFrame to the axis. The only thing you need to
do is to swap in the new labels. Here is the revised script in its entirety:

// Get a handle to the existing X-axis TextFrame:
var tframe = 
graph.getCoordinate().getXScale().getAxisSpec().getTextFram
e();

// Get a handle to the graph element (bars):
var elem = graph.getElement(0);

// Compute the total amount of all companies: 
var sumTotal = sum(table['Sum(Total)']);

// Loop through companies on chart:
for(i=1;i<table.length;i++) {

// Get the original label (company):
var oldLabel = table[i][0];

// Compute the fractional value of corresponding 'Total':
var barFraction = table[i][1]/sumTotal;

// Format the fraction as a percent:
var barPercent = formatNumber(barFraction,'##.00%');

// Compose the new label, with form 'Company:Percent':
var newLabel = oldLabel + ':\n' + barPercent;

// Assign the new label in place of the old label:
tframe.setText(oldLabel,newLabel);

}
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CT.12Changing the Chart Coordinates
There are several different Coordinate objects, each of which creates a
different kind of chart. The following sections discuss the different types of
chart coordinate systems.

CT.12.1Rectangular Coordinates

The default coordinate set is rectangular coordinates, as defined by the
RectCoord object. Rectangular coordinates represent two-dimensional data
on horizontal (X) and vertical (Y) axes. 

A RectCoord object is created automatically when you create a new Chart
object. Therefore, if you plan to use rectangular coordinates on the chart,
you do not need to explicitly specify a RectCoord object. You only need to
explicitly create a RectCoord object when you define other types of
coordinate systems. (See the following sections for more details.)

Assigning Rectangular Coordinates Automatically 

The following example illustrates automatic creation of rectangular
coordinates:

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

dataset = [["Direction", "Score"],[(Math.PI/
2),20],[(Math.PI/4),30],[(Math.PI),35]];
graph = new EGraph();
var elem = new PointElement("Direction", "Score");
var xscale = new LinearScale("Direction");
var yscale = new LinearScale("Score");
yscale.setMin(0);
yscale.setMax(40);
var yaxis = new AxisSpec();
yaxis.setGridStyle(Chart.DOT_LINE);
yscale.setAxisSpec(yaxis);

xscale.setMin(0);
xscale.setMax(1.95*Math.PI);
xscale.setIncrement(Math.PI/8);
var xaxis = new AxisSpec();
var tspec = new TextSpec();
tspec.setFormat(new java.text.DecimalFormat("0.0"));
xaxis.setTextSpec(tspec);
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xaxis.setGridStyle(Chart.DOT_LINE);
xscale.setAxisSpec(xaxis);

graph.setScale("Direction",xscale);
graph.setScale("Score",yscale);
graph.addElement(elem);

The script defines a PointElement style (scatter plot), and specifies a
LinearScale for the ‘Direction’ field and ‘Score’ field. Note that the script
does not explicitly create a RectCoord object. A rectangular coordinate
system is created automatically, and this allows you to assign the specified
scales directly to the Graph:

graph.setScale("Direction",xscale);
graph.setScale("Score",yscale);

Assigning Rectangular Coordinates Explicitly

You can explicitly define the RectCoord object, if needed. The script below
is the same as the script in Assigning Rectangular Coordinates
Automatically, but uses two scales to explicitly define a set of rectangular
coordinates. These coordinates are then explicitly assigned to the chart.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

dataset = [["Direction", "Score"],[(Math.PI/
2),20],[(Math.PI/4),30],[(Math.PI),35]];
graph = new EGraph();
var elem = new PointElement("Direction", "Score");
var xscale = new LinearScale("Direction");
var yscale = new LinearScale("Score");
yscale.setMin(0);
yscale.setMax(40);
var yaxis = new AxisSpec();
yaxis.setGridStyle(Chart.DOT_LINE);
yscale.setAxisSpec(yaxis);

xscale.setMin(0);
xscale.setMax(1.95*Math.PI);
xscale.setIncrement(Math.PI/8);
var xaxis = new AxisSpec();
var tspec = new TextSpec();
tspec.setFormat(new java.text.DecimalFormat("0.0"));
xaxis.setTextSpec(tspec);
xaxis.setGridStyle(Chart.DOT_LINE);
xscale.setAxisSpec(xaxis);
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graph.setScale("Direction",xscale);
graph.setScale("Score",yscale);
var rect = new RectCoord(xscale,yscale);
graph.setCoordinate(rect);
graph.addElement(elem);

The resulting chart is the same as in the previous case.

CT.12.2Polar Coordinates

Polar coordinates represent data in terms of an angle and magnitude
(radius). They are defined by the PolarCoord object, which accepts a
RectCoord object as input. The following sections explain how to create
and modify polar coordinates. They also demonstrate a common use of
polar coordinates, the pie chart.

Converting Rectangular to Polar Coordinates

To use polar coordinates, you first need to create a set of rectangular
coordinates. Consider the script from the previous section, Rectangular
Coordinates:

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

dataset = [["Direction", "Score"],[(Math.PI/
2),20],[(Math.PI/4),30],[(Math.PI),35]];
graph = new EGraph();
var elem = new PointElement("Direction", "Score");
var xscale = new LinearScale("Direction");
var yscale = new LinearScale("Score");
yscale.setMin(0);
yscale.setMax(40);
var yaxis = new AxisSpec();
yaxis.setGridStyle(Chart.DOT_LINE);
yscale.setAxisSpec(yaxis);

xscale.setMin(0);
xscale.setMax(1.95*Math.PI);
xscale.setIncrement(Math.PI/8);
var xaxis = new AxisSpec();
var tspec = new TextSpec();
tspec.setFormat(new java.text.DecimalFormat("0.0"));
xaxis.setTextSpec(tspec);
xaxis.setGridStyle(Chart.DOT_LINE);
xscale.setAxisSpec(xaxis);
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graph.setScale("Direction",xscale);
graph.setScale("Score",yscale);
var rect = new RectCoord(xscale,yscale);
graph.setCoordinate(rect);
graph.addElement(elem);

Note that this script explicitly creates a set of rectangular coordinates by
calling the RectCoord constructor. To convert the chart to a polar
coordinate system, use this RectCoord object to create a new PolarCoord
object: 

var polar = new PolarCoord(rect);

Assign this new coordinate set to the chart to obtain the desired polar
representation. The modified script is shown below:

dataset = [["Direction", "Score"],[(Math.PI/
2),20],[(Math.PI/4),30],[(Math.PI),35]];
graph = new EGraph();
var elem = new PointElement("Direction", "Score");
var xscale = new LinearScale("Direction");
var yscale = new LinearScale("Score");
yscale.setMin(0);
yscale.setMax(40);
var yaxis = new AxisSpec();
yaxis.setGridStyle(Chart.DOT_LINE);
yscale.setAxisSpec(yaxis);

xscale.setMin(0);
xscale.setMax(1.95*Math.PI);
xscale.setIncrement(Math.PI/8);
var xaxis = new AxisSpec();
var tspec = new TextSpec();
tspec.setFormat(new java.text.DecimalFormat("0.0"));
xaxis.setTextSpec(tspec);
xaxis.setGridStyle(Chart.DOT_LINE);
xscale.setAxisSpec(xaxis);

graph.setScale("Direction",xscale);
graph.setScale("Score",yscale);
var rect = new RectCoord(xscale,yscale);
var polar = new PolarCoord(rect);
graph.setCoordinate(polar);
graph.addElement(elem);

By default, the rectangular coordinate’s X-axis is mapped to the polar
coordinate’s angle, and the rectangular coordinate’s Y-axis is mapped to
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the polar coordinate’s magnitude (radius). To reverse a mapping, use the
Coordinate object’s transpose() method.

Tailoring a Coordinate Mapping

When converting rectangular to polar coordinates, you can choose to map
only one of the dimensions. Use the PolarCoord Type property to do this. 

Mapping just a single
dimension is useful
for pie charts. See
Example: Pie Chart.

The example below is the same as that in Converting Rectangular to Polar
Coordinates, except that here only the angle dimension is mapped:

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

dataset = [["Direction", "Score"],[(Math.PI/
2),20],[(Math.PI/4),30],[(Math.PI),35]];
graph = new EGraph();
var elem = new PointElement("Direction", "Score");
var xscale = new LinearScale("Direction");
var yscale = new LinearScale("Score");
yscale.setMin(0);
yscale.setMax(40);
var yaxis = new AxisSpec();
yaxis.setGridStyle(Chart.DOT_LINE);
yscale.setAxisSpec(yaxis);

xscale.setMin(0);
xscale.setMax(1.95*Math.PI);
xscale.setIncrement(Math.PI/8);
var xaxis = new AxisSpec();
var tspec = new TextSpec();
tspec.setFormat(new java.text.DecimalFormat("0.0"));
xaxis.setTextSpec(tspec);
xaxis.setGridStyle(Chart.DOT_LINE);
xscale.setAxisSpec(xaxis);

graph.setScale("Direction",xscale);
graph.setScale("Score",yscale);
var rect = new RectCoord(xscale,yscale);
var polar = new PolarCoord(rect);
polar.setType(PolarCoord.THETA);
graph.setCoordinate(polar);
graph.addElement(elem);

The result is that all points have the same magnitude, with variation only
along the angle dimension. To reverse a mapping, use the Coordinate
object’s transpose() method.
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Example: Pie Chart

You can think of a pie chart as a stacked bar chart with just one bar,
displayed in polar coordinates. To see this, consider the script below, which
creates a simple bar chart.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

dataset = [["State", "Revenue"], ["CA", 
200],["NY",300],["PA",150]];
graph = new EGraph();
var elem = new IntervalElement("State","Revenue");
var xscale = new CategoricalScale("State")
var yscale = new LinearScale("Revenue");
var rect = new RectCoord(xscale, yscale);
graph.setCoordinate(rect);
graph.addElement(elem);

To create a pie chart from this data, just convert the chart to a stacked bar,
and then convert to polar coordinates. Follow the steps below:

1. Instead of using different X-axis positions to distinguish the ‘State’
data, distinguish the states using a ColorFrame object.

dataset = [["State", "Revenue"], ["CA", 
200],["NY",300],["PA",150]];
graph = new EGraph();
var elem = new IntervalElement(null,"Revenue");
var xscale = new CategoricalScale("State")
var yscale = new LinearScale("Revenue");
var rect = new RectCoord(null, yscale);
var cframe = new CategoricalColorFrame("State");
elem.setColorFrame(cframe);
graph.setCoordinate(rect);
graph.addElement(elem);
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Note that a ‘null’ value is assigned for the (unused) X-dimension
when creating the IntervalElement and RectCoord objects.

2. Convert the chart into a stacked bar chart with just one bar by using
the GraphElement’s collisionModifier property. Create a
StackRange object to make sure there is enough room for the
stacked elements.

elem.setCollisionModifier(GraphElement.STACK_SYMMETRIC);
yscale.setScaleRange(new StackRange());

3. Create polar coordinates from the existing rectangular coordinates.
By default, this maps the non-null coordinate (Y-axis) to the polar
coordinate’s magnitude dimension. Specify that it should be
mapped to the angle dimension instead.

var polar = new PolarCoord(rect);
polar.setType(PolarCoord.THETA);

4. Use the Chart’s setCoordinate() method to apply the new polar
coordinates.

graph.setCoordinate(polar);

5. Remove the axis lines and labels. To do this, create an AxisSpec
object, and assign it to the Scale.

var yspec = new AxisSpec();
yspec.setLabelVisible(false);
yspec.setLineVisible(false);
yspec.setTickVisible(false);
yscale.setAxisSpec(yspec);
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6. Add the state names to the individual slices and hide the legend. To
do this, create a new TextFrame object based on the “State” field,
and assign it to the GraphElement. To hide the legend, create a new
LegendSpec object, and assign it to the ColorFrame.

var tframe = new DefaultTextFrame("State");
elem.setTextFrame(tframe);
var legend = new LegendSpec();
legend.setVisible(false);
cframe.setLegendSpec(legend);

7. Explode the slices for better appearance.

elem.setHint(GraphElement.HINT_EXPLODED,'true');

The final script for the pie chart is shown below.

dataset = [["State", "Revenue"], ["CA", 
200],["NY",300],["PA",150]];
graph = new EGraph();
var elem = new IntervalElement(null,"Revenue");
var xscale = new CategoricalScale("State")
var yscale = new LinearScale("Revenue");
var rect = new RectCoord(null, yscale);
var cframe = new CategoricalColorFrame("State");
elem.setColorFrame(cframe);
elem.setCollisionModifier(GraphElement.STACK_SYMMETRIC);
yscale.setScaleRange(new StackRange());
var polar = new PolarCoord(rect);
polar.setType(PolarCoord.THETA);
var yspec = new AxisSpec();
yspec.setLabelVisible(false);
yspec.setLineVisible(false);
yspec.setTickVisible(false);
yscale.setAxisSpec(yspec);
var tframe = new DefaultTextFrame("State");
elem.setTextFrame(tframe);
var legend = new LegendSpec();
legend.setVisible(false);
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cframe.setLegendSpec(legend);
elem.setHint(GraphElement.HINT_EXPLODED,'true');
graph.setCoordinate(polar);
graph.addElement(elem);

CT.12.3Parallel Coordinates

Parallel coordinates display multiple dimensions as parallel axes, rather
than orthogonal axes, as for rectangular coordinates. Parallel coordinates
are defined by the ParallelCoord object, which accepts a set of Scale
objects as input.

To understand parallel coordinates, consider the following data set, which
contains scores for three students over three consecutive tests.

By plotting this data on three parallel coordinates (‘Test 1’, ‘Test 2’, ‘Test
3’), you can visualize trends across the different tests. To create this chart,
follow the steps below:

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

1. Define the data set and chart objects.

dataset = 
[["Test1","Test2","Test3","Name"],[100,80,20,'Joe'],[75,50,
40,'Jane'],[50,30,80,'Fred']];
graph = new EGraph();

2. Create a new LineElement object to define a line-style chart, and
assign its dimensions.

var elem = new LineElement();
elem.addDim("Test1");
elem.addDim("Test2");
elem.addDim("Test3");

3. Define the scales used for the three axes. (In this case the scales are
the same for all three.)

var scale1 = new LinearScale("Test1");
var scale2 = new LinearScale("Test2");
var scale3 = new LinearScale("Test3");
scale1.setMax(100);
scale2.setMax(100);
scale3.setMax(100);
scale1.setMin(0);
scale2.setMin(0);

Test 1 Test 2 Test 3 Name
200 175 50 Joe
800 1000 300 Jane
10 15 20 Fred
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scale3.setMin(0);

4. Create the new ParallelCoord object using the defined scales.

var coord = new ParallelCoord(scale1,scale2,scale3);

5. Use a CategoricalColorFrame to distinguish the three students.
Assign the frame to the line element.

var frame = new CategoricalColorFrame("Name");
elem.setColorFrame(frame);

6. Assign the parallel coordinate system to the chart.

graph.addElement(elem);
graph.setCoordinate(coord);

The complete script is shown below:

dataset = 
[["Test1","Test2","Test3","Name"],[100,80,20,'Joe'],[75,50,
40,'Jane'],[50,30,80,'Fred']];
graph = new EGraph();
var elem = new LineElement();
elem.addDim("Test1");
elem.addDim("Test2");
elem.addDim("Test3");
var scale1 = new LinearScale("Test1");
var scale2 = new LinearScale("Test2");
var scale3 = new LinearScale("Test3");
scale1.setMax(100);
scale2.setMax(100);
scale3.setMax(100);
scale1.setMin(0);
scale2.setMin(0);
scale3.setMin(0);
var coord = new ParallelCoord(scale1,scale2,scale3);
var frame = new CategoricalColorFrame("Name");
elem.setColorFrame(frame);
graph.addElement(elem);
graph.setCoordinate(coord);

CT.12.4Facet Coordinates

The FacetCoord object contains a set of inner and outer coordinates on
which multidimensional data can be represented as nested charts. To create
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a FacetCoord object, pass a pair of RectCoord objects to the FacetCoord
constructor:

var rect = new FacetCoord(outerCoord,innerCoord);

To understand facet coordinates, consider the following data set.

Because there are four different dimensions, there are several ways to look
at the data. For example, you may want to plot ‘Priority’ vs. ‘Name’, and
also break this down by ‘Product’ and ‘State’. To construct a facet chart to
do this, follow the steps below:

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

1. Define the data and the Chart objects, and create a new
IntervalElement (bar chart).

dataset = [["State", "Product", "Name", "Priority"],["NJ", 
"P1", "Joe", 2],["NJ", "P2", "Sam", 3],["NY", "P1", "Jane", 
4],["NJ", "P1", "Sam", 1],["NJ", "P2", "Joe", 10],["NY", 
"P1", "Sam", 10]];
graph = new EGraph();
var elem = new IntervalElement("Name", "Priority");

2. Create a Scale for each of the dimensions. All dimensions are
categorical except for ‘Priority’.

var state = new CategoricalScale("State");
var name = new CategoricalScale("Name");
var product = new CategoricalScale("Product");
var priority = new LinearScale("Priority");

3. Define two sets of rectangular coordinates, one for the outer
coordinates (‘Product’ vs. ‘State’) and one for the inner coordinates
(‘Priority’ vs. ‘Name’).

var inner = new RectCoord(name, priority);
var outer = new RectCoord(state, product);

4. Create the facet coordinates based on the outer and inner
rectangular coordinates defined above.

State Product Name Priority
NJ P1 Joe 2
NJ P2 Sam 3
NY P1 Jane 4
NJ P1 Sam 1
NJ P2 Joe 10
NY P1 Sam 10
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var coord = new FacetCoord(outer,inner);

5. Assign the coordinates and the bar elements to the chart.

graph.setCoordinate(coord);
graph.addElement(elem);

The resulting chart displays an outer grid based on the outer coordinates
(‘State’ and ‘Product’). Within each cell of the outer grid, the chart displays
the corresponding inner coordinates (‘Name’ and ‘Priority’). 

The complete script is provided below.

dataset = [["State", "Product", "Name", "Priority"],["NJ", 
"P1", "Joe", 2],["NJ", "P2", "Sam", 3],["NY", "P1", "Jane", 
4],["NJ", "P1", "Sam", 1],["NJ", "P2", "Joe", 10],["NY", 
"P1", "Sam", 10]];
graph = new EGraph();
var elem = new IntervalElement("Name", "Priority");
var state = new CategoricalScale("State");
var name = new CategoricalScale("Name");
var product = new CategoricalScale("Product");
var priority = new LinearScale("Priority");
var inner = new RectCoord(name, priority);
var outer = new RectCoord(state, product);
var coord = new FacetCoord(outer,inner);
graph.setCoordinate(coord);
graph.addElement(elem)

CT.12.5Setting a Coordinate Background

You can assign a background color or background image to the coordinate
area (plot area) of a chart by defining a PlotSpec object. The following
example illustrates how to set a blue background for a chart:

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var sscale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
var coord = new RectCoord(sscale,qscale);
var spec = new PlotSpec();
spec.setBackground(java.awt.Color(0xEEEEFF));
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coord.setPlotSpec(spec);
graph.setCoordinate(coord);
graph.addElement(elem);

Use the setBackgroundImage() function to display an image as the plot
background. The following example uses a static Google map image as a
background by aligning the map coordinates with the chart coordinates.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

// Define latitude and longitude values for landmarks:
dataset = 
[["Latitude","Longitude","PlaceName"],[40.8516051126306,-
73.95223617553711,' GW Bridge '],[40.76292614285948,-
74.00982856750488,' Lincoln Tunnel '],[40.72755146730012,-
74.02107238769531,' Holland Tunnel ']];
graph = new EGraph();

// Define chart elements and basic point appearance:
var elem = new PointElement("Longitude","Latitude");
var tframe = new DefaultTextFrame("PlaceName");
var sframe = new StaticShapeFrame();
var cframe = new StaticColorFrame();
cframe.setColor(java.awt.Color(0x0000000));
sframe.setShape(GShape.FILLED_CIRCLE);

// Define appearance of text labels:
var tspec = new TextSpec();
tspec.setBackground(java.awt.Color(0x0000000))
tspec.setFont(java.awt.Font('Trebuchet',java.awt.Font.BOLD, 
11));
tspec.setColor(java.awt.Color(0xffff00));

// Configure a background image using PlotSpec:
var pspec = new PlotSpec();
pspec.setLockAspect(true);
var logo = getImage("http://maps.google.com/maps/api/
staticmap?center=40.7857,-
73.9819&zoom=11&size=400x400&sensor=false");
pspec.setBackgroundImage(logo);
pspec.setYMax(40.8902) // YMax = high latitude
pspec.setYMin(40.6822) // YMin = low latitude
pspec.setXMax(-73.84529) // XMax = high longitude
pspec.setXMin(-74.1206) // XMin = low longitude

// Set chart scales to match image coordinates:
var latscale = new LinearScale("Latitude");
var lonscale = new LinearScale("Longitude");
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var aspec = new AxisSpec();
aspec.setLabelVisible(false);
latscale.setAxisSpec(aspec);
lonscale.setAxisSpec(aspec);
latscale.setScaleOption(0);
lonscale.setScaleOption(0);
latscale.setMax(pspec.getYMax()); // match YMax 
latscale.setMin(pspec.getYMin()); // match YMin
lonscale.setMax(pspec.getXMax()); // match XMax
lonscale.setMin(pspec.getXMin()); // match XMin
var coord = new RectCoord(lonscale,latscale);
coord.setPlotSpec(pspec);

// Assign visual frames to chart elements:
elem.setTextFrame(tframe);
elem.setTextSpec(tspec);
elem.setShapeFrame(sframe);
elem.setColorFrame(cframe);
elem.setHint(GraphElement.HINT_ALPHA,1);

// Assign coordinates. Generate chart with appropriate size:
graph.setCoordinate(coord);
graph.addElement(elem);

// For a report, set the chart element size as desired:
//Chart1.size = [5.6,5.6];

Note that the limits of the chart scales (latscale.setMax, latscale.setMin,
lonscale.setMax, lonscale.setMin) have been set to match the
geographical boundaries of the map image. This allows the image to align
correctly with the chart axes.

See Also
Appendix CR.4.9 , PlotSpec, for reference information.
background, in Advanced Report Scripting, to set a background for the
report element.
Chart Properties, in Advanced Report Design, to set a background for the
report element.
Color Tab, in Advanced Dashboard Design, to set a background for the
Viewsheet element.
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CT.13Representing Data with Shape, Color, Size
You can create a basic two-dimensional representation of data with just a
GraphElement object. To represent additional dimensions by using other
visual attributes of elements, create a VisualFrame.

To understand how to use a VisualFrame, consider the script below:

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

dataset = 
[["State","Quantity","Total"],["NJ",200,2500],["NY",300,150
0]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
graph.addElement(elem);

This creates a basic point (scatter) chart displaying the dimensions ‘State’
and ‘Quantity’. If you want to additionally represent the dimension ‘Total’
with the element size, use a VisualFrame such as the LinearSizeFrame.
Follow these steps: 

1. Create a new LinearSizeFrame object, and specify the field
containing the data that will determine the element sizes.

var frame = new LinearSizeFrame();
frame.setField("Total");

A VisualFrame object
such as LinearSize-
Frame contains a
mapping between data
values and physical
attributes. Therefore,
you need a Scale to
specify the mapping’s
scaling. 

2. Create a new LinearScale object, and assign the scale properties.
(See Appendix CT.7, Changing Chart Scaling, for more
information.) 

var scale = new LinearScale();
scale.setFields("Total");
scale.setMax(3000);
scale.setMin(1000);

3. Assign the new Scale to the VisualFrame object:

frame.setScale(scale);

4. Assign the VisualFrame object to the GraphElement object:
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elem.setSizeFrame(frame);

The point sizes now represent the data values contained in the ‘Total’ field.
The complete script is shown below. 

dataset = 
[["State","Quantity","Total"],["NJ",200,2500],["NY",300,150
0]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var frame = new LinearSizeFrame();
frame.setField("Total");
var scale = new LinearScale();
scale.setFields("Total");
scale.setMax(3000);
scale.setMin(1000);
frame.setScale(scale);
elem.setSizeFrame(frame);
graph.addElement(elem);

See Also
Representing Multiple Measures, for information on adding multiple
elements.
Changing the Appearance of Chart Elements, to use static VisualFrame
objects.

CT.14Representing Multiple Measures
To represent multiple measures on a single chart, simply define a
GraphElement object for each measure, and add the GraphElement to the
Chart.

Consider the following script.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

dataset = [["State", "Quantity 1", "Quantity 
2"],["NJ",200,500], ["NY",300,1000],["PA",370,440], 
["CT",75,20]];
graph = new EGraph();
var elem1 = new IntervalElement("State", "Quantity 1");
graph.addElement(elem1);
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This creates a basic bar chart displaying the dimensions ‘State’ and
‘Quantity 1’. To add the measure ‘Quantity 2’ to the chart as line element,
follow the steps below:

1. Create a new LineElement to represent the graph of ‘Quantity 2’ vs.
‘State’.

var elem2 = new LineElement("State", "Quantity 2"); 

2. Assign this new element to the main Chart object.

graph.addElement(elem2);

A legend is created automatically. To modify the legend, make changes to
the VisualFrame’s LegendSpec property. See Changing Legend
Properties.

See Also
Changing Legend Properties, for more details about modifying legends.
Representing Data with Shape, Color, Size, to visually break out data as
sub-series.

CT.15Adding Decorative Elements
To draw decorative elements (lines, shapes, text, etc.) on the chart, use a
GraphForm object. Consider the following example:

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

dataset = [["State", "Quantity"],["NJ", 200],["NY", 300], 
["PA", 370],["CT", 75]];
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graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
graph.addElement(elem);

This generates a basic bar chart with quantities for four different states. To
add a small note indicating that the lowest value was due to an inventory
problem, follow the steps below.

1. Create a new LineForm object, and specify location values to point
at the ‘CT’ bar.

var lineform = new LineForm();
lineform.addValues([['CT', 150],['CT', 100]]);

2. Set the line color to red, and draw an arrow at the end. 

lineform.setColor(java.awt.Color(0xff0000));
lineform.setEndArrow(true);

3. Create a new LabelForm object, and specify location values to
position it above the ‘CT’ bar.

var labelform = new LabelForm();
labelform.setValues(['CT', 150]);

4. Set the label contents, set the text color to red, and center-align. To
set the text color, create a new TextSpec object and assign it to the
LabelForm.

var labelSpec = new TextSpec();
labelSpec.setColor(java.awt.Color(0xff0000));
labelform.setTextSpec(labelSpec);
labelform.setLabel("Note: Low\nInventory");
labelform.setAlignmentX(Chart.CENTER_ALIGNMENT);

5. Assign the LineForm and LabelForm objects to the Chart object.

graph.addForm(lineform);
graph.addForm(labelform);
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The final script is shown below.

dataset = [["State", "Quantity"],["NJ", 200],["NY", 
300],["PA", 370],["CT", 75]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var lineform = new LineForm();
lineform.addValues([['CT', 150],['CT', 100]]);
lineform.setColor(java.awt.Color(0xff0000));
lineform.setEndArrow(true);
var labelform = new LabelForm();
labelform.setValues(['CT', 150]);

var labelSpec = new TextSpec();
labelSpec.setColor(java.awt.Color(0xff0000));
labelform.setTextSpec(labelSpec);
labelform.setLabel("Note: Low\nInventory");
labelform.setAlignmentX(Chart.CENTER_ALIGNMENT);
graph.addForm(lineform);
graph.addForm(labelform);
graph.addElement(elem);
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Appendix CR: Chart Script Reference

This appendix lists all of the JavaScript objects and properties available for
use in Style Chart scripts. Many of these properties are also exposed within
Style Studio’s Report Element panel.

CR.1 Chart Object

The Chart element presents datasets as visual graphs. 

See Also
Modifying Chart Properties, for examples of setting chart properties in
script.
Modifying a Chart Data Binding, for examples of modifying field
bindings.
Modifying a Chart Element using API Functions, for examples of
modifying the contents of a chart.

CR.1.1 General Properties

This section presents general Chart properties.

QUERY

Specifies the data block to be used by the Chart component. The available
data blocks appear at the top of the Component panel in Visual Composer.

Type
string

Example
query = 'SalesByDate';

See Also
Modifying a Chart Data Binding, for an example of data binding.

GRAPH

Specifies the EGraph object to be rendered by the Chart element.
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Type
EGraph

Example
graph = new EGraph();

See Also
Creating a Chart Using API Functions, for an example of how to create a
chart.

SETHYPERLINK(COL, HYPERLINK)

Adds hyperlinks to a chart dataset. Use setParameterField to specify
values to pass as parameters in the link and setTargetFrame to specify the
link’s target frame. See the example below.

Parameter
col dataset index, first dataset is “1”
hyperlink string or 

inetsoft.report.Hyperlink.Ref object

Example 1
var link = new inetsoft.report.Hyperlink("www.google.com", 
inetsoft.report.Hyperlink.WEB_LINK);
link.setParameterField("test", "Sales");
link.setTargetFrame("_blank");
setHyperlink(1, link); 

Alternatively, you can pass all of this information within a single array as
the second argument to the function. See the example below. The Boolean
item in the array indicates whether the hyperlink targets a report/Viewsheet
(true) or a web site (false).

Example 2
setHyperlink(1, ["report1", [["param1", "value1"], 
["param2", "value2"],...]], true, "_blank")

CR.1.2 General Axis Properties

This section presents the general properties available for both dimensions
and measures. Properties should be prefixed by one of the following:

axis['Dimension Name']
or

axis['Measure Name']

Example
Chart1.axis['Company'].lineColor = [0,255,255];
Chart1.axis['Sum(Total)'].lineColor = [0,255,255];

AXIS.LABELVISIBLE

Sets the visibility of the dimension or measure axis labels.
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Type
Boolean

Example
Chart1.axis['Company'].labelVisible = false;

AXIS.LINEVISIBLE

Sets the visibility of the dimension or measure axis line.

Type
Boolean

Example
Chart1.axis['Company'].lineVisible = false;

AXIS.TICKSVISIBLE

Sets the visibility of the axis tick marks for a dimension or measure.

Type
Boolean

Example
Chart1.axis['Sum(Total)'].ticksVisible = false
Chart1.axis['Company'].ticksVisible = true
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AXIS.LINECOLOR

Sets the color of the dimension or measure axis line.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.axis['Company'].lineColor = [255,0,0];
Chart1.axis['Company'].lineColor = {r:255,g:0,b:0}

AXIS.LABELCOLOR

Sets the color of the dimension or measure axis labels.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.axis['Company'].labelColor = [255,0,0];
Chart1.axis['Company'].labelColor = {r:255,g:0,b:0}

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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AXIS.FONT

Use ‘Edit Value’ in
the Script Editor’s
auto-complete menu
to specify font
descriptions.

Sets the font of the dimension or measure axis labels.

Type
java.awt.Font, or 
font description

Example
Chart1.axis['Company'].font = 

new java.awt.Font('Serif', java.awt.Font.BOLD, 12);
Chart1.axis['Company'].font ='Lucida Sans Unicode-BOLD-14'

AXIS.ROTATION

Use ‘Edit Value’ in
the Script Editor’s
auto-complete menu
to specify font
descriptions.

Sets the rotation of the dimension or measure axis labels.

Type
number (degrees)

Example
Chart1.axis['Company'].rotation = 30;

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Font.html
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AXIS.FORMAT

Sets the format for dimension or measure axis labels. The available formats
are shown below:

  – Chart.DATE_FORMAT for date display
  – Chart.DECIMAL_FORMAT for number display
  – Chart.MESSAGE_FORMAT for text display
  – Chart.PERCENT_FORMAT for fraction display 
  – Chart.CURRENCY_FORMAT for locale-adapting currency display

For the Date, Decimal, and Message formats, optionally specify the format
and mask as items in an array. See Format Types in Advanced Report
Design and Format Tab in Advanced Dashboard Design for more
information about the masks.

Type
Constant (format) or Array ([format, mask])

Example (Number)
Chart1.axis['Sum(Total)'].format = 
[Chart.DECIMAL_FORMAT,"#,###.00"];

Example (Text)
Chart1.axis['Company'].format = [Chart.MESSAGE_FORMAT,"{0} 
Inc."];
Chart1.axis['Company'].rotation = 30;
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CR.1.3 Measure Axis Properties

This section presents the properties available specifically for a measure
axis. Properties should be prefixed by axis['Measure Name'].

Example
Chart1.axis['Sum(Total)'].increment = 300000

AXIS.MAXIMUM

Sets the maximum value for a measure axis.

Type
number

Example
Chart1.axis['Sum(Total)'].maximum = 1500000;

AXIS.MINIMUM

Sets the minimum value for a measure axis.

Type
number

Example
Chart1.axis['Sum(Total)'].minimum = 500000

AXIS.INCREMENT

Sets the numerical increment for measure axis labels.
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Type
number

Example
Chart1.axis['Sum(Total)'].increment = 300000

AXIS.MINORINCREMENT

Sets the numerical increment for measure axis tick marks.

Type
number

Example
Chart1.axis['Sum(Total)'].increment = 500000
Chart1.axis['Sum(Total)'].minorIncrement = 100000

AXIS.LOGARITHMIC

Sets logarithmic scaling for a measure axis.

Type
Boolean

Example
Chart1.axis['Sum(Total)'].logarithmic = true
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AXIS.REVERSED

Reverses the direction of the axis scale so that higher numbers appear at the
bottom or left.

Type
Boolean

Example
Chart1.axis['Sum(Total)'].reversed = true;

AXIS.SHAREDRANGE

For a facet chart (a chart with multiple bound X-fields and Y-fields),
specifies whether the same scale range should be used across all sub-graphs
in a facet, or whether a sub-graph’s scaling should be shared only with sub-
graphs in the same row (for Y-axis scaling) or same column (for X-axis
scaling).

Type
Boolean

Example
Chart1.yAxis.sharedRange = false;
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XAXIS

Provides a shortcut to set axis properties for the all X-axes.

Example
Chart1.xAxis.labelColor=[255,0,0];
Chart1.xAxis.rotation=30;

The available properties are listed in General Axis Properties and Measure
Axis Properties.

To set properties for a particular X-axis (e.g., ‘Category’), use the axis
property together with the axis name:

Chart1.axis.Category.labelColor=[255,0,0];
Chart1.axis.Category.rotation=30;

See Also
yaxis, to set properties for Y-axes.

YAXIS

Provides a shortcut to set axis properties for all Y-axes.

Example
Chart1.yAxis.minorIncrement = 1000;
Chart1.yAxis.labelColor = [255,0,0]

The available properties are listed in General Axis Properties and Measure
Axis Properties.

To set properties for a particular Y-axis (e.g., ‘Total’), use the axis property
together with the axis name:

Chart1.axis['Sum(Total)'].minorIncrement = 1000;
Chart1.axis['Sum(Total)'].labelColor = [255,0,0];

See Also
xaxis, to set properties for X-axes.
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y2axis, to set properties for secondary Y-axes.

Y2AXIS

Provides a shortcut to set axis properties for all secondary Y-axes. This only
applies to a measure axes that have been marked as ‘Secondary Axis’.

Example
Chart1.y2Axis.minorIncrement=1000
Chart1.y2Axis.labelColor=[255,0,0]

The available properties are listed in General Axis Properties and Measure
Axis Properties.

See Also
Single Chart vs. Separate Charts, in Dashboard Design or Report Design
for information about setting a secondary axis.
yaxis, to set properties for primary Y-axes.

CR.1.4 Title Properties

This section presents properties available for Graph titles. Title properties
should be prefixed by either xTitle or yTitle.

Example
Chart1.xTitle.text = "New Jersey Employees"
Chart1.yTitle.text = "New Jersey Sales"

XTITLE.TEXT

Sets the X-axis title text.

Type
string

Example
Chart1.xTitle.text = "New Jersey Employees"

YTITLE.TEXT 

Sets the Y-axis title text.

Type
string

Example
Chart1.yTitle.text = "New Jersey Sales"
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XTITLE.FONT

Use ‘Edit Value’ in
the Script Editor’s
auto-complete menu
to specify font
descriptions.

Sets the X-axis title font.

Type
java.awt.Font, or 
font description

Example
Chart1.xTitle.font = new java.awt.Font('Serif', 
java.awt.Font.BOLD, 12);
Chart1.xTitle.font = 'Lucida Sans Unicode-BOLD-14'

YTITLE.FONT

Use ‘Edit Value’ in
the Script Editor’s
auto-complete menu
to specify font
descriptions.

Sets the Y-axis title font.

Type
java.awt.Font, or 
font description

Example
Chart1.yTitle.font = new java.awt.Font('Serif', 
java.awt.Font.BOLD, 12);
Chart1.yTitle.font ='Lucida Sans Unicode-BOLD-14'

XTITLE.ROTATION

Sets the X-axis title rotation angle.

Type
number (degrees)

Example
Chart1.xTitle.rotation = 30;

YTITLE.ROTATION

Sets the Y-axis title rotation angle.

Type
number (degrees)

Example
Chart1.yTitle.rotation = 30;

XTITLE.COLOR 

Sets the X-axis title color.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Font.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Font.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.xTitle.color = [128,0,128];
Chart1.xTitle.color = {r:128,g:0,b:128}

YTITLE.COLOR

Sets the Y-axis title color.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.yTitle.color = [128,0,128];
Chart1.yTitle.color = {r:128,g:0,b:128}

XTITLE.VISIBLE

Sets the visibility of the X-axis title.

Type
Boolean

Example
Chart1.xTitle.visible = false
Chart1.xTitle.visible = true

YTITLE.VISIBLE

Sets the visibility of the Y-axis title.

Type
Boolean

Example
Chart1.yTitle.visible = false
Chart1.yTitle.visible = true

X2TITLE.TEXT

Sets the title text for the secondary (top) X-axis.

Type
string

Example
Chart1.x2Title.text = "New Jersey Employees"

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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Y2TITLE.TEXT 

Sets the title text for the secondary (right) Y-axis.

Type
string

Example
Chart1.y2Title.text = "New Jersey Sales"

X2TITLE.FONT

Use ‘Edit Value’ in
the Script Editor’s
auto-complete menu
to specify font
descriptions.

Sets the title font for the secondary (top) X-axis.

Type
java.awt.Font, or 
font description

Example
Chart1.x2Title.font = new java.awt.Font('Serif', 
java.awt.Font.BOLD, 12);
Chart1.x2Title.font ='Lucida Sans Unicode-BOLD-14'

Y2TITLE.FONT

Use ‘Edit Value’ in
the Script Editor’s
auto-complete menu
to specify font
descriptions.

Sets the title font for the secondary (right) Y-axis.

Type
java.awt.Font, or 
font description

Example
Chart1.y2Title.font = new java.awt.Font('Serif', 
java.awt.Font.BOLD, 12);
Chart1.y2Title.font ='Lucida Sans Unicode-BOLD-14'

X2TITLE.ROTATION

Sets the title rotation angle for the secondary (top) X-axis.

Type
number (degrees)

Example
Chart1.x2Title.rotation = 30;

Y2TITLE.ROTATION

Sets the title rotation angle for the secondary (right) Y-axis.

Type
number (degrees)

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Font.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Font.html
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Example
Chart1.y2Title.rotation = 30;

X2TITLE.COLOR 

Sets the title color for the secondary (top) X-axis.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.x2Title.color = [128,0,128];
Chart1.x2Title.color = {r:128,g:0,b:128}

Y2TITLE.COLOR

Sets the title color for the secondary (right) Y-axis.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.y2Title.color = [128,0,128];
Chart1.y2Title.color = {r:128,g:0,b:128}

X2TITLE.VISIBLE

Sets the visibility of the secondary (top) X-axis. The default is true
(visible) if a value has been provided for the x2Title.text, otherwise false.

Type
Boolean

Example
Chart1.x2Title.visible = false
Chart1.x2Title.visible = true

Y2TITLE.VISIBLE

Sets the visibility of the secondary (right) Y-axis. The default is true
(visible) if a value has been provided for the y2Title.text, otherwise false.

Type
Boolean

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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Example
Chart1.y2Title.visible = false
Chart1.y2Title.visible = true

CR.1.5 Plot Properties

This section presents properties available for the Graph plot area. 

CHARTSTYLE

For a chart with multiple styles (‘Multiple Styles’ selected from ‘Select
Chart Style’ panel), sets the style for the specified dataset. For a chart with
a single style, sets the global style.

Type
Chart Constants constant
(see Chart Styles)

Example
Multi-style chart:
Chart1.chartStyle['Sum(Total)'] = Chart.CHART_LINE

Single-style chart:
Chart1.chartStyle = Chart.CHART_LINE

FILLTIMEGAP 

When you designate a dimension as a “time series” (see
bindingInfo.setTimeSeries(col,boolean)), the fillTimeGap property
specifies how missing data is represented on the chart. When fillTimeGap
is false, the plotted lines simply ignore the missing data and connect
adjacent points on the chart. When fillTimeGap is true, the behavior for
missing data is determined by the fillZero property.

Type
Boolean

The following examples display a time-series which is missing data for the
month of April 2009. To create this time-series, bind a chart to the ‘Sales’ >
‘Sales Explore’ Worksheet. Place the ‘Date’ field on the X-axis (with
‘Level’ = ‘Month’) and place ‘Total’ on the Y-axis. To simulate missing
data, add a condition to the chart to filter out data from April 2009. Use the
scripts below to modify the way the chart represents the missing data for
April 2009.

Example 1
Chart1.fillTimeGap = false
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Example 2
Chart1.fillTimeGap = true
Chart1.fillZero = false

Example 3
Chart1.fillTimeGap = true
Chart1.fillZero = true

FILLZERO 

When you set fillTimeGap to true or set the corresponding property in the
dialog box, the fillZero property determines whether gaps are represented
as ‘Null’, which leaves an empty space at the location, or as ‘Zero’, which
inserts a numerical value of 0 at the location.

Type
Boolean

Example 1
Chart1.fillTimeGap = true
Chart1.fillZero = false
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Example 2
Chart1.fillTimeGap = true
Chart1.fillZero = true

MAPTYPE

Specifies the type of map (region of globe displayed). 

Type
Chart Constants constant or
String: 'U.S.', 'Asia', 'Canada', 'Europe', 'Mexico'

'World'

Example
Chart1.mapType = Chart['MAP_TYPE_U.S.'];
Chart1.mapType = 'U.S.'

VALUEFONT 

Use ‘Edit Value’ in
the Script Editor’s
auto-complete menu
to specify font
descriptions.

Sets the font for data values displayed in the chart plot area.

Type
java.awt.Font, or 
font description

Example
Chart1.valueFont = new java.awt.Font('Serif', 
java.awt.Font.BOLD, 12);
Chart1.valueFont='Lucida Sans Unicode-BOLD-14'

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Font.html
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See Also
valueFormats, to set the font of a value on a multi-style chart.

VALUEFORMAT

Sets the format for data values displayed in the chart plot area. The
available formats are shown below:

  – Chart.DATE_FORMAT for date display
  – Chart.DECIMAL_FORMAT for number display
  – Chart.MESSAGE_FORMAT for text display
  – Chart.PERCENT_FORMAT for fraction display 
  – Chart.CURRENCY_FORMAT for locale-adapting currency display

For the Date, Decimal, and Message formats, optionally specify the format
and mask as items in an array. See Format Types in Advanced Report
Design and Format Tab in Advanced Dashboard Design for more
information about the masks.

Type
Constant (format) or Array ([format, mask])

Example (Number)
Chart1.valueFormat = [Chart.DECIMAL_FORMAT,"#,###.00"];

Example (Text)
Chart1.valueFormat = [Chart.MESSAGE_FORMAT,"{0} Dollars"];
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See Also
valueFormats, to set the format of a value on a multi-style chart.

VALUEROTATION

Sets the rotation angle for data values displayed in the chart plot area.

Type
number (degrees)

Example
Chart1.valueRotation = 30;

See Also
valueFormats, to set the rotation of a value on a multi-style chart.

VALUECOLOR

Sets the color for data values displayed in the chart plot area.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.valueColor = [255,0,255];
Chart1.valueColor = {r:255,g:0,b:255};

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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See Also
valueFormats, to set the color of a value on a multi-style chart.

VALUEFORMATS

Provides access to value formatting for Charts that have ‘Multiple Styles’
enabled. (See Setting a Chart Style for an Individual Dataset in Advanced
Dashboard Design or Setting a Chart Style for an Individual Dataset in
Advanced Report Design for information about the ‘Multiple Styles’
property.) To format a measure in a multiple-style chart, set the
valueFormats property for the desired measure.

Example
Chart1.valueFormats['Sum(Quantity Purchased)'].color= 
[255,0,0];
Chart1.valueFormats['Sum(Quantity Purchased)'].rotation = 
30;
Chart1.valueFormats['Sum(Total)'].color = [0,0,255];
Chart1.valueFormats['Sum(Total)'].format = 
[Chart.DECIMAL_FORMAT,"$#,###.00"]
Chart1.valueFormats['Sum(Total)'].font = 'Lucida Sans 
Unicode-BOLD-8';

For information about the valueFormats sub-properties (color, font,
format, rotation), see the following: valueColor, valueFont, valueFormat,
valueRotation. To format all measures in a multiple-style chart, use one of
these properties.

See Also
valueColor, to specify value color in a single-style chart.
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valueFont, to specify value font in a single-style chart.
valueFormat, to specify value format in a single-style chart.
valueRotation, to specify value rotation in a single-style chart.

VALUEVISIBLE 

Sets the visibility for data values displayed in the chart plot area.

Type
Boolean

Example
Chart1.valueVisible = false;

ADDCONFIDENCEINTERVALTARGET(MEASURE, COLORS, VALUES,
OPTIONS) 

Draws a set of horizontal or vertical confidence intervals on the chart. 

Parameter
measure Name of measure on which to draw confidence 
intervals
colors Color (see valueColor) or array of colors to 
fill area of confidence intervals
values Confidence level as a percentage (e.g., '99' 
for 99% confidence interval)
options Name-value pairs of options (see below, e.g., 
{fillAbove:0xff0000, fillBelow:0x00ff00})

Options
fillAbove Color (see valueColor) to fill the 
region above the upper confidence line
fillBelow Color (see valueColor) to fill the 
region below the lower confidence line
label String to label the confidence line(s). 
The following codes can be inserted:

{0}: Target value
{1}: Target formula
{2}: Field name

lineColor Color (see valueColor) to apply to all 
confidence lines
lineStyle The line style (a Line Styles constant) 
to apply to all confidence lines
labelFont The font description (e.g., 'Lucida 
Sans Unicode-BOLD-14') to apply to all line labels
labelColor The color (see valueColor) to apply to 
all line labels

Example
var options = 
{fillAbove:[225,225,225],fillBelow:[225,225,225],label:['{1
}: {0,number,$#,##0}','{1}: 
{0,number,$#,##0}'],lineColor:'red',lineStyle:Chart.THICK_L
INE,labelFont:'Lucida Sans Unicode-BOLD-
11',labelColor:'black'}
addConfidenceIntervalTarget('Sum(Product.Total)',0xDDAAAA,
99,options)
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See Also
Adding a Statistical Measure, in Advanced Report Design, for more
information about target lines.
Adding a Statistical Measure, in Advanced Dashboard Design, for more
information about target lines.

ADDPERCENTAGETARGET(MEASURE, COLORS, VALUES, OPTIONS) 

Draws a set of horizontal or vertical lines on the chart to mark the specified
percentage figures. 

Parameter
measure Name of measure on which to draw percentage 
lines
colors Color (see valueColor) or array of colors to 
fill areas between percentage lines
values Percentage, or array of percentages, at which 
to draw lines
options Name-value pairs of options (see below, e.g., 
{fillAbove:0xff0000, fillBelow:0x00ff00})

Options
fillAbove Color (see valueColor) to fill the 
region above the upper percentage line
fillBelow Color (see valueColor) to fill the 
region below the lower percentage line
label String, or array of strings, to label 
the percentage line(s). The following codes can be inserted:

{0}: Target value
{1}: Target formula
{2}: Field name

lineColor Color (see valueColor) to apply to all 
percentage lines
lineStyle The line style (a Line Styles constant) 
to apply to all percentage lines
labelFont The font description (e.g., 'Lucida 
Sans Unicode-BOLD-14') to apply to all line labels
labelColor The color (see valueColor) to apply to 
all line labels
percentageAggregate The basis on which to compute the 
percentage: 'Average', 'Minimum', 'Maximim', 'Median', 'Sum'

Example (Single Percentage Line)
var options = 
{fillAbove:[225,225,225],fillBelow:[225,225,225],label:['{1
}: 
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{0,number,$#,##0}'],lineColor:'red',lineStyle:Chart.THICK_L
INE,labelFont:'Lucida Sans Unicode-BOLD-
11',labelColor:'black',percentageAggregate:'Average'}
addPercentageTarget('Sum(Product.Total)','null',125,option
s)

Example (Multiple Percentage Lines)
var options = 
{fillAbove:[225,225,225],fillBelow:[225,225,225],label:['{1
}: {0,number,$#,##0}','{1}: 
{0,number,$#,##0}'],lineColor:'red',lineStyle:Chart.THICK_L
INE,labelFont:'Lucida Sans Unicode-BOLD-
11',labelColor:'black',percentageAggregate:'Maximum'}
addPercentageTarget('Sum(Product.Total)',[0xDDAAAA,0xDDCCC
C],[30,60,90],options)

See Also
Adding a Statistical Measure, in Advanced Report Design, for more
information about target lines.
Adding a Statistical Measure, in Advanced Dashboard Design, for more
information about target lines.

ADDPERCENTILETARGET(MEASURE, COLORS, VALUES, OPTIONS) 

Draws a set of horizontal or vertical lines on the chart to mark the specified
percentiles. 

Parameter
measure Name of measure on which to draw percentile 
lines
colors Color (see valueColor) or array of colors to 
fill areas between percentile lines
values Percentage, or array of percentages, at which 
to draw lines
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options Name-value pairs of options (see below, e.g., 
{fillAbove:0xff0000, fillBelow:0x00ff00})

Options
fillAbove Color (see valueColor) to fill the 
region above the upper percentile line
fillBelow Color (see valueColor) to fill the 
region below the lower percentile line
label String, or array of strings, to label 
the percentile line(s). The following codes can be inserted:

{0}: Target value
{1}: Target formula
{2}: Field name

lineColor Color (see valueColor) to apply to all 
percentile lines
lineStyle The line style (a Line Styles constant) 
to apply to all percentile lines
labelFont The font description (e.g., 'Lucida 
Sans Unicode-BOLD-14') to apply to all line labels
labelColor The color (see valueColor) to apply to 
all line labels

Example (Single Percentile Line)
var options = 
{fillAbove:[225,225,255],fillBelow:[225,225,225],label:['{1
}: 
{0,number,$#,##0}'],lineColor:'red',lineStyle:Chart.THICK_L
INE,labelFont:'Lucida Sans Unicode-BOLD-
11',labelColor:'black'}
addPercentileTarget('Sum(Product.Total)','null',95,options
)

Example (Multiple Percentage Lines)
var options = 
{fillAbove:[225,225,255],fillBelow:[225,225,225],label:['{1
}: {0,number,$#,##0}','{1}: {0,number,$#,##0}','{1}: 
{0,number,$#,##0}'],lineColor:'red',lineStyle:Chart.THICK_L
INE,labelFont:'Lucida Sans Unicode-BOLD-
11',labelColor:'black'}
addPercentileTarget('Sum(Product.Total)',[0xDDAAAA,0xDDCCC
C],[50,75,90],options)
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See Also
Adding a Statistical Measure, in Advanced Report Design, for more
information about target lines.
Adding a Statistical Measure, in Advanced Dashboard Design, for more
information about target lines.

ADDQUANTILETARGET(MEASURE, COLORS, VALUES, OPTIONS) 

Draws a set of horizontal or vertical lines on the chart to mark the specified
quantiles. 

Parameter
measure Name of measure on which to draw quantile 
lines
colors Color (see valueColor) or array of colors to 
fill areas between quantile lines
values Number of quantiles at which to draw lines
options Name-value pairs of options (see below, e.g., 
{fillAbove:0xff0000, fillBelow:0x00ff00})

Options
fillAbove Color (see valueColor) to fill the 
region above the upper quantile line
fillBelow Color (see valueColor) to fill the 
region below the lower quantile line
label String, or array of strings, to label 
the quantile line(s). The following codes can be inserted:

{0}: Target value
{1}: Target formula
{2}: Field name

lineColor Color (see valueColor) to apply to all 
quantile lines
lineStyle The line style (a Line Styles constant) 
to apply to all quantile lines
labelFont The font description (e.g., 'Lucida 
Sans Unicode-BOLD-14') to apply to all line labels
labelColor The color (see valueColor) to apply to 
all line labels

Example
var options = 
{fillAbove:[225,225,255],fillBelow:[225,225,225],label:['{1
}: {0,number,$#,##0}','{1}: {0,number,$#,##0}','{1}: 
{0,number,$#,##0}'],lineColor:'red',lineStyle:Chart.THICK_L
INE,labelFont:'Lucida Sans Unicode-BOLD-
11',labelColor:'black'}
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addQuantileTarget('Sum(Product.Total)',[0xDDAAAA,0xDDCCCC]
,4,options)

See Also
Adding a Statistical Measure, in Advanced Report Design, for more
information about target lines.
Adding a Statistical Measure, in Advanced Dashboard Design, for more
information about target lines.

ADDSTANDARDDEVIATIONTARGET(MEASURE, COLORS, VALUES,
OPTIONS) 

Draws a set of horizontal or vertical lines on the chart to mark the specified
number of standard deviations from the mean. 

Parameter
measure Name of measure on which to draw standard 
deviation lines
colors Color (see valueColor) or array of colors to 
fill areas between standard deviation lines
values Array of multipliers for which to draw 
standard deviation lines
options Name-value pairs of options (see below, e.g., 
{fillAbove:0xff0000, fillBelow:0x00ff00})

Options
fillAbove Color (see valueColor) to fill the 
region above the upper standard deviation line
fillBelow Color (see valueColor) to fill the 
region below the lower standard deviation line
label String, or array of strings, to label 
the standard deviation line(s). The following codes can be 
inserted:

{0}: Target value
{1}: Target formula
{2}: Field name

lineColor Color (see valueColor) to apply to all 
standard deviation lines
lineStyle The line style (a Line Styles constant) 
to apply to all standard deviation lines
labelFont The font description (e.g., 'Lucida 
Sans Unicode-BOLD-14') to apply to all line labels
labelColor The color (see valueColor) to apply to 
all line labels
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Example
var options = 
{fillAbove:[225,225,225],fillBelow:[225,225,225],label:['{1
}: {0,number,$#,##0}','{1}: {0,number,$#,##0}','{1}: 
{0,number,$#,##0}','{1}: 
{0,number,$#,##0}'],lineColor:'red',lineStyle:Chart.THICK_L
INE,labelFont:'Lucida Sans Unicode-BOLD-
11',labelColor:'black'}
addStandardDeviationTarget('Sum(Product.Total)',[0xDDCCCC,
0xDDAAAA,0xDDCCCC],[-1,1,-2,2],options)

See Also
Adding a Statistical Measure, in Advanced Report Design, for more
information about target lines.
Adding a Statistical Measure, in Advanced Dashboard Design, for more
information about target lines.

ADDTARGETBAND(MEASURE, COLORS, VALUES, OPTIONS) 

Draws a set of horizontal or vertical target bands in the plot area using the
specified colors and options. 

Parameter
measure Name of measure on which to draw target bands
colors Color (see valueColor) or array of colors to 
fill area of bands
values Array of values and/or valid aggregation 
methods ('max','min','avg','med') at which to draw the band 
lines 
options Name-value pairs of options (see below, e.g., 
{fillAbove:0xff0000, fillBelow:0x00ff00})

Options
fillAbove Color (see valueColor) to fill the 
region above the upper band line
fillBelow Color (see valueColor) to fill the 
region below the lower band line
label String to label the target band(s). The 
following codes can be inserted:

{0}: Target value
{1}: Target formula
{2}: Field name

lineColor Color (see valueColor) to apply to all 
target band lines
lineStyle The line style (a Line Styles constant) 
to apply to all target band lines
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labelFont The font description (e.g., 'Lucida 
Sans Unicode-BOLD-14') to apply to all band labels
labelColor The color (see valueColor) to apply to 
all band labels

Example (One Target Band)
var options = 
{fillAbove:[225,225,225],fillBelow:[225,225,225],label:['{1
}','{1}'],lineColor:'red',lineStyle:Chart.THICK_LINE,labelF
ont:'Lucida Sans Unicode-BOLD-11',labelColor:'black'}
addTargetBand('Sum(Product.Total)',0xDDAAAA,['min','avg'],
options)

Example (Multiple Target Bands)
var options = 
{fillAbove:[225,225,225],fillBelow:[225,225,225],label:['{1
}: {0,number,$#,##0}','{1}: {0,number,$#,##0}','{1}: 
{0,number,$#,##0}'],lineColor:'red',lineStyle:Chart.THICK_L
INE,labelFont:'Lucida Sans Unicode-BOLD-
11',labelColor:'black'}
addTargetBand('Sum(Product.Total)',[0xDDAAAA,0xAAAADD],['m
in','avg','max'],options)

See Also
Adding a Target Band, in Advanced Report Design, for more information
about target lines.
Adding a Target Band, in Advanced Dashboard Design, for more
information about target lines.

ADDTARGETLINE(MEASURE, COLORS, VALUES, OPTIONS) 

Draws a set of horizontal or vertical target lines in the plot area using the
specified colors and options. 
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Parameter
measure Name of measure on which to draw target line
colors Color (see valueColor) or array of colors to 
fill area between target lines
values Array of values and/or valid aggregation 
methods ('max','min','avg','med') at which to draw the lines 
options Name-value pairs of options (see below, e.g., 
{fillAbove:0xff0000, fillBelow:0x00ff00})

Options
fillAbove Color (see valueColor) to fill the 
region above the target line
fillBelow Color (see valueColor) to fill the 
region below the target line
label String to label the target line(s). The 
following codes can be inserted:

{0}: Target value
{1}: Target formula
{2}: Field name

lineColor Color (see valueColor) to apply to all 
target lines
lineStyle The line style (a Line Styles constant) 
to apply to all target lines
labelFont The font description (e.g., 'Lucida 
Sans Unicode-BOLD-14') to apply to all target labels
labelColor The color (see valueColor) to apply to 
all target labels

Example (One Target Line)
var options = 
{fillAbove:[200,200,255],fillBelow:[225,225,225],label:'Val
ue: {0}',lineColor:'blue'}
addTargetLine('Sum(Product.Total)',null,2500000,options)

Example (Multiple Target Lines)
var options = 
{fillAbove:[200,200,200],fillBelow:[200,200,200],label:['{1
}: {0,number,$#,##0}','{1}: 
{0,number,$#,##0}'],lineColor:'blue',lineStyle:Chart.DASH_L
INE,labelFont:'Lucida Sans Unicode-BOLD-
11',labelColor:'black'}
addTargetLine('Sum(Product.Total)',0xDD99DD,['avg','max'],
options)
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See Also
Adding a Target Line, in Advanced Report Design, for more information
about target lines.
Adding a Target Line, in Advanced Dashboard Design, for more
information about target lines.

APPLYEFFECT 

Enables a 3d visual effect for chart elements.

Type
Boolean

Example
Chart1.applyEffect = true
Chart2.applyEffect = false

PLOTALPHA 

Sets the transparency of chart elements (bars, lines, points, etc.). A value of
0 indicates complete transparency (i.e., chart elements not visible), and a
value of 1 indicates complete opacity. 

Type
Number Number in range [0,1]

Example
Chart1.plotAlpha = .5;
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PIEEXPLODED 

Separates the slices of a pie chart by a small gap.

Type
Boolean

Example
Chart1.pieExploded = true

XGRIDCOLOR

Sets the X-axis grid color.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.xGridColor = [255,0,0];
Chart1.xGridColor = {r:255,g:0,b:0}

YGRIDCOLOR 

Sets the Y-axis grid color.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.yGridColor = [255,0,0];
Chart1.yGridColor = {r:255,g:0,b:0}

XGRIDSTYLE

Sets the X-axis grid style. A grid line is drawn at each axis tick.

Type
Chart Constants constant
(see Line Styles)

Example
Chart1.yGridStyle=Chart.DOT_LINE
Chart1.xGridStyle=Chart.THICK_LINE

YGRIDSTYLE

Sets the Y-axis grid style. A grid line is drawn at each axis tick.

Type
Chart Constants constant
(see Line Styles)

Example
Chart1.yGridStyle=Chart.DOT_LINE
Chart1.xGridStyle=Chart.THICK_LINE
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XBANDCOLOR

Displays bands of the specified color on a categorical or timescale X-axis.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.xBandColor = [150,150,200];
Chart1.xBandColor = {r:150,g:150,b:200};

See Also
xBandSize, to set the band thickness.

YBANDCOLOR

Displays bands of the specified color on a categorical or timescale Y-axis.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.yBandColor = [220,220,255];
Chart1.yBandColor = {r:220,g:220,b:255};

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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See Also
yBandSize, to set the band thickness.

XBANDSIZE

Specifies the width of the bands on a categorical or timescale X-axis. The
band size is an integer indicating the number of category groups (for a
categorical axis) or the number of date groups (for a timescale axis) to be
spanned by each band. 

Type
integer number of groups spanned by band

Example
Chart1.xBandSize = 2;

See Also
xBandColor, to set the band color.

YBANDSIZE

Specifies the width of the bands on a categorical or timescale Y-axis. The
band size is an integer indicating the number of category groups (for a
categorical axis) or the number of date groups (for a timescale axis) to be
spanned by each band. 

Type
integer number of groups spanned by band
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Example
Chart1.yBandSize = 3;

See Also
yBandColor, to set the band color.

QUADRANTCOLOR 

Sets the color of the quadrant lines.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.quadrantColor=[255,0,0];
Chart1.quadrantStyle=Chart.DOT_LINE;

QUADRANTSTYLE

Sets the style of the quadrant lines. 

Type
Chart Constants constant
(see Line Styles)

Example
Chart1.quadrantColor=[255,0,0];

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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Chart1.quadrantStyle=Chart.DOT_LINE;

DIAGONALCOLOR 

Sets the color of the diagonal line.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.diagonalColor=[255,0,0];
Chart1.diagonalStyle=Chart.DOT_LINE;

DIAGONALSTYLE

Sets the style of the diagonal line. 

Type
Chart Constants constant
(see Line Styles)

Example
Chart1.diagonalColor=[255,0,0];
Chart1.diagonalStyle=Chart.DOT_LINE;

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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LEGENDPOSITION

Sets the legend position relative to the chart. Set the property to Chart.NONE
to hide the legend.

Type
Chart Constants constant
(see Legend Positions)

Example
Chart1.legendPosition = Chart.LEFT;

LEGENDBORDER

Sets the legend border line style. Set the property to Chart.NONE to hide the
legend border.

Type
Chart Constants constant
(see Line Styles)

Example
Chart1.legendBorder = Chart.DASH_LINE;
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LEGENDBORDERCOLOR

Sets the color of the legend border.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.legendBorderColor = [255,0,0];
Chart1.legendBorderColor = {r:255,g:0,b:0}

LEGENDTITLEFONT 

Use ‘Edit Value’ in
the Script Editor’s
auto-complete menu
to specify font
descriptions.

Sets the font for the legend title.

Type
java.awt.Font, or 
font description

Example
Chart1.legendTitleFont = new java.awt.Font('Serif', 
java.awt.Font.BOLD, 12);
Chart1.legendTitleFont = 'Comic Sans MS-BOLD-14';

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Font.html
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LEGENDTITLECOLOR

Sets the color of the legend title text.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.legendTitleColor = [255,0,0];
Chart1.legendTitleColor = {r:255,g:0,b:0}

COLORLEGEND.FONT 

Use ‘Edit Value’ in
the Script Editor’s
auto-complete menu
to specify font
descriptions.

Sets the font for labels within a color-key legend.

Type
java.awt.Font, or 
font description

Example
Chart1.colorLegend.font = new java.awt.Font('Serif', 
java.awt.Font.BOLD, 12);
Chart1.colorLegend.font = 'Comic Sans MS-BOLD-12';

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Font.html
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SHAPELEGEND.FONT 

Use ‘Edit Value’ in
the Script Editor’s
auto-complete menu
to specify font
descriptions.

Sets the font for labels within a shape-key legend.

Type
java.awt.Font, or 
font description

Example
Chart1.shapeLegend.font = new java.awt.Font('Serif', 
java.awt.Font.BOLD, 12);
Chart1.shapeLegend.font = 'Comic Sans MS-BOLD-12';

SIZELEGEND.FONT 

Use ‘Edit Value’ in
the Script Editor’s
auto-complete menu
to specify font
descriptions.

Sets the font for labels within a size-key legend.

Type
java.awt.Font, or 
font description

Example
Chart1.sizeLegend.font = new java.awt.Font('Serif', 
java.awt.Font.BOLD, 12);
Chart1.sizeLegend.font = 'Comic Sans MS-BOLD-12';

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Font.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Font.html
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COLORLEGEND.COLOR

Sets the color for labels within a color-key legend.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.colorLegend.color = [255,0,0];
Chart1.colorLegend.color = {r:255,g:0,b:0}

SHAPELEGEND.COLOR

Sets the color for labels within a shape-key legend.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.shapeLegend.color = [255,0,0];
Chart1.shapeLegend.color = {r:255,g:0,b:0}

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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SIZELEGEND.COLOR

Sets the color for labels within a size-key legend.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Example
Chart1.sizeLegend.color = [255,0,0];
Chart1.sizeLegend.color = {r:255,g:0,b:0}

COLORLEGEND.TITLE 

Sets the legend title for a color-key legend.

Type
String

Example
Chart1.colorLegend.title = 'Salesperson';

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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SHAPELEGEND.TITLE 

Sets the legend title for a shape-key legend.

Type
String

Example
Chart1.shapeLegend.title = 'Salesperson';

SIZELEGEND.TITLE 

Sets the legend title for a size-key legend.

Type
String

Example
Chart1.sizeLegend.title = 'Salesperson';
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COLORLEGEND.TITLEVISIBLE 

Sets the visibility of the legend title bar for a color-key legend.

Type
Boolean

Example
Chart1.colorLegend.titleVisible = false;

SHAPELEGEND.TITLEVISIBLE 

Sets the visibility of the legend title bar for a shape-key legend.

Type
Boolean

Example
Chart1.shapeLegend.titleVisible = false;

SIZELEGEND.TITLEVISIBLE 

Sets the visibility of the legend title bar for a size-key legend.

Type
Boolean

Example
Chart1.sizeLegend.titleVisible = false;
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COLORLEGEND.FORMAT 

Sets the format for data values displayed in the color legend. The available
formats are shown below:

  – Chart.DATE_FORMAT for date display
  – Chart.DECIMAL_FORMAT for number display
  – Chart.MESSAGE_FORMAT for text display
  – Chart.PERCENT_FORMAT for fraction display 
  – Chart.CURRENCY_FORMAT for locale-adapting currency display

For the Date, Decimal, and Message formats, optionally specify the format
and mask as items in an array. See Format Types in Advanced Report
Design and Format Tab in Advanced Dashboard Design for more
information about the masks.

Type
Constant (format) or Array ([format, mask])

Example (Number Format)
Chart1.colorLegend.format = 
[Chart.DECIMAL_FORMAT,"$#,##0.00"]

Example (Text Format)
Chart1.colorLegend.format = [Chart.MESSAGE_FORMAT,"{0} 
Inc."];
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SHAPELEGEND.FORMAT 

Sets the format for data values displayed in the shape legend. The available
formats are shown below:

  – Chart.DATE_FORMAT for date display
  – Chart.DECIMAL_FORMAT for number display
  – Chart.MESSAGE_FORMAT for text display
  – Chart.PERCENT_FORMAT for fraction display 
  – Chart.CURRENCY_FORMAT for locale-adapting currency display

For the Date, Decimal, and Message formats, optionally specify the format
and mask as items in an array. See Format Types in Advanced Report
Design and Format Tab in Advanced Dashboard Design for more
information about the masks.

Type
Constant (format) or Array ([format, mask])

Example (Number Format)
Chart1.shapeLegend.format = 
[Chart.DECIMAL_FORMAT,"$#,##0.00"];

Example (Text Format)
Chart1.shapeLegend.format = [Chart.MESSAGE_FORMAT,"{0} 
Inc."];
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SIZELEGEND.FORMAT 

Sets the format for data values displayed in the size legend. The available
formats are shown below:

  – Chart.DATE_FORMAT for date display
  – Chart.DECIMAL_FORMAT for number display
  – Chart.MESSAGE_FORMAT for text display
  – Chart.PERCENT_FORMAT for fraction display 
  – Chart.CURRENCY_FORMAT for locale-adapting currency display

For the Date, Decimal, and Message formats, optionally specify the format
and mask as items in an array. See Format Types in Advanced Report
Design and Format Tab in Advanced Dashboard Design for more
information about the masks.

Type
Constant (format) or Array ([format, mask])

Example (Number Format)
Chart1.sizeLegend.format = 
[Chart.DECIMAL_FORMAT,"$#,##0.00"];

Example (Text Format)
Chart1.sizeLegend.format = [Chart.MESSAGE_FORMAT,"{0} 
Inc."];
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COLORFIELD

Returns the name of the query field that is currently assigned to the ‘Color’
binding (ColorFrame) at runtime. This property is read-only.

Type
String

Example
if (Chart1.colorField == 'State') {
StateSelectionList1.visible = true;

}
else {
StateSelectionList1.visible = false;

}

See Also
bindingInfo.setColorField(col, type), to set the ‘Color’ binding in script.
bindingInfo.getColorField(), to return the design-time ‘Color’ binding.

SHAPEFIELD

Returns the name of the query field that is currently assigned to the ‘Shape’
binding (ShapeFrame) at runtime. This property is read-only.

Type
String

Example
if (Chart1.shapeField == 'State') {
StateSelectionList1.visible = true;

}
else {
StateSelectionList1.visible = false;

}

See Also
bindingInfo.setShapeField(col, type), to set the ‘Shape’ binding in script.
bindingInfo.getShapeField(), to return the design-time ‘Shape’ binding.
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SIZEFIELD

Returns the name of the query field that is currently assigned to the ‘Size’
binding (SizeFrame) at runtime. This property is read-only.

Type
String

Example
if (Chart1.sizeField == 'State') {
StateSelectionList1.visible = true;

}
else {
StateSelectionList1.visible = false;

}

See Also
bindingInfo.setSizeField(col, type), to set the ‘Size’ binding in script.
bindingInfo.getSizeField(), to return the design-time ‘Size’ binding.

TEXTFIELD

Returns the name of the query field that is currently assigned to the ‘Text’
binding (TextFrame) at runtime. This property is read-only.

Type
String

Example
if (Chart1.textField == 'State') {
StateSelectionList1.visible = true;

}
else {
StateSelectionList1.visible = false;

}

See Also
bindingInfo.setTextField(col, type), to set the ‘Text’ binding in script.
bindingInfo.getTextField(), to return the design-time ‘Text’ binding.

GEOFIELDS

Returns the names of the query fields (as an array) that are currently
assigned to the ‘Geographic’ binding at runtime. This property is read-only.

Type
Array of Strings

Example
if (Chart1.geoFields[0] == 'State') {
StateSelectionList1.visible = true;

}
else {
StateSelectionList1.visible = false;
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}

See Also
bindingInfo.geoFields, to associate fields with the ‘Geographic’ binding.

XFIELDS

Returns the names of the query fields (as an array) that are currently
assigned to the X-axis binding at runtime. This property is read-only.

Type
Array of Strings

Example
if (Chart1.xFields[0] == 'State') {
StateSelectionList1.visible = true;

}
else {
StateSelectionList1.visible = false;

}

See Also
bindingInfo.xFields, to associate fields with the X-axis binding.

YFIELDS

Returns the names of the query fields (as an array) that are currently
assigned to the Y-axis binding at runtime. This property is read-only.

Type
Array of Strings

Example
if (Chart1.yFields[0] == 'Quantity Purchased') {
Gauge1.visible = true;

}
else {
Gauge1.visible = false;

}

See Also
bindingInfo.yFields, to associate fields with the X-axis binding.

SETLABELALIASOFCOLORLEGEND(VALUE, ALIAS)

Replace the specified label in the color legend with an alias.

Parameters
value Value to be replaced
alias Replacement string

Example
Chart1.setLabelAliasOfColorLegend('NJ','New Jersey');
Chart1.setLabelAliasOfColorLegend('NY','New York');
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SETLABELALIASOFSHAPELEGEND(VALUE, ALIAS)

Replace the specified label in the shape legend with an alias.

Parameters
value Value to be replaced
alias Replacement string

Example
Chart1.setLabelAliasOfShapeLegend('NJ','New Jersey');
Chart1.setLabelAliasOfShapeLegend('NY','New York');

SETLABELALIASOFSIZELEGEND(VALUE, ALIAS)

Replace the specified label in the size legend with an alias.

Parameters
value Value to be replaced
alias Replacement string

Example
Chart1.setLabelAliasOfSizeLegend('NJ','New Jersey');
Chart1.setLabelAliasOfSizeLegend('NY','New York');
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CR.1.6 Chart bindingInfo Property

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

This section presents functions related to the bindingInfo property of the
Graph. The bindingInfo property provides access to the binding, grouping,
and aggregation settings available within the Chart Binding panel. 

Figure 1. The Binding panel.

The bindingInfo properties also control the ColorFrame, ShapeFrame,
SizeFrame, and TextureFrame objects that determine visual styling for data
represented on the chart (e.g., subseries).

BINDINGINFO.XFIELDS

Specifies the query fields to be displayed on the X-axis.

Type
2D Array [[Xfield1,Type1],[Xfield2,Type2],...]

Xfield: String
Type: Chart Constants constant:
STRING, DATE, or NUMBER

Example
Chart1.query = "All Sales";
Chart1.bindingInfo.xFields = [["Employee",Chart.STRING]];
Chart1.bindingInfo.yFields = [["Total",Chart.NUMBER]];
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See Also
xFields, to return the fields currently bound to X-axis at runtime.

BINDINGINFO.YFIELDS

Specifies the query fields to be displayed on the Y-axis.

Type
2D Array [[Xfield1,Type1],[Xfield2,Type2],...]

Xfield: String
Type: Chart Constants constant:
STRING, DATE, or NUMBER

Example
Chart1.query = "All Sales";
Chart1.bindingInfo.xFields = [["Employee",Chart.STRING]];
Chart1.bindingInfo.yFields = [["Total",Chart.NUMBER]];

See Also
yFields, to return the fields currently bound to X-axis at runtime.

BINDINGINFO.BREAKDOWNFIELDS

Specifies the query fields on which to break down the data. These fields
will be bound to the ‘Group By’ region of the Chart Editor.

Type
2D Array [[Field1,Type1],[Field2,Type2],...]

Field: String
Type: Chart Constants constant:
STRING, DATE, or NUMBER

Example
Chart1.query = "All Sales";
Chart1.bindingInfo.xFields = [["Employee",Chart.STRING]];
Chart1.bindingInfo.yFields = [["Total",Chart.NUMBER]];
Chart1.bindingInfo.breakdownFields = [["Order 
Date",Chart.DATE]];
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BINDINGINFO.GEOFIELDS

Specifies the query fields to be used as geographic fields. These fields will
be bound to the ‘Geographic’ region of the Chart Editor.

Type
2D Array [[Field1,Type1],[Field2,Type2],...]

Field: String
Type: Chart Constants constant:
STRING, DATE, or NUMBER

Example
Chart1.query = "customers";
Chart1.chartStyle = Chart.CHART_MAP;
Chart1.bindingInfo.setColorField("customer_id",Chart.NUMBER
);
Chart1.bindingInfo.setFormula("customer_id",Chart.DISTINCTC
OUNT_FORMULA,Chart.AESTHETIC_COLOR);
Chart1.bindingInfo.geoFields = [['state',Chart.STRING]];
Chart1.mapType = Chart['MAP_TYPE_U.S.'];
Chart1.bindingInfo.setMapLayer("state",Chart.STATE);
Chart1.bindingInfo.shapes['DistinctCount(customer_id)'] = 
new StaticShapeFrame(GShape.NIL);

See Also
geoFields, to return the currently bound ‘Geographic’ field at runtime.

BINDINGINFO.SETMAPLAYER(COL,LAYER)

Specifies the map layer corresponding to a geographic field.

Parameters
col Field for which layer is assigned
layer Chart Constants constant:

Chart.STATE
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Chart.CITY
Chart.COUNTRY
Chart.ZIP
Chart.PROVINCE

Example
Chart1.query = "customers";
Chart1.chartStyle = Chart.CHART_MAP;
Chart1.bindingInfo.setColorField("customer_id",Chart.NUMBER
);
Chart1.bindingInfo.setFormula("customer_id",Chart.DISTINCTC
OUNT_FORMULA,Chart.AESTHETIC_COLOR);
Chart1.bindingInfo.geoFields = [['state',Chart.STRING]];
Chart1.mapType = Chart['MAP_TYPE_U.S.'];
Chart1.bindingInfo.setMapLayer("state",Chart.STATE);
Chart1.bindingInfo.shapes['DistinctCount(customer_id)']=new 
StaticShapeFrame(GShape.NIL);

See Also
bindingInfo.getMapLayer(col), to return the layer assigned to a geographic
field.
mapType, to set the outline of the map.

BINDINGINFO.GETMAPLAYER(COL)

Returns the map layer assigned to a geographic field.

Parameters
col Field for which layer is desired

Example
var layer = Chart1.bindingInfo.getMapLayer('state')

See Also
bindingInfo.setMapLayer(col,layer), to set the geographic layer.

BINDINGINFO.GETGROUPORDER(COL,BINDING)

Returns the grouping level for a specified Date dimension.

Parameters
col Name of field for which to obtain grouping
binding The field’s binding (Chart Constants 
constant):

Chart.BINDING_FIELD: bound to X or Y axis
Chart.AESTHETIC_COLOR: bound to Color 
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Chart.AESTHETIC_SHAPE: bound to Shape
Chart.AESTHETIC_SIZE: bound to Size
Chart.AESTHETIC_TEXT: bound to Text

Return
Number: 5 = Chart.YEAR_INTERVAL

4 = Chart.QUARTER_INTERVAL
3 = Chart.MONTH_INTERVAL
2 = Chart.WEEK_INTERVAL
1 = Chart.DAY_INTERVAL
8 = Chart.HOUR_INTERVAL
7 = Chart.MINUTE_INTERVAL
6 = Chart.SECOND_INTERVA
513 = Chart.QUARTER_OF_YEAR_PART
514 = Chart.MONTH_OF_YEAR_PART
515 = Chart.WEEK_OF_YEAR_PART
518 = Chart.DAY_OF_MONTH_PART
519 = Chart.DAY_OF_WEEK_PART
521 = Chart.HOUR_OF_DAY_PART

Example
Chart1.bindingInfo.getGroupOrder("Order Date", 
Chart.BINDING_FIELD)

BINDINGINFO.SETGROUPORDER(COL,GROUPING)

Specifies the grouping level for a specified Date dimension. 

Parameter
col date field to group
grouping Chart Constants constant:

Chart.YEAR_INTERVAL
Chart.QUARTER_INTERVAL
Chart.MONTH_INTERVAL
Chart.WEEK_INTERVAL
Chart.DAY_INTERVAL
Chart.HOUR_INTERVAL
Chart.MINUTE_INTERVAL
Chart.SECOND_INTERVAL
Chart.QUARTER_OF_YEAR_PART
Chart.MONTH_OF_YEAR_PART
Chart.WEEK_OF_YEAR_PART
Chart.DAY_OF_MONTH_PART
Chart.DAY_OF_WEEK_PART
Chart.HOUR_OF_DAY_PART

The distinction between grouping levels such as Chart.MONTH_INTERVAL
and Chart.MONTH_OF_YEAR_PART is as follows:

• Chart.MONTH_INTERVAL groups the same month of different years 
individually (e.g., January 2009, January 2010, February 2009, 
February 2010, etc.).

• Chart.MONTH_OF_YEAR_PART groups the same month of different years 
together (January, February, etc.). 

The same distinction obtains for Chart.DAY_INTERVAL,
Chart.DAY_OF_MONTH_PART, and other similar pairs.
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Example
Chart1.bindingInfo.setGroupOrder("Order 
Date",Chart.QUARTER_INTERVAL)

BINDINGINFO.ISTIMESERIES(COL)

Returns the state of the specified Date column, designated as time-series or
not. 

Parameter
col Name of field to test for time-series

Return
Boolean true: Field is set as time-series

false: Field is not set as time-series

Example
var ts = Chart1.bindingInfo.isTimeSeries("Order Date");

BINDINGINFO.SETTIMESERIES(COL,BOOLEAN)

Specifies that gaps in Date data should be retained. For example, if the data
in the chart is grouped by month, and there is no data for the month of June,
the ‘timeSeries’ property ensures that the month of June is still retained in
the chart. 

Parameter
col Name of field to set as time-series
Boolean true: gaps are preserved for date data

false: gaps are removed

Example
Chart1.bindingInfo.setTimeSeries("Order Date", true);
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BINDINGINFO.GETCOLUMNORDER(COL)

Returns the sorting order for a specified dimension.

Parameter
col Name of field for which to obtain sorting

Return
Number 1=ascending, 

2=descending
0=none

Example
var ord = Chart1.bindingInfo.getColumnOrder("Company")

See Also
bindingInfo.getColumnOrder(colName), for the equivalent Table function.

BINDINGINFO.SETCOLUMNORDER(COL,ORDER,[SORTCOL])

Specifies the sorting order for a specified dimension. To sort a dimension
by measure value, set order to SORT_VALUE_ASC or SORT_VALUE_DESC, and
use the sortCol string to supply the column and aggregation by which to
sort.

Parameter
col Name of field on which to apply sorting
order The sort order, a Chart Constants constant:

Chart.SORT_NONE
Chart.SORT_ASC // ascending
Chart.SORT_DESC // descending
Chart.SORT_VALUE_ASC // ascending by 

value
Chart.SORT_VALUE_DESC // ascending by 

value
sortCol String: Formula for sorting:

'Sum(column_name)'
'Average(column_name)' 
'Max(column_name)' 
'Min(column_name)' 
'Count(column_name)' 
'Distinct Count(column_name)' 
'First(column_name1,column_name2)' 
'Last(column_name1,column_name2)' 
'Correlation(column_name1,column_name2)' 
'Covariance(column_name1,column_name2)' 
'Variance(column_name)' 
'Median(column_name)' 
'Mode(column_name)' 
'Std Deviation(column_name)' 
'Variance(Pop)(column_name)' 
'Std Deviation(Pop)(column_name)' 
'Weighted Average(column_name1,column_name2)' 

Example
Chart1.bindingInfo.setColumnOrder('Company',Chart.SORT_DESC
)
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Example
Chart1.bindingInfo.setColumnOrder('Company',Chart.SORT_VALU
E_DESC,'Sum(Total)');

See Also
bindingInfo.setColumnOrder(colName,order), for the equivalent Table
function.

BINDINGINFO.GETTOPN(COL)

Returns the number (N) of top or bottom groups being filtered for the
specified field.

Parameter
col Name of filtered field 

Example
var N = Chart1.bindingInfo.getTopN("Company");

See Also
bindingInfo.getTopN(groupCol), for the equivalent Table function.

BINDINGINFO.SETTOPN(COL,N)

Filters the top or bottom N groups for a specified field based on an
aggregate measure.

Parameter
col Name of field to filter
N The number of top or bottom groups to filter

Example
Chart1.bindingInfo.setTopN("Company",3)
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See Also
bindingInfo.setTopN(groupCol, n), for the equivalent Table function.

BINDINGINFO.ISTOPNREVERSE(COL)

Returns the state of the Top-N/Bottom-N filter.

Parameter
col Name of the filtered field

Returns
Boolean true: filter is bottom N

false: filter is top N

Example
var rev = Chart1.bindingInfo.isTopNReverse("Company");

See Also
bindingInfo.isTopNReverse(groupCol), for the equivalent Table function.

BINDINGINFO.SETTOPNREVERSE(COL,BOOLEAN)

Specifies whether filter should extract the top-N or the bottom-N groups
based on an aggregate.

Parameter
col Name of field to filter
Boolean true: filter bottom N

false: filter top N

Example
Chart1.bindingInfo.setTopN("Company",3)
Chart1.bindingInfo.setTopNReverse("Company",true);
// Returns bottom-N groups
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See Also
bindingInfo.setTopNReverse(groupCol, boolean), for the equivalent Table
function.

BINDINGINFO.GETTOPNSUMMARYCOL(COL)

Returns the aggregate used for Top-N/Bottom-N filtering on a specified
field.

Parameter
col Name of filtered field

Example
var agg = Chart1.bindingInfo.getTopNSummaryCol("Company")

See Also
bindingInfo.getTopNSummaryCol(groupCol), for the equivalent Table
function.

BINDINGINFO.SETTOPNSUMMARYCOL(COL,AGG)

Specifies the aggregate to be used for Top-N/Bottom-N filtering on a given
field.

Parameter
col Name of field to filter
agg The aggregate by which to filter

Example
Chart1.bindingInfo.setTopN("Company",3)
Chart1.bindingInfo.setTopNSummaryCol("Company","Max(Total)"
);

See Also
bindingInfo.setTopNSummaryCol(groupCol, col), for the equivalent Table
function.
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BINDINGINFO.GETFORMULA(COL,BINDING)

Returns the aggregation method used for a measure. The measure can be
bound to the X or Y axis, or to one of the VisualFrames (ColorFrame,
ShapeFrame, SizeFrame, and TextureFrame).

Parameter
col Field for which to obtain summary method
binding The field’s binding (Chart Constants 
constant):

Chart.BINDING_FIELD: bound to X or Y axis
Chart.AESTHETIC_COLOR: bound to Color 
Chart.AESTHETIC_SHAPE: bound to Shape
Chart.AESTHETIC_SIZE: bound to Size
Chart.AESTHETIC_TEXT: bound to Text

Returns
The formula name (String)

Example
// For a field "Total" bound to the Y-axis:
var formula = 
Chart1.bindingInfo.getFormula("Total",Chart.BINDING_FIELD);

See Also
bindingInfo.getFormula(i), for the equivalent Table function.

BINDINGINFO.SETFORMULA(COL, FORMULA, BINDING)

Sets the aggregation method for a measure (chart series). The measure can
be bound to the X or Y axis, or to one of the VisualFrames (ColorFrame,
ShapeFrame, SizeFrame, and TextureFrame).

Parameter
col The name of the field to be summarized
formula A Chart Constants summarization formula

(See Summarization Formulas.) 
binding The field’s binding (Chart Constants 
constant):

Chart.BINDING_FIELD: bound to X or Y axis
Chart.AESTHETIC_COLOR: bound to Color 
Chart.AESTHETIC_SHAPE: bound to Shape
Chart.AESTHETIC_SIZE: bound to Size
Chart.AESTHETIC_TEXT: bound to Text

Example (axis-bound field)
// For a field "Total" bound to the Y-axis:
Chart1.bindingInfo.setFormula("Total", Chart.MAX_FORMULA, 
Chart.BINDING_FIELD);
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Example (frame-bound field)
// For a field "Total" bound to the ColorFrame:
Chart1.bindingInfo.setFormula("Total", Chart.MAX_FORMULA, 
Chart.AESTHETIC_COLOR);

See Also
bindingInfo.setFormula(col, formula), for the equivalent Table function.

BINDINGINFO.GETPERCENTAGETYPE(COL,BINDING)

Returns the basis for computing percentages.

Parameter
col Field for which to obtain percentage type
binding The field’s binding (Chart Constants 
constant):

Chart.BINDING_FIELD: bound to X or Y axis
Chart.AESTHETIC_COLOR: bound to Color 
Chart.AESTHETIC_SHAPE: bound to Shape
Chart.AESTHETIC_SIZE: bound to Size
Chart.AESTHETIC_TEXT: bound to Text

Returns
Number 2 = PERCENTAGE_OF_GRANDTOTAL

1 = PERCENTAGE_OF_GROUP
0 = Chart.PERCENTAGE_NONE

Example
var type = Chart1.bindingInfo.getPercentageType("Total", 
Chart.BINDING_FIELD)

BINDINGINFO.SETPERCENTAGETYPE(COL,TYPE)

Specifies the basis for computing percentages, grand total or group total.
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Parameter
col Name of field for which to set percentage
type Chart Constants constant:

Chart.PERCENTAGE_NONE
Chart.PERCENTAGE_OF_GRANDTOTAL
Chart.PERCENTAGE_OF_GROUP

Example
Chart1.bindingInfo.setPercentageType("Total", 
Chart.PERCENTAGE_OF_GROUP)

BINDINGINFO.GETSECONDARYFIELD(COL, BINDING)

Get the secondary field used in a bivariate aggregation method (e.g.,
correlation, covariance, etc.).

Parameter
col Field for which to obtain secondary field
binding Field binding (Chart Constants constant):

Chart.BINDING_FIELD: bound to X or Y axis
Chart.AESTHETIC_COLOR: bound to Color 
Chart.AESTHETIC_SHAPE: bound to Shape
Chart.AESTHETIC_SIZE: bound to Size
Chart.AESTHETIC_TEXT: bound to Text

Returns
The field name (String)

Example
// For primary field "Price" bound to the Y-axis:
var col2 = Chart1.bindingInfo.getSecondaryField("Price", 
Chart.BINDING_FIELD);

BINDINGINFO.SETSECONDARYFIELD(COL1, COL2, BINDING)

Set the secondary field to be used in a bivariate aggregation method (e.g.,
correlation, covariance, etc.).

Parameter
col1 Name of existing primary field
col2 Name of secondary field
binding Field binding (Chart Constants constant):

Chart.BINDING_FIELD: bound to X or Y axis
Chart.AESTHETIC_COLOR: bound to Color 
Chart.AESTHETIC_SHAPE: bound to Shape
Chart.AESTHETIC_SIZE: bound to Size
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Chart.AESTHETIC_TEXT: bound to Text

Example
// For primary field "Price" bound to the ColorFrame:
var formula = Chart1.bindingInfo.setSecondaryField("Price", 
"Discount", Chart.AESTHETIC_COLOR);

BINDINGINFO.GETCOLORFIELD()

Returns the field bound to the ColorFrame (color coding).

Returns
String Field name used for color-coding

Example
var cfield = Chart1.bindingInfo.getColorField();

See Also
colorField, to return the runtime ‘Color’ binding.

BINDINGINFO.SETCOLORFIELD(COL, TYPE)

Bind the specified field to a ColorFrame (color coding).

Parameter
col Field to be used for color-coding
type Chart Constants constant: STRING, DATE, or 
NUMBER

Example (Dimension field)
// For a dimension (categorical) field:
Chart1.bindingInfo.setColorField("Employee",Chart.STRING);

Example (Measure field)
// For a measure (numerical) field:
Chart1.bindingInfo.setColorField("Total",Chart.NUMBER);
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See Also
bindingInfo.colorFrame, for information on the different ColorFrames
available.

BINDINGINFO.GETSHAPEFIELD()

Returns the field bound to the ShapeFrame (shape coding).

Returns
String Field name used for shape-coding

Example
var sfield = Chart1.bindingInfo.getShapeField();

BINDINGINFO.SETSHAPEFIELD(COL, TYPE)

Bind the specified field to a ShapeFrame (shape coding). The aesthetic
treatment applied to the chart elements depends on the type of the chart:

• Bar-type charts apply a TextureFrame, which draws different fill 
patterns. (For dimension binding, the default is the 
CategoricalTextureFrame. For measure binding, the default is 
LeftTiltTextureFrame.)

• Line-type charts apply a LineFrame, which draws different line styles. 
(For dimension binding, the default is the CategoricalLineFrame. For 
measure binding, the default is LinearLineFrame.)

• Point-type charts apply a ShapeFrame, which draws different shape 
types. (For dimension binding, the default is the 
CategoricalShapeFrame. For measure binding, the default is 
FillShapeFrame.)

Parameter
col Field to be used for shape-coding
type Chart Constants constant: STRING, DATE, or 
NUMBER

Example (Dimension field)
// For a dimension (categorical) field:
Chart1.bindingInfo.setShapeField("Employee",Chart.STRING);
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Example (Measure field)
// For a measure (numerical) field:
Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);

See Also
bindingInfo.textureFrame, for information on setting the TextureFrame.
bindingInfo.lineFrame, for information on setting the LineFrame.
bindingInfo.shapeFrame, for information on setting the ShapeFrame.

BINDINGINFO.GETSIZEFIELD()

Returns the field bound to the SizeFrame (size coding).

Returns
String Field name used for size-coding

Example
var sfield = Chart1.bindingInfo.getSizeField();

BINDINGINFO.SETSIZEFIELD(COL, TYPE)

Bind the specified field to a SizeFrame (size coding).

Parameter
col Field to be used for size-coding
type Chart Constants constant: STRING, DATE, or 
NUMBER

Example (Dimension field)
// For a dimension (categorical) field:
Chart1.bindingInfo.setSizeField("Employee",Chart.STRING);
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Example (Measure field)
// For a measure (numerical) field:
Chart1.bindingInfo.setSizeField("Total",Chart.NUMBER);

See Also
bindingInfo.sizeFrame, for information on the different ShapeFrames
available.

BINDINGINFO.GETTEXTFIELD()

Returns the field bound to the TextFrame (text coding).

Returns
String Field name used for text-coding

Example
var tfield = Chart1.bindingInfo.getTextField();

BINDINGINFO.SETTEXTFIELD(COL, TYPE)

Bind the specified field to a TextFrame (text coding).

Parameter
col Field to be used for text-coding
type Chart Constants constant: STRING, DATE, or 
NUMBER

Example (Dimension field)
// For a dimension (categorical) field:
Chart1.bindingInfo.setTextField("Employee",Chart.STRING);
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Example (Measure field)
// For a measure (numerical) field:
Chart1.bindingInfo.setTextField("Total",Chart.NUMBER);

BINDINGINFO.SETCANDLEBINDINGFIELD(ARR)

Configure the binding for a candlestick-type chart. A candlestick chart
displays four different measures, “low,” “high,” “opening,” and “closing,”
and is most often used to plot trading information. The parameter arr
contains information for plotting one of these four measures.

Parameter
arr Array of properties for a candlestick chart 
measure:

[field1,measure,formula,option,field2]

The items in the array are described below:

field1 Field containing data corresponding to 
measure.
measure The measure represented by field1:

Chart.HIGH: field1 defines the high values
Chart.LOW: field1 defines the low values
Chart.OPEN: field1 defines the opening values
Chart.CLOSE: field1 defines the closing values

formula A Chart Constants summarization formula
(See Summarization Formulas.) 

option Specifies how percentages should be computed:
Chart.PERCENTAGE_NONE
Chart.PERCENTAGE_OF_GRANDTOTAL
Chart.PERCENTAGE_OF_GROUP

field2 The second operand for a bivariate formula 
(e.g., correlation).

The first two items in the array (field1, measure) are required. The others
are optional.
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Example
To create a candlestick chart that displays the average high, low, opening,
and closing prices by quarter, follow the steps below:

1. Create a new report or Viewsheet. For a Viewsheet, select the
‘Stock History’ > ‘Stock Prices’ query (under ‘Data Source’ >
‘Other Data Sources’) as the data source. 

2. Add a new Chart element to the report or Viewsheet. 

3. Enter the following script in the onLoad or onRefresh handler of
the report or Viewsheet.

Chart1.query='Stock Prices';

Chart1.chartStyle = Chart.CHART_CANDLE;
var data_high = ["Stock 
Prices.High",Chart.HIGH,Chart.AVERAGE_FORMULA];
var data_low = ["Stock 
Prices.Low",Chart.LOW,Chart.AVERAGE_FORMULA];
var data_close = ['Stock Prices.Close/
Last',Chart.CLOSE,Chart.AVERAGE_FORMULA];
var data_open = ['Stock 
Prices.Open',Chart.OPEN,Chart.AVERAGE_FORMULA]; 

Chart1.bindingInfo.xFields=[['Date',Chart.DATE]];
Chart1.bindingInfo.setGroupOrder('Date',Chart.QUARTER_INTER
VAL);
Chart1.bindingInfo.setCandleBindingField(data_high);
Chart1.bindingInfo.setCandleBindingField(data_low);
Chart1.bindingInfo.setCandleBindingField(data_close);
Chart1.bindingInfo.setCandleBindingField(data_open);

4. Preview the chart.

In a Viewsheet, you
can also use the
‘Zoom’ tool to limit
the date range.

5. To observe the structure of the chart more closely, set a condition
on the chart to limit the date range (e.g., limit to the year of 2004). 
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Note that for each quarter, the values of each of the measures (High, Low,
Close/Last, Open) have been independently aggregated as specified by the
corresponding formula parameter (in this case, Chart.AVERAGE_FORMULA for
each). 

The “high” and “low” measures are represented by the extremes of the
candle “wick,” and the “open” and “close” measures are represented by the
extremes of the candle “body.” Candles for which the “open” measure
exceeds the value of the “close” measure are shown filled. Candles for
which the “close” measure exceeds the value of the “open” measure are
shown unfilled. 

See Also
bindingInfo.getCandleBindingField(measure), to obtain current binding
information.

BINDINGINFO.GETCANDLEBINDINGFIELD(MEASURE)

Return the field used as the specified measure on a candlestick-type chart,
together with associated binding information. 

Parameter
measure The measure to return:

Chart.HIGH: measure defining the high values
Chart.LOW: measure defining the low values
Chart.OPEN: measure defining the opening 

values
Chart.CLOSE: measure defining the closing 

values

Example
Chart1.bindingInfo.getCandleBindingField(Chart.LOW);
// returns (for example): lowPrice[lowPrice, null, Average, 
0]

See Also
bindingInfo.setCandleBindingField(arr), to set the binding information.
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BINDINGINFO.SETSTOCKBINDINGFIELD(ARR)

Configure the binding for a stock-type chart, also known as an open-hi-
low-close (OHLC) chart. A stock chart displays four different measures,
“low,” “high,” “opening,” and “closing,” and is most often used to plot
trading information. The parameter arr contains information for plotting
one of these four measures.

Parameter
arr Array of properties for a stock chart measure:

[field1,measure,formula,option,field2]

The items in the array are described below:

field1 Field containing data coresponding to 
measure.
measure The measure represented by field1:

Chart.HIGH: field1 defines the high values
Chart.LOW: field1 defines the low values
Chart.OPEN: field1 defines the opening values
Chart.CLOSE: field1 defines the closing values

formula A Chart Constants summarization formula
(See Summarization Formulas.) 

option Specifies how percentages should be computed:
Chart.PERCENTAGE_NONE
Chart.PERCENTAGE_OF_GRANDTOTAL
Chart.PERCENTAGE_OF_GROUP

field2 The second operand for a bivariate formula 
(e.g., correlation).

The first two items in the array (field1, measure) are required. The others
are optional.

Example
To create a stock chart that displays the average high, low, opening, and
closing prices by quarter, follow the steps below:

1. Create a new report or Viewsheet. For a Viewsheet, select the
‘Stock History’ > ‘Stock Prices’ query (under ‘Data Source’ >
‘Other Data Sources’) as the data source. 

2. Add a new Chart element to the report or Viewsheet. 

3. Enter the following script in the onLoad or onRefresh handler of
the report or Viewsheet.

Chart1.query='Stock Prices';

Chart1.chartStyle = Chart.CHART_STOCK;
var data_high = ["Stock 
Prices.High",Chart.HIGH,Chart.AVERAGE_FORMULA];
var data_low = ["Stock 
Prices.Low",Chart.LOW,Chart.AVERAGE_FORMULA];
var data_close = ['Stock Prices.Close/
Last',Chart.CLOSE,Chart.AVERAGE_FORMULA];
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var data_open = ['Stock 
Prices.Open',Chart.OPEN,Chart.AVERAGE_FORMULA]; 

Chart1.bindingInfo.xFields=[['Date',Chart.DATE]];
Chart1.bindingInfo.setGroupOrder('Date',Chart.QUARTER_INTER
VAL);
Chart1.bindingInfo.setStockBindingField(data_high);
Chart1.bindingInfo.setStockBindingField(data_low);
Chart1.bindingInfo.setStockBindingField(data_close);
Chart1.bindingInfo.setStockBindingField(data_open);

4. Preview the chart.

In a Viewsheet, you
can also use the
‘Zoom’ tool to limit
the date range.

5. To observe the structure of the chart more closely, set a condition
on the chart to limit the date range (e.g., limit to the year of 2004). 

Note that for each quarter, the values of each of the measures (High, Low,
Close/Last, Open) have been independently aggregated as specified by the
corresponding formula parameter (in this case, Chart.AVERAGE_FORMULA for
each). 

The “high” and “low” measures are represented by the extremes of the
vertical line, and the “open” and “close” measures are represented,
respectively, by the left and right horizontal lines.

See Also
bindingInfo.getStockBindingField(measure), to obtain current binding
information.
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BINDINGINFO.GETSTOCKBINDINGFIELD(MEASURE)

Return the field used as the specified measure on a stock-type (OHLC)
chart, together with associated binding information. 

Parameter
measure The measure to return:

Chart.HIGH: measure defining the high values
Chart.LOW: measure defining the low values
Chart.OPEN: measure defining the opening 

values
Chart.CLOSE: measure defining the closing 

values

Example
Chart1.bindingInfo.getStockBindingField(Chart.LOW);
// returns (for example): lowPrice[lowPrice, null, Average, 
0]

See Also
bindingInfo.setStockBindingField(arr), to set the binding information.

BINDINGINFO.COLORFRAME

Specifies the aesthetic color treatment for the chart elements. A
ColorFrame can color-code chart elements by value, or simply specify a
static color scheme. The default for dimensions is CategoricalColorFrame,
and the default for measures is GradientColorFrame.

Type
ColorFrame

Example
Chart1.bindingInfo.setColorField("Total",Chart.NUMBER);
Chart1.bindingInfo.colorFrame = new HeatColorFrame;

See Also
Modifying a Chart Element using API Functions, to apply a ColorFrame
outside of the data binding.
bindingInfo.colors, to set a static color for a particular measure.
bindingInfo.setColorField(col, type), for information on binding a color
field.
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BINDINGINFO.SHAPEFRAME

Specifies the aesthetic treatment for shape-coded data on point-type charts.
A ShapeFrame can shape-code chart elements by value, or simply specify
a static shape style.

Type
ShapeFrame (point-type charts)

Example
Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.shapeFrame = new TriangleShapeFrame;

See Also
Modifying a Chart Element using API Functions, to apply a ShapeFrame
outside of the data binding.
bindingInfo.shapes, to set a static shape for a particular measure.
bindingInfo.setShapeField(col, type), for information on binding a shape
field.

BINDINGINFO.SIZEFRAME

Specifies the size of graphical elements. A SizeFrame can size-code chart
elements by value, or simply specify a static size. The default for
dimensions is CategoricalSizeFrame. The default for measures is
LinearSizeFrame.

Type
SizeFrame

Example
Chart1.bindingInfo.setSizeField("Total",Chart.NUMBER);
Chart1.bindingInfo.sizeFrame = new LinearSizeFrame;
Chart1.bindingInfo.sizeFrame.smallest = 10;
Chart1.bindingInfo.sizeFrame.largest = 50;
Chart1.bindingInfo.sizeFrame.max = 100;
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See Also
Modifying a Chart Element using API Functions, to apply a SizeFrame
outside of the data binding.
bindingInfo.size, to set a static size .
bindingInfo.setSizeField(col, type), for information on binding a size field.

BINDINGINFO.TEXTUREFRAME

Specifies the aesthetic treatment (fill pattern) for the shape-coded data on a
bar-type chart. A TextureFrame can texture-code chart elements by value,
or simply specify a static texture style. 

Type
TextureFrame (bar-type chart)

Example
Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.textureFrame = new GridTextureFrame;

See Also
Modifying a Chart Element using API Functions, to apply a TextureFrame
outside of the data binding.
bindingInfo.textures, to set a static texture for a particular measure.
bindingInfo.setShapeField(col, type), for information on binding a shape
field.

BINDINGINFO.LINEFRAME

Specifies the aesthetic treatment (line style) for the shape-coded data on a
line-type chart. A LineFrame can texture-code chart elements by value, or
simply specify a static texture style. 



COMMON FUNCTION REFERENCE

1146 of 1397

Type
LineFrame (line-type chart)

Example
Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.lineFrame = new LinearLineFrame;

See Also
Modifying a Chart Element using API Functions, to apply a LineFrame
outside of the data binding.
bindingInfo.lines, to set a static texture for a particular measure.
bindingInfo.setShapeField(col, type), for information on binding a shape
field.

BINDINGINFO.COLORS

Specifies a StaticColorFrame (fixed color) for a particular measure. 

Type
StaticColorFrame

Example
Chart1.bindingInfo.colors['Sum(Total)'] = new 
StaticColorFrame(java.awt.Color(0xFF00FF));

See Also
Modifying a Chart Element using API Functions, to apply a ColorFrame
outside of the data binding.
bindingInfo.colorFrame, for information on assigning value-keyed frames.
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BINDINGINFO.SHAPES

Specifies a StaticShapeFrame (fixed shape) for a particular measure on
point-type charts. 

Type
StaticShapeFrame (point-type charts)

Example
Chart1.bindingInfo.shapes['Sum(Total)'] = new 
StaticShapeFrame(GShape.SQUARE);

See Also
Modifying a Chart Element using API Functions, to apply a ShapeFrame
outside of the data binding.
bindingInfo.shapeFrame, for information on assigning value-keyed
frames.

BINDINGINFO.SIZE

Specifies a StaticSizeFrame (fixed size) for all measures. 

Type
StaticSizeFrame

Example
Chart1.bindingInfo.size = new StaticSizeFrame(30);

See Also
Modifying a Chart Element using API Functions, to apply a SizeFrame
outside of the data binding.
bindingInfo.sizeFrame, for information on assigning value-keyed frames.
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BINDINGINFO.TEXTURES

Specifies a StaticTextureFrame (fixed pattern) for a particular measure on
bar-type charts. 

Type
StaticTextureFrame (bar-type charts)

Example
Chart1.bindingInfo.textures['Sum(Total)'] = new 
StaticTextureFrame(GTexture.PATTERN_5);

See Also
Modifying a Chart Element using API Functions, to apply a TextureFrame
outside of the data binding.
bindingInfo.textureFrame, for information on assigning value-keyed
frames.

BINDINGINFO.LINES

Specifies a StaticLineFrame (fixed line style) for a particular measure on
line-type charts. 

Type
StaticLineFrame (line-type charts)

Example
Chart1.bindingInfo.lines['Sum(Total)'] = new 
StaticLineFrame(GLine.LARGE_DASH);

See Also
Modifying a Chart Element using API Functions, to apply a LineFrame
outside of the data binding.
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bindingInfo.lineFrame, for information on assigning value-keyed frames.

BINDINGINFO.ADDMAPPING(COL, VALUE, GEOCODE)

Specifies the mapping between a value of field col and a defined
geographical code, geocode. The geographical codes are defined in the
CSV files within inetsoft/graph/geo/data directory of the bisuite.jar file for
the corresponding map.

Parameter
col Field from which value should be mapped
value Value to be mapped to a defined geo location
geocode A geographical location in the geo data file

The latitude and lon-
gitude for code
'USA0113' are
defined in inetsoft/
graph/geo/data/us-cit-
ies.csv.

Example
// Map the value 'Queens' (in column 'city') to 'New York 
City'.
Chart1.bindingInfo.addMapping('city','Queens','USA0113');

See Also
bindingInfo.getMappings(col), to retrieve the currently specified mappings.
bindingInfo.removeMapping(col,value), to remove a currently specified
mapping.

BINDINGINFO.GETMAPPINGS(COL)

Returns the mappings that exist between the values in field col and defined
geographical codes (as a two dimensional string array).

Parameter
col Field whose mappings should be returned

Example
// Display mappings in column 'city':
var mapArr = Chart1.bindingInfo.getMappings('city');

for(i=0 ; i<mapArr.length ; i++) {
alert('Value "' + mapArr[i][0] + '" is mapped to ' + 

mapArr[i][1] + '.');
}

See Also
bindingInfo.addMapping(col, value, geocode), to add a specified
geographical mapping.
bindingInfo.removeMapping(col,value), to remove a currently specified
mapping.



COMMON FUNCTION REFERENCE

1150 of 1397

BINDINGINFO.REMOVEMAPPING(COL,VALUE)

Removes the mapping that exists between the specified value of field col
and a defined geographical code.

Parameter
col Field from which value is mapped
value Value whose mapping should be removed

Example
// Remove mapping for value 'Queens' in column 'city':
Chart1.bindingInfo.removeMapping('city','Queens');

See Also
bindingInfo.addMapping(col, value, geocode), to add a specified
geographical mapping.
bindingInfo.getMappings(col), to retrieve the currently specified mappings.

CR.2 Object Hierarchy

The figure below shows the object structure of the Style Chart API. Among
the significant objects, GraphElement contains the elements that
graphically represent data (lines, bars, etc.). VisualFrame contains
information about mapping data dimensions to physical properties (size,
color, etc.), and Scale contains the scaling information for such mappings.
GraphForm contains information for manually-drawn chart objects. 
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CR.3 Getting and Setting Chart Properties

The Chart API provides “getter” and “setter” methods that allow you to
read and write most chart properties from script. The following sections
provide definitions and examples for the “setter” methods. 

In general, you can call the “getter” method corresponding to a particular
“setter” method by simply changing the method name prefix.

For example, the “getter” method corresponding to
LabelForm.setAlignmentY() is LabelForm.getAlignmentY(). The
following script illustrates how you can “get” the alignment of one chart
component, and use it to “set” the alignment of another.

dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form1 = new LabelForm();
var form2 = new LabelForm();
form1.setLabel("label1");
form1.setPoint(new java.awt.Point(100, 100));
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form1.setAlignmentY(Chart.TOP_ALIGNMENT);
form2.setLabel("label2");
form2.setPoint(new java.awt.Point(200, 100));
form2.setAlignmentY(form1.getAlignmentY());
graph.addForm(form1);
graph.addForm(form2);
graph.addElement(elem);

Many attributes can also be accessed as object properties. For example:

form2.alignmentY = form1.alignmentY;

CR.4 General Chart Properties

The following sections present the top-level components required to build a
chart. These include the DataSet object, which encapsulates data from a
JavaScript array, and the EGraph object, which represents the global chart
object. The TextSpec, AxisSpec, LegendSpec, and TitleSpec objects are
used by various other components to set formatting for text, axes, legends,
and titles.

CR.4.1 Data

The Chart data object is a two-dimensional array containing the aggregate
data displayed on the Chart. You can use standard array notation,
data[i][j], to access the data value in row i and column j. Use
data.length and data.size, respectively, to obtain the number of X-axis
labels and number of datasets. For an example, see Accessing Chart Data
in Script in Chart Script Tutorial.

Tip: You can use the
Chart’s “query” prop-
erty to set a query in
the onLoad Handler.
See Modifying a Chart
Data Binding for an
example.

You can assign the results of a runQuery() function to the Data object to set
the chart dataset:

data = runQuery("sales by state"); 

The Data object also supports formula table syntax such as the following:

// Data in aggregated measure/column 'Sum(Sales)'
data["Sum(Sales)"]

// Data in 'Sum(Sales)' for state of NJ
data["Sum(Sales)@State:NJ"]

// Data in 'Sum(Sales)' where the value exceeds 1000000
data["State?Sum(Sales) > 1000000"]

See Also
Creating a Chart Using API Functions, for an example using runQuery().
DataSet, for information on setting the chart dataset.
Table, for information on accessing the dataset along with column headers.
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CR.4.2 Table

The Chart’s Table object is a two-dimensional array containing the
aggregates records (summarized data) bound to a chart. You can use
standard array notation, table[i][j], to access the data value in row i and
column j. Use table.length and table.size, respectively, to obtain the
number of rows and columns in the summarized data. 

The values provided by the Table object are the same as those provided by
the DataSet object, except that the first row, table[0][j], contains the
column headers rather than the first row of data. 

For example, consider the following chart bound to the ‘All Sales’ query in
‘Orders’ > ‘Sample Queries’.

Example
// First row of 'table' has headers: Employee, Sum(Total)
var str = "";
for (var j = 0; j < table.size; j++) {
str += table[0][j] + ", ";

}
log(str);

Example
// First row of 'dataset' has data: Annie, 4412983.0
var str = "";
for (var j = 0; j < dataset.getColCount(); j++) {
str += dataset.getData(j,0) + ", ";

}
log(str);

See Also
DataSet, for information on accessing the chart’s aggregated dataset.
Data, for information on accessing Chart data with advanced syntax.

CR.4.3 DataSet

The DataSet object allows you to set the values to be displayed on the
graph. It has the form of a two-dimensional array, where each column
represents a distinct measure. You can specify the DataSet by one of the
following methods:
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• In Style Studio or Visual Composer, set the chart binding using the 
Chart Editor. 

• In report or Viewsheet script, assign a JavaScript array to the dataset 
property.

dataset = [["State", "Quantity"],["NJ", 200],["NY", 
300],["PA", 370],["CT", 75]];

See Running a Query
from Script in
Advanced Dashboard
Scripting and Running
a Query from Script in
Advanced Report
Scripting for details
about runQuery().

• In report or Viewsheet script, assign a query result (e.g., ‘sales by state’) 
to the dataset property. 

dataset = runQuery("sales by state"); 

The DataSet object is also accessible for reading. See the getData()
method for more information. However, in many cases, the Data property
provides more convenient access to Chart data.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Setting the DataSet)
dataset = [["State","Quantity"], ["CA",200], ["NY",3000]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
graph.addElement(elem);

Full Name
inetsoft.graph.data.DataSet

See Also
Binding Data to a Chart in Script, for various approaches to binding data to
a chart.
Creating a Chart Using API Functions, for report and Viewsheet chart
datasets.

DataSet: getData(), getRowCount(), getColCount()

DataSet.GETDATA(COLUMN,ROW)

Returns the value in the DataSet object specified by the column and row
indices. The first column (index 0) contains the X-axis labels.

Parameters
column Column index of value to return
row Row index of value to return

Note: In many cases,
the Data property is
more convenient to
use than DataSet.

For example, consider a chart with two datasets (measures), as shown
below: 
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Note the index order: (column, row).

Use dataset.getData(j,i) with row index i and column index j to access
these plotted values. The DataSet.getRowCount() and
DataSet.getColCount() functions provide the number of rows and columns
of summarized data. 

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example
var str = "";

// Loop through rows
for (var i = 0; i < dataset.getRowCount(); i++) {

str = "";

// Loop through columns
for (var j = 0; j < dataset.getColCount(); j++) {

str += dataset.getData(j, i) + ",";
}

// Output the results
log(str); // Style Studio
alert(str); // Visual Composer

}

The following output is written by the log() function (for Style Studio) to
the Console window: 

Sun May 31 00:00:00 EDT 2009, 1.0, 4.0,
Mon Jun 01 00:00:00 EDT 2009, 2.0, 5.0,
Tue Jun 02 00:00:00 EDT 2009, 3.0, 6.0,
Wed Jun 03 00:00:00 EDT 2009, 4.0, 7.0,

The values in the first column (e.g., Sun...2009, Mon...2009, etc.) are the
dates on the X-axis, while the second and third columns represent the two
datasets (Measure 1 and Measure 2).

See Also
Table, for information on accessing the dataset along with column headers.
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Data, for information on accessing pre-aggregate data.

DataSet.GETROWCOUNT()

Returns the number of rows in the DataSet (including the header row).

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example
// Create a chart with two datasets:
dataset = [["State", "Total", "Profit"],["NJ", 200, 
25],["NY", 300, 150]];
graph = new EGraph();
var elem1 = new IntervalElement("State", "Total");
var elem2 = new IntervalElement("State", "Profit");
var frame = new StaticColorFrame(java.awt.Color.red);
elem2.setColorFrame(frame);
graph.addElement(elem1);
graph.addElement(elem2);

Note: In many cases,
the Data property is
more convenient to
use than DataSet.

// Loop through the rows of the second dataset (Profit),
// and place labels on the bars.
for (var i=0; i<dataset.getRowCount(); i++) {
var form = new LabelForm();
form.setLabel(dataset.getData(2,i));
form.setValues([dataset.getData(0,i),

dataset.getData(2,i)]);
var spec = new TextSpec();
spec.setColor(java.awt.Color.red)
form.setTextSpec(spec)
graph.addForm(form)

}

See Also
DataSet.getData(column,row), to retrieve data from the DataSet object.

DataSet.GETCOLCOUNT()

Returns the number of columns in the DataSet.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.
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Example (Report or Viewsheet)
// Create a chart with two datasets:
dataset = [["State", "Total", "Profit"],["NJ", 200, 25], 
["NY", 300, 150]];
graph = new EGraph();
var elem1 = new IntervalElement("State", "Total");
var elem2 = new IntervalElement("State", "Profit");
var frame = new StaticColorFrame(java.awt.Color.red);
elem2.setColorFrame(frame);
graph.addElement(elem1);
graph.addElement(elem2);

Note: In many cases,
the Data property is
more convenient to
use than DataSet.

// Loop through the rows and columns,
// and place labels on the bars.
for (var i=0; i<dataset.getRowCount(); i++) {
for (var j=0; j<dataset.getColCount(); j++) {
var form = new LabelForm();
form.setColor(java.awt.Color.black);
form.setLabel(dataset.getData(j,i));
form.setValues([dataset.getData(0,i),

dataset.getData(j,i)-20]);
graph.addForm(form)

}
}

See Also
DataSet, to use a Data Block or query as the dataset source.
DataSet.getData(column,row), to retrieve data from the DataSet object.

DataSet.SETORDER(DIM,ARR)

Set a manual label ordering for a given dimension field.

Parameters
dim String giving name of the dimension to sort
arr Array of strings with desired label order:

['label1','label2','label3',...]

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"],["NJ", 200],["NY", 
300],["PA", 25]];
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dataset.setOrder('State',['PA','NY','NJ']);
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.
DataSet.getData(column,row), to retrieve data from the DataSet object.

CR.4.4 EGraph

The EGraph object represents the graph definition. To create a new
EGraph object, call the EGraph constructor. 

graph = new EGraph();

Full Name
inetsoft.graph.EGraph

See Also
Creating a Chart Using API Functions, for the basic steps in building a
chart.

EGraph.ADDELEMENT(ELEM)

Adds the specified GraphElement to the chart. See Chart Elements for
available elements.

Parameter
elem a GraphElement object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new LineElement("State", "Quantity");
graph.addElement(elem);
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See Also
DataSet, to use a Data Block or query as the dataset source.
Representing Multiple Measures, to add multiple elements.
Chart Elements, for available elements.

EGraph.ADDFORM(FORM)

Adds the specified GraphForm to the chart. See Chart Annotation and
Decoration for available forms.

Parameter
form a GraphForm object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form = new LineForm();
form.addPoint(new java.awt.Point(0,0));
form.addPoint(new java.awt.Point(100,100));
form.addPoint(new java.awt.Point(200,100));
form.setFill(true);
graph.addForm(form);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.
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EGraph.GETCOORDINATE()

Returns a handle to the graph’s Coordinate object. This is useful in cases
where the coordinates were not explicitly assigned to a variable at creation
time.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report)
Bind a bar-type chart to the sample ‘All Sales’ query in ‘Orders’ > ‘Sample
Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script:

var coord = graph.getCoordinate();
coord.transpose();

Example (Viewsheet)
Create a Viewsheet based on the ‘Sales Explore’ Worksheet. Bind a bar-
type chart with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script:

var coord = graph.getCoordinate();
coord.transpose();

See Also
Appendix SC.12, Changing the Chart Coordinates, for information on
modifying coordinates.
Appendix SC.6, Chart Coordinates & Scaling, for available coordinate
sets.

EGraph.GETELEMENT(INDEX)

Returns a handle to the GraphElement object specified by the index. This is
useful in cases where the element was not explicitly assigned to a variable
at creation time.

Parameter
index Integer index of element

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report)
Bind a bar-type chart to the sample ‘All Sales’ query in ‘Orders’ > ‘Sample
Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script:
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var elem = graph.getElement(0);
elem.setHint(GraphElement.HINT_SHINE,'false');

Example (Viewsheet)
Create a Viewsheet based on the ‘Sales Explore’ Worksheet. Bind a bar-
type chart with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script:

var elem = graph.getElement(0);
elem.setHint(GraphElement.HINT_SHINE,'false');

See Also
Representing Multiple Measures, to add multiple elements.
Chart Elements, for available elements.

EGraph.GETELEMENTCOUNT()

Returns the number of GraphElement objects currently on the chart. 

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Total 1","Total 2"], ["NJ",200,500], 
["NY",300,400]];
graph = new EGraph();
graph.addElement(new LineElement("State","Total 1"));
graph.addElement(new LineElement("State","Total 2"));
var elemCount = graph.getElementCount();
for (var i=0;i<elemCount;i++) {

graph.getElement(i).endArrow = true;
}

See Also
DataSet, to use a Data Block or query as the dataset source.

EGraph.GETFORM(INDEX)

Returns a handle to the GraphForm object specified by the index. This is
useful in cases where the form was not explicitly assigned to a variable at
creation time.

Parameter
index Integer index of form

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
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var elem = new IntervalElement("State", "Quantity");
graph.addForm(new LineForm());
var form = graph.getForm(0);
form.addPoint(java.awt.Point(100,100));
form.addPoint(java.awt.Point(200,200));
form.setColor(java.awt.Color(0xff0000));
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.
Adding Decorative Elements, for information on manually adding
elements.
Chart Annotation and Decoration, for available forms.

EGraph.GETFORMCOUNT()

Returns the number of forms currently present on the chart.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
graph.addForm(new LineForm());
graph.addForm(new LineForm());
graph.addForm(new LineForm());
var formCount = graph.getFormCount();
for (var i=0;i<formCount;i++) {
graph.getForm(i).addValues(['NJ',i*100]);
graph.getForm(i).addValues(['NY',300]);
graph.getForm(i).setColor(java.awt.Color(0xff0000));

}
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

EGraph.GETSCALE(FIELD)

Returns a handle to the Scale object specified by the field name parameter.
This is useful in cases where the scale was not explicitly assigned to a
variable at creation time.

Parameters
field String representing field name

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.
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Example (Report)
Bind a bar-type chart to the sample ‘All Sales’ query in ‘Orders’ > ‘Sample
Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script:

var scale = graph.getScale("Sum(Total)");
scale.setMin(600000);
scale.setMax(1000000);

Example (Viewsheet)
Create a Viewsheet based on the ‘Sales Explore’ Worksheet. Bind a bar-
type chart with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script:

var scale = graph.getScale("Sum(Total)");
scale.setMin(600000);
scale.setMax(1000000);

See Also
Changing Chart Scaling, for information on setting scales.
Chart Coordinates & Scaling, for available scales.

EGraph.SETLEGENDLAYOUT(VALUE)

Specifies the chart legend’s position. 

Parameter
value Chart.BOTTOM // below chart data

Chart.TOP // above chart data
Chart.RIGHT // right of chart 
Chart.LEFT // left of chart
Chart.IN_PLACE // floated on chart
Chart.NONE // no legend

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new CategoricalColorFrame();
frame.setField("State");
elem.setColorFrame(frame);
graph.setLegendLayout(Chart.BOTTOM);
graph.addElement(elem);
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See Also
Legend Positions, for a list of available positions.
DataSet, to use a Data Block or query as the dataset source.

EGraph.SETCOORDINATE(COORD)

Sets the specified Coordinate for the chart. See Chart Coordinates &
Scaling for available coordinate types.

Parameter
coord a Coordinate object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var sscale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
var coord = new RectCoord(sscale,qscale);
coord.transpose();
graph.setCoordinate(coord);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.
Changing the Chart Coordinates, for information on modifying
coordinates.
Chart Coordinates & Scaling, for available coordinate sets.

EGraph.SETSCALE(FIELD, SCALE)

Sets the specified Scale for the given axis. See Chart Coordinates &
Scaling for available scales.

Parameters
field name of axis to receive scale (String)
scale scale to apply to axis (Scale)
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new LineElement("State", "Quantity");
var qscale = new LinearScale("Quantity");
qscale.setMin(100);
qscale.setMax(500);
graph.addElement(elem);
graph.setScale("Quantity", qscale);

See Also
DataSet, to use a Data Block or query as the dataset source.
Changing Chart Scaling, for information on setting scales.
Chart Coordinates & Scaling, for available scales.

EGraph.SETXTITLESPEC(SPEC)

Specifies the X-axis title information for X-axis below the chart.

Parameter
spec a TitleSpec object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var spec = new TitleSpec();
spec.setLabel("X Title")
graph.setXTitleSpec(spec);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.
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EGraph.SETX2TITLESPEC(SPEC)

Specifies the X-axis title information for X-axis above the chart.

Parameter
spec a TitleSpec object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var spec = new TitleSpec();
spec.setLabel("X Title")
graph.setX2TitleSpec(spec);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

EGraph.SETYTITLESPEC(SPEC)

Specifies the Y-axis title information for Y-axis to left of chart.

Parameter
spec a TitleSpec object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var spec = new TitleSpec();
spec.setLabel("Y Title")
graph.setYTitleSpec(spec);
graph.addElement(elem);
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See Also
DataSet, to use a Data Block or query as the dataset source.

EGraph.SETY2TITLESPEC(SPEC)

Specifies the Y-axis title information for Y-axis to right of chart.

Type
spec a TitleSpec object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var spec = new TitleSpec();
spec.setLabel("Y Title")
graph.setY2TitleSpec(spec);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.4.5 LegendSpec 

The LegendSpec object contains legend formatting information. 

Full Name
inetsoft.graph.LegendSpec
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LegendSpec: setBackground, setBorder, setBorderColor, setPartial, setPosition,
setPreferredSize, setTextFrame, setTextSpec, setTitle, setTitleTextSpec, setTitleVisible,
setVisible 

See Also
VisualFrame, to create groupings that generate a legend on the chart.
EGraph.setLegendLayout(value), to place the legend in a predefined
location.

LegendSpec.SETBACKGROUND(VALUE)

Specifies the legend background color.

Parameter
value a java.awt.Color object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new CategoricalColorFrame();
frame.setField("State");
var spec = new LegendSpec();
spec.setBackground(java.awt.Color(0xff00ff));
frame.setLegendSpec(spec);
elem.setColorFrame(frame);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

LegendSpec.SETBORDER(VALUE)

Specifies the legend border style.

Parameter
value a GLine object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new CategoricalColorFrame();
frame.setField("State");
var spec = new LegendSpec();
spec.setBorder(Chart.DASH_LINE);
frame.setLegendSpec(spec);
elem.setColorFrame(frame);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

LegendSpec.SETBORDERCOLOR(VALUE)

Specifies the legend border color.

Parameter
value a java.awt.Color object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new CategoricalColorFrame();
frame.setField("State");
var spec = new LegendSpec();
spec.setBorderColor(java.awt.Color(0xff00ff));
frame.setLegendSpec(spec);
elem.setColorFrame(frame);
graph.addElement(elem);

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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See Also
DataSet, to use a Data Block or query as the dataset source.

LegendSpec.SETPARTIAL(BOOLEAN)

Specifies whether legend items can be ignored when there is insufficient
space.

Type
boolean true: ignore items exceeding legend size

false: compress items to fit (default)

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["New Jersey",200], 

["New York",300], ["Pennsylvania",120],
["Connecticut",450], ["New Mexico",200],
["Colorado",300], ["Oregon",200],
["Kentucky",300], ["California",100], 
["Alaska",350], ["Alabama",200], ["Kansas",500], 
["Texas",200], ["North Dakota",300], 
["Maryland",200], ["Delaware",250], 
["Washington",200], ["Vermont",75]];

graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new CategoricalColorFrame();
frame.setField("State");
var spec = new LegendSpec();
spec.setPartial(true);
frame.setLegendSpec(spec);
elem.setColorFrame(frame);
graph.addElement(elem);
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Drag the Chart handles to a make the chart smaller. Note how the contents
of the legend are abridged.

See Also
DataSet, to use a Data Block or query as the dataset source.

LegendSpec.SETPOSITION(VALUE)

Specifies the position of the legend’s bottom-left corner (in pixels or
proportion) for cases when “in place” layout is used. (Positive values
specify distance from left/bottom. Negative values specify distance from
right/top.)

Type
value a subclass of java.awt.geom.Point2D

e.g., 
java.awt.Point for pixels
java.awt.geom.Point2D.Double for proportion

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new CategoricalColorFrame();
frame.setField("State");
var spec = new LegendSpec();
spec.setPosition(java.awt.Point(50,245)); // in pixels
frame.setLegendSpec(spec);
elem.setColorFrame(frame);
graph.setLegendLayout(Chart.IN_PLACE);
graph.addElement(elem);

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/geom/Point2D.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Point.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/geom/Point2D.Double.html
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See Also
DataSet, to use a Data Block or query as the dataset source.
EGraph.setLegendLayout(value), to place the legend in a predefined
location.

LegendSpec.SETPREFERREDSIZE(VALUE)

Specifies the legend size (pixels) for cases when
EGraph.setLegendLayout(value) is set to Chart.IN_PLACE.

Parameter
value a java.awt.Dimension object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new CategoricalColorFrame();
frame.setField("State");
var spec = new LegendSpec();
spec.setPosition(java.awt.Point(50,245)); // in pixels
spec.setPreferredSize(java.awt.Dimension(100,40));
frame.setLegendSpec(spec);
elem.setColorFrame(frame);
graph.setLegendLayout(Chart.IN_PLACE);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Dimension.html
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LegendSpec.SETTEXTFRAME(FRAME)

Specifies the TextFrame containing a mapping between legend values and
replacement text. 

Parameter
frame a TextFrame object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new CategoricalColorFrame();
var tf = new DefaultTextFrame();
frame.setField("State");
tf.setText('NJ','New Jersey');
tf.setText('NY','New York');
var spec = new LegendSpec();
spec.setTextFrame(tf);
frame.setLegendSpec(spec);
elem.colorFrame = frame;
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

LegendSpec.SETTEXTSPEC(SPEC)

Specifies the legend body text attributes, such as color, font, format, etc.

Parameter
spec a TextSpec object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.
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Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new CategoricalColorFrame();
frame.setField("State");
var lspec = new LegendSpec();
var tspec = new TextSpec();
tspec.setColor(java.awt.Color(0xff0000))
lspec.setTextSpec(tspec);
frame.setLegendSpec(lspec);
elem.setColorFrame(frame);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

LegendSpec.SETTITLE(VALUE)

Specifies the legend title.

Parameter
value a String containing the title text

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new CategoricalColorFrame();
frame.setField("State");
var spec = new LegendSpec();
spec.setTitle('Legend1');
frame.setLegendSpec(spec);
elem.setColorFrame(frame);
graph.addElement(elem);
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See Also
DataSet, to use a Data Block or query as the dataset source.

LegendSpec.SETTITLETEXTSPEC(SPEC)

Specifies the legend title text attributes, such as color, font, format, etc.

Parameter
spec a TextSpec object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new CategoricalColorFrame();
frame.setField("State");
var lspec = new LegendSpec();
var tspec = new TextSpec();
tspec.setColor(java.awt.Color(0xff0000))
lspec.setTitleTextSpec(tspec);
frame.setLegendSpec(lspec);
elem.setColorFrame(frame);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.
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LegendSpec.SETTITLEVISIBLE(BOOLEAN)

Specifies whether the legend title is visible.

Parameter
boolean true: show title

false: hide title

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new CategoricalColorFrame();
frame.setField("State");
var spec = new LegendSpec();
spec.setTitleVisible(false);
frame.setLegendSpec(spec);
elem.setColorFrame(frame);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

LegendSpec.SETVISIBLE(BOOLEAN)

Specifies whether the legend is visible.

Type
boolean true: show legend

false: hide legend

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
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var frame = new CategoricalColorFrame();
frame.setField("State");
var spec = new LegendSpec();
spec.setVisible(false);
frame.setLegendSpec(spec);
elem.setColorFrame(frame);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.4.6 TitleSpec 

The TitleSpec object contains title text and formatting information. 

Full Name
inetsoft.graph.TitleSpec

TitleSpec: setLabel, setTextSpec 

TitleSpec.SETLABEL(VALUE)

Specifies the title text.

Parameter
value a String containing the label

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var spec = new TitleSpec();
spec.setLabel("X Title")
graph.setXTitleSpec(spec);
graph.addElement(elem);
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See Also
DataSet, to use a Data Block or query as the dataset source.

TitleSpec.SETTEXTSPEC(SPEC)

Specifies the title text attributes, such as color, font, format, etc.

Parameter
spec a TextSpec object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var titlespec = new TitleSpec();
var textspec = new TextSpec();
textspec.setColor(java.awt.Color(0xff0000));
titlespec.setLabel("X Title")
titlespec.setTextSpec(textspec);
graph.setXTitleSpec(titlespec);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.4.7 TextSpec 

The TextSpec object contains information about the display of text.
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Full Name
inetsoft.graph.TextSpec

TextSpec: setBackground, setColor, setFont, setFormat, setRotation

TextSpec.SETBACKGROUND(VALUE)

Specifies the label background color.

Parameter
value a java.awt.Color object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form = new LabelForm();
form.setLabel("label1");
form.setValues(['NY', 100]);
var spec = new TextSpec();
spec.setBackground(java.awt.Color(0xcccccc));
form.setTextSpec(spec)
graph.addForm(form);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

TextSpec.SETCOLOR(VALUE)

Specifies the text color.

Parameter
value a java.awt.Color object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var titlespec = new TitleSpec();
var textspec = new TextSpec();
textspec.setColor(java.awt.Color(0xff0000));
titlespec.setLabel("X Title")
titlespec.setTextSpec(textspec);
graph.setXTitleSpec(titlespec);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

TextSpec.SETFONT(VALUE)

Specifies the text font, as a string with the following form: 'FontFamily-
FontStyle-FontSize'. 

Parameter
value a java.awt.Font object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var titlespec = new TitleSpec();
var textspec = new TextSpec();
textspec.setFont(java.awt.Font('Verdana',java.awt.Font.BOL
D, 14));
titlespec.setLabel("X Title")
titlespec.setTextSpec(textspec);
graph.setXTitleSpec(titlespec);
graph.addElement(elem);

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Font.html
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The following values are available for font family, style, and size:

• FontFamily can be one of the available server fonts, as well as a generic 
family such as serif and sans serif. 

• FontStyle can be BOLD, ITALIC, PLAIN, and BOLD ITALIC.

• FontSize can be any integer value.

See Also
DataSet, to use a Data Block or query as the dataset source.

TextSpec.SETFORMAT(FORMAT)

Specifies how date or numeric data should be represented in string format
for display. 

Parameter
format a java.text.Format object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"],["NJ",20000],["NY",30000]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var qscale = new LinearScale("Quantity");
var aspec = new AxisSpec();
var tspec = new TextSpec();
tspec.setFormat(java.text.DecimalFormat("##,###.00"));
aspec.setTextSpec(tspec);
qscale.setAxisSpec(aspec);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

http://download.oracle.com/javase/7/docs/api/index.html?java/text/Format.html
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Date masks follow the
java.text.SimpleDate-
Format format.

Date Format: For date formatting, use the following date masks:

M = Month
d = date
y = year
E = day of the week

Example:
For the date Nov 8, 2006:

M = 11; MM = 11; MMM = Nov; MMMM = November
d = 8; dd = 08;
yy = 06; yyyy = 2006
EEE = Wed
EEEE = Wednesday

Therefore, mask 'MMM-dd-yyyy' yields “Nov-08-2006.”

Numeric masks fol-
low the java.text.Deci-
malFormat format.

Number Format: For number formatting, use the following numeric
masks:

# = number 
0 = Number with zero padding

Example:
For the number 124521.63:

#,###.## yields 124,521.63
#,###.000 yields 124,521.630

Text Format: For text formatting, use {0} as a placeholder for the string
data.

Example:
For the string 'Susan':

“Salesperson: {0}” yields: “Salesperson: Susan”
“--{0}--” yields: “--Susan--”

See Also
DataSet, to use a Data Block or query as the dataset source.

http://download.oracle.com/javase/7/docs/api/index.html?java/text/SimpleDateFormat.html
http://download.oracle.com/javase/7/docs/api/index.html?java/text/SimpleDateFormat.html
http://download.oracle.com/javase/7/docs/api/index.html?java/text/DecimalFormat.html
http://download.oracle.com/javase/7/docs/api/index.html?java/text/DecimalFormat.html
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TextSpec.SETROTATION(VALUE)

Specifies the text rotation in degrees. 

Parameter
value a number of degrees

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"],["NJ",20000],["NY",30000]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var qscale = new LinearScale("Quantity");
var aspec = new AxisSpec();
var tspec = new TextSpec();
tspec.setRotation(45);
aspec.setTextSpec(tspec);
qscale.setAxisSpec(aspec);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.4.8 AxisSpec 

The AxisSpec object holds axis information for a scale.

Full Name
inetsoft.graph.AxisSpec

AxisSpec: setAbbreviate, setAxisStyle, setGridAsShape, setGridColor, setGridOnTop,
setGridStyle, setInPlot, setLabelVisible, setLineColor, setLineVisible, setTextFrame,
setTextSpec, setTickVisible

AxisSpec.SETABBREVIATE(BOOLEAN)

Specifies that the common prefix of TimeScale labels should be omitted to
conserve space. This property is only observed when a Date format is
specified.



COMMON FUNCTION REFERENCE

1184 of 1397

Parameter
boolean true: drop common prefixes

false: do not drop prefixes

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
var date1 = new Date();
var date2 = new Date();
date1.setFullYear(2008,0,1);
date2.setFullYear(2008,10,1);
dataset = [["Date", "Quantity"], [date1,200], [date2,300]];
graph = new EGraph();
var elem = new IntervalElement("Date", "Quantity");
var tscale = new TimeScale("Date");
var aspec = new AxisSpec();
var tspec = new TextSpec();
tspec.setFormat(java.text.SimpleDateFormat('yyyy-MMM'));
aspec.setTextSpec(tspec);
aspec.setAbbreviate(true);
tscale.setAxisSpec(aspec);
graph.setScale("Date", tscale);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

AxisSpec.SETALLTICKS(BOOLEAN)

Specifies whether tick marks should be shown for unlabeled data points.

Parameter
boolean true: show all ticks

false: show ticks for labeled points

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.
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Example (Report or Viewsheet)
For a report, add a blank chart and bind the chart to the sample ‘All Sales’
query in ‘Orders’ > ‘Sample Queries’. For a Viewsheet, create a new
Viewsheet based on the sample ‘All Sales’ query, and add a blank chart.
The follow the steps below:

1. Open the Chart Editor for the chart, and drag ‘Order Date’ to the X-
axis and ‘Total’ to the Y-axis. 

2. Press the ‘Edit Dimension’ button next to the ‘Order Date’ field
and select ‘Month’ from the ‘Level’ menu. Press the green ‘Apply’
button.

3. Add the following element-level script to the chart, and preview.

axis['Order Date'].format = [Chart.DATE_FORMAT,"yyyy"];
graph.getScale('Order 
Date').getAxisSpec().setAllTicks(true);

Observe that ticks are displayed for every month, even though the ‘yyyy’
date format displays labels only for the years.

See Also
axis.ticksVisible, to set visibility of axis ticks.
LinearScale.setMinorIncrement(value), to set tick spacing for a linear
scale.

AxisSpec.SETAXISSTYLE(VALUE)

Specifies the axis style.

Parameter
value AxisSpec.AXIS_SINGLE (axes on left/bottom)

AxisSpec.AXIS_SINGLE2 (axis on top/right)
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AxisSpec.AXIS_DOUBLE (both axes, left/bot labels)
AxisSpec.AXIS_DOUBLE2 (both axes, top/right labels)
AxisSpec.AXIS_CROSS (axis at zero-position)
AxisSpec.AXIS_NONE (axis not drawn)

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"],["NJ",20000],["NY",30000]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var qscale = new LinearScale("Quantity");
var aspec = new AxisSpec();
aspec.setAxisStyle(AxisSpec.AXIS_DOUBLE2);
qscale.setAxisSpec(aspec);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

AxisSpec.SETGRIDASSHAPE(BOOLEAN)

Specifies whether axis grid lines are represented as shapes or positions. If
represents as shapes, the grid lines can be transformed into curves under a
coordinate transformation (for example, transformation of rectangular to
polar coordinates). Otherwise, the grid lines remain straight, and only the
endpoints are transformed.

Parameter
boolean true if represented as shape

false if represented as position

AxisSpec.SETGRIDCOLOR(VALUE)

Specifies the color of the axis grid lines.

Parameter
value a java.awt.Color object

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html


COMMON FUNCTION REFERENCE

1187 of 1397

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"],["NJ",20000],["NY",30000]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var qscale = new LinearScale("Quantity");
var aspec = new AxisSpec();
aspec.setGridColor(java.awt.Color(0xff0000));
aspec.setGridStyle(Chart.DASH_LINE);
qscale.setAxisSpec(aspec);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

AxisSpec.SETGRIDONTOP(BOOLEAN)

Specifies whether axis grid lines are layered over or under the chart
elements.

Parameter
boolean true: grid overlays elements

false: elements overlay grid

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"],["NJ",20000],["NY",30000]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var qscale = new LinearScale("Quantity");
var aspec = new AxisSpec();
aspec.setGridOnTop(true);
aspec.setGridColor(java.awt.Color(0xff0000));
aspec.setGridStyle(Chart.DASH_LINE);
qscale.setAxisSpec(aspec);
graph.setScale("Quantity", qscale);
graph.addElement(elem);
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See Also
DataSet, to use a Data Block or query as the dataset source.

AxisSpec.SETGRIDSTYLE(VALUE)

Specifies the style of the axis grid lines.

Parameter
value a GLine value

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"],["NJ",20000],["NY",30000]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var qscale = new LinearScale("Quantity");
var aspec = new AxisSpec();
aspec.setGridColor(java.awt.Color(0xff0000));
aspec.setGridStyle(Chart.DASH_LINE);
qscale.setAxisSpec(aspec);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

AxisSpec.SETINPLOT(BOOLEAN)

Specifies whether the specified maximum measure value is included within
the plot region. When true, this adds a slight buffer to the edge of the plot
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area in order to ensure that the specified maximum value falls within the
displayed plot area.

Parameter
boolean true: display max value within plot region

false: display max value at edge of plot

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"],["NJ",20000],["NY",30000]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var qscale = new LinearScale("Quantity");
qscale.setMax(40000);
var aspec = new AxisSpec();
aspec.setInPlot(true);
qscale.setAxisSpec(aspec);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

See Also
GraphElement.setInPlot(boolean), to adjust plot boundaries to include
graph elements.
GraphForm.setInPlot(boolean), to adjust plot boundaries to include graph
forms.
LinearScale.setMax(value), for information on how to manually set a
maximum value using the API method.
axis.maximum, for information on how to manually set a maximum value
using the axis property.
DataSet, to use a Data Block or query as the dataset source.

AxisSpec.SETLABELVISIBLE(BOOLEAN)

Specifies whether the axis labels are visible or hidden.

Parameter
boolean true if visible

false if not visible
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"],["NJ",20000],["NY",30000]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var qscale = new LinearScale("Quantity");
var aspec = new AxisSpec();
aspec.setLabelVisible(false);
qscale.setAxisSpec(aspec);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

AxisSpec.SETLINECOLOR(VALUE)

Specifies the color of the axis lines.

Parameter
value a java.awt.Color object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"],["NJ",20000],["NY",30000]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var qscale = new LinearScale("Quantity");
var cscale = new CategoricalScale("State");
var aspec1 = new AxisSpec();
var aspec2 = new AxisSpec();
aspec1.setLineColor(java.awt.Color(0xff0000));
aspec2.setLineColor(java.awt.Color(0x00ff00));
qscale.setAxisSpec(aspec1);
cscale.setAxisSpec(aspec2);
graph.setScale("Quantity", qscale);
graph.setScale("State", cscale);
graph.addElement(elem);

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html


COMMON FUNCTION REFERENCE

1191 of 1397

See Also
DataSet, to use a Data Block or query as the dataset source.

AxisSpec.SETLINEVISIBLE(BOOLEAN)

Specifies whether the axis lines are visible or hidden.

Parameter
boolean true if visible

false if not visible

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"],["NJ",20000],["NY",30000]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var qscale = new LinearScale("Quantity");
var cscale = new CategoricalScale("State");
var aspec1 = new AxisSpec();
var aspec2 = new AxisSpec();
aspec1.setLineVisible(true);
aspec2.setLineVisible(false);
qscale.setAxisSpec(aspec1);
cscale.setAxisSpec(aspec2);
graph.setScale("Quantity", qscale);
graph.setScale("State", cscale);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.
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AxisSpec.SETTEXTFRAME(FRAME)

Specifies a mapping between axis values and replacement text.

Parameter
frame a TextFrame object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"],["NJ",20000],["NY",30000]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var cscale = new CategoricalScale("State");
var tframe = new DefaultTextFrame();
tframe.setText('NJ','New Jersey');
tframe.setText('NY','New York');
var aspec = new AxisSpec();
aspec.setTextFrame(tframe);
cscale.setAxisSpec(aspec);
graph.setScale("State", cscale);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

AxisSpec.SETTEXTSPEC(SPEC)

Specifies the display of axis text.

Parameter
spec a TextSpec object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
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var qscale = new LinearScale("Quantity");
var aspec = new AxisSpec();
var textspec = new TextSpec();
textspec.setColor(java.awt.Color(0xff0000));
aspec.setTextSpec(textspec);
qscale.setAxisSpec(aspec);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

AxisSpec.SETTICKVISIBLE(BOOLEAN)

Specifies whether the axis tick marks are visible or hidden.

Parameter
boolean true if visible

false if not visible

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var qscale = new LinearScale("Quantity");
var aspec = new AxisSpec();
aspec.setTickVisible(false);
qscale.setAxisSpec(aspec);
graph.setScale("Quantity", qscale);
graph.addElement(elem);
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See Also
DataSet, to use a Data Block or query as the dataset source.

CR.4.9 PlotSpec 

The PlotSpec object contains visual information for a Coordinate object
(i.e., the Chart’s plot area).

Full Name
inetsoft.graph.PlotSpec

PlotSpec: alpha, setBackground, setBackgroundImage, setLockAspect, setXMax,
setXMin, setYMax, setYMin

PlotSpec.SETALPHA(VALUE)

Specifies the transparency level for the Coordinate object background
color or background image.

Parameter
value a number in range [0,1], where:

0 = completely transparent 
1 = completely opaque

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
elem.setHint(GraphElement.HINT_ALPHA,.8)
var sscale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
var coord = new RectCoord(sscale,qscale);
var spec = new PlotSpec();
var logo = getImage("http://www.inetsoft.com/images/home/
logo.gif");
spec.setBackgroundImage(logo);
spec.setAlpha(.3);
coord.setPlotSpec(spec);
graph.setCoordinate(coord);
graph.addElement(elem);
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See Also
DataSet, to use a Data Block or query as the dataset source.

PlotSpec.SETBACKGROUND(VALUE)

Specifies the background color for a Coordinate object (i.e., the plot area).

Parameter
value a java.awt.Color object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var sscale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
var coord = new RectCoord(sscale,qscale);
var spec = new PlotSpec();
spec.setBackground(java.awt.Color(0xEEEEFF));
coord.setPlotSpec(spec);
graph.setCoordinate(coord);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

PlotSpec.SETBACKGROUNDIMAGE(VALUE)

Specifies the background image for a Coordinate object (i.e., the plot area).

Parameter
Image object, see getImage()

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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var elem = new IntervalElement("State", "Quantity");
elem.setHint(GraphElement.HINT_ALPHA,.8)
var sscale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
var coord = new RectCoord(sscale,qscale);
var spec = new PlotSpec();
var logo = getImage("http://www.inetsoft.com/images/home/
logo.gif");
spec.setBackgroundImage(logo);
coord.setPlotSpec(spec);
graph.setCoordinate(coord);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

PlotSpec.SETLOCKASPECT(BOOLEAN)

Specifies that the original image aspect ratio should be retained, with
coordinate scaling adapted to the image. If set to false (default), the image
is resized to fit the existing coordinate scaling.

Parameter
boolean true: keep original aspect ratio

false: change ratio to fit plot area (default)

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
elem.setHint(GraphElement.HINT_ALPHA,.8)
var sscale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
var coord = new RectCoord(sscale,qscale);
var spec = new PlotSpec();
spec.setLockAspect(true);
var logo = getImage("http://www.inetsoft.com/images/home/
logo.gif");
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Note: The gray back-
ground is set from the
‘Chart Properties’ dia-
log box (Style Stu-
dio) or the ‘Format’
dialog box (Views-
heet).

spec.setBackgroundImage(logo);
coord.setPlotSpec(spec);
graph.setCoordinate(coord);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

PlotSpec.SETXMAX(VALUE)

Specifies the X-axis value at which to place the right edge of the
background image.

Parameter
value a number

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["Q1","Q2"], [300,200], [500,300]];
graph = new EGraph();
var elem = new PointElement("Q1", "Q2");
elem.setHint(GraphElement.HINT_ALPHA,.8)
var sscale = new LinearScale("Q1");
var qscale = new LinearScale("Q2");
var coord = new RectCoord(sscale,qscale);
var spec = new PlotSpec();
var logo = 
getImage("http://www.inetsoft.com/images/home/logo.gif");
spec.setBackgroundImage(logo);
spec.setYMax(150)
spec.setYMin(100)
spec.setXMax(400)
spec.setXMin(100)
coord.setPlotSpec(spec);
graph.setCoordinate(coord);
graph.addElement(elem);
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See Also
DataSet, to use a Data Block or query as the dataset source.

PlotSpec.SETXMIN(VALUE)

Specifies the X-axis value at which to place the left edge of the background
image.

Parameter
value a number

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["Q1","Q2"], [300,200], [500,300]];
graph = new EGraph();
var elem = new PointElement("Q1", "Q2");
elem.setHint(GraphElement.HINT_ALPHA,.8)
var sscale = new LinearScale("Q1");
var qscale = new LinearScale("Q2");
var coord = new RectCoord(sscale,qscale);
var spec = new PlotSpec();
var logo = 
getImage("http://www.inetsoft.com/images/home/logo.gif");
spec.setBackgroundImage(logo);
spec.setYMax(150)
spec.setYMin(100)
spec.setXMax(400)
spec.setXMin(100)
coord.setPlotSpec(spec);
graph.setCoordinate(coord);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

PlotSpec.SETYMAX(VALUE)

Specifies the Y-axis value at which to place the top edge of the background
image.

Parameter
value a number
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["Q1","Q2"], [300,200], [500,300]];
graph = new EGraph();
var elem = new PointElement("Q1", "Q2");
elem.setHint(GraphElement.HINT_ALPHA,.8)
var sscale = new LinearScale("Q1");
var qscale = new LinearScale("Q2");
var coord = new RectCoord(sscale,qscale);
var spec = new PlotSpec();
var logo = 
getImage("http://www.inetsoft.com/images/home/logo.gif");
spec.setBackgroundImage(logo);
spec.setYMax(150)
spec.setYMin(100)
spec.setXMax(400)
spec.setXMin(100)
coord.setPlotSpec(spec);
graph.setCoordinate(coord);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

PlotSpec.SETYMIN(VALUE)

Specifies the Y-axis value at which to place the bottom edge of the
background image.

Parameter
value a number

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["Q1","Q2"], [300,200], [500,300]];
graph = new EGraph();
var elem = new PointElement("Q1", "Q2");
elem.setHint(GraphElement.HINT_ALPHA,.8)
var sscale = new LinearScale("Q1");
var qscale = new LinearScale("Q2");
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var coord = new RectCoord(sscale,qscale);
var spec = new PlotSpec();
var logo = 
getImage("http://www.inetsoft.com/images/home/logo.gif");
spec.setBackgroundImage(logo);
spec.setYMax(150)
spec.setYMin(100)
spec.setXMax(400)
spec.setXMin(100)
coord.setPlotSpec(spec);
graph.setCoordinate(coord);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.5 Chart Elements

This section discusses the various data-representation elements that can be
added to charts.

CR.5.1 GraphElement

The GraphElement object contains the visual elements that represent data.
For example, PointElement is a GraphElement that represents data tuples
as points.

Full Name
inetsoft.graph.element.GraphElement
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GraphElement: addDim(), addVar(), setCollisionModifier, setColorFrame, setInPlot,
setLabelPlacement, setLineFrame, setHint(), setShapeFrame, setSizeFrame,
setTextFrame, setTextSpec, setTextureFrame

Created by
AreaElement
PointElement
SchemaElement
LineElement
IntervalElement

GraphElement.ADDDIM(FIELD)

Add a dimension to a GraphElement object. A dimension is plotted on the
X-axis, or on the outer coordinates of nested coordinates.

Parameter
field String containing name of dimension

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "City", "Quantity"], 

["NJ","Edison",2500], ["NJ","Piscataway",3000],
["NY","NY City",5000],["NY","Yonkers",450]];

graph = new EGraph();
var elem = new IntervalElement("State","Quantity");
elem.addDim("City");
graph.addElement(elem);
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See Also
DataSet, to use a Data Block or query as the dataset source.

GraphElement.ADDVAR(FIELD)

Add a variable to a GraphElement object. A variable is plotted on the Y-
axis.

Parameter
field String containing name of variable

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity", 
"Total"],["NY",550,2500],["NJ",370,3000]];
graph = new EGraph();
var elem = new LineElement("State","Quantity");
elem.addVar("Total");
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

GraphElement.SETCOLLISIONMODIFIER(VALUE)

Specifies how collisions (elements occupying the same location) should be
handled. 
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Parameter
value GraphElement.MOVE_NONE (do not stack/center)

GraphElement.MOVE_CENTER (center, do not stack)
GraphElement.MOVE_DODGE (offset horizontal)
GraphElement.MOVE_STACK (offset vertical (stack))
GraphElement.MOVE_JITTER (random offset (points))
GraphElement.DODGE_SYMMETRIC (offset horiz, center)
GraphElement.STACK_SYMMETRIC (offset vert, center)

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NJ", 300], 
["NY", 300], ["NY", 100]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var scale = new LinearScale("Quantity");
var frame = new HeatColorFrame();
frame.setField("Quantity");
elem.setColorFrame(frame);
elem.setStackGroup(true);
elem.setCollisionModifier(GraphElement.STACK_SYMMETRIC);
graph.addElement(elem);

Example (Report or Viewsheet)
dataset = [["State","Quantity"],["NJ",200],["NJ",200], 

["NJ",200],["NJ",200],["NJ",200],["NJ",300], 
["NY",300],["NY",300],["NY",300],["NY",300],
["NY",300],["NY",450]];

graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var frame = new HeatColorFrame();
frame.setField("Quantity");
elem.setColorFrame(frame);
elem.setStackGroup(true);
elem.setCollisionModifier(GraphElement.MOVE_JITTER);
graph.addElement(elem);
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See Also
DataSet, to use a Data Block or query as the dataset source.

GraphElement.SETCOLORFRAME(FRAME)

Specifies the aesthetic color treatment for the chart elements. A
ColorFrame can color-code chart elements by value, or simply specify a
static color scheme. 

Parameter
frame a ColorFrame object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var frame = new HeatColorFrame();
var elem = new IntervalElement("State", "Quantity");
frame.setField("Quantity");
elem.setColorFrame(frame);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

GraphElement.SETINPLOT(BOOLEAN)

Specifies whether the chart should be resized so that graph elements remain
fully visible in the chart area.
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Parameter
boolean true: resize chart

false: do not resize chart (crop elements)

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var scale = new LinearScale("Quantity");
scale.setMax(100);
graph.setScale("Quantity",scale);
elem.setInPlot(false);
graph.addElement(elem);

See Also
AxisSpec.setInPlot(boolean), to adjust plot boundaries to include graph
labels.
GraphForm.setInPlot(boolean), to adjust plot boundaries to include graph
forms.
DataSet, to use a Data Block or query as the dataset source.

GraphElement.SETLABELPLACEMENT(VALUE)

Specifies the location of element labels.

Parameter
value Chart.CENTER (center of element)

Chart.BOTTOM (below element)
Chart.TOP (above element 
Chart.RIGHT (right of element)
Chart.LEFT (left of element)

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.
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Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["CA", 200], ["NY", 300]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var frame = new DefaultTextFrame();
frame.setField("Quantity")
elem.setTextFrame(frame);
elem.setLabelPlacement(Chart.BOTTOM);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

GraphElement.SETLINEFRAME(FRAME)

Specifies the aesthetic line style of graphical elements. A LineFrame can
line-code chart elements by value, or simply specify a static line style.

Parameter
frame a LineFrame object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["CA", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new StaticLineFrame();
frame.setLine(GLine.LARGE_DASH)
elem.setLineFrame(frame);
graph.addElement(elem);
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See Also
DataSet, to use a Data Block or query as the dataset source.

GraphElement.SETHINT(TYPE,VALUE)

Add an effect to a GraphElement object. The available effects are
HINT_EXPLODED (element separation, or explosion), HINT_SHINE (three-
dimensional shading), and HINT_ALPHA (transparency).

Parameters
type GraphElement.HINT_EXPLODED, 

GraphElement.HINT_SHINE, or
GraphElement.HINT_ALPHA

value For HINT_EXPLODED: 'true' or 'false'
For INT_SHINE: 'true' or 'false' 
For HINT_ALPHA: float in range [0,1]

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"],["NY",200], ["NJ",300]];
graph = new EGraph();
var elem = new IntervalElement("State","Quantity");
elem.setHint(GraphElement.HINT_SHINE,'true')
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

GraphElement.SETSHAPEFRAME(FRAME)

Specifies the aesthetic shape treatment for the chart elements. A
ShapeFrame can shape-code chart elements by value, or simply specify a
static shape style. 

Parameter
frame a ShapeFrame object
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity","m1","m2", 
"m3"],["NJ",200,6,3,4],["NY",300,8,2,5]];
graph = new EGraph();
var frame = new StarShapeFrame();
var elem = new PointElement("State", "Quantity");
frame.setFields(["m1", "m2", "m3"]);
elem.setShapeFrame(frame);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

GraphElement.SETSIZEFRAME(FRAME)

Specifies the size of graphical elements. A SizeFrame can size-code chart
elements by value, or simply specify a static size.

Parameter
frame a SizeFrame object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = 
[["State","Quantity","width"],["NJ",200,5],["NY",300,10],["
PA",75,15]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity")
var frame = new LinearSizeFrame();
frame.setField("width");
frame.setSmallest(10);
frame.setLargest(50);
frame.setMax(100);
elem.setSizeFrame(frame);
graph.addElement(elem);
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See Also
DataSet, to use a Data Block or query as the dataset source.

GraphElement.SETTEXTFRAME(FRAME)

Specifies the data values to be displayed on the chart elements as text, as
well as the mapping between element values and displayed text. 

Parameter
frame a TextFrame object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["CA", 200], ["NY", 300]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var frame = new DefaultTextFrame();
frame.setField("Quantity");
elem.setTextFrame(frame);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

GraphElement.SETTEXTSPEC(SPEC)

Specifies the text attributes such as color, font, format, etc.
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Parameter
spec a TextSpec object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["CA", 200], ["NY", 300]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var frame = new DefaultTextFrame();
frame.setField("Quantity");
var spec = new TextSpec();
spec.setColor(java.awt.Color(0xff0000));
elem.setTextFrame(frame);
elem.setTextSpec(spec);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

GraphElement.SETTEXTUREFRAME(FRAME)

Specifies the aesthetic texture of graphical elements. A TextureFrame can
texture-code chart elements by value, or simply specify a static texture
style.

Parameter
frame a TextureFrame object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 300], ["NY", 200]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new StaticTextureFrame();
frame.setTexture(GTexture.PATTERN_18)
elem.setTextureFrame(frame);
graph.addElement(elem);
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See Also
DataSet, to use a Data Block or query as the dataset source.

CR.5.2 IntervalElement 

The IntervalElement object contains the visual elements for bar charts and
range visualization. To create a new IntervalElement object, call the
IntervalElement constructor.

var elem = new IntervalElement("State", "Quantity");

You can pass a set of fields as input to the constructor (e.g., ‘State’,
‘Quantity’), or specify these later using the addDim() and addVar()
methods.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
graph.addElement(elem);

Full Name
inetsoft.graph.element.IntervalElement

IntervalElement: addInterval(), setStackGroup, setStackNegative

Inherits from
GraphElement: addDim(), addVar(), setCollisionModifier,
setColorFrame, setInPlot, setLabelPlacement, setLineFrame, setHint(),
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setShapeFrame, setSizeFrame, setTextFrame, setTextSpec,
setTextureFrame

See Also
DataSet, to use a Data Block or query as the dataset source.

IntervalElement.ADDINTERVAL(LOWER,UPPER)

Adds a “floating” interval element (bar) with lower and upper values
specified by the inputs.

Parameters
lower Name of field defining lower values (String)
upper Name of field defining upper values (String)

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["Student","Bottom Score","Top 
Score"],["Joe",70,80], ["Eric",50,90],["Jane",90,100], 
["Sue",40,45]];
graph = new EGraph();
var elem = new IntervalElement();
elem.addDim("Student");
elem.addInterval("Bottom Score","Top Score")
graph.addElement(elem);

Inherits from
GraphElement: addDim(), addVar(), setCollisionModifier,
setColorFrame, setInPlot, setLabelPlacement, setLineFrame, setHint(),
setShapeFrame, setSizeFrame, setTextFrame, setTextSpec,
setTextureFrame

See Also
DataSet, to use a Data Block or query as the dataset source.

IntervalElement.SETSTACKGROUP(BOOLEAN)

Specifies whether each element group (i.e., bar series) should be stacked
independently, or whether all should form a single stack order.
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Parameters
boolean true: independent stack order for each group

false: single stack order for all groups

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"],["NJ",200], 
["NJ",300],["NY",300],["NY",100]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var scale = new LinearScale("Quantity");
var frame = new HeatColorFrame();
frame.setField("Quantity");
elem.setColorFrame(frame);
elem.setStackGroup(true);
elem.setCollisionModifier(GraphElement.STACK_SYMMETRIC);
graph.addElement(elem);

Inherits from
GraphElement: addDim(), addVar(), setCollisionModifier,
setColorFrame, setInPlot, setLabelPlacement, setLineFrame, setHint(),
setShapeFrame, setSizeFrame, setTextFrame, setTextSpec,
setTextureFrame

See Also
DataSet, to use a Data Block or query as the dataset source.

IntervalElement.SETSTACKNEGATIVE(BOOLEAN)

Specifies whether negative and positive values stack independently on
opposite sides of the axis, or whether stacking is cumulative (i.e.,
determined arithmetically).

Parameters
boolean true: independent stack order for each group

false: single stack order for all groups

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.
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Example (Report or Viewsheet)
dataset = 
[["State","Quantity"],["NJ",200],["NJ",300],["NY",-
300],["NY",100]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var scale = new LinearScale("Quantity");
var frame = new HeatColorFrame();
frame.setField("Quantity");
elem.setColorFrame(frame);
elem.setStackGroup(true);
elem.setStackNegative(false);
elem.setCollisionModifier(GraphElement.STACK_SYMMETRIC);
graph.addElement(elem);

Inherits from
GraphElement: addDim(), addVar(), setCollisionModifier,
setColorFrame, setInPlot, setLabelPlacement, setLineFrame, setHint(),
setShapeFrame, setSizeFrame, setTextFrame, setTextSpec,
setTextureFrame

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.5.3 LineElement 

The LineElement object contains the visual elements for a line chart. To
create a new LineElement object, call the LineElement constructor.

var elem = new LineElement("State", "Quantity");

You can pass one, two, or three field names (e.g., ‘State’, ‘Quantity’) to the
constructor, or specify these later using the addDim() and addVar()
methods.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 100], ["NY", 300]];
graph = new EGraph();
var elem = new LineElement("State", "Quantity")
graph.addElement(elem);
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Full Name
inetsoft.graph.element.LineElement

LineElement: setClosed, setEndArrow, setStackGroup, setStackNegative, setStartArrow

Inherits from
GraphElement: addDim(), addVar(), setCollisionModifier,
setColorFrame, setInPlot, setLabelPlacement, setLineFrame, setHint(),
setShapeFrame, setSizeFrame, setTextFrame, setTextSpec,
setTextureFrame

See Also
DataSet, to use a Data Block or query as the dataset source.

LineElement.SETCLOSED(BOOLEAN)

Specifies whether the line object should be automatically closed (i.e.,
endpoints connected).

Type
boolean true: close the figure

false: do not close

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = 
[["State","Quantity"],["NJ",100],["NY",300],["PA",200]];
graph = new EGraph();
elem = new LineElement("State", "Quantity")
elem.setClosed(true);
graph.addElement(elem);



COMMON FUNCTION REFERENCE

1216 of 1397

Inherits from
GraphElement: addDim(), addVar(), setCollisionModifier,
setColorFrame, setInPlot, setLabelPlacement, setLineFrame, setHint(),
setShapeFrame, setSizeFrame, setTextFrame, setTextSpec,
setTextureFrame

See Also
DataSet, to use a Data Block or query as the dataset source.

LineElement.SETENDARROW(BOOLEAN)

Specifies whether an arrow should be drawn at the end of the line (last
point).

Parameters
boolean true: draw arrow

false: do not draw arrow

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = 
[["State","Quantity"],["NJ",100],["NY",300],["PA",200]];
graph = new EGraph();
elem = new LineElement("State", "Quantity")
elem.setEndArrow(true);
graph.addElement(elem);

Inherits from
GraphElement: addDim(), addVar(), setCollisionModifier,
setColorFrame, setInPlot, setLabelPlacement, setLineFrame, setHint(),
setShapeFrame, setSizeFrame, setTextFrame, setTextSpec,
setTextureFrame

See Also
DataSet, to use a Data Block or query as the dataset source.

LineElement.SETSTACKGROUP(BOOLEAN)

Specifies whether each subgroup receives an independent element
(separate line), or whether a single element is used for all.

Parameters
boolean true: independent lines for each group

false: single line for all groups (default)

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.
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Example (Report or Viewsheet)
dataset = 
[["State","Product","Quantity"],["NJ","P1",200],["NJ","P2",
300], ["NY","P1",300],["NY","P2",100]];
graph = new EGraph();
var elem = new LineElement("State", "Quantity");
elem.setColorFrame(new CategoricalColorFrame("Product"));
elem.setStackGroup(true);
graph.addElement(elem);

Inherits from
GraphElement: addDim(), addVar(), setCollisionModifier,
setColorFrame, setInPlot, setLabelPlacement, setLineFrame, setHint(),
setShapeFrame, setSizeFrame, setTextFrame, setTextSpec,
setTextureFrame

See Also
DataSet, to use a Data Block or query as the dataset source.

LineElement.SETSTACKNEGATIVE(BOOLEAN)

Specifies whether negative and positive values stack independently on
opposite sides of the axis, or whether stacking is cumulative (i.e.,
determined arithmetically).

Parameters
boolean true: independent stack order for each group

false: single stack order for all groups

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = 
[["State","Product","Quantity"],["NJ","P1",200],["NJ","P2",
300], ["NY","P1",-300],["NY","P2",100]];
graph = new EGraph();
var elem = new LineElement("State", "Quantity");
var scale = new LinearScale("Quantity");
elem.setColorFrame(new CategoricalColorFrame("Product"));
elem.setStackGroup(true);
elem.setStackNegative(false);
elem.setCollisionModifier(GraphElement.STACK_SYMMETRIC);
graph.addElement(elem);
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Inherits from
GraphElement: addDim(), addVar(), setCollisionModifier,
setColorFrame, setInPlot, setLabelPlacement, setLineFrame, setHint(),
setShapeFrame, setSizeFrame, setTextFrame, setTextSpec,
setTextureFrame

See Also
DataSet, to use a Data Block or query as the dataset source.

LineElement.SETSTARTARROW(BOOLEAN)

Specifies whether an arrow should be drawn at the start of the line (first
point).

Parameters
boolean true: draw arrow

false: do not draw arrow

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = 
[["State","Quantity"],["NJ",100],["NY",300],["PA",200]];
graph = new EGraph();
elem = new LineElement("State", "Quantity")
elem.setStartArrow(true);
graph.addElement(elem);

Inherits from
GraphElement: addDim(), addVar(), setCollisionModifier,
setColorFrame, setInPlot, setLabelPlacement, setLineFrame, setHint(),
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setShapeFrame, setSizeFrame, setTextFrame, setTextSpec,
setTextureFrame

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.5.4 SchemaElement 

The SchemaElement object contains user-defined visual elements that can
be added to the graph. To create a new SchemaElement object, call the
SchemaElement constructor.

var elem = new SchemaElement("State", "Quantity");

You can pass a set of field names (e.g., ‘State’, ‘Quantity’) to the
constructor, or specify these later using the addDim() and addVar()
methods.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = 
[["State","Hi","Upper","Median","Lower","Lo"],["NJ",200,180
,150,120,100],["NJ",220,170,140,110,105],["NY",300,250,230, 
150,80]];
graph = new EGraph();
var elem = new SchemaElement();
elem.addDim("State")
elem.addSchema("Hi","Upper","Median","Lower","Lo")
elem.setPainter(new BoxPainter());
graph.addElement(elem);

Full Name
inetsoft.graph.element.SchemaElement

SchemaElement: setPainter

Inherits from
GraphElement: addDim(), addVar(), setCollisionModifier,
setColorFrame, setInPlot, setLabelPlacement, setLineFrame, setHint(),
setShapeFrame, setSizeFrame, setTextFrame, setTextSpec,
setTextureFrame
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See Also
DataSet, to use a Data Block or query as the dataset source.

SchemaElement.SETPAINTER(PAINTER)

Specifies the SchemaPainter object to be used in drawing the visual chart
elements.

Parameter
painter BoxPainter: Box and whiskers plot

CandlePainter: Candle plot
StockPainter: Stock chart

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Hi", "Lo", "Open", "Close"],["NJ", 
200, 100, 120, 150],["NY", 300, 100, 200, 120]]       
graph = new EGraph();
var elem = new SchemaElement();
elem.addDim("State")
elem.addSchema("Hi", "Close", "Lo")
elem.setPainter(new StockPainter());
graph.addElement(elem);

Inherits from
GraphElement: addDim(), addVar(), setCollisionModifier,
setColorFrame, setInPlot, setLabelPlacement, setLineFrame, setHint(),
setShapeFrame, setSizeFrame, setTextFrame, setTextSpec,
setTextureFrame

See Also
DataSet, to use a Data Block or query as the dataset source.

SchemaElement.ADDSCHEMA(COL)

Specifies the SchemaPainter object to be used in drawing the visual chart
elements.

Parameter
col list of columns for schema binding
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Hi", "Lo", "Open", "Close"],["NJ", 
200, 100, 120, 150],["NY", 300, 100, 200, 120]];
graph = new EGraph();
var elem = new SchemaElement();
elem.addDim("State")
elem.addSchema("Hi", "Close", "Lo")
elem.setPainter(new StockPainter());
graph.addElement(elem);

Inherits from
GraphElement: addDim(), addVar(), setCollisionModifier,
setColorFrame, setInPlot, setLabelPlacement, setLineFrame, setHint(),
setShapeFrame, setSizeFrame, setTextFrame, setTextSpec,
setTextureFrame

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.5.5 PointElement 

The PointElement object contains the visual elements for a point (scatter)
chart. To create a new PointElement object, call the PointElement
constructor.

var elem = new PointElement("State", "Quantity");

You can pass a set of field names (e.g., ‘State’, ‘Quantity’) to the
constructor, or specify these later using the addDim() and addVar()
methods.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity")
graph.addElement(elem);
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Full Name
inetsoft.graph.element.PointElement

Inherits from
GraphElement: addDim(), addVar(), setCollisionModifier,
setColorFrame, setInPlot, setLabelPlacement, setLineFrame, setHint(),
setShapeFrame, setSizeFrame, setTextFrame, setTextSpec,
setTextureFrame

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.5.6 AreaElement

The AreaElement object contains the visual elements for an area chart. To
create a new AreaElement object, call the AreaElement constructor.

var elem = new AreaElement("State", "Quantity");

You can pass a set of field names (e.g., ‘State’, ‘Quantity’) to the
constructor, or specify these later using the addDim() and addVar()
methods.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
elem = new AreaElement("State", "Quantity");
graph.addElement(elem);
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Full Name
inetsoft.graph.element.AreaElement

Inherits from
LineElement: setClosed, setEndArrow, setStackGroup, setStackNegative,
setStartArrow
GraphElement: addDim(), addVar(), setCollisionModifier,
setColorFrame, setInPlot, setLabelPlacement, setLineFrame, setHint(),
setShapeFrame, setSizeFrame, setTextFrame, setTextSpec,
setTextureFrame

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.6 Chart Coordinates & Scaling

This section discusses objects related to setting chart coordinates and their
scaling properties. See Changing Chart Scaling for a tutorial introduction.

CR.6.1 Coordinate

The Coordinate object contains the coordinates against which data can be
represented. 

Full Name
inetsoft.graph.coord.Coordinate

Coordinate: reflect, rotate, setExtent, transpose

Created by
PolarCoord
RectCoord
ParallelCoord
FacetCoord

Coordinate.REFLECT(VERT)

Reflect the coordinates about the vertical or horizontal axis.

Parameter
vert true: reflect about horizontal axis

false: reflect about vertical axis

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var sscale = new CategoricalScale("State");
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var qscale = new LinearScale("Quantity");
var coord = new RectCoord(sscale,qscale);
coord.reflect(true);
graph.setCoordinate(coord);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

Coordinate.ROTATE(VALUE)

Rotate the axes by the specified angle.

Parameter
value an Angle in degrees

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["Direction", "Score"],[(Math.PI/
2),20],[(Math.PI/4),30],[(Math.PI),35]];
graph = new EGraph();
var elem = new PointElement("Direction", "Score");
var xscale = new LinearScale("Direction");
var yscale = new LinearScale("Score");
yscale.setMin(0);
yscale.setMax(40);
xscale.setMin(0);
xscale.setMax(1.95*Math.PI);
xscale.setIncrement(Math.PI/8);
var rect = new RectCoord(xscale,yscale);
var polar = new PolarCoord(rect);
polar.rotate(45)
polar.setType(PolarCoord.THETA);
graph.setCoordinate(polar);
graph.addElement(elem);
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See Also
DataSet, to use a Data Block or query as the dataset source.

Coordinate.SETEXTENT(MINX, MINY, MAXX, MAXY)

Sets the extent of a geographical coordinate system (for a map-type chart)
to the specified latitudes and longitudes.

Parameter
minX the minimum longitude
minY the minimum latitude
maxX the maximum longitude
maxY the maximum latitude

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
Create a map of the United States. (See Creating a Map Chart in Advanced
Dashboard Design or Binding a Chart to Geographical Data (Map) in
Advanced Report Design for more information.) To restrict the range of the
map to the region between Washington and Boston, first obtain the latitude
and longitude of these cities:

• Washington: 38.895111 latitude, -77.036667 longitude

• Boston: 42.358056 latitude, -71.063611 longitude

Add the following chart script to limit the extent of the map to this range.
Note that the x-axis corresponds to longitude, and the y-axis corresponds to
latitude.

graph.getCoordinate().setExtent(-77.036667, 38.895111,-
71.063611, 42.358056)
graph.getElement(0).setInPlot(false)
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The setInPlot(false) function allows the chart to display only the
specified portion of the map. Otherwise, the chart will force the entire map
to display, regardless of the specified extent. See
GraphElement.setInPlot(boolean) for more information.

Coordinate.SETFULLMAP(BOOLEAN)

Specifies, when ‘true’, that the entire map should be displayed within the
element’s borders. Otherwise, only regions of the map representing data are
displayed, and other regions are cropped.

Parameter
boolean true: fit entire map in chart borders 
(default)

false: fit only data regions in chart borders

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Viewsheet)
Create the map described in the example for drillMembers in Advanced
Dashboard Scripting. To zoom the map to display only the selected
regions, add the following script to the Chart component:

var zoomed = SelectionTree1.selectedObjects.length > 0;
graph.getCoordinate().setFullMap(!zoomed);
graph.getElement(0).setInPlot(!zoomed);
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The setInPlot(false) function allows the chart to display only the
specified portion of the map. Otherwise, the chart will force the entire map
to display regardless of the setFullMap setting. See
GraphElement.setInPlot(boolean) for more information.

Example (Report)
Create a report, as shown below, containing a US map based on the sample
‘Order Model’ data model. (See Binding a Chart to Geographical Data
(Map) in Advanced Report Design for more information on how to create a
map.)

Add a parameterized condition to the map. To do this, follow the steps
below:

1. Right-click on the map, and select ‘Condition’ from the context
menu. This opens the ‘Condition’ dialog box.
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2. Use the menus to enter the following parameterized condition.
Make sure to select the ‘Variable’ option from the right-side pop-up
menu, and enable the ‘Use Selection List’ option.

3. Press ‘Append’ to add the condition, and then press ‘OK’.

4. Right-click on the map and select ‘Script’ from the context menu to
open the Script Editor. Add the following script:

graph.getCoordinate().setFullMap(false);
graph.getElement(0).setInPlot(false);

The setInPlot(false) function allows the chart to display only the
specified portion of the map. Otherwise, the chart will force the
entire map to display regardless of the setFullMap setting. See
GraphElement.setInPlot(boolean) for more information.

5. Press ‘Save and Close’ to close the Script Editor.

6. Preview the report and select a set of nearby states when prompted
for the ‘States’ parameter.

Observe that the resulting map is cropped to display only data from the
selected geographical regions.
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Coordinate.TRANSPOSE()

Interchanges the axes. For example, in a rectangular coordinate system, the
X-axis becomes the Y-axis, and the Y-axis becomes the X-axis.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var sscale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
var coord = new RectCoord(sscale,qscale);
coord.transpose()
graph.setCoordinate(coord);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.6.2 PolarCoord 

The PolarCoord object contains polar coordinates against which data can
be represented. To create a PolarCoord object, call the PolarCoord
constructor:

var polar = new PolarCoord(rect);

You can pass a RectCoord object to the constructor (e.g., ‘rect’), or specify
this later using the PolarCoord.setCoordinate(coord) property.
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["CA",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("Quantity");
var yscale = new LinearScale("Quantity");
var rect = new RectCoord(null, yscale);
var polar = new PolarCoord(rect);
var frame = new CategoricalColorFrame();
var range = new StackRange();
polar.setType(PolarCoord.THETA);
frame.setField("State");
elem.setColorFrame(frame);
elem.setCollisionModifier(GraphElement.MOVE_STACK);
yscale.setScaleRange(range);
var spec = new AxisSpec();
spec.setLabelVisible(false);
spec.setTickVisible(false);
spec.setLineVisible(false);
yscale.setAxisSpec(spec);
graph.setCoordinate(polar);
graph.addElement(elem);

Full Name
inetsoft.graph.coord.PolarCoord

PolarCoord: setCoordinate, setType

Inherits from
Coordinate: reflect, rotate, setExtent, transpose

See Also
DataSet, to use a Data Block or query as the dataset source.
Polar Coordinates, for a walkthrough of polar coordinates.

PolarCoord.SETTYPE(VALUE)

Specifies the type of polar transformation.

Parameter
value PolarCoord.THETA (use only angle)

PolarCoord.THETA_RHO (use angle and radius)
PolarCoord.RHO (use only radius)
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PolarCoord.PLUS (angle & radius, with hole)

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["CA",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("Quantity");
var yscale = new LinearScale("Quantity");
var rect = new RectCoord(null, yscale);
var polar = new PolarCoord(rect);
var frame = new CategoricalColorFrame();
var range = new StackRange();
polar.setType(PolarCoord.THETA);
frame.setField("State");
elem.setColorFrame(frame);
elem.setCollisionModifier(GraphElement.MOVE_STACK);
yscale.setScaleRange(range);
var spec = new AxisSpec();
spec.setLabelVisible(false);
spec.setTickVisible(false);
spec.setLineVisible(false);
yscale.setAxisSpec(spec);
graph.setCoordinate(polar);
graph.addElement(elem);

Inherits from
Coordinate: reflect, rotate, setExtent, transpose

See Also
DataSet, to use a Data Block or query as the dataset source.

PolarCoord.SETCOORDINATE(COORD)

Specifies the rectangular coordinates on which the polar coordinates should
be based.

Parameter
coord a RectCoord object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.
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Example (Report or Viewsheet)
dataset = [["Direction", "Score"], [(Math.PI/2),20], 
[(Math.PI/4),30], [(Math.PI),35]];
graph = new EGraph();
var elem = new PointElement("Direction", "Score");
var xscale = new LinearScale("Direction");
var yscale = new LinearScale("Score");
yscale.setMin(0);
yscale.setMax(40);
xscale.setMin(0);
xscale.setMax(1.95*Math.PI);
xscale.setIncrement(Math.PI/8);
var rect = new RectCoord(xscale,yscale);
var polar = new PolarCoord();
polar.setCoordinate(rect);
graph.setCoordinate(polar);
graph.addElement(elem);

Inherits from
Coordinate: reflect, rotate, setExtent, transpose

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.6.3 RectCoord

The RectCoord object contains rectangular coordinates against which data
can be represented. To create a RectCoord object, pass a pair of Scale
objects to the RectCoord constructor:

var rect = new RectCoord(xscale,yscale);

You can pass a set of Scale objects (e.g., ‘xscale’, ‘yscale’, etc.) to the
constructor, or specify this later using the RectCoord.setXScale(scale) and
RectCoord.setYScale(scale) properties.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var sscale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
var coord = new RectCoord(sscale,qscale);
graph.setCoordinate(coord);
graph.addElement(elem);

Full Name
inetsoft.graph.coord.RectCoord

RectCoord: setXScale, setYScale, setYScale2
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Inherits from
Coordinate: reflect, rotate, setExtent, transpose

See Also
DataSet, to use a Data Block or query as the dataset source.
Rectangular Coordinates, for a walkthrough of rectangular coordinates.

RectCoord.SETXSCALE(SCALE)

Specifies the scale for the X-axis. This can also be specified as an argument
to the constructor.

Type
scale a Scale object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var sscale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
var coord = new RectCoord();
coord.setXScale(sscale);
coord.setYScale(qscale);
graph.setCoordinate(coord);
graph.addElement(elem);

Inherits from
Coordinate: reflect, rotate, setExtent, transpose

See Also
DataSet, to use a Data Block or query as the dataset source.

RectCoord.SETYSCALE(SCALE)

Specifies the scale for the Y-axis. This can also be specified as an argument
to the constructor.

Type
scale a Scale object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
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var sscale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
var coord = new RectCoord();
coord.setXScale(sscale);
coord.setYScale(qscale);
graph.setCoordinate(coord);
graph.addElement(elem);

Inherits from
Coordinate: reflect, rotate, setExtent, transpose

See Also
DataSet, to use a Data Block or query as the dataset source.

RectCoord.SETYSCALE2(SCALE)

Specifies the scale for the secondary (right-side) Y-axis. 

Type
scale a Scale object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity","Total"], ["NJ",200,10000], 
["NY",300,8000]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var elem2 = new PointElement("State", "Total");
//elem2.setColorFrame(new 
StaticColorFrame(java.awt.Color.red));
var cframe = new CategoricalColorFrame();
cframe.init("Quantity", "Total");
elem.setColorFrame(cframe);
elem2.setColorFrame(cframe);
var sscale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
var qscale2 = new LinearScale("Total");
var coord = new RectCoord();
coord.setXScale(sscale);
coord.setYScale(qscale);
coord.setYScale2(qscale2);
graph.setCoordinate(coord);
graph.addElement(elem);
graph.addElement(elem2);
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Inherits from
Coordinate: reflect, rotate, setExtent, transpose

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.6.4 Rect25Coord

The Rect25Coord object is the same as the RectCoord object, but creates a
3D effect for elements. To create a Rect25Coord object, call the object
constructor:

var rect = new Rect25Coord(xscale,yscale);

You can pass a set of Scale objects (e.g., ‘xscale’, ‘yscale’, etc.) to the
constructor, or specify these later using the inherited
RectCoord.setXScale(scale) and RectCoord.setYScale(scale) properties.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var sscale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
var coord = new Rect25Coord(sscale,qscale);
graph.setCoordinate(coord);
graph.addElement(elem);

Full Name
inetsoft.graph.coord.Rect25Coord

Inherits from
RectCoord: setXScale, setYScale, setYScale2
Coordinate: reflect, rotate, setExtent, transpose

See Also
DataSet, to use a Data Block or query as the dataset source.
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CR.6.5 ParallelCoord

The ParallelCoord object contains parallel coordinates against which data
can be represented. To create a ParallelCoord object, pass a set of Scale
objects to the ParallelCoord constructor:

var rect = new ParallelCoord(scale1,scale2,...);

You can pass a set of Scale objects (e.g., ‘scale1’, ‘scale2’, etc.) to the
constructor, or specify this later using the ParallelCoord.setScales(scales)
property.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = 
[["Quantity","Total","Returns"],[200,800,10],[175,1000,15],
[50,300,20]];
graph = new EGraph();
var elem = new LineElement();
var qscale = new LinearScale("Quantity");
var tscale = new LinearScale("Total");
var rscale = new LinearScale("Returns");
var coord = new ParallelCoord(qscale,tscale,rscale);
elem.addDim("Quantity");
elem.addDim("Total");
elem.addDim("Returns");
graph.addElement(elem);
graph.setCoordinate(coord);

Full Name
inetsoft.graph.coord.ParallelCoord

ParallelCoord: setScales

Inherits from
Coordinate: reflect, rotate, setExtent, transpose

See Also
DataSet, to use a Data Block or query as the dataset source.
Appendix SC.12.2, Polar Coordinates, for a walkthrough example of
parallel coordinates.
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ParallelCoord.SETSCALES(SCALES)

Specifies the set of parallel scales to use. These can also be specified as
arguments to the constructor.

Parameter
scales Array of Scale objects

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = 
[["Quantity","Total","Returns"],[200,800,10],[175,1000,15],
[50,300,20]];
graph = new EGraph();
var elem = new LineElement();
var qscale = new LinearScale("Quantity");
var tscale = new LinearScale("Total");
var rscale = new LinearScale("Returns");
var coord = new ParallelCoord();
coord.setScales([qscale,tscale,rscale]);
elem.addDim("Quantity");
elem.addDim("Total");
elem.addDim("Returns");
graph.addElement(elem);
graph.setCoordinate(coord);

Inherits from
Coordinate: reflect, rotate, setExtent, transpose

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.6.6 TriCoord

The TriCoord object contains triangular coordinates against which data can
be represented. Although the triangular coordinate system contains three
axes, it represents only two independent dimensions, and the three
measures must sum to the maximum value of the scale. This makes the
triangular coordinates effective for representing proportions of a fixed total.

Note: The three measures must sum to the maximum value of the
scale.
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To create a TriCoord object, call the TriCoord constructor:

var coord = new TriCoord(qscale);

You can pass a Scale object (e.g., ‘qscale’) to the constructor, or specify
this later using the TriCoord.setScale(scale) property.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = 
[["Quantity","Total","Returns"],[50,50,100],[75,100,25],[10
0,100,0]];
graph = new EGraph();
var elem = new PointElement();
var qscale = new LinearScale("Quantity");
qscale.setMin(0);
qscale.setMax(200);
var spec = new AxisSpec();
spec.setGridStyle(Chart.DOT_LINE);
qscale.setAxisSpec(spec);
var coord = new TriCoord(qscale);
elem.addDim("Quantity");
elem.addDim("Total");
elem.addVar("Returns");
graph.addElement(elem);
graph.setScale("Quantity", qscale);
graph.setScale("Total", qscale);
graph.setScale("Returns", qscale);
graph.setCoordinate(coord);

The first dimension (‘Quantity’) is represented on the bottom axis, the
second dimension (‘Total’) on the right axis, and the third dimension
(‘Returns’) on the left axis. Note that the third dimension must be added
using addVar() rather than addDim().

Full Name
inetsoft.graph.coord.TriCoord

TriCoord: setScale

Inherits from
Coordinate: reflect, rotate, setExtent, transpose
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See Also
DataSet, to use a Data Block or query as the dataset source.

TriCoord.SETSCALE(SCALE)

Specifies the scale to use for all three axes. This can also be specified as an
argument to the constructor.

Parameter
scale a Scale object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = 
[["Quantity","Total","Returns"],[50,50,100],[75,100,25],[10
0,100,0]];
graph = new EGraph();
var elem = new PointElement();
var qscale = new LinearScale("Quantity");
qscale.setMin(0);
qscale.setMax(200);
var spec = new AxisSpec();
spec.setGridStyle(Chart.DOT_LINE);
spec.setGridColor(java.awt.Color.red);
qscale.setAxisSpec(spec);
var coord = new TriCoord();
coord.setScale(qscale);
elem.addDim("Quantity");
elem.addDim("Total");
elem.addVar("Returns");
graph.addElement(elem);
graph.setScale("Quantity", qscale);
graph.setScale("Total", qscale);
graph.setScale("Returns", qscale);
graph.setCoordinate(coord);

Inherits from
Coordinate: reflect, rotate, setExtent, transpose

See Also
DataSet, to use a Data Block or query as the dataset source.
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CR.6.7 FacetCoord

The FacetCoord object contains a set of inner and outer coordinates on
which multidimensional data can be represented as nested charts. To create
a FacetCoord object, call the FacetCoord constructor:

var rect = new FacetCoord(outerCoord,innerCoord);

You can pass a pair of RectCoord objects (e.g., ‘outerCoord’, ‘innerCoord’,
etc.) to the constructor, or specify these later using the
FacetCoord.setInnerCoordinates(coord) and
FacetCoord.setOuterCoordinate(coord) properties.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "City", "Product", "Quantity"],["NJ", 
"Piscataway", "P1", 200],["NJ", "Edison", "P2", 100],["NY", 
"NYC", "P1", 300]];
graph = new EGraph();
var elem = new IntervalElement("City", "Quantity");
var state = new CategoricalScale("State");
var city = new CategoricalScale("City");
var product = new CategoricalScale("Product");
var quantity = new LinearScale("Quantity");
var inner = new RectCoord(city, quantity);
var outer = new RectCoord(state, product);
var coord = new FacetCoord(outer,inner);
graph.setCoordinate(coord);
graph.addElement(elem);

Full Name
inetsoft.graph.coord.FacetCoord

FacetCoord: setInnerCoordinates, setOuterCoordinate

Inherits from
Coordinate: reflect, rotate, setExtent, transpose

See Also
DataSet, to use a Data Block or query as the dataset source.
Appendix SC.12.4, Facet Coordinates, for a walkthrough of facet
coordinates.
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FacetCoord.SETINNERCOORDINATES(COORD)

Specifies a RectCoord object, or array of RectCoord objects, to use for the
inner coordinates of the facet graph. If an array is specified, each inner
coordinate set is plotted independently. The ‘innerCoordinates’ property
can also be specified as an argument to the constructor.

Parameter
coord Array of RectCoord objects

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "City", "Product", "Quantity"],["NJ", 
"Piscataway", "P1", 200],["NJ", "Edison", "P2", 100],["NY", 
"NYC", "P1", 300]];
graph = new EGraph();
var elem = new IntervalElement("City", "Quantity");
var state = new CategoricalScale("State");
var city = new CategoricalScale("City");
var product = new CategoricalScale("Product");
var quantity = new LinearScale("Quantity");
var inner = new RectCoord(city, quantity);
var outer = new RectCoord(state, product);
var coord = new FacetCoord();
coord.setInnerCoordinates([inner]);
coord.setOuterCoordinate(outer);
graph.setCoordinate(coord);
graph.addElement(elem);

Inherits from
Coordinate: reflect, rotate, setExtent, transpose

See Also
DataSet, to use a Data Block or query as the dataset source.

FacetCoord.SETOUTERCOORDINATE(COORD)

Specifies the rectangular coordinate set to use for the outer coordinates of
the facet graph. The RectCoord object used for outer coordinates generally
has categorical scales on both axes. The ‘outerCoordinate’ can also be
specified as an argument to the constructor.
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Parameter
coord a RectCoord object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "City", "Product", "Quantity"],["NJ", 
"Piscataway", "P1", 200],["NJ", "Edison", "P2", 100],["NY", 
"NYC", "P1", 300]];
graph = new EGraph();
var elem = new IntervalElement("City", "Quantity");
var state = new CategoricalScale("State");
var city = new CategoricalScale("City");
var product = new CategoricalScale("Product");
var quantity = new LinearScale("Quantity");
var inner = new RectCoord(city, quantity);
var outer = new RectCoord(state, product);
var coord = new FacetCoord();
coord.setInnerCoordinates([inner]);
coord.setOuterCoordinate(outer);
graph.setCoordinate(coord);
graph.addElement(elem);

Inherits from
Coordinate: reflect, rotate, setExtent, transpose

See Also
DataSet, to use a Data Block or query as the dataset source.

FacetCoord.SETVERTICAL(BOOLEAN)

Specifies whether the inner coordinates are arranged vertically or
horizontally.

Parameter
boolean true: stack vertically (default)

false: stack horizontally

Inherits from
Coordinate: reflect, rotate, setExtent, transpose

CR.6.8 Scale 

The Scale object contains a scale defining the measurement of a dimension. 
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Full Name
inetsoft.graph.scale.Scale

Scale: init, setAxisSpec, setFields, setScaleOption

Created by
LinearScale
LogScale
PowerScale
TimeScale
CategoricalScale

Scale.INIT(DATASET)

Forces the immediate computation of the automatic scale attributes. The
init() method is only required if you need to access automatically-
computed scale attributes within your chart script. These attributes are not
available within a script until the scale is initialized via the init() method. 

Parameter
dataset The Chart dataset attribute

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var qscale = new LinearScale("Quantity");
var elem = new IntervalElement("State", "Quantity")
qscale.init(dataset)
var defaultMax = qscale.getMax();
qscale.setMax(defaultMax + defaultMax/2);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

Scale.SETAXISSPEC(SPEC)

Specifies the axis properties for the scale.

Parameter
spec AxisSpec



COMMON FUNCTION REFERENCE

1244 of 1397

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var qscale = new LinearScale("Quantity");
var elem = new IntervalElement("State", "Quantity")
var spec = new AxisSpec();
spec.setLineColor(java.awt.Color(0xff0000));
qscale.setAxisSpec(spec);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

Scale.SETDATAFIELDS(ARR)

Specifies the fields to use for initializing the scale; i.e., determining the
maximum and minimum values. If left unspecified, the values in the
Scale.setFields(field) property are used for this purpose.

Parameter
arr Array of Strings

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity","Total"], ["NJ",100,0], 
["NY",1500,30000]];
graph = new EGraph();
var qscale = new LogScale();
var elem = new IntervalElement("State", "Quantity");
qscale.setDataFields(["Total"]);
graph.addElement(elem)
graph.setScale("Quantity", qscale);

See Also
DataSet, to use a Data Block or query as the dataset source.
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Scale.SETFIELDS(FIELD)

Specifies the fields to which the scale should be applied.

Parameter
field a String containing a column name

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"],["NJ",100],["NY",4000]];
graph = new EGraph();
var qscale = new LogScale();
var elem = new IntervalElement("State", "Quantity");
qscale.setFields(["Quantity"]);
var coord = new RectCoord(new CategoricalScale("State"), 
qscale)
graph.setCoordinate(coord);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

Scale.SETSCALEOPTION(VALUE)

Specifies a scaling option for the default scaling. The Scale.TICKS and
Scale.ZERO options determine the maximum and minimum values that are
used to calculate the scale range. 

The Scale.TICKS option uses the maximum and minimum tick values (i.e.,
rounded numbers) rather than the maximum and minimum data values.
The Scale.ZERO option uses zero as the minimum rather than the minimum
data value (if positive). To combine multiple options, use the pipe (“or”)
operator:

qscale.setScaleOption(Scale.ZERO | Scale.TICKS);

Parameter
value Scale.RAW (no modification)

Scale.NO_NULL (remove NULL-data gaps in scale)
Scale.TICKS (use ticks in scale range calculation)
Scale.ZERO (use zero in scale range)

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
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var sscale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
var coord = new RectCoord(sscale,qscale);
qscale.setScaleOption(Scale.ZERO);
graph.setCoordinate(coord);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

Scale.SETSHAREDRANGE(BOOLEAN)

For a FacetCoord, specifies whether the same scale range should be used
across all sub-graphs in a facet, or whether a sub-graph’s scaling should be
shared only with sub-graphs in the same row (for Y-axis scaling) or same
column (for X-axis scaling).

Parameter
value true share scaling across all sub-graphs

false share scaling by row and column

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "City", "Product", "Quantity"],["NJ", 
"Piscataway", "P1", 200],["NJ", "Edison", "P2", 100],["NY", 
"NYC", "P1", 300]];
graph = new EGraph();
var elem = new IntervalElement("City", "Quantity");
var state = new CategoricalScale("State");
var city = new CategoricalScale("City");
var product = new CategoricalScale("Product");
var quantity = new LinearScale("Quantity");
quantity.setSharedRange(false)
var inner = new RectCoord(city, quantity);
var outer = new RectCoord(state, product);
var coord = new FacetCoord(outer,inner);
graph.setCoordinate(coord);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.6.9 LinearScale 

The LinearScale object contains a linear scale, i.e., a scale that linearly
maps numerical values to physical attributes. To create a LinearScale
object, call the LinearScale constructor.

var qscale = new LinearScale('Last Year','This Year');
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You can pass the names of the fields (e.g., ‘Last Year’, ‘This Year’) for
which the scale should be generated to the constructor, or specify these
later using the inherited Scale.setFields(field) property.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var qscale = new LinearScale();
qscale.setFields(["Quantity"]);
var elem = new IntervalElement("State", "Quantity")
graph.setScale("Quantity", qscale);
graph.addElement(elem);

Full Name
inetsoft.graph.scale.LinearScale

Inherits from
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

LinearScale: setIncrement, setMax, setMin, setMinorIncrement, setReversed,
setScaleRange

LinearScale.SETINCREMENT(VALUE)

Specifies the interval between values on the scale. When the scale is
applied to an axis, this is the interval between values displayed on the axis.

Parameter
value Number specifying interval between values

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var qscale = new LinearScale("Quantity");
var elem = new IntervalElement("State", "Quantity")
qscale.setIncrement(15);
graph.setScale("Quantity", qscale);
graph.addElement(elem);
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Inherits from
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

LinearScale.SETMAX(VALUE)

Specifies the maximum value of the scale. 

Parameter
value Number specifying the maximum scale value

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var qscale = new LinearScale("Quantity");
var elem = new IntervalElement("State", "Quantity")
qscale.setMin(150);
qscale.setMax(450);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

If you set the maximum scale value smaller than the largest data value (so
as to crop the data), you should also set elem.setInPlot(false).
Otherwise, the chart will force the data to appear in its entirety, resulting in
a partially unlabeled axis.
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Inherits from
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

LinearScale.SETMIN(VALUE)

Specifies the minimum value of the scale.

Parameter
value Number specifying the minimum scale value

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var qscale = new LinearScale("Quantity");
var elem = new IntervalElement("State", "Quantity")
qscale.setMin(150);
qscale.setMax(450);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

Inherits from
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

LinearScale.SETMINORINCREMENT(VALUE)

Specifies the minor interval between values on the scale. When the scale is
applied to an axis, this is the interval between tick marks displayed on the
axis.

Parameter
value Number specifying interval between ticks
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var qscale = new LinearScale("Quantity");
qscale.setIncrement(50);
var elem = new IntervalElement("State", "Quantity")
qscale.setMinorIncrement(10);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

Inherits from
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

LinearScale.SETREVERSED(BOOLEAN)

Specifies the orientation of the scale, either with value increasing from
bottom to top (default), or from top to bottom.

Parameter
boolean true: value increases from top to bottom

false: value increases from bottom to top

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var qscale = new LinearScale("Quantity");
var elem = new IntervalElement("State", "Quantity")
qscale.setMin(150);
qscale.setMax(450);

// Place setReversed() after setMin() and setMax()
qscale.setReversed(true);
graph.setScale("Quantity", qscale);
graph.addElement(elem);
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Inherits from
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

LinearScale.SETSCALERANGE(RANGE)

Specifies the calculation strategy for finding scale range.

Parameter
range a ScaleRange object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var qscale = new LinearScale("Quantity");
var elem = new IntervalElement("State", "Quantity")
qscale.setScaleRange(new StackRange()); // adds 200+300
graph.setScale("Quantity", qscale);
graph.addElement(elem);

Inherits from
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.



COMMON FUNCTION REFERENCE

1252 of 1397

CR.6.10 LogScale

The LogScale object contains a logarithmic scale, i.e., a scale that
logarithmically maps numerical data values to physical attributes (axis
position, element size, etc.). To create a LogScale object, call the LogScale
constructor.

var qscale = new LogScale('Last Year', 'This Year');

You can pass the names of the fields (e.g., ‘Last Year’, ‘This Year’) for
which the scale should be generated to the constructor, or specify these
later using the inherited Scale.setFields(field) property.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",2000]];
graph = new EGraph();
var qscale = new LogScale();
qscale.setFields(["Quantity"]);
var elem = new IntervalElement("State", "Quantity")
graph.setScale("Quantity", qscale);
graph.addElement(elem);

Full Name
inetsoft.graph.scale.LogScale

LogScale: setBase

Inherits from
LinearScale: setIncrement, setMax, setMin, setMinorIncrement,
setReversed, setScaleRange
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

LogScale.SETBASE(VALUE)

Specifies the base of the logarithmic scale. The default is 10.
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Parameter
value a number specifying the logarithm base

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",12], ["NY",450]];
graph = new EGraph();
var qscale = new LogScale("Quantity");
var elem = new IntervalElement("State", "Quantity")
qscale.setBase(2);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

Inherits from
LinearScale: setIncrement, setMax, setMin, setMinorIncrement,
setReversed, setScaleRange
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.6.11 PowerScale 

The PowerScale object contains a scale that maps values to physical
attributes by raising them to a specified exponent. To create a PowerScale
object, call the PowerScale constructor with the fields for which the scale
should be generated.

var qscale = new PowerScale('Last Year', 'This Year');

You can pass the names of the fields (e.g., ‘Last Year’, ‘This Year’) for
which the scale should be generated to the constructor, or specify these
later using the inherited Scale.setFields(field) property.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.



COMMON FUNCTION REFERENCE

1254 of 1397

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var qscale = new PowerScale();
qscale.setFields(["Quantity"])
var elem = new IntervalElement("State", "Quantity")
qscale.setExponent(0.5);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

Full Name
inetsoft.graph.scale.PowerScale

PowerScale: setExponent

Inherits from
LinearScale: setIncrement, setMax, setMin, setMinorIncrement,
setReversed, setScaleRange
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

PowerScale.SETEXPONENT(VALUE)

Specifies the exponent of the scaling. The axis position of value x is given
by x^exponent.

Parameter
value a number specifying the scaling exponent

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var qscale = new PowerScale();
qscale.setFields(["Quantity"])
var elem = new IntervalElement("State", "Quantity")
qscale.setExponent(0.5);
graph.setScale("Quantity", qscale);
graph.addElement(elem);
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Inherits from
LinearScale: setIncrement, setMax, setMin, setMinorIncrement,
setReversed, setScaleRange
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.6.12 TimeScale

The TimeScale object contains a time scale, i.e., a scale that linearly maps
date and time data values to physical attributes. To create a TimeScale
object, call the TimeScale constructor with the fields for which the scale
should be generated.

var qscale = new TimeScale('Date');

You can pass the names of the fields (e.g., ‘Date’) for which the scale
should be generated to the constructor, or specify these later using the
inherited Scale.setFields(field) property.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
var date1 = new Date();
var date2 = new Date();
var maxDate = new Date();
date1.setFullYear(2008,0,1);
date2.setFullYear(2009,0,1);
maxDate.setFullYear(2011,0,1);
dataset = [["Date", "Quantity"], [date1,200], [date2,300]];
graph = new EGraph();
var elem = new IntervalElement("Date","Quantity")
var tscale = new TimeScale();
tscale.setFields(["Date"]);
tscale.setMax(maxDate);
graph.setScale("Date", tscale);
graph.addElement(elem);
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Full Name
inetsoft.graph.scale.TimeScale

TimeScale: setIncrement, setMax, setMin, setType

Inherits from
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

TimeScale.SETINCREMENT(VALUE)

Specifies an integer increment at which to place labels on the TimeScale
axis. The integer value designates the increment in terms of the prevailing
time unit, e.g., Weeks, Months, Quarters, etc.

Parameter
value an integer

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
graph.getScale("Order Date").setIncrement(12)

Inherits from
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.
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TimeScale.SETMAX(VALUE)

Specifies the latest date on the scale.

Parameter
value a Date object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
var date1 = new Date();
var date2 = new Date();
var maxDate = new Date();
date1.setFullYear(2008,0,1);
date2.setFullYear(2009,0,1);
maxDate.setFullYear(2011,0,1);
dataset = [["Date", "Quantity"], [date1,200], [date2,300]];
graph = new EGraph();
var elem = new IntervalElement("Date","Quantity")
var tscale = new TimeScale();
tscale.setFields(["Date"]);
tscale.setMax(maxDate);
graph.setScale("Date", tscale);
graph.addElement(elem);

If you set the maximum scale value smaller than the largest data value (so
as to crop the data), you should also set elem.setInPlot(false).
Otherwise, the chart will force the data to appear in its entirety, resulting in
a partially unlabeled axis.

Inherits from
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

TimeScale.SETMIN(VALUE)

Specifies the earliest date on the scale.

Parameter
value a Date object

https://developer.mozilla.org/en/Core_JavaScript_1.5_Reference/Global_Objects/Date
https://developer.mozilla.org/en/Core_JavaScript_1.5_Reference/Global_Objects/Date
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
var date1 = new Date();
var date2 = new Date();
var minDate = new Date();
date1.setFullYear(2008,0,1);
date2.setFullYear(2009,0,1);
minDate.setFullYear(2005,0,1);
dataset = [["Date", "Quantity"], [date1,200], [date2,300]];
graph = new EGraph();
var elem = new IntervalElement("Date","Quantity")
var tscale = new TimeScale("Date");
tscale.setMin(minDate);
graph.setScale("Date", tscale);
graph.addElement(elem);

Inherits from
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

TimeScale.SETTYPE(TYPE)

Specifies the placement of tick marks on a TimeScale axis. (This is
analogous to the increment setting for a LinearScale axis.)

Parameter
type an axis increment specifier:

TimeScale.DAY
TimeScale.HOUR
TimeScale.MINUTE
TimeScale.MONTH
TimeScale.QUARTER
TimeScale.SECOND
TimeScale.WEEK
TimeScale.YEAR

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.
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Example (Report or Viewsheet)
dataset = [["Date", "Quantity"], [new Date(2008,8,1),200], 
[new Date(2008,10,1),400], [new Date(2009,0,1),300], [new 
Date(2009,1,1),900]];
graph = new EGraph();
var elem = new IntervalElement("Date","Quantity")
var tscale = new TimeScale("Date");
tscale.setType(TimeScale.YEAR)
graph.setScale("Date", tscale);
graph.addElement(elem);

Inherits from
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.6.13 CategoricalScale 

The CategoricalScale object contains a nominal scale, i.e., a scale that
logically maps nominal values to physical attributes. To create a
CategoricalScale object, call the CategoricalScale constructor with the
fields for which the scale should be generated.

var qscale = new CategoricalScale('State');

You can pass the names of the fields (e.g., ‘State’) for which the scale
should be generated to the constructor, or specify these later using the
inherited Scale.setFields(field) property.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var sscale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
var coord = new RectCoord(sscale, qscale);
coord.transpose();
graph.setCoordinate(coord);
graph.addElement(elem);
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Full Name
inetsoft.graph.scale.CategoricalScale

CategoricalScale: setValues, setFill

Inherits from
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CategoricalScale.SETFILL(BOOLEAN)

Specifies that scale boundaries should be set equal to the extreme data
values (leaving no gap at the axis edges).

Parameter
Boolean true, to fill axis to edges

false, to leave gap at edges

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300], 
["CT", 50], ["PA", 175]];
graph = new EGraph();
var elem = new AreaElement("State", "Quantity");
var sscale = new CategoricalScale("State");
sscale.setFill(true)
var qscale = new LinearScale("Quantity");
var coord = new RectCoord(sscale, qscale);
graph.setCoordinate(coord);
graph.addElement(elem);

Inherits from
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.



COMMON FUNCTION REFERENCE

1261 of 1397

CategoricalScale.SETVALUES(VALUE)

Specifies the categorical values in the scale, and their order.

Parameter
value Array of String

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var sscale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
var coord = new RectCoord(sscale, qscale);
sscale.setValues(["NY","NJ"]);
coord.transpose();
graph.setCoordinate(coord);
graph.addElement(elem);

Inherits from
Scale: init, setAxisSpec, setFields, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.6.14 ScaleRange 

The ScaleRange object contains the calculation strategy for finding the
scale range.

Full Name
inetsoft.graph.scale.ScaleRange

ScaleRange: setAbsoluteValue

Created by
StackRange
LinearRange
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ScaleRange.SETABSOLUTEVALUE(BOOLEAN)

Specifies whether negative quantities should be represented against the
positive axis or against the negative axis (default).

Parameter
boolean true: show neg values on pos axis

false: show neg values on neg axis

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",-300]];
graph = new EGraph();
var qscale = new LinearScale("Quantity");
var elem = new IntervalElement("State", "Quantity");
var frame = new DefaultTextFrame();
frame.setField("Quantity")
elem.setTextFrame(frame)
var range = new LinearRange();
range.setAbsoluteValue(true);
qscale.setScaleRange(range);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.6.15 StackRange

The StackRange object computes the range by “stacking” the data values.
To create a StackRange object, call the StackRange constructor.

var range = new StackRange();

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var qscale = new LinearScale("Quantity");
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var elem = new IntervalElement("State", "Quantity")
qscale.setScaleRange(new StackRange()); // adds 200+300
graph.setScale("Quantity", qscale);
graph.addElement(elem);

Full Name
inetsoft.graph.scale.StackRange

StackRange: setGroupField, setStackNegative

Inherits from
ScaleRange: setAbsoluteValue

See Also
DataSet, to use a Data Block or query as the dataset source.

StackRange.SETGROUPFIELD(VALUE)

Determines the scale range from the stacked values of largest single group,
based on the specified grouping field.

Parameter
value the field name, a String

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", 
"Quantity"],["NJ",200],["NJ",100],["NY",400],["NY",300]];
graph = new EGraph();
var qscale = new LinearScale("Quantity");
var elem = new PointElement("State", "Quantity")
range = new StackRange();
range.setGroupField("State"); // max of 200+100, 400+300
qscale.setScaleRange(range);
graph.setScale("Quantity", qscale);
graph.addElement(elem);
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Inherits from
ScaleRange: setAbsoluteValue

See Also
DataSet, to use a Data Block or query as the dataset source.

StackRange.SETSTACKNEGATIVE(BOOLEAN)

Specifies whether the negative scale range is determine by independently
stacking the negative values (default), or whether stacking is not applied to
negative values in computing the range.

Parameter
boolean true: stack negative values to get range

false: do not stack negative values

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", 
"Quantity"],["NJ",200],["NJ",100],["NY",-300],["NY",-400]];
graph = new EGraph();
var qscale = new LinearScale("Quantity");
var elem = new IntervalElement("State", "Quantity")
range = new StackRange();
range.setStackNegative(false);
qscale.setScaleRange(range);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

Inherits from
ScaleRange: setAbsoluteValue



COMMON FUNCTION REFERENCE

1265 of 1397

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.6.16 LinearRange

The LinearRange object computes the range by using the minimum and
maximum data values. To create a LinearRange object, call the
LinearRange constructor.

var range = new LinearRange();

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"],["NJ",-200],["NY",300]];
graph = new EGraph();
var qscale = new LinearScale("Quantity");
var elem = new IntervalElement("State", "Quantity")
range = new LinearRange();
qscale.setScaleRange(range);
graph.setScale("Quantity", qscale);
graph.addElement(elem);

Full Name
inetsoft.graph.scale.LinearRange

Inherits from
ScaleRange: setAbsoluteValue

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7 Chart Aesthetics

This section discusses the VisualFrame objects that can be added to chart
elements to introduce visual style. VisualFrame objects allow you to
represent additional data dimensions by using the physical attributes of
chart elements, or to apply a fixed (static) visual style.
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CR.7.1 VisualFrame

The VisualFrame object contains common properties for all aesthetic
frames.

Full Name
inetsoft.graph.aesthetic.VisualFrame

VisualFrame: setField, setLegendSpec, setScale, setScaleOption

Created by
ColorFrame
SizeFrame
ShapeFrame
TextFrame
LineFrame
TextureFrame

VisualFrame.SETFIELD(FIELD)

Specifies the field (column) associated with this frame.

Parameter
field name of the column (String)

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new BrightnessColorFrame();
frame.setField("Quantity");
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frame.setColor(java.awt.Color(0xff0000));
elem.setColorFrame(frame);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

VisualFrame.SETLEGENDSPEC(SPEC)

Specifies the formatting for the legend generated for the scale.

Parameter
spec a LegendSpec object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var frame = new LinearSizeFrame();
var spec = new LegendSpec();
spec.setBorderColor(java.awt.Color(0xff0000));
frame.setField("Quantity");
frame.setLegendSpec(spec);
elem.setSizeFrame(frame);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

VisualFrame.SETSCALE(SCALE)

Specifies the scale associated with this frame.

Parameter
scale a Scale object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.
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Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new BrightnessColorFrame();
frame.setField("Quantity");
var scale = new LinearScale();
scale.setMax(325);
scale.setMin(175);
frame.setScale(scale);
frame.setColor(java.awt.Color(0xff0000));
elem.setColorFrame(frame);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

VisualFrame.SETSCALEOPTION(VALUE)

Specifies a scaling option for the default scaling. The Scale.TICKS and
Scale.ZERO options determine the maximum and minimum values that are
used to calculate the scale range. 

The Scale.TICKS option uses the maximum and minimum tick values (i.e.,
rounded numbers) rather than the maximum and minimum data values.
The Scale.ZERO option uses zero as the minimum rather than the minimum
data value (if positive). To combine multiple options, use the pipe (“or”)
operator:

frame.setScaleOption(Scale.ZERO | Scale.TICKS);

Parameter
value Scale.TICKS

Scale.ZERO

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",290]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new GradientColorFrame();
frame.setField("Quantity");
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frame.setScaleOption(Scale.TICKS);
elem.setColorFrame(frame);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.2 ColorFrame 

A ColorFrame object contains the color treatment for visual chart elements.
You can use a ColorFrame object to represent data dimensions with color
(color coding), or to apply a fixed (static) color style. 

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Chart1.bindingInfo.setColorField("Total",Chart.NUMBER);
Chart1.bindingInfo.colorFrame = new BrightnessColorFrame;
Chart1.bindingInfo.colorFrame.color = 0xFF00FF;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Viewsheet or Report)
var frame = new StaticColorFrame;
frame.color = java.awt.Color(0xFF00FF);
var elem = graph.getElement(0); // bar elements
elem.colorFrame = frame;
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Full Name
inetsoft.graph.aesthetic.ColorFrame

Created by
BrightnessColorFrame
SaturationColorFrame
BipolarColorFrame
StaticColorFrame
CircularColorFrame
GradientColorFrame
HeatColorFrame
RainbowColorFrame
CategoricalColorFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.3 BrightnessColorFrame 

The BrightnessColorFrame object contains a continuous color frame that
returns varying brightnesses of the specified color. To create a
BrightnessColorFrame object, call the BrightnessColorFrame constructor.

var frame = new BrightnessColorFrame('Quantity');

You can pass a field name to the constructor (e.g., “Quantity”), or specify
this later using the inherited VisualFrame.setField(field) property.

Full Name
inetsoft.graph.aesthetic.BrightnessColorFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.
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BrightnessColorFrame: setColor

BrightnessColorFrame.SETCOLOR(VALUE)

Specifies the color whose brightness is varied. The data values in the
associated column (specified by the inherited VisualFrame.setField(field)
property) are mapped to a spectrum of brightnesses of the specified color.

Value (Property Syntax)
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Value (Function Syntax)
value a java.awt.Color object

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Chart1.bindingInfo.setColorField("Total",Chart.NUMBER);
Chart1.bindingInfo.colorFrame = new BrightnessColorFrame;
Chart1.bindingInfo.colorFrame.color = 0xFF00FF;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Viewsheet or Report)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new BrightnessColorFrame();
frame.setField("Quantity")
frame.setColor(java.awt.Color(0xff0000));
elem.setColorFrame(frame);
graph.addElement(elem);

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.4 SaturationColorFrame

The SaturationColorFrame object contains a continuous color frame that
returns varying saturations of the specified color. To create a
SaturationColorFrame object, call the SaturationColorFrame constructor.

var frame = new SaturationColorFrame('Quantity');

You can pass a field name to the constructor (e.g., “Quantity”), or specify
this later using the inherited VisualFrame.setField(field) property.

Full Name
inetsoft.graph.aesthetic.SaturationColorFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

SaturationColorFrame: setColor

SaturationColorFrame.SETCOLOR(VALUE)

Specifies the color whose saturation is varied. The data values in the
associated column (specified by the inherited VisualFrame.setField(field)
property) are mapped to a spectrum of saturations of the specified color.

Type
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Value (Function Syntax)
value a java.awt.Color object

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html


COMMON FUNCTION REFERENCE

1273 of 1397

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a bar-type chart to the sample ‘All Sales’ query in ‘Orders’ > ‘Sample
Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script in the onLoad Handler.

Chart1.bindingInfo.setColorField("Total",Chart.NUMBER);
Chart1.bindingInfo.colorFrame = new SaturationColorFrame;
Chart1.bindingInfo.colorFrame.color = 0xFF0000;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Viewsheet or Report)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new SaturationColorFrame();
frame.setField("Quantity");
frame.setColor(java.awt.Color(0xff0000));
elem.setColorFrame(frame);
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.



COMMON FUNCTION REFERENCE

1274 of 1397

CR.7.5 BipolarColorFrame

The BipolarColorFrame object contains a continuous color frame that
returns gradations between two colors. To create a BipolarColorFrame
object, call the BipolarColorFrame constructor.

var frame = new BipolarColorFrame('Quantity');

You can pass a field name to the constructor (e.g., “Quantity”), or specify
this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a bar-type chart to the sample ‘All Sales’ query in ‘Orders’ > ‘Sample
Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script in the onLoad Handler.

Chart1.bindingInfo.setColorField("Total",Chart.NUMBER);
Chart1.bindingInfo.colorFrame = new BipolarColorFrame;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", 
"Quantity"],["NJ",200],["NY",300],["PA",50]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new BipolarColorFrame();
frame.setField("Quantity");
elem.setColorFrame(frame);
graph.addElement(elem);
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Full Name
inetsoft.graph.aesthetic.BipolarColorFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.6 StaticColorFrame 

The StaticColorFrame object contains a color frame defined by explicit
color data in the VisualFrame.setField(field) column, or by the fixed color
in StaticColorFrame.setColor(value). To create a StaticColorFrame object,
call the StaticColorFrame constructor.

var frame = new StaticColorFrame();

You can pass a color value directly to the constructor, e.g., 

var frame = new StaticColorFrame(java.awt.Color(0xFF00FF));

or specify it later using the in StaticColorFrame.setColor(value) property.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity","Color"], 
["NJ",200,0xff0000], ["NY",300,0xff00ff]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new StaticColorFrame();
frame.setField("Color");
elem.setColorFrame(frame);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.StaticColorFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

StaticColorFrame: setColor, setNegativeColor

StaticColorFrame.SETCOLOR(VALUE)

Specifies the static color to be used for positive field values. The static
color can also be passed as an input to the constructor. If the data column
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specified by the inherited VisualFrame.setField(field) property contains
(positive) numbers or colors, these data values are used instead of
StaticColorFrame.setColor(). 

Value (Property Syntax)
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Value (Function Syntax)
value a java.awt.Color object

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a bar-type chart to the sample ‘All Sales’ query in ‘Orders’ > ‘Sample
Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script in the onLoad Handler.

Chart1.bindingInfo.setColorField("Company",Chart.STRING);
Chart1.bindingInfo.colorFrame = new StaticColorFrame;
Chart1.bindingInfo.colorFrame.color = 0xFF00FF;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Viewsheet or Report)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new StaticColorFrame();
frame.setColor(java.awt.Color(0x00ff00));
elem.setColorFrame(frame);
graph.addElement(elem);

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

StaticColorFrame.SETNEGATIVECOLOR(VALUE)

Specifies the static color to be used for negative field values. If a value is
specified for StaticColorFrame.setNegativeColor(), then
StaticColorFrame.setColor() defines the color of positive values, and
StaticColorFrame.setNegativeColor() defines the color of negative values.
In this case, the inherited VisualFrame.setField(field) property is not used. 

Value (Property Syntax)
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Value (Function Syntax)
value a java.awt.Color object

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
In this example, you will set the color of negative values for a bar chart.
Follow the steps below:

1. Create a new report, and add a Chart component to the report. 

2. Click on the chart to open the Chart Editor.

3. In the Data tab of the Chart Editor, expand the ‘All Sales’ query in
‘Orders’ > ‘Sample Queries’. 

4. Drag the ‘Order Date’ field from the Data tab to the ‘X’ region. 

5. Press the ‘Edit Dimension’ button next to the ‘X’ region. Select
‘Quarter’ from the ‘Level’ menu, and press ‘Apply’.

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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6. Drag the ‘Total’ field from the Data tab to the ‘Y’ region. 

7. Press the ‘Edit Measure’ button next to the ‘Y’ region. Select
‘Change from Previous’ from the ‘Calculate’ menu, and press
‘Apply’.

8. Drag the ‘Total’ field from the Data tab to the ‘Color’ region. 

9. Press the ‘Edit Measure’ button next to the ‘Color’ region. Select
‘Change from Previous’ from the ‘Calculate’ menu, and press
‘Apply’.

10. Add the following script in the onLoad handler.

Chart1.bindingInfo.colorFrame = new StaticColorFrame;
Chart1.bindingInfo.colorFrame.color = 0x00FF00;
Chart1.bindingInfo.colorFrame.negativeColor = 0xFF0000;

Note: You can use
highlighting to achieve
the same effect with-
out script.

11. Preview the report, and observe that negative-valued bars are
displayed in the specified static color.
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Viewsheet or Report)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",-300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new StaticColorFrame();
frame.setField("Quantity");
frame.setColor(java.awt.Color(0x00ff00));
frame.setNegativeColor(java.awt.Color(0xff0000));
elem.setColorFrame(frame);
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.7 CircularColorFrame

The CircularColorFrame object contains a continuous color frame that
returns gradations from the full spectrum. To create a CircularColorFrame
object, call the CircularColorFrame constructor.

var frame = new CircularColorFrame('Quantity');

You can pass the name of a field (e.g., ‘Quantity’) to the constructor, or
specify this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a bar-type chart to the sample ‘All Sales’ query in ‘Orders’ > ‘Sample
Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setColorField("Total",Chart.NUMBER);
Chart1.bindingInfo.colorFrame = new CircularColorFrame;
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Viewsheet or Report)
dataset = [["State", 
"Quantity"],["NJ",200],["NY",300],["PA",50],["CT",100]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new CircularColorFrame();
frame.setField("Quantity");
elem.setColorFrame(frame);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.CircularColorFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.8 GradientColorFrame

The GradientColorFrame object contains a continuous color frame that
returns gradations between two colors. To create a GradientColorFrame
object, call the GradientColorFrame constructor.

var frame = new GradientColorFrame();

You can pass the name of a field (e.g., ‘Quantity’) to the constructor, or
specify this later using the inherited VisualFrame.setField(field) property.
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Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a bar-type chart to the sample ‘All Sales’ query in ‘Orders’ > ‘Sample
Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setColorField("Total",Chart.NUMBER);
Chart1.bindingInfo.colorFrame = new GradientColorFrame;
Chart1.bindingInfo.colorFrame.fromColor = 0x0000FF;
Chart1.bindingInfo.colorFrame.toColor = 0xFF00FF;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", 
"Quantity"],["NJ",200],["NY",300],["PA",50],["CT",100]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new GradientColorFrame();
frame.setField("Quantity");
elem.setColorFrame(frame);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.GradientColorFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption
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See Also
DataSet, to use a Data Block or query as the dataset source.

GradientColorFrame: setFromColor, setToColor 

GradientColorFrame.SETFROMCOLOR(VALUE)

Specifies the starting color (for lowest value) of the gradient.

Value (Property Syntax)
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Value (Function Syntax)
value a java.awt.Color object

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a bar-type chart to the sample ‘All Sales’ query in ‘Orders’ > ‘Sample
Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setColorField("Total",Chart.NUMBER);
Chart1.bindingInfo.colorFrame = new GradientColorFrame;
Chart1.bindingInfo.colorFrame.fromColor = 0x0000FF;
Chart1.bindingInfo.colorFrame.toColor = 0xFF00FF;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", 
"Quantity"],["NJ",200],["NY",300],["PA",50],["CT",100]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new GradientColorFrame();
frame.setFromColor(java.awt.Color(0x000000));
frame.setToColor(java.awt.Color(0xff0000));

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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frame.setField("Quantity");
elem.setColorFrame(frame);
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

GradientColorFrame.SETTOCOLOR(VALUE)

Specifies the ending color (for highest value) of the gradient.

Value (Property Syntax)
java.awt.Color e.g., java.awt.Color.BLUE
number (hex) e.g., 0xFF0000
string (color name) e.g., 'red'
array [r,g,b] e.g., [255,0,0]
JSON {r:#,g:#,b:#} e.g., {r:255,g:0,b:0}

Value (Function Syntax)
value a java.awt.Color object

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a bar-type chart to the sample ‘All Sales’ query in ‘Orders’ > ‘Sample
Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setColorField("Total",Chart.NUMBER);
Chart1.bindingInfo.colorFrame = new GradientColorFrame;
Chart1.bindingInfo.colorFrame.fromColor = 0x0000FF;
Chart1.bindingInfo.colorFrame.toColor = 0xFF00FF;

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html


COMMON FUNCTION REFERENCE

1284 of 1397

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", 
"Quantity"],["NJ",200],["NY",300],["PA",50],["CT",100]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new GradientColorFrame();
frame.setFromColor(java.awt.Color(0x000000));
frame.setToColor(java.awt.Color(0xff0000));
frame.setField("Quantity");
elem.setColorFrame(frame);
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.9 HeatColorFrame 

The HeatColorFrame object contains a continuous color frame that returns
varying shades of brown. To create a HeatColorFrame object, call the
HeatColorFrame constructor.

var frame = new HeatColorFrame('Quantity');

You can pass the name of a field (e.g., ‘Quantity’) to the constructor, or
specify this later using the inherited VisualFrame.setField(field) property.
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Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a bar-type chart to the sample ‘All Sales’ query in ‘Orders’ > ‘Sample
Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setColorField("Total",Chart.NUMBER);
Chart1.bindingInfo.colorFrame = new HeatColorFrame();

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", 
"Quantity"],["NJ",200],["NY",300],["PA",50],["CT",100]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new HeatColorFrame();
frame.setField("Quantity");
elem.setColorFrame(frame);
graph.addElement(elem); 

Full Name
inetsoft.graph.aesthetic.HeatColorFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.
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CR.7.10 RainbowColorFrame

The RainbowColorFrame object contains a continuous color frame that
returns colors of the rainbow. To create a RainbowColorFrame object, call
the RainbowColorFrame constructor.

var frame = new RainbowColorFrame('Quantity');

You can pass the name of a field (e.g., ‘Quantity’) to the constructor, or
specify this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a bar-type chart to the sample ‘All Sales’ query in ‘Orders’ > ‘Sample
Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setColorField("Total",Chart.NUMBER);
Chart1.bindingInfo.colorFrame = new RainbowColorFrame;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", 
"Quantity"],["NJ",200],["NY",300],["PA",50],["CT",100]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new RainbowColorFrame();
frame.setField("Quantity");
elem.setColorFrame(frame);
graph.addElement(elem); 
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Full Name
inetsoft.graph.aesthetic.RainbowColorFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.11 RGBCubeColorFrame

The RGBCubeColorFrame object contains a continuous color frame that
returns colors drawn from a range of the RGB color cube specified by two
boundary colors, [rgb1,rgb2]. To create a RGBCubeColorFrame object,
call the RGBCubeColorFrame constructor.

var frame = new RGBCubeColorFrame('Quantity',[rgb1,rgb2]);

You can pass the name of a field (e.g., ‘Quantity’) to the constructor, or
specify this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a bar-type chart to the sample ‘All Sales’ query in ‘Orders’ > ‘Sample
Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setColorField("Total",Chart.NUMBER);
Chart1.bindingInfo.colorFrame = new 
RGBCubeColorFrame([[0,0,0],[.5,1,1]]);
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = 
[["State","Quantity"],["NJ",200],["NY",300],["PA",50],["CT"
,100]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new RGBCubeColorFrame([[0,0,0],[.5,1,1]]);
frame.setField("Quantity");
elem.setColorFrame(frame);
graph.addElement(elem); 

Full Name
inetsoft.graph.aesthetic.RGBCubeColorFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.12 CategoricalColorFrame 

The CategoricalColorFrame object contains a color frame that returns a
distinct color for each unique value in the bound field. To create a
CategoricalColorFrame object, call the CategoricalColorFrame
constructor.

var frame = new CategoricalColorFrame('State');

You can pass the name of a field (e.g., ‘State’) to the constructor, or specify
this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a bar-type chart to the sample ‘All Sales’ query in ‘Orders’ > ‘Sample
Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script in the onLoad handler.
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Chart1.bindingInfo.setColorField("Employee",Chart.STRING);
Chart1.bindingInfo.colorFrame = new CategoricalColorFrame;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",20], ["NY",40]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new CategoricalColorFrame();
frame.setField("State");
elem.setColorFrame(frame);
graph.addElement(elem); 

Full Name
inetsoft.graph.aesthetic.CategoricalColorFrame

CategoricalColorFrame: getColor, init, setColor

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CategoricalColorFrame.GETCOLOR(VAL)

Returns the color assigned to the specified value.

Parameter
val a data value
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Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a bar-type chart to the sample ‘All Sales’ query in ‘Orders’ > ‘Sample
Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setColorField("Employee",Chart.STRING);
Chart1.bindingInfo.colorFrame = new CategoricalColorFrame;
Chart1.bindingInfo.colorFrame.setColor("Robert",java.awt.Co
lor.lightGray);
var robColor = 
Chart1.bindingInfo.colorFrame.getColor("Robert")
Chart1.bindingInfo.colorFrame.setColor("Sue",robColor);

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"],["NJ",200],["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity")
frame = new CategoricalColorFrame();
frame.setField("State");
frame.setColor('NJ',java.awt.Color(0xff0000));
var NJcolor = frame.getColor('NJ');
frame.setColor('NY',NJcolor);
elem.setColorFrame(frame);
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption
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See Also
DataSet, to use a Data Block or query as the dataset source.

CategoricalColorFrame.INIT(VAL[,COLOR])

Initialize the ColorFrame with a set of categorical values and (optionally)
colors.

Parameter
val array of categorical initialization values,

or name of field containing categorical values
color array of colors corresponding to value array

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example 1 (Report or Viewsheet)
dataset = [["State","Quantity","Total"], ["NJ",200,10000], 
["NY",300,8000]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var elem2 = new PointElement("State", "Total");
var cframe = new CategoricalColorFrame();
cframe.init("Quantity", "Total");
elem.setColorFrame(cframe);
elem2.setColorFrame(cframe);
var sscale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
var qscale2 = new LinearScale("Total");
var coord = new RectCoord();
coord.setXScale(sscale);
coord.setYScale(qscale);
coord.setYScale2(qscale2);
graph.setCoordinate(coord);
graph.addElement(elem);
graph.addElement(elem2);

Example 2 (Report or Viewsheet)
dataset = [["State","Quantity","Total"], ["NJ",200,10000], 
["NY",300,8000]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var elem2 = new PointElement("State", "Total");
var cframe = new CategoricalColorFrame();
cframe.init(["Quantity","Total"],[java.awt.Color(0xff00ff)
,java.awt.Color(0x00ffff)]);
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elem.setColorFrame(cframe);
elem2.setColorFrame(cframe);
var sscale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
var qscale2 = new LinearScale("Total");
var coord = new RectCoord();
coord.setXScale(sscale);
coord.setYScale(qscale);
coord.setYScale2(qscale2);
graph.setCoordinate(coord);
graph.addElement(elem);
graph.addElement(elem2);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CategoricalColorFrame.SETCOLOR(VAL,COLOR)

Assigns a color to the specified value.

Parameter
val data value
color java.awt.Color to represent data value

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a bar-type chart to the sample ‘All Sales’ query in ‘Orders’ > ‘Sample
Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total) on the Y-
axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setColorField("Employee",Chart.STRING);
Chart1.bindingInfo.colorFrame = new CategoricalColorFrame;
Chart1.bindingInfo.colorFrame.setColor("Robert",java.awt.C
olor.lightGray);
Chart1.bindingInfo.colorFrame.setColor("Sue",java.awt.Colo
r(0x222222));

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Color.html
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity")
frame = new CategoricalColorFrame();
frame.setField("State");
frame.setColor('NJ',java.awt.Color(0xff0000));
frame.setColor('NY',java.awt.Color(0xff00ff));
elem.setColorFrame(frame)
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.13 SizeFrame 

The SizeFrame object contains the size scale for visual chart objects. You
can use a SizeFrame object to represent data dimensions with size (size
coding), or to apply a fixed (static) size.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.
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Chart1.bindingInfo.setSizeField("Total",Chart.NUMBER);
Chart1.bindingInfo.sizeFrame = new LinearSizeFrame;
Chart1.bindingInfo.sizeFrame.smallest = 10;
Chart1.bindingInfo.sizeFrame.largest = 50;
Chart1.bindingInfo.sizeFrame.max = 100;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. 

var frame = new StaticSizeFrame;
frame.setSize(30);
var elem = Chart1.graph.getElement(0); // point elements
elem.setSizeFrame(frame);

Full Name
inetsoft.graph.aesthetic.SizeFrame

SizeFrame: setLargest, setMax, setSmallest 

Created by
StaticSizeFrame
LinearSizeFrame
CategoricalSizeFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption
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See Also
DataSet, to use a Data Block or query as the dataset source.

SizeFrame.SETLARGEST(VALUE)

Specifies the highest value in the range. For point and line graphs, this is
the size (in pixels) at which the largest value in the bound column is
displayed. Smaller values are scaled according to the mapping defined by
the object’s scaling method (e.g., linear for LinearSizeFrame, etc.). 

For schema and bar graphs, the value specified for the largest property is
relative to the SizeFrame.setMax(value) value. For example, if largest=50
and max=100, the largest value in the bound column is displayed at one half
of the maximum allowable size. The value of largest should be less than
the value of max.

Parameter
value Number of pixels, or relative size

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setSizeField("Total",Chart.NUMBER);
Chart1.bindingInfo.sizeFrame = new LinearSizeFrame;
Chart1.bindingInfo.sizeFrame.smallest = 10;
Chart1.bindingInfo.sizeFrame.largest = 50;
Chart1.bindingInfo.sizeFrame.max = 100;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity", "width"], ["NJ", 200, 
5],["NY", 300,10], ["PA",75,15]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity")
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elem.sizeFrame = new LinearSizeFrame();
elem.sizeFrame.setField("width");
elem.sizeFrame.setSmallest(10);
elem.sizeFrame.setLargest(50);
elem.sizeFrame.setMax(100);
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

SizeFrame.SETMAX(VALUE)

Specifies an arbitrary value representing the maximum allowable size for a
graphical element. For schema and bar graphs, the values specified for the
SizeFrame.setLargest(value) and SizeFrame.setSmallest(value) properties
are relative to the max value. For example, if smallest=50 and max=100, the
smallest value in the bound column is displayed at one half of the
maximum allowable size. For point and line graphs, the max property is
ignored. 

Parameter
value Number of pixels, or relative size

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setSizeField("Total",Chart.NUMBER);
Chart1.bindingInfo.sizeFrame = new LinearSizeFrame;
Chart1.bindingInfo.sizeFrame.smallest = 10;
Chart1.bindingInfo.sizeFrame.largest = 50;
Chart1.bindingInfo.sizeFrame.max = 100;
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity", "width"], ["NJ", 200, 
5],["NY", 300,10], ["PA",75,15]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity")
elem.sizeFrame = new LinearSizeFrame();
elem.sizeFrame.setField("width");
elem.sizeFrame.setSmallest(10);
elem.sizeFrame.setLargest(50);
elem.sizeFrame.setMax(100);
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

SizeFrame.SETSMALLEST(VALUE)

Specifies the lowest value in the range. For point and line graphs, this is the
size (in pixels) at which the smallest value in the bound column is
displayed. Larger values are scaled according to the mapping defined by
the object’s scaling method (e.g., linear for LinearSizeFrame, etc.). 

For schema and bar graphs, the value specified for the smallest property is
relative to the SizeFrame.setMax(value) value. For example, if
smallest=50 and max=100, the smallest value in the bound column is
displayed at one half of the maximum allowable size.
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Parameter
value Number of pixels, or relative size

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setSizeField("Total",Chart.NUMBER);
Chart1.bindingInfo.sizeFrame = new LinearSizeFrame;
Chart1.bindingInfo.sizeFrame.smallest = 10;
Chart1.bindingInfo.sizeFrame.largest = 50;
Chart1.bindingInfo.sizeFrame.max = 100;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity", "width"], ["NJ", 200, 
5],["NY", 300,10], ["PA",75,15]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity")
elem.sizeFrame = new LinearSizeFrame();
elem.sizeFrame.setField("width");
elem.sizeFrame.setSmallest(10);
elem.sizeFrame.setLargest(50);
elem.sizeFrame.setMax(100);
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption
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See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.14 StaticSizeFrame

The StaticSizeFrame object contains a size frame defined by explicit size
data in the VisualFrame.setField(field) column, or by the fixed size in
StaticSizeFrame.setSize(value). To create a StaticSizeFrame object, call the
StaticSizeFrame constructor.

var frame = new StaticSizeFrame(10);

You can pass a numerical size (e.g., 10) to the constructor, or specify this
later using the StaticSizeFrame.setSize(value) property. 

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setSizeField("Company",Chart.STRING);
Chart1.bindingInfo.sizeFrame = new StaticSizeFrame;
Chart1.bindingInfo.sizeFrame.setSize(30);

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity","Size"],["NJ",200,1], 
["NY",300,10]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new StaticSizeFrame();
frame.setField("Size");
elem.setSizeFrame(frame);
graph.addElement(elem);
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Full Name
inetsoft.graph.aesthetic.StaticSizeFrame

StaticSizeFrame: setSize

Inherits from
SizeFrame: setLargest, setMax, setSmallest
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

StaticSizeFrame.SETSIZE(VALUE)

Specifies the static size for graphical elements. For point and line graphs,
this is the size (in pixels) of the elements. For schema and bar graphs, the
value specified for the size property is relative to the
SizeFrame.setMax(value) value (default = 30). For example, if size=50 and
max=100, the graphical elements are displayed at one half of the maximum
allowable size. 

If the data in the column assigned to the inherited
VisualFrame.setField(field) property are positive values, these data values
are used instead of StaticSizeFrame.size.

Parameter
value Number of pixels, or relative size

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setSizeField("Company",Chart.STRING);
Chart1.bindingInfo.sizeFrame = new StaticSizeFrame;
Chart1.bindingInfo.sizeFrame.size = 30;
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity")
var frame = new StaticSizeFrame();
frame.setMax(100);
frame.setSize(50);
elem.setSizeFrame(frame);
graph.addElement(elem);

Inherits from
SizeFrame: setLargest, setMax, setSmallest
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.15 LinearSizeFrame 

The LinearSizeFrame object contains a frame that linearly maps numerical
data values to sizes. To create a LinearSizeFrame object, call the
LinearSizeFrame constructor.

var frame = new LinearSizeFrame('Quantity');

You can pass the name of a field (e.g., ‘Quantity’) to the constructor, or
specify this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.
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Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setSizeField("Total",Chart.NUMBER)
Chart1.bindingInfo.sizeFrame = new LinearSizeFrame;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity", "width"], ["NJ", 200, 5], 
["NY", 300,10], ["PA",75,15]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new LinearSizeFrame();
frame.setField("width");
frame.setSmallest(10);
frame.setLargest(50);
frame.setMax(100);
elem.setSizeFrame(frame);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.LinearSizeFrame

Inherits from
SizeFrame: setLargest, setMax, setSmallest
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.
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CR.7.16 CategoricalSizeFrame

The CategoricalSizeFrame object contains a frame that assigns a unique
size to each distinct value. To create a CategoricalSizeFrame object, call
the CategoricalSizeFrame constructor.

var frame = new CategoricalSizeFrame('State');

You can pass the name of a field (e.g., ‘State’) to the constructor, or specify
this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setSizeField("Employee",Chart.STRING)
Chart1.bindingInfo.sizeFrame = new CategoricalSizeFrame;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300], 
["PA", 75]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new CategoricalSizeFrame();
frame.setField("State");
elem.setSizeFrame(frame);
graph.addElement(elem);
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Full Name
inetsoft.graph.aesthetic.CategoricalSizeFrame

CategoricalSizeFrame: setSize

Inherits from
SizeFrame: setLargest, setMax, setSmallest
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CategoricalSizeFrame.SETSIZE(VAL,SIZE)

Assigns a size to the specified value.

Parameter
val a data value
size size at which to represent data value

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setSizeField("Employee",Chart.STRING)
Chart1.bindingInfo.sizeFrame = new CategoricalSizeFrame;
Chart1.bindingInfo.sizeFrame.setSize('Robert',20);
Chart1.bindingInfo.sizeFrame.setSize('Eric',20)
Chart1.bindingInfo.sizeFrame.setSize('Sue',5);
Chart1.bindingInfo.sizeFrame.setSize('Annie',5);
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200],["NY", 300], 
["PA", 75]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity")
var frame = new CategoricalSizeFrame();
frame.setField("State");
frame.setSize('NJ',5);
frame.setSize('NY',10);
frame.setSize('PA',20);
elem.setSizeFrame(frame);
graph.addElement(elem);

Inherits from
SizeFrame: setLargest, setMax, setSmallest
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.17 TextureFrame 

The TextureFrame object contains the texture for visual chart objects. You
can use a TextureFrame object to represent data dimensions with texture
(texture coding), or to apply a fixed (static) texture pattern.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.textureFrame = new LeftTiltTextureFrame;
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. 

var frame = new StaticTextureFrame();
frame.setTexture(GTexture.PATTERN_5);
var elem = graph.getElement(0); // bar elements
elem.setTextureFrame(frame);

Full Name
inetsoft.graph.aesthetic.TextureFrame

Created by
LeftTiltTextureFrame
OrientationTextureFrame
RightTiltTextureFrame
GridTextureFrame
CategoricalTextureFrame
StaticTextureFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.
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CR.7.18 StaticTextureFrame 

The StaticTextureFrame object contains a texture frame defined by explicit
texture data in the VisualFrame.setField(field) column, or by the fixed
texture in StaticTextureFrame.setTexture(value). To create a
StaticTextureFrame object, call the StaticTextureFrame constructor.

var frame = new StaticTextureFrame();

You can pass a GTexture object directly to the constructor, e.g., 

var frame = new StaticTextureFrame(GTexture.PATTERN_5);

or specify it later using the StaticTextureFrame.setTexture(value) property.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. 

var frame = new StaticTextureFrame();
frame.setTexture(GTexture.PATTERN_5);
var elem = graph.getElement(0); // bar elements
elem.setTextureFrame(frame);

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity","Texture"],["NJ",200,1], 
["NY",300,10]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new StaticTextureFrame();
frame.setField("Texture");
elem.setTextureFrame(frame);
graph.addElement(elem);
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Full Name
inetsoft.graph.aesthetic.StaticTextureFrame

StaticTextureFrame: setTexture

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

StaticTextureFrame.SETTEXTURE(VALUE)

Specifies the static texture for graphical elements. If the data in the column
assigned to the inherited VisualFrame.setField(field) property are GTexture
numbers, these data values are used instead of
StaticTextureFrame.texture.

Parameter
value a GTexture object

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Company",Chart.STRING);
Chart1.bindingInfo.textureFrame = new StaticTextureFrame();
Chart1.bindingInfo.textureFrame.texture = 
GTexture.PATTERN_5;
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",300], ["NY",200]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity")
frame = new StaticTextureFrame();
frame.setTexture(GTexture.PATTERN_18); 
elem.setTextureFrame(frame);
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.19 LeftTiltTextureFrame 

The LeftTiltTextureFrame object contains a texture for visual chart objects
rendered by negatively-sloping lines with variable spacing. To create a
LeftTiltTextureFrame object, call the LeftTiltTextureFrame constructor.

var frame = new LeftTiltTextureFrame('Total');

You can pass the name of a field (e.g., ‘Total’) to the constructor, or specify
this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.textureFrame = new LeftTiltTextureFrame;
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity","Total"], 
["NJ",300,10],["NY",200,20],["PA",250,35]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity")
var frame = new LeftTiltTextureFrame("Total");
elem.setTextureFrame(frame);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.LeftTiltTextureFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.20 OrientationTextureFrame 

The OrientationTextureFrame object contains a texture for visual chart
objects rendered by uniformly-spaced lines with variable slope. To create a
OrientationTextureFrame object, call the OrientationTextureFrame
constructor.

var frame = new OrientationTextureFrame('Total');

You can pass the name of a field (e.g., ‘Total’) to the constructor, or specify
this later using the inherited VisualFrame.setField(field) property.
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Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.textureFrame = new 
OrientationTextureFrame;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity","Total"], 
["NJ",300,10],["NY",200,20],["PA",250,35]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity")
var frame = new OrientationTextureFrame("Total");
elem.setTextureFrame(frame);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.OrientationTextureFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.
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CR.7.21 RightTiltTextureFrame 

The RightTiltTextureFrame object contains a texture for visual chart
objects rendered by positively-sloping lines with variable spacing. To
create a RightTiltTextureFrame object, call the RightTiltTextureFrame
constructor.

var frame = new RightTiltTextureFrame('Total');

You can pass the name of a field (e.g., ‘Total’) to the constructor, or specify
this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.textureFrame = new 
RightTiltTextureFrame;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity","Total"], 
["NJ",300,10],["NY",200,20],["PA",250,35]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity")
var frame = new RightTiltTextureFrame("Total");
elem.setTextureFrame(frame);
graph.addElement(elem);
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Full Name
inetsoft.graph.aesthetic.RightTiltTextureFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.22 GridTextureFrame 

The GridTextureFrame object contains a texture for visual chart objects
rendered by variably-spaced orthogonal lines. To create a
GridTextureFrame object, call the GridTextureFrame constructor.

var frame = new GridTextureFrame('Total');

You can pass the name of a field (e.g., ‘Total’) to the constructor, or specify
this later using the inherited VisualFrame.setField(field) property.

Full Name
inetsoft.graph.aesthetic.GridTextureFrame

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Employee",Chart.STRING);
Chart1.bindingInfo.textureFrame = new GridTextureFrame();
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity","Total"], 
["NJ",300,10],["NY",200,20],["PA",250,35]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity")
var frame = new GridTextureFrame("Total");
elem.setTextureFrame(frame);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.GridTextureFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.23 CategoricalTextureFrame 

The CategoricalTextureFrame object contains a texture for visual chart
objects, rendering a unique texture for each discrete value. To create a
CategoricalTextureFrame object, call the CategoricalTextureFrame
constructor.

var frame = new GridTextureFrame('State');

You can pass the name of a field (e.g., ‘State’) to the constructor, or specify
this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Employee",Chart.STRING);
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Chart1.bindingInfo.textureFrame = new 
CategoricalTextureFrame;
Chart1.bindingInfo.textureFrame.setTexture('Robert',GTextur
e.PATTERN_1);
Chart1.bindingInfo.textureFrame.setTexture('Eric',GTexture.
PATTERN_1);
Chart1.bindingInfo.textureFrame.setTexture('Sue',GTexture.P
ATTERN_5);
Chart1.bindingInfo.textureFrame.setTexture('Annie',GTexture
.PATTERN_5);

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity","Rep"], ["NJ",200,"John"], 
["NY",300,"Sue"], ["PA",75,"Sue"], ["CT", 120,"John"]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity")
var frame = new CategoricalTextureFrame();
frame.setField("Rep");
elem.setTextureFrame(frame);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.CategoricalTextureFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CategoricalTextureFrame: setTexture
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CategoricalTextureFrame.SETTEXTURE(VAL,TEXTURE)

Assigns a texture to the specified value.

Parameter
val a data value
shape a GTexture object

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Employee",Chart.STRING);
Chart1.bindingInfo.textureFrame = new 
CategoricalTextureFrame;
Chart1.bindingInfo.textureFrame.setTexture('Robert',GTextu
re.PATTERN_1);
Chart1.bindingInfo.textureFrame.setTexture('Eric',GTexture
.PATTERN_1);
Chart1.bindingInfo.textureFrame.setTexture('Sue',GTexture.
PATTERN_5);
Chart1.bindingInfo.textureFrame.setTexture('Annie',GTextur
e.PATTERN_5);

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
textureframe = new CategoricalTextureFrame("State");
textureframe.setTexture('NJ',GTexture.PATTERN_18);
textureframe.setTexture('NY',GTexture.PATTERN_14);
elem.setTextureFrame(textureframe);
graph.addElement(elem);
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Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.24 ShapeFrame 

A ShapeFrame object contains the shape style for visual chart objects. You
can use a ShapeFrame object to represent data dimensions with shape
(shape coding), or to apply a fixed (static) shape style. 

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.shapeFrame = new FillShapeFrame;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. 
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var frame = new StaticShapeFrame();
frame.setShape(GShape.ARROWBAR);
var elem = graph.getElement(0); // point elements
elem.setShapeFrame(frame);

Full Name
inetsoft.graph.aesthetic.ShapeFrame

Created by
OvalShapeFrame
FillShapeFrame
OrientationShapeFrame
PolygonShapeFrame
TriangleShapeFrame
CategoricalShapeFrame
StaticShapeFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.25 OvalShapeFrame 

The OvalShapeFrame object contains the shape styles for oval elements of
varying aspect ratio. To create a OvalShapeFrame object, call the
OvalShapeFrame constructor.

var frame = new OvalShapeFrame('Total');

You can pass the name of a field (e.g., ‘Total’) to the constructor, or specify
this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.
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Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.shapeFrame = new OvalShapeFrame();

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity","Total"], ["NJ",200,30], 
["NY",300,15],["PA",150,5]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new OvalShapeFrame("Total");
elem.setShapeFrame(frame);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.OvalShapeFrame

OvalShapeFrame: setFill

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

OvalShapeFrame.SETFILL(VALUE)

Specifies the fill for the oval elements. 

Parameter
boolean true: fill oval

false: do not fill oval
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Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.shapeFrame = new OvalShapeFrame;
Chart1.bindingInfo.shapeFrame.fill = true;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity","Total"], ["NJ",200,30], 
["NY",300,15],["PA",150,5]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var frame = new OvalShapeFrame("Total");
frame.setFill(true);
elem.setShapeFrame(frame);
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.
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CR.7.26 FillShapeFrame 

The FillShapeFrame object contains the shape styles for oval elements with
variable degree of fill. To create a FillShapeFrame object, call the
FillShapeFrame constructor.

var frame = new FillShapeFrame('Total');

You can pass the name of a field (e.g., ‘Total’) to the constructor, or specify
this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.shapeFrame = new FillShapeFrame;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity","Total"], ["NJ",200,30], 
["NY",300,15], ["PA",150,5]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var shapeframe = new FillShapeFrame("Total");
var sizeframe = new StaticSizeFrame();
sizeframe.setSize(10);
elem.setSizeFrame(sizeframe);
elem.setShapeFrame(shapeframe);
graph.addElement(elem);
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Full Name
inetsoft.graph.aesthetic.FillShapeFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.27 OrientationShapeFrame 

The OrientationShapeFrame object contains the shape styles for line
elements with variable orientation. To create a OrientationShapeFrame
object, call the OrientationShapeFrame constructor.

var frame = new OrientationShapeFrame('Total');

You can pass the name of a field (e.g., ‘Total’) to the constructor, or specify
this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.shapeFrame = new OrientationShapeFrame;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
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Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity","Total"], ["NJ",200,30], 
["NY",300,15], ["PA",150,5]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var shapeframe = new OrientationShapeFrame("Total");
var sizeframe = new StaticSizeFrame();
sizeframe.setSize(10);
elem.setSizeFrame(sizeframe);
elem.setShapeFrame(shapeframe);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.OrientationShapeFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.28 PolygonShapeFrame 

The PolygonShapeFrame object contains the shape styles for elements with
varying number of sides. To create a PolygonShapeFrame object, call the
PolygonShapeFrame constructor.

var frame = new PolygonShapeFrame('Total');

You can pass the name of a field (e.g., ‘Total’) to the constructor, or specify
this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.shapeFrame = new PolygonShapeFrame;
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity","Total"], ["NJ",200,30], 
["NY",300,15], ["PA",150,5]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var sizeframe = new StaticSizeFrame();
sizeframe.setSize(10);
var frame = new PolygonShapeFrame("Total");
elem.setShapeFrame(frame);
elem.setSizeFrame(sizeframe);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.PolygonShapeFrame

PolygonShapeFrame: setFill

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

PolygonShapeFrame.SETFILL(BOOLEAN)

Specifies whether the polygonal elements should be filled. 

Parameter
boolean true: fill oval

false: do not fill oval
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Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.shapeFrame = new PolygonShapeFrame;
Chart1.bindingInfo.shapeFrame.fill = true;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity","Total"], ["NJ",200,30], 
["NY",300,15],["PA",150,5]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var sizeframe = new StaticSizeFrame();
sizeframe.setSize(10);
var frame = new PolygonShapeFrame("Total");
frame.setFill(true);
elem.setShapeFrame(frame);
elem.setSizeFrame(sizeframe);
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.
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CR.7.29 TriangleShapeFrame 

The TriangleShapeFrame object contains the shape styles for isosceles
trapezoid elements with varying width ratios. To create a
TriangleShapeFrame object, call the TriangleShapeFrame constructor.

var frame = new TriangleShapeFrame('Total');

You can pass the name of a field (e.g., ‘Total’) to the constructor, or specify
this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.shapeFrame = new TriangleShapeFrame;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity","Total"], ["NJ",200,30],
["NY",300,15], ["PA",150,5]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var sizeframe = new StaticSizeFrame();
sizeframe.setSize(10);
var frame = new TriangleShapeFrame("Total");
elem.setShapeFrame(frame);
elem.setSizeFrame(sizeframe);
graph.addElement(elem);
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Full Name
inetsoft.graph.aesthetic.TriangleShapeFrame

TriangleShapeFrame: setFill

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

TriangleShapeFrame.SETFILL(BOOLEAN)

Specifies whether the triangular elements should be filled. 

Parameter
boolean true: fill triangle

false: do not fill triangle

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.shapeFrame = new TriangleShapeFrame;
Chart1.bindingInfo.shapeFrame.fill = true;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
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Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity","Total"], ["NJ",200,30], 
["NY",300,15], ["PA",150,5]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var sizeframe = new StaticSizeFrame();
sizeframe.setSize(10);
var frame = new TriangleShapeFrame("Total");
frame.setFill(true);
elem.setShapeFrame(frame);
elem.setSizeFrame(sizeframe);
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.30 CategoricalShapeFrame 

The CategoricalShapeFrame object contains a shape style for visual chart
objects, rendering a unique shape for each discrete value. To create a
CategoricalShapeFrame object, call the CategoricalShapeFrame
constructor.

var frame = new CategoricalShapeFrame('State');

You can pass the name of a field (e.g., ‘State’) to the constructor, or specify
this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Example
Chart1.bindingInfo.setShapeField("Employee",Chart.STRING);
Chart1.bindingInfo.shapeFrame = new CategoricalShapeFrame;
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity","Rep"], ["NJ",200,"John"], 
["NY",300,"Sue"], ["PA",75,"Sue"], ["CT", 120,"John"]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity")
var frame = new CategoricalShapeFrame("Rep");
elem.setShapeFrame(frame);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.CategoricalShapeFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CategoricalShapeFrame: setShape

CategoricalShapeFrame.SETSHAPE(VAL,SHAPE)

Assigns a shape to the specified value.

Parameter
val data value
shape GShape or GShape.ImageShape object

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.
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Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Employee",Chart.STRING);
Chart1.bindingInfo.shapeFrame = new CategoricalShapeFrame;
Chart1.bindingInfo.shapeFrame.setShape('Robert', 
GShape.FILLED_CIRCLE);
Chart1.bindingInfo.shapeFrame.setShape('Sue', 
GShape.FILLED_DIAMOND);

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
sizeframe = new StaticSizeFrame("State");
sizeframe.setSize(10);
shapeframe = new CategoricalShapeFrame("State");
shapeframe.setShape('NJ',GShape.FILLED_CIRCLE);
shapeframe.setShape('NY',GShape.FILLED_DIAMOND);
elem.setShapeFrame(shapeframe);
elem.setSizeFrame(sizeframe);
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.31 StaticShapeFrame 

The StaticShapeFrame object contains a shape frame defined by explicit
shape data in the VisualFrame.setField(field) column, or by the fixed shape
in StaticShapeFrame.setShape(shape). To create a StaticShapeFrame
object, call the StaticShapeFrame constructor.

var frame = new StaticShapeFrame('GShape.CIRCLE');

You can pass a GShape or SVGShape object (e.g., ‘GShape.CIRCLE’,
‘SVGShape.FACE_BLANK’) or a field name (e.g., ‘Shape’) to the constructor,
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or specify this later using the StaticShapeFrame.setShape(shape) or
inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example 1 (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Company",Chart.STRING);
Chart1.bindingInfo.shapeFrame = new StaticShapeFrame;
Chart1.bindingInfo.shapeFrame.setShape(GShape.ARROWBAR);

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example 2 (Report or Viewsheet)
dataset = [["State","Quantity","Shape"], ["NJ",200,"STAR"], 
["NY",300,"CIRCLE"]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var sizeframe = new StaticSizeFrame(5);
var shapeframe = new StaticShapeFrame();
shapeframe.setField("Shape");
elem.setShapeFrame(shapeframe);
elem.setSizeFrame(sizeframe);
graph.addElement(elem);

Example 3 (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new PointElement("State","Quantity");
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var shapeFrame = new StaticShapeFrame(SVGShape.FACE_HAPPY); 
var sizeFrame = new StaticSizeFrame(10);
elem.setSizeFrame(sizeFrame);
elem.setShapeFrame(shapeFrame);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.StaticShapeFrame

StaticShapeFrame: setShape

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

StaticShapeFrame.SETSHAPE(SHAPE)

Specifies the static shape for graphical elements. If the data in the column
assigned to the inherited VisualFrame.setField(field) property are shape
names, these data values are used instead of StaticShapeFrame.shape.

Parameter
shape GShape, GShape.ImageShape, or SVGShape object

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Company",Chart.STRING);
Chart1.bindingInfo.shapeFrame = new StaticShapeFrame;
Chart1.bindingInfo.shapeFrame.setShape(GShape.ARROWBAR);
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var frame = new StaticShapeFrame();
var elem = new PointElement("State", "Quantity");
frame.setShape(GShape.CROSS); 
elem.setShapeFrame(frame);
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.32 MultiShapeFrame 

The MultiShapeFrame object contains the shape styles for visual chart
objects on multiple dimensions.

Full Name
inetsoft.graph.aesthetic.MultiShapeFrame

MultiShapeFrame: setFields, setScales

Created by
VineShapeFrame
ThermoShapeFrame
StarShapeFrame
SunShapeFrame
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BarShapeFrame
ProfileShapeFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

MultiShapeFrame.SETFIELDS(ARR)

Specifies the columns containing the shape specifications for the graphical
elements. 

Parameter
arr Array of Strings

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity", "m1", "m2", "m3"], ["NJ", 
200, 6,3,4], ["NY", 300,8,2,5]];
graph = new EGraph();
var frame = new StarShapeFrame();
var elem = new PointElement("State", "Quantity");
frame.setFields(["m1", "m2", "m3"]);
elem.setShapeFrame(frame);
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

MultiShapeFrame.SETSCALES(ARR)

Specifies the scales to be used for each shape field. 

Parameter
arr Array of Scale
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity", "m1", "m2", "m3"], ["NJ", 
200, 50,50,5], ["NY", 300,20,30,50]];
graph = new EGraph();
var frame = new StarShapeFrame();
var elem = new PointElement("State", "Quantity");
var yscale = new LinearScale("Quantity");
yscale.setMax(500);
frame.setFields(["m1", "m2", "m3"]);
var scale1 = new LinearScale("m1");
var scale2 = new LinearScale("m2");
var scale3 = new LinearScale("m3");
scale1.setMax(10);
scale2.setMax(10);
scale3.setMax(10);
frame.setScales([scale1, scale2, scale3]);
elem.setShapeFrame(frame);
graph.setScale("Quantity",yscale)
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.33 VineShapeFrame 

The VineShapeFrame object contains the shape styles for three-
dimensional “vine” elements. To create a VineShapeFrame object, call the
VineShapeFrame constructor.

var frame = new VineShapeFrame("m1","m2","m3");

You can pass a set of field names (e.g., ‘m1’, ‘m2’, ‘m3’) to the constructor,
or specify this later using the inherited MultiShapeFrame.setFields(arr)
property. The dimensions are specified in the following order: [angle,
magnitude, radius].

• Angle: The angle of the stem line
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• Magnitude: The length of the stem line

• Radius: The radius of the circle

Full Name
inetsoft.graph.aesthetic.VineShapeFrame

VineShapeFrame: setEndAngle, setStartAngle 

Inherits from
MultiShapeFrame: setFields, setScales
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

VineShapeFrame.SETENDANGLE(VALUE)

The angle to which the maximum angle in the data is mapped. (Note that
the max property of any applied scale also affects the displayed angle.)

Parameter
value the angle in degrees

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity", "m1", "m2", "m3"],["NJ", 
200,90,25,50],["NY", 300,30,15,15]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var frame = new VineShapeFrame();
var mscale = new LinearScale();
var rscale = new LinearScale();
mscale.setMin(0);
mscale.setMax(5);
rscale.setMin(0);
rscale.setMax(90);
frame.setScales([rscale, mscale, mscale]);
frame.setFields(["m1", "m2", "m3"]);
frame.setStartAngle(0);
frame.setEndAngle(90);
elem.setShapeFrame(frame);
graph.addElement(elem);
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Inherits from
MultiShapeFrame: setFields, setScales
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

VineShapeFrame.SETSTARTANGLE(VALUE)

The angle to which the minimum angle in the data is mapped. (Note that
the min property of any applied scale also affects the displayed angle.)

Parameter
value the angle in degrees

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity", "m1", "m2", "m3"], ["NJ", 
200,90,25,50], ["NY", 300,30,15,15]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var frame = new VineShapeFrame();
var mscale = new LinearScale();
var rscale = new LinearScale();
mscale.setMin(0);
mscale.setMax(5);
rscale.setMin(0);
rscale.setMax(90);
frame.setScales([rscale, mscale, mscale]);
frame.setFields(["m1", "m2", "m3"]);
frame.setStartAngle(0);
frame.setEndAngle(90);
elem.setShapeFrame(frame);
graph.addElement(elem);

Inherits from
MultiShapeFrame: setFields, setScales
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.



COMMON FUNCTION REFERENCE

1338 of 1397

CR.7.34 ThermoShapeFrame 

The ThermoShapeFrame object contains the shape styles for two-
dimensional “thermometer” elements. To create a ThermoShapeFrame
object, call the ThermoShapeFrame constructor.

var frame = new ThermoShapeFrame("Height", "Weight");

You can pass a pair of field names (e.g., ‘Height’, ‘Weight’) to the
constructor, or specify this later using the inherited
MultiShapeFrame.setFields(arr) property. The dimensions are specified in
the order [level, width].

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity","Height","Weight"], ["NJ", 
200,50,1], ["NY", 300,30,4]];
graph = new EGraph();
var frame = new ThermoShapeFrame();
var elem = new PointElement("State", "Quantity");
var hscale = new LinearScale()
var wscale = new LinearScale()
hscale.setMin(0);
hscale.setMax(100);
wscale.setMin(0);
wscale.setMax(5);
frame.setFields(["Height", "Weight"]);
frame.setScales([hscale, wscale]);
elem.setShapeFrame(frame);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.ThermoShapeFrame

Inherits from
MultiShapeFrame: setFields, setScales
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.
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CR.7.35 StarShapeFrame 

The StarShapeFrame object contains the shape styles for multi-dimensional
“star” (closed line) elements. To create a StarShapeFrame object, call the
StarShapeFrame constructor.

var frame = new StarShapeFrame("m1","m2","m3");

You can pass a set of field names (e.g., ‘m1’, ‘m2’, ‘m3’) to the constructor,
or specify this later using the inherited MultiShapeFrame.setFields(arr)
property.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity","m1","m2","m3"], ["NJ", 
200,5,1,3], ["NY", 300,3,4,4]];
graph = new EGraph();
var frame = new StarShapeFrame();
var elem = new PointElement("State", "Quantity");
frame.setFields(["m1","m2","m3"]);
elem.setShapeFrame(frame);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.StarShapeFrame

Inherits from
MultiShapeFrame: setFields, setScales
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.36 SunShapeFrame 

The SunShapeFrame object contains the shape styles for multidimensional
“sun” (radial line) elements. To create a SunShapeFrame object, call the
SunShapeFrame constructor.

var frame = new SunShapeFrame("m1","m2","m3");
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You can pass a set of field names (e.g., ‘m1’, ‘m2’, ‘m3’) to the constructor,
or specify this later using the inherited MultiShapeFrame.setFields(arr)
property.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity","m1","m2","m3"], ["NJ", 
200,5,1,3], ["NY", 300,3,4,4]];
graph = new EGraph();
var frame = new SunShapeFrame();
var elem = new PointElement("State", "Quantity");
frame.setFields(["m1","m2","m3"]);
elem.setShapeFrame(frame);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.SunShapeFrame

Inherits from
MultiShapeFrame: setFields, setScales
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.37 BarShapeFrame 

The BarShapeFrame object contains the shape styles for multi-dimensional
“mini-bar chart” elements. To create a BarShapeFrame object, call the
BarShapeFrame constructor.

var frame = new BarShapeFrame("m1","m2","m3");

You can pass a set of field names (e.g., ‘m1’, ‘m2’, ‘m3’) to the constructor,
or specify this later using the inherited MultiShapeFrame.setFields(arr)
property. The dimensions are mapped to the bar heights from left to right.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
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Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity","m1","m2","m3"], ["NJ", 
200,5,1,3], ["NY", 300,3,4,4]];
graph = new EGraph();
var frame = new BarShapeFrame();
var elem = new PointElement("State", "Quantity");
frame.setFields(["m1","m2","m3"]);
elem.setShapeFrame(frame);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.BarShapeFrame

Inherits from
MultiShapeFrame: setFields, setScales
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.38 PieShapeFrame 

The PieShapeFrame object contains the shape styles for multi-dimensional
“mini-pie” elements to be used together with a point-type (PointElement)
chart. To create a PieShapeFrame object, call the PieShapeFrame
constructor.

var frame = new PieShapeFrame("m1","m2","m3");

You can pass a set of field names (e.g., ‘m1’, ‘m2’, ‘m3’) to the constructor,
or specify this later using the inherited MultiShapeFrame.setFields(arr)
property. The dimension values are mapped proportionately to the areas of
the pie slices.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.
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Example (Report or Viewsheet)
dataset = [["State", "Quantity","m1","m2","m3"], ["NJ", 
200,5,2,3], ["NY", 300,2,4,4]];
graph = new EGraph();
var frame = new PieShapeFrame();
var elem = new PointElement("State", "Quantity");
var sframe = new StaticSizeFrame(15);
frame.setFields(["m1","m2","m3"]);
elem.setShapeFrame(frame);
elem.setSizeFrame(sframe);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.PieShapeFrame

Inherits from
MultiShapeFrame: setFields, setScales
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.39 ProfileShapeFrame 

The ProfileShapeFrame object contains the shape styles for multi-
dimensional “mini-line chart” elements. To create a ProfileShapeFrame
object, call the ProfileShapeFrame constructor.

var frame = new ProfileShapeFrame("m1","m2","m3");

You can pass a set of field names (e.g., ‘m1’, ‘m2’, ‘m3’) to the constructor,
or specify this later using the inherited MultiShapeFrame.setFields(arr)
property. The dimensions are mapped to the line segments from left to
right.

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity","m1","m2","m3"], ["NJ", 
200,5,1,3], ["NY", 300,3,4,4]];
graph = new EGraph();
var frame = new ProfileShapeFrame();
var elem = new PointElement("State", "Quantity");
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frame.setFields(["m1","m2","m3"]);
elem.setShapeFrame(frame);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.ProfileShapeFrame

Inherits from
MultiShapeFrame: setFields, setScales
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.40 TextFrame 

The TextFrame object contains a mapping between values and displayed
text.

Full Name
inetsoft.graph.aesthetic.TextFrame

TextFrame: setText

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

Created by
DefaultTextFrame

TextFrame.SETTEXT(VALUE,TEXT)

Specifies the mapping between a value and the text that should be
displayed. 

Parameters
value the data value to be replaced
text the replacement string

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.
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Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var cframe = new CategoricalColorFrame();
var tframe = new DefaultTextFrame();
var spec = cframe.getLegendSpec();
cframe.setField("State");
tframe.setText('NJ','New Jersey');
tframe.setText('NY','New York');
spec.setTextFrame(tframe)
elem.setColorFrame(cframe);
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.41 DefaultTextFrame 

The DefaultTextFrame object contains data to display in text form, as well
as a mapping between these values and any desired replacement text. To
create a DefaultTextFrame object, call the DefaultTextFrame constructor.

var frame = new DefaultTextFrame('Quantity');

You can pass a field name (e.g., ‘Quantity’) to the constructor, or specify
this later using the inherited VisualFrame.setField(field) property. To
stylize or reposition text created using a DefaultTextFrame, use the
GraphElement.setTextSpec(spec) and
GraphElement.setLabelPlacement(value) options.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setTextField("Company",Chart.STRING)
Chart1.bindingInfo.textFrame = new DefaultTextFrame;
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",203], ["NY",327]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var spec = new TextSpec();
var frame = new DefaultTextFrame();
spec.setFont(java.awt.Font('Verdana',java.awt.Font.BOLD, 
14));
frame.setField("Quantity");
elem.setTextFrame(frame);
elem.setTextSpec(spec);
graph.addElement(elem);

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var cframe = new CategoricalColorFrame();
var tframe = new DefaultTextFrame();
var spec = cframe.getLegendSpec();
cframe.setField("State");
tframe.setText('NJ','New Jersey');
tframe.setText('NY','New York');
spec.setTextFrame(tframe)
elem.setColorFrame(cframe);
graph.addElement(elem);
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Full Name
inetsoft.graph.aesthetic.DefaultTextFrame

Inherits from
TextFrame: setText
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.42 LineFrame 

The LineFrame object contains the line design for visual chart objects.
LineFrame objects allow you to represent additional data dimensions by
using the physical attributes of chart elements, or to apply a fixed (static)
line style.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a line-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.lineFrame = new LinearLineFrame;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.
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Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ",200], ["NY",300], 
["PA",100]];
graph = new EGraph();
var elem = new LineElement("State", "Quantity");
var frame = new StaticLineFrame();
frame.setLine(GLine.DASH_LINE);
elem.setLineFrame(frame);
graph.addElement(elem)

Full Name
inetsoft.graph.aesthetic.LineFrame

Created by
LinearLineFrame
CategoricalLineFrame
StaticLineFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.43 StaticLineFrame 

The StaticLineFrame object contains a line frame defined by explicit line
data in the VisualFrame.setField(field) column, or by the fixed line in
StaticLineFrame.setLine(value). To create a StaticLineFrame object, call
the StaticLineFrame constructor.

var frame = new StaticLineFrame(GLine.LARGE_DASH);

You can pass a GLine object or a field name (e.g., ‘Line’) to the
constructor, or specify this later using the StaticLineFrame.setLine(value)
or inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.
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Example (Report)
Bind a line-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.lineFrame = new StaticLineFrame;
Chart1.bindingInfo.lineFrame.line = GLine.LARGE_DASH;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity","Line"], 
["NJ",200,Chart.THICK_LINE], ["NY",300,Chart.MEDIUM_DASH]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var sizeframe = new StaticSizeFrame(9);
var lineframe = new StaticLineFrame();
lineframe.setField("Line");
elem.setLineFrame(lineframe);
elem.setSizeFrame(sizeframe);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.StaticLineFrame

StaticLineFrame: setLine

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.
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StaticLineFrame.SETLINE(VALUE)

Specifies the static line style for graphical elements. If the data in the
column assigned to the inherited VisualFrame.setField(field) property are
GLine objects, these data values are used instead of StaticLineFrame.line.

Parameter
value GLine or

Chart.NONE // Empty border

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a line-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Company",Chart.NUMBER)
Chart1.bindingInfo.lineFrame = new StaticLineFrame;
Chart1.bindingInfo.lineFrame.line = GLine.LARGE_DASH;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 300], ["NY", 200]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity")
var frame = new StaticLineFrame();
frame.setLine(GLine.DOT_LINE);
elem.setLineFrame(frame);
graph.addElement(elem);
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Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.44 LinearLineFrame 

The LinearLineFrame object contains a continuous line frame that returns
varying line styles. To create a LinearLineFrame object, call the
LinearLineFrame constructor.

var frame = new LinearLineFrame('Quantity');

You can pass the name of a field (e.g., ‘Quantity’) to the constructor, or
specify this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a line-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Total",Chart.NUMBER);
Chart1.bindingInfo.lineFrame = new LinearLineFrame;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity","Total"], ["NJ",300,1000], 
["NY",200,1500]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity")
var lframe = new LinearLineFrame();
var sframe = new StaticSizeFrame();
lframe.setField("Total");
sframe.setSize(10);
elem.setLineFrame(lframe);
elem.setSizeFrame(sframe);
graph.addElement(elem);
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Full Name
inetsoft.graph.aesthetic.LinearLineFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.7.45 CategoricalLineFrame

The CategoricalLineFrame object contains a unique line style for each
discrete value. To create a CategoricalLineFrame object, call the
CategoricalLineFrame constructor.

var frame = new CategoricalLineFrame('Quantity');

You can pass the name of a field (e.g., ‘Quantity’) to the constructor, or
specify this later using the inherited VisualFrame.setField(field) property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a line-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Employee",Chart.STRING);
Chart1.bindingInfo.lineFrame = new CategoricalLineFrame;
Chart1.bindingInfo.lineFrame.setLine('Robert', 
GLine.LARGE_DASH);
Chart1.bindingInfo.lineFrame.setLine('Eric', 
GLine.LARGE_DASH);
Chart1.bindingInfo.lineFrame.setLine('Sue',GLine.DOT_LINE);
Chart1.bindingInfo.lineFrame.setLine('Annie', 
GLine.DOT_LINE);
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", 
"Quantity"],["NJ",300],["NY",200],["PA",100]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity")
var frame = new CategoricalLineFrame();
frame.setField("State");
elem.setLineFrame(frame);
graph.addElement(elem);

Full Name
inetsoft.graph.aesthetic.CategoricalLineFrame

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.

CategoricalLineFrame: setLine

CategoricalLineFrame.SETLINE(VAL,LINE)

Assigns a line style to the specified value.

Parameter
val a data value
line a GLine value

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.
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Example (Report)
Bind a line-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Employee",Chart.STRING);
Chart1.bindingInfo.lineFrame = new CategoricalLineFrame;
Chart1.bindingInfo.lineFrame.setLine('Robert', 
GLine.LARGE_DASH);
Chart1.bindingInfo.lineFrame.setLine('Eric', 
GLine.LARGE_DASH);
Chart1.bindingInfo.lineFrame.setLine('Sue', 
GLine.DOT_LINE);
Chart1.bindingInfo.lineFrame.setLine('Annie', 
GLine.DOT_LINE);

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity")
frame = new CategoricalLineFrame();
frame.setField("State");
frame.setLine('NJ',GLine.THIN_LINE);
frame.setLine('NY',GLine.LARGE_DASH);
elem.setLineFrame(frame);
graph.addElement(elem);

Inherits from
VisualFrame: setField, setLegendSpec, setScale, setScaleOption

See Also
DataSet, to use a Data Block or query as the dataset source.
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CR.8 Chart Annotation and Decoration

This section describes objects used to add arbitrary text, shapes, and lines
to a chart.

CR.8.1 GraphForm 

The GraphForm object contains information for form (i.e., shape) elements
manually drawn on the chart. 

Full Name
inetsoft.graph.guide.form.GraphForm

GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure, setZIndex

Created by
LabelForm
TagForm
ShapeForm
RectForm
LineForm

GraphForm.SETCOLOR(VALUE)

Specifies the line and fill color of the form.

Type
value Number

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form = new LineForm();
form.addPoint(new java.awt.Point(0,0));
form.addPoint(new java.awt.Point(100,100));
form.addPoint(new java.awt.Point(200,100));
form.setColor(java.awt.Color(0xff0000));
graph.addForm(form);
graph.addElement(elem);
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See Also
DataSet, to use a Data Block or query as the dataset source.

GraphForm.SETFILL(BOOLEAN)

Specifies whether the form should be filled or unfilled.

Type
boolean true: fill the shape

false: do not fill the shape

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form = new LineForm();
form.addPoint(new java.awt.Point(0,0));
form.addPoint(new java.awt.Point(100,100));
form.addPoint(new java.awt.Point(200,100));
form.setFill(true);
graph.addForm(form);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.
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GraphForm.SETINPLOT(BOOLEAN)

For forms that use relative positioning (values or tuples), specifies whether
the chart should be resized so that forms remain fully visible in the chart
area.

Type
boolean true: resize chart

false: do not resize chart (crop forms)

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var form = new LineForm();
var elem = new IntervalElement("State", "Quantity");
form.addValues(['NJ',0]);
form.addValues(['NJ',300]);
form.addValues(['NY',400]);
form.setInPlot(true);
form.setFill(true);
graph.addForm(form);
graph.addElement(elem);

See Also
AxisSpec.setInPlot(boolean), to adjust plot boundaries to include graph
labels.
GraphElement.setInPlot(boolean), to adjust plot boundaries to include
graph elements.
DataSet, to use a Data Block or query as the dataset source.

GraphForm.SETLINE(VALUE)

Specifies the line style used to draw the form.

Type
value a GLine constant

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
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Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var form = new LineForm();
var elem = new IntervalElement("State", "Quantity");
form.addPoint(new java.awt.Point(0,0));
form.addPoint(new java.awt.Point(100,100));
form.addPoint(new java.awt.Point(200,100));
form.setLine(Chart.DASH_LINE);
graph.addForm(form);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

GraphForm.SETMEASURE(COL)

Specifies the measure for which the form should be displayed. If the chart
contains a measure of this name, the form object is displayed. Otherwise it
is not displayed. This is useful for FacetCoord charts, when the form
should be displayed only for the chart that represents a particular measure.

Type
col name of a column (String)

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity", "Sales"], ["NJ", 200, 800], 
["NY", 300, 600]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var elem2 = new IntervalElement("State", "Sales");
var form = new LabelForm();
form.setValues(['NJ',200]);
form.setLabel("NJ Sales");
form.setAlignmentX(Chart.CENTER_ALIGNMENT);
form.setMeasure("Sales");
graph.addForm(form);
var scale = new CategoricalScale("State");
var qscale = new LinearScale("Quantity");
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var sscale = new LinearScale("Sales");
var qcoord = new RectCoord(scale, qscale);
var scoord = new RectCoord(scale, sscale);
var facet = new FacetCoord();
facet.setInnerCoordinates([qcoord, scoord]);
graph.setCoordinate(facet);
graph.addElement(elem);
graph.addElement(elem2);

See Also
DataSet, to use a Data Block or query as the dataset source.

GraphForm.SETXOFFSET(VALUE)

Specifies an offset (in pixels) by which to shift the form object horizontally.
Positive values offset the object to the right; negative values offset the
object to the left.

Type
value an integer (pixels) 

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"],["NJ", 200],["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form = new LabelForm();
form.setLabel("label1");
form.setValues(['NY', 100]);
form.setXOffset(-50)
form.setYOffset(100)
graph.addForm(form);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

GraphForm.SETYOFFSET(VALUE)

Specifies an offset (in pixels) by which to shift the form object vertically.
Positive values offset the object upward; negative values offset the object
downward.
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Type
value an integer (pixels) 

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"],["NJ", 200],["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form = new LabelForm();
form.setLabel("label1");
form.setValues(['NY', 100]);
form.setXOffset(-50)
form.setYOffset(100)
graph.addForm(form);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

GraphForm.SETZINDEX(VALUE)

Specifies the layering order for forms. A shape with a larger zIndex
overlays a shape with a smaller zIndex. To ensure that a manually drawn
shape appears in front of other chart elements, select a large zIndex. See Z-
Index Defaults for the values of standard chart objects.

Type
value the index, a positive integer

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form1 = new LineForm();
var form2 = new LineForm();
form1.addPoint(new java.awt.Point(0,0));
form1.addPoint(new java.awt.Point(100,100));
form1.addPoint(new java.awt.Point(200,100));
form1.setColor(java.awt.Color(0xff0000));
form1.setFill(true);
form1.setZIndex(300);
form2.addPoint(new java.awt.Point(100,0));
form2.addPoint(new java.awt.Point(150,150));
form2.addPoint(new java.awt.Point(200,100));
form2.setColor(java.awt.Color(0xffff00));
form2.setFill(true);
form2.setZIndex(200);
graph.addForm(form1);
graph.addForm(form2);
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graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.8.2 LineForm 

The LineForm object contains information for lines manually drawn on the
chart. To create a LineForm object, call the LineForm constructor.

var line = new LineForm();

Full Name
inetsoft.graph.guide.form.LineForm

LineForm: setEndArrow, setPoints, setStartArrow, setTuples, setValues

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

LineForm.SETENDARROW(BOOLEAN)

Specifies whether an arrow should be drawn at the end of the line (i.e., at
the last point specified for the line form).

Type
boolean true: draw arrow

false: no arrow

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form = new LineForm();
form.addPoint(new java.awt.Point(0,0));
form.addPoint(new java.awt.Point(100,100));
form.setEndArrow(true);
form.setColor(java.awt.Color(0xff0000));
graph.addForm(form);
graph.addElement(elem);
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See Also
DataSet, to use a Data Block or query as the dataset source.

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

LineForm.ADDPOINT(VALUE)

Specifies the pixel location (integer values) or proportional location
(fractional values) defining a point on the line. (Positive values specify
distance from left/bottom. Negative values specify distance from right/top.)

Type
value a subclass of java.awt.geom.Point2D

e.g., 
java.awt.Point for pixels
java.awt.geom.Point2D.Double for proportion

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form1 = new LineForm();
var form2 = new LineForm();

// Set form1 points in pixels:
form1.addPoint(new java.awt.Point(100, 0));
form1.addPoint(new java.awt.Point(100, 200));
form1.addPoint(new java.awt.Point(200,100));
form1.setColor(java.awt.Color(0xff0000));

// Set form2 points proportionally:
form2.addPoint(new java.awt.geom.Point2D.Double(.5,0));
form2.addPoint(new java.awt.geom.Point2D.Double(.5,.7)); 
form2.addPoint(new java.awt.geom.Point2D.Double(.7,.5));
form2.setColor(java.awt.Color(0xff00ff));

graph.addForm(form1);
graph.addForm(form2);
graph.addElement(elem);

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/geom/Point2D.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Point.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/geom/Point2D.Double.html
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Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

LineForm.SETSTARTARROW(BOOLEAN)

Specifies whether an arrow should be drawn at the start of the line (i.e., at
the first point specified for the line form). 

Type
boolean true: draw arrow

false: no arrow

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form = new LineForm();
form.addPoint(new java.awt.Point(0,0));
form.addPoint(new java.awt.Point(100,100));
form.setStartArrow(true);
form.setColor(java.awt.Color(0xff0000));
graph.addForm(form);
graph.addElement(elem);
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Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

LineForm.ADDTUPLE(VALUE)

Specifies a point defining the line in logical space. The coordinates of the
points are relative to the prevailing axis scaling.

Type
value An [X,Y] pair

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form = new LineForm();
form.addTuple([.5, 0]);
form.addTuple([.5, 200]);
form.addTuple([1,100]);
form.setColor(java.awt.Color(0xff0000));
graph.addForm(form);
graph.addElement(elem);

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

LineForm.ADDVALUES(VALUE)

Specifies a point defining the line in logical space. The coordinates of the
points are relative to prevailing axis scaling prior to transformation. So, for
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a categorical X-axis (e.g., ‘NJ’, ‘NY’, ‘PA’, etc.), the X-values of points
should specify a categorical value (e.g., ‘NJ’).

Type
value an [X,Y] pair

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form = new LineForm();
form.addValues(['NJ', 0]);
form.addValues(['NJ', 200]);
form.addValues(['NY', 100]);
form.setColor(java.awt.Color(0xff0000));
graph.addForm(form);
graph.addElement(elem);

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.8.3 RectForm

The RectForm object contains information for rectangles manually drawn
on the chart. To create a RectForm object, call the RectForm constructor.

var rect = new RectForm();

Full Name
inetsoft.graph.guide.form.RectForm

RectForm: setBottomRightPoint, setBottomRightTuple, setBottomRightValues,
setTopLeftPoint, setTopLeftTuple, setTopLeftValues

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex
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RectForm.SETBOTTOMRIGHTPOINT(VALUE)

Specifies the pixel location (integer values) or proportional location
(fractional values) defining the bottom right corner of the rectangle.
(Positive values specify distance from left/bottom. Negative values specify
distance from right/top.)

Type
value a subclass of java.awt.geom.Point2D

e.g., 
java.awt.Point for pixels
java.awt.geom.Point2D.Double for proportion

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var rect1 = new RectForm();
var rect2 = new RectForm();

// Set rect1 points in pixels:
rect1.setTopLeftPoint(new java.awt.Point(100, 100));
rect1.setBottomRightPoint(new java.awt.Point(150, 50));
rect1.setColor(java.awt.Color(0xff0000));

// Set rect2 points proportionally:
rect2.setTopLeftPoint(new 
java.awt.geom.Point2D.Double(.5,.8));
rect2.setBottomRightPoint(new 
java.awt.geom.Point2D.Double(.8,.5));
rect2.setColor(java.awt.Color(0xff00ff));
graph.addForm(rect1);
graph.addForm(rect2);
graph.addElement(elem);

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/geom/Point2D.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Point.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/geom/Point2D.Double.html
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RectForm.SETBOTTOMRIGHTTUPLE(VALUE)

Specifies the point in logical space for the bottom right corner of the
rectangle. The coordinates of the point are relative to the prevailing axis
scaling.

Type
value An [X,Y] pair 

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var rect = new RectForm();
rect.setTopLeftTuple([1,200]);
rect.setBottomRightTuple([2,50]);
rect.setColor(java.awt.Color(0xff0000));
graph.addForm(rect);
graph.addElement(new IntervalElement("State", "Quantity"));

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

RectForm.SETBOTTOMRIGHTVALUES(VALUE)

Specifies the point in logical space for the bottom right corner of the
rectangle. The coordinates of the point are relative to prevailing axis
scaling prior to transformation. So, for a categorical X-axis (e.g., ‘NJ’,
‘NY’, ‘PA’, etc.), the X-value of bottomRightValues should specify a
categorical value (e.g., ‘NJ’).

Type
value an [X,Y] pair 

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
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Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var rect = new RectForm();
rect.setTopLeftValues(['NJ',200]);
rect.setBottomRightValues(['NY',50]);
rect.setColor(java.awt.Color(0xff0000));
graph.addForm(rect);
graph.addElement(new IntervalElement("State", "Quantity"));

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

RectForm.SETTOPLEFTPOINT(VALUE)

Specifies the pixel location (integer values) or proportional location
(fractional values) defining the top left corner of the rectangle. (Positive
values specify distance from left/bottom. Negative values specify distance
from right/top.)

Type
value a subclass of java.awt.geom.Point2D

e.g., 
java.awt.Point for pixels
java.awt.geom.Point2D.Double for proportion

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var rect1 = new RectForm();
var rect2 = new RectForm();

// Set rect1 points in pixels:

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/geom/Point2D.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Point.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/geom/Point2D.Double.html
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rect1.setTopLeftPoint(new java.awt.Point(100, 100));
rect1.setBottomRightPoint(new java.awt.Point(150, 50));
rect1.setColor(java.awt.Color(0xff0000));

// Set rect2 points proportionally:
rect2.setTopLeftPoint(new 
java.awt.geom.Point2D.Double(.5,.8));
rect2.setBottomRightPoint(new 
java.awt.geom.Point2D.Double(.8,.5));
rect2.setColor(java.awt.Color(0xff00ff));
graph.addForm(rect1);
graph.addForm(rect2);
graph.addElement(elem);

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

RectForm.SETTOPLEFTTUPLE(VALUE)

Specifies the point in logical space for the top left corner of the rectangle.
The coordinates of the point are relative to the prevailing axis scaling.

Type
value An [X,Y] pair 

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var rect = new RectForm();
rect.setTopLeftTuple([1,200]);
rect.setBottomRightTuple([2,50]);
rect.setColor(java.awt.Color(0xff0000));
graph.addForm(rect);
graph.addElement(new IntervalElement("State", "Quantity"));
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Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

RectForm.SETTOPLEFTVALUES(VALUE)

Specifies the point in logical space for the top left corner of the rectangle.
The coordinates of the point are relative to prevailing axis scaling prior to
transformation. So, for a categorical X-axis (e.g., ‘NJ’, ‘NY’, ‘PA’, etc.),
the X-value of topLeftValues should specify a categorical value (e.g., ‘NJ’).

Type
value an [X,Y] pair 

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var rect = new RectForm();
rect.setTopLeftValues(['NJ',200]);
rect.setBottomRightValues(['NY',50]);
rect.setColor(java.awt.Color(0xff0000));
graph.addForm(rect);
graph.addElement(new IntervalElement("State", "Quantity"));

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex
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See Also
DataSet, to use a Data Block or query as the dataset source.

CR.8.4 LabelForm 

The LabelForm object contains information for labels manually drawn on
the chart. To create a LabelForm object, call the LabelForm constructor:

var form = new LabelForm();

The label border color and style are set by the inherited
GraphForm.setColor(value) and GraphForm.setLine(value) properties.

Full Name
inetsoft.graph.guide.form.LabelForm

LabelForm: setAlignmentX, setAlignmentY, setCollisionModifier, setInsets, setLabel,
setPoint, setTextSpec, setTuple,setValues

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DefaultTextFrame, to automatically use data values as element labels.

LabelForm.SETALIGNMENTX(VALUE)

Specifies the horizontal alignment of the label with respect to the specified
X location. Alignment is also applied to the label text.

Values
Chart.LEFT_ALIGNMENT
Chart.CENTER_ALIGNMENT
Chart.RIGHT_ALIGNMENT

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form1 = new LabelForm();
var form2 = new LabelForm();
form1.setLabel("label1");
form1.setPoint(new java.awt.Point(120, 100));
form2.setLabel("label2");
form2.setPoint(new java.awt.Point(120, 120));
form2.setAlignmentX(Chart.CENTER_ALIGNMENT);
graph.addForm(form1);
graph.addForm(form2);
graph.addElement(elem);
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Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

LabelForm.SETALIGNMENTY(VALUE)

Specifies the vertical alignment of the label with respect to the specified Y
location.

Values
Chart.TOP_ALIGNMENT
Chart.MIDDLE_ALIGNMENT
Chart.BOTTOM_ALIGNMENT

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form1 = new LabelForm();
var form2 = new LabelForm();
form1.setLabel("label1");
form1.setPoint(new java.awt.Point(100, 100));
form2.setLabel("label2");
form2.setPoint(new java.awt.Point(100, 100));
form2.setAlignmentY(Chart.TOP_ALIGNMENT);
graph.addForm(form1);
graph.addForm(form2);
graph.addElement(elem);
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Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

LabelForm.SETCOLLISIONMODIFIER(VALUE)

Specifies how collisions (labels occupying the same location) should be
handled. 

Values
VLabel.MOVE_NONE // no adjustment
VLabel.MOVE_FREE // move label any direction
VLabel.MOVE_RIGHT // move label right
VLabel.MOVE_UP // move label up

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form1 = new LabelForm();
var form2 = new LabelForm();
form1.setLabel("label1");
form1.setValues(['NY', 100]);
form2.setLabel("label2");
form2.setValues(['NY', 100]);
form1.setCollisionModifier(VLabel.MOVE_FREE);
graph.addForm(form1);
graph.addForm(form2);
graph.addElement(elem);

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.
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LabelForm.SETINSETS(VALUE)

Specifies the padding in pixels surrounding the label text.

Type
value a java.awt.Insets object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form = new LabelForm();
form.setLabel("label1");
form.setValues(['NY', 100]);
var spec = new TextSpec();
spec.setBackground(java.awt.Color(0x00ff00));
form.setTextSpec(spec);
form.setInsets(new java.awt.Insets(0,15,0,15)); 
// Argument order: top,left,bottom,right
graph.addForm(form);
graph.addElement(elem);

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

LabelForm.SETLABEL(VALUE)

Specifies the text of the label. (Use “\n” to insert newline.) 

Type
value a String containing label text

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Insets.html
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Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form = new LabelForm();
form.setLabel("Hello\nWorld");
form.setValues(['NY', 100]);
graph.addForm(form);
graph.addElement(elem);

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.
DefaultTextFrame, to automatically use data values as element labels.

LabelForm.SETPOINT(VALUE)

Specifies the pixel location (integer values) or proportional location
(fractional values) for the label. (Positive values specify distance from left/
bottom. Negative values specify distance from right/top.)

Type
value a subclass of java.awt.geom.Point2D

e.g., 
java.awt.Point for pixels
java.awt.geom.Point2D.Double for proportion

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form1 = new LabelForm();
var form2 = new LabelForm();
form1.setLabel("label1");
form2.setLabel("label2");
// Set form1 points in pixels:
form1.setPoint(new java.awt.Point(50, 100));
// Set form2 points proportionally:
form2.setPoint(new java.awt.geom.Point2D.Double(.5,.7));
graph.addForm(form1);
graph.addForm(form2);
graph.addElement(elem);

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/geom/Point2D.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Point.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/geom/Point2D.Double.html
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Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

LabelForm.SETTEXTSPEC(SPEC)

Specifies the label text attributes, such as color, font, format, etc.

Type
spec a TextSpec object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form = new LabelForm();
form.setLabel("label1");
form.setValues(['NY', 100]);
var spec = new TextSpec();
spec.setColor(new java.awt.Color(0xff0000));
form.setTextSpec(spec);
graph.addForm(form);
graph.addElement(elem);

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex
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See Also
DataSet, to use a Data Block or query as the dataset source.

LabelForm.SETTUPLE(VALUE)

Specifies the point in logical space for the label text. The coordinates of the
point are relative to the prevailing axis scaling.

Type
value An [X,Y] pair 

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form = new LabelForm();
form.setLabel("label1");
form.setTuple([0, 100]);
graph.addForm(form);
graph.addElement(elem);

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

LabelForm.SETVALUES(VALUE)

Specifies the location of the label text using coordinate values, numeric or
categorical. The coordinates of the point are relative to the prevailing axis
scaling. So, for a categorical X-axis (e.g., ‘NJ’, ‘NY’, ‘PA’, etc.), the X-
value of setValues should specify a categorical value (e.g., ‘NJ’).

Type
value an [X,Y] pair 

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"],["NJ", 200],["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form = new LabelForm();
form.setLabel("label1");
form.setValues(['NY', 100]);
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graph.addForm(form);
graph.addElement(elem);

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.8.5 TagForm

The TagForm object contains information for a tag form. A tag is a label
that is associated with a particular object and is automatically positioned to
avoid other objects. 

To create a TagForm object, call the TagForm constructor:

var tag = new TagForm();

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = 
[["State","Quantity"],["NJ",200],["NY",300],["NY",305]];
graph = new EGraph();
var elem = new PointElement("State", "Quantity");
var form1 = new TagForm();
var form2 = new TagForm();
form1.setLabel("label1");
form1.setValues(['NY', 300]);
form2.setLabel("label2");
form2.setValues(['NY', 305]);
graph.addForm(form1);
graph.addForm(form2);
graph.addElement(elem);

Full Name
inetsoft.graph.guide.form.TagForm

Inherits from
LabelForm: setAlignmentX, setAlignmentY, setCollisionModifier,
setInsets, setLabel, setPoint, setTextSpec, setTuple,setValues
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.
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CR.8.6 ShapeForm

The ShapeForm object contains information for shapes manually drawn on
the chart. 

Full Name
inetsoft.graph.guide.form.ShapeForm

ShapeForm: setAlignmentX, setAlignmentY, setPosition, setRotation, setShape, setSize,
setTuple, setValues

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

ShapeForm.SETALIGNMENTX(VALUE)

Specifies the horizontal alignment of the shape with respect to the specified
X position. 

Values
Chart.LEFT_ALIGNMENT
Chart.CENTER_ALIGNMENT
Chart.RIGHT_ALIGNMENT

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var shape1 = new ShapeForm();
var shape2 = new ShapeForm();
shape1.setPoint(new java.awt.geom.Point2D.Double(.5,.75));
shape1.setShape(GShape.FILLED_TRIANGLE);
shape1.setColor(java.awt.Color(0xff0000));
shape1.setSize(new java.awt.Dimension(20,20));
shape1.setAlignmentX(Chart.LEFT_ALIGNMENT);
shape2.setPoint(new java.awt.geom.Point2D.Double(.5,.5));
shape2.setShape(GShape.FILLED_TRIANGLE);
shape2.setColor(java.awt.Color(0x000000));
shape2.setSize(new java.awt.Dimension(20,20));
shape2.setAlignmentX(Chart.CENTER_ALIGNMENT);
graph.addForm(shape1);
graph.addForm(shape2);
graph.addElement(elem);
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Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

ShapeForm.SETALIGNMENTY(VALUE)

Specifies the vertical alignment of the shape with respect to the specified Y
position.

Values
Chart.TOP_ALIGNMENT
Chart.MIDDLE_ALIGNMENT
Chart.BOTTOM_ALIGNMENT

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var shape1 = new ShapeForm();
var shape2 = new ShapeForm();
shape1.setPoint(new java.awt.geom.Point2D.Double(.6,.5));
shape1.setShape(GShape.FILLED_TRIANGLE);
shape1.setColor(java.awt.Color(0xff0000));
shape1.setSize(new java.awt.Dimension(20,20));
shape1.setAlignmentY(Chart.TOP_ALIGNMENT);
shape2.setPoint(new java.awt.geom.Point2D.Double(.5,.5));
shape2.setShape(GShape.FILLED_TRIANGLE);
shape2.setColor(java.awt.Color(0x000000));
shape2.setSize(new java.awt.Dimension(20,20));
shape2.setAlignmentY(Chart.MIDDLE_ALIGNMENT);
graph.addForm(shape1);
graph.addForm(shape2);
graph.addElement(elem);
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Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

ShapeForm.SETPOINT(VALUE)

Specifies the pixel location or proportional location where the shape is
placed. (Positive values specify distance from left/bottom. Negative values
specify distance from right/top.)

Type
value a subclass of java.awt.geom.Point2D

e.g., 
java.awt.Point for pixels
java.awt.geom.Point2D.Double for proportion

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var shape1 = new ShapeForm();
var shape2 = new ShapeForm();

// Set shape1 points in pixels:
shape1.setPoint(new java.awt.Point(150, 100));
shape1.setShape(GShape.FILLED_TRIANGLE);
shape1.setColor(java.awt.Color(0xff0000));
shape1.setSize(new java.awt.Dimension(10,10));

// Set shape2 points proportionally:
shape2.setPoint(new java.awt.geom.Point2D.Double(.5,.5));
shape2.setShape(GShape.FILLED_TRIANGLE);
shape2.setColor(java.awt.Color(0xff0000));
shape2.setSize(new java.awt.Dimension(20,20));

graph.addForm(shape1);
graph.addForm(shape2);
graph.addElement(elem);

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/geom/Point2D.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Point.html
http://download.oracle.com/javase/7/docs/api/index.html?java/awt/geom/Point2D.Double.html
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Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

ShapeForm.SETROTATION(VALUE)

Specifies the shape rotation in degrees. 

Type
Number

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var shape1 = new ShapeForm();
var shape2 = new ShapeForm();
shape1.setPoint(new java.awt.geom.Point2D.Double(.6,.5));
shape1.setShape(GShape.FILLED_TRIANGLE);
shape1.setColor(java.awt.Color(0xff0000));
shape1.setSize(new java.awt.Dimension(20,20));
shape1.setRotation(45);
shape2.setPoint(new java.awt.geom.Point2D.Double(.5,.5));
shape2.setShape(GShape.FILLED_TRIANGLE);
shape2.setColor(java.awt.Color(0x000000));
shape2.setSize(new java.awt.Dimension(20,20));
graph.addForm(shape1);
graph.addForm(shape2);
graph.addElement(elem);
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Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

ShapeForm.SETSHAPE(SHAPE)

Specifies the type of shape as a GShape or SVGShape.

Type
GShape
SVGShape
GShape.ImageShape

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form = new ShapeForm();
form.setValues(['NJ',100]);
form.setShape(GShape.FILLED_TRIANGLE);
form.setColor(java.awt.Color(0xff0000));
form.setSize(new java.awt.Dimension(50,50));
graph.addForm(form);
graph.addElement(elem);

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var logo = getImage("http://www.inetsoft.com/images/home/
logo.gif");
var shape = new GShape.ImageShape();
shape.setImage(logo);
var form = new ShapeForm();
form.setValues(['NJ',100]);
form.setShape(shape);
form.setSize(new java.awt.Dimension(150,40));
graph.addForm(form);
graph.addElement(elem);
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Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

ShapeForm.SETSIZE(VALUE)

Specifies the size of the shape in pixels.

Type
value a java.awt.Dimension object

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
var arr = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
var data = new DataSet(arr);
var graph = new EGraph(data);
var elem = new IntervalElement("State", "Quantity");
var form = new ShapeForm();
form.setValues(['NJ',100]);
form.setShape(GShape.FILLED_TRIANGLE);
form.setColor(java.awt.Color(0xff0000));
form.setSize(new java.awt.Dimension(50,50));
graph.addForm(form);
graph.addElement(elem);

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

ShapeForm.SETTUPLE(VALUE)

Specifies the location of the shape in logical space. The coordinates of the
location are relative to the prevailing axis scaling.

http://download.oracle.com/javase/7/docs/api/index.html?java/awt/Dimension.html
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Type
value An [X,Y] pair 

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var form = new ShapeForm();
form.setTuple([.5,100]);
form.setShape(GShape.FILLED_TRIANGLE);
form.setColor(java.awt.Color(0xff0000));
form.setSize(new java.awt.Dimension(50,50));
graph.addForm(form);
graph.addElement(elem);

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

ShapeForm.SETVALUES(VALUE)

Specifies the location of the shape in logical space. The coordinates of the
location are relative to prevailing axis scaling prior to transformation. So,
for a categorical X-axis (e.g., ‘NJ’, ‘NY’, ‘PA’, etc.), the X-value of the
location should specify a categorical value (e.g., ‘NJ’).

Type
value an [X,Y] pair 

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
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var elem = new IntervalElement("State", "Quantity");
var form = new ShapeForm();
form.setValues(['NJ',100]);
form.setShape(GShape.FILLED_TRIANGLE);
form.setColor(java.awt.Color(0xff0000));
form.setSize(new java.awt.Dimension(50,50));
graph.addForm(form);
graph.addElement(elem);

Inherits from
GraphForm: setColor, setFill, setInsidePlot, setLine, setMeasure,
setZIndex

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.9 Utility Objects

This section describes objects which provide useful constants. 

CR.9.1 GTexture

The GTexture object contains a set of patterns. Create a GTexture object by
referring to a pattern number, 1–19.

var texture = GTexture.PATTERN_5;

The image below presents the available textures and their corresponding
numbers.

See Also
StaticTextureFrame, for information on using static textures.

CR.9.2 GLine

The GLine object provides the following predefined line style constants:
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GLine.THIN_LINE
GLine.DOT_LINE
GLine.DASH_LINE
GLine.MEDIUM_DASH
GLine.LARGE_DASH

You can also create a GLine object by passing a Chart constant (see Line
Styles) to the object constructor, as follows:

var line = new GLine(Chart.DOT_LINE);

To create a user-defined style, pass a dash size and width (both type
doubles) to the object constructor, as follows.

var line = new GLine(dashsize, width);

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a line-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad Handler.

Chart1.bindingInfo.setShapeField("Company",Chart.NUMBER)
Chart1.bindingInfo.lineFrame = new StaticLineFrame;
Chart1.bindingInfo.lineFrame.line = GLine(20,10);

See Also
Line Styles, for the built-in styles available as Chart Constants constants.
StaticLineFrame, for information on using GLines.

CR.9.3 GShape

The GShape object contains a set of shapes. For element properties
requiring a GShape object, the shape can be specified as shown below. 

GShape.ImageShape (user-defined image)
GShape.ARROW
GShape.ARROWBAR
GShape.CIRCLE
GShape.CROSS
GShape.DIAMOND
GShape.FILLED_ARROW
GShape.FILLED_ARROWBAR
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GShape.FILLED_CIRCLE
GShape.FILLED_DIAMOND 
GShape.FILLED_SQUARE 
GShape.FILLED_TRIANGLE
GShape.HYPHEN
GShape.LINE
GShape.LSHAPE
GShape.SQUARE
GShape.STAR
GShape.STICK
GShape.TRIANGLE
GShape.VSHAPE
GShape.XSHAPE
GShape.NIL (no shape)

See Also
SVGShape, for information on using built-in and custom SVG images.
ShapeForm, for information on using GShapes as decorative shapes.
StaticShapeFrame, for information on using GShapes as static shapes.

CR.9.4 GShape.ImageShape

The GShape.ImageShape object contains a custom image to be used as a
fill pattern with StaticShapeFrame and CategoricalShapeFrame objects.
To create an ImageShape object, call the object constructor:

var shape = new GShape.ImageShape("http://.../image.gif");

You can provide the image location as input to the constructor, e.g.,

var shape = new GShape.ImageShape("http://.../image.gif");

or specify this later using the GShape.ImageShape.image property.

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField('Employee',Chart.STRING)
var logo = getImage("http://www.inetsoft.com/images/home/
logo.gif");
var shape = new GShape.ImageShape();
shape.image = logo;
var frame = new StaticShapeFrame(shape);
Chart1.bindingInfo.shapeFrame = frame;
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Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var logo = getImage("http://www.inetsoft.com/images/home/
logo.gif");
var shape = new GShape.ImageShape();
shape.image = logo;
var frame = new StaticShapeFrame(shape)
elem.setShapeFrame(frame);
graph.addElement(elem);

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var logo = getImage("http://www.inetsoft.com/images/home/
logo.gif");
var shape = new GShape.ImageShape(logo);
var frame = new CategoricalShapeFrame("State");
frame.setShape("NJ", shape);
elem.setShapeFrame(frame);
graph.addElement(elem);
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Full Name
inetsoft.graph.aesthetic.GShape.ImageShape

GShape.ImageShape: setShape, setTile

See Also
DataSet, to use a Data Block or query as the dataset source.
StaticShapeFrame, for information on using custom images.

GShape.ImageShape.IMAGE

Specifies the image to use as the fill.

Type
Image object, see getImage()

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Employee",Chart.STRING);
var logo = getImage("http://www.inetsoft.com/images/home/
logo.gif");
var shape = new GShape.ImageShape();
shape.image = logo;
var frame = new StaticShapeFrame(shape);
Chart1.bindingInfo.shapeFrame = frame;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var logo = getImage("http://www.inetsoft.com/images/home/
logo.gif");
var shape = new GShape.ImageShape();
shape.setImage(logo);
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var frame = new StaticShapeFrame(shape)
elem.setShapeFrame(frame);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

GShape.ImageShape.TILE

Specifies whether the image should be stretched to fit the fill area or tiled at
the original size.

Type
boolean true: keep original size, and tile to fit

false: stretch to fit (default)

Note: Report script that modifies 'bindingInfo' should be placed in
the onLoad handler.

Example (Report)
Bind a point-type chart to the sample ‘All Sales’ query in ‘Orders’ >
‘Sample Queries’, with ‘Company’ (top 5) on the X-axis, and Sum(Total)
on the Y-axis. Add the following script in the onLoad handler.

Chart1.bindingInfo.setShapeField("Employee",Chart.STRING);
var logo = getImage("http://www.inetsoft.com/images/home/
logo.gif");
var shape = new GShape.ImageShape();
shape.image = logo;
shape.tile = true;
var frame = new StaticShapeFrame(shape);
Chart1.bindingInfo.shapeFrame = frame;

Note: Script that modifies 'graph' should be placed at the element
level. See Editing Script in Advanced Report Scripting and Adding
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Component Script in Advanced Dashboard Scripting for more
information.

Example (Report or Viewsheet)
dataset = [["State", "Quantity"], ["NJ", 200], ["NY", 300]];
graph = new EGraph();
var elem = new IntervalElement("State", "Quantity");
var logo = getImage("http://www.inetsoft.com/images/home/
logo.gif");
var shape = new GShape.ImageShape();
shape.setImage(logo);
shape.setTile(true);
var frame = new StaticShapeFrame(shape)
elem.setShapeFrame(frame);
graph.addElement(elem);

See Also
DataSet, to use a Data Block or query as the dataset source.

CR.9.5 SVGShape

The SVGShape object contains a set of shapes for use with
StaticShapeFrame and ShapeForm. For element properties requiring a
SVGShape object, the shape can be specified as shown below. 

SVGShape.CHECK
SVGShape.DOWN_ARROW
SVGShape.FACE_BLANK
SVGShape.FACE_HAPPY
SVGShape.FACE_OK
SVGShape.FACE_SAD
SVGShape.FACE_SMILE
SVGShape.FEMALE
SVGShape.LEFT_ARROW 
SVGShape.MALE 
SVGShape.MINUS
SVGShape.PLUS
SVGShape.RIGHT_ARROW
SVGShape.STAR
SVGShape.SUN
SVGShape.UP_ARROW
SVGShape.WARNING
SVGShape.X
SVGShape.NIL (no shape)

You can also create a custom SVGShape from an SVG image stored in the
local file system or on a server.
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Example 1 (Built-in SVG Shape)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new PointElement("State","Quantity");
var shapeFrame = new StaticShapeFrame(SVGShape.FACE_HAPPY); 
var sizeFrame = new StaticSizeFrame(10);
elem.setSizeFrame(sizeFrame);
elem.setShapeFrame(shapeFrame);
graph.addElement(elem);

Example 2 (Local SVG Shape)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new PointElement("State","Quantity");
var svg = new SVGShape("file:\C:/HappyFaceSVG.svg");
var shapeFrame = new StaticShapeFrame(svg); 
var sizeFrame = new StaticSizeFrame(10);
elem.setSizeFrame(sizeFrame);
elem.setShapeFrame(shapeFrame);
graph.addElement(elem);

Example 3(Remote SVG Shape)
dataset = [["State","Quantity"], ["NJ",200], ["NY",300]];
graph = new EGraph();
var elem = new PointElement("State","Quantity");
var svg = new SVGShape("http://www.w3.org/Icons/SVG/svg-
logo.svg");
var shapeFrame = new StaticShapeFrame(svg); 
var sizeFrame = new StaticSizeFrame(10);
elem.setSizeFrame(sizeFrame);
elem.setShapeFrame(shapeFrame);
graph.addElement(elem);

See Also
GShape, for information on using built-in bitmap shapes.
GShape.ImageShape, for information on using custom bitmap shapes.
ShapeForm, for information on using GShapes as decorative shapes.
StaticShapeFrame, for information on using GShapes as static shapes.

CR.10Z-Index Defaults

The GraphForm.setZIndex(value) property of a form object determines
whether the object lies above or below other chart objects. When an object
has a higher zIndex than a second object, the first object will partially or
fully occlude the second object
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The table below provides the default zIndex settings for common chart
objects.

CR.11Chart Constants

The Chart object is a static object that contains definitions for constants
related to charts (line styles, etc.). These constants can be accessed without
explicitly creating an instance of a Chart object, as shown below:

Chart1.chartStyle['Sum(Total)'] = Chart.CHART_LINE;

CHART STYLES

The following Chart Constants style constants are available for the
chartStyle property within report onLoad and Viewsheet script.

OBJECT DEFAULT ZINDEX

Coordinate border 20
Grid line 30
Axis 40
Axis border 50
Visual object 60
Grid line on top of Object 70
Form object 80
Facet gridline 90
Text 100

CHART STYLE DESCRIPTION

CHART_AUTO Automatic style selection
CHART_PARETO Pareto chart.
CHART_LINE Line chart
CHART_LINE_STACK Stacked line chart
CHART_POINT Point chart
CHART_BAR 2D bar chart
CHART_BAR_STACK Stacked bar chart
CHART_PIE 2D pie chart
CHART_3D_BAR 3D bar chart
CHART_3D_BAR_STACK 3D stacked bar chart
CHART_3D_PIE 3D pie chart
CHART_STOCK High-low-closing chart
CHART_AREA Area chart
CHART_AREA_STACK Stacked area chart
CHART_RADAR Radar chart
CHART_FILL_RADAR Filled radar chart
CHART_CANDLE Candle chart
CHART_WATERFALL Waterfall chart
CHART_MAP Map chart
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LINE STYLES

The Chart Constants line style constants below can be used in all chart
properties requiring line styles, such as axis grid lines, target lines, etc.

See Also
xGridStyle, to set the graph grid lines.

SUMMARIZATION FORMULAS

The Chart Constants summarization formulas below are available for chart
scripting.

LEGEND POSITIONS

The following legend positions are available for
EGraph.setLegendLayout(value).

LINE STYLE DESCRIPTION

   NONE No line
   ULTRA_THIN_LINE Very thin line at ¼ of a point width
   THIN_THIN_LINE Very thin line at ½ of a point width
   THIN_LINE Thin line at one point width
   MEDIUM_LINE Medium width line
   THICK_LINE Thick width line
   DOT_LINE Dotted line
   DASH_LINE Dash line
   MEDIUM_DASH Medium size dash line
   LARGE_DASH Large size dash line

NONE NTHMOSTFREQUENT
AVERAGE NTHSMALLEST
CONCAT POPULATIONSTANDARDDEVIATION
CORRELATION POPULATIONVARIANCE
COUNT PRODUCT
COVARIANCE PTHPERCENTILE
DISTINCTCOUNT STANDARDDEVIATION
MAX SUMSQ
MEDIAN SUMWT
MIN SUM
MODE VARIANCE
NTHLARGEST WEIGHTEDAVERAGE

LEGEND POSITION DESCRIPTION

Chart.NONE No legend
 Chart.BOTTOM Below X-axis title, aligned left
 Chart.TOP Above graph, aligned left
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CR.12Miscellaneous Chart Functions

This section presents special-purpose charting functions. 

CREATEBULLETGRAPH(MEASURE, RANGES, TARGET, COLOR, XDIMS,
YDIMS, OPTS)

The createBulletGraph() function generates a bullet graph to display a
specified measure along with a target and multiple value ranges. (All
parameters are optional. To omit any parameter setting, pass null as the
value.)

Parameter
measure Name of column to provide the measure values
ranges Array of column names to provide range values,

displayed as shaded regions
target Name of column to provide the target value, 

displayed as vertical bar 
color A single color or array of colors to be used 

for bullets. See below. 
xdims Array of column names to use as dimensions on 

X-axis
ydims Array of column names to use as dimensions on 

Y-axis 
opts String containing additional options:

'vertical=false': force horizontal bars
'ylabel=false': hide y-dimension labels
'xlabel=false': hide x-dimension labels
'vlabel=false': hide the measure value labels

The color parameter can be either a scalar hex color value (e.g.,
0x0000FF.), or an array of colors. The organization for the color array is as
follows:

[measure, target, range 1, range 2, range 3, ...]

e.g., [0x0000FF, 0xFF0000, 0xDD0000, 0xBB0000, 0x990000]

Example
Consider the Worksheet Data Block called, ‘Query1’, shown below. (This
Data Block is a mirror of the ‘All Sales’ query in ‘Orders’ > ‘Sample
Queries’, with grouping on the ‘Employee’ and ‘Company’ fields,
aggregation on the ‘Total’ field, and expression columns for ‘Target’,
‘range1’, ‘range2’, and ‘range3’.)

 Chart.LEFT To left of Y-axis title, aligned top
 Chart.RIGHT To right of graph, aligned top (default)
 Chart.IN_PLACE Superimposed on graph
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Create a Viewsheet based on this Data Worksheet, add a Chart component,
and insert the following Chart script:

dataset = viewsheet['Query1']
graph = createBulletGraph('Total', 
['range1','range2','range3'],'Target',0x0000FF, 
['Company'],['Employee'],'vertical=false');

See Also
DataSet, for information on specifying the chart data in script.
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